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Introducing the NetBackup
interfaces

This chapter includes the following topics:

■ About NetBackup

■ NetBackup documentation

■ About NetBackup administration interfaces

■ Using the NetBackup Administration Console

■ NetBackup configuration wizards

■ Running the Troubleshooter

About NetBackup
NetBackup provides a complete, flexible data protection solution for a variety of
platforms. The platforms include Windows, UNIX, and Linux systems.

NetBackup administrators can set up periodic or calendar-based schedules to
perform automatic, unattended backups for clients across a network. An
administrator can carefully schedule backups to achieve systematic and complete
backups over a period of time, and optimize network traffic during off-peak hours.
The backups can be full or incremental: Full backups back up all indicated client
files, while incremental backups back up only the files that have changed since the
last backup.

The NetBackup administrator can allow users to back up, restore, or archive the
files from their computer. (An archive operation backs up a file, then deletes it from
the local disk if the backup is successful.)

NetBackup includes both the server and the client software as follows:
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■ Server software resides on the computer that manages the storage devices.

■ Client software resides on computer(s) that contain data to back up. (Servers
also contain client software and can be backed up.)

Figure 1-1 shows an example of a NetBackup storage domain.

Figure 1-1 NetBackup storage domain example

Media servers

NetBackup
clients

NetBackup
master server

Media Manager tape
storage unit

Storage unit

SAN

OpenStorage
disk pool

NetBackup accommodates multiple servers that work together under the
administrative control of one NetBackup master server in the following ways:

■ Themaster server manages backups, archives, and restores. Themaster server
is responsible for media and device selection for NetBackup. Typically, the
master server contains the NetBackup catalog. The catalog contains the internal
databases that contain information about NetBackup backups and configuration.

■ Media servers provide additional storage by allowing NetBackup to use the
storage devices that are attached to them. Media servers can also increase
performance by distributing the network load. Media servers can also be referred
to by using the following terms:

■ Device hosts (when tape devices are present)

■ Storage servers (when I/O is directly to disk)
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■ Data movers (when data is sent to independent, external disk devices like
OpenStorage appliances)

During a backup or archive, the client sends backup data across the network to a
NetBackup server. The NetBackup server manages the type of storage that is
specified in the backup policy.

During a restore, users can browse, then select the files and directories to recover.
NetBackup finds the selected files and directories and restores them to the disk on
the client.

NetBackup documentation
For a complete list of NetBackup technical documents for each supported release,
see the NetBackup release notes, Administration, Installation, Troubleshooting,
Getting Started, and Solutions Guides page at the following URL:

http://www.veritas.com/docs/DOC5332

The documents are in Adobe® Portable Document Format (PDF), viewable with
the Adobe Acrobat Reader. Download the reader from http://www.adobe.com.

Veritas assumes no responsibility for the installation and use of the reader.

The NetBackup landing page on the Veritas Support website contains a list of helpful
how-to and product alert topics.

About NetBackup administration interfaces
NetBackup can be administered with several interfaces. The best choice depends
on personal preference and the workstation that is available to the administrator.

Table 1-1 NetBackup administration interfaces

DescriptionName of
interface

With the NetBackup web user interface (UI), you can administer many NetBackup activities and
configurations, including role-based access control. For specific information about the web UI and
its features, refer to the web UI administrators' guides that are available at the following website:

http://www.veritas.com/DOC5332

To start the NetBackup web UI:

■ Open a web browser and go to https://masterserver/webui/login.

Note: Users must be root or an administrator or have a role that is configured for them in
NetBackup RBAC.

NetBackup web
user interface
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Table 1-1 NetBackup administration interfaces (continued)

DescriptionName of
interface

The NetBackup Administration Console contains all the available configuration and features
for NetBackup, with the exception of role-based access control.

From the master server you can configure and manage the storage devices on all of your media
servers.

For support information about supported versions of NetBackup, see https://sort.veritas.com/eosl.

See “Administering remote servers of different versions” on page 36.

NetBackup includes an administration console for all the supported versions of NetBackup. Select
the version of the console that is compatible with the NetBackup server that you want to administer.

To start the NetBackup Administration Console

■ On Windows, select NetBackup 8.x Administration Console from the Start menu.
■ On UNIX, run the jnbSA command.

Note: To log in to any NetBackup Administration Console, your login credentials must be
authenticated from the connecting master or media server.

NetBackup
Administration
Console

Run the tpconfig command to start a character-based, menu interface for device management.

Use the tpconfig interface from any terminal (or terminal emulation window) that has a termcap
or a terminfo definition.

Character-based,
menu interface

NetBackup commands are available on both Windows and UNIX platforms. Enter NetBackup
commands at the system prompt or use the commands in scripts.

All NetBackup administrator programs and commands require root or administrator user privileges
by default.

See “About authorizing nonroot users for specific applications” on page 1181.

For complete information on all NetBackup commands, see the NetBackup Commands Reference
Guide.

To view help for the commands, use the UNIX man command.

Command line

See “Using the NetBackup Administration Console” on page 40.

See “Administering remote servers of different versions” on page 36.

About security certificates for NetBackup hosts
NetBackup uses security certificates for authentication of NetBackup hosts. The
NetBackup security certificates conform to the X.509 Public Key Infrastructure (PKI)
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standard. A master server acts as the NetBackup Certificate Authority (CA) and
issues NetBackup certificates to hosts.

NetBackup provides two types of NetBackup host security certificates: Host ID-based
certificates and host name-based certificates. Host ID-based certificates are based
on Universally Unique Identifiers (UUID) that are assigned to each NetBackup host.
The NetBackup master server assigns these identifiers to the hosts.

Any security certificates that were generated before NetBackup 8.0 are now referred
to as host name-based certificates. NetBackup is in the process of replacing these
older certificates with newer host ID-based certificates. The transition will be
completed in future releases and the use of host name-based certificates will be
eliminated. However, the transition is ongoing and the current NetBackup version
continues to require the older host name-based certificates for certain operations.

https://www.veritas.com/support/en_US/article.100044300

For information on external CA support in NetBackup and external CA-signed
certificates, see the NetBackup Security and Encryption Guide.

For more information about deployment, management, and usage of security
certificates, see the NetBackup Security and Encryption Guide.

About setting up the NetBackup Administration Console on UNIX
NetBackup provides two Java-based administration consoles through which the
administrator can manage NetBackup. The consoles can be run on either of the
following systems:

■ Directly on a supported Java-capable UNIX computer by running
/usr/openv/java/jnbSA &

The jnbSA command is described in the NetBackup Commands Reference
Guide.
Use the -r command to connect to the compatible version of the console for
the server that you want to administer.

■ On a Windows computer that has the NetBackup Administration Console
installed.
From the multiple versions of consoles installed, select the version of the console
that is compatible with the NetBackup server that you want to administer.

Startup procedures and configuration information is explained in the following topics.

Administering remote servers of different versions
The NetBackup web user interface (web UI) is only available for NetBackup 8.1.2
and later. This interface is available on the master server and supports the version

36Introducing the NetBackup interfaces
About NetBackup administration interfaces

https://www.veritas.com/support/en_US/article.100044300
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


of NetBackup on that server. You do not need to locate and open a specific version
as you do with the NetBackup Administration Console. See the documentation for
the NetBackup web UI.

The NetBackup server installation provides multiple versions of the NetBackup
Administration Console to administer remote servers of different versions. When
starting the console, select the version of the console that is compatible with the
NetBackup server that you want to administer.

Alternatively, from the command line, you can use the jnbSA command with the -r
option to launch the console. For example, to connect to a 8.0 master server from
a 8.1 UNIX master server, enter the following command on the 8.1 master server:

./jnbSA -r 8.0

Several versions of the interface exist. Use the -h option and review the -r options
to find out which versions are supported.

If no -r option is specified, the default is the NetBackup version of the current
master server.

Note: To log on to anyNetBackup Administration Console, your logon credentials
must be authenticated from the connecting master or media server.

Backward compatibility with triple-dot versions
TheNetBackupAdministration Console is backward-compatible between a patch
release (x.x.x.x) and a major (x.x) or minor release (x.x.x) that shares the same
first and second digits.

For example, the 8.1.x.y console is compatible with a 8.1 master server. However,
a NetBackup 8.1.x.y console cannot administer a 8.0.x.y master server. See
Figure 1-2 for various examples.

Figure 1-2 Examples of supported and unsupported back-level console
configurations

8.0

Yes

8.0.x.y

No

8.0.x.y

8.1.x.y

7.7

Yes

7.7.3

No

7.7.3

8.1

See “Accessing remote servers” on page 1173.
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Logging in to the NetBackup Administration Console
Use theNetBackupAdministration Console to administer andmonitor NetBackup
operations.

To log in to the NetBackup Administration Console

1 On aWindows host where theNetBackupAdministrationConsole is installed,
select Start > Programs > Veritas NetBackup > NetBackup 8.2
Administration Console.

On a UNIX computer, use the jnbSA command:

/usr/openv/java/jnbSA &

2 The login screen for theNetBackup Administration Console displays a name
in the Host name field.

The default host name is the last host that you successfully logged in to. The
drop-down list contains the names of other hosts that you logged in to.

To log in to a different host, type the name of another host.

If the server you enter is a media server or client, the media server or client
must have a security certificate installed.

See “About security certificates for NetBackup hosts” on page 35.

3 In the login screen, type your user name and password. To log in to a Windows
server, enter both the domain of the server and the user name as follows:

domain_name\user_name

The domain_name specifies the domain of the NetBackup host. If the host is
not a member of a domain, the domain_name is not required.

4 To log in to the application server using Windows Active Directory credentials,
enable Use Active Directory login credentials. By enabling the option, you
can bypass the authentication that is required using the user name and enable
Single Sign-on (SSO).

Users with administrative as well as non-administrative privileges can use SSO.
The user with administrative privileges needs to right-click and select the Run
as administrator option while launching the NetBackup Administration
Console. Selecting this option enables the user to view the console with
administrative privileges.

Note the following about SSO:

■ The SSO option is available only when both the NetBackup master server
and the NetBackup client are Windows hosts.

38Introducing the NetBackup interfaces
About NetBackup administration interfaces



■ After the first successful login using SSO, the Use Active Directory login
credentials check box remains in the enabled state for the next login
attempt on the same server for the same client.

■ The NetBackup Administration Console on a UNIX master server does
not show the check box to use the Active Directory credentials.

■ UNIX hosts can log in to the application server using the user name-based
authentication.

5 Click Login to log in to the NetBackup application server program on the
specified server. The interface program continues to communicate through the
server that is specified in the logon screen for the remainder of the current
session.

See “User Account Settings properties” on page 244.

Notes about using the NetBackup Administration Console
■ TheNetBackup Administration Console is best viewed at a screen resolution

of 1280 X 1024 or higher. The minimum supported screen resolution to use the
console is 1024 X 768.

■ The NetBackup Administration Console does not support user-defined
characters (UDC) and vendor-defined characters (VDC) because of the
implementation of Java’s encoding converters.

■ On non-English versions of Windows and UNIX systems, the NetBackup
Administration Console may display non-US ASCII characters incorrectly.
This issue can lead to functional failures.
This issue results from a character encoding mismatch between the NetBackup
server and theNetBackup Administration Console. For a detailed description
of the configuration, refer to the following article on the Veritas Support website:
http://www.veritas.com/docs/TECH75745

■ To use the NetBackup Administration Console on a Windows computer, the
Microsoft Windows UAC (User Access Control) feature must be disabled. See
the following link for instructions:
http://windows.microsoft.com/en-us/windows/turn-user-account-control-on-off#1TC=windows-7

■ If there is more than one NetBackup server, the NetBackup Administration
Console can be run on more than one server at one time. However, if more
than one administrator makes changes to the configuration, the results are
unpredictable.

Figure 1-3 shows the selection to install only the NetBackup Administration
Console.
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Figure 1-3 Selection on the installation panel to install only the NetBackup
Administration Console

See “Accessing remote servers” on page 1173.

Using the NetBackup Administration Console
The NetBackup Administration Console provides a graphical user interface
through which the administrator can manage NetBackup. It runs on both the
Windows and the UNIX platforms.

Current master server
The name of the currently selected master server.

The information in the NetBackup Administration Console applies to this server
only.

Login Activity
Click to display the information about the current user's successful and unsuccessful
login attempts, and the password expiration date.
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Backup, Archive, and Restore
Administrators can use theBackup, Archive, and Restore utility to perform backup,
archive, and restore operations for the computer that is currently selected.

Activity Monitor
Use the Activity Monitor to display NetBackup job information. The Activity
Monitor provides the control over the jobs, services, processes, and drives.

See “About the Activity Monitor” on page 1096.

NetBackup Management
NetBackup Management contains many of the utilities to manage NetBackup:

■ Reports
Use to compile information to verify, manage, and troubleshoot NetBackup
operations.
See “About the Reports utility” on page 1138.

■ Policies
Use to create and specify the backup policies that define the rules for backing
up a group of clients.
See “About the Policies utility” on page 709.

■ Storage
Use to configure storage units, storage unit groups, storage lifecycle policies
(SLPs), and windows for secondary operations in SLPs.
See “About the Storage utility” on page 588.

■ Catalog
Use to create and configure a catalog backup, which is a special type of backup
that NetBackup requires for its own internal databases.
See “About the Catalog utility” on page 1013.

■ Host Properties
Use to customize NetBackup configuration options.
See “About the NetBackup Host Properties” on page 53.

■ Applications
Applications contains all discovered instances on SQL and Oracle clients and
any manually added instances. These instances are used to build an Oracle or
a SQL Intelligent Policy.
For more information, see the NetBackup for Oracle Administrator’s Guide and
the NetBackup for SQL Server Administrator’s Guide.
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Media and Device Management
Media and Device Management contains the utilities for managing the media and
devices that NetBackup uses to store backups:

■ Device Monitor
Manages the drives, device paths, and service requests for operators.

■ Media
Adds and manages removable media.

■ Devices
Adds, configures, and manages storage devices.

■ Credentials
Adds, removes, and manages logon credentials for NDMP hosts or storage
servers.

Security Management
Security Management contains utilities to manage settings for security and hosts.

■ Security Events
Use to view the login details about the current administrator and the user-initiated
changes that are made to NetBackup
For more information about Security Events, see the NetBackup Security and
Encryption Guide.
http://www.veritas.com/docs/DOC5332

■ Host Management
Use to carry out NetBackup host operations, such as adding or removing host
ID to host name mappings, reset host, or add comment for a host.

■ Certificate Management
Use to manage NetBackup certificates and view external certificates.

■ Global Security Settings
Use to configure security settings for the NetBackup domain.

■ Access Management
NetBackup Access Control (NBAC) is the legacy access control method for
NetBackup and is no longer being updated. Veritas recommends that you use
role-based access control (RBAC) with the web UI.
http://www.veritas.com/docs/DOC5332.

Other licensed utilities
Additional licensed utilities appear under the main NetBackup nodes.
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Logging Assistant
The Logging Assistant is a tool that helps administrators configure, gather, and
upload debug logs.

See “About the Logging Assistant” on page 1144.

Deployment Management
Deployment Management contains the Deployment Policies utility which is the
main component of VxUpdate that serves as a client or host upgrade tool.

For more, See “About deployment policies utility” on page 1033.

For more information regarding VxUpdate, see Deployment Management chapter
within the NetBackup Upgrade Guide

http://www.veritas.com/docs/DOC5332

NetBackup configuration wizards
The easiest way to configure NetBackup is to use the configuration wizards available
in the NetBackup Administration Console. The wizards help configure the
properties of a NetBackup environment.

The wizard selection varies in the pane on the right, depending on which NetBackup
utility is selected in the left of the screen.

Table 1-2 Configuration wizards

DescriptionWizard

Configures NetBackup for the first time. The wizard leads the user through the
necessary steps to a working NetBackup configuration.

The Getting Started Wizard is comprised of the following wizards, which can also
be run separately, outside of the Getting Started Wizard:

■ Device Configuration Wizard
■ Volume Configuration Wizard
■ Catalog Backup Wizard
■ Policy Configuration Wizard

Configure more advanced properties through the individual utilities.

Note: Do not use the Getting Started Wizard to configure policies for Replication
Director.

Getting Started Wizard

Click Configure Storage Devices to configure NetBackup to use robotic tape
libraries and tape drives.

Device Configuration Wizard
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Table 1-2 Configuration wizards (continued)

DescriptionWizard

Click Configure Disk Storage Servers to create the servers that manage disk
storage.

The wizard appears if a NetBackup Data Protection Optimization Option license
is installed.

Storage Server Configuration
Wizard

Click Configure Cloud Storage Servers to add or configure a cloud provider.

For more information, see the NetBackup Cloud Administrator's Guide.

Cloud Storage Server
Configuration Wizard

Click Configure Disk Pool to create pools of disk volumes for backup by one or
more media servers.

The wizard appears if a NetBackup Data Protection Optimization Option license
is installed.

Disk Pool Configuration Wizard

Click Configure Volumes to configure removable media to use for backups.Volume Configuration Wizard

ClickConfigure the Catalog Backup to set up catalog backups. Catalog backups
are essential to recover data in the case of a server failure or crash.

Catalog Backup Wizard

Click Create a Policy to set up one of the policy types:

■ A policy to back up file systems, databases, or applications.
■ A policy to protect VMware or Hyper-V virtual machines.
■ A policy to back up NDMP hosts.
■ A policy to back up Oracle data.

Note: Do not use the Policy Configuration Wizard to configure policies for
Replication Director.

Policy Configuration Wizard

This wizard is available only on computers runningWindows. Click Import Images
to import NetBackup images in a two-part process.

See “About importing backup images” on page 1027.

Import Images Wizard

Click Recover the Catalog to recover a catalog backup in a disaster recovery
situation.

For more information about NetBackup disaster recovery, see the NetBackup
Troubleshooting Guide.

Catalog Recovery Wizard

Running the Troubleshooter
When a NetBackup job returns a status code, use the Troubleshooter to find a
description of the problem and a recommended solution. The Troubleshooter is
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particularly useful for understanding the status of a job in the Activity Monitor or
in the Reports utility.

To run the Troubleshooter

1 In the NetBackup Administration Console, do one of the following:

■ In the left pane, click Activity Monitor.
■ In the right pane, select the Jobs tab at the bottom

of the pane.
■ Select a job from the list.

To understand the status of a
job in the Activity Monitor

■ In the left pane, expand NetBackup Management
> Reports.

■ In the left pane, click the name of the report you want
to run.
For some reports, you must first expand a report
group, and then click the name of the report.

■ In the right pane, click Run Report.
■ Select a job from the list that is generated.

To understand the status of a
job in a report

Go to step 2.To look up a status code

2 Click Help > Troubleshooter.

The dialog box that appears describes the status code on the Problem tab.
Possible solutions can be found on the Troubleshoot tab. The Veritas Support
tab displays the web address of Veritas Support or the URL to a tech note that
addresses the specific error code.

3 If no explanation appears, enter a status code and click Lookup.

The Troubleshooter provides assistance for NetBackup codes only. Assistance
with Media and Device Management codes is available by using NetBackup
online Help and searching for the particular status code.

See “Viewing job details in the Activity Monitor” on page 1101.

See “About the Jobs tab” on page 1100.

See “Copying report text to another document” on page 1142.

See “Printing a report” on page 1143.

See “Saving or exporting a report” on page 1143.
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Administering NetBackup
licenses

This chapter includes the following topics:

■ About administering NetBackup licenses

About administering NetBackup licenses
NetBackup license keys are added when the software is installed. Licenses can be
added later in the License Key dialog box for separately-priced options.

To access NetBackup licenses on a UNIX computer, use either the menu-driven
license utility (get_license_key.sh utility) or the bpminlicense command.

See the following topic for instructions:

Starting the NetBackup license utility on a UNIX computer

Accessing licenses for a NetBackup server
Use the following procedure to access licenses for a NetBackup server.

To access licenses for a NetBackup master or a media server

1 To view the licenses of the current server:

In the NetBackup Administration Console, select Help > License Keys.

2 Select the license details to view as follows:

Displays a summary of the active features that are licensed on this
server. This view lists each feature and the number of instances of
the feature that are licensed.

Summary of
active licensed
features
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Displays the details of the license keys that are registered on this
server.

This view lists the following:

■ Each license key
■ The server where the key is registered
■ When the key was registered
■ The features that the key provides

All registered
license keys
details

Adding NetBackup licenses
Use the following procedure to add NetBackup licenses to the selected server.

To add a license to a server

1 In the NetBackup Administration Console, select Help > License Keys.

2 Click New.

3 Enter the license key and click Add or OK.

If you added a license on a computer, restart all of the NetBackup utilities and
the NetBackup Administration Console.

4 Perform a manual catalog backup after the licenses are updated.

An immediate, manual catalog backup prevents stale licenses from being
restored in case a catalog restore is necessary before the next scheduled
catalog backup.

See “Backing up NetBackup catalogs manually” on page 940.

Printing NetBackup licenses
Use the following procedure to print the licenses that are installed on a NetBackup
server.

To print a list of NetBackup licenses

1 In the NetBackup Administration Console, select Help > License Keys.

2 Click Print.

Deleting NetBackup licenses
Use the following procedure to delete a license that is installed on a NetBackup
server.
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To delete a license

1 In the NetBackup Administration Console, select Help > License Keys.

2 Select the license that you want to delete from the license key list. If the key
has more than one feature, all of the features are listed in the dialog box.

3 Click Delete.

4 Click OK or Yes to delete the key and all of the features that are associated
with the key. The license key cannot be restored.

If you deleted a license, restart all of the NetBackup utilities and theNetBackup
Administration Console.

Viewing NetBackup license key properties
Use the following procedure to view the properties of a NetBackup license.

To view the properties of a NetBackup license

◆ In the NetBackup Administration Console, select Help > License Keys.

Double-click on a license.

Exporting NetBackup licenses
Use the following procedure to export NetBackup licenses.

To export NetBackup licenses

1 In the NetBackup Administration Console, select Help > License Keys.

2 Click Export.

3 Enter the path and the file name where you want all licenses to be exported.

4 Click Save.

Starting the NetBackup license utility on a UNIX computer
Use the following procedure to start the NetBackup license utility on a computer
running UNIX.

To start the NetBackup license utility on a computer running UNIX

1 From the command line, run
/usr/openv/netbackup/bin/admincmd/get_license_key

2 At the prompt, enter one of the following menu selections, then press Enter:

■ Type A to add a new license key, then type the license key at the prompt.

■ Type D to delete a license from the list, then type the license key at the
prompt.
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■ Type F to list only the licenses that are currently active. Expired licenses
do not appear in this listing. Specify a local or a remote host.

■ Type L to list all registered licenses—active or inactive. Specify a local or
a remote host.

■ Type H for help on the License Key Utility.

■ Type q to quit the utility.
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Configuring hosts

■ Chapter 3. Configuring Host Properties

■ Chapter 4. Configuring server groups

■ Chapter 5. Enabling support for NAT clients in NetBackup

■ Chapter 6. Configuring host credentials

■ Chapter 7. Managing media servers
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Configuring Host
Properties

This chapter includes the following topics:

■ About the NetBackup Host Properties

■ Access Control properties

■ Active Directory host properties

■ Bandwidth properties

■ Busy File Settings properties

■ Clean-up properties

■ Client Name properties

■ Client Attributes properties

■ Client Settings properties for UNIX clients

■ Client Settings properties for Windows clients

■ Cloud Storage properties

■ Credential Access properties

■ Data Classification properties

■ Default Job Priorities properties

■ Distributed application restore mapping properties

■ Encryption properties
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■ Enterprise Vault properties

■ Enterprise Vault Hosts properties

■ Exchange properties

■ Exclude Lists properties

■ Fibre Transport properties

■ Firewall properties

■ General Server properties

■ Global Attributes properties

■ Logging properties

■ Login Banner Configuration properties

■ Lotus Notes properties

■ Media properties

■ NDMP Global Credentials properties

■ Network properties

■ Network Settings properties

■ Port Ranges properties

■ Preferred Network properties

■ Resilient Network properties

■ Resource Limit properties

■ Restore Failover properties

■ Retention Periods properties

■ RHV Access Hosts properties

■ Scalable Storage properties

■ Servers properties

■ SharePoint properties

■ SLP Parameters properties

■ Throttle Bandwidth properties
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■ Timeouts properties

■ Universal Settings properties

■ User Account Settings properties

■ UNIX Client properties

■ VMware Access Hosts properties

■ Windows Client properties

■ Configuration options not found in the Host Properties

■ About using commands to change the configuration options on UNIX clients
and servers

■ Configuration options for NetBackup servers

■ Configuration options for NetBackup clients

About the NetBackup Host Properties
The configuration options within theHost Properties let an administrator customize
NetBackup tomeet specific site preferences and requirements. Some options cannot
be configured by using the NetBackup Administration Console.

See “Configuration options not found in the Host Properties” on page 250.

To change the properties of another client or server, the NetBackup server where
you logged on using the NetBackup Administration Console must be in the
Servers list on the other system.

See “Servers properties” on page 214.

See “Allow access to another server” on page 1170.

For example, if you logged on to server_1 using the NetBackup Administration
Console and want to change a setting on client_2, client_2 must include server_1
in its Servers list.

Methods to set the NetBackup configuration options
A NetBackup administrator can use one of the following methods to read or set the
default configuration options or to change those options that do not appear in the
Host Properties:
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Table 3-1 NetBackup Host Properties configuration methods

DescriptionMethod

Most properties are listed in the NetBackup Administration Console in the Host
Properties. To navigate to the various properties, select NetBackup Management >
Host Properties. Depending on the host to be configured, select Master Servers,
Media Servers, or Clients.

See “About the NetBackup Host Properties” on page 53.

NetBackup Administration
Console interface

Use the nbgetconfig command or bpgetconfig command to obtain a list of
configuration entries. Then use nbsetconfig or bpsetconfig to change the options
as needed.

These commands update the appropriate configuration files on bothWindows (registry)
and UNIX (bp.conf file) master servers and clients.

Use the nbemmcmd command to modify some options on hosts.

Detailed information on these commands is available in the NetBackup Commands
Reference Guide.

Command line

The vm.conf file contains configuration entries for media and device management.

See the NetBackup Administrator's Guide, Volume II for more information.

vm.conf file

Administrators can specify configuration options for NetBackup clients.

See the NetBackup Backup, Archive, and Restore Getting Started Guide.

Backup, Archive, and
Restore client interface

Connecting to a host to view the host properties
TheNetBackupAdministrationConsole displays properties for NetBackupmaster
servers, media servers, and clients under Host Properties.

Use the following procedure to connect to and to view the host properties of a
master server, a media server, or a client.

To connect to and view host properties of master server, media server, or
client

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties.

2 In the left pane, select Master Servers, Media Servers, or Clients.

3 In the right pane, perform one of the following to connect to a host:

■ Highlight the host by selecting the row. The host is connected to after
approximately 3 seconds.

■ Right-click a host and select Connect.
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Changing the host properties on multiple hosts at the same time
You can change the host properties for multiple hosts at one time. This can be done
by one of the following procedures:

■ Changing multiple hosts in the Host Properties

■ Changing multiple hosts in the Policies utility

Note: In a clustered environment, host properties must be made on each node of
the cluster separately.

Changing multiple hosts in the Host Properties
To change the properties on multiple hosts

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties.

2 Select Master Server, Media Server, or Clients.

3 In the right pane, select a host. Hold down the Shift key and select another
host.

4 With multiple hosts still selected, click Actions > Properties.

The properties dialog box displays the names of the selected hosts that will be
affected by the subsequent host property changes.

5 Make changes as necessary.

6 Click OK.

Changing multiple hosts in the Policies utility
To change the properties on multiple hosts from Summary of All Policies

1 In theNetBackup Administration Console, navigate to Policies > Summary
of All Policies in the middle pane.

2 Under Summary of All Policies, expand Clients.

3 In the right pane, hold down the Shift key to select multiple clients.

4 With multiple hosts still selected, right-click and select Host Properties.

5 Change the client properties in the dialog box.

6 Click OK.

Exporting host properties
Use the following procedure to export the properties of a host.
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To export the properties of a host

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Servers, Media Servers, or Clients.

2 Select a host. If you want to select multiple hosts, hold down the Shift key and
select another host.

3 Click File > Export.

4 In the Export dialog box, name the file, browse to the directory where you want
to save it, and click Save.

Access Control properties
NetBackup Access Control (NBAC) is the legacy access control method for
NetBackup and is no longer being updated. Veritas recommends that you use
role-based access control (RBAC) with the web UI. See the NetBackup Web UI for
Security Administrator's Guide.

Use theAccessControl host properties in theNetBackupAdministrationConsole
to configure NetBackup Authentication and Authorization. The properties apply to
currently selected master servers, media servers, and clients.

The NetBackup Product Authentication and Authorization property displays,
regardless of which tab is selected. It determines whether the local system uses
access control and how the system uses it.

The NetBackup Product Authentication and Authorization property contains
the following options.

Table 3-2 NetBackup Product Authentication and Authorization property
options

DescriptionOption

Specifies that the local system should accept requests only from the remote systems that use
NetBackup authentication and authorization. Connections from the remote systems that do not
use NetBackup authentication and authorization are rejected. Select Required if maximum
security is required.

Required

Specifies that the local system should reject connections from any remote system that uses
NetBackup authentication and authorization. Select Prohibited if the network is closed and
maximum performance is required.

Prohibited

Specifies that the local system should negotiate with the remote system about whether to use
NetBackup authentication and authorization. Select Automatic if the network contains mixed
versions of NetBackup.

Automatic
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For more information about controlling access to NetBackup, see the NetBackup
Security and Encryption Guide.

Authentication Domain tab of the Access Control properties
The Authentication Domain tab contains the properties that determine which
authentication broker a computer uses. A master server that uses NetBackup
authentication and authorization must have at least one authentication domain
entry.

If a media server or client does not define an authentication domain, it uses the
authentication domains of its master server.

The Authentication Domain tab on the Access Control dialog box contains the
following properties.

Table 3-3 Authentication Domain tab properties

DescriptionProperty

Select a broker, then click Find to list all of
the available authentication domains.

Available Brokers

List of available authentication domains.Available Authentication Domains list

Select the authentication domain(s) that this
host can use and click Add.

Add button

List of the authentication domains that are
selected for the host to use.

Selected Authentication Domains list

Select the authentication domain(s) that you
no longer want to use and click Remove.

Remove button

Authorization Service tab of the Access Control properties
The Authorization Service tab refers to the authorization service that the local
NetBackup server uses. The Authorization Service tab does not appear as a
property for clients.

The Authorization Service tab contains the following properties, which you can
configure for a master or a media server.

Table 3-4 Authorization Service property options

DescriptionOption

Specifies the host name or IP address of the authorization service.Host name
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Table 3-4 Authorization Service property options (continued)

DescriptionOption

Specifies a nonstandard port number. Select Customize the port
number and enter the port number of the authorization service.

Customize the port number of the
authorization service

Note: Define a host to perform authorization if you configure this tab for a media
server to use access control.

Network Attributes tab of the Access Control properties
The Network Attributes tab contains a list of networks that are allowed (or not
allowed) to use NetBackup authentication and authorization with the local system.

The Network Attributes tab on the Access Control dialog box contains the
following properties:

The Networks property indicates whether specific networks can or cannot use NetBackup
authentication and authorization with the local system. The names on the list are relevant
only if the NetBackup Product Authentication and Authorization property in the Access
Control dialog box is set to Automatic or Required.

Veritas recommends setting the master server NetBackup Product Authentication and
Authorization property toAutomatic until the clients are configured for access control. Then,
change theNetBackup Product Authentication and Authorization property on the master
server to Required.

If a media server or client does not define a NetBackup Authentication and Authorization
network, it uses the networks of its master server.

Networks

TheNetBackup Product Authentication and Authorization property in this tab determines
whether the selected network uses access control and how the network uses it.

See “Access Control properties” on page 56.

NetBackup Product
Authentication and
Authorization
property

Add Network dialog box
The Add Network dialog box contains the following properties.

Table 3-5 Add Network dialog box properties

DescriptionProperty

Indicates whether the network to be added is a Host name or a Domain name.Host/Domain
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Table 3-5 Add Network dialog box properties (continued)

DescriptionProperty

Specifies that if the network is a host, one of the following items must be entered:

■ The host name of the remote system. (host.domain.com)
■ The IP address of the remote system. (10.0.0.29)

Host Details

■ Domain Name/IP
Enter a dot that is followed by the Internet domain name of the remote systems. (.domain)
or the network of the remote system, followed by a dot. (10.0.0.)

■ If the domain is specified by IP, select one of the following items:
■ Bit count

Indicates that the mask is based on bit count. Select from between 1 and 32.
For example: Mask 192.168.10.10/16 has the same meaning as subnet mask
192.168.20.20:255:255:0.0

■ Subnet mask
Select to enter a subnet mask in the same format as the IP address.

Domain Details

Active Directory host properties
TheActive Directory properties in theNetBackup Administration Console apply
to the backup of currently selected Windows Server 2008 clients. The Active
Directory properties determine how the backups that allow Active Directory granular
restores are performed.

See “Creating a policy that allows Active Directory granular restores” on page 898.
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Figure 3-1 Active Directory dialog box

The Active Directory dialog box contains the following properties.

Table 3-6 Active Directory dialog box properties

DescriptionProperty

Checks snapshots for data corruption. Applies only to snapshots that
the Microsoft Volume Shadow Copy Services (VSS) performs.

If corrupt data is found and this option is not selected, the job fails.

See “Windows Open File Backup tab of the Client Attributes
properties” on page 78.

Perform consistency check before backup
when usingMicrosoft Volume ShadowCopy
Service snapshot provider

Continues the backup job even if the consistency check fails.

It may be preferable for the job to continue, even if the consistency
check fails. For example, a backup of the database in its current state
may be better than no backup at all. Or, it may be preferable for the
backup of a large database to continue if it encounters only a small
problem.

Continue with backup if consistency check
fails
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Bandwidth properties
Use theBandwidth properties to specify network bandwidth limits for the NetBackup
clients of the selected server.

Note: The Bandwidth properties apply only to IPv4 networks. Use the Throttle
Bandwidth properties to limit IPv6 networks.

See “Throttle Bandwidth properties” on page 236.

The actual limiting occurs on the client side of the backup connection. The bandwidth
limits only restrict bandwidth during backups. By default, the bandwidth is not limited.

The Bandwidth properties apply to currently selected master servers.

Figure 3-2 Bandwidth dialog box

To manage entries in theBandwidth dialog box, select one of the following buttons.

Adds an entry to the bandwidth table for each of the selected clients.Add
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Changes an entry to the bandwidth table for each of the selected
clients.

Change

Removes the selected entry from the bandwidth table.Remove

When a backup starts, NetBackup reads the bandwidth limit configuration as
configured in the Bandwidth host properties. NetBackup then determines the
appropriate bandwidth value and passes it to the client. NetBackup computes the
bandwidth for each new job based on the number of jobs that are currently running
for the IP range. NetBackup does not include local backups in its calculations.

The NetBackup client software enforces the bandwidth limit. Before a buffer is
written to the network, client software calculates the current value for kilobytes per
second and adjusts its transfer rate if necessary.

Bandwidth limit usage considerations and restrictions
Some usage restrictions apply to the bandwidth limit settings in the Bandwidth
dialog box. The following table lists the restrictions and describes the specific
behaviors that you may need to consider.

Table 3-7 Bandwidth limit usage considerations and restrictions

Bandwidth limit behavior or
restrictions

Client or operation

Bandwidth limit is meant primarily for file
system backups using Standard and
MS-Windows policies. It is not implemented
for most other policy and client types.

■ Standard
■ MS-Windows

If a server is also a client and data does not
go over the network, bandwidth limits have
no effect on local backups.

Local backups

Bandwidth limits restrict maximum network
usage and do not imply required bandwidth.
For example, if you set the bandwidth limit
for a client to 500 kilobytes per second, the
client can use up to that limit. It does not
mean, however, that the client requires 500
kilobytes per second.

Setting required bandwidth
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Table 3-7 Bandwidth limit usage considerations and restrictions (continued)

Bandwidth limit behavior or
restrictions

Client or operation

You cannot use bandwidth limits to distribute
the backup workload of active backups by
having NetBackup pick the most available
network segment. NetBackup does not pick
the next client to run based on any configured
bandwidth limits.

Distributing the workload of active backups

Add Bandwidth Settings dialog box for Bandwidth properties
The Add Bandwidth Settings and the Change Bandwidth Settings dialog boxes
contain the following properties.

Specifies the beginning of the IP address range of the
clients and networks to which the entry applies. For
example: 10.1.1.2

From Host

Specifies the end of the IP address range of the clients
and networks to which the entry applies. For example:
10.1.1.9

To Host

Specifies the bandwidth limitation in kilobytes per second.
A value of 0 disables the limits for an individual client or
the range of IP addresses covered by the entry. For
example, a value of 200 indicates 200 kilobytes per second.

Bandwidth (KB/Sec)

Busy File Settings properties
The Busy File Settings properties in the NetBackup Administration Console
apply to currently selected UNIX clients. The Busy File Settings properties define
what occurs when NetBackup encounters a busy file during a backup of a UNIX
client.
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Figure 3-3 Busy File Settings dialog box

The Busy File Settings dialog box contains the following properties.

Table 3-8 Busy File Settings dialog box properties

DescriptionProperty

Specifies the path to the busy-files working directory. On a UNIX client, the value in the
user’s $HOME/bp.conf file takes precedence if it exists. By default, NetBackup creates
the busy_files directory in the /usr/openv/netbackup directory.

Working directory

Specifies the recipient of the busy-file notification message when the action is set to Send
email. By default, the mail recipient is the administrator. On a UNIX client, the value in the
user’s $HOME/bp.conf file takes precedence if it exists. By default,
BUSY_FILE_NOTIFY_USER is not in any bp.conf file and the mail recipient is root.

Operator's email
address

Enables busy files to be processed according to the host property settings. NetBackup
follows the Busy File Settings if it determines that a file changes during a backup. By
default, Process busy files is not enabled and NetBackup does not process the busy files.

Additional information about busy file processing is available in the NetBackup
Administrator’s Guide, Volume II.

Process busy files
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Table 3-8 Busy File Settings dialog box properties (continued)

DescriptionProperty

Specifies the absolute path and file name of the busy file. The metacharacters *, ?, [], [ - ]
can be used for pattern matching of file names or parts of file names.

File action file list

Adds a new file entry. Enter the file and path directly, or browse to select a file.Add

Adds a new file entry for all of the clients currently selected. Enter the file and path directly,
or browse to select a file.

Add to All

Removes the selected file from the file action list.Remove

The following options specify which action to take when busy-file processing is enabled.
On a UNIX client, the value in the user’s $HOME/bp.conf file takes precedence if it exists.

■ Send email sends a busy sends a busy file notification message to the user that is
specified in Operator’s email address.

■ Retry the backup retries the backup on the specified busy file. The Retry count value
determines the number of times NetBackup tries a backup.

■ Ignore excludes the busy file from busy file processing. The file is backed up, then a
log entry that indicates it was busy appears in the All Log Entries report.

Busy file action

Specifies the number of times to try the backup. The default retry count is 1.Retry count

Activating the Busy File Settings in host properties
To activate the settings in the Busy File Settings host properties, use the following
procedure.

To activate Busy File Settings

1 Copy the bpend_notify_busy script:

/usr/openv/netbackup/bin/goodies/bpend_notify_busy

to the path:

/usr/openv/netbackup/bin/bpend_notify

2 Set the file access permissions to allow group and others to run bpend_notify.

3 Configure a policy with a user backup schedule for the busy file backups.

This policy services the backup requests that the repeat option in the actions
file generates. The policy name is significant. By default, NetBackup
alphabetically searches (uppercase characters first) for the first available policy
with a user backup schedule and an open backup window. For example, a
policy name of AAA_busy_files is selected ahead of B_policy.
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Clean-up properties
The Clean-up properties in the NetBackup Administration Console refer to the
retention of various logs and incomplete jobs. The Clean-up properties apply to
currently selected master servers.

Figure 3-4 Clean-up dialog box

The Clean-up dialog box contains the following properties.
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Table 3-9 Clean-up dialog box properties

DescriptionProperty

Specifies the number of days to keep true image restore information on disk.
After the specified number of days, the images are pruned (removed). Applies
to all policies for which NetBackup collects true image restore information.
The default is one day.

When NetBackup performs a true image backup, it stores the following
images on the backup media:

■ Backed up files
■ True image restore information

NetBackup also stores the true image restore information on disk in the
following directories:

On Windows:

install_path\NetBackup\db\images

On UNIX:

/usr/openv/netbackup/db/images

NetBackup retains the information for the number of days that this property
specifies.

Keeping the information on disk speeds up restores. If a user requests a
true image restore after the information was deleted from disk, NetBackup
retrieves the required information from the media. The only noticeable
difference to the user is a slight increase in total restore time. NetBackup
deletes the additional information from disk again after one day.

Keep true image restoration
information

Indicates the number of days that a failed restore job can remain in an
Incomplete state. After that time, the Activity Monitor shows the job as Done.
The default is 7 days. Themaximum setting is 365 days. If Checkpoint Restart
for restores is used, the Restore retries property allows a failed restore job
to be retried automatically.

See “Universal Settings properties” on page 241.

See “Checkpoint restart for restore jobs” on page 738.

Move restore job from incomplete
state to done state
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Table 3-9 Clean-up dialog box properties (continued)

DescriptionProperty

Indicates the maximum number of hours that a failed backup job can remain
in an incomplete state. After that time, the Activity Monitor shows the job as
Done. The minimum setting is 1 hour. The maximum setting is 72 hours.
The default is 3 hours.

When an active job has an error, the job goes into an Incomplete state. In
the Incomplete state, the administrator can correct the condition that caused
the error. If an Incomplete job does not complete successfully and is moved
to the Done state, the job retains the error status.

Note: A resumed job reuses the same job ID, but a restarted job receives
a new job ID. The job details indicate that the job was resumed or restarted.

Note: This property does not apply to suspended jobs. Suspended jobs
must be resumed manually before the retention period of the job is met and
the image expires. If a suspended job is resumed after the retention period
is met, the job fails and is moved to the Done state.

Move backup job from incomplete
state to done state

Specifies the maximum interval that can elapse before an image cleanup is
run. Image cleanup is run after every successful backup session (that is, a
session in which at least one backup runs successfully). If a backup session
exceeds this maximum interval, an image cleanup is initiated.

Image cleanup interval

Specifies the minimum interval that can elapse before an image cleanup is
run. Image cleanup is not run after a successful backup session until this
minimum interval has elapsed since the previous image cleanup.

Catalog cleanup wait time

Client Name properties
The Client name property in the NetBackup Administration Console specifies
the NetBackup client name for the selected client. The name must match the name
the policy uses to back up the client. The only exception is for a redirected restore,
where the name must match that of the client whose files are to be restored. The
client name is initially set during installation.

The name that is entered here must also match the client name in the Client
Attributes dialog box for the master server. If it does not match, the client cannot
browse for its own backups.

Note: Using an IPv6 address as a client name in a policy can cause backups to
fail. Specify a host name instead of an IPv6 address.
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See “Client Attributes properties” on page 69.

Figure 3-5 Client Name dialog box

If the value is not specified, NetBackup uses the name that is set in the following
locations:

■ For a Windows client
In the Network application from the Control Panel.

■ For a UNIX client
The name that is set by using the hostname command.
The name can also be added to a $HOME/bp.conf file on a UNIX client. However,
the name is normally added in this manner only for redirected restores. The
value in the $HOME/bp.conf file takes precedence if it exists.

Client Attributes properties
In theNetBackup Administration Console, theClient Attributes properties apply
to the clients of currently selected master servers.
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The Global client attributes property applies to all clients, unless overridden as
described in the following table.

Table 3-10 Global client attributes group box

DescriptionAttribute

Allows all clients to browse files for restoring. This attribute is overridden if
the Browse and restore ability option on the General tab is set to Deny
both for a particular client(s).

Allow client browse

Allows all clients to restore files. This attribute is overridden if the Browse
and restore ability option on the General tab is set to Allow browse only
or Deny both.

Allow client restore

Specifies the list of clients in the client database on the currently selected
master server(s). A client must be in the client database before you can
change the client properties in the Client Attributes dialog box.

The client database consists of directories and files in the following
directories:

Windows: install_path\NetBackup\db\client

UNIX: /usr/openv/netbackup/db/client

If a client is not listed in the Clients list, click Add to display the Add Client
dialog box and add a client to the client database. Enter a client name in the
text box or click the browse button (...) and select a client.

See “Add Client dialog box” on page 71.

The name that is entered here must match the Client Name property for the
specific client. If it does not match, the client cannot browse its own backups.

See “Client Name properties” on page 68.

Use the bpclient command to add clients to the client database if dynamic
addressing (DHCP) is in use.

Additional information about busy file processing is available in the NetBackup
Administrator’s Guide, Volume II.

On UNIX: You also can create, update, list, and delete client entries by using
the bpclient command that is located in the following directory:

/usr/openv/netbackup/bin/admincmd

Clients

Specifies how to configure the selected Windows master servers (clients).

See “General tab of the Client Attributes properties” on page 71.

General tab
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Table 3-10 Global client attributes group box (continued)

DescriptionAttribute

Specifies how to configure the connection between a NetBackup server and
a NetBackup client.

See “Connect Options tab of the Client Attributes properties” on page 76.

Connect Options tab

Specifies whether a client uses Windows Open File Backup. Also, specifies
whether Volume Snapshot Provider or Volume Shadow Copy Service
is used as the snapshot provider.

See “Windows Open File Backup tab of the Client Attributes properties”
on page 78.

Windows Open File Backup tab

Add Client dialog box
To add a client to the database, enter the name of a client, or browse to find a client.
The Add Client dialog box contains the following properties.

Specifies the name of the client to be added to the database.
Enter the name of the client to add.

Enter client name

Finds the list of current clients and displays them in the Browse
for computer window. Select the client to add to the database
and click Add.

... (browse)

Adds the specified client to the client database (client name
displays in the Clients window).

Add

Closes the Add Client dialog box.Close

Displays more information about how to add a client.Help

General tab of the Client Attributes properties
The properties on the General tab apply to selected Windows master servers. The
tab appears on the Client Attributes dialog box.
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Figure 3-6 General tab of Client Attributes dialog box

The General tab contains the following properties.
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Table 3-11 General tab properties

DescriptionProperty

Makes the specified clients in the General tab unavailable for backups until
the specified date and time. By default, clients are online and included in the
policies in which they are listed.

When Offline Backups until is selected for a client, no jobs are scheduled
for that client. Since the client is not part of any job, no backup status is listed
for the client.

If a client is taken offline, any job that includes the client and is already
running is allowed to complete.

If a backup or restore job is manually submitted for a client that is offline, the
Activity Monitor displays the job as failed with a status code 1000 (Client is
offline).

Note: Changes to this property do not appear in the audit report.

The ability to take clients offline is useful in a number of situations.

See “Offline option usage considerations and restrictions” on page 74.

Offline Backups until:

Makes the specified clients in the General tab unavailable for restores until
the specified date and time. By default, clients are online and available for
restore.

Offline Restores until:

Specifies the maximum number of jobs that are allowed at one time for each
selected client. (This value applies to the number of jobs on the client, even
if multistreaming is not used.)

To change the setting, select Maximum data streams. Then scroll to or
enter a value up to 99.

The Maximum data streams property interacts with Maximum jobs per
client and Limit jobs per policy as follows:

■ If the Maximum data streams property is not set, the limit is either the
one indicated by the Maximum jobs per client property or the Limit
jobs per policy property, whichever is lower.

■ If the Maximum data streams property is set, NetBackup ignores the
Maximum jobs per client property. NetBackup uses either Maximum
data streams or Limit jobs per policy, whichever is lower.
See “Global Attributes properties” on page 136.
See “Limit jobs per policy (policy attribute)” on page 739.

Maximum data streams

73Configuring Host Properties
Client Attributes properties



Table 3-11 General tab properties (continued)

DescriptionProperty

Specifies the client permissions to list and restore backups and archives.
Select the client(s) in the General tab of the Client Attributes dialog box
and choose a Browse and restore ability property.

To use the Global client attributes settings, select Use global settings.

■ To allow users on the selected clients to both browse and restore, select
Allow both.

■ To allow users on the selected clients to browse but not restore, select
Allow browse only.

■ To prevent users on the selected clients from the ability to browse or
restore, select Deny both.

Browse and restore ability

Specifies whether the clients can list and restore from scheduled backups.
(This setting does not affect user backups and archives.)

This property applies to the privileges that are allowed to a non-Windows
administrator or non-root user who is logged into the client. This property
also applies to the users that do not have backup and restore privileges.

Windows administrators and root users can list and restore from scheduled
backups as well as user backups regardless of the Free browse setting.

Free browse

Specifies the deduplication action for clients if you use the NetBackup Data
Protection Optimization Option.

For a description of the client-side deduplication options and their actions:

See “Where deduplication should occur” on page 75.

Deduplication

Offline option usage considerations and restrictions
The ability to take clients offline is useful in a number of situations. For example,
in the event of planned outages or maintenance, client systems can be taken offline
to avoid the unnecessary errors that administrators would then need to investigate.
This option can also be used to anticipate new clients in the system; listing them
in policies but configuring them as offline until they are in place and ready to be
used

The following actions can be performed if a client is offline.

Table 3-12 Offline option actions

Action or restrictionType of job or operation

Offline clients continue to be included in any job.A client is offline and the job is already in progress
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Table 3-12 Offline option actions (continued)

Action or restrictionType of job or operation

Job retries continue as normal.A client is offline and job retries were started before the
client was taken offline

Continues to run until complete.Any duplication job that is associated with a storage
lifecycle policy and an offline client

Can be run for offline clients.Restore jobs

The backup fails with a status code 1000 (Client is offline).
The user can either wait until the client is brought online
again or bring the client online manually. Use either the
NetBackup Administration Console or the bpclient
command to do so before resubmitting the manual job.

The user attempts a manual backup for an offline client

Not allowed for offline clients.Archive backups

Not allowed for offline clients.Administrators restarting or resuming jobs

Caution: If the master server is offline, hot catalog backups cannot run.

Where deduplication should occur
The Deduplication property specifies the deduplication action for clients if you use
either the NetBackup Data Protection Optimization Option. Table 3-13 describes
the client-side deduplication options.

The clients that deduplicate their own data and the master server must use the
same name to resolve the storage server. The name must be the host name under
which the NetBackup Deduplication Engine credentials were created. If they do not
use the same name, backups fail. In some environments, careful configuration may
be required to ensure that the client and the master server use the same name for
the storage server. Such environments include those that use VLAN tagging and
those that use multi-homed hosts.

NetBackup does not support the following for client-side deduplication:

■ Multiple copies per each job configured in a NetBackup backup policy. For the
jobs that specify multiple copies, the backup images are sent to the storage
server and may be deduplicated there.

■ NDMP hosts. The backup jobs fail if you try to use client-side deduplication for
NDMP hosts.
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Table 3-13 Client-side deduplication options

DescriptionOption

Always deduplicates the data on the media server. The default.

Jobs fail if one of the following is true:

■ The deduplication services on the storage server are inactive.
■ The deduplication pool is down.

Always use the media server (the
default)

Deduplicates the data on the client and then sends it directly to the storage
server.

NetBackup first determines if the storage server is active. If it is active, the
client deduplicates the backup data and sends it to the storage server to be
written to disk. If it is not active, the client sends the backup data to a media
server, which deduplicates the data.

Prefer to use client-side deduplication

Always deduplicates the backup data on the client and then sends it directly
to the storage server.

If a job fails, NetBackup does not retry the job.

Always use client-side deduplication

You can override the Prefer to use client-side deduplication or Always use
client-side deduplication host property in the backup policies.

See “Disable client-side deduplication (policy attribute)” on page 762.

More information about client deduplication is available in the NetBackup
Deduplication Guide.

Connect Options tab of the Client Attributes properties
The properties in the Connect Options tab describe how a NetBackup server
connects to NetBackup clients. The tab appears on the Client Attributes dialog
box.
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Figure 3-7 Connect Options tab of Client Attributes dialog box

The Connect Options tab contains the following options.

Table 3-14 Connect Options tab properties

DescriptionProperty

Specifies how daemons are to connect back to the NetBackup Client daemon
(BPCD) and contains the following options:

■ Use default connect options
Uses the value that is defined in the Firewall host properties of the client’s
NetBackup server.
See “Firewall properties” on page 128.

■ Random port
NetBackup randomly chooses a free port in the allowed range to perform the
legacy connect-back method.

■ VNETD port
NetBackup uses the vnetd port number for the connect-back method.

BPCD connect back
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Table 3-14 Connect Options tab properties (continued)

DescriptionProperty

Specifies the method that the selected clients should use to connect to the server
and contains the following options:

■ Use default connect options
Uses the value that is defined in the Firewall host properties of the client’s
NetBackup server.
See “Firewall properties” on page 128.

■ Reserved port
Uses a reserved port number.

■ Non-reserved port
Uses a non-reserved port number.

Ports

Specifies the method that the selected clients should use to connect to the server
and contains the following options.

■ Use default connect options
Uses the value that is defined in the Firewall host properties of the client’s
NetBackup server.

■ Automatic
Connects to the daemons on the server using vnetd if possible. If the daemons
cannot use vnetd, the connection is made by using the daemon’s legacy port
number.

■ VNETD only
Connects to the daemons on the server by using only vnetd. If the firewall
rules prevent a server connection using the legacy port number, check this
option.
When selected, the BPCD connect back setting is not applicable.
In addition, the Ports setting usesNon-reserved port, regardless of the value
selected.

■ Daemon port only
Connects to the daemons on the server by using only the legacy port number.
This option only affects connections to NetBackup 7.0 and earlier. For
connections to NetBackup 7.0.1 and later, the veritas_pbx port is used.

■ See “Resilient Network properties” on page 192.

Daemon connection port

Windows Open File Backup tab of the Client Attributes properties
TheWindows Open File Backup properties in the NetBackup Administration
Console specify whether a client uses Windows Open File Backup. The properties
also specify whether Volume Snapshot Provider or Volume Shadow Copy
Service is used as the snapshot provider.
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Snapshots are a point-in-time view of a source volume. NetBackup uses snapshots
to access busy or active files during a backup job. Without a snapshot provider,
active files are not accessible for backup.

Figure 3-8 Windows Open File Backup tab of Client Attributes dialog box

TheWindows Open File Backup tab contains the following options.
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Table 3-15 Windows Open File Backup tab properties

DescriptionProperty

Adds the NetBackup clients only if you want to change the default settings on theWindows
Open File Backup tab.

By default, no clients are listed in the Client Attributes dialog box. The server uses the
following Windows Open File Backup defaults for all Windows clients:

■ Windows Open File Backup is enabled on the client.
■ Microsoft Volume Shadow Copy Service (VSS) is used for NetBackup 7.0 clients.

See “Back-level and upgraded clients that use Windows Open File Backup” on page 83.
■ Snapshots are taken of individual drives (Individual drive snapshot) as opposed to all

drives at once (Global drive snapshot).
■ Upon error, the snapshot is terminated (Abort backup on error).

Add

Deletes a client from the list by selecting the client and then clicking Delete.Remove

Specifies that Windows Open File Backups be used for the selected clients. Adds the clients
to the list only if you want to change the default property settings.

For Microsoft Distributed File System Replication (DFSR) servers, select Enable Windows
Open File Backups. The Snapshot Provider must be Volume Shadow Copy Service.

See “About Microsoft DFSR backups” on page 714.

This option functions independently from the Perform Snapshot backups policy option
that is available when the Snapshot Client is licensed.

If a client is included in a policy that has the Perform Snapshot backups policy option
disabled and you do not want snapshots, the Enable Windows Open File Backups for
this client property must be disabled as well for the client. If both options are not disabled,
a snapshot is created, though that may not be the intention of the administrator.

For more information, see the NetBackup Snapshot Client Administrator’s Guide.

EnableWindowsOpen
File Backups

80Configuring Host Properties
Client Attributes properties

http://www.veritas.com/docs/DOC5332


Table 3-15 Windows Open File Backup tab properties (continued)

DescriptionProperty

Note: This option is used for back-level versions of NetBackup only. Support for theWindows
versions that are listed here has ended.

Selects the snapshot provider for the selected clients:

■ Use Veritas Volume Snapshot Provider (VSP)
This option specifies that Veritas VSP be used as the snapshot provider.

■ Use Microsoft Volume Shadow Copy Service (VSS)
This option specifies thatMicrosoft VSS be used to create volume snapshots of volumes
and logical drives for the selected clients.
Configure VSS through the Microsoft VSS configuration dialog boxes.
For information about how to do Active Directory granular restores when using VSS, see
the following topic:
See “Active Directory host properties” on page 59.
For Microsoft Distributed File System Replication (DFSR) servers, selectUseMicrosoft
Volume Shadow Copy Service (VSS).
See “About Microsoft DFSR backups” on page 714.

Snapshot Provider
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Table 3-15 Windows Open File Backup tab properties (continued)

DescriptionProperty

Selects how snapshots are made for the selected clients:

■ Individual drive snapshot
Specifies that the snapshot should be of an individual drive (default). When this property
is enabled, snapshot creation and file backup are done sequentially on a per volume
basis. For example, assume that drives C and D are to be backed up.
If the Individual drive snapshot property is selected, NetBackup takes a snapshot of
drive C, backs it up, and discards the snapshot. It then takes a snapshot of drive D,
backs it up, and discards the snapshot.
Volume snapshots are enabled on only one drive at a time, depending on which drive
is to be backed up. This mode is useful when relationships do not have to be maintained
between files on the different drives.
Use this configuration if snapshot creation fails when all volumes for the backup are
snapshot at once when the Global drive snapshot property is enabled. Individual drive
snapshot is enabled by default for all non-multistreamed backups by using the Windows
Open File Backup option.

■ Global drive snapshot
Specifies that the snapshot is of a global drive. All the volumes that require snapshots
for the backup job (or stream group for multistreamed backups) are taken at one time.
For example, assume that drives C and D are to be backed up.
In this situation, NetBackup takes a snapshot of C and D. Then NetBackup backs up
Cand backs up D.
NetBackup then discards the C and D snapshots.
This property maintains file consistency between files in different volumes. The backup
uses the same snapshot that is taken at a point in time for all volumes in the backup.

Note: The Individual drive snapshot property and theGlobal drive snapshot property
only apply to non-multistreamed backups that use Windows Open File Backup. All
multistreamed backup jobs share the same volumes snapshots for the volumes in the
multistreamed policy. The volume snapshots are taken in a global fashion.

Snapshot usage
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Table 3-15 Windows Open File Backup tab properties (continued)

DescriptionProperty

Selects the processing instructions that NetBackup should follow if it encounters an error
during processing:

■ Abort backup on error
Specifies that a backup aborts if it fails for a snapshot-related issue after the snapshot
is created and while the backup uses the snapshot to back up open or active files on the
file system.
The most common reason for a problem after the snapshot is created and is in use by
a backup, is that the cache storage is full. If the Abort backup on error property is
checked (default), the backup job aborts with a snapshot error status if the backup detects
a snapshot issue.
This property does not apply to successful snapshot creation. The backup job continues
regardless of whether a snapshot was successfully created for the backup job. TheAbort
backup on error property applies only to the snapshot errors that occur after the snapshot
is successfully created and is in use by a backup job.

■ Disable snapshot and continue
Specifies that if the snapshot becomes invalid during a backup, the volume snapshots
for the backup are destroyed. The backup continues with Windows open file backups
disabled.
Regarding the file that had a problem during a backup—it may be that the file was not
backed up by the backup job. The file may not be able to be restored.

Note: Volume snapshots typically become invalid during the course of a backup because
insufficient cache storage was allocated for the volume snapshot. Reconfigure the cache
storage configuration of the Windows Open File Backup snapshot provider to a
configuration that best suits your client’s installation.

Snapshot error control

Back-level and upgraded clients that useWindows Open File Backup
The following table shows the expected Open File Backup behavior based on the
client version and the Snapshot Provider setting.

Table 3-16 Snapshot Provider behavior for clients in a 7.x environment

BehaviorSnapshot Provider
setting

Client
version

Using VSS for Open File Backup is the default behavior in 7.x.Windows VSS

(7.0 default setting)

7.x
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Table 3-16 Snapshot Provider behavior for clients in a 7.x environment
(continued)

BehaviorSnapshot Provider
setting

Client
version

Even if Veritas VSP is indicated, Windows VSS is used for Open File Backup.

For upgraded clients:

■ For 6.x clients that used VSP and have been upgraded to 7.0:
VSP settings are ignored and VSS snapshots are automatically
implemented.

■ For 6.x VSS users:
You do not need to create a Client Attribute entry to enable VSS. VSS
is the only snapshot provider available to the NetBackup 7.0 Windows
client.

Veritas VSP7.x

Windows VSS is used for Open File Backup.Windows VSS7.x

Client Settings properties for UNIX clients
The UNIX Client Settings properties in the NetBackup Administration Console
apply to currently selected NetBackup clients running on the UNIX platform.
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Figure 3-9 Client Settings (UNIX) dialog box

The UNIX Client Settings dialog box contains the following properties.

Table 3-17 UNIX Client Settings dialog box properties

DescriptionProperty

Determines what happens when NetBackup tries to back up a file with mandatory
file locking enabled in its file mode.

Select one of the following options:

■ Wait
By default, NetBackup waits for files to become unlocked. If the wait exceeds
theClient read timeout host property that is configured on the master server,
the backup fails with a status 41.
See “Timeouts properties” on page 238.

■ Skip
NetBackup skips the files that currently havemandatory locking set by another
process. A message is logged if it was necessary to skip a file.

Locked file action
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Table 3-17 UNIX Client Settings dialog box properties (continued)

DescriptionProperty

Specifies the number of days to keep progress reports before the reports are
deleted. The default is 3 days. The minimum is 0. The maximum is 9,999 days.

Logs for user-directed operations are stored on the client system in the following
directory:

install_path\NetBackup\logs\user_ops\loginID\logs

Keep status of user-directed
backups, archives, and restores

Specifies that the access time (atime) for a file displays the backup time. By
default, NetBackup preserves the access time by resetting it to the value it had
before the backup.

Note: This setting affects the software and the administration scripts that
examine a file’s access time.

Note: If NetBackup Accelerator is used to perform the backup, this setting is
ignored. Accelerator does not record and reset the atime for the files that it
backs up.

See “Accelerator notes and requirements” on page 767.

Reset file access time to the value
before backup

Specifies the amount of memory available on the client when files are
compressed during backup. If you select compression, the client software uses
this value to determine how much space to request for the compression tables.
The more memory that is available to compress code, the greater the
compression and the greater the percentage of computer resources that are
used. If other processes also need memory, use a maximum value of half the
actual physical memory on a computer to avoid excessive swapping.

The default is 0. This default is reasonable; change it only if problems are
encountered.

Megabytes of memory to use for
file compression

Determines if NetBackup uses the File Change Log on VxFS clients.

The default is off.

See “VxFS file change log for incremental backups property” on page 87.

Use VxFS file change log for
incremental backups

For additional information, see the NetBackup Snapshot Client Administrator’s
Guide.

Default cache device path for
snapshots
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Table 3-17 UNIX Client Settings dialog box properties (continued)

DescriptionProperty

Corresponds to adding a COMPRESS_SUFFIX =.suffix option to the bp.conf
file.

Specifies a list of file extensions. During a backup, NetBackup does not compress
files with these extensions because the file may already be in a compressed
format.

Do not use wildcards to specify these extensions. For example, .A1 is allowed,
but not .A* or .A[1-9]

Files that are already compressed become slightly larger if compressed again.
If compressed files with a unique file extension already exist on a UNIX client,
exclude it from compression by adding it to this list.

Do not compress files endingwith
list

Adds file endings to the list of file endings that you do not want to compress.
Click Add, then type the file extension in the File Endings dialog box. Use
commas or spaces to separate file endings if more than one is added. Click
Add to add the ending to the list, then click Close to close the dialog box.

Add

Adds a file extension that you do not want to compress, to the lists of all clients.
To add the file extension to the lists of all clients, select it in the list on the Client
Settings host property, then click Add to All.

Add to All

Removes a file extension from the list. To remove a name, either type it in the
box or click the browse button (...) and select a file ending. Use commas or
spaces to separate names.

Remove

VxFS file change log for incremental backups property
The Use VxFS file change log for incremental backups property is supported
on all platforms and versions where VxFS file systems support FCL.

The following VxFS file systems support FCL:

■ Solaris SPARC platform running VxFS 4.1 or later.

■ AIX running VxFS 5.0 or later.

■ HP 11.23 running VxFS 5.0 or later.

■ Linux running VxFS 4.1 or later.

The File Change Log (FCL) tracks changes to files and directories in a file system.
Changes can include files created, links and unlinks, files renamed, data that is
appended, data that is overwritten, data that is truncated, extended attribute
modifications, holes punched, and file property updates.
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NetBackup can use the FCL to determine which files to select for incremental
backups, which can potentially save unnecessary file system processing time. The
FCL information that is stored on each client includes the backup type, the FCL
offset, and the timestamp for each backup.

The advantages of this property depend largely on the number of file system changes
relative to the file system size. The performance impact of incremental backups
ranges from many times faster or slower, depending on file system size and use
patterns.

For example, enable this property for a client on a very large file system that
experiences relatively few changes. The incremental backups for the client may
complete sooner since the policy needs to read only the FCL to determine what
needs to be backed up on the client.

If a file experiences many changes or multiple changes to many files, the time
saving benefit may not be as great.

See “Backup Selections tab” on page 841.

The following items must be in place for the Use VxFS file change log for
incremental backups property to work:

■ Enable the Use VxFS file change log for incremental backups property for
every client that wants NetBackup to take advantage of the FCL.

■ Enable the FCL on the VxFS client.
See the Veritas File System Administrator’s Guide for information about how to
enable the FCL on the VxFS client.

■ Enable the Use VxFS file change log for incremental backups property on
the client(s) in time for the first full backup. Subsequent incremental backups
need this full backup to stay synchronized.

■ Specify the VxFS mount point in the policy backup selections list in one of the
following ways:

■ Specify ALL_LOCAL_DRIVES.

■ Specifying the actual VxFS mount point.

■ Specifying a directory at a higher level than the VxFS mount point, provided
that Cross mount points is enabled.
See “Cross mount points (policy attribute)” on page 746.

If the policy has Collect true image restore information or Collect true image
restore information with move detection enabled, it ignores the Use VxFS file
change log for incremental backups property on the client.

The following table describes the additional options that are available on the VxFS
file change log feature.
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Table 3-18 VxFS file change log feature options

DescriptionOption

Displays any messages that note when the file change log
is used during a backup as follows:

Using VxFS File Change Log for backup of pathname

Also notes when full and incremental backups are not
synchronized.

Activity Monitor messages

The data files must be in sync with the FCL for this property
to work. To keep the data files synchronized with the FCL,
do not turn the FCL on the VxFS client off and on.

Note: If NetBackup encounters any errors as it processes
the FCL, it switches to the normal files system scan. If this
switch occurs, it appears in the Activity Monitor.

Keeping the data files
synchronized with the FCL

Additional VxFS commands are available to administrate the
FCL in the Veritas File System Administrator’s Guide.

VxFS administration

Client Settings properties for Windows clients
The Windows Client Settings properties apply to currently selected Windows
clients.
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Figure 3-10 Windows Client Settings dialog box

TheClient Settings dialog box forWindows clients contains the following properties.

Table 3-19 Windows Client Settings properties

DescriptionProperty

Enables logs for bpinetd, bpbkar, tar, and nbwin. The higher the level, the
more information is written. The default is 0.

General level

Enables logs for TCP.

Scroll to one of the following available log levels:

■ 0 No extra logging (default)
■ 1 Log basic TCP/IP functions
■ 2 Log all TCP/IP functions, including all read and write requests
■ 3 Log contents of each read or write buffer

Note: Setting the TCP level to 2 or 3 can cause the status reports to be very
large. It can also slow a backup or restore operation.

TCP level
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Table 3-19 Windows Client Settings properties (continued)

DescriptionProperty

Specifies how long the client waits before the archive bits for a differential
incremental backup are cleared. The minimum allowable value is 300 (default).
The client waits for acknowledgment from the server that the backup was
successful. If the server does not reply within this time period, the archive bits are
not cleared.

This option applies only to differential-incremental backups. Cumulative-incremental
backups do not clear the archive bit.

Wait time before clearing archive
bit

Note: The Use Change Journal option applies to Windows clients only.

This option works together with the Use Accelerator policy attribute and the
Accelerator forced rescan schedule attribute.

See “Accelerator and the Windows change journal” on page 766.

See “Use Accelerator (policy attribute)” on page 763.

See “Accelerator forced rescan option (schedule attribute)” on page 801.

Use change journal

Specifies that files are selected for the backups that are based on the date that
the file was last modified. When Use change journal is selected, Incrementals
based on timestamp is automatically selected.

Incrementals based on
timestamp

Specifies that NetBackup include files in an incremental backup only if the archive
bit of the file is set. The system sets this bit whenever a file is changed and it
normally remains set until NetBackup clears it.

A full backup always clears the archive bit. A differential-incremental backup clears
the archive bit if the file is successfully backed up. The differential-incremental
backup must occur within the number of seconds that theWait time before
clearing archive bit property indicates. A cumulative-incremental or user backup
has no effect on the archive bit.

Disable this property to include a file in an incremental backup only if the date
and time stamp for the file has changed since the last backup. For a
differential-incremental backup, NetBackup compares the date/time stamp to the
last full or incremental backup. For a cumulative-incremental backup, NetBackup
compares the timestamp to the last full backup.

If you install or copy files from another computer, the new files retain the date
timestamp of the originals. If the original date is before the last backup date on
this computer, then the new files are not backed up until the next full backup.

Note: Veritas recommends that you do not combine differential incremental
backups and cumulative incremental backups within the same Windows policy
when the incremental backups are based on archive bit.

Incrementals based on archive
bit
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Table 3-19 Windows Client Settings properties (continued)

DescriptionProperty

Specifies the number of minutes to add to the date range for incremental backups
when you use date-based backups. This value compensates for differences in
the speed of the clock between the NetBackup client and server. The default is
60 minutes.

This value is used during incremental backups when you use the archive bit and
when you examine the create time on folders. This comparison is done for archive
bit-based backups as well as date-based backups.

Time overlap

Specifies the size (in kilobytes) of the TCP and the IP buffers that NetBackup
uses to transfer data between the NetBackup server and client. For example,
specify 10 for a buffer size of 10 kilobytes. The minimum allowable value is 2,
with no maximum allowable value. The default is 128 kilobytes.

Communications buffer size

Specifies the seconds that are allowed between when a user requests a backup
or restore and when the operation begins. The operation fails if it does not begin
within this time period.

This property has nominimum value or maximum value. The default is 60 seconds.

User directed timeouts

Defines how many times a NetBackup client can send the same error message
to a NetBackup server. For example, if the archive bits cannot be reset on a file,
this property limits how many times the message appears in the server logs. The
default is 10.

Maximum error messages for
server

Specifies how many days the system keeps progress reports before NetBackup
automatically deletes them. The default is 3 days.

Keep status of user-directed
backups, archives, and restores

Instructs NetBackup to search the default range of backup images automatically.
The backed up folders and files within the range appear whenever a restore
window is opened.

Clear the Perform default search for restore check box to disable the initial
search. With the property disabled, the NetBackup Restore window does not
display any files or folders upon opening. The default is that the option is enabled.

Perform default search for
restore

How to determine if change journal support is useful in your
NetBackup environment

Using NetBackup support for the change journal is beneficial only where the volumes
are large and relatively static.

Suitable candidates for enabling NetBackup change journal support are as follows:

■ If the NTFS volume contains more than 1,000,000 files and folders and the
number of changed objects between incremental backups is small (less than
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100,000), the volume is a good candidate for enabling NetBackup change journal
support.

Unsuitable candidates for enabling NetBackup change journal support are as follows:

■ Support for the change journal is intended to reduce scan times for incremental
backups by using the information that is gathered from the change journal on a
volume. Therefore, to enable NetBackup change journal support is not
recommended if the file system on the volume contains relatively few files and
folders. (For example, hundreds of thousands of files and folders.) The normal
file system scan is suitable under such conditions.

■ If the total number of changes on a volume exceeds from 10% to 20% of the
total objects, the volume is not a good candidate for enabling NetBackup change
journal support.

■ Be aware that virus scanning software can interfere with the use of the change
journal. Some real-time virus scanners intercept a file open for read, scan for
viruses, then reset the access time. This results in the creation of a change
journal entry for every scanned file.

Guidelines for enabling NetBackup change journal support
The following items are guidelines to consider for enabling NetBackup change
journal support:

■ Change journal support is not offered for user-directed backups. The USN
stamps for full and incremental backups in the permanent record do not change.

■ NetBackup support for change journal works with checkpoint restart for restores.
See “Checkpoint restart for restore jobs” on page 738.

■ Support for change journal is not offered with several NetBackup options or
Veritas products.

If Use change journal is enabled, it has no effect while you use the following
options or products:

■ True image restore (TIR) or True image restore with Move Detection
See “Collect true image restore information (policy attribute) with and without
move detection” on page 754.

■ Synthetic backups
See “About synthetic backups” on page 904.

■ Bare Metal Restore (BMR)
For more information, see the NetBackup Bare Metal Restore Administrator’s
Guide.
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See “How to determine if change journal support is useful in your NetBackup
environment” on page 92.

Cloud Storage properties
The NetBackup Cloud Storage properties in the NetBackup Administration
Console apply to the currently selected master server.

The hosts that appear in this Cloud Storage list are available to select when you
configure a storage server. The Service Provider type of your cloud vendor
determines whether a service host is available or required.

NetBackup includes service hosts for some cloud storage providers. You can add
a new host to the Cloud Storage list if the Service Provider type allows it. If you
add a host, you also can change its properties or delete it from the Cloud Storage
list. (You cannot change or delete the information that is included with NetBackup.)

If you do not add a service host to this Cloud Storage list, you can add one when
you configure the storage server. The Service Provider type of your cloud vendor
determines whether a Service Hostname is available or required.
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Figure 3-11 Cloud Storage host properties

Cloud Storage host properties contain the following properties:

Table 3-20 Cloud Storage

DescriptionProperty

The cloud storage that corresponds to the various cloud service
providers that NetBackup supports are listed here.

To add a cloud storage to the Cloud Storage list, click Add.

To change properties of a cloud storage that you added, select it
in the Cloud Storage list and click Change.

To remove a cloud storage that you added, select it in the Cloud
Storage list and click Remove.

Cloud Storage

The cloud storage servers that correspond to the selected cloud
storage are displayed.

To change the properties of a cloud storage server, select it in the
Associated Storage Servers for list and click Change.

Associated Storage
Servers for
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Note: Changes that you make in the Cloud Storage dialog box are applied before
you click OK in the Host Properties dialog box.

For more information about NetBackup cloud storage, see the NetBackup Cloud
Administrator's Guide:

■ http://www.veritas.com/docs/DOC5332

Credential Access properties
Certain NetBackup hosts that are not named as clients in a policy must be enabled
to access NDMP or disk array credentials. Use the Credential Access properties
dialog box to enter the names of those NetBackup hosts.

Figure 3-12 Credential Access dialog box

The Credential Access dialog box contains the following properties.
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Table 3-21 Credential Access dialog box properties

DescriptionProperty

To add an NDMP client to the NDMP Clients list, click Add. Enter the names of the
NDMP hosts that are not named as clients in a policy.

NDMP Clients list

To add a Disk Client to the Disk Clients list, click Add. Enter the names of the
NetBackup hosts that meet all of the following criteria:

■ The host must be designated in a policy as the Off-host backup host in an alternate
client backup.

■ The host that is designated as the Off-host backup computer must not be named
as a client on the Clients tab in any NetBackup policy.

■ The policy for the off-host backup must be configured to use one of the disk array
snapshot methods for the EMC CLARiiON, HP EVA, or IBM disk arrays

Note: The credentials for the disk array or NDMP host are specified under Media
and Device Management > Credentials.

Note: Off-host alternate client backup is a feature of NetBackup Snapshot Client,
which requires a separate license. The NetBackup for NDMP feature requires the
NetBackup for NDMP license.

Disk clients list

Data Classification properties
The Data Classification properties apply to currently selected master and media
servers.

Data classifications must be configured in the Data Classification host properties
before storage lifecycle policies can be configured.

See “Data classifications (policy attribute)” on page 731.
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Figure 3-13 Data Classification dialog box

The Data Classification dialog box contains the following properties.
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Table 3-22 Data Classification dialog box properties

DescriptionProperty

The Rank column displays the rank of the data classifications. The order of the data
classifications determines the rank of the classification in relationship to the others in
the list. The lowest numbered rank has the highest priority.

Use the Move Up and Move Down options to move the classification up or down in
the list.

To create a new data classification, click New. New data classifications are added to
bottom of the list. To increase the rank of a data classification, select a line and click
Move Up. To decrease the rank of a data classification, select a line and click Move
Down.

Rank column

The Name column displays the data classification name. While data classifications
cannot be deleted, the data classification names can be modified.

NetBackup provides the following data classifications by default:

■ Platinum (highest rank by default)
■ Gold (second highest rank by default)
■ Silver (third highest rank by default)
■ Bronze (lowest rank by default)

Name column

In the Description column, enter a meaningful description for the data classification.
Descriptions can be modified.

Description column

The Data Classification ID is the GUID value that identifies the data classification and
is generated when a new data classification is added and the host property is saved.
This column is not displayed by default.

A data classification ID becomes associated with a backup image by setting the Data
Classification attribute in the policy dialog box. The ID is written into the image header.
The storage lifecycle policies use the ID to identify the images that are associated with
classification.

ID values can exist in image headers indefinitely, so data classifications cannot be
deleted. The name, description, and rank can change without changing the identity of
the data classification.

Data Classification ID

Note: Data classifications cannot be deleted. However, the name, description, and
the rank can be changed. The classification ID remains the same.

Creating a Data Classification
Use the following procedures to create or change a data classification.
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To create a data classification

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties.

2 In the left pane, click Data Classification.

3 Click New.

4 Add the name and description in the New Data Classification dialog box.

5 Click OK to save the classification and close the dialog box.

Note: Data classifications cannot be deleted.

6 Select a line in the Data Classification host properties and use the Move Up
andMove Down options to move the classification level up or down in the list.

Default Job Priorities properties
The Default Job Priorities host properties let administrators configure the default
job priority for different job types. The Default Job Priorities host property lists the
job types and the configurable default priority for each.
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Figure 3-14 Default Job Priorities dialog box

The job priority can be set for individual jobs in the following utilities:

■ In the Jobs tab of the Activity Monitor for queued or active jobs.
See “Changing the JobPriority dynamically from theActivityMonitor” on page 1105.

■ In the Catalog utility for verify, duplicate, and import jobs.

■ In the Reports utility for a Media Contents report job.

■ In the Backup, Archive, and Restore client interface for restore jobs.

The Default Job Priorities dialog box contains the following properties.

Table 3-23 Default Job Priorities dialog box properties

DescriptionProperty

This listing includes 18 job types and the current configurable priority for each.Job Type and Job Priority list
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Table 3-23 Default Job Priorities dialog box properties (continued)

DescriptionProperty

The Job Priority value specifies the priority that a job has as it competes with other
jobs for backup resources. The value can range from 0 to 99999. The higher the number,
the greater the priority of the job.

A new priority setting affects all the policies that are created after the host property has
been changed.

A higher priority does not guarantee that a job receives resources before a job with a
lower priority. NetBackup evaluates jobs with a higher priority before those with a lower
priority.

However, the following factors can cause a job with a lower priority to run before a job
with a higher priority:

■ To maximize drive use, a low priority job may run first if it can use a drive that is
currently loaded. A job with a higher priority that requires that the drive be unloaded
would wait.

■ If a low priority job can join a multiplexed group, it may run first. The job with a
higher priority may wait if it is not able to join the multiplexed group.

■ If the NetBackup Resource Broker (nbrb) receives a job request during an
evaluation cycle, it does not consider the job until the next cycle, regardless of the
job priority.

Job Priority

Understanding the Job Priority setting
NetBackup uses the Job Priority setting as a guide. Requests with a higher priority
do not always receive resources before a request with a lower priority.

The NetBackup Resource Broker (NBRB) maintains resource requests for jobs in
a queue.

NBRB evaluates the requests sequentially and sorts them based on the following
criteria:

■ The request's first priority.

■ The request’s second priority.

■ The birth time (when the Resource Broker receives the request).

The first priority is weighted more heavily than the second priority, and the second
priority is weighted more heavily than the birth time.

Because a request with a higher priority is listed in the queue before a request with
a lower priority, the request with a higher priority is evaluated first. Even though the
chances are greater that the higher priority request receives resources first, it is
not always definite.
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The following scenarios present situations in which a request with a lower priority
may receive resources before a request with a higher priority:

■ A higher priority job needs to unload the media in a drive because the retention
level (or the media pool) of the loaded media is not what the job requires. A
lower priority job can use the media that is already loaded in the drive. To
maximize drive utilization, the Resource Broker gives the loaded media and
drive pair to the job with the lower priority.

■ A higher priority job is not eligible to join an existing multiplexing group but a
lower priority job is eligible to join the multiplexing group. To continue spinning
the drive at the maximum rate, the lower priority job joins the multiplexing group
and runs.

■ TheResource Broker receives resource requests for jobs and places the requests
in a queue before processing them. New resource requests are sorted and
evaluated every 5 minutes. Some external events (a new resource request or
a resource release, for example) can also trigger an evaluation. If the Resource
Broker receives a request of any priority while it processes requests in an
evaluation cycle, the request is not evaluated until the next evaluation cycle
starts.

Distributed application restoremapping properties
Some applications, such as SharePoint, Exchange, and SQL Server distribute and
replicate data across multiple hosts. Or, the configuration includes a cluster where
communication occurs across multiple nodes. Use the Distributed Application
Restore Mapping to provide a mapping of the hosts in the database environment
so that NetBackup can successfully restore the databases. See the administrator's
guide for the database agent for more details.

For example, for a SharePoint farm, assume that the farm has two application
servers (App1 and App2), one front-end server (FE1) and one SQL database
(SQLDB1). The Distributed Application Restore Mapping for this SharePoint server
would be as following follows:

Component hostApplication host

SQLDB1App1

SQLDB1App2

SQLDB1FE1

The Distributed Application Restore Mapping dialog box contains the following
properties.
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Table 3-24 Distributed Application Restore Mapping dialog box properties

DescriptionProperty

Adds a component host that is authorized to run restores on a SharePoint, Exchange,
or SQL Server application host.

For SharePoint, NetBackup catalogs backup images under the front-end server name.
To allow NetBackup to restore SQL Server back-end databases to the correct hosts
in a farm, provide a list of the SharePoint hosts.

For Exchange, any operations that use Granular Recovery Technology (GRT) require
that you provide a list of the Exchange virtual and the physical host names. Also include
the off-host client and the granular proxy host.

For SQL Server, this configuration is required for restores of a SQL Server cluster or
a SQL Server availability group (AG).

Note: For VMware backups and restores that protect SharePoint, Exchange, or SQL
Server, you only need to add the hosts that browse for backups or perform restores.
You also must configure a mapping if you use a Primary VM Identifier other than VM
hostname. See the administrator's guide for the database agent for more details.

Note: Use either the client's short name or its fully qualified domain name (FQDN).
You do not need to provide both names in the list.

For more details, see the following:

NetBackup for SharePoint Server Administrator's Guide

NetBackup for Exchange Server Administrator's Guide

NetBackup for SQL Server Administrator's Guide

Add

Changes the application host or component host of the currently selected mapping.Change

Removes the currently selected mapping.Remove

Encryption properties
The Encryption properties control encryption on the currently selected client.

Multiple clients can be selected and configured at one time only if all selected clients
are running the same version of NetBackup. If not, the Encryption properties dialog
box is hidden.

More information is available in the NetBackup Security and Encryption Guide.
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Figure 3-15 Encryption dialog box

The Encryption permissions property indicates the encryption setting on the
selected NetBackup client as determined by the master server.

Table 3-25 Encryption permissions selections

DescriptionProperty

Specifies that the client does not permit encrypted backups.
If the server requests an encrypted backup, the backup job
ends due to error.

Not allowed

Specifies that the client allows either encrypted or
unencrypted backups. Allowed is the default setting for a
client that has not been configured for encryption.

Allowed

Specifies that the client requires encrypted backups. If the
server requests an unencrypted backup, the backup job ends
due to error.

Required
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Select the Enable encryption property if the NetBackup Encryption is used on the
selected client.

After Enable Encryption is selected, choose from the properties in Table 3-26.

Table 3-26 Encryption dialog box properties

DescriptionProperty

Pertains to the 128-bit and the 256-bit options of NetBackup Encryption.

If the selected client does not use Legacy encryption,Enable standard encryption is automatically
selected.

Enable standard
encryption

The following cipher types are available: BF-CFB, DES-EDE-CFB, AES-256-CFB, and
AES-128-CFB. AES-128-CFB is the default.

More information about the ciphers file is available in the NetBackup Security and Encryption
Guide.

Client Cipher

Pertains to the 40-bit and the 56-bit data encryption standard (DES) NetBackup encryption
packages.

Enable legacy
DES encryption

Defines the encryption strength on the NetBackup client when Legacy encryption is used:

■ DES_40
Specifies the 40-bit DES encryption. DES_40 is the default value for a client that has not been
configured for encryption.

■ DES_56
Specifies the 56-bit DES encryption.

Encryption
strength

Specify the folder that contains the encryption libraries on NetBackup clients.

The default location is as follows:

■ On Windows:

install_path\NetBackup\bin\

Where install_path is the directory where NetBackup is installed and by default is C:\Program
Files\Veritas.

■ On UNIX:

/usr/openv/lib

If it is necessary to change the setting, specify the new name.

Encryption
libraries
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Table 3-26 Encryption dialog box properties (continued)

DescriptionProperty

Specify the file that contains the encryption keys on NetBackup clients.

The default location is as follows:

■ On Windows:

install_path\NetBackup\bin\keyfile.dat

Where install_path is the folder where NetBackup is installed and by default is C:\Program
Files\Veritas.

■ On UNIX:

/usr/openv/netbackup/keyfile

If it is necessary to change the setting, specify the new name.

Encryption key
file

Additional encryption methods for Windows clients
In addition to NetBackup client and server data encryption, Microsoft Windows
clients also have access to methods of encrypting the data on the original disk.

Each of the following methods has its own costs and benefits. NetBackup supports
each method for protecting Microsoft Windows clients.

Encrypting File System
The Encrypting File System (EFS) on Microsoft Windows provides file system-level
encryption. EFS is a form of encryption where individual files or directories are
encrypted by the file system itself.

The technology enables files to be transparently encrypted to protect confidential
data from attackers with physical access to the computer. Users can enable
encryption on a per-file, per-directory, or per-drive basis. The Group Policy in a
Windows domain environment can also mandate some EFS settings.

No NetBackup settings are involved in protecting these encrypted objects. Any
object with an encrypted file system attribute is automatically backed up and restored
in its encrypted state.

BitLocker Drive Encryption
BitLocker Drive Encryption is a full disk encryption feature included with Microsoft's
Windows desktop and server versions.

Disk encryption is a technology which protects information by converting it into
unreadable code that cannot be deciphered easily by unauthorized people. Disk
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encryption uses disk encryption software or hardware to encrypt every bit of data
that goes on a disk or a disk volume.

As with EFS, no NetBackup settings are involved to use BitLocker for encryption.
Unlike EFS, the encryption layer is invisible to NetBackup, with the data being
automatically decrypted and encrypted by the operating system.

NetBackup does nothing to manage the encryption process and therefore backs
up and restores the unencrypted data.

Note: If you recover a Windows computer that has BitLocker encryption enabled,
you must re-enable BitLocker encryption following the restore.

Off-host backup is not supported with volumes that run Windows BitLocker Drive
Encryption.

Enterprise Vault properties
The Enterprise Vault properties apply to currently selected clients.

To perform backups and restores, NetBackup must know the user name and
password for the account that is used to log on to the Enterprise Vault Server and
to interact with the Enterprise Vault SQL database. The user must set the logon
account for every NetBackup client that runs backup and restore operations for
Enterprise Vault components.
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Figure 3-16 Enterprise Vault dialog box

The Enterprise Vault dialog box contains the following properties.

Table 3-27 Enterprise Vault dialog box properties

DescriptionProperty

Specify the user ID for the account that is used to log on to Enterprise Vault
(DOMAIN\user name).

User Name

Specify the password for the account.Password

Select what kind of consistency checks to perform on the SQL Server databases
before NetBackup begins a backup operation.

Consistency check before
backup

Enterprise Vault Hosts properties
The Enterprise Vault Hosts properties apply to currently selected master servers.

Special configuration is required to allow NetBackup to restore SQL databases to
the correct hosts in an Enterprise Vault farm. In the Enterprise Vault Hostsmaster
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server properties, specify a source and a destination host. By doing so, you specify
a source host that can run restores on the destination host.

Figure 3-17 Enterprise Vault Hosts master server properties

The Enterprise Vault Hosts dialog box contains the following properties.

Table 3-28 Enterprise Vault Hosts dialog box properties

DescriptionOption

Adds the source and the destination hosts within the Enterprise Vault configuration.
You must provide the name of the Source host and the name of theDestination host.

Add

Changes the source host and the destination host, an entry that you select from the
Enterprise Vault Hosts field.

Change

Exchange properties
The Exchange properties apply to the currently selected Windows clients. For
clustered or replicated environments, configure the same settings for all nodes. If
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you change the attributes for the virtual server name, only the DAG host server is
updated.

For complete information on these options, see the NetBackup for Exchange Server
Administrator's Guide.

Figure 3-18 Exchange dialog box

The Exchange dialog box contains the following properties.

Table 3-29 Exchange dialog box properties

DescriptionProperty

This property only applies toMS-Exchange-Server backup policies with Exchange
2007. This version of Exchange is no longer supported.

Snapshot verification I/O throttle

Note: This property only applies to MS-Exchange-Server backup policies.

Choose which logs to include with snapshot backups:

■ Back up only uncommitted log files
■ Back up all log files (including committed log files)

Backup option for log files
during full backups
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Table 3-29 Exchange dialog box properties (continued)

DescriptionProperty

Note: This property only applies to MS-Exchange-Server backup policies.

Enable this option to delete transaction logs after a successful Instant Recovery
backup. By default, transaction logs are not deleted for a full Instant Recovery
backup that is snapshot only.

Truncate log after successful
Instant Recovery backup

Note: This property applies when you duplicate or browse a backup that uses
Granular Recovery Technology (GRT).

You can specify a different Windows system to act as a proxy for the source client
when you duplicate or browse a backup (with bplist) that uses GRT. Use a
proxy if you do not want to affect the source client or if it is not available.

For complete information on this option, see the NetBackup for Exchange Server
Administrator's Guide.

Exchange granular proxy host

Note: This property only applies to MS-Exchange-Server backup policies with
Exchange 2007. This version of Exchange is no longer supported.

Enable single instance backup
for message attachments

Disable this option if you do not want to perform a consistency check during a
DAG backup. If you check Continue with backup if consistency check fails,
NetBackup continues to perform the backup even if the consistency check fails.

Perform consistency check
before backup with Microsoft
Volume Shadow Copy Service
(VSS)

Note the following for this property:

■ This property applies to MS-Exchange-Server and VMware backup policies
with Exchange recovery.

■ For Exchange 2013 and later, you must configure this property if you want to
use GRT.

Provide the credentials for the account for NetBackup Exchange operations. This
account must have the necessary permissions to perform Exchange restores.
The permissions that are required depend on the Exchange version that you have.
The account also needs the right to “Replace a process level token.”

For complete information on this property, see the NetBackup for Exchange Server
Administrator's Guide.

Exchange credentials

About the Exchange credentials in the client host properties
The Exchange credentials in the client host properties indicate the account that has
necessary permissions to perform Exchange restores. The permissions that are
required depend on the Exchange version that you have.
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Note the following:

■ The account that you configured for the Exchange credentialsmust also have
the right to “Replace a process level token.”

■ For database restores from VMware backups, the Exchange credentials that
you provide must have permissions to restore VM files.

■ If you want to restore from a VMware snapshot copy that was created with
Replication Director, do the following:

■ Provide the Exchange credentials in theDomain\user and Password fields.

■ Configure the NetBackup Client Service with an account that has access to
the CIFS shares that are created on the NetApp disk array.

■ If you specify the minimal NetBackup account for the Exchange credentials in
the client host properties, NetBackup can back up only active copies of the
Exchange databases. If you select Passive copy only in theDatabase backup
source field when you create a policy, any backups fail. The failure occurs
because the Microsoft Active Directory Service Interface does not provide a list
of database copies for a minimal account.

Additional notes for Exchange 2013 and later
To use GRT, configure the Exchange credentials on all granular clients.

Alternatively, you can configure the Exchange credentials only on the granular
clients that perform restores. In this case, for the entire domain add “Exchange
Servers” to the “View-Only Organization Management” role group. Perform this
configuration in the Exchange Administration Center (EAC) or in Active Directory.
See the following Microsoft article for more information:

http://technet.microsoft.com/en-us/library/jj657492

Additional notes for Exchange 2010
These additional items apply to Exchange 2010:

■ For granular restores from VMware backups, only the Exchange client that
performs the granular restore requires configuration of the Exchange credentials.
The Exchange credentials are not required for backup or browse operations.

Exclude Lists properties
Use the Exclude Lists host properties to create and to modify the exclude lists for
Windows clients. An exclude list names the files and directories to be excluded
from backups of the selected Windows clients.
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For UNIX clients, use the nbgetconfig and nbsetconfig commands to gather and
modify the exclude list files from the /usr/openv/netbackup directory on each
client. nbgetconfig and nbsetconfig can also be used on a UNIX server to create
an exclude list on a Windows client.

See “Configuring the exclude list on a Windows client from a UNIX master server”
on page 121.

Figure 3-19 Exclude Lists dialog box

Exclude Lists properties apply only to Windows clients.

For information about creating exclude lists for UNIX clients, see the following topic:

See “About excluding files from automatic backups” on page 881.

If more than one exclude or include list exists for a client, NetBackup uses only the
most specific one.

For example, assume that a client has the following exclude lists:

■ An exclude list for a policy and schedule.

■ An exclude list for a policy.
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■ An exclude list for the entire client. This list does not specify a policy or schedule.

In this example, NetBackup uses the first exclude list (for policy and schedule)
because it is the most specific.

Exclude and include lists that are set up for a policy or for a policy and schedule
are not used to determine if an entire drive is to be excluded when NetBackup
determines if a backup job should be started.

Normally, this is not a problem. However, if a policy uses multistreaming and a drive
or a mount point is excluded, that job will report an error status when it completes.
To avoid the situation, do not use the policy or the policy and schedule lists to
exclude an entire volume.

The Exclude Lists dialog box contains the following properties.

Table 3-30 Excludes Lists dialog box properties

DescriptionProperty

Indicates that the files and directories to exclude are case-sensitive.Use case sensitive exclude
list

Displays the policies that contain schedule, file, and directory exclusions as follows:

■ Add
Click to exclude a file from being backed up by a policy. The exclusion is configured
in the Add to exclude list dialog box, then added to the Exclude list. When the
policies in this list are run, the files and directories that are specified on the list are
not backed up.

■ Add to all
When multiple Windows clients are selected, click Add to all to add the selected
list item to the Exclude list for all selected clients. Add to all is enabled only when
multiple Windows clients are selected for configuration.

■ Remove
Click to remove the selected policy, schedule, or file from the Exclude list.

Exclude lists
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Table 3-30 Excludes Lists dialog box properties (continued)

DescriptionProperty

Displays the policies, schedules, files, and directories that are excepted from the
Exclude list. When the policies on the Exceptions to the exclude list run, the files
and directories on the list are backed up if they were part of the original file list and
were subsequently excluded. The list is useful to exclude all files in a directory but one.

For example, if the file list of items to back up contains /foo, and the exclude list
contains /foo/bar, adding /fum to the exceptions list does not back up the /fum
directory. However, adding fum to the exceptions list will back up any occurrences of
fum (file or directory) that occur within /foo/bar.

Options include the following:

■ Add
Click to create an exception to the Exclude list. The exception is configured in the
Add exceptions to exclude list dialog box, then added to the Exceptions to the
exclude list.
When the policies on the Exceptions to the exclude list run, the items on the
exceptions list are backed up (if they were part of the original file list and
subsequently excluded). Effectively, you add files back into the backup list of a
policy.

■ Add to all
When multiple Windows clients are selected, click Add to all to add the selected
list item to the Exceptions to the exclude list for all selected clients. When the
policies on the exclude list run, the items on the exceptions list are backed up on
all selected clients.

■ Remove
Click to remove the selected policy, schedule, or file from the Exceptions list. After
the item is removed from the Exclude list, the item is excluded from the backup.

Exceptions to exclude list

About the Add to Exclude List and Add Exceptions to Exclude List
dialog boxes

The Add to Exclude List dialog box and the Add Exceptions to Exclude List
dialog box contain the following fields:
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Table 3-31 Add to Exclude dialog box

DescriptionField

The policy name that contains the files and the directories
that you want to exclude or make exceptions for. You can
also select the policy name from the drop-down menu. To
exclude or make exceptions for the backup of specific files
or directories from all policies, select All Policies.

Policy

The schedule name that is associated with the files and the
directories that you want to exclude or make exceptions for.
You can also select the schedule name from the drop-down
menu. To exclude or make exceptions for the backups of
specific files or directories from all schedules, select All
Schedules.

Schedule

Either browse or enter the full path to the files and the
directories that you want to exclude or make exceptions for.

Files/Directories

Figure 3-20 Add to Exclude List properties

Adding an entry to an exclude list
Use the following procedure to add an entry to an exclude list for a policy:

To add an entry to the exclude list

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Clients. Double-click on a client.

2 Under the Exclude List, click Add.

3 In the Policy field, select a policy name from the drop-down menu or enter the
name of a policy. Select All Policies to exclude these items from all policies.
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4 In the Schedule field, select a schedule name from the drop-down menu or
enter the name of a schedule. Select All Schedules to exclude the specified
files and directories from all schedules in the policy.

5 In the Files/Directories field, either browse or enter the files or directories to
be excluded from the backups that are based on the selected policy and
schedule.

6 Click Add to add the specified files and directories to the exclude list.

7 Click Apply to accept the changes. Click OK to accept the changes and close
the host properties dialog box.

Adding an exception to the exclude list
Use the following procedure to add an exception to the exclude list for a policy:

To add an exception to the exclude list

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Clients. Double-click on a client.

2 Under the Exceptions to the Exclude List, click Add.

3 In the Policy field, select a policy name from the drop-down menu or enter the
name of a policy. Select All Policies to add these items back into all policies.
(In other words, these items are to be excluded from the exclude list.)

4 In the Schedule field, select a schedule name from the drop-down menu or
enter the name of a schedule. Select All Schedules to add these items back
into the schedules.

5 In the Files/Directories field, either browse or enter the files or directories to
be added back into the backups that are based on the selected policy and
schedule.

6 Click Add to add the specified files and directories to the Exceptions to the
Exclude List.

7 Click Apply to accept the changes. Click OK to accept the changes and close
the host properties dialog box.

Syntax rules for exclude lists
Veritas suggests that you always specify automounted directories and CD-ROM
file systems in the exclude list. Otherwise, if the directories are not mounted at the
time of a backup, NetBackup must wait for a timeout.

The following syntax rules apply to exclude lists:

■ Only one pattern per line is allowed.
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■ NetBackup recognizes standard wildcard use.
See “Wildcard use in NetBackup” on page 1164.
See “NetBackup naming conventions” on page 1163.

■ If all files are excluded in the backup selections list, NetBackup backs up only
what is specified by full path names in the include list. Files can be excluded by
using / or * or by using both symbols together (/*).

■ Spaces are considered legal characters. Do not include extra spaces unless
they are part of the file name.
For example, if you want to exclude a file named
C:\testfile (with no extra space character at the end)
and your exclude list entry is
C:\testfile (with an extra space character at the end)
NetBackup cannot find the file until you delete the extra space from the end of
the file name.

■ End a file path with \ to exclude only directories with that path name (for example,
C:\users\test\). If the pattern does not end in \ (for example, C:\users\test),
NetBackup excludes both files and directories with that path name.

■ To exclude all files with a given name, regardless of their directory path, enter
the name. For example:
test

rather than
C:\test

This example is equivalent to prefixing the file pattern with
\

\*\

\*\*\

\*\*\*\

and so on.

The following syntax rules apply only to UNIX clients:

■ Do not use patterns with links in the names. For example, assume /home is a
link to /usr/home and /home/doc is in the exclude list. The file is still backed
up in this case because the actual directory path, /usr/home/doc, does not
match the exclude list entry, /home/doc.

■ Blank lines or lines which begin with a pound sign (#) are ignored.
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Example of a Windows client exclude list
Assume that an exclude list in the Exclude Lists host properties contains the
following entries:

C:\users\doe\john

C:\users\doe\abc\

C:\users\*\test

C:\*\temp

core

Given the exclude list example, the following files, and directories are excluded
from automatic backups:

■ The file or directory named C:\users\doe\john.

■ The directory C:\users\doe\abc\ (because the exclude entry ends with \).

■ All files or directories named test that are two levels beneath users on drive
C.

■ All files or directories named temp that are two levels beneath the root directory
on drive C.

■ All files or directories named core at any level and on any drive.

Example of a UNIX exclude list
In this example of a UNIX exclude list, the list contains the following entries:

# this is a comment line

/home/doe/john

/home/doe/abc/

/home/*/test

/*/temp

core

Given the exclude list example, the following files and directories are excluded from
automatic backups:

■ The file or directory named /home/doe/john.

■ The directory /home/doe/abc (because the exclude entry ends with /).

■ All files or directories named test that are two levels beneath home.

■ All files or directories named temp that are two levels beneath the root directory.

■ All files or directories named core at any level.
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About creating an include list on a UNIX client
To add a file that is eliminated with the exclude list, create a
/usr/openv/netbackup/include_list file. The same syntax rules apply as for
the exclude list.

Note: Exclude and include lists do not apply to user backups and archives.

To illustrate the use of an include list, we use the example from the previous
discussion. The exclude list in that example causes NetBackup to omit all files or
directories named test from all directories beneath /home/*/test.

In this case, add a file named /home/jdoe/test back into the backup by creating
an include_list file on the client. Add the following to the include_list file:

# this is a comment line

/home/jdoe/test

To create an include list for a specific policy or policy and schedule combination,
use a .policyname or .policyname.schedulename suffix. The following are two
examples of include list names for a policy that is named wkstations that contains
a schedule that is named fulls.

/usr/openv/netbackup/include_list.workstations

/usr/openv/netbackup/include_list.workstations.fulls

The first file affects all scheduled backups in the policy that is named wkstations.
The second file affects backups only when the schedule is named fulls.

For a given backup, NetBackup uses only one include list: the list with the most
specific name. Given the following two files:

include_list.workstations

include_list.workstations.fulls

NetBackup uses only include_list.workstations.fulls as the include list.

Configuring the exclude list on aWindows client from a UNIX master
server

An administrator can change the exclude list on a Windows client from a UNIX
master server by using the nbgetconfig (or bpgetconfig) and the nbsetconfig

(or bpsetconfig) commands.
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Configuring the exclude list on a Windows client from a UNIX master server

1 From the UNIX server, use the nbgetconfig command to access the exclude
list on a Windows client.

For example, where:

nbmaster1 is a UNIX master server.

nbmedia1 is a Windows computer and a NetBackup client.

On nbmaster1, run the following command:

/usr/openv/netbackup/bin/nbgetconfig -M nbmedia1 EXCLUDE

The output lists the exclude list on nbmedia1:

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bprd.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bpsched.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackupDB\data\*

EXCLUDE = C:\Program Files\Veritas\Volmgr\misc\*

2 Create an exclude list on the UNIX server.

For example, file ex_list on nbmaster1:

vi /tmp/ex_list

The contents of ex_list consists of the following files and directories:

more /tmp/ex_list

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bprd.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bpsched.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackupDB\data\*

EXCLUDE = C:\Program Files\Veritas\Volmgr\misc\*

EXCLUDE = C:\

EXCLUDE = D:\
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3 From the UNIX server, use the nbsetconfig command to set the exclude list
on a Windows client.

For example, run the following command on nbmaster1 to make ex_list the
exclude list on client nbmedia1:

/usr/openv/netbackup/bin/nbsetconfig -h nbmedia1 /tmp/ex_list

4 On the UNIX server, use the nbgetconfig command to view the new exclude
list on the Windows client.

For example:

/usr/openv/netbackup/bin/nbgetconfig -M nbmedia1 EXCLUDE

The output lists the updated exclude list on nbmedia1:

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bprd.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackup\bin\bpsched.d\*.lock

EXCLUDE = C:\Program Files\Veritas\NetBackupDB\data\*

EXCLUDE = C:\Program Files\Veritas\Volmgr\misc\*

EXCLUDE = C:\

EXCLUDE = D:\

Traversing excluded directories
An exclude list can indicate a directory for exclusion, while the client uses an include
list to override the exclude list. NetBackup traverses the excluded directories if
necessary, to satisfy the client’s include list.

Assume the following settings for a Windows client:

■ The backup policy backup selection list indicates ALL_LOCAL_DRIVES. When a
scheduled backup runs, the entire client is backed up.
The entire client is also backed up if the backup selection list consists of only:
/

■ The exclude list on the client consists of only: *
An exclude list of * indicates that all files are excluded from the backup.

■ However, since the include list on the Windows client includes the following file:
C:\WINNT, the excluded directories are traversed to back up C:\WINNT.
If the include list did not contain any entry, no directories are traversed.

In another example, assume the following settings for a UNIX client:

■ The backup selection list for the client consists of the following: /
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■ The exclude list for the UNIX client consists of the following: /

■ The include list of the UNIX client consists of the following directories:
/data1

/data2

/data3

Because the include list specifies full paths and the exclude list excludes everything,
NetBackup replaces the backup selection list with the client’s include list.

Fibre Transport properties
NetBackup Fibre Transport properties control how your Fibre Transport media
servers and SAN clients use the Fibre Transport service for backups and restores.
The Fibre Transport properties apply to the host type that you select in the
NetBackup Administration Console, as follows:

Table 3-32 Host types for Fibre Transport properties

DescriptionHost type

Global Fibre Transport properties that apply to all SAN clients.Master server

The Fibre Transport Maximum concurrent FT connections
property applies to the FT media server or servers that you selected
in the NetBackup Administration Console.

Media server

The Fibre Transport properties apply to the SAN client or clients
that you selected in the NetBackup Administration Console. The
default values for clients are the global property settings of the master
server. Client properties override the global Fibre Transport
properties.

Client
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Figure 3-21 Fibre Transport host properties for a master server

Table 3-33 describes the Fibre Transport properties. All properties are not available
for all hosts. In this table, FT device is an HBA port on a Fibre Transport media
server. The port carries the backup and restore traffic. A media server may have
more than one FT device.
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Table 3-33 Fibre Transport dialog box properties

DescriptionProperty

This property appears only when you select an FT media server or servers in the
NetBackup Administration Console.

This property specifies the number of FT connections to allow to the selected
media server or media servers. A connection is equivalent to a job.

If no value is set, NetBackup uses the following defaults:

■ For NetBackup Appliance model 5330 and later: 32
■ For NetBackup Appliance model 5230 and later: 32
■ For NetBackup Fibre Transport media servers: 8 times the number of fast HBA

ports on the media server plus 4 times the number of slow HBA ports. A fast
port is 8 GB or faster, and a slow port is less than 8 GB.

You can enter up to the following maximum connections for the media server or
servers to use:

■ On a Linux FT media server host: 40.
Veritas recommends that you use 32 or fewer connections concurrently on
Linux.
On Linux hosts, you can increase that maximum by setting a NetBackup touch
file, NUMBER_DATA_BUFFERS_FT.
See “About Linux concurrent FT connections” on page 127.

■ For NetBackup Appliance model 5330 and later: 40.
■ For NetBackup Appliance model 5230 and later: 40.
■ On a Solaris FT media server host: 64.

NetBackup supports 644 buffers per media server for Fibre Transport. To
determine the number of buffers that each connection uses, divide 644 by the
value you enter. More buffers per connection equal better performance for each
connection.

Maximum concurrent FT
connections

This property appears only when you select a client or client in the NetBackup
Administration Console.

This property specifies that the client follow the properties as they are configured
on the master server.

Use defaults from the master
server configuration

The Preferred property specifies to use an FT device if one is available within
the configured wait period in minutes. If an FT device is not available after the
wait period elapses, NetBackup uses a LAN connection for the operation.

If you select this option, also specify the wait period for backups and for restores.

For the global property that is specified on the master server, the default is
Preferred.

Preferred
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Table 3-33 Fibre Transport dialog box properties (continued)

DescriptionProperty

The Always property specifies that NetBackup should always use an FT device
for backups and restores of SAN clients. NetBackup waits until an FT device is
available before it begins the operation.

However, an FT device must be online and up. If not, NetBackup uses the LAN.
An FT device may be unavailable because none are active, none have been
configured, or the SAN Client license expired.

Always

The Fail property specifies that NetBackup should fail the job if an FT device is
not online and up. If the FT devices are online but busy, NetBackup waits until a
device is available and assigns the next job to the device. An FT device may be
unavailable because none are active, none have been configured, or the SAN
Client license expired.

Fail

The Never property specifies that NetBackup should never use an FT pipe for
backups and restores of SAN clients. NetBackup uses a LAN connection for the
backups and restores.

If you specify Never for the master server, Fibre Transport is disabled in the
NetBackup environment. If you select Never, you can configure FT usage on a
per-client basis.

If you specify Never for a media server, Fibre Transport is disabled for the media
server.

If you specify Never for a SAN client, Fibre Transport is disabled for the client.

Never

NetBackup provides one finer level of granularity for Fibre Transport. SAN client
usage preferences override the FT properties that you configure through Host
Properties.

For more information about NetBackup Fibre Transport, see the NetBackup SAN
Client and Fibre Transport Guide:

http://www.veritas.com/docs/DOC5332

About Linux concurrent FT connections
NetBackup uses theMaximum concurrent FT connections Fibre Transport host
property to configure the number of concurrent connections to a Fibre Transport
media server, up to the total that is allowed per host.

See “Fibre Transport properties” on page 124.

If the total number of concurrent connections on Linux is too low for your purposes,
you can increase the total number of concurrent connections. The consequence is
that each client backup or restore job uses fewer buffers, which means that each
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job is slower because of fewer buffers. To increase the number of concurrent
connections, reduce the number of buffers per connection. To do so, create the
following file and include one of the supported values from Table 3-34 in the file:

/usr/openv/netbackup/db/config/NUMBER_DATA_BUFFERS_FT

Table 3-34 shows the values that NetBackup supports for the
NUMBER_DATA_BUFFERS_FT file. NetBackup supports 644 buffers per media server
for Fibre Transport.

Table 3-34 Supported values for buffers per FT connection

Total concurrent
connections: Linux FT
media server

Total concurrent
connections:NetBackup
5230 and 5330 and later
appliances

NUMBER_DATA_BUFFERS_FT

404016

535312

646410

If you want, you then can limit the number of connections for a media server or
media servers by using the Maximum concurrent FT connections of the Fibre
Transport host properties.

Firewall properties
The Firewall properties describe how the selected master servers and media
servers connect to legacy services running on that NetBackup host.

Servers are added to the host list of the Firewall properties. To configure port usage
for clients, see the Client Attributes properties.

See “Client Attributes properties” on page 69.
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Figure 3-22 Firewall dialog box

The Firewall dialog box contains the following properties.
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Table 3-35 Firewall dialog box properties

DescriptionProperty

By default, NetBackup selects firewall-friendly connect options underDefault connect
options. However, the default options can be set differently for individual servers under
Attributes for selected Hosts.

By default, the firewall settings are configured to require the fewest possible ports to
be open.

These properties correspond to the DEFAULT_CONNECT_OPTIONS configuration option.

To change the default connect options for the selected server, click Change.

ClickChange to change theDefault connect options. Change the Firewall properties
in the Default Connect Options dialog box.

Note: IfVNETD only is selected as theDaemon connection port, theBPCD connect
back setting is not applicable. If VNETD only is selected as the Daemon connection
port, Use non-reserved ports is always used regardless of the value of the Ports
setting.

Default connect options

To change the default connect options for any host name, add the host name to the
host list. Servers do not automatically appear on the list.

■ Add option
Click Add to add a host entry to the host list. A host must be listed before it can be
selected for configuration.

■ Add to all option
Click Add to All to add the listed hosts (along with the specified properties) to all
hosts that are selected for host property configuration. (That is, the hosts that are
selected upon opening the Host Properties.)

■ Remove option
Select a host name in the list, then click Remove to remove the host from the list.

Hosts list

Connect options can be configured for individual servers.

These properties correspond to the CONNECT_OPTIONS configuration option.

Attributes for selected hosts
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Table 3-35 Firewall dialog box properties (continued)

DescriptionProperty

This property specifies how daemons are to connect back to the NetBackup Client
daemon (BPCD) as follows:

■ Use default connect options (An option for individual hosts)
Use the methods that are specified under Default connect options.

■ Random port
NetBackup randomly chooses a free port in the allowed range to perform the
traditional connect-back method.

■ VNETD port
This method requires no connect-back. The Veritas Network Daemon (vnetd) was
designed to enhance firewall efficiency with NetBackup during server-to-server and
server-to-client communications. The server initiates all bpcd socket connections.
Consider the example in which bpbrm on a media server initially connects with
bpcd on a client. The situation does not pose a firewall problem because bpbrm
uses the well-known PBX or vnetd port.

BPCD connect back

Select whether a reserved or non-reserved port number should be used to connect to
the host name:

■ Use default connect options (An option for individual hosts)
Use the methods that are specified under Default attributes.

■ Reserved port
Connect to the host name by a reserved port number.

■ Use non-reserved ports
Connect to the host name by a non-reserved port number.

Ports
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Table 3-35 Firewall dialog box properties (continued)

DescriptionProperty

This option only affects connections to NetBackup 7.0 and earlier. For connections to
NetBackup 7.0.1 and later, the veritas_pbx port is used.

If configuring connections for NetBackup 7.0 and earlier, select theDaemon connection
port method to use to connect to the server:

■ Use default connect options (An option for individual hosts)
Use the methods that are specified under Default connect options.

■ Automatic
The daemons on the server are connected to by vnetd if possible. If it is not possible
to use vnetd, the daemon’s traditional port number makes the connection.

■ VNETD only
The daemons on the server are connected to by vnetd only. Select this property
if your firewall rules prevent connections to the server by the traditional port number.

■ Daemon port only
The daemons on the server are connected to by the traditional port number only.

Note: If vnetd only is selected as the Daemon connection port, the BPCD connect
back setting is not applicable. If vnetd only is selected as the Daemon connection
port, Non-reserved port is always used regardless of the value of the Ports setting.

Daemon connection port

Set property settings back to the defaults.Defaults

Enabling logging for vnetd
Use the following procedure to enable logging for vnetd.

To enable logging for vnetd

◆ Create a vnetd directory in the following location:

■ On Windows: install_path\NetBackup\logs\vnetd
Or, double-click mklogdir.bat in the install_path\NetBackup\logs\

directory to populate the logs directory with log subdirectories, including
one for vnetd.

■ On UNIX: /usr/openv/logs/vnetd

General Server properties
The General Server properties apply to selected master and media servers.
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Figure 3-23 General Server dialog box

The General Server dialog box contains the following properties.

Table 3-36 General Server dialog box properties

DescriptionProperty

This property specifies how long the server waits for additional restore requests
of multiplexed images on the same tape. All of the restore requests that are
received within the delay period are included in the same restore operation (one
pass of the tape).

The default is a delay of 30 seconds.

Delay on multiplexed restores

This property applies to the disk storage units of 6.0 media servers only.
Subsequent releases use internal methods to monitor disk space more frequently.

Check the capacity of disk storage
units every
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Table 3-36 General Server dialog box properties (continued)

DescriptionProperty

This property appears for master servers only, but applies to all media servers
as well. This property does not apply to NDMP drives.

If a client is also a media server or a master server and Must use local drive is
checked, a local drive is used to back up the client. If all drives are down, another
can be used.

This property increases performance because backups are done locally rather
than sent across the network. For example, in a SAN environment a storage unit
can be created for each SAN media server. Then, the media server clients may
be mixed with other clients in a policy that uses ANY AVAILABLE storage unit.
When a backup starts for a client that is a SAN media server, the backups go to
the SAN connected drives on that server.

Must use local drive

By default, NetBackup for NDMP is configured to use Direct Access Recovery
(DAR) during NDMP restores. DAR can reduce the time it takes to restore files
by allowing the NDMP host to position the tape to the exact location of the
requested file(s). Only the data that is needed for those files is read.

Clear this check box to disable DAR on all NDMP restores. Without DAR,
NetBackup reads the entire backup image, even if only a single restore file is
needed.

Use direct access recovery for
NDMP restores

This option performs message-level cataloging when you duplicate Exchange
backup images that use Granular Recovery Technology (GRT) from disk to tape.
To perform duplication more quickly, you can disable this option. However, then
users are not able to browse for individual items on the image that was duplicated
to tape.

See the NetBackup for Exchange Administrator's Guide.

Enable message-level cataloging
when duplicating Exchange images
that use Granular Recovery
Technology
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Table 3-36 General Server dialog box properties (continued)

DescriptionProperty

Specific servers can be specified in this list as servers to perform restores,
regardless of where the files were backed up. (Both servers must be in the same
master and media server cluster.) For example, if files were backed up on media
server A, a restore request can be forced to use media server B.

The following items describe situations in which the capability to specify servers
is useful:

■ Two (or more) servers share a robot and each have connected drives. A restore
is requested while one of the servers is either temporarily unavailable or is
busy doing backups.

■ A media server was removed from the NetBackup configuration, and is no
longer available.

To add a host to the Media host override list, click Add.

Click Add to All to add a host to the list for all of the hosts currently selected.

To change an entry in the list, select a host name, then click Change.

Configure the following options in the Add Media Override settings or Change
Media Override settings dialog box:

■ Original backup server
Enter the name of the server where data was backed up originally.

■ Restore server
Enter the name of the server that is to process future restore requests.

Media host override list

Sets all properties back to the default settings.Defaults

Forcing restores to use a specific server
Use the following procedure to force restores to use a specific server.
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To force restores to use a specific server

1 If necessary, physically move the media to the host to answer the restore
requests, then update the Enterprise Media Manager database to reflect the
move.

2 Modify the NetBackup configuration on the master server. Add the original
backup media server and the restore server to theMedia host override list in
the General Server host properties.

3 Stop and restart the NetBackup Request Daemon (bprd) on the master server.

This process applies to all storage units on the original backup server. Restores
for any storage unit on the Original backup server go to the server that is
listed as the Restore server.

To revert to the original configuration for future restores, delete the line from
the Media host override list.

Global Attributes properties
The Global Attributes properties apply to currently selected master servers. The
Global Attributes properties affect all operations for all policies and clients. The
default values are adequate for most installations but can be changed.
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Figure 3-24 Global Attributes dialog box

The Global Attributes dialog box contains the following properties.

Table 3-37 Global Attributes dialog box properties

DescriptionProperty

This property specifies how often NetBackup retries a job. The default is 10 minutes.
The maximum is 60 minutes; the minimum is 1 minute.

Job retry delay
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Table 3-37 Global Attributes dialog box properties (continued)

DescriptionProperty

NetBackup considers the failure history of a policy to determine whether or not to run
a scheduled backup job. The Schedule backup attempts property sets the timeframe
for NetBackup to examine.

This property determines the following characteristics for each policy:

■ How many preceding hours NetBackup examines to determine whether to allow
another backup attempt (retry). By default, NetBackup examines the past 12 hours.

■ How many times a backup can be retried within that timeframe. By default,
NetBackup allows two attempts. Attempts include the scheduled backups that start
automatically or the scheduled backups that are user-initiated.

Consider the following example scenario using the default setting 2 tries every 12
hours:

■ Policy_A runs at 6:00 P.M.; Schedule_1 fails.
■ Policy_A is user-initiated at 8:00 P.M.; Schedule_2 fails.
■ At 11:00 P.M., NetBackup looks at the previous 12 hours. NetBackup sees one

attempt at 6:00 P.M. and one attempt at 8:00 P.M. The Schedule backup attempts
setting of two has been met so NetBackup does not try again.

■ At 6:30 A.M. the next morning, NetBackup looks at the previous 12 hours. NetBackup
sees only one attempt at 8:00 P.M. The Schedule backup attempts setting of two
has not been met so NetBackup tries again. If a schedule window is not open at
this time, NetBackup waits until a window is open.

Note: This attribute does not apply to user backups and archives.

Schedule backup attempts

This property specifies how long NetBackup waits to process a policy after a policy is
changed. The interval allows the NetBackup administrator time tomakemultiple changes
to the policy. The default is 10 minutes. The maximum is 1440 minutes; the minimum
is 1 minute.

Policy update interval

This property specifies themaximum number of backup and archive jobs that NetBackup
clients can perform concurrently. The default is one job.

NetBackup can process concurrent backup jobs from different policies on the same
client only in the following situations:

■ More than one storage unit available
■ One of the available storage units can perform more than one backup at a time.

See “About constraints on the number of concurrent jobs” on page 139.

Maximum jobs per client

This property specifies how long NetBackup waits after a backup before it compresses
the image catalog file.

Compress catalog interval
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Table 3-37 Global Attributes dialog box properties (continued)

DescriptionProperty

This property specifies the maximum number of vault jobs that are allowed to be active
on the master server. The greater the maximum number of vault jobs, the more system
resources are used.

If the active vault jobs limit is reached, subsequent vault jobs are queued and their
status is shown as Queued in the Activity Monitor.

If a duplication job or eject job waits, its status is shown as Active in the Activity Monitor.

See “About the Jobs tab” on page 1100.

Maximum vault jobs

This property specifies the address(es) where NetBackup sends notifications of
scheduled backups or administrator-directed manual backups.

To send the information to more than one administrator, separate multiple email
addresses by using a comma, as follows:

useraccount1@company.com,useraccount2@company.com

Disaster recovery information that is created during catalog backups is not sent to the
addresses indicated here. Disaster recovery information is sent to the address that is
indicated on the Disaster Recovery tab in the catalog backup policy.

See “Disaster Recovery tab” on page 888.

Administrator email
address property

About constraints on the number of concurrent jobs
Specify any number of concurrent jobs within the following constraints.

Table 3-38 Constraints on concurrent jobs

DescriptionConstraint

NetBackup can perform concurrent backups to separate storage units or to drives
within a storage unit. For example, a single Media Manager storage unit supports as
many concurrent backups as it has drives. A disk storage unit is a directory on disk,
so the maximum number of jobs depends on system capabilities.

Number of storage devices
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Table 3-38 Constraints on concurrent jobs (continued)

DescriptionConstraint

Too many concurrent backups on an individual client interfere with the performance
of the client. The best setting depends on the hardware, operating system, and
applications that are running.

The Maximum jobs per client property applies to all clients in all policies.

To accommodate weaker clients (ones that can handle only a small number of jobs
concurrently), consider using one of the following approaches:

■ Set the Maximum data streams property for those weaker client(s) appropriately.
(This property is found under Host Properties > Master Servers > Double-click
on a specific master server > Client Attributes > General tab.)
See “General tab of the Client Attributes properties” on page 71.

■ Use the Limit jobs per policy policy setting in a client-specific policy. (A
client-specific policy is one in which all clients share this characteristic).
See “Limit jobs per policy (policy attribute)” on page 739.

Server and client speed

The available bandwidth of the network affects how many backups can occur
concurrently. Two Exabyte 8500, 8mm tape drives can create up to a
900-kilobyte-per-second network load. Depending on other factors, the load might be
too much for a single Ethernet. For loading problems, consider backups over multiple
networks or compression.

A special case exists to back up a client that is also a server. Network loading is not a
factor because the network is not used. Client and server loading, however, is still a
factor.

Network loading

Figure 3-25 Maximum jobs per client

Client

/home

/usr

Policy A

Policy B

Tape Drive 1

Server

Tape Drive 2

Note: Catalog backups can run concurrently with other backups. To do so, set the
Maximum jobs per client value to greater than two for the master server. The
higher setting ensures that the catalog backup can proceed while the regular backup
activity occurs.
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Setting up email notifications about backups
Email notifications can be sent to the client's administrator or to the global
administrator, specifying that a backup was successful or unsuccessful.

The following represents the contents of a notification email:

Backup on client hostname by root was partially successful.

File list

---------

C:\Documents and Settings

Before emails can be sent, the computing environment must be configured correctly.

Additional Windows configuration to receive emails
NetBackup can send notification to specified email addresses about backups on
all clients or specific clients.

The nbmail.cmd script must be configured on any Windows host that is to receive
email.

Windows systems also require that an application to transfer messages using the
Simple Mail Transfer Protocol be installed to accept script parameters. UNIX
platforms have an SMTP transfer method built into the system.

Additional UNIX configuration to receive emails
NetBackup uses the mail transfer agent sendmail to send email notifications. Install
sendmail from the following website and configure the environment accordingly:

http://www.sendmail.org/releases

Notification methods
To set up email notifications about backups, choose one or both of the following
notification methods:

■ Send emails about failed backups only.
Send a message to the email address(es) of the NetBackup administrator(s)
about any backup that ends in a non-zero status.
To do so, configure the Administrator email address in theGlobal Attributes
properties. Since email is sent from the master server or the media server, the
nbmail.cmd script or sendmailmust be configured on the master and the media
servers.
See “Sending messages to the global administrator about unsuccessful backups
only” on page 144.

■ Send emails about successful and failed backups.
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Send a message to the local administrator(s) of each client about successful
and unsuccessful backups.
To do so, configure either the Client sends mail property or the Server sends
mail property in the Universal Settings properties for the client. Email is sent
from the client (Client sends mail) or the master or the media server (Server
sends mail). Therefore, nbmail.cmd or sendmail must be configured on the
master and the media servers, or the client if specified.
See “Sending messages to the administrator about successful and unsuccessful
backups” on page 144.

See “Installing and testing the email utility on Windows” on page 146.

See “About constraints on the number of concurrent jobs” on page 139.

Configuring the nbmail.cmd script on Windows
For Windows hosts to receive email notifications about backups, the nbmail.com

script must be configured on the host.

By default, nbmail.cmd does not send email. Use the following procedure to
configure the nbmail.cmd script.

To configure the nbmail.cmd script

1 On a NetBackup master server, copy nbmail.cmd from the following directory:

install_path\NetBackup\bin\goodies\nbmail.cmd

2 Paste it into the following directory on the server or client:

install_path\NetBackup\bin\
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3 Use a text editor to open nbmail.cmd. Create a backup copy of nbmail.cmd
before modifying it.

In some text editors, using the word wrap option can create extra line feeds in
the script and render it non-functional.

The following options are used in the script:

The subject line of the email-s

Indicates who receives the email.-t

The originator of the email, though it is not necessarily known to the
mail server. The default (-i NetBackup) shows that the email is from
NetBackup.

-i

The name of the SMTP server that is configured to accept and relay
emails.

-server

Suppresses all output to the screen.-q

4 Most of the lines are informational in nbmail.cmd.

Locate the following lines in the script:

@REM @IF "%~4"=="" (

@REM blat %3 -s %2 -t %1 -i NetBackup -server SERVER_1 -q

@REM ) ELSE (

@REM blat %3 -s %2 -t %1 -i NetBackup -server SERVER_1 -q -attach %4

@REM )

5 Adjust the fives lines as follows:

■ Remove @REM from each of the five lines to activate the necessary
sections for BLAT to run.

■ Replace SERVER_1 with the name of the mail server. For example:

@IF "%~4"=="" (

blat %3 -s %2 -t %1 -i NetBackup -server emailserver.company.com -q

) ELSE (

blat %3 -s %2 -t %1 -i NetBackup -server emailserver.company.com -q -attach %4

)

6 Save nbmail.cmd.

See “About constraints on the number of concurrent jobs” on page 139.
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Sending messages to the global administrator about unsuccessful
backups only

Use the following procedure to send messages to the global administrator about
backups with a non-zero status.

To sendmessages to the global administrator about backups with a non-zero
status

1 On Windows servers, install and configure a mail client.

See “Installing and testing the email utility on Windows” on page 146.

Edit the nbmail.cmd script.

See “Configuring the nbmail.cmd script on Windows” on page 142.

2 On the master server, open the NetBackup Administration Console.

3 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Server.

4 In the right pane, double-click the master server you want to modify.

5 Open the host properties of the master server.

6 In the properties dialog box, in the left pane, click Global Attributes.

7 In the Administrator’s email address field, enter the email address of the
administrator to receive the notification emails. (Separate multiple addresses
with commas.) Click Apply.

The global administrator’s email address can also be changed by using the
bpconfig command on the master server:

install_path\NetBackup\bin\admincmd\bpconfig -ma email_address

For example:

C:\Program Files\Veritas\NetBackup\bin\admincmd\bpconfig

-ma name@company.com

Sending messages to the administrator about successful and
unsuccessful backups

An alternative to sending all emails through the master server is to send emails
through each client or through the media server that backed up the client. An email
can be sent to the administrator after every backup.
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To send email notifications for all backups from a client

1 On a Windows client, install and configure a mail client.

See “Installing and testing the email utility on Windows” on page 146.

On the client or the media server, edit the nbmail.cmd script, depending on
whetherClient sendsmail is enabled or Server sendsmail is enabled in step
6.

See “Configuring the nbmail.cmd script on Windows” on page 142.

2 On the master server, open the NetBackup Administration Console.

3 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Clients.

4 In the right pane, double-click the client you want to modify. Multiple clients
can also be selected.

5 In the properties dialog box, in the left pane, select Universal Settings.

6 Enable the Client sends mail option or if the client cannot send mail, enable
the Server sends mail option.

7 In the Client administrator’s email field, enter the email address of the
administrator(s) to receive the notification emails. (Separate multiple addresses
with commas.) Click Apply.

See “Universal Settings properties” on page 241.
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Installing and testing the email utility on Windows
BLAT is the most common application that is used for email notification. It is a mail
client in the public domain.

NetBackup supports BLAT v2.4 and later versions.

BLAT is used as an example in the following discussions.

Use the following procedure to install and configure the email utility.

To install and configure the email utility

1 Download the .ZIP file from the BLAT download page, currently: www.blat.net

2 Extract the files to a directory.

3 Copy the blat.exe file to the Windows System32 directory.
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4 From a command prompt, run the following command:

blat -install emailserver.company.com useraccount@company.com

Where:

emailserver.company.com is the host name or IP address of the mail server
that sends the email notifications.

useraccount@company.com is the primary account to send the emails from
the specified server.

5 Test the email utility, following the To test the email utility procedure.

Use the following procedure to test the email utility.

To test the email utility

1 Create a test text file that contains a message. For example, create
C:\testfile.txt

2 From a command prompt, run:

blat C:\testfile.txt -s test_subject -to useraccount@company.com

A correct setup sends the contents of testfile.txt to the email address
specified.

3 Use the following list to troubleshoot problems if NetBackup notification does
not work correctly:

■ Make sure that the BLAT command is not commented out in the nbmail.cmd
script.

■ Make sure that the path to blat.exe is specified in nbmail.cmd if the
command is not in the \system32 directory.

■ Make sure that BLAT syntax has not changed in the later versions of BLAT.
Check the readme for the version of BLAT running on the system.

■ The BLAT command may need the -ti n timeout parameter if the system
experiences delays. (n represents seconds.)

■ The BLAT binary must not be corrupt or incompatible with the email system.
Download the latest version.

■ Configure the email addresses correctly in the host properties.

■ The email account that is specified must be a valid on the mail server.

■ If the mail server requires authentication for SMTP, make sure that the
account that is used for the NetBackup client process is authorized. The
default account is the local system.
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Logging properties
The Logging properties apply to the master servers, media servers, and the clients
that are currently selected. The available properties differ between master servers,
media servers, and clients. The Logging properties contain the processes that
continue to use Legacy logging as well as processes that use Unified logging.

Legacy logging
For those processes that use legacy logging, administrators must first create a log
directory for each process to be logged. A logging level selection on the Logging
properties page does not create the log directory.

Note: If you have used the Logging Assistant tool earlier, you do not need to
manually create log directories. The Logging Assistant tool automatically creates
log directories.

Create the NetBackup legacy log directories in the following locations:

■ On Windows: install_path\NetBackup\logs\process_name

■ On UNIX: /usr/openv/netbackup/logs/process_name

Note: Do not save logs to a remote file system such as NFS or CIFS. Logs that are
stored remotely and then grow large can cause critical performance issues.

To create all of the NetBackup debug log directories at one time, run the following
files:

■ On Windows, run mklogdir.bat:
install_path\NetBackup\logs\mklogdir.bat

■ OnUNIX, run the mklogdir shell script: /usr/openv/netbackup/logs/mklogdir

Create the Media Manager legacy log directories in the following locations:

■ On Windows: install_path\Volmgr\debug

■ On UNIX: /usr/openv/volmgr/debug

In the case of legacy logging, NetBackup uses the configuration file (the Windows
registry or the bp.conf file on UNIX) to set the maximum size of a log file. Use the
bpsetconfig command-line interface to configure the following parameters:

■ The MAX_LOGFILE_SIZE parameter indicates the maximum size of a log file.
When the log file size in NetBackup matches the MAX_LOGFILE_SIZE setting,
the next logs are stored in a new log file.
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See “MAX_LOGFILE_SIZE option for NetBackup servers and clients for legacy
logging” on page 311.

■ The MAX_NUM_LOGFILES parameter indicates the maximum number of log files
that can be created in NetBackup. When the number of log files matches the
MAX_NUM_LOGFILES setting, the older log files are purged.
See “MAX_NUM_LOGFILES option for NetBackup servers and clients for legacy
logging” on page 312.

Note: Do not edit the configuration file manually because incorrect syntax or
characters in the file may adversely affect NetBackup operations.

See the NetBackup Commands Reference Guide for information about the
bpsetconfig command.

Unified logging
Unified logging creates log file names andmessages in a format that is standardized
across Veritas products. Some NetBackup processes on the server use unified
logging.

Unified logging writes the logs into subdirectories in the following locations:

■ On Windows: install_path\NetBackup\logs

■ On UNIX: /usr/openv/logs

Unlike legacy logging, subdirectories for the processes that use unified logging are
created automatically.

Note: Do not save logs to a remote file system such as NFS or CIFS. Logs that are
stored remotely and then grow large can cause critical performance issues.

In the case of unified logging, NetBackup uses the nblog.conf configuration file
to set the maximum size of a log file. Use the vxlogcfg command to configure the
following log settings in the nblog.conf file:

■ Configure the MaxLogFileSizeKB parameter to set the maximum size of a log
file. When the log file size in NetBackup matches the MaxLogFileSizeKB setting,
the next logs are stored in a new log file.

■ Configure the NumberOfLogFiles parameter to set the maximum number of log
files that you want to create in NetBackup. When the number of log files in
NetBackupmatches the NumberOfLogFiles setting, the older log files are purged.
See the NetBackup Logging Reference Guide for more information about
controlling the log file size.
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Note: Do not edit the nblog.conf file manually. Incorrect syntax or characters in
the file may adversely affect NetBackup operations.

See the NetBackup Commands ReferenceGuide for information about the vxlogcfg
command and the nblog.conf file.

The Logging dialog box contains the following properties:

Table 3-39 Logging dialog box properties

DescriptionProperty

This property controls the logging level for all processes in the Logging dialog box that are set
to Same as global. The logging levels control the amount of information that the NetBackup
server writes to the logs.

■ No logging
No log is created for any process that is set to Same as global.

■ Minimum logging (default)
A small amount of information is logged for each process that is set to Same as global.
Use this setting unless advised otherwise by Veritas Technical Support. Other settings can
cause the logs to accumulate large amounts of information.

■ Levels 1 through 4
Progressively more information is logged at each level for each process that is set to Same
as global.

■ 5 (Maximum)
The maximum amount of information is logged for each process that is set to Same as global.

Some NetBackup processes allow individual control over the amount of information the process
writes to logs. For those processes you can specify a different logging level other than Same as
global.

Global logging
level
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Table 3-39 Logging dialog box properties (continued)

DescriptionProperty

The processes that are listed under Process specific overrides use Legacy logging.

These services require that you first create a log directory in the following location:

■ On Windows: install_path\NetBackup\logs\process_name
■ On UNIX: /usr/openv/netbackup/logs/process_name

The following settings are available for each process:

■ Same as global
Make this selection to use the same logging level as the Global logging level property. If
the Global logging level is set to No logging, no log is created for the individual process.

■ No logging
No log is created for the specific process.

■ Minimum logging
A small amount of information is logged for the specific process.

■ Levels 1 through 4
Progressively more information is logged at each level for the specific process.

■ 5 (Maximum)
The maximum amount of information is logged for the specific process.

Table 3-40 lists and describes the processes that use legacy logging.

Process specific
overrides

These services use unified logging.

Each service creates a log automatically in the following directories:

■ On Windows: install_path\NetBackup\logs
■ On UNIX: /usr/openv/logs

The following settings are available for each process:

■ Same as global
Make this selection to use the same logging level as the Global logging level property. If
the Global logging level is set to No logging, no log is created for the individual process.

■ No logging
No log is created for the specific process.

■ Minimum logging
A small amount of information is logged for the specific process.

■ Levels 1 through 4
Progressively more information is logged at each level for the specific process.

■ 5 (Maximum)
The maximum amount of information is logged for the specific process.

You can also use the vxlogcfg command to change debug levels.

Table 3-41 lists and describes the services that use unified logging.

Debug logging
levels for
NetBackup
services
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Table 3-39 Logging dialog box properties (continued)

DescriptionProperty

Click Enable to create logs for critical NetBackup processes. In previous NetBackup versions,
logging starts once you have created the log directories for the required processes. After you
click Enable, the log directories are automatically created for the critical NetBackup processes
and logging begins.

You can enable Logging for critical processes for master servers, media servers, and clients.

Note: Enabling Logging for critical processes is a one-time activity that you can do using the
NetBackup Administration Console. After the logging is enabled, you cannot disable it using the
Logging dialog box. To manually disable the logging for a process, disable the logging level of
the process.

See “Disabling the logging of NetBackup processes” on page 155.

If you have enabled Logging for critical processes, clickingDefaults does not modify Logging
for critical processes and Keep logs up to GB options. While changing the logging properties
for multiple hosts, if the Logging for critical processes option on one of the hosts is enabled,
clicking Defaults does not modify the Logging for critical processes and Keep logs up to GB
options of any host.

After the Logging for critical processes is enabled, NetBackup sets the log retention to the
default log size in GB. You can modify it by reconfiguring the Keep logs up to GB option.

Note: Clearing the Keep logs up to GB option may adversely affect NetBackup operations.
Veritas recommends that you specify the log retention in GBwhen Logging for critical processes
is enabled.

The following critical NetBackup processes are logged when you select the Enable option:

■ Master server processes: bprd and bpdbm.
■ Media server processes: bpbrm, bptm, and bpdm.
■ Client process: bpfis.

Specifies how many days to keep the logs in case you need the logs to evaluate failures. For
example, if you check the backups every day, you can delete the logs sooner than if you check
the backups once a month. However, the logs can consume a large amount of disk space, so do
not keep the logs any longer than necessary. The default is 28 days.

Specifies the length of time, in days, that the master server keeps its error catalog, job catalog,
and debug log information. NetBackup derives the Backup Status, Problems, All Log Entries,
and Media Log reports from the error catalog. Also limits the time period that these reports can
cover. When this time expires, NetBackup also deletes these logs (that exist) on media servers
and clients.

Keep logs for
days
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Table 3-39 Logging dialog box properties (continued)

DescriptionProperty

Specifies the size of the NetBackup logs that you want to retain. When the NetBackup log size
grows to this value, the older logs are deleted. To set the log size in GB, select the check box
and specify the value in GB.

This option is available for the master servers, media servers, and clients.

■ For master and media servers, the recommended value is 25 GB or greater.
■ For clients, the recommended value is 5 GB or greater.

When configuring this option, consider the NetBackup log pruning behavior. All logs are retained
until the log size reaches the high water mark, that is, 95% of the Keep logs up to GB value.
NetBackup checks for the log size every 10 minutes. Once the log size reaches the high water
mark, the deletion of older logs is started. The deletion continues until the log size reaches the
low water mark, that is, 85% of the Keep logs up to GB value.

Consider the following example:

■ The Keep logs up to GB option is set to 100 GB.
■ NetBackup logs are created and retained until the log size reaches the high water mark, that

is, 95 GB.
■ NetBackup checks the log size every 10 minutes and determines that the log size is 95 GB.
■ Log pruning is started and older logs are deleted until the log size reaches the low water mark,

that is, 85 GB.
■ Log pruning stops when the log size reaches 85 GB and all existing logs are retained until

the log size again reaches the high water mark.

If you do not select theKeep logs up to GB option, the default value is unlimited. The log retention
or log pruning does not happen based on the log size.

If bothKeep logs up to GB andKeep logs for days are selected, the logs are pruned depending
on the condition that occurs first.

If no log retention options are selected, the increasing log size may eventually lead to a situation
of low disk space, as all logs are retained.

Note: You can verify the log pruning behavior in NetBackup using the logs at the following
location:

On Windows: install_path\NetBackup\logs\nbutil

On UNIX: /usr/openv/netbackup/logs/nbutil

Keep logs up to
GB
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Table 3-39 Logging dialog box properties (continued)

DescriptionProperty

If NetBackup Vault is installed, the Keep Vault logs for property is enabled. Select the number
of days to keep the Vault session directories, or select Forever.

Session directories are found in the following location:

install_path\NetBackup\vault\sessions\vaultname\ session_x

Where session_x is the session number. This directory contains vault log files, temporary working
files, and report files.

Keep Vault logs
for

Note:While collecting NetBackup logs using Logging Assistant, the total NetBackup
log size may increase. If you have enabled the new Keep logs up to GB option
and the total NetBackup log size reaches its high water mark, logs are deleted.
Logs that you want to retain may also be deleted. To avoid the deletion of logs that
you want to retain, disable the Keep logs up to GB option while you collect logs
using Logging Assistant. Alternatively, you can set the Keep logs up to GB option
to a value higher than the current value, so that the important logs are not deleted
before the log collection is complete.

See “About the Logging Assistant” on page 1144.

Table 3-40 Process-specific overrides

DescriptionService

The NetBackup backup and restore manager.BPBRM logging level

The NetBackup tape manager.BPTM logging level

The NetBackup disk manager.BPDM logging level

The NetBackup Jobs Database Management daemon.BPJOBD logging level

The NetBackup database manager.BPDBM logging level

The NetBackup request daemon or manager.BPRD logging level
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Table 3-41 Debug logging levels for NetBackup services

DescriptionService

This property appears for master servers.
NBPEM creates Policy/Client tasks and
determines when jobs are due to run. If a
policy is modified or if an image expires,
NBPEM is notified and the appropriate
Policy/Client tasks are updated.

Policy Execution Manager

This property appears for master servers.
NBJM accepts the jobs that the Policy
Execution Manager submits and acquires the
necessary resources.

Job Manager

NBRBmakes the allocations for storage units,
tape drives, client reservations.

Resource Broker

NetBackup Administration Console logging
Legacy logging and unified logging write information about the NetBackup processes
that backup, restore, duplicate, and so on. You can also configure NetBackup so
that it writes log information about the NetBackup Administration Console. The
log information may be helpful to troubleshoot problems.

The NetBackup Logging Reference Guide describes how to troubleshoot the
NetBackup Administration Console:

http://www.veritas.com/docs/DOC5332

Disabling the logging of NetBackup processes
You can disable the logging of a NetBackup process by changing the logging level
of the process.

Note: To enable Logging for critical processes, in theNetBackupAdministration
Console, select NetBackup Management > Host Properties. Double-click on
Master Servers, Media Servers, or Clients and select a host. Open the Logging
properties and click Enable.

To disable the logging of a process by changing the logging level

◆ Do any of the following:

■ In the Logging dialog box, in the Process specific overrides pane, set
the logging level of the process to No logging.

155Configuring Host Properties
Logging properties

http://www.veritas.com/docs/DOC5332


■ Use the Logging Assistant to change the logging level of a process to disable
the logging of the process.
See “Disabling debug logging” on page 1159.

Note: For the processes for which you cannot change or disable logging
levels using the Logging > Process specific overrides pane or the Logging
Assistant, use the configuration file option.

■ Change or disable the logging level of a process by modifying using the
configuration file (the Windows registry or the bp.conf file in UNIX). Use
the bpsetconfig command to set the ProcessName_VERBOSE parameter
to -2.
Example 1 - To disable logging for the bprd process, use the bpsetconfig
command to set the value of BPRD_VERBOSE as follows:

bpsetconfig> BPRD_VERBOSE = -2

Example 2 - To disable logging for the bpfis process that is specific to
NetBackup clients, run the bpsetconfig command on the associatedmedia
server or master server with the - h host option to set the value of
BPFIS_VERBOSE as follows:

bpsetconfig> -h client_host_name

bpsetconfig> BPFIS_VERBOSE = -2

See the NetBackup Commands Reference Guide for information on the
bpsetconfig command.

Note: Do not edit the configuration file manually. Incorrect syntax or
characters in the file may adversely affect NetBackup operations.

Login Banner Configuration properties
Use the Login Banner Configuration properties to configure a banner screen that
appears each time a user logs into the NetBackup Administration Console, the
NetBackup web UI, or theBackup, Archive, and Restore client. The Login Banner
Configuration properties can be configured to make it mandatory for the user to
acknowledge the login banner screen before the user can access the console.

A different login banner can be configured for any master server, media server, or
client.
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Figure 3-26 shows example banner text for a media server.

Figure 3-26 Login Banner Configuration dialog box

The first time that the NetBackup Administration Console or the NetBackup web
UI is launched, the Login Banner Configuration properties are not configured so
no banner appears to the user. The Login Banner Configuration host properties
must be configured in order for the banner to appear.

The user can change the server once they log into the NetBackup Administration
Console. (On the File menu, click Change Server.) If the banner is configured for
the remote server, the banner appears on the remote server as well.

If a user opens a new console or window from the existing console, the banner
does not appear for the new window. (On the File menu, click the New Console
option or the New Window from Here option.)

Table 3-42 Login Banner Configuration dialog box properties

DescriptionProperty

Enter the text that is to appear in the banner.Login Banner Heading
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Table 3-42 Login Banner Configuration dialog box properties (continued)

DescriptionProperty

Enter the text for the banner message. The maximum is 29,000 characters.Text of login banner

Configure this option when approval is necessary to use the NetBackup
Administration Console, the NetBackup web UI, or the Backup, Archive,
and Restore client. Specific approval may be required due to a legal
agreement at the company in which the NetBackup environment resides.

If this option is enabled, users are required to click the Agree option and
then click OK before the console opens. The agreement is meant only for
the user that reads and agrees to the message.

If the user chooses Disagree, the screen is closed.

ShowAgree and Disagree buttons on
the login banner

Figure 3-27 NetBackup Administration Console - Login Banner with agreement
option enabled
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Figure 3-28 NetBackup Administration Console - Login Banner without
agreement option

The text that is entered into this dialog box can be found in the following files:

On Windows: install\netbackup\var\LoginBanner.conf

On UNIX: /usr/openv/var/LoginBanner.conf

Removing login banner screen and text
To remove the banner and the text that appears after a user logs into NetBackup,
use the following procedure:

To remove the login banner screen and text

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties.

2 Depending on the host that displays the login banner, select Master Servers,
Media Servers, or Clients).

3 In the right pane, double-click the host name to display the properties.

4 In the properties dialog box, in the left pane, click the Login Banner
Configuration host properties.

5 Clear the Login Banner Heading text and the login banner text.

6 Click OK to save the changes.
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Lotus Notes properties
The Lotus Notes properties apply to the clients that are currently selected and that
run NetBackup for Lotus Notes.

For more information, see the NetBackup for Lotus Notes Administrator’s Guide.

Figure 3-29 Lotus Notes dialog box

The following properties can be configured in the Lotus Notes host properties or
by using the nbgetconfig and nbsetconfig commands.

See “Methods to set the NetBackup configuration options” on page 53.

For UNIX servers: If you have multiple installations of Domino server, the values
in the client properties or the bp.conf only apply to one installation. For other
installations, specify the installation path and location of the notes.ini file with the
LOTUS_INSTALL_PATH and NOTES_INI_PATH directives in the backup policy.
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Table 3-43 Lotus Notes client host properties

DescriptionConfiguration optionsClient host
properties

The maximum number of logs that can be prefetched in a single
restore job during recovery. Specify a value greater than 1.

If this value is less than or equal to 1, NetBackup does not gather
transaction logs during recovery. One transaction log extent per
job is restored to the Domino server’s log directory.

LOTUS_NOTES_LOGCACHESIZE = 3

LOTUS_NOTES_LOGCACHESIZE

In the Windows registry, this value
is a DWORD value.

Maximum
number of
logs to
restore

Specify a path where NetBackup can temporarily store the
prefetched transaction logs during recovery.

For example:

■ On Windows: D:\LogCache
■ On UNIX: /tmp/logcache

If you do not specify a path, during recovery NetBackup restores
the logs to the Domino server's transaction log directory.

Note the following before specifying the Transaction log cache
path:

■ If the specified path does not exist then it is created during
restore.

■ The restore job fails with a Status 5 error if the user does not
have write permission for the folder.

■ Transaction logs are restored to the original location, the
Domino transaction log directory, if a path is not specified.

■ If the value of Maximum number of logs to restore is less
than or equal to 1 then this path is ignored. The logs are not
prefetched; one transaction log per job is restored to the
Domino Server’s log directory.

■ If there is not sufficient space to restore the specified number
of logs, NetBackup tries to restore only the number of logs
that can be accommodated.

LOTUS_NOTES_LOGCACHEPATH

In the Windows registry, this value
is a string value.

Transaction
log cache
path
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Table 3-43 Lotus Notes client host properties (continued)

DescriptionConfiguration optionsClient host
properties

Enter the NOTES.INI file that is associated with the server used
to back up and restore the Lotus database. Use this setting to
specify the correct .INI file to back up and restore from Domino
partitioned servers. Specifying the .INI file for non-partitioned
servers is not necessary.

Specify the absolute path to the NOTES.INI file:

■ On Windows:
If the notes.ini file is not located in the default directory,
indicate its location in the INI path box. For example:
D:\Lotus\Domino\notes.ini

■ On UNIX:
If the notes.ini is not located in the directory that is specified
in the Path, indicate its location here. For example:
/db/notesdata/notes.ini

Include the directory and the notes.ini file name.

LOTUS_NOTES_INI

In the Windows registry, this value
is a string value.

INI path

Specify the path where the Lotus Notes program files reside on
the client. NetBackupmust knowwhere these files are to perform
backup and restore operations. The value in this box overrides
the Lotus registry key, if both are defined.

Specify the path where the Lotus Notes program files reside on
the client:

■ On Windows:
Specify the path for Lotus program directory (where
nserver.exe resides). For example:
D:\Lotus\Domino

■ On UNIX:
Specify a path that includes the Domino data directory, the
Lotus program directory, and the Lotus resource directory.
For example:
/export/home/notesdata:/opt/lotus/notes/latest

/sunspa:/opt/lotus/notes/latest/sunspa/res/C

The Path value overrides the Lotus registry value, if both are
defined.

LOTUS_NOTES_PATH

In the Windows registry, this value
is a string value.

Path
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Media properties
The Media properties apply to the master servers and media servers that are
currently selected. Media properties control how NetBackup manages media.

Figure 3-30 Media dialog box

The Media dialog box contains the following properties.
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Table 3-44 Media dialog box properties

DescriptionProperty

This property overrides the NetBackup overwrite protection for specific media types.
Normally, NetBackup does not overwrite certain media types. To disable overwrite
protection, place a check in the check box of one or more of the listed media formats.

For example, place a check in the CPIO check box to permit NetBackup to overwrite
the cpio format.

By default, NetBackup does not overwrite any of the formats on removable media, and
logs an error if an overwrite attempt occurs. This format recognition requires that the
first variable length block on a media be less than or equal to 32 kilobytes.

The following media formats on removable media can be selected to be overwritten:

■ When ANSI is enabled, ANSI labeled media can be overwritten.
■ When AOS/VS is enabled, AOS/VS media can be overwritten. (Data General

AOS/VS backup format.)
■ When CPIO is enabled, CPIO media can be overwritten.
■ When DBR is enabled, DBR media can be overwritten. (The DBR backup format

is no longer used.)
■ Remote Storage MTF1 media format. When MTF1 is enabled, Remote Storage

MTF1 media format can be overwritten.
■ When TAR is enabled, TAR media can be overwritten.
■ When MTF is enabled, MTF media can be overwritten. With only MTF checked, all

other MTF formats can be overwritten. (The exception is Backup Exec MTF
(BE-MTF1) and Remote Storage MTF (RS-MTF1) media formats, which are not
overwritten.

■ When BE-MTF1 is enabled, Backup Exec MTF media can be overwritten.

See “Results when media overwrites are not permitted” on page 167.

Allow media overwrite
property
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Table 3-44 Media dialog box properties (continued)

DescriptionProperty

This property allows exclusive access protection for tape drives. With access protection,
other host bus adaptors cannot issue commands to control the drives during the
reservation.

SCSI reservations provide protection for NetBackup Shared Storage Option
environments or any other multiple-initiator environment in which drives are shared.

The protection setting configures access protection for all tape drives from the media
server on which the option is configured. You can override the media server setting
for any drive path from that media server.

See “Recommended use for Enable SCSI reserve property” on page 168.

See “Drive path options” on page 459.

The following are the protection options:

■ The SCSI persistent reserve option provides SCSI persistent reserve protection
for SCSI devices. The devices must conform to the SCSI Primary Commands - 3
(SPC-3) standard.

■ The SPC-2 SCSI reserve option (default) provides SPC-2 SCSI reserve protection
for SCSI devices. The devicesmust conform to the reserve and releasemanagement
method in the SCSI Primary Commands - 2 standard.

■ To operate NetBackup without tape drive access protection, clear the Enable SCSI
reserve property. If unchecked, other HBAs can send the commands that may
cause a loss of data to tape drives.

Note: Ensure that all of your hardware processes SCSI persistent reserve commands
correctly. All of your hardware includes Fibre Channel bridges. If the hardware does
not process SCSI persistent reserve commands correctly and NetBackup is configured
to use SCSI persistent reserve, no protection may exist.

Enable SCSI reserve

This property lets NetBackup mix retention levels on tape volumes. It applies to media
in both robotic drives and nonrobotic drives. The default is that the check box is clear
and each volume can contain backups of only a single retention level.

Allow multiple retentions
per media

This property, when checked, lets backups span to multiple tape media. This property
lets NetBackup select another volume to begin the next fragment. The resulting backup
has data fragments on more than one volume. The default is that Allow backups to
span tape media is checked and backups are allowed to span media.

If the end of media is encountered and this property is not selected, the media is set
to FULL and the operation terminates abnormally. This action applies to both robotic
drives and nonrobotic drives.

Allow backups to span tape
media
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Table 3-44 Media dialog box properties (continued)

DescriptionProperty

This property lets backups span disk volumes when one disk volume becomes full.
The default is that this property is enabled.

The Allow backups to span disk property does not apply to AdvancedDisk or
OpenStorage storage units. Backups span disk volumes within disk pools automatically.

The following destinations support disk spanning:

■ A BasicDisk storage unit spanning to a BasicDisk storage unit. The units must be
within a storage unit group.

■ An OpenStorage or AdvancedDisk volume spanning to another volume in the disk
pool.

For disk spanning to occur, the following conditions must be met:

■ The storage units must share the same media server.
■ The multiplexing level on spanning storage units should be the same. If there are

any differences, the level on the target unit can be higher.
See “Enable multiplexing storage unit setting” on page 606.

■ A disk staging storage unit cannot span to another storage unit. Also, a disk staging
storage unit is not eligible as a target for disk spanning.

■ Disk spanning is not supported on NFS.

Allow backups to span disk

This property lets NetBackup use whatever labeled or unlabeled media is found in a
nonrobotic drive. The default is that the Enable standalone drive extension property
is enabled.

Enable standalone drive
extension

This property allows the logging of the job information. This logging is the same
information that the NetBackup Activity Monitor uses. The default is that job logging
occurs.

Enable job logging

This property controls media sharing, as follows:

■ Enable this property to allow all NetBackup media servers and NDMP hosts in the
NetBackup environment to share media for writing. Do not configure server groups
for media sharing.

■ Clear this property to restrict media sharing to specific server groups. Then configure
media server groups and backup policies to use media sharing.

■ Clear this property to disable media sharing. Do not configure media server groups.

The default is that media sharing is disabled. (The property is cleared and no server
groups are configured.)

See “About NetBackup server groups” on page 400.

Enable unrestricted media
sharing for all media
servers
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Table 3-44 Media dialog box properties (continued)

DescriptionProperty

This property specifies the media ID prefix to use in media IDs when the unlabeled
media is in nonrobotic drives. The prefix must be one to three alpha-numeric characters.
NetBackup appends numeric characters. By default, NetBackup uses A and assigns
media IDs such as A00000, A00001, and so on.

For example, if FEB is specified, NetBackup appends the remaining numeric characters.
The assigned media IDs become FEB000, FEB001, and so on. (Note that this
numbering does not work with the Configure Volumes wizard).

Media ID prefix
(non-robotic)

To specify a Media unmount delay property indicates that the unloading of media is
delayed after the requested operation is complete. Media unmount delay applies only
to user operations, to include backups and restores of database agent clients, such
as those running NetBackup for Oracle. The delay reduces unnecessary media
unmounts and the positioning of media in cases where the media is requested again
a short time later.

The delay can range from 0 seconds to 1800 seconds. The default is 180 seconds. If
you specify 0, the media unmount occurs immediately upon completion of the requested
operation. Values greater than 1800 are set to 1800.

Media unmount delay

This property specifies how long NetBackup waits for media in nonrobotic drives. A
configurable delay is useful if a gravity feed stacker is used on a nonrobotic drive. A
delay often exists between dismounting one media and mounting another. The default
is 0 seconds.

During the delay period, NetBackup checks every 60 seconds to see if the drive is
ready. If the drive is ready, NetBackup uses it. Otherwise, NetBackup waits another
60 seconds and checks again. If the total delay is not a multiple of 60, the last wait is
the remainder. If the delay is less than 60 seconds, NetBackup checks after the end
of the delay.

For example, set the delay to 150 seconds. NetBackup waits 60 seconds, checks for
ready, waits 60 seconds, checks for ready, waits 30 seconds, and checks for ready
the last time. If the delay was 50 seconds (a short delay is not recommended),
NetBackup checks after 50 seconds.

Media request delay

Results when media overwrites are not permitted
If media contains one of the protected formats and media overwrites are not
permitted, NetBackup takes the following actions:

■ Sets the volume’s state to FROZEN
■ Selects a different volume
■ Logs an error

If the volume has not been previously
assigned for a backup
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■ Sets the volume’s state to SUSPENDED
■ Aborts the requested backup
■ Logs an error

If the volume is in the NetBackup media
catalog and was previously selected for
backups

The backup is aborted and an error is logged.
The error indicates the volume cannot be
overwritten.

If the volume is mounted for a backup of the
NetBackup catalog

NetBackup aborts the request and logs an
error. The error indicates that the volume
does not have a NetBackup format.

If the volume is mounted to restore files or list
the media contents

Recommended use for Enable SCSI reserve property
All tape drive and bridge vendors support the SPC-2 SCSI reserve and release
method. NetBackup has used SPC-2 SCSI reserve since NetBackup 3.4.3, and it
is the default tape drive reservation method in NetBackup. SPC-2 SCSI reserve is
effective for most NetBackup environments.

The SCSI persistent reserve method provides device status and correction and
may be more effective in the following environments:

■ Where NetBackup media servers operate in a cluster environment.
NetBackup can recover and use a reserved drive after a failover (if NetBackup
owns the reservation). (With SPC-2 SCSI reserve, the drive must usually be
reset because the reservation owner is inoperative.)

■ Where the drive has high availability.
NetBackup can resolve NetBackup drive reservation conflicts andmaintain high
drive availability. (SPC-2 SCSI reserve provides no method for drive status
detection.)

However, the SCSI persistent reserve method is not supported or not supported
correctly by all device vendors. Therefore, thoroughly analyze the environment to
ensure that all of the hardware supports SCSI persistent reserve correctly.

Veritas recommends careful consideration of all of the following factors before
Enable SCSI reserve is used:

■ Only a limited number of tape drive vendors support SCSI persistent reserve.

■ SCSI persistent reserve is not supported or not supported correctly by all Fibre
Channel bridge vendors. Incorrect support in a bridge means no access
protection. Therefore, if the environment uses bridges, do not use SCSI persistent
reserve.

■ If parallel SCSI buses are used, carefully consider the use of SCSI persistent
reserve. Usually, parallel drives are not shared, so SCSI persistent reserve
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protection is not required. Also, parallel drives are usually on a bridge, and
bridges do not support SCSI persistent reserve correctly. Therefore, if the
environment uses parallel SCSI buses, do not use SCSI persistent reserve.

■ The operating system tape drivers may require extensive configuration to use
SCSI persistent reserve. For example, if the tape drives do not support SPC-3
Compatible Reservation Handling (CRH), ensure that the operating system does
not issue SPC-2 reserve and release commands.

If any of the hardware does not support SCSI persistent reserve, Veritas
recommends that SCSI persistent reserve is not used.

NDMP Global Credentials properties
The credentials that are entered for NDMP Global Credentials can apply to any
NDMP host in the configuration. However, the Use global NDMP credentials for
this NDMP host option must be selected in the Add NDMP Host dialog box for
the NDMP host.

Figure 3-31 NDMP Global Credentials dialog box
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The NDMP Global Credentials properties dialog box contains the following
properties.

Table 3-45 NDMP Global Credentials dialog box properties

DescriptionProperty

The user name under which NetBackup accesses the NDMP server. This user must
have permission to run NDMP commands.

User name

Enter the password.Password

Re-enter the password.Confirm password

To access the Add NDMP Host dialog box, add an NDMP host under Media and
Device Management > Credentials > NDMP Hosts.

Figure 3-32 shows the Add NDMP Host dialog box. In the Credentials section,
selectUse global NDMP credentials for this NDMPhost so that theNDMPGlobal
Credentials apply to that host.

Note: Be careful when you add an NDMP host. If you add NDMP host credentials
using the fully qualified domain name (FQDN), you must also indicate the fully
qualified domain name on the client for lookups. That is, the server list in the Backup,
Archive, and Restore administration console must list the NDMP host by the FQDN
as well.

If you add NDMP host credentials using its short name, you can use either the short
name or the FQDN in the client server list.
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Figure 3-32 Add NDMP Host dialog box

For NDMP Global Credentials
to apply, this must be selected
on the NDMP host as well

Network properties
Use the Network properties to set the properties that define requirements for
communications between clients and the master server. The Network properties
apply to currently selected Windows clients.
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Figure 3-33 Network dialog box

The Network dialog box contains the following properties.

Table 3-46 Network dialog box properties

DescriptionProperty

This property specifies the port that the NetBackup client uses to communicate with
the NetBackup server. The default is 13782.

Note: If you change this port number, remember that it must be the same for all
NetBackup servers and clients that communicate with one another.

NetBackup client service
port (BPCD)

This property specifies the port for the client to use when it sends requests to the
NetBackup request service (bprd process) on the NetBackup server. The default is
13720.

Note: If you change this port number, remember that it must be the same for all
NetBackup servers and clients that communicate with one another.

NetBackup request service
port (BPRD)
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Table 3-46 Network dialog box properties (continued)

DescriptionProperty

This property specifies how many minutes the client waits before it announces that a
different IP address is to be used. The announcement occurs only if the specified time
period has elapsed and the address has changed since the last time the client
announced it.

Announce DHCP interval

Network Settings properties
TheNetwork Settings host properties apply to master servers, media servers, and
clients.

Figure 3-34 Network Settings dialog box

The Network Settings dialog box contains properties for Reverse Host Name
Lookup and IP Address Family Support.
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Reverse Host Name Lookup property
The domain name system (DNS) reverse host name lookup is used to determine
what host and domain name a given IP address indicates.

Some administrators cannot or do not want to configure the DNS server for reverse
host name lookup. For these environments, NetBackup offers the Reverse Host
Name Lookup property to allow, restrict, or prohibit reverse host name lookup.

Administrators can configure the Reverse Host Name Lookup property for each
host.

Table 3-47 Reverse Host Name Lookup property settings

DescriptionProperty

The Allowed property indicates that the host requires reverse host name lookup to
work to determine that the connection comes from a recognizable server.

By default, the host resolves the IP address of the connecting server to a host name
by performing a reverse lookup.

If the conversion of the IP address to host name fails, the connection fails.

Otherwise, it compares the host name to the list of known server host names. If the
comparison fails, the host rejects the server and the connection fails.

Allowed setting

The Restricted property indicates that the NetBackup host first attempts to perform
reverse host name lookup. If the NetBackup host successfully resolves the IP address
of the connecting server to a host name (reverse lookup is successful), it compares
the host name to the list of known server host names.

If the resolution of the IP address to a host name fails (reverse lookup fails), based on
the Restricted setting, the host converts the host names of the known server list to IP
addresses (using a forward lookup). The host compares the IP address of the connecting
server to the list of known server IP addresses.

If the comparison fails, the host rejects the connection from server and the connection
fails.

Restricted setting

The Prohibited property indicates that the NetBackup host does not try reverse host
name lookup at all. The host resolves the host names of the known server list to IP
addresses using forward lookups.

The NetBackup host then compares the IP address of the connecting server to the list
of known server IP addresses.

If the comparison fails, the NetBackup host rejects the connection from the server and
the connection fails.

Prohibited setting
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Reverse Host Name Lookup changes outside of the
Administration Console
In some cases, a master server may not be able to view the host properties of a
media server or client in theNetBackup Administration Console. The NetBackup
customer's DNS reverse host name lookup configuration may be one possible
reason why the Host Properties may not be visible.

In this case, since changing the NetBackup Reverse Host Name Lookup host
property requires being able to view theHost Properties, you’ll need to use another
method to change it.

Configure the REVERSE_NAME_LOOKUP option by using the nbgetconfig and
nbsetconfig commands. The nbsetconfig command configures the option on
Windows and UNIX master servers and clients.

See “Methods to set the NetBackup configuration options” on page 53.

The REVERSE_NAME_LOOKUP entry uses the following format:

REVERSE_NAME_LOOKUP = ALLOWED | RESTRICTED | PROHIBITED

For example:

REVERSE_NAME_LOOKUP = PROHIBITED

The values of ALLOWED, RESTRICTED, and PROHIBITED represent the samemeaning
as the values in the Network Settings host properties.

IP Address Family Support property
On the hosts that use both IPv4 and IPv6 addresses, use the IP Address Family
Support property to indicate which address family to use:

■ IPv4 only (Default)

■ IPv6 only

■ Both IPv4 and IPv6

While the IP Address Family Support property controls how host names are
resolved to IP addresses, the Preferred Network properties control how NetBackup
uses the addresses.

Port Ranges properties
Use the Port Ranges properties in the NetBackup Administration Console to
determine how hosts connect to one another. These properties apply to selected
master servers, media servers, and clients.
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Figure 3-35 Port Ranges dialog box

The Port Ranges dialog box contains the following properties.

Table 3-48 Port Ranges dialog box properties

DescriptionProperty

Specifies how the selected computer chooses a port when it communicates with
NetBackup on other computers. Enable this property to let NetBackup randomly select
ports from those that are free in the allowed range. For example, if the range is from
1023 through 5000, it chooses randomly from the numbers in this range.

If this property is not enabled, NetBackup chooses numbers sequentially, not randomly.
NetBackup starts with the highest number that is available in the allowed range. For
example, if the range is from 1023 through 5000, NetBackup chooses 5000. If 5000 is
in use, port 4999 is chosen.

This property is enabled by default.

Use random port
assignments

Lets the administrator define the range of non-reserved ports on the selected computer.
NetBackup can use any available port within this range as the source port when
communicating with NetBackup on another computer.

Client port window
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Table 3-48 Port Ranges dialog box properties (continued)

DescriptionProperty

Lets the operating system determine which non-reserved port to use.Use OS selected non
reserved port

This setting defines the range of reserved ports to use as the source port for the
connection to NetBackup services. (By default, a NetBackup host uses a non-reserved
port to connect to destination host names.)

If the following conditions are true, NetBackup chooses a port from the specified range:

■ The destination host name is local to the connecting host.
■ The local host name configuration uses a reserved port for the source port rather

than a non-reserved port.
■ The destination port is a daemon port. The local host name uses a daemon port

for the destination if one of the following is true:
■ The destination connect option for the local host name specifies that a daemon

port be used.
■ Attempts to connect to destination ports 1556 and 13274 on the local host fail,

which causes the daemon port to be used.

Other topics describe how to configure the local host to use a reserved source port
and the destination port number for connections.

See “CONNECT_OPTIONS option for NetBackup servers and clients” on page 274.

See “DEFAULT_CONNECT_OPTIONS option for NetBackup servers and clients”
on page 277.

Beginning with NetBackup 7.0.1, connections to other daemon ports use only theClient
port window, not the Client reserved port window.

Client reserved port
window

This property specifies the range of non-reserved ports on which NetBackup processes
on this computer accept connections from NetBackup when the connection is not to a
well known port. This property primarily applies to bpcd call-back when vnetd is
disabled in the connect options and the local host name is configured for non-reserved
ports.

This property also applies in the situation where a third-party protocol is used, such as
NDMP. It specifies the range of non-reserved ports on which this server accepts
NetBackup connections from other computers. The default range is 1024 through 5000.

Instead of indicating a range of ports, you can enable Use OS selected non reserved
port to let the operating system determine which non-reserved port to use.

This setting applies to the selected master or media server. The Accept connections
on non reserved ports property must be enabled in the Universal Settings dialog
box for hosts running NetBackup 7.0.1 and prior versions.

See “Universal Settings properties” on page 241.

Server port window
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Table 3-48 Port Ranges dialog box properties (continued)

DescriptionProperty

This entry specifies the range of local reserved ports on which this computer accepts
connections from NetBackup when the connection is not to a well known port. This
property primarily applies to bpcd call-back when vnetd is disabled in the connect
options for a local host name.

Server reserved port
window

Registered ports and dynamically-allocated ports
NetBackup communicates between computers by using a combination of registered
ports and dynamically-allocated ports.

Registered ports
These ports are registered with the Internet Assigned Numbers Authority (IANA)
and are permanently assigned to specific NetBackup services. For example, the
port for the NetBackup client daemon (bpcd) is 13782.

The following system configuration file can be used to override the default port
numbers for each service:

On Windows: %systemroot%\system32\drivers\etc\services

On UNIX: /etc/services

Note: Veritas recommends that the port numbers that are associated with PBX
(1556 and 1557) not be changed.

Dynamically-allocated ports
These ports are assigned as needed, from configurable ranges in the Port Ranges
host properties for NetBackup servers and clients.

In addition to the range of numbers, you can specify whether NetBackup selects a
port number at random or starts at the top of the range and uses the first one
available.

Preferred Network properties
Use the Preferred Network properties in theNetBackup Administration Console
to specify to NetBackup which networks or interfaces to use for outgoing NetBackup
traffic from the selected hosts. These properties apply to currently selected master
servers, media servers, and clients.

The corresponding configuration option for this property is PREFERRED_NETWORK.
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See “PREFERRED_NETWORK option for NetBackup servers” on page 318.

Note: The Preferred Network setting in NetBackup does not apply to the Granular
Recovery Technology (GRT) and VMware Instant Recovery features. Network
settings that are configured in the operating system are used for these features
during communication.

Preferred Network entries are not needed if NetBackup is configured using host
names with IP addresses to which the operating system resolves and then routes
correctly.

When external constraints prevent the environment from being corrected, Preferred
Network entries may be useful as follows:

■ Can be used to prevent NetBackup from connecting to specific destination
addresses.

■ Can be used to cause NetBackup to connect only to specific destination
addresses.

■ Can be used to request a subset of local interfaces for source binding when
making outbound connections.

Caution:When used for source binding, the operating system may not honor the
source binding list provided by NetBackup. If the operating system implements the
weak host model, asymmetrical network routing may result. If asymmetrical routing
occurs, the remote host may reject the inbound connection if it implements the
strong host model. Similarly, stateful network devices may also drop asymmetrical
connections. To ensure the use of specific outbound interfaces for specific remote
hosts or networks, make sure that the OS name resolution and routing configurations
are correct; create static host routes if needed. Ensure that all network drivers
properly implement the IP and TCP networking protocols.

The local Preferred Network entries do not affect the forwarding profile that the
local host returns to a remote host during initial CORBA connection setup; it will
contain all the local plumbed interfaces. However, the End Point Selection algorithm
within the remote process will utilize its local Preferred Network entries to evaluate
the profile when selecting the destination for the subsequent CORBA connection.

With respect to source binding, the Preferred Network properties offer more
flexibility than the Use specified network interface property in the Universal
Settings properties. The Use specified network interface property can be used
to specify only a single interface for NetBackup to use for outbound calls. The
Preferred Network properties were introduced so that administrators can give
more elaborate and constrictive instructions that apply to multiple individual networks,
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or a range of networks. For example, an administrator can configure a host to use
any network except one. If both properties are specified, Use specified network
interface overrides Preferred Network.

Note: Do not inadvertently configure hosts so that they cannot communicate with
any other host. Use the bptestnetconn utility to determine whether the hosts can
communicate as you intend.

See “bptestnetconn utility to display Preferred Network information” on page 189.

Figure 3-36 Preferred Network dialog box

The Preferred Network dialog box contains a list of networks and the directive that
has been configured for each.
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Table 3-49 Preferred Network dialog box properties

DescriptionProperty

The list of preferred networks contains the following information:

■ The Target column lists the networks (or host names or IP addresses) that have been
given specific directives. If a network is not specifically listed as a target, or if a range
of addresses does not include the target, NetBackup considers the target to be available
for selection.
Note that if the same network considerations apply for all of the hosts, the list of directives
can be identical across all hosts in the NetBackup environment. If a directive contains
an address that does not apply to a particular host, that host ignores it. For example,
an IPv4-only host ignores IPv6 directives, and IPv6-only hosts ignore IPv4 directives.
This lets the administrator use the same Preferred Network configurations for all the
hosts in the NetBackup environment.

■ The Specified as column indicates the directive for the network: Match, Prohibited,
or Only.

■ The Source column lists source binding information to use to filter addresses. The
Source property is an optional configuration property.

List of network
specifications for
NetBackup
communications

Select a network in the list, then click the up or down arrow to change the order of the
network in the list. The order can affect which network NetBackup selects.

See “Order of directive processing in the Preferred Network properties” on page 188.

Ordering arrows

Click Add to add a network to the Preferred Network properties. The directive for the
network is configured in the Add Preferred Network Settings dialog box.

See Table 3-50 on page 182.

Add

The Add to all button is active when multiple servers are selected.Add to all

Select a network in the list, then clickChange to change the Preferred Network properties.
The directive is changed in the Change Preferred Network Settings dialog box.

See “Add or Change Preferred Network Settings dialog box” on page 181.

Change

Select a network in the list, then click Remove to remove the network from the list of
preferred networks.

Remove

Add or Change Preferred Network Settings dialog box
TheAdd Preferred Network Settings dialog box contains the following properties.
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Table 3-50 Add or Change Preferred Network Settings dialog box properties

DescriptionProperty

Enter a network address or a host name:

■ NetBackup recognizes the following wildcard entries as addresses:
■ 0.0.0.0

Matches any IPv4 address.
■ 0::0

Matches any IPv6 address.
■ 0/0

Matches the address of any family.
■ If the target is a host name which resolves to more than one IP address, only the first IP

address will be used.
■ If a subnet is not specified, the default is /128 when the address is non-zero and /0 when the

address is 0. This applies to both Target and Source properties.
A subnet of /0 cannot be used with a non-zero address because it effectively negates all of
the bits in the address, making the target or the source match every address. For example,
0/0.

Note: Do not use the following malformed entries as wildcards: 0/32, 0/64, or 0/128. The left
side of the slash must be a legitimate IP address. However, 0/0 may be used, as listed.

Target

The Match directive:

■ Applies when Target is a destination address.
■ Indicates that the specified network, address, or host name is preferred for communication

with the selected host.
■ Does not reject other networks, addresses, or host names from being selected, even if they

do not match. (The Only directive rejects unsuitable targets if they do not match.)
■ Is useful following a Prohibited or a Only directive. When used with other directives, Match

indicates to NetBackup to stop rule processing because a suitable match has been found.
■ Can be used with the Source property to indicate source binding.

Match

Use the Prohibited directive to exclude or prevent the specified network, address, or host name
from being used.

The Target is applied to both the source and the destination addresses. If a Source is specified
and the Prohibited is indicated, it is ignored but the target is still prohibited.

If the matched address is a destination address, evaluation stops. If this was the only potential
destination, the connection is not attempted. If there are additional potential destinations, they
are evaluated starting over with the first entry.

If the matched address is a source address, it is removed from the source binding list.

Caution: On some platforms, prohibiting a local interface may cause unexpected results when
connecting to remote hosts. Prohibiting a local interface does not affect connections that are
internal to the host.

Prohibited
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Table 3-50 Add or Change Preferred Network Settings dialog box properties
(continued)

DescriptionProperty

The Only directive:

■ Applies to destination addresses.
■ Indicates that the specified network, address, or host name that is used for communication

with the selected host must be in the specified network.
Use theOnly directive to prevent any network from being considered other than those specified
as Only.

■ If the address that is being evaluated does not match the target, it is not used and evaluation
stops for that address. If the address being evaluated was the only potential destination, the
connection is not attempted. If there is an additional potential destination, it is evaluated
starting over with the first entry.

■ Can be used with the Source property to indicate source binding.

Only

Use this property with the Match or the Only directives to identify the local host name, IP
addresses, or networks that may be used for source binding.

If a subnet is not specified, the default is /128.

If this host has an IP address that matches Source, that IP address will be used as the source
when connecting to the destination. If the Source is not valid for this host, it is ignored.

Source

How NetBackup uses the directives to determine which network to
use

Each host has an internal table of preferred network rules that NetBackup consults
before it selects a network interface to use for communication with another host.
The table includes every interface-IP address combination available to the selected
host. Based on the Preferred NetBackup directives, the table indicates to
NetBackup whether or not the host is allowed to use a given network.

This topic uses the example of two multihomed servers (Server_A and Server_B)
as shown in Figure 3-37. Server A is considering which addresses it can use to
access Server_B, given the Preferred Network directives configured on Server_A.

When Preferred Network directives are used to place restrictions on targets, they
are added from the perspective of the server making the connection. The directives
on Server_A affect its preferences as to which Server_B addresses it can use.
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Figure 3-37 Multihomed servers example

2001:db8:0:11d::1efc

Backup interface

10.96.73.253

Backup interface

Server_B

Server_A

Directives on Server_A indicate
what interfaces it can use to
access Server_B

2001:db8:0:11e::1efc
2001:db8:0:11c::1efc

Backup interface

10.81.73.147
2001:db8:0:1f0::1efc

Production interface

Figure 3-38 shows a table for Server_B. Server_B has multiple network interfaces,
some of which havemultiple IP addresses. In the table, yes indicates that NetBackup
can use the network-IP combination as a source. In this example, no directives
have been created for the host. Since no networks are listed in the Preferred
Network properties, any network-IP combinations can be used for communication.

Note: The following topic shows the bptestnetconn output for this example
configuration:

See “bptestnetconn utility to display Preferred Network information” on page 189.
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Figure 3-38 From Server_A's perspective: Available IP addresses on
Server_B when no directives are indicated on Server_A
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Figure 3-39 shows a table for the same host (Server_B). Now, the Preferred
Network properties are configured so that all IPv4 addresses are excluded from
selection consideration by NetBackup. All NetBackup traffic is to use only IPv6
addresses.

Figure 3-39 From Server_A's perspective: Available IP addresses on
Server_B when directives to use IPv6 addresses only are
indicated on Server_A
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The following topics describe various configurations:

■ See “Configurations to use IPv6 networks” on page 186.

■ See “Configurations to use IPv4 networks” on page 187.

■ See “Configuration to prohibit using a specified address” on page 190.

■ See “Configuration to prefer a specified address” on page 190.
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■ See “Configuration that restricts NetBackup to one set of addresses” on page 191.

■ See “Configuration that limits the addresses, but allows any interfaces”
on page 192.

Configurations to use IPv6 networks
The following Preferred Network configurations instruct NetBackup to use only
IPv6 addresses as targets in outbound calls for the currently selected hosts. The
configurations satisfy a topology where all backup traffic uses an IPv6 network and
other traffic uses other networks.

One configuration uses the Prohibited directive (Figure 3-40) and one configuration
uses the Match directive (Figure 3-41).

The more efficient method to specify one address family, (IPv6, in this case), is to
prohibit IPv4. The behavior of theMatch directive is not as exclusive as Prohibited.
In this case, Match may not necessarily exclude other address families.

Figure 3-40 uses the Prohibited directive with a wildcard to indicate to NetBackup
to not consider using any IPv4 addresses. In this situation, NetBackup must use
an IPv6 address.

Note: The default configuration is for NetBackup to use only IPv4 addresses.

If you have not previously changed the Network Settings > IP Address Family
Support option to Both IPv4 and IPv6 or IPv6 only, creating a directive that
prohibits all IPv4 addresses renders the server mute.

See “IP Address Family Support property” on page 175.

See “Network Settings properties” on page 173.

Figure 3-40 Prohibit IPv4 addresses as targets

Figure 3-41 uses the Match directive with a wildcard to indicate to NetBackup to
prefer IPv6 addresses. In this case, NetBackup tries to use an IPv6 address, but
may consider IPv4 addresses if necessary.
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Figure 3-41 Match IPv6 addresses as targets

Figure 3-42 shows another configuration that allows NetBackup to choose from
multiple IPv6 networks.

Given the multihomed example configuration, the directive indicates the following:

■ Four IPv6 networks, from fec0:0:0:fe04 through fec0:0:0:fe07, are described
as targets.

■ For all addresses in these networks, a source binding address that is derived
from the IP addresses of host name host_fred is used.

See “How NetBackup uses the directives to determine which network to use”
on page 183.

Figure 3-42 Indicating a range of IPv6 networks

Configurations to use IPv4 networks
The following Preferred Network configurations instruct NetBackup to use only
IPv4 addresses as targets in outbound calls for the currently selected hosts. The
configurations satisfy a topology where all backup traffic uses an IPv4 network and
other traffic uses other networks.

One configuration uses the Prohibited directive (Figure 3-43) and one configuration
uses the Match directive (Figure 3-44).

The more efficient method to specify one address family, (IPv4, in this case), is to
prohibit IPv6. The behavior of theMatch directive is not as exclusive as Prohibited.
In this case, Match may not necessarily exclude other address families.
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Figure 3-43 uses the Prohibited directive with a wildcard to indicate to NetBackup
to not consider using any IPv6 addresses. In this situation, NetBackup must use
an IPv4 address.

Figure 3-43 Prohibit IPv6 addresses as targets

Figure 3-44 uses the Match directive with a wildcard to indicate to NetBackup to
prefer IPv4 addresses. In this case, NetBackup tries to use an IPv4 address, but
may consider IPv6 addresses if necessary.

Figure 3-44 Match IPv4 addresses as targets

Order of directive processing in the Preferred Network properties
NetBackup sorts all directives into decreasing order by the Target subnet length
so that the more specific network specifications, such as complete host names or
IP addresses, match first. (For example, a Target with a /24 subnet is processed
before a Target with a /16 subnet.) In this way, NetBackup can honor host-specific
overrides.

If multiple directives have the same length subnet, NetBackup looks at the order in
which the directives are listed.

Use the up or down arrows to the right of the list to change the order of the directives.

NetBackup processes each resolved destination address and each prospective
source address relative to the directives. Directives that contain addresses that do
not apply to either host are ignored.
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bptestnetconn utility to display Preferred Network information
The bptestnetconn utility is available to administrators to test and analyze host
connections. Use the preferred network option (--prefnet or -p) to display
information about the preferred network configuration, along with the forward lookup
information of a host on the server list.

For example, bptestnetconn -v6 -p -s -H host1 displays the directives in the
order in which NetBackup processes them, which may not be the order in which
they are configured.

■ The bptestnetconn command is described in the NetBackup Commands
Reference Guide.

■ Best practices for using the bptestnetconn command are described in
https://www.veritas.com/support/en_US/article.000017676.

Figure 3-45 shows the bptestnetconn output when run on Server_A, for Server_B.
That is, bptestnetconn is run from Server_A's perspective. Based on the directives
configured on Server_A, for Server_B, bptestnetconn shows the available IP
addresses on Server_B. In this example, no directives are configured on Server_A.

Figure 3-45 bptestnetconn for Server_B with no directives listed

[root@Server_A netbackup]# bptestnetconn -f --prefnet -H Server_B
---------------------------------------------------------------------
FL: Server_B -> 10.81.73.147 : 11 ms SRC: ANY
FL: Server_B -> 10.96.73.253 : 11 ms SRC: ANY
FL: Server_B -> 2001:db8:0:11d::1efc : 11 ms SRC: ANY
FL: Server_B -> 2001:db8:0:11e::1efc : 11 ms SRC: ANY
FL: Server_B -> 2001:d8b:0:1f0::1efc : 11 ms SRC: ANY
FL: Server_B -> 2001:db8:0:11c::1efc : 11 ms SRC: ANY
---------------------------------------------------------------------
Total elapsed time: 0 sec

Any source is available to
use for a connection

List of networks available to
Server_B

Host for which lookup
is performed

The following directive is added to the Preferred Networks properties on Server_A:
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In the configuration file the directive appears as follows:

PREFERRED_NETWORK = 2001:0db8:0:11c::/62 ONLY

This directive provides NetBackup with the information to filter the addresses and
choose to communicate with only those that match the :11c, :11d, :11e, and :11f
networks. The addresses that do not match the Only directive are prohibited, as
shown in the bptestnetconn output.

See “PREFERRED_NETWORK option for NetBackup servers” on page 318.

Figure 3-46 shows the bptestnetconn output for Server_B, given this directive.

Figure 3-46 bptestnetconn for Server_B with directive

[root@Server_A netbackup]# bptestnetconn -f --prefnet -H Server_B
---------------------------------------------------------------------
FL: Server_B -> 10.81.73.147 : 11 ms TGT PROHIBITED
FL: Server_B -> 10.96.73.253 : 11 ms TGT PROHIBITED
FL: Server_B -> 2001:db8:0:11d::1efc : 11 ms SRC: ANY
FL: Server_B -> 2001:db8:0:11e::1efc : 11 ms SRC: ANY
FL: Server_B -> 2001:d8b:0:1f0::1efc : 11 ms TGT PROHIBITED
FL: Server_B -> 2001:db8:0:11c::1efc : 11 ms SRC: ANY
---------------------------------------------------------------------
Total elapsed time: 0 sec

Directives make some targets
unavailable to Server_B

List of networks available to
Server_B

Configuration to prohibit using a specified address
Figure 3-47 shows a configuration that prohibits NetBackup from using the specified
address, or in this case, addresses.

Figure 3-47 Prohibited target example

Configuration to prefer a specified address
Figure 3-48 shows a configuration that makes NetBackup prefer to use one range
of destination addresses over others that might be available.
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Other available destination addresses will only be used if one of the following is
true:

■ No destination address exists that is in this range, or

■ A Match is specified for those addresses using a larger subnet mask, or

■ A Match is specified for those addresses with a same length subnet mask and
the address is ordered above this directive.

A Prohibited directive can be used to prevent the use of an address within this
range. The Prohibited directive would need either a longer subnet mask, or a
subnet mask of equal length with the Prohibited directive ordered above theMatch
directive. AdditionalMatch directives may be used to indicate the additional backup
networks that are allowed.

Figure 3-48 Match network selection with the source

Configuration that restricts NetBackup to one set of addresses
Figure 3-49 configures NetBackup to use only the specified range of destination
addresses, and the allowed source addresses must also be in the same range. The
only exception is if other directives with larger subnets are present, or with
equal-length subnets but ordered above this one.

Figure 3-49 Only network selection with the same source binding address

A host with the Only directive configured considers only those target addresses in
the 192.168.100.0 subnet. Additionally, source binding to the local interface must
be done on the 192.168.100.0 subnet.
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Configuration that limits the addresses, but allows any interfaces
Figure 3-50 shows a configuration that allows only the addresses that start with the
specified prefix to be considered. No source binding is specified, so any interface
may be used.

Figure 3-50 Limiting the addresses, without any source binding

Resilient Network properties
The Resilient Network properties appear for the master server, for media servers,
and for clients. For media servers and clients, the Resilient Network properties
are read only. When a job runs, the master server updates the media server and
the client with the current properties.

The Resilient Network properties let you configure NetBackup to use resilient
network connections for backups and restores. A resilient connection allows backup
and restore traffic between a client and a NetBackup media server to function
effectively in high-latency, low-bandwidth networks such asWANs. The data travels
across a wide area network (WAN) to media servers in a central datacenter.

NetBackup monitors the socket connections between the remote client and the
NetBackupmedia server. If possible, NetBackup re-establishes dropped connections
and resynchronizes the data stream. NetBackup also overcomes latency issues to
maintain an unbroken data stream. A resilient connection can survive network
interruptions of up to 80 seconds. A resilient connection may survive interruptions
longer than 80 seconds.

The NetBackup Remote Network Transport Service manages the connection
between the computers. The Remote Network Transport Service runs on the master
server, the client, and the media server that processes the backup or restore job.
If the connection is interrupted or fails, the services attempt to re-establish a
connection and synchronize the data.

NetBackup protects only the network socket connections that the NetBackup Remote
Network Transport Service (nbrntd) creates. Examples of the connections that are
not supported are:
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■ Clients that back up their own data (deduplication clients and SAN clients)

■ Granular Recovery Technology (GRT) for Exchange Server or SharePoint Server

■ NetBackup nbfsd process.

NetBackup protects connections only after they are established. If NetBackup cannot
create a connection because of network problems, there is nothing to protect.

Resilient connections apply between clients and NetBackup media servers, which
includes master servers when they function as media servers. Resilient connections
do not apply to master servers or media servers if they function as clients and back
up data to a media server.

Resilient connections can apply to all of the clients or to a subset of clients.

Note: If a client is in a different subdomain than the server, add the fully qualified
domain name of the server to the client’s hosts file. For example,
india.veritas.org is a different subdomain than china.veritas.org.

When a backup or restore job for a client starts, NetBackup searches the Resilient
Network list from top to bottom looking for the client. If NetBackup finds the client,
NetBackup updates the resilient network setting of the client and the media server
that runs the job. NetBackup then uses a resilient connection.
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Figure 3-51 Master server Resilient Network host properties

See “About the Daemons tab” on page 1106.

Table 3-51 describes the Resilient Network properties.

Table 3-51 Resilient Network dialog box properties

DescriptionProperty

TheHost Name or IP Address of the host. The address can
also be a range of IP addresses so you can configure more
than one client at once. You can mix IPv4 addresses and
ranges with IPv6 addresses and subnets.

If you specify the host by name, Veritas recommends that
you use the fully qualified domain name.

Use the arrow buttons on the right side of the pane to move
up or move down an item in the list of resilient networks.

Host Name or IP Address

Resiliency is either ON or OFF.Resiliency
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Note: The order is significant for the items in the list of resilient networks. If a client
is in the list more than once, the first match determines its resilient connection
status. For example, suppose you add a client and specify the client IP address
and specifyOn for Resiliency. Suppose also that you add a range of IP addresses
asOff, and the client IP address is within that range. If the client IP address appears
before the address range, the client connection is resilient. Conversely, if the IP
range appears first, the client connection is not resilient.

The resilient status of each client also appears as follows:

■ In the NetBackup Administration Console, select NetBackup Management
> Policies in the left pane and then select a policy. In the right pane, a
Resiliency column shows the status for each client in the policy.

■ In the NetBackup Administration Console, select NetBackup Management
> Host Properties > Clients in the left pane. In the right pane, a Resiliency
column shows the status for each client.

Other NetBackup properties control the order in which NetBackup uses network
addresses.

See “Preferred Network properties” on page 178.

The NetBackup resilient connections use the SOCKS protocol version 5.

Resilient connection traffic is not encrypted. Veritas recommends that you encrypt
your backups. For deduplication backups, use the deduplication-based encryption.
For other backups, use policy-based encryption.

Resilient connections apply to backup connections. Therefore, no additional network
ports or firewall ports must be opened.

Note: If multiple backup streams run concurrently, the Remote Network Transport
Service writes a large amount of information to the log files. In such a scenario,
Veritas recommends that you set the logging level for the Remote Network Transport
Service to 2 or less. Instructions to configure unified logs are in a different guide.

See the NetBackup Logging Reference Guide.

Resilient connection resource usage
Resilient connections consumemore resources than regular connections, as follows:

■ More socket connections are required per data stream. Three socket connections
are required to accommodate the Remote Network Transport Service that runs
on both the media server and the client. Only one socket connection is required
for a non-resilient connection.
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■ More sockets are open on media servers and clients. Three open sockets are
required rather than one for a non-resilient connection. The increased number
of open sockets may cause issues on busy media servers.

■ More processes run on media servers and clients. Usually, only one more
process per host runs even if multiple connections exist.

■ The processing that is required to maintain a resilient connection may reduce
performance slightly.

Specifying resilient connections
Use the following procedure to specify resilient connections for NetBackup clients.

See “Resilient Network properties” on page 192.

Alternatively, you can use the resilient_clients script to specify resilient
connections for clients:

■ Windows: install_path\NetBackup\bin\admincmd\resilient_clients

■ UNIX: /usr/openv/netbackup/bin/admincmd/resilient_clients

To specify resilient connections

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Servers in the left pane.

2 In the right pane, select the master server on which to specify properties.

3 On the Actions menu, click Properties.

4 In the properties dialog box left pane, select Resilient Network.

5 In the Resilient Network dialog box, use the following buttons to manage
resiliency for clients:
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To add resilient settings

1 Click Add.

The Add Resilient Network Settings dialog box appears

2 Enter a client host name, an IP address, or an address range.

If you specify the client host by name, Veritas recommends that
you use the fully qualified domain name.

For address ranges, use Classless Inter-Domain Routing (CIDR)
notation (for example, 192.168.100.0/24 or fd00::/8).

3 Ensure that the Resiliency On option is selected.

4 Click Add.

5 Repeat until you have finished entering clients or address ranges.

6 When you finish adding network settings, click Close.

Add

If you select multiple hosts in theNetBackup Administration Console,
the entries in the Resilient Network list may appear in different colors,
as follows:

■ The entries that appear in black type are configured on all of the
hosts.

■ The entries that appear in gray type are configured on some of the
hosts only.

For the entries that are configured on some of the hosts only, you can
add them to all of the hosts. To do so, select them and click Add To All.

Add To All

To change resilient settings

1 Select the client host name, the IP address, or the address range.

2 Click Change.

The Change Resilient Network Settings dialog box appears

3 Select the desired Resiliency setting.

4 Click OK.

Change

Remove the select host or address rang

1 Select the client host name, the IP address, or the address range.

2 Click Remove.

The client is removed immediately; a confirmation dialog box does
not appear.

Remove
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Move an item in the list of items

1 Select the client host name, the IP address, or the address range.

2 Click the appropriate button to move up the item or move down the
item.

The order of the items in the list is significant.

See “Resilient Network properties” on page 192.

6 After specifying resilient connections, click OK.

The settings are propagated to the affected hosts through normal NetBackup
inter-host communication, which can take up to 15 minutes.

7 If you want to begin a backup immediately, restart the NetBackup services on
the master server.

Resource Limit properties
TheResource Limit properties in theNetBackup Administration Console control
the number of simultaneous backups that can be performed on a VMware or Hyper-V
resource type. These settings apply to all policies for the currently selected master
server.

For example, a VMwareResource Limit of four for Datastoremeans that NetBackup
policies can perform no more than four simultaneous backups on any particular
datastore.

Note: The Resource Limit properties apply only to policies that use automatic
selection of virtual machines (the policy's Query Builder). If you select virtual
machines manually on theBrowse for Virtual Machines dialog box, theResource
Limit properties have no effect.

The Resource Limit dialog box contains the following properties, depending on
which application is selected.

For more information about the specific resource types, click Help.
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Figure 3-52 Resource Limit dialog box with VMware application selected
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Figure 3-53 Resource Limit dialog box with Hyper-V application selected

Restore Failover properties
The Restore Failover properties in the NetBackup Administration Console
control how NetBackup performs automatic failover to a NetBackup media server.
A failover server may be necessary if the regular media server is temporarily
inaccessible to perform a restore operation. The automatic failover does not require
administrator intervention. By default, NetBackup does not perform automatic
failover. These properties apply to currently selected master servers.
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Figure 3-54 Restore Failover dialog box

The Restore Failover dialog box contains the following properties:

Table 3-52

DescriptionProperty

Displays the NetBackup media servers that have failover protection for
restores.

Media server

Displays the servers that provide the failover protection. NetBackup
searches from top to bottom in the column until it finds another server
that can perform the restore.

Failover restore
server

A NetBackup media server can appear only once in the Media server column but
can be a failover server for multiple other media servers. The protected server and
the failover server must both be in the same master and media server cluster.

The following situations describe examples of when to use the restore failover
capability:
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■ Two or more media servers share a robot and each has connected drives. When
a restore is requested, one of the servers is temporarily inaccessible.

■ Two or more media servers have stand alone drives of the same type. When a
restore is requested, one of the servers is temporarily inaccessible.

In these instances, inaccessible means that the connection between bprd on the
master server and bptm on the media server (through bpcd) fails.

Possible reasons for the failure are as follows:

■ The media server is down.

■ The media server is up but bpcd does not respond. (For example, if the
connection is refused or access is denied.)

■ The media server is up and bpcd is running, but bptm has problems. (For
example, bptm cannot find the required tape.)

Assigning an alternate media server as a failover restore server
You can assign another media server to act as a failover restore server for your
media server. If your media server is unavailable during a restore, the failover
restore server takes its place.

To assign an alternate media server as a failover restore server

1 In the NetBackup Administration Console, in the left panel, expand
NetBackup Management > Host Properties > Master Servers.

2 In the right pane, double-click on the master server you want to modify.

3 In the properties dialog box, in the left pane, click Restore Failover.

4 Click Add.

5 In the Media server field, specify the media server for failover protection.

6 In the Failover restore servers field, specify the media servers to try if the
server that is designated in the Media server field is unavailable. Separate
the names of multiple servers with a single space.

7 Click Add. The dialog box remains open for another entry.

8 Click Close.

9 From the Restore Failover dialog box, click Apply to accept the changes.

Before the change takes effect, you must stop and restart the NetBackup Request
daemon on the master server where the configuration was changed.

See “About enabling automatic failover to an alternate server” on page 1203.
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Retention Periods properties
Use theRetention Periods properties in theNetBackup Administration Console
to define a duration for each retention level. You can select from 0-100 retention
levels.

In a policy, the retention period determines how long NetBackup retains the backups
or the archives that are created according to the schedule. These properties apply
to selected master servers.

Figure 3-55 Retention Periods dialog box

By default, NetBackup stores each backup on a volume that already contains
backups at the same retention level. However, NetBackup does not check the
retention period that is defined for that level. When the retention period for a level
is redefined, some backups that share the same volumemay have different retention
periods.

For example, if the retention level 3 is changed from one month to 6 months,
NetBackup stores future level 3 backups on the same volumes. That is, the backups

203Configuring Host Properties
Retention Periods properties



are placed on the volumes with the level 3 backups that have a retention period of
one month.

No problem exists if the new and the old retention periods are of similar values.
However, before a major change is made to a retention period, suspend the volumes
that were previously used for that retention level.

Note: If a backup or duplicate job is configured with a retention level greater than
25 and the storage unit specified in the policy is managed by a pre-NetBackup 8.0
media server, the backup jobs associated with the policy fail with the following error
message:

Retention level <number> is not valid.

As a workaround, you can either upgrade the media server to NetBackup 8.0 or
later or set the retention level between 0 and 25 in the policy. Note that the retention
period for level 25 is always set to expire immediately and this value cannot be
changed.

Note: In case of a manual import, if a master or media server that runs an earlier
version than NetBackup 8.0 imports a backup image created on a NetBackup 8.0
master server and configured with a retention level greater than 24, the import job
resets the retention level to 9 (infinite). As a workaround, you can import such
backup images from a master or media server that runs NetBackup 8.0 or later.

See “Determining retention periods for volumes” on page 206.

See “Suspending or unsuspending volumes” on page 548.

The Retention Periods dialog box contains the following properties.

Table 3-53 Retention Periods dialog box properties

DescriptionProperty

Assigns a number to the retention level setting.Value

Specifies the units of time for the retention period. The list includes hours as the smallest
unit of granularity and the special units, Infinite, and Expires immediately.

Units

The retention level number (0 through 100).Retention Level
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Table 3-53 Retention Periods dialog box properties (continued)

DescriptionProperty

A list of the current definitions for the possible levels of retention. By default, levels 9
through 100 (except level 25) are set to infinite. Retention level 9 cannot be changed
and the retention period is always set to infinite. Retention level 25 also cannot be
changed and the retention period is always set to expire immediately.

See “Retention Periods with end dates beyond 2038, excluding Infinity” on page 207.

With the default, there is no difference between a retention level of 12 and a retention
level of 20, for example.

The Schedule Count column indicates how many schedules currently use each level.
If the retention period is changed for a level, it affects all schedules that use that level.

The Changes Pending column uses an asterisk (*) to indicate that the period has
been changed and not applied. NetBackup does not change the actual configuration
until the administrator accepts or applies the changes.

Retention Period

Lists the number of schedules that use the currently selected retention level.Schedule Count

Displays a list of the current policy names and schedule names that use the retention
level.

Schedules using this
retention level

Displays a summary of how changes affect existing schedules. The list displays all
schedules in which the retention period is shorter than the frequency period.

Impact Report

Changing a retention period
Use the following procedure to change a retention period.

To change a retention period

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties > Master Servers.

2 In the right pane, double-click on the master server you want to modify.

3 In the properties dialog box, in the left pane, click Retention Periods.
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4 Select the retention level to change.

By default, levels 9 through 100 (except level 25) are set to infinite. If the levels
are left at the default, there is no difference between a retention level of 12 and
a retention level of 20. Level 9 cannot be changed and the retention period is
always set to infinite. Retention level 25 also cannot be changed and the
retention period is always set to expires immediately.

See “Retention Periods with end dates beyond 2038, excluding Infinity”
on page 207.

The dialog box displays the names of all schedules that use the selected
retention level as well as the policy to which each schedule belongs.

5 Type the new retention period in the Value box.

6 From the Units drop-down list, select a unit of measure (days, weeks, months,
years, Infinite, or Expires immediately).

After you change the value or unit of measure, an asterisk (*) appears in the
Changes Pending column to indicate that the period was changed. NetBackup
does not change the actual configuration until the administrator accepts or
applies the changes.

7 Click Impact Report.

The policy impact list displays the policies and the schedule names where the
new retention period is less than the frequency period. To prevent a potential
gap in backup coverage, redefine the retention period for the schedules or
change the retention or frequency for the schedule.

8 Do one of the following:

■ To discard your changes, click Cancel.

■ To save your changes and leave the dialog box open to make further
changes, click Apply.

■ To save your changes and close the dialog box, click OK.

Determining retention periods for volumes
Use the following procedure to determine retention periods for volumes.

To determine retention periods for volumes

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media

2 In the right pane, find the volume on the list and examine the value in the
Retention Period column.
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To see all volumes that have the same retention period, click the Retention Period
column header to sort the volumes by retention period. This column heading is
hidden by default.

Retention Periods with end dates beyond 2038, excluding Infinity
Due to UNIX epoch time and the year 2038 problem, any retention end date that
exceeds January 19, 2038 is automatically set to expire on January 19, 2038,
regardless of whether the expiration end date is reached

This issue does not apply to retention levels for which the retention period is set to
Infinity. NetBackup never expires media with a retention set to Infinity unless
instructed to do so by the NetBackup administrator.

RHV Access Hosts properties
Use theRHVAccessHosts properties in theNetBackupAdministrationConsole
to add or remove RHV backup hosts. These properties apply to currently selected
master servers.

These properties appear when the NetBackup Enterprise Client license is installed.
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Figure 3-56 RHV Access Hosts dialog box

The backup host or appliance acts as a channel to establish an indirect
communication between the NetBackup master server and the RHV manager. The
backup host is a NetBackup client that performs backups or restores on behalf of
the virtual machines.

A NetBackup master and media server can also be configured as the backup host.
However, you do not need to add the master or media server acting as a backup
host to the RHV Access Hosts list.

The backup host is referred to as the recovery host when it performs a restore

You can add servers to and remove servers from the access hosts list:

ClickAdd and enter the fully qualified domain name of the backup host.Add

Select the backup host in the list and click Remove.Remove

For more information, see the NetBackup Web UI RHV Administrator's Guide.
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Scalable Storage properties
The Scalable Storage Cloud Settings properties contain information about
encryption, metering, bandwidth throttling, and network connections between the
NetBackup hosts and your cloud storage provider.

The Scalable Storage properties appear only if the host is supported for cloud
storage. See the NetBackup hardware compatibility list for your release available
through the following URL:

http://www.netbackup.com/compatibility

The Scalable Storage properties apply to currently selected media servers.

Figure 3-57 Scalable Storage Cloud Settings host properties

Table 3-54 describes the properties.
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Table 3-54 Scalable Storage Cloud Settings host properties

DescriptionProperty

If you configured the NetBackup Key Management Service (KMS), the name of the
KMS server.

Key Management Server
(KMS) Name

Determines how often NetBackup gathers connection information for reporting purposes.
NetBackup OpsCenter uses the information that is collected to create reports. The
value is set in seconds. The default setting is 300 seconds (5 minutes). If this value to
zero, metering is disabled.

Metering Interval

Use this value to specify the speed of your connection to the cloud. The value is
specified in kilobytes per second. The default value is 102400 KB/sec.

Total Available Bandwidth

The time, in seconds, between measurements of bandwidth usage. The larger this
value, the less often NetBackup checks to determine the bandwidth in use.

If this value is zero, throttling is disabled.

Sampling interval

Click Advanced Settings to specify additional settings for throttling.

See “Configuring advanced bandwidth throttling settings” on page 211.

See “Advanced bandwidth throttling settings” on page 212.

Advanced Settings
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Table 3-54 Scalable Storage Cloud Settings host properties (continued)

DescriptionProperty

The default maximum number of concurrent jobs that the media server can run for the
cloud storage server.

This value applies to the media server, not to the cloud storage server. If you have
more than one media server that can connect to the cloud storage server, each media
server can have a different value. Therefore, to determine the total number of
connections to the cloud storage server, add the values from each media server.

If you configure NetBackup to allow more jobs than the number of connections,
NetBackup fails any jobs that start after the number of maximum connections is reached.
Jobs include both backup and restore jobs.

You can configure job limits per backup policy and per storage unit.

See “Limit jobs per policy (policy attribute)” on page 739.

See “Maximum concurrent jobs storage unit setting” on page 608.

Note: NetBackup must account for many factors when it starts jobs: the number of
concurrent jobs, the number of connections per media server, the number of media
servers, and the job load-balancing logic. Therefore, NetBackup may not fail jobs
exactly at the maximum number of connections. NetBackup may fail a job when the
connection number is slightly less than the maximum, exactly the maximum, or slightly
more than the maximum.

If the media server is not a CloudCatalyst storage server, a value over 100 is generally
not needed.

If the media server is a CloudCatalyst storage server, change the value to 160 or more.

Maximum concurrent jobs

Configuring advanced bandwidth throttling settings
Advanced bandwidth throttling settings let you control various aspects of the
connection between the NetBackup hosts and your cloud storage provider.

The total bandwidth and the bandwidth sampling interval are configured on the
Cloud Settings tab of the Scalable Storage host properties screen.

See “Scalable Storage properties” on page 209.

To configure advanced bandwidth throttling settings

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Media Servers in the left pane.

2 In the right pane, select the host on which to specify properties.

3 Click Actions > Properties.

4 In the properties dialog box left pane, select Scalable Storage.
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5 In the right pane, click Advanced Settings. The Advanced Throttling
Configuration dialog box appears.

The following is an example of the dialog box:

6 Configure the settings and then click OK.

See “Advanced bandwidth throttling settings” on page 212.

Advanced bandwidth throttling settings
The following table describes the advanced bandwidth throttling settings.

Table 3-55 Advanced Throttling Configuration settings

DescriptionProperty

Use this field to specify the percentage of total bandwidth that read
operations can use. Specify a value between 0 and 100. If you
enter an incorrect value, an error is generated.

If there is insufficient bandwidth to transmit the specified amount
of data within a few minutes, restore or replication failures may
occur due to timeouts.

Consider the total load of simultaneous jobs on multiple media
servers when you calculate the required bandwidth.

Default value: 100

Possible values: 0 to 100

Read Bandwidth
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Table 3-55 Advanced Throttling Configuration settings (continued)

DescriptionProperty

Use this field to specify the percentage of total bandwidth that write
operations can use. Specify a value between 0 and 100. If you
enter an incorrect value, an error is generated.

If there is insufficient bandwidth to transmit the specified amount
of data within a few minutes, backup failures may occur due to
timeouts.

Consider the total load of simultaneous jobs on multiple media
servers when you calculate the required bandwidth.

Default value: 100

Possible values: 0 to 100

Write Bandwidth

Use this field to specify the time interval that is considered work
time for the cloud connection.

Specify a start time and end time in 24-hour format. For example,
2:00 P.M. is 14:00.

Indicate how much bandwidth the cloud connection can use in the
Allocated bandwidth field. This value determines how much of
the available bandwidth is used for cloud operations in this time
window. The value is expressed as a percentage or in kilobytes
per second.

Work time

Use this field to specify the time interval that is considered off time
for the cloud connection.

Specify a start time and end time in 24-hour format. For example,
2:00 P.M. is 14:00.

Indicate how much bandwidth the cloud connection can use in the
Allocated bandwidth field. This value determines how much of
the available bandwidth is used for cloud operations in this time
window. The value is expressed as a percentage or in kilobytes
per second.

Off time

Specify the start and stop time for the weekend.

Indicate how much bandwidth the cloud connection can use in the
Allocated bandwidth field. This value determines how much of
the available bandwidth is used for cloud operations in this time
window. The value is expressed as a percentage or in kilobytes
per second.

Weekend
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Table 3-55 Advanced Throttling Configuration settings (continued)

DescriptionProperty

This field displays how much of the available bandwidth the cloud
storage server transmits to a NetBackup media server during each
restore job. The value is expressed in kilobytes per second.

Read Bandwidth
(KB/s)

This field displays how much of the available bandwidth the
NetBackup media server transmits to the cloud storage server
during backup jobs. The value is expressed in kilobytes per second.

Write Bandwidth
(KB/s)

Servers properties
The Servers properties display the NetBackup server lists on selected master
servers, media servers, and clients. The server lists display the NetBackup servers
that each host recognizes.

The Master Server field contains the name of the master server for the selected
host. (The name of the selected host appears in the title bar.)

The Servers dialog box contains the following tabs:

Table 3-56 Servers dialog box properties

DescriptionTab

This tab lists the additional servers that can access the server that is specified asMaster
server.

During installation, NetBackup sets the master server to the name of the system where
the server software is installed. NetBackup uses the master server value to validate
server access to the client. The master server value is also used to determine which
server the client must connect to so that files can be listed and restored.

To configure access to a remote server, add to the server list the name of the host seeking
access.

Note: For a Fibre Transport (FT) media server that has multiple network interfaces for
VLANs: Ensure that the FT server’s primary host name appears before any other interface
names for that FT media server host.

For more information, see the NetBackup SAN Client and Fibre Transport Guide.

See “Accessing remote servers” on page 1173.

Additional Servers tab

214Configuring Host Properties
Servers properties

http://www.veritas.com/docs/DOC5332


Table 3-56 Servers dialog box properties (continued)

DescriptionTab

This tab lists the hosts that are media servers only. Hosts that are listed as media servers
can back up and restore clients, but have limited administrative privileges.

If a server appears only on the Media servers tab, the server is a media server. Media
servers can back up and restore clients, but they have limited administrative privileges.

A server that appears on the Media servers tab and the Additional servers tab may
introduce unintended consequences. A computer that is defined as both a master server
and a media server gives the administrator of the media server full master server
privileges. By listing the media server in both places, you may inadvertently give the
media server administrator more privileges than intended.

Media Servers tab

This tab lists the Veritas NetBackup OpsCenter servers that can access the currently
selected master server.

To add a server to the list, ensure that the NetBackup server can reach the OpsCenter
server.

For more information, see the Veritas NetBackup OpsCenter Administrator's Guide.

OpsCenter Servers tab

Use this tab to add the remote master servers that you trust using NetBackup CA-signed
certificates and to view the master servers that are already trusted.

See “About trusted master servers for Auto Image Replication” on page 1064.

See “Adding a trusted master server using NetBackup CA-signed (host ID-based)
certificate” on page 220.

Note: The NetBackup Administration Console does not support adding a trusted
master server using an external CA-signed certificate.

See “Adding a trusted master server using external CA-signed certificate” on page 225.

Note: If either the source or remote master server is clustered, you must enable
inter-node communication on all of the nodes in the cluster. Do so before you add the
trusted master server.

See “Enabling NetBackup clusteredmaster server inter-node authentication” on page 217.

You cannot remove a trusted master server when an Import SLP is configured in that
master server's domain.

Information about Auto Image Replication and storage lifecycle policies is available.

See “About NetBackup Auto Image Replication” on page 1051.

See “About storage lifecycle policies” on page 645.

Trusted Master Servers
tab
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Figure 3-58 Additional servers tab in the Servers dialog box

Adding a server to a servers list
Depending on the tab that is selected, you can add a master server, media server,
client, or OpsCenter server to the server list in the Additional servers tab, the
Media servers tab, or the OpsCenter servers tab. All tabs appear in the Servers
properties dialog box.

To add a server to a list

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties.

2 Depending on the host to be configured, select Master Servers, Media
Servers, or Clients.

3 In the right pane, double-click the master server, media server, or client that
you want to modify.

4 In the properties dialog box, in the left pane, click Servers.

5 Select the tab that contains the server list that you want to modify.
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6 Click Add.

To add multiple hosts, select more than one media server or client in step 2
and click Apply To All in step 5. However, you can add only one master server
to the list at a time.

7 In the Add a New Server Entry dialog box, enter the name of the new server.

8 Click Add. The dialog box remains open for another entry.

9 Click Close.

Note: If you add a media server, run nbemmcmd -addhost to add the media server
to the Enterprise Media Manager (EMM) in the NetBackup database of the master
server.

Removing a server from a server list
You can remove a master server or a media server from the Additional servers
list. You can also remove a media server from the Media servers list.

To remove a server from a server list

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties.

2 Depending on the host to be configured, select Master Servers, Media
Servers, or Clients.

3 In the right pane, double-click the master server, media server, or client you
want to modify.

4 In the properties dialog box, in the left pane, click Servers.

5 Select a server from the Additional servers list, theMedia servers list, or the
OpsCenter servers list.

6 Click Remove.

Enabling NetBackup clustered master server inter-node
authentication

NetBackup requires inter-node authentication among the master servers in a cluster.
For authentication, you must provision an authentication certificate on all of the
nodes of the cluster. The certificates are used to establish SSL connections between
the NetBackup hosts. The inter-node authentication allows the following NetBackup
functionality:
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The NetBackup Administration Console in master server
clusters requires the NetBackup authentication certificates
for correct functionality.

NetBackup Administration
Console

Auto Image Replication in which amaster server is in a cluster
requires inter-node authentication among the hosts in that
cluster. The NetBackup authentication certificates provide
the means to establish the proper trust relationships.

Provision the certificates on the cluster hosts before you add
the trustedmaster server. This requirement applies regardless
of whether the clustered mastered server is the source of the
replication operation or the target.

See “About trusted master servers for Auto Image
Replication” on page 1064.

Targeted A.I.R. (Auto Image
Replication)

See “Adding a trusted master server using NetBackup CA-signed (host ID-based)
certificate” on page 220.

To enable clustered master server inter-node authentication

◆ On the active node of the NetBackup master server cluster, run the following
NetBackup command:

■ Windows: install_path\NetBackup\bin\admincmd\bpnbaz -setupat

■ UNIX: /usr/openv/netbackup/bin/admincmd/bpnbaz -setupat

NetBackup creates the certificates on every node in the master server cluster.

The following is example output:

# bpnbaz -setupat

You will have to restart NetBackup services on this machine after

the command completes successfully.

Do you want to continue(y/n)y

Gathering configuration information.

Please be patient as we wait for 10 sec for the security services

to start their operation.

Generating identity for host 'bit1.remote.example.com'

Setting up security on target host: bit1.remote.example.com

nbatd is successfully configured on NetBackup Master Server.

Operation completed successfully.
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About the certificate to be used for adding a trusted master server
Source or target master servers may use NetBackup CA-signed certificates (host
ID-based certificates) or external CA-signed certificates.

For more information on NetBackup host ID-based certificates and external CA
support, refer to the NetBackup Security and Encryption Guide.

To establish trust between source and target master servers, NetBackup verifies
the following:

If the external CA configuration options - ECA_CERT_PATH,
ECA_PRIVATE_KEY_PATH, and ECA_TRUST_STORE_PATH - are
defined in the NetBackup configuration file of the source master server,
it can establish the trust using an external certificate.

In case of Windows certificate trust store, only ECA_CERT_PATH is
defined.

For more information on the configuration options, refer to the
NetBackup Administrator's Guide, Volume I.

Can the source
master server
establish trust using
external CA-signed
certificate?

The target master server may support external CA, NetBackup CA, or
both. The following settings show the CA usage information of the
master server:

■ In the NetBackup Administration Console - NetBackup
Management >SecurityManagement >Global Security Settings

■ In the NetBackup web user interface - Security > Global Security
Settings > Secure Communication.

Which certificate
authorities (CA)
does the target
master server
support?

The following table lists CA support scenarios and certificate to be used to establish
trust between the source and the target master servers.
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Table 3-57 Certificate to be used for trust setup

Certificate to be used for trust setupCA usage of the
target master server

Source master
server capability
to use external
certificate

External CA

See “Adding a trusted master server using external CA-signed
certificate” on page 225.

External CAYes

The source master
server can use
NetBackup CA and
external CA for
communication with a
remote master server

NetBackup CA

See “Adding a trusted master server using NetBackup CA-signed
(host ID-based) certificate” on page 220.

NetBackup CA

NetBackup prompts to select the CA that you want to use for trust
setup

■ If you choose to use external CA, do the following:
See “Adding a trusted master server using external CA-signed
certificate” on page 225.

■ If you choose to use NetBackup CA, do the following:
See “Adding a trusted master server using NetBackup
CA-signed (host ID-based) certificate” on page 220.

External CA and
NetBackup CA

No trust is establishedExternal CANo

The source master
server can use only
NetBackup CA for
communication with a
remote maser server

NetBackup CA

See “Adding a trusted master server using NetBackup CA-signed
(host ID-based) certificate” on page 220.

NetBackup CA

NetBackup CA

See “Adding a trusted master server using NetBackup CA-signed
(host ID-based) certificate” on page 220.

External CA and
NetBackup CA

Adding a trusted master server using NetBackup CA-signed (host
ID-based) certificate

Replication operations require that a trust relationship exists between the NetBackup
servers in the different domains.

Before you begin
Perform the following steps on both the source and the target server:

■ Identify the NetBackup versions that are installed on the source and the target
servers.
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■ Obtain the authorization tokens of the remote server.
Use the bpnbat command to log on and nbcertcmd to get the authorization
tokens.

■ Obtain the fingerprints for the remote server.
To obtain the SHA1 fingerprint of root certificate, use the nbcertcmd

-displayCACertDetail command.

■ Ensure that you have one of the following permissions:

■ System administrator permissions with root permissions for UNIX,
administrator permissions for Windows, or a NetBackupCLI user for a 3.1
NetBackup appliance.

■ Access to the NetBackup Administration Console, where you have
<username> ADMIN=ALL permissions through auth.conf.

■ Enhanced Auditing (EA) user permissions through authalias.conf.

■ For remote Windows master server, if the user's domain is not same as that
of the authentication service, you must add the domain with LDAP using the
vssat addldapdomain command. See the NetBackupCommandsReference
Guide.
Also, this user must have RBAC security administrator permissions. See the
WEB UI for the Security Administrators Guide..

Adding a trusted master server using NetBackup
CA-signed certificates, when both the source and the target
servers are NetBackup version 8.1 or later
Use this procedure to add a trusted master server when a NetBackup CA-based
certificate is used to establish the trust.

See “Adding a trusted master server using external CA-signed certificate”
on page 225.

To add a trusted master server, when both the source and the target servers
are NetBackup version 8.1 or later

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Servers in the left pane.

2 In the right pane, select the master server and Actions > Properties.

3 In the properties dialog box left pane, select Servers.

4 On the Trusted Master Servers tab, click Add.
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5 Enter the fully-qualified host name of the remote master server and click
Validate Certificate Authority.

6 In the Validate Certificate Authority dialog box, verify if the CA certificate
fingerprint of the remote server is correct.

To proceed, click Yes.

If the fingerprints don’t match, click No. Contact the remote server admin to
provide the correct fingerprints.

7 Enter the trusted master server details using one of the following methods.

■ (Recommended) Select Specify authentication token of the trusted
master server and enter the token details of the remote master server.

■ Select Specify credentials of the trusted master server and enter the
user name and password. Note that this method may present a possible
security breach. Only an authentication token can provide restricted access
and allow secure communication between both the hosts.
To establish trust with a 3.1 NetBackup master appliance, use the
NetBackup CLI credentials.
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8 Click OK.

9 Perform the same procedure on the remote master server that you added in
step 5.

Adding a trusted master server using NetBackup
CA-signed certificates, when both the source and the target
server are NetBackup version 8.0 or earlier
To add a trusted master server, when both the source and the target server
are NetBackup version 8.0 or earlier

1 Ensure that the Enable insecure communication with NetBackup 8.0 and
earlier hosts option is enabled in the global security settings.

2 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Servers in the left pane.
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3 In the right pane, select the master server and Actions > Properties.

4 In the properties dialog box left pane, select Servers.

5 On the Trusted Master Servers tab, click Add.

6 Enter the fully-qualified host name of the remote master server and click
Validate Certificate Authority.
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7 Enter the Username and Password of the remote master server host.

8 Click OK.

More information
See “About trusted master servers for Auto Image Replication” on page 1064.

For details on usage reporting in the web UI, see theNetBackupWeb UI for Backup
Administrator's Guide.

For more information on commands, see the NetBackup Commands Reference
Guide. For details on the authalias.conf, see the NetBackup Security and
Encryption Guide.

Adding a trusted master server using external CA-signed certificate
You can now establish a trust between source and target master servers using an
external CA-signed certificate.

For more information on the external CA support, refer to the NetBackup Security
and Encryption Guide.

See “About the certificate to be used for adding a trustedmaster server” on page 219.
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Note: TheNetBackup Administration Console does not support adding a trusted
master server using an external certificate.

If you try to add a trusted master server with an external certificate using the
NetBackup Administration Console, an error is displayed.

To add a trusted master server using an external certificate

1 Configure the following external certificate configuration options on the source
master server:

■ ECA_CERT_PATH

■ ECA_PRIVATE_KEY_PATH

■ ECA_TRUST_STORE_PATH

■ ECA_KEY_PASSPHRASEFILE (optional)

Note: In case of Windows certificate store, configure only the ECA_CERT_PATH
configuration option.

2 Run the nbseccmd -setuptrustedmaster command on the source master
server.

For more information on the commands, refer to the NetBackup Commands
Reference Guide.

If the source and target master servers are configured with external certificates that
are issued by different certificate authorities, refer to the following section from the
NetBackup Deduplication Guide: Configuring external CA for secure communication
between the source MSDP storage server and the target MSDP storage server.

Removing a trusted master server
To remove a trusted master server, you must perform the following procedure on
both the source and the target server.

Note: If either your source or the target server is on version 8.0 or earlier, follow
the procedure that is prescribed in the respective guide.
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To remove a trusted master server

1 Ensure that all replication jobs to the trusted target master server are complete.
You can use nbstlutil stlilist to list the state of all storage lifecycle
policy-managed operations. To cancel jobs use nbstlutil cancel.

See the NetBackup Commands Reference Guide for information about the
nbstlutil command.

2 Delete all storage lifecycle policies (SLPs) that use the trusted master as a
destination.

Note: Before deleting a storage lifecycle policy, ensure that there are no backup
policies that indicate the SLP for the Policy storage.

3 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties > Master Servers in the left pane.

4 In the right pane, select the master server.

5 On the Actions menu, click Properties.

6 In the properties dialog box left pane, select Servers.

7 In the Servers dialog box, select the Trusted Master Servers tab.

8 On the Trusted Master Servers tab, select the trusted master server that you
want to remove and click Remove.

The Remove Server confirmation dialog box is displayed.

9 Click Yes.

10 When you finish removing trusted master servers, click OK.

11 Restart the nbsl service.

12 Repeat the steps on the source master server.

Note: In case of multiple NICs, if you have established trust using more that one
host NIC and if you remove the trust relationship with any one host NIC, the trust
with all the other host NICs is broken.

Changing the master server that performs backups and restores for
a client

Use the Make Master option to change the master server that performs backups
and restores for a client. This option does not change a host into a master server.
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Note: The client can also change their master server in the Backup, Archive, and
Restore interface by selecting Actions > Specify NetBackup Machines and
Policy Type. In this dialog, select the master server to use for backups and restores.

This option is useful in a disaster recovery situation or in a NetBackup environment
where Auto Image Replication is configured. For example, select a client in the
source domain, then useMake Master to temporarily point the client to the master
server of the target domain. After changing the master server, restores from the
target domain can be initiated.

To change the master server that a client uses for backups and restores

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties.

2 Depending on the host to be configured, select Clients.

3 In the details pane, double-click on the client that you want to modify.

4 In the dialog box, click Servers.

5 From the Additional servers list, select a server.

6 Click Make Master.

In the configuration file, the newmaster server appears as the first server entry
in the list.

Changing the master server does not prevent the former master server from
initiating backups for the client. As long as that server continues to be listed
on the client’s server list, the master server can perform backups.

SharePoint properties
The SharePoint properties apply to currently selected Windows clients to protect
SharePoint Server installations.
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Figure 3-59 SharePoint dialog box

The SharePoint dialog box contains the following properties.

Table 3-58 SharePoint dialog box properties

DescriptionProperty

Specifies the domain and the user name for the account you
want to use to log on to SharePoint (DOMAIN\user name).

Domain\User name

Specifies the password for the account.Password

Specifies the consistency checks to perform on the SQL
Server databases before NetBackup begins a backup
operation. These checks are performed for both
server-directed and user-directed backups.

If you choose to perform a consistency check, you can select
Continue with backup if consistency check fails.
NetBackup then continues to perform the backup if the
consistency check fails.

Consistency check before
backup

229Configuring Host Properties
SharePoint properties



Table 3-58 SharePoint dialog box properties (continued)

DescriptionProperty

For VMware backups that protect Federated SharePoint
configurations, provide the name of the back-end SQL server.
This server acts as the granular restore proxy host for the
catalog hosts (front-end servers in the farm).

SharePoint granular restore
proxy host

For complete information on these options, see the NetBackup for Microsoft
SharePoint Server Administrator’s Guide.

Consistency check options for SharePoint Server
The following consistency checks can be performed before a SharePoint Server
backup.

Table 3-59 Consistency check options

DescriptionOption

Do not perform consistency checking.None

Select this option to exclude indexes from the consistency check. If indexes are not
checked, the consistency check runs significantly faster but is not as thorough. Only
the data pages and clustered index pages for each user table are included in the
consistency check. The consistency of the non-clustered index pages is not checked.

Full check, excluding
indexes

Include indexes in the consistency check. Any errors are logged.Full check, including
indexes

SLP Parameters properties
TheSLPParameters properties in theNetBackupAdministration Console allow
administrators to customize how storage lifecycle policies are maintained and how
SLP jobs run. These properties apply to the SLPs of the currently selected master
servers.
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Figure 3-60 SLP Parameters dialog box

Change the parameters in either the Host Properties or use the command line.
Whenever a storage lifecycle policy parameter is changed from the default, the
change creates the nbcl.conf configuration file.

The nbcl.conf file is found in the following locations. It is present only if the default
of any parameter has been changed.

■ On Windows:
install_path\NetBackup\var\global\nbcl.conf

■ On UNIX:
/usr/openv/var/global/nbcl.conf

To use the command-line method, use the nbgetconfig and the nbsetconfig

commands to change the defaults. For information about these commands, see
the NetBackup Commands Reference Guide.

Table 3-60 describes the SLP Parameters and the default of each. It also lists the
configuration options and the syntax to use with the command-line method.
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Use the drop-down menu in the Units column to change the units of measurement
for size or time.

Table 3-60 SLP Parameters

DescriptionProperty

The smallest batch size that can run as a single duplication job. The job does not run
until enough images accumulate to reach this minimum batch size or until the Force
interval for small jobs time is reached. Minimum: 1 kilobyte; no maximum size. Default:
8 gigabytes.

Configuration option default: SLP.MIN_SIZE_PER_DUPLICATION_JOB = 8 GB

Minimum size per
duplication job

The largest batch size that can run as a single duplication job. Minimum: 1 kilobyte;
no maximum size. Default: 100 gigabytes.

Configuration entry default: SLP.MAX_SIZE_PER_DUPLICATION_JOB = 100 GB

Maximum size per
duplication job

The largest batch size that can run as a single job for Auto Image Replication. Minimum:
1 kilobyte; no maximum size. Default: 100 gigabytes.

Configuration entry default: SLP.MAX_SIZE_PER_BACKUP_REPLICATION_JOB =
100 GB

Maximum size per A.I.R.
replication job

The largest number of images in a single batch that can run as a single job. Default:
50 images, with no minimum number or maximum number.

Use this parameter with the Limit I/O streams disk pool option which limits the number
of jobs that can run concurrently to each volume in the disk pool.

Configuration entry default: SLP.MAX_IMAGES_PER_SNAPSHOT_REPLICATION_JOB
= 50

Maximum images per
snapshot replication job

The fewest number of images in a single batch that can run as an Auto Image
Replication import job. The job does not run until either the minimum size is reached
or the Force interval for small jobs time is reached. Minimum: 1 image; no maximum
number of images. Default: 1 image.

Configuration entry default: SLP.MIN_IMAGES_PER_IMPORT_JOB = 1

Minimum images per A.I.R.
Import job

The largest number of images in a single batch that can run as an Auto Image
Replication import job. Minimum: 1 job; no maximum number of images. Default: 250
images.

Configuration entry default: SLP.MAX_IMAGES_PER_IMPORT_JOB = 250

Maximum images per A.I.R.
Import job
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Table 3-60 SLP Parameters (continued)

DescriptionProperty

The age that the oldest image in a batch must reach after which the batch is submitted
as a duplication job. This value prevents many small duplication jobs from running at
one time or running too frequently. It also prevents NetBackup from waiting too long
before it submits a small job. Default: 30 minutes, with nominimum number or maximum
number.

Configuration entry default: SLP.MAX_TIME_TIL_FORCE_SMALL_DUPLICATION_JOB
= 30 MINUTES

Force interval for small jobs

Indicates the frequency of the job submission for all operations. No minimum interval
or maximum interval. Default: 5 minutes.

By default, all jobs are processed before more jobs are submitted. Increase this interval
to allow NetBackup to submit more jobs before all jobs are processed. Set the interval
when the list of available images is scanned for those that can be batched together
and jobs submitted. A shorter interval allows for a better response to changing system
workloads at the cost of increased processing.

Configuration entry default: SLP.JOB_SUBMISSION_INTERVAL = 5 MINUTES

Job submission interval

The number of minutes between image-processing sessions. Set the interval when
newly created images are recognized and set up for SLP processing. Default: 5 minutes.

Configuration entry default: SLP.IMAGE_PROCESSING_INTERVAL = 5 MINUTES

Image processing interval

The time between when a job finishes and before NetBackup removes the job artifacts
for the completed job. No minimum interval or maximum interval. Default: 24 hours.

Configuration entry default: SLP.CLEANUP_SESSION_INTERVAL = 24 HOURS

Cleanup interval

The amount of time to wait before an unsuccessful operation is added to the first job
that runs after the delay. (This applies to all SLP jobs.) The extra time gives the
administrator additional time to solve a problem that prevents job completion. No
minimum interval or maximum interval. Default: 2 hours.

Configuration entry default: SLP.IMAGE_EXTENDED_RETRY_PERIOD = 2 HOURS

Extended image retry
interval

Concerns the deletion of SLP versions where a more recent version exists. The setting
controls how long a version must be inactive before NetBackup deletes it. Default: 14
days.

Configuration entry default: SLP.VERSION_CLEANUP_DELAY = 14 DAYS

See “Deleting old storage lifecycle policy versions” on page 705.

Unused SLP definition
version cleanup delay
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Table 3-60 SLP Parameters (continued)

DescriptionProperty

Limits the number of concurrently active duplication jobs that can access a single tape
media storage unit to xx times the number of available drives. Allows tuning to avoid
overloading the Resource Broker, yet makes sure that the devices are not idle. No
minimummultiplier or maximummultiplier. Default: 2 (multiply access to the write drives
by two).

Configuration entry default: SLP.TAPE_RESOURCE_MULTIPLIER = 2

Tape resource multiplier

Limits the number of concurrently active duplication jobs that can access a single disk
storage unit to xx times the number of available drives. Allows tuning to avoid
overloading the Resource Broker, yet makes sure that the devices are not idle. No
minimummultiplier or maximummultiplier. Default: 2 (multiply access to the write drives
by two).

Configuration entry default: SLP.DISK_RESOURCE_MULTIPLIER = 2

Disk resource multiplier

If this parameter is set to Yes (default), multiple SLPs of the same priority can be
processed in the same job. If No, batching can occur only within a single SLP.

Configuration entry default: SLP.DUPLICATION_GROUP_CRITERIA = 1

Configuration entry for no, do not allow
batching:SLP.DUPLICATION_GROUP_CRITERIA = 0

Group images across SLPs

Sets the amount of time before a window closes when NetBackup does not submit
new jobs using that window. Minimum 2 minute; maximum: 60 minutes. Default: 15
minutes.

Configuration entry default: SLP.WINDOW_CLOSE_BUFFER_TIME = 15 MINUTES

Window close buffer time

For deferred operations, jobs are submitted x time before the source copy is due to
expire. Default: 4 hours.

Configuration entry default: SLP.DEFERRED_DUPLICATION_OFFSET_TIME = 4
HOURS

Deferred duplication offset
time

Used for Auto Image Replication, indicates whether an SLP (that contains an Import
operation) is created automatically in the target domain if no SLP is configured there.
Default: Yes, an SLP is created in the target domain.

Configuration entry default: SLP.AUTO_CREATE_IMPORT_SLP = 1

Auto create A.I.R. Import
SLP

How long NetBackup retries an Import job before it stops and deletes the record. After
the initial four attempts, the retries become less frequent. Default: 0 (do not retry after
the initial four attempts).

Configuration entry default: SLP.REPLICA_METADATA_CLEANUP_TIMER = 0 HOURS

How long to retry failed
A.I.R. import jobs
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Table 3-60 SLP Parameters (continued)

DescriptionProperty

How long NetBackup waits before it generates a notification that an Auto Image
Replication copy is still in import pending state. After an Auto Image Replication copy
has been replicated, NetBackup puts the source copy into import pending state. If the
copy is in import pending state for the time period that this threshold sets, NetBackup
generates a notification. Notifications are sent to the NetBackup error log and are visible
in the Problems report. Notifications may also be sent to an email address, if specified.
Default: 24 hours

Configuration entry default: SLP.PENDING_IMPORT_THRESHOLD = 24 HOURS

See “About Auto Image Replication import confirmation” on page 1072.

Pending A.I.R import
threshold

The email address that receives pending A.I.R. import notifications. Default: None.

Configuration entry format: SLP.NOTIFICATIONS ADDRESS = user@company.com

Email address to receive
notifications

Command-line units of measurement for the SLP
parameters
The abbreviations are case-insensitive for units of measurement.

The following abbreviations can be used where sizes are indicated:

megabytembkilobyteskilobyte(s)kilobytekbbytes

tbgigabytesgigabyte(s)gigabytegbmegabytesmegabyte(s)

petabytespetabyte(s)petabytepbterabytesterabyte(s)terabyte

The following abbreviations can be used where units of time are indicated:

minutesminute(s)minuteminsecondssecond(s)secondsec

monthmondaysday(s)dayhourshour(s)hour

yearsyear(s)yearweeksweek(s)weekmonthsmonth(s)

About batch creation logic in Storage Lifecycle Manager
The Storage Lifecycle Manager service (nbstserv) is in charge of creating
duplication jobs for storage lifecycle policies. Part of duplication job creation includes
grouping the backup (or source) jobs into batches.
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Note: Restart nbstserv after making changes to the underlying storage for any
operation in an SLP.

One objective of the batching logic is to prevent media contention for tape operations,
including virtual tape libraries (VTL).

Batching logic applies to both disk and tape. (Though the method to prevent media
contention for disk is to use disk pools and then to limit I/O streams to disk pools.)

The batching logic requires that for each evaluation cycle, nbstserv consider all
completed source jobs when determining which duplication job to run next. By
default, nbstserv performs the evaluation once every 5 minutes.

nbstserv avoids overloading the Resource Broker (nbrb) queue with jobs. Too
many jobs in the queue make the role of the Resource Broker harder and slows
down system performance.

By default, nbstserv now creates groups based on the Group images across
SLPs parameter in theSLPParameters host properties. By default, multiple storage
lifecycle policies with the same priority can be batched together.

See “SLP Parameters properties” on page 230.

This batching logic change affects how duplication jobs appear in the Activity
Monitor. Storage lifecycle policies that have been combined into one job appear
under a single policy name: SLP_MultipleLifecycles. If a storage lifecycle policy
has not been combined with another, the name appears in the Activity Monitor
under the name of the SLP: SLP_name.

Users may see some duplication jobs that, although in the running state, do not
duplicate data because they have no resources to read or write. These jobs continue
to run until they receive resources to complete the job.

To turn off grouping by duplication job priority, set theGroup images across SLPs
parameter to No in the SLP Parameters host properties.

Throttle Bandwidth properties
Use the Throttle Bandwidth properties to specify a limit for the network bandwidth
or transfer rate that NetBackup clients use on a network. The actual limiting occurs
on the client side of the backup connection. These properties limit only backups.
Restores are unaffected. The default is that the bandwidth is not limited.

The Throttle Bandwidth properties are similar to the Bandwidth host properties,
but offer greater flexibility in IPv6 environments.
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Figure 3-61 Throttle Bandwidth dialog box

To manage entries in the Throttle Bandwidth dialog box, select one of the following
buttons:

Add a network or host to the Network or Host list using the Add
Bandwidth Settings dialog box.

Add

Change the selected network or host property using the Change
Bandwidth Settings dialog box.

Change

Removes the selected network or host from the Network or Host
list.

Remove

Add Bandwidth Settings dialog box for Throttle Bandwidth properties
The Add Bandwidth Settings and the Change Bandwidth Settings dialog boxes
contain the following properties.

The network or host to which the throttle applies.Network or Host
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The bandwidth or the transfer rate in kilobyte per second for
the network or host indicated. A value of zero disables
throttling IPv6 addresses.

Bandwidth (KB/Sec)

Timeouts properties
The Timeouts properties apply to selected master servers, media servers, and
clients.

Figure 3-62 Timeouts dialog box

The Timeouts dialog box contains the following properties.

Table 3-61 Timeouts dialog box properties

DescriptionProperty

Specifies the number of seconds the server waits before it times out when it connects
to a client. The default is 300 seconds.

Client connect timeout
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Table 3-61 Timeouts dialog box properties (continued)

DescriptionProperty

Specifies the number of seconds the server waits for the bpstart_notify script on
a client to complete. The default is 300 seconds.

Note: If using the bpstart_notify script: The Client read timeout
(CLIENT_READ_TIMEOUT option) must be equal to or greater than the Backup start
notify timeout (BPSTART_TIMEOUT option). If the Client read timeout is less than
the Backup start notify timeout, the job can timeout while the bpstart_notify
script is running.

Backup start notify timeout

Specifies how long the client can wait for a response from the NetBackup master server
while it lists files.

Note: If it exists, the value in a UNIX client’s $HOME/bp.conf file takes precedence
to the property here.

If the limit is exceeded, the user receives a socket read failed error. The timeout can
be exceeded even while the server processes the request.

File browse timeout

Specifies that the client waits for the timeout period as determined by the operating
system when it lists files, as follows:

■ Windows client: 300 seconds
■ UNIX client: 1800 seconds

UseOSdependent timeouts

Specifies how long NetBackup waits for the requestedmedia to bemounted, positioned,
and ready on backups, restores, and duplications.

This property applies to currently selected master servers.

Use this timeout to eliminate excessive waiting time during manual media mounts. (For
example, when robotic media is out of the robot or is off-site.)

Media mount timeout
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Table 3-61 Timeouts dialog box properties (continued)

DescriptionProperty

Specifies the number of seconds that NetBackup waits for a response from a client
before the operation attempt fails. This timeout can apply to a NetBackup master,
remote media server, or database-extension client (such as NetBackup for Oracle).
The default is 300 seconds.

If the server does not get a response from a client within the Client read timeout
period, the backup or restore operation, for example, fails.

The sequence on a database-extension client is as follows:

■ NetBackup on the database-extension client reads the client’s client-read timeout
to find the initial value. If the option is not set, the standard 5-minute default is used.

■ When the database-extension API receives the server’s value, it uses it as the
client-read timeout.

See “Client Settings properties for UNIX clients” on page 84.

Veritas recommends increasing the timeout value in the following situations:

■ The client-read timeout on a database-extension client is a special case. Clients
can initially require more time to get ready than other clients. More time is required
because database backup utilities frequently start several backup jobs at the same
time, slowing the central processing unit. A setting of 15 minutes is adequate for
many installations.

■ Backing up directly to a CloudCatalyst storage server. If the value is not increased
for both the master server and the media server, you may see jobs failing with the
following message in the job details:
Error bpbrm (pid=119850) socket read failed: errno = 62 -
Timer expired

Note that increasing the timeout is not needed it you use a storage lifecycle policy
to first back up to an MSDP storage server and then duplicate the data to an MSDP
cloud storage server using an optimized duplication operation. (This is the
recommended method of operation.)

Note: If using the bpstart_notify script: The Client read timeout
(CLIENT_READ_TIMEOUT option) must be equal to or greater than the Backup start
notify timeout (BPSTART_TIMEOUT option). If the Client read timeout is less than
the Backup start notify timeout, the job can timeout while the bpstart_notify
script is running.

Client read timeout

Specifies the number of seconds that the server waits for the bpend_notify script
on a client to complete. The default is 300 seconds.

Note: If this timeout is changed, verify that Client read timeout is set to the same or
higher value.

Backup end notify timeout
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Table 3-61 Timeouts dialog box properties (continued)

DescriptionProperty

Specifies the number of seconds that the master server waits before it times out when
it connects to a remote media server. The default is 30 seconds.

Media server connect
timeout

Universal Settings properties
Use theUniversal Settings properties in theNetBackup Administration Console
to configure basic backup and restore settings. These properties apply to selected
master servers, media servers, and clients.

Figure 3-63 Universal Settings dialog box

The Universal Settings dialog box contains the following options.
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Table 3-62 Universal Settings dialog box properties

DescriptionProperty

Specifies the number of attempts a client has to restore after a failure. (The default is
0; the client does not attempt to retry a restore. The client can try up to three times.)
Change Restore retries only if problems are encountered.

If a job fails after the maximum number of retries, the job goes into an incomplete state.
The job remains in the incomplete state as determined by the Move restore job from
incomplete state to done state property.

See “Clean-up properties” on page 66.

A checkpointed job is retried from the start of the last checkpointed file rather than at
the beginning of the job.

Checkpoint restart for restore jobs allows a NetBackup administrator to resume a
failed restore job from the Activity Monitor.

See “Take checkpoints every __ minutes (policy attribute)” on page 736.

Restore retries

Specifies how long ago NetBackup searches for files to restore. For example, to limit
the browse range to one week before the current date, clear the Last full backup
check box and specify 7.

This limit is specified on the master server and applies to all NetBackup clients. A limit
can be specified on an individual client to reduce the size of the Search window. The
client setting cannot make the browse window larger.

By default, NetBackup includes files from the time of the last-full backup through the
latest backup for the client. If the client belongs to more than one policy, then the browse
starts with the earliest of the set of last-full backups.

Browse timeframe for
restores

Indicates whether NetBackup includes all backups since the last successful full backup
in its browse range. This property must be disabled to enter a value for the Browse
timeframe for restores property. The default is that this property is enabled.

Last full backup

Specifies the network interface that NetBackup uses to connect to another NetBackup
client or server. A NetBackup client or server can have more than one network interface.
To force NetBackup connections to be made on a specific network interface, use this
entry to specify the network host name of that interface. By default, the operating
system determines the one to use.

Use specified network
interface

Specifies whether a NetBackup server can create or modify files on the NetBackup
client. For example, enable this property to prevent server-directed restores and remote
changes to the client properties.

After theAllow server file writes property is applied, it can be cleared only by modifying
the client configuration. The default is that server writes are allowed.

See “DISALLOW_SERVER_FILE_WRITES option for NetBackup servers and clients”
on page 283.

Allow server file writes
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Table 3-62 Universal Settings dialog box properties (continued)

DescriptionProperty

UNIX only:

No progress log is produced for a redirected restore if the requesting server is not
included in the server list for the server that performs the restore. (A progress log is
an entry in the Task Progress tab of the Backup, Archive, and Restore client interface.)

Without the entry in the server list, the restoring server has no access to write the log
files to the requesting server.

Consider the following solutions:

■ To produce a progress log, add the requesting server to the server list and log into
the requesting server.
■ In theNetBackup Administration Console, expandNetBackupManagement

> Host Properties > Master Servers.
■ In the details pane, double-click on master server you want to modify, and click

Servers from the options pane.
■ Add the restoring server to the server list.

■ Log on to the restoring server. Check the Activity Monitor to determine the success
of the restore operation.

Logging the status of a
redirected restore

This property no longer applies.Accept connections from
non-reserved ports

Specifies whether the client sends an email to the address that is specified in the
Universal Settings properties. If the client cannot send email, use Server sendsmail.
The default is that this property is enabled.

Client sends mail

Specifies whether the server sends an email to the address that is specified in the
Global Attributes properties. Enable this property if the client cannot send mail and
you want an email notification. The default is that this property is disabled.

See “Global Attributes properties” on page 136.

Server sends mail

Specifies the email address of the administrator on the client. This address is where
NetBackup sends backup status reports for the client. By default, no email is sent. To
enter multiple addresses or email aliases, separate entries with commas.

Client administrator’s email

Logging the status of a redirected restore
A redirected restore may not produce a progress log. The name of the requesting
server must appear in the server list for the server that performs the restore.
Otherwise, no progress log is produced for a redirected restore.(A progress log is
an entry in the Task Progress tab of the Backup, Archive, and Restore client
interface.)
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Without the entry in the server list, the restoring server has no access to write the
log files to the requesting server. Add the requesting server to the server list and
log into the requesting server.

To produce a progress log

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties > Master Servers.

2 In the right pane, double-click the master server you want to modify.

In the properties dialog box, in the left pane, click Servers.

3 Perform one of the following actions:

■ Additional servers
From the Media servers list, click Add.

■ Media servers
From the Additional servers list, click Add.

4 In the Add a New Server Entry dialog box, enter the name of the new server.

5 Click Add. The dialog box remains open for another entry.

6 Click Close.

7 Log on to the restoring server.

Check the Activity Monitor to determine the success of the restore operation.

See “About the Jobs tab” on page 1100.

User Account Settings properties
Use the User Account Settings properties to customize the idle timeout and
account lockout time for users of the NetBackup Administration Console and the
NetBackup web UI.
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Figure 3-64 User Account Settings dialog box

The User Account Settings dialog box contains the following properties.

Table 3-63 User Account Settings dialog box properties

DescriptionProperty

Logs out the user session if there is no GUI activity for the specified period of time.

Select the Enable auto log off timeout check box to enable the auto logoff timeout
option.

Select the number of minutes after which the session should be terminated.

Note: To terminate the session as per the GUI Idle Timeout settings, NetBackup
requires the bprd service to be running.

GUI Idle Timeout
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Table 3-63 User Account Settings dialog box properties (continued)

DescriptionProperty

Specifies the user account lockout duration if the number of invalid or failed logon
attempts exceeds the specified number.

Select the Enable account lockout check box to lock the user out of the console or
the web UI for the specified duration:

■ Number of failed login attempts allowed: Select number of attempts to lock the
user out of the account after that many unsuccessful login attempts.

Note: To lock the user out of the account as per this setting, NetBackup requires
the bprd service to be running.

■ Account lockout duration: Select a time period after which a user account is
automatically unlocked after the set duration.

Account lockout

Unlocking a user account
A user account is locked if the number of invalid login attempts exceeds the specified
number or if the idle timeout duration passes. The user account remains locked
until the account lockout period passes. However, user accounts can be unlocked
before the lockout period passes if there is an immediate need to access the
NetBackup Administration Console or the NetBackup web UI.

To unlock a user account

1 From the Actions menu, select the Unlock users option.

The Unlock Users dialog box lists the names of the users whose accounts
are locked.

2 Select the users who you want to unlock and click Unlock.

Select the Refresh option on the top right of the Unlock Users dialog box.
The user accounts that were unlocked do not appear in the list.

Locking a NetBackupAdministration Console session manually
A NetBackup session locks automatically if it is left idle or inactive. A NetBackup
Administration Console session can also be manually locked. For example, if a
user has to temporarily leave and does not want to close the active session. The
user must log in again to access the session.

Note: The console is locked even when multiple dialog boxes are open.
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Locking a NetBackup session manually

1 On the File menu, select the Lock the console option or select the lock icon
on the top left.

Alternatively, press Alt + K to lock the console.

2 NetBackup prompts you to log in again to access the session. Enter a valid
password to log in.

UNIX Client properties
Use the UNIX Client properties in the NetBackup Administration Console to
define properties of clients running on the UNIX platform.

Figure 3-65 UNIX Client dialog box

See “Client Settings properties for UNIX clients” on page 84.
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See “Busy File Settings properties” on page 63.

See “Lotus Notes properties” on page 160.

VMware Access Hosts properties
Use the VMware Access Hosts properties in the NetBackup Administration
Console to add or remove VMware backup hosts. These properties apply to
currently selected master servers.

These properties appear when the NetBackup Enterprise Client license is installed.

Figure 3-66 VMware Access Hosts dialog box

The backup host is a NetBackup client that performs backups on behalf of the virtual
machines. (This host was formerly known as the VMware backup proxy server.)
The backup host is the only host on which NetBackup client software is installed.
As an option, the backup host can also be configured as a NetBackup master server
or media server.

The backup host is referred to as the recovery host when it performs a restore

You can add servers to and remove servers from the access hosts list:
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ClickAdd and enter the fully qualified domain name of the backup host.Add

Select the backup host in the list and click Remove.Remove

For more information, see the NetBackup for VMware Administrator’s Guide.

Windows Client properties
Use theWindows Client properties in the NetBackup Administration Console
to define NetBackup properties for Microsoft Windows clients.

Figure 3-67 Windows Client dialog box

Windows Client properties include specific host properties for configuringWindows
clients.
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Configuration options not found in the Host
Properties

Most NetBackup configuration options can be found in the Host Properties of the
NetBackup Administration Console. However, some options cannot be accessed
in the Host Properties.

To change the default value for an option that is not found in the Host Properties,
first use the nbgetconfig command to obtain a list of configuration options. Then
use nbsetconfig to change the options as needed.

For information about these commands, see the NetBackup Commands Reference
Guide.

About using commands to change the
configuration options on UNIX clients and servers

When commands (nbsetconfig or bpsetconfig) are used to change the
configuration options on UNIX NetBackup servers or clients, the commands change
the appropriate configuration files.

Most options are found in the following configuration file:

/usr/openv/netbackup/bp.conf

If a single UNIX system is running as both a client and a server, the bp.conf file
contains options for both the client and the server.

The bp.conf file observes the following syntax:

■ Use the # symbol to comment out lines.

■ Any number of spaces or tabs are allowed on either side of = signs.

■ Blank lines are allowed.

■ Any number of blanks or tabs are allowed at the start of a line.

Each nonroot user on a UNIX client can also have a personal bp.conf file in their
home directory:

$HOME/bp.conf

The options in personal bp.conf files apply only to user operations. During a user
operation, NetBackup checks the $HOME/bp.conf file before
/usr/openv/netbackup/bp.conf.
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Root users do not have personal bp.conf files. NetBackup uses the
/usr/openv/netbackup/bp.conf file for root users.

Stop and restart all NetBackup daemons and utilities on the server after you make
a change to the bp.conf file on a UNIX master server. This action ensures that all
of the NetBackup processes use the new bp.conf values. This action is not required
for changes to bp.conf files on a client or to a $HOME/bp.conf file on the master
server.

The SERVER option must be present in the /usr/openv/netbackup/bp.conf file on
all NetBackup UNIX clients and servers. During installation, NetBackup sets the
SERVER option to the name of the master server where the software is installed. It
is the only required option in the bp.conf files. NetBackup uses internal software
defaults for all options in the bp.conf file, except SERVER.

The SERVER entries must be the same on all servers in a master and a media server
cluster. Veritas recommends (but does not require) that all other entries also match
on all servers. (The CLIENT_NAME option is an exception.)

Configuration options for NetBackup servers
The following topics are about configuration options for NetBackup servers. Nearly
all of these options can also be set in the Host Properties in the NetBackup
Administration Console.

Note: On Windows platform, NetBackup supports 7-bit ASCII characters for the
file paths that are to be specified for security-specific configuration options.

See “Configuration options not found in the Host Properties” on page 250.

About robust logging
Robust logging indicates to NetBackup to limit the amount of disk space that a log
directory consumes. When a log file grows to the specified maximum size, the log
file is closed and a new log file is opened. If the new log file causes the maximum
number of log files in the directory to be exceeded, the oldest log file is deleted.

Robust logging functionality comprises the following configuration parameters:
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This configuration parameter specifies the maximum size that
you want to set for a log file in MB.

The default value for MAX_LOGFILE_SIZE is 500 MB.

See “MAX_LOGFILE_SIZE option for NetBackup servers and
clients for legacy logging” on page 311.

MAX_LOGFILE_SIZE

This configuration parameter specifies the maximum number
of log files that you want to be created in NetBackup.

The default value for MAX_NUM_LOGFILES is 0 infinite.

See “MAX_NUM_LOGFILES option for NetBackup servers
and clients for legacy logging” on page 312.

MAX_NUM_LOGFILES

ALLOW_MEDIA_OVERWRITE option for NetBackup servers
This option overrides the NetBackup overwrite protection for various media formats
on removable media.

Table 3-64 ALLOW_MEDIA_OVERWRITE information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

ALLOW_MEDIA_OVERWRITE = media_format

This option should appear only once in the configuration file.

How to use

On the master server (and media servers if applicable), add the following entry to permit
overwriting the cpio format:

ALLOW_MEDIA_OVERWRITE = CPIO

Example

NetBackupManagement > Host Properties >ClickMaster Servers orMedia Servers
> Double-click on server > Media > Allow media overwrite.

See “Media properties” on page 163.

Equivalent Administration
Console property

252Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


AUTHENTICATION_DOMAIN option for NetBackup servers and
clients

This option defines a set of NetBackup product authentication principles.

Table 3-65 AUTHENTICATION_DOMAIN information

DescriptionUsage

A master server, media server, or client that uses NetBackup product authentication
and authorization must have at least one AUTHENTICATION_DOMAIN entry listed for
this option. More than one domain can be specified.

If a media server or client does not define an authentication domain, it uses the
authentication domains of its master server.

Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

AUTHENTICATION_DOMAIN = domain "comment"
mechanism broker [port]

This option may appear more than once in the configuration file.

The following variables are defined:

■ domain is an Internet domain name or a Windows domain name.
■ "comment" is a quoted comment that describes the authentication domain.
■ mechanism is the authentication mechanism.

The keywords for various mechanisms are as follows:
■ NIS: Network Information Service version 1
■ NIS+: Network Information Service version 2
■ PASSWD: Local UNIX password file on the specified broker
■ VXPD: The NetBackup product authentication and authorization private database
■ WINDOWS: Windows Active Directory or primary domain controller

■ broker is the host name or IP address of the authentication broker.
■ port is the port number of the authentication broker. The default is the standard port

number for authentication brokers.

How to use
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Table 3-65 AUTHENTICATION_DOMAIN information (continued)

DescriptionUsage

AUTHENTICATION_DOMAIN = mycompany.com "Typical UNIX logins"
NIS broker1.mycompany.com
AUTHENTICATION_DOMAIN = OurEnterprise "Typical Windows logins"
WINDOWS broker2.mycompany.com 5544
AUTHENTICATION_DOMAIN = mycompany.com "VxSS-Only Identities"
VXPD broker1.mycompany.com
AUTHENTICATION_DOMAIN = broker3.mycompany.com "Local
UNIX Logins on host broker3" PASSWD broker3.mycompany.com

In this example:

■ mycompany.com is the Internet domain name and OurEnterprise is theWindows
domain name.

■ The broker on host name broker1 handles both NIS and private authentication
for NetBackup product authentication.

■ The broker on host name broker2 handlesWindows authentication for NetBackup
product authentication.

■ broker2 uses the non-standard port number 5544.
■ The broker on host name broker3 uses its local /etc/passwd file for NetBackup

product authentication.

Example

NetBackupManagement > Host Properties >ClickMaster Servers,Media Servers,
Clients > Double-click on server > Access Control > Authentication Domain.

See “Authentication Domain tab of the Access Control properties” on page 57.

Equivalent Administration
Console property

AUTHORIZATION_SERVICE option for NetBackup servers
This option defines the NetBackup Product Authorization Service that the local
NetBackup server uses.

Table 3-66 AUTHORIZATION_SERVICE information

DescriptionUsage

Amaster server that uses NetBackup product authorizationmust define an authorization
service. If a media server does not define an authorization service, it uses the
authorization service of the master server.

Where to use
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Table 3-66 AUTHORIZATION_SERVICE information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

AUTHORIZATION_SERVICE = host [ port ]

The following variables are defined:

■ host is the host name or IP address of the authorization service.
■ port is the port number of the authorization service. The default is the standard port

number for the authorization service.

This option should appear only once in the configuration file.

How to use

NetBackupManagement > Host Properties >ClickMaster Servers orMedia Servers
> Double-click on server > Access Control > Authorization Service.

See “Authorization Service tab of the Access Control properties” on page 57.

Equivalent Administration
Console property

AUTO_ADD_ALL_ALIASES_FOR_CLIENT option for NetBackup
servers

This option allows client aliases to be automatically added to the NetBackup
database when bpdbm detects a new client in a backup policy.

Table 3-67 AUTO_ADD_ALL_ALIASES_FOR_CLIENT information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-67 AUTO_ADD_ALL_ALIASES_FOR_CLIENT information
(continued)

DescriptionUsage

By default, AUTO_ADD_ALL_ALIASES_FOR_CLIENT is not present in the configuration
file. When AUTO_ADD_ALL_ALIASES_FOR_CLIENT is not present, the option is
enabled. That is, bpdbm is allowed to add client aliases automatically.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

AUTO_ADD_ALL_ALIASES_FOR_CLIENT = YES | NO

This entry should appear only once in the configuration file.

How to use

The following entry prohibits bpdbm from adding a client alias automatically:

AUTO_ADD_ALL_ALIASES_FOR_CLIENT = NO

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BPBRM_VERBOSE option for NetBackup servers
The BPBRM_VERBOSE option is used for debugging purposes. It controls the amount
of information that NetBackup includes in the bpbrm debug log.

Table 3-68 BPBRM_VERBOSE information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-68 BPBRM_VERBOSE information (continued)

DescriptionUsage

The default is that BPBRM_VERBOSE is the same value as the VERBOSE option (Global
logging level). The BPBRM_VERBOSE option overrides the VERBOSE option in the
configuration file.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPBRM_VERBOSE = -1 | 0 | 1 | 2 | 3 | 4 | 5

This entry should appear only once in the configuration file.

How to use

■ To use the same value as the VERBOSE option, enter:
BPBRM_VERBOSE = 0

This option is the same as setting the BPBRM logging level in the Logging host
properties to Same as Global.

■ To log the minimum amount of information, enter:
BPBRM_VERBOSE = -1

This option is the same as setting the BPBRM logging level to 0 in the Logging
host properties.

■ To log additional information, enter a value of 1 through 5:
BPBRM_VERBOSE = 1

This option is the same as setting the BPBRM logging level to 1 in the Logging
host properties.

■ To log the maximum amount of information, enter:
BPBRM_VERBOSE = 5

This option is the same as setting the BPBRM logging level to 5 in the Logging
host properties.

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Logging > BPBRM logging level.

See the NetBackup Logging Reference Guide for more information about the debug
log.

See “Logging properties” on page 148.

Equivalent Administration
Console property

BPCD_WHITELIST_PATH option for NetBackup servers and clients
NetBackup will deny access to a file that is specified for NetBackup operations if
the path is a non-default path. For example, a path that is specified for progress
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log or rename files. You must use the BPCD_WHITELIST_PATH option to allow access
to non-default custom paths.

Table 3-69 BPCD_WHITELIST_PATH information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPCD_WHITELIST_PATH = Absolute pathname to the directory

How to use

The following are the example entries on a NetBackup server or client:

BPCD_WHITELIST_PATH = directory1

BPCD_WHITELIST_PATH = directory2

Create a separate entry for each directory.

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BPDBJOBS_COLDEFS options for UNIX master servers
Use BPDBJOBS_COLDEFS entries to customize the output of the bpdbjobs process.
Add a BPDBJOBS_COLDEFS option for every column you want to include in the output.

Add BPDBJOBS_COLDEFS entries to the bp.conf file to customize the output of the
bpdbjobs process.

Table 3-70 BPDBJOBS_COLDEFS information

DescriptionUsage

On a UNIX NetBackup master server.Where to use
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Table 3-70 BPDBJOBS_COLDEFS information (continued)

DescriptionUsage

Add BPDBJOBS_COLDEFS to the /usr/openv/netbackup/bp.conf file.

Add an entry for every column to include in the output by using the following format:

BPDBJOBS_COLDEFS = COLDEFS_ENTRY [minimum_size [true |
false]]

The following variables are defined:

■ COLDEFS_ENTRY is the name of the column to include in the output.
■ minimum_size is the minimum column width. If not specified, the default is a width

of 5.
■ true indicates that the column should expand as needed. If not specified, true

is the default.
■ false indicates that the column should not expand beyond the minimum_size.

How to use

The order of the entries determines the order in which the column headings appear.

BPDBJOBS_COLDEFS = JOBID 5 true
BPDBJOBS_COLDEFS = TYPE 4 true
BPDBJOBS_COLDEFS = STATE 5 true
BPDBJOBS_COLDEFS = STATUS 6 true
BPDBJOBS_COLDEFS = POLICY 6 true
BPDBJOBS_COLDEFS = SCHEDULE 8 true
BPDBJOBS_COLDEFS = CLIENT 6 true
BPDBJOBS_COLDEFS = DSTMEDIA_SERVER 12 true
BPDBJOBS_COLDEFS = ACTPID 10 true

The appearance of BPDBJOBS_COLDEFS entries in the bp.conf file has the following
ramifications:

■ The addition of any BPDBJOBS_COLDEFS option overrides all default columns.
■ All users on the local system see only those columns that are specified in the

bp.conf file.

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

Table 3-71 shows possible COLDEFS entries and the column which is created by
each.
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Table 3-71 COLDEFS entries

Column NameCOLDEFS entry

Active Elapsed (elapsed active time)ACTIVEELAPSED

Active PID (PID of job)ACTPID

AttemptATTEMPT

Backup TypeBACKUPTYPE

ClientCLIENT

Completion (percent complete)COMPLETION

Compression (yes or no)COMPRESSION

Dedup (shows deduplication rate in
bpdbjobs command output)

DEDUPRATIO

Dest Media Svr (writing media server)DSTMEDIA_SERVER

Dest Media ID (writing media ID)DSTMEDIAID

Dest StUnit (writing storage unit)DSTSTORAGE_UNIT

Elapsed (elapsed time)ELAPSED

EndedENDED

Est File (estimated number of files)ESTFILE

Est KB (estimated number of kilobytes)ESTKB

FilesFILES

GroupGROUP

JobIDJOBID

KB Per SecKBPERSEC

KilobytesKILOBYTES

Last Backup (date and time)LASTBACKUP

Main PID (PID that spawns job, if applicable)MAINPID

Media to Eject (number of tapes to eject;
Vault only)

NUMTAPESEJECT
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Table 3-71 COLDEFS entries (continued)

Column NameCOLDEFS entry

Operation (current operation)OPERATION

OwnerOWNER

PathnamePATHNAME

Parent JobIDPARENTJOBID

PolicyPOLICY

Policy TypePOLICYTYPE

PriorityPRIORITY

Profile (Vault only)PROFILE

Retention (retention period)RETENTION

ResumableRESUMABLE

Robot (Vault only)ROBOT

Request PID (PID requesting job, if
applicable)

RQSTPID

ScheduleSCHEDULE

Schedule TypeSCHEDULETYPE

Session ID (Vault only)SESSIONID

Src Media SvrSRCMEDIA_SERVER

Src Media IDSRCMEDIAID

Src StUnitSRCSTORAGE_UNIT

StartedSTARTED

StateSTATE

StatusSTATUS

Stream NumberSTREAMNUMBER

SuspendableSUSPENDABLE

Type (job type)TYPE
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Table 3-71 COLDEFS entries (continued)

Column NameCOLDEFS entry

Vault (Vault only)VAULT

BPDBM_VERBOSE option for NetBackup servers
The BPDBM_VERBOSE option is used for debugging purposes. It controls the amount
of information NetBackup includes in the bpdbm debug log.

Table 3-72 BPDBM_VERBOSE information

DescriptionUsage

On NetBackup master servers.Where to use

The default is that BPDBM_VERBOSE is the same value as the VERBOSE option (Global
logging level). The BPDBM_VERBOSE option overrides the VERBOSE option in the
configuration file.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPDBM_VERBOSE = -1 | 0 | 1 | 2 | 3 | 4 | 5

This entry should appear only once in the configuration file.

How to use
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Table 3-72 BPDBM_VERBOSE information (continued)

DescriptionUsage

■ To use the same value as the VERBOSE option for, enter:
BPDBM_VERBOSE = 0

This option is the same as setting the BPDBM logging level to Same as Global
in the Logging host properties.

■ To log the minimum amount of information, enter:
BPDBM_VERBOSE = -1

This option is the same as setting the BPDBM logging level to 0 in the Logging
host properties.

■ To log additional information, enter a value of 1 through 5:
BPDBM_VERBOSE = 1

This option is the same as setting the BPDBM logging level to 1 in the Logging
host properties.

■ To log the maximum amount of information, enter:
BPDBM_VERBOSE = 5

This option is the same as setting the BPDBM logging level to 5 in the Logging
host properties.

The following examples show two entries which enable logging, while they minimize
the growth rate of the bpdbm debug file:

VERBOSE = 5

BPDBM_VERBOSE = -1

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Logging > Global logging level > BPDBM logging level.

See the NetBackup Logging Reference Guide for more information about logging.

See “Logging properties” on page 148.

Equivalent Administration
Console property

BPRD_VERBOSE option for NetBackup servers
Used for debugging purposes, the BPRD_VERBOSE option controls the amount of
information that NetBackup includes in the bprd debug logs.

Table 3-73 BPRD_VERBOSE information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-73 BPRD_VERBOSE information (continued)

DescriptionUsage

The default is that the value is the same as the VERBOSE option (Global logging level).
The BPRD_VERBOSE option overrides the VERBOSE option in the configuration file.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPRD_VERBOSE = -1 | 0 | 1 | 2 | 3 | 4 | 5

This entry should appear only once in the configuration file.

How to use

■ To use the same value as the VERBOSE option, enter:
BPRD_VERBOSE = 0

This option is the same as setting the BPRD logging level in the Logging host
properties to Same as Global.

■ To log the minimum amount of information, enter:
BPRD_VERBOSE = -1

This option is the same as setting the BPRD logging level to 0 in the Logging
host properties.

■ To log additional information, enter a value of 1 through 5:
BPRD_VERBOSE = 1

This option is the same as setting the BPRD logging level to 1 in the Logging
host properties.

■ To log the maximum amount of information, enter:
BPRD_VERBOSE = 5

This option is the same as setting the BPRD logging level to 5 in the Logging
host properties.

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Logging > BPRD logging level.

See the NetBackup Logging Reference Guide for more information about the debug
log.

See “Logging properties” on page 148.

Equivalent Administration
Console property

BPTM_VERBOSE option for NetBackup servers
The BPTM_VERBOSE option is used for debugging purposes. It controls the amount
of information that NetBackup includes in the bptm debug logs.
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Table 3-74 BPTM_VERBOSE information

DescriptionUsage

On NetBackup master servers.Where to use

The default is that BPTM_VERBOSE is the same value as the VERBOSE option (Global
logging level). The BPTM_VERBOSE option overrides the VERBOSE option in the
configuration file.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPTM_VERBOSE = -1 | 0 | 1 | 2 | 3 | 4 | 5

This entry should appear only once in the configuration file.

How to use

■ To use the same value as the VERBOSE option, enter:
BPTM_VERBOSE = 0

This option is the same as setting the BPTM logging level in the Logging host
properties to Same as Global.

■ To log the minimum amount of information, enter:
BPTM_VERBOSE = -1

This option is the same as setting the BPTM logging level to 0 in the Logging
host properties.

■ To log additional information, enter a value of 1 through 5:
BPTM_VERBOSE = 1

This option is the same as setting the BPTM logging level to 1 in the Logging
host properties.

■ To log the maximum amount of information, enter:
BPTM_VERBOSE = 5

This option is the same as setting the BPTM logging level to 5 in the Logging
host properties.

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Logging > BPTM logging level.

See the NetBackup Logging Reference Guide for more information about the debug
log.

See “Logging properties” on page 148.

Equivalent Administration
Console property
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BPEND_TIMEOUT option for NetBackup servers
The BPEND_TIMEOUT option specifies the number of seconds to wait for the
bpend_notify script on a client to complete.

Table 3-75 BPEND_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPEND_TIMEOUT = seconds

The default timeout is 300 seconds (five minutes).

Note: If this option is changed, verify that the CLIENT_READ_TIMEOUT option is set
to the same value or higher.

This entry should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Timeouts > Backup end notify timeout.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property

BPSTART_TIMEOUT option for NetBackup servers
The BPSTART_TIMEOUT option specifies the number of seconds to wait for the
bpstart_notify script on a client to complete.

Table 3-76 BPSTART_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-76 BPSTART_TIMEOUT information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPSTART_TIMEOUT = seconds

The default timeout is 300 seconds (five minutes).

Note: If using the bpstart_notify script: The Client read timeout
(CLIENT_READ_TIMEOUT option) must be equal to or greater than the Backup start
notify timeout (BPSTART_TIMEOUT option). If the Client read timeout is less than
the Backup start notify timeout, the job can timeout while the bpstart_notify
script is running.

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Timeouts > Backup start notify timeout.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property

CHECK_RESTORE_CLIENT option for NetBackup servers
The CHECK_RESTORE_CLIENT option specifies that the client to be restored to is
checked before the restore starts. An unresponsive client can slow restores for
other clients that have data on the same tapes.

Table 3-77 CHECK_RESTORE_CLIENT information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

This option should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property
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CLIENT_CONNECT_TIMEOUT option for NetBackup servers
This option specifies the number of seconds that the server waits when it connects
to a client. If the server needs to wait longer than the time specified, it times out.

Table 3-78 CLIENT_CONNECT_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CLIENT_CONNECT_TIMEOUT = seconds

The default timeout is 300 seconds (five minutes).

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Timeouts > Client connect timeout.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property

CLIENT_PORT_WINDOWoption for NetBackup servers and clients
This option specifies the range of non-reserved ports on this computer that are
used as source ports when connecting to NetBackup on other computers. This
setting applies to daemon or service socket connections to the server and to the
client hosts as well as call-back from bpcd.

Table 3-79 CLIENT_PORT_WINDOW information

DescriptionUsage

On NetBackup servers and clients.Where to use
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Table 3-79 CLIENT_PORT_WINDOW information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CLIENT_PORT_WINDOW = start_port_range end_port_range

If 0 is specified for the first number (default), the operating system determines the
non-reserved port to use.

This option should appear only once in the configuration file.

How to use

The following example permits ports from 4800 through 5000:

CLIENT_PORT_WINDOW = 4800 5000

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Port Ranges > Client port window.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property

CLIENT_READ_TIMEOUT option for NetBackup servers
The CLIENT_READ_TIMEOUT option specifies the number of seconds that NetBackup
waits for a response from a client before the operation attempt fails. For example,
if the master server does not get a response from a client within the
CLIENT_READ_TIMEOUT period, the backup or restore operation fails.

Table 3-80 CLIENT_READ_TIMEOUT information

DescriptionUsage

On NetBackup master and media servers.Where to use
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Table 3-80 CLIENT_READ_TIMEOUT information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CLIENT_READ_TIMEOUT = seconds

By default, CLIENT_READ_TIMEOUT is not present on the server or the database
agent and the client-read timeout is 300 seconds (five minutes). This time is a
reasonable default. Change only in the event of problems.

CLIENT_READ_TIMEOUT on a database agent is a special case because these types
of clients can initially require more time to get ready than other clients. Database backup
utilities frequently start several backup jobs at the same time, which can slow the CPU.

The sequence on a database agent is as follows:

■ NetBackup on the database agent reads the client’s CLIENT_READ_TIMEOUT to
find the value to use initially. If the option is not set, the standard default of five
minutes is used.

■ When the database agent API receives the server’s value, it uses it as the
CLIENT_READ_TIMEOUT.

Veritas recommends increasing the timeout value on the master and media server in
the following situations:

■ For database agents, a setting of 15 minutes is adequate for many installations.
■ Backing up directly to a CloudCatalyst storage server. If the value is not increased,

you may see jobs failing with the following message in the job details:
Error bpbrm (pid=119850) socket read failed: errno = 62 -
Timer expired

Note that increasing the timeout is not needed it you use a storage lifecycle policy
to first back up to an MSDP storage server and then duplicate the data to an MSDP
cloud storage server using an optimized duplication operation. (This is the
recommended method of operation.)

Note: If using the bpstart_notify script: The Client read timeout
(CLIENT_READ_TIMEOUT option) must be equal to or greater than the Backup start
notify timeout (BPSTART_TIMEOUT option). If the Client read timeout is less than
the Backup start notify timeout, the job can timeout while the bpstart_notify
script is running.

How to use

The following example configures a client read timeout of 15 minutes.

CLIENT_READ_TIMEOUT = 900

Example
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Table 3-80 CLIENT_READ_TIMEOUT information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Click Master Servers or Media
Servers > Double-click on server > Timeouts > Client read timeout.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property

CLIENT_RESERVED_PORT_WINDOWoption forNetBackup servers
and clients

The CLIENT_RESERVED_PORT_WINDOW option specifies the range of reserved ports
on this computer that are used for connecting to NetBackup on other computers.
This setting applies when the computer connects to a client (bpcd) configured to
accept only reserved ports.

Beginning with NetBackup 7.0.1, connections to other daemon ports use only the
CLIENT_PORT_WINDOW, not the CLIENT_RESERVED_PORT_WINDOW.

Table 3-81 CLIENT_RESERVED_PORT_WINDOW information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CLIENT_RESERVED_PORT_WINDOW = start_port_range end_port_range

The default is from 512 through 1023. Note that if 0 is specified for the first number, a
non-reserved port is used instead. The operating system chooses the nonreserved
port.

This option should appear only once in the configuration file.

How to use

The following example permits ports from 900 through 1023:

CLIENT_RESERVED_PORT_WINDOW = 900 1023

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Port Ranges > Client reserved port window.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property
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CLUSTER_ECA_CERT_PATH for clustered master server
The CLUSTER_ECA_CERT_PATH option is specific to clustered master server. It
specifies the path to the external CA-signed certificate of the virtual name.

Table 3-82 CLUSTER_ECA_CERT_PATH information

DescriptionUsage

On clustered master server.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

CLUSTER_ECA_CERT_PATH = Path to the certificate
of the virtual identity

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

CLUSTER_ECA_KEY_PASSPHRASEFILE for clustered master
server

The CLUSTER_ECA_KEY_PASSPHRASEFILE option is specific to clustered master
server. It specifies the path to the text file where the passphrase for the virtual name
certificate's private key is stored.

CLUSTER_ECA_KEY_PASSPHRASEFILE is optional. You should define this option if the
virtual name certificate's private key is encrypted.

See “CLUSTER_ECA_PRIVATE_KEY_PATH for clustered master server”
on page 273.

Table 3-83 CLUSTER_ECA_KEY_PASSPHRASEFILE information

DescriptionUsage

On clustered master server.Where to use
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Table 3-83 CLUSTER_ECA_KEY_PASSPHRASEFILE information
(continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

CLUSTER_ECA_KEY_PASSPHRASE_FILE = Path to the
passphrase file

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

CLUSTER_ECA_PRIVATE_KEY_PATH for clustered master server
The CLUSTER_ECA_PRIVATE_KEY_PATH option is specific to clusteredmaster server.
It specifies the path to the private key for the external CA-signed certificate of the
virtual name.

If the virtual name certificate's private key is encrypted, you should define the
CLUSTER_ECA_KEY_PASSPHRASEFILE option.

See “CLUSTER_ECA_KEY_PASSPHRASEFILE for clustered master server”
on page 272.

Table 3-84 CLUSTER_ECA_PRIVATE_KEY_PATH information

DescriptionUsage

On clustered master server.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

CLUSTER_ECA_PRIVATE_KEY_PATH = Path to the
private key of the external certificate

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property
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CLUSTER_ECA_TRUST_STORE_PATH for clusteredmaster server
The CLUSTER_ECA_TRUST_STORE_PATH option is specific to clusteredmaster server.
It specifies the path to the certificate bundle file that contains all trusted root CA
certificates in PEM format.

Table 3-85 CLUSTER_ECA_TRUST_STORE_PATH information

DescriptionUsage

On clustered master server.Where to use

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

CLUSTER_ECA_TRUST_STORE_PATH = Path to the
external CA certificate

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration Console
property

CONNECT_OPTIONS option for NetBackup servers and clients
The CONNECT_OPTIONS apply to connections to the local host only, as follows (they
do not apply to connections to remote hosts):

■ Whether processes on host are reached:

■ By using the Veritas Exchange (PBX) or Veritas Network daemon (vnetd)
port only.

■ By using the daemon ports only.

■ By first using the PBX, then the vnetd port, and then the daemon ports if
needed.

■ Whether subsequent call-back connections with host use the traditional call-back
method, use vnetd, or use a PBX/vnetd forwarding connection.

■ Whether connections to host use reserved or a non-reserved source port number.
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Table 3-86 CONNECT_OPTIONS information

DescriptionUsage

On NetBackup master servers, media servers, or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CONNECT_OPTIONS = host [ 0 | 1 | 2 ]
[ 0 | 1 | 2 ][ 0 | 1 | 2 | 3]

The following variables are defined:

Host is a host name local to this host. You may have multiple CONNECT_OPTIONS
entries in the configuration, and localhost overrides other local host names. If a
local host name is not specified in any CONNECT_OPTIONS entries, the values from
the DEFAULT_CONNECT_OPTIONS option are used.

See “DEFAULT_CONNECT_OPTIONS option for NetBackup servers and clients”
on page 277.

How to use

The first setting indicates the type of port to use as the source port for connections to
service daemons on host:

0 = Connections on this computer should be from a reserved source port number. It
is selected from the CLIENT_RESERVED_PORT_WINDOW range.

1 = Connections on this computer should be from a non-reserved source port number
that is selected from the CLIENT_PORT_WINDOW range. (The default is 1.) If this option
is selected for use with the daemon port and host is running a version of NetBackup
older than 7.1, enable Allow non reserved ports for the selected host.

In the NetBackup Administration Console, see the Universal Settings dialog box
under Host Properties > Media Servers.

2 = Use the method that the DEFAULT_CONNECT_OPTIONS configuration option
defines.

See “Universal Settings properties” on page 241.
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Table 3-86 CONNECT_OPTIONS information (continued)

DescriptionUsage

The second setting indicates the call-back method to use with host. (This applies if
configured to use the daemon port or if bpcd cannot be reached using ports 1556 or
13724.)

0 = Use the traditional call-back method. Host connects back to a random port number
that this computer has selected from the SERVER_RESERVED_PORT_WINDOW range,
or SERVER_PORT_WINDOW range as determined by the first setting.

1 = Use the vnetd no call-back method. Connect to vnetd instead of a random port.
If this computer is NetBackup 7.0.1 or later, attempt to connect to port 1556 before
attempting to connect to vnetd. The connection is outbound to host if the third setting
is 0 or 1. The connection is inbound from host if the third setting is 2.

2 =Use themethod that the DEFAULT_CONNECT_OPTIONS configuration option defines
(default).

The third setting affects which destination port number to use for connections to daemon
services on host.

0 = Use vnetd if possible, to connect to a daemon on this computer. If it is not possible,
connect by using the traditional port number of the daemon. If this host is NetBackup
7.0.1 or later, attempt to connect to port 1556 before attempting to connect to vnetd.
If bpcd is reachable through port 1556 or vnetd, then the first two settings are ignored
and all connections to host are outbound and use non-reserved ports.

1 = Use vnetd to connect to a daemon on host. If this computer is NetBackup 7.0.1
or later, attempt to connect to port 1556 before attempting to connect to vnetd. The
traditional port number of the daemon is not used if the connection cannot be established
using port 1556 or vnetd. If bpcd is reachable through port 1556 or vnetd, then the
first two settings are ignored and all connections to host are outbound and use
non-reserved ports.

2 = Use only the traditional port number of the daemon to connect to a daemon on
host. If the daemon is bpcd, the second setting is then used to determine the call-back
method.

3 =Use themethod that the DEFAULT_CONNECT_OPTIONS configuration option defines
(default).
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Table 3-86 CONNECT_OPTIONS information (continued)

DescriptionUsage

The configuration file can contain CONNECT_OPTIONS settings for local host names.

CONNECT_OPTIONS = localhost 0 0 0

In this example, local connections to daemons on local host shark attempt to use port
1556. If the previous attempt was unsuccessful, then the connections try vnetd. If that
attempt is unsuccessful, the daemon port is used. If the connections are successful
using 1556 or vnetd, then the first two settings are ignored.

$ bptestbpcd -host shark
0 0 1
10.82.105.11:40402 -> 10.82.105.11:1556
10.82.105.11:40404 -> 10.82.105.11:1556

Example 1

CONNECT_OPTIONS = host 0 1 2

In this example:

■ Connections to daemons on the local host must use the daemon port numbers.
■ Call-back connections are to vnetd on this computer.
■ The source ports for the daemon connection is bound from the reserved port number

range.

Example 2

CONNECT_OPTIONS = host 1 1 2

In this example:

■ Connections to daemons on the local host must use the daemon port numbers.
■ Call-back connections are to vnetd on this computer.
■ The source ports for the daemon connection is bound from the non-reserved port

number range.

Example 3

NetBackup Management > Host Properties > Master Servers > Click Master
Servers, Media Servers, Clients > Double-click on server > Firewall.

See “Firewall properties” on page 128.

Equivalent Administration
Console property

DEFAULT_CONNECT_OPTIONS option for NetBackup servers and
clients

The DEFAULT_CONNECT_OPTIONS option specifies the default values for the
CONNECT_OPTIONS configuration option. If a host name is not specified in any
CONNECT_OPTIONS option, the value from the DEFAULT_CONNECT_OPTIONS option is
used.
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Note: The DEFAULT_CONNECT_OPTIONS apply to connections to the local host only;
they do not apply to connections to remote hosts.

See “CONNECT_OPTIONS option for NetBackup servers and clients” on page 274.

Table 3-87 DEFAULT_CONNECT_OPTIONS information

DescriptionUsage

On NetBackup master servers, media servers, or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DEFAULT_CONNECT_OPTIONS = [ 0 | 1 ][ 0 | 1 ][ 0 | 1 | 2 ]

The default value is 0 1 0.

This option should appear only once in the configuration file.

How to use

The first setting indicates the type of port to use as the source port when connecting
to the bpcd daemon port on the local host. It also indicates the type of server port if
using the traditional call-back method.

0 = Connections on this computer should use a reserved port number. They are selected
from the CLIENT_RESERVED_PORT_WINDOW range for source ports and from the
SERVER_RESERVED_PORT_WINDOW range if using the traditional call-back method.

1 = Connections on this computer should use a non-reserved port number. Connections
are selected from the CLIENT_PORT_WINDOW range for source ports and from the
SERVER_PORT_WINDOW range if using the traditional call-back method.

The second setting indicates the call-back method to use. (This setting applies if
configured to use the daemon port or if bpcd cannot be reached using ports 1556 or
13724.)

0 = Use the traditional call-back method. The destination host connects back to a
random port number that this computer has selected from the
SERVER_RESERVED_PORT_WINDOW range, or the SERVER_PORT_WINDOW range as
determined by the first setting.

1 = Use the vnetd no call-back method. Connect to vnetd instead of a random port.
Attempt to connect to port 1556 before attempting to connect to vnetd. The connection
is outbound to the destination host if the third setting is 0 or 1. The connection is inbound
if the third setting is 2.

278Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Table 3-87 DEFAULT_CONNECT_OPTIONS information (continued)

DescriptionUsage

The third setting affects which destination port number to use when attempting
connections to daemon services on the destination host.

0 = Use PBX or vnetd to connect to a daemon on the destination host if possible,
otherwise connect by using the traditional port number of the daemon. Attempt to
connect to port 1556 before attempting to connect to vnetd. If bpcd is reachable
through port 1556 or vnetd, then the first two settings are ignored and all connections
are outbound and use non-reserved ports.

1 = Connect to a daemon on the destination host by using PBX or vnetd. Attempt to
connect to port 1556 before attempting to connect to vnetd. The traditional port number
of the daemon will not be used if the connection cannot be established using port 1556
or vnetd. If bpcd is reachable through port 1556 or vnetd, then the first two settings
are ignored and all connections are outbound and use non-reserved ports.

2 = Connect to a daemon on the destination host by using the traditional port number
of the daemon only. The first setting is used to determine the port range and the second
setting is used to determine the call-back method.

NetBackupManagement > Host Properties >ClickMaster Servers,Media Servers,
Clients > Double-click on server > Firewall.

See “Firewall properties” on page 128.

Equivalent Administration
Console property

DISABLE_CERT_AUTO_RENEWoption for NetBackup servers and
clients

This option disables the automatic renewal of host ID-based certificates.

For more information about the automatic renewal of host ID-based certificates,
see the NetBackup Security and Encryption Guide.

http://www.veritas.com/docs/DOC5332

Table 3-88 DISABLE_CERT_AUTO_RENEW information

DescriptionUsage

On NetBackup master servers and clients.Where to use
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Table 3-88 DISABLE_CERT_AUTO_RENEW information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DISABLE_CERT_AUTO_RENEW = 1

This option should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

DISABLE_JOB_LOGGING option for NetBackup servers
This option disables the logging of the job information that the NetBackup Activity
Monitor requires.

Table 3-89 DISABLE_JOB_LOGGING information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DISABLE_JOB_LOGGING

The default is that this option is not present in the configuration file and that job logging
occurs.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Media > Enable job logging.

See “Media properties” on page 163.

Equivalent Administration
Console property
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DISABLE_STANDALONE_DRIVE_EXTENSIONS option for
NetBackup servers

This option disables the nonrobotic drive operations. During a backup, NetBackup
automatically attempts to use standalone volumes in nonrobotic drives.

Table 3-90 DISABLE_STANDALONE_DRIVE_EXTENSIONS information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbemmcmd command to change the option. For example:

nbemmcmd -changesetting -DISABLE_STANDALONE_DRIVE_EXTENSIONS no

For information about these commands, see the NetBackup Commands Reference
Guide.

This option should appear only once in the configuration file.

How to use

The following command enables nonrobotic drive operations.

nbemmcmd -changesetting -DISABLE_STANDALONE_DRIVE_EXTENSIONS no

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Media > Enable standalone drive extension. The default is that this option
is enabled.

See “Media properties” on page 163.

Equivalent Administration
Console property

DISALLOW_BACKUPS_SPANNING_MEDIA option for NetBackup
servers

This option prevents backups from spanning media.

Table 3-91 DISALLOW_BACKUPS_SPANNING_MEDIA information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-91 DISALLOW_BACKUPS_SPANNING_MEDIA information
(continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DISALLOW_BACKUPS_SPANNING_MEDIA

The default is that the entry is not present in the configuration file and backups are
allowed to span media.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Media > Allow backups to span tape media.

See “Media properties” on page 163.

Equivalent Administration
Console property

DISALLOW_CLIENT_LIST_RESTOREoption for NetBackup servers
This option denies the list and restore requests for all clients. When this option is
present, clients cannot list or restore any files that they have backed up through
this master server.

Table 3-92 DISALLOW_CLIENT_LIST_RESTORE information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DISALLOW_CLIENT_LIST_RESTORE

The default is that the entry is not present in the configuration file and clients can list
and restore their files.

Note: Override the DISALLOW_CLIENT_LIST_RESTORE option for individual clients
by changing their list_restore setting.

How to use
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Table 3-92 DISALLOW_CLIENT_LIST_RESTORE information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Client Attributes > Allow Client Restore.

See “Client Attributes properties” on page 69.

Equivalent Administration
Console property

DISALLOW_CLIENT_RESTORE option for NetBackup servers
This option denies the restore requests for all clients. When this option is present,
clients cannot restore the files that they have backed up through this master server.

Table 3-93 DISALLOW_CLIENT_RESTORE information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DISALLOW_CLIENT_RESTORE

The default is that the entry is not present in the configuration file and clients can restore
their files.

Note: To override the DISALLOW_CLIENT_RESTORE option for individual clients,
change their list_restore setting.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Client Attributes > Allow Client Browse.

See “Client Attributes properties” on page 69.

Equivalent Administration
Console property

DISALLOW_SERVER_FILE_WRITES option for NetBackup servers
and clients

The DISALLOW_SERVER_FILE_WRITES entry prevents the NetBackup server from
creating files on the NetBackup server or client. This entry prevents NetBackup
servers from remotely performing restores or remotely changing client configurations.

For further information on the commands that are described in the following tables,
see the NetBackup Commands Reference Guide.
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Table 3-94 DISALLOW_SERVER_FILE_WRITES information (in the
NetBackup Administration Console or command line)

Default behaviorNotes when used
remotely

Notes when used
on local host

How to useWhere to use

The server writes are
allowed.

Allow server file
writes cannot be set
from the NetBackup
Administration
Console. On themedia
server or client, use the
DISALLOW_SERVER_
FILE_WRITES entry.
See Table 3-96.

Allow server file
writes can be set on an
all-in-one host that
contains the master
server, media server,
and client.

If the media server and
client are not on the
master server, you
must use the
DISALLOW_
SERVER_FILE_WRITES
entry on the media
server or client.

NetBackup
Management > Host
Properties >
Double-click on master
server, media server, or
client > Universal
Settings > Allow
server file writes

NetBackup
Administration
Console

The server-directed
restores are allowed.

Allow server-directed
restores cannot be
used remotely. On the
media server or client,
use the DISALLOW_
SERVER_FILE_WRITES
entry. See Table 3-96.

Allow server-directed
restores can be used
only from a Windows
computer.

File > NetBackup
Client Properties >
Allow server-directed
restores

NetBackup
Backup,
Archive, and
Restore
Windows client
interface

DISALLOW_SERVER_
FILE_WRITES = No

bpsetconfig and
bpgetconfig can be
run only from the
master server or media
server.

Note:
DISALLOW_SERVER_
FILE_WRITES = No
using bpsetconfig or
nbsetconfig cannot
be set remotely (can
only be set locally).

DISALLOW_SERVER_
FILE_WRITES can be
enabled and disabled.

For command
examples, see
Table 3-95 and
Table 3-96.

bpsetconfig
or
bpgetconfig
(use only on
master server or
media server)

nbsetconfig
or
nbgetconfig
(use on master
server, media
server, or client)
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Table 3-95 bpsetconfig and nbsetconfig examples for local host

Command examples for local hostCommand

From the local master server or media server

On Windows:

install_path\NetBackup\bin\admincmd>bpsetconfig

bpsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

bpsetconfig> <ctl-Z>

On UNIX:

/usr/openv/netbackup/bin/admincmd/bpsetconfig

bpsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

bpsetconfig> <ctl-D>

bpsetconfig

From the local master server, media server, or client

On Windows:

install_path\NetBackup\bin>nbsetconfig

nbsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

nbsetconfig> <ctl-Z>

On UNIX:

/usr/openv/netbackup/bin/nbsetconfig

nbsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

nbsetconfig> <ctl-D>

nbsetconfig
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Table 3-96 bpsetconfig and nbsetconfig examples for remote host

Command examples for remote hostCommand

From the remote master server or media server

On Windows:

install_path\NetBackup\bin\admincmd>bpsetconfig -h host

bpsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

bpsetconfig> <ctl-Z>

On UNIX:

/usr/openv/netbackup/bin/admincmd/bpsetconfig -h host

bpsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

bpsetconfig> <ctl-D>

bpsetconfig

From the remote master server, media server, or client

On Windows:

install_path\NetBackup\bin>nbsetconfig -h host

nbsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

nbsetconfig> <ctl-Z>

On UNIX:

/usr/openv/netbackup/bin/nbsetconfig -h host

nbsetconfig> DISALLOW_SERVER_FILE_WRITES = Yes

nbsetconfig> <ctl-D>

nbsetconfig

EAT_VERBOSE option for NetBackup servers and clients
Used for debugging purposes, the EAT_VERBOSE option controls the amount of
information NetBackup includes in the authentication service (AT) client logs that
pertain to NetBackup processes.

Table 3-97 EAT_VERBOSE information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-97 EAT_VERBOSE information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

EAT_VERBOSE = [ 0 | 1 | 2 | 3 | 4 ]

The default is that the entry is not present in the configuration file.

The AT logs are generated for the NetBackup processes based on the default logging
level, which reports only errors.

Following are some of the NetBackup processes that use the AT service:

■ bpnbat

■ bpnbaz

■ nbcertcmd

■ nbsl

If the EAT_VERBOSE entry is present in the configuration file, the verbosity of AT logs
for the NetBackup processes is based on the EAT_VERBOSE option. The AT logs are
stored in the respective process log files.

To disable AT logging for NetBackup processes, set the EAT_VERBOSE option to -2 in
the configuration file.

Use the following format:

EAT_VERBOSE = -2

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

ECA_CERT_PATH for NetBackup servers and clients
The ECA_CERT_PATH option specifies the path to the external CA-signed certificate
of the host. This option is mandatory.

It supports certificates in PEM and P7B format that can either be DER or PEM
encoded - PEM-formatted certificates in the same file or a P7B file that can either
be DER or PEM encoded.

If you have an intermediate certificate (from a certificate chain), sequence of the
certificates in the path should be as follows: leaf certificate > intermediate certificate

NetBackup supports the following certificate sources:

287Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


■ Windows certificate store

Note: The Windows certificate store is not supported for clustered master
servers.

■ File-based certificates

Table 3-98 ECA_CERT_PATH information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

For file-based certificates, use the following format:

ECA_CERT_PATH = Path to the external certificate
of the host

For example: c:\server.pem

For Windows certificate store, use the following format:

ECA_CERT_PATH = Certificate store name\Issuer
name\Subject name

You can specify multiple certificate selection queries in a
comma-separated format.

ECA_CERT_PATH = Store name1\Issuer name1\Subject
name1,Store name2\Issuer name2\Subject name2

See “SpecifyingWindows certificate store for ECA_CERT_PATH”
on page 288.

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration Console
property

SpecifyingWindows certificate store for ECA_CERT_PATH
NetBackup selects a certificate from any of the local machine certificate stores on
a Windows host.

In case of Windows certificate store, ECA_CERT_PATH is a list of comma-separated
clauses.

288Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Each clause is of the form Store name\Issuer\Subject. Each clause element contains
a query. $hostname is a keyword that is replaced with the fully qualified domain
name of the host. Use double quotes when a \ is present in the actual path. For
example, MY\Veritas\"NetBackup\$hostname".

The 'Store name' should be the exact name of the store where the certificate resides.
For example: 'MY'

The 'Issuer' is optional. If this is provided, NetBackup picks the certificates for which
the Issuer DN contains the provided substring.

The 'Subject' is mandatory. NetBackup picks the certificate for which the Subject
DN contains the provided substring.

You must ensure to:

■ Add the root certificate to Trusted Root Certification Authorities or Third-Party
Root Certification Authorities in the Windows certificate store.

■ If you have any intermediate CAs, add their certificates to the Intermediate
Certification Authorities in the Windows certificate store.

Example - Certificate locations with WHERE CLAUSE:
■ My\Veritas\$hostname, My\ExampleCompany\$hostname

Where (certificate store is MY, Issuer DN contains Veritas, Subject DN contains
$hostname) OR (certificate store name is MY, Issuer DN contains
ExampleCompany, Subject DN contains $hostname)

■ MY\Veritas\"NetBackup\$hostname"
Where certificate store name is MY, Issuer DN contains Veritas, Subject DN
contains NetBackup\$hostname

■ MY\\$hostname
Where certificate store name is MY, any Issuer DN, Subject DN contains
$hostname

■ MY\Veritas\NetBackup $hostname
Where certificate store name is MY, Issuer DN contains Veritas, Subject DN
contains NetBackup $hostname

If you provide a space between words, it is considered as a valid character.

Example - Certificate locations with invalid data:
■ MY\\

The Subject DN should have some value.

■ My\$hostname
The Subject DN should have some value.
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■ \\$hostname
The certificate store name should have exact value of the store in which the
certificate resides.

■ MY\CN=Veritas\CN=$hostname
The Subject DN and issuer DN cannot contain =, and also specific tags like
CN=.

ECA_CRL_CHECK for NetBackup servers and clients
The ECA_CRL_CHECK option lets you specify the revocation check level for external
certificates of the host. It also lets you disable the revocation check for the external
certificates. Based on the check, revocation status of the certificate is validated
against the Certificate Revocation List (CRL) during host communication.

You can choose to use the CRLs from the directory that is specified for the
ECA_CRL_PATH configuration option in the configuration file (bp.conf on UNIX or
Windows registry) or the CRL Distribution Point (CDP).

See “ECA_CRL_PATH for NetBackup servers and clients” on page 291.

Table 3-99 ECA_CRL_CHECK information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_CRL_CHECK = CRL check

You can specify one of the following:

■ DISABLE (or 0) - Revocation check is disabled. Revocation
status of the certificate is not validated against the CRL during
host communication.

■ LEAF (or 1) - Revocation status of the leaf certificate is
validated against the CRL. This is the default value.

■ CHAIN (or 2) - Revocation status of all certificates from the
certificate chain are validated against the CRL.

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

290Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


ECA_CRL_PATH for NetBackup servers and clients
The ECA_CRL_PATH option specifies the path to the directory where the Certificate
Revocation Lists (CRL) of the external certificate authority (CA) are located.

These CRLs are copied to NetBackup CRL cache. Revocation status of the external
certificate is validated against the CRLs from the CRL cache.

CRLs in the CRL cache are periodically updated with the CRLs in the directory that
is specified for ECA_CRL_PATH based on the ECA_CRL_PATH_SYNC_HOURS option.

See “ECA_CRL_PATH_SYNC_HOURS for NetBackup servers and clients”
on page 292.

If the ECA_CRL_CHECK option is not set to DISABLE (or 0) and the ECA_CRL_PATH

option is not specified, NetBackup downloads the CRLs from the URLs that are
specified in the CRL distribution point (CDP) and uses them to verify revocation
status of the peer host's certificate.

See “ECA_CRL_CHECK for NetBackup servers and clients” on page 290.

Note: For validating the revocation status of a virtualization server certificate, the
VIRTUALIZATION_CRL_CHECK option is used.

See “VIRTUALIZATION_CRL_CHECK for NetBackup servers and clients”
on page 359.

Table 3-100 ECA_CRL_PATH information

DescriptionUsage

On NetBackup servers or clients.

If certificate validation is required for VMware or RHV servers,
this option must be set on the NetBackup master server and
respective access hosts, irrespective of the certificate authority
that NetBackup uses for host communication (NetBackup CA
or external CA).

Where to use

Use the nbgetconfig and the nbsetconfig commands
to view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format to specify a path to the CRL directory:

ECA_CRL_PATH = Path to the CRL directory

How to use
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Table 3-100 ECA_CRL_PATH information (continued)

DescriptionUsage

No equivalent exists in the NetBackup Administration
Console host properties.

Equivalent Administration
Console property

ECA_CRL_PATH_SYNC_HOURS for NetBackup servers and clients
The ECA_CRL_PATH_SYNC_HOURS option specifies the time interval in hours to update
the Certificate revocation lists (CRL) in the NetBackup CRL cache with the CRLs
in the directory specified for the ECA_CRL_PATH configuration option.

See “ECA_CRL_PATH for NetBackup servers and clients” on page 291.

The ECA_CRL_PATH_SYNC_HOURS option is not applicable if CDP is used for CRLs.

By default, CRLs in the cache are updated every one hour.

During host communication, revocation status of the external certificate is validated
against the CRLs from the CRL cache.

Table 3-101 ECA_CRL_PATH_SYNC_HOURS information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_CRL_PATH_SYNC_HOURS = Number of hours

Minimum number of hours that you can specify - 1 hour

Maximum number of hours that you can specify - 720 hour

The default value is one hour.

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property
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ECA_CRL_REFRESH_HOURS for NetBackup servers and clients
The ECA_CRL_REFRESH_HOURS option specifies the time interval in hours to download
the CRLs from the URLs that are specified in the peer host certificate's CRL
distribution points (CDP).

The ECA_CRL_REFRESH_HOURS option is applicable when you use CDP for CRLs.

See “ECA_CRL_PATH for NetBackup servers and clients” on page 291.

After the specified time interval, CRLs of the certificate authority are downloaded
from the URLs that are available in CDP.

By default, the CRLs are downloaded from the CDP after every 24 hours.

Table 3-102 ECA_CRL_REFRESH_HOURS information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_CRL_REFRESH_HOURS = Number of hours

Minimum number of hours that you can specify - 0 hour, which
indicates that CRLs from the CDP are not periodically
downloaded.

Maximum number of hours that you can specify - 4380 hours

The default value for the option is 24 hours.

Note: CRLs are also downloaded from the CDP during host
communication if they are expired or not available in the CRL
cache, irrespective of the time interval set for the
ECA_CRL_REFRESH_HOURS option.

How to use

No equivalent exists in theNetBackupAdministration Console
host properties.

Equivalent Administration
Console property

ECA_DISABLE_AUTO_ENROLLMENT for NetBackup servers and
clients

The ECA_DISABLE_AUTO_ENROLLMENT option lets you disable the automatic enrollment
of an external certificate for a host with the given master server. The certificate is
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automatically enrolled with a master server when a proxy communication takes
place with respect to the host for the first time.

You may want to disable the automatic certificate enrollment process and enroll
the certificates as and when required.

By default automatic enrollment is enabled.

Table 3-103 ECA_DISABLE_AUTO_ENROLLMENT information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_DISABLE_AUTO_ENROLLMENT = 1

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration Console
property

ECA_DR_BKUP_WIN_CERT_STORE for NetBackup servers and
clients

The ECA_DR_BKUP_WIN_CERT_STORE option specifies whether you want to take a
backup of the Windows certificate store information during catalog backup or not.

By default, Windows certificate store information is backed up during catalog backup.

Note: If the Windows certificate store information is not exportable, it cannot be
backed up during catalog backup.

Table 3-104 ECA_DR_BKUP_WIN_CERT_STORE information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-104 ECA_DR_BKUP_WIN_CERT_STORE information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

If you do not want the catalog backup operation to take a backup
of the Windows certificate store information, use the following
format:

ECA_DR_BKUP_WIN_CERT_STORE = NO

How to use

No equivalent exists in theNetBackupAdministration Console
host properties.

Equivalent Administration
Console property

ECA_KEY_PASSPHRASEFILE for NetBackup servers and clients
The ECA_KEY_PASSPHRASEFILE option specifies the path to the text file where the
passphrase for the external certificate's private key is stored.

You should specify the ECA_KEY_PASSPHRASEFILE option only if the certificate's
private key is encrypted.

See “ECA_PRIVATE_KEY_PATH for NetBackup servers and clients” on page 296.

Note: You should not specify the ECA_KEY_PASSPHRASEFILE option if you use
Windows certificate store.

See “ECA_CERT_PATH for NetBackup servers and clients” on page 287.

Table 3-105 ECA_KEY_PASSPHRASEFILE information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_KEY_PASSPHRASEFILE = Path to the passphrase
file

How to use

295Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Table 3-105 ECA_KEY_PASSPHRASEFILE information (continued)

DescriptionUsage

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

ECA_PRIVATE_KEY_PATH for NetBackup servers and clients
The ECA_PRIVATE_KEY_PATH option specifies the file path to the private key for the
external CA-signed certificate of the host. The private key file should be in PEM
format.

This option is mandatory for file-based certificates.

If the private key of the certificate is encrypted, you should specify the
ECA_KEY_PASSPHRASEFILE option.

See “ECA_KEY_PASSPHRASEFILE for NetBackup servers and clients” on page 295.

For encrypted private keys, NetBackup supports the following formats:

■ DES, 3DES, and AES if the private key is in the PKCS #1 format (if encrypted,
can be in PEM format)

■ DES, 3DES, AES, RC2, and RC4 if the private key is in the PKCS #8 format (if
encrypted, can be in PEM or DER format)

Note: You should not specify the ECA_PRIVATE_KEY_PATH option if Windows
certificate store is specified for the ECA_CERT_PATH option.

See “ECA_CERT_PATH for NetBackup servers and clients” on page 287.

Table 3-106 ECA_PRIVATE_KEY_PATH information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-106 ECA_PRIVATE_KEY_PATH information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_PRIVATE_KEY_PATH = Path to the private key
of the external certificate

For example: c:\key.pem

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration Console
property

ECA_TRUST_STORE_PATH for NetBackup servers and clients
The ECA_TRUST_STORE_PATH option specifies the file path to the certificate bundle
file that contains all trusted root CA certificates.

This certificate file should have one or more certificates in PEM format.

The trust store supports certificates in the following formats:

■ PEM

■ P7B that can either be DER or PEM encoded

Note: Do not specify the ECA_TRUST_STORE_PATH option if you use the Windows
certificate store.

This option is mandatory for file-based certificates.

Table 3-107 ECA_TRUST_STORE_PATH information

DescriptionUsage

On NetBackup servers or clients.

If certificate validation is required for VMware or RHV servers,
this option must be set on the NetBackup master server and
respective access hosts, irrespective of the certificate authority
that NetBackup uses for host communication (NetBackup CA or
external CA).

Where to use
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Table 3-107 ECA_TRUST_STORE_PATH information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ECA_TRUST_STORE_PATH = Path to the external CA
certificate

For example: c:\rootCA.pem

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

ENABLE_CRITICAL_PROCESS_LOGGING for NetBackup servers
and clients

The ENABLE_CRITICAL_PROCESS_LOGGING option lets you automatically log critical
NetBackup processes. Log directories for the critical processes are created and
logging begins when this option is enabled in the Logging host properties.

Table 3-108 ENABLE_CRITICAL_PROCESS_LOGGING information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-108 ENABLE_CRITICAL_PROCESS_LOGGING information
(continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view
the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Initially, the bp.conf file does not contain
ENABLE_CRITICAL_PROCESS_LOGGING entry.

After logging for critical processes is enabled, a corresponding
entry is added in the bp.conf file as follows:

ENABLE_CRITICAL_PROCESS_LOGGING = YES

Note: You should not modify the
ENABLE_CRITICAL_PROCESS_LOGGING parameter. To disable
the logging for critical processes, you need to modify their logging
levels.

See “Disabling the logging of NetBackup processes” on page 155.

How to use

NetBackup Management > Host Properties > Click Master
Servers, Media Servers, Clients > Double-click on server >
Logging > Logging for critical processes.

See “Logging properties” on page 148.

Equivalent
Administration Console
property

ENABLE_DIRECT_CONNECTION for servers
With NAT clients in place, NetBackup master servers and media servers are
configured only to accept communication requests from clients. Servers cannot
communicate directly with clients. However, servers need to communicate directly
with clients in the following scenarios:

■ When the NetBackup domain consists of clients that are not behind any firewall
or are not using any gateway

■ When the NetBackup domain consists of clients with earlier versions

The ENABLE_DIRECT_CONNECTION option lets you establish a direct connection
between servers and such clients.

By default the direct connection between servers and clients is disabled.
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Table 3-109 ENABLE_DIRECT_CONNECTION information

DescriptionUsage

On NetBackup servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

To enable a direct connection between servers and clients, use the
following format:

ENABLE_DIRECT_CONNECTION = TRUE

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration
Console

ENABLE_MQBROKER for servers
The ENABLE_MQBROKER option is automatically set to TRUE when you configure the
NetBackup Messaging Broker or nbmqbroker service on the master server using
the configureMQ command.

If you want to stop the communication between the master server and NAT clients,
you can manually disable the ENABLE_MQBROKER option.

After you change the option value, restart the master server services.

Table 3-110 ENABLE_MQBROKER information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

To stop the communication between the master server and NAT
clients, use the following format:

ENABLE_MQBROKER = FALSE

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console
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FAILOVER_RESTORE_MEDIA_SERVERS option for NetBackup
servers

This option specifies that an automatic failover media server be used if a server is
temporarily inaccessible for a restore. This failover does not require administrator
intervention.

Table 3-111 FAILOVER_RESTORE_MEDIA_SERVERS information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

FAILOVER_RESTORE_MEDIA_SERVERS = failed_host host1 host2 ...
hostN

■ failed_host is the server that is not operational.
■ host1 ... hostN are the servers that provide failover capabilities.

The default is that NetBackup does not perform automatic failover.

When automatic failover is necessary for a server, NetBackup searches from left to
right through the associated FAILOVER_RESTORE_MEDIA_SERVERS list. It stops when
it finds one that is eligible to perform the restore.

Note: The configuration file can contain multiple
FAILOVER_RESTORE_MEDIA_SERVERS entries and each entry can list multiple servers.
However, a NetBackup server can be a failed_host in only one option.

After a FAILOVER_RESTORE_MEDIA_SERVERS option is added, stop and restart the
NetBackup Request daemon on the master server where you plan to change the
configuration.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Restore Failover.

See “Restore Failover properties” on page 200.

Equivalent Administration
Console property

FORCE_RESTORE_MEDIA_SERVERoption for NetBackup servers
This option forces the restore to go to a specific server, regardless of where the
files were backed up.
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Table 3-112 FORCE_RESTORE_MEDIA_SERVER information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

FORCE_RESTORE_MEDIA_SERVER = from_host to_host

Where from_host is the server that performed the original backup and to_host is the
server to use for the restore.

Stop and restart the NetBackup Request daemon on the master server after adding
the FORCE_RESTORE_MEDIA_SERVER option. Physically move the media to to_host
before attempting a restore. Update the Media Manager volume database to reflect
the move.

This setting applies to all storage units on the original server. Restores for any storage
unit on from_host go to to_host. To revert to the original configuration for future restores,
delete the option.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > General Server > Media Host Override.

See “General Server properties” on page 132.

Equivalent Administration
Console property

GENERATE_ENGLISH_LOGS option for NetBackup servers and
clients

This option enables the generation of an English error log, and English trace logs
for the bparchive, bpbackup, bpduplicate, bpimport, and bprestore commands.
This option is useful to support personnel to assist in distributed environments
where different locales result in logs that contain various languages.

An English text error log (indicated by the suffix _en) is created in the following
directory:

■ On Windows: Install_path\NetBackup\db\error

■ On UNIX: /usr/openv/netbackup/db/error
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Table 3-113 GENERATE_ENGLISH_LOGS information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

GENERATE_ENGLISH_LOGS

This entry should appear only once in the configuration file.

Setting the GENERATE_ENGLISH_LOGS option also forces the -en argument on the
execution of the following commands when the progress log is specified (-L):
bparchive, bpbackup, bpduplicate, bpimport, and bprestore.

The suffix _en indicates the English text progress log.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

HOSTDB_RESYNC_INTERVAL option for NetBackup servers and
clients

The HOSTDB_RESYNC_INTERVAL option specifies the time interval to synchronize
data entry changes to the NetBackup host database.

Table 3-114 HOSTDB_RESYNC_INTERVAL information

DescriptionUsage

On NetBackup clients.Where to use

303Configuring Host Properties
Configuration options for NetBackup servers

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Table 3-114 HOSTDB_RESYNC_INTERVAL information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

HOSTDB_RESYNC_INTERVAL = days

The default value is 24 hours (1 day).

The maximum value for this option is 7 days. The minimum value for this option is zero,
which implies that the option is turned off and that no data synchronization happens.

This option should appear only once in the configuration file.

How to use

The following example sets the time interval of 3 days to allow data synchronization
to the host database:

HOSTDB_RESYNC_INTERVAL = 3

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

HYPERV_WMI_CREATE_DISK_TIMEOUT option for NetBackup
servers

This option specifies the timeout period for creating a virtual disk during restore of
a Hyper-V VM that was backed up with the WMI method.

Table 3-115 HYPERV_WMI_CREATE_DISK_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use

Change the HYPERV_WMI_CREATE_DISK_TIMEOUT by using the bpsetconfig
command or the nbsetconfig command.

For information about these commands, see the NetBackup Commands Reference
Guide.

The default is 24 hours. The range for this option is 0 hours to 240 hours. A value of
0 means the restore job never times out during virtual disk creation.

How to use
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Table 3-115 HYPERV_WMI_CREATE_DISK_TIMEOUT information
(continued)

DescriptionUsage

The following entry tells the NetBackup restore job to wait 48 hours for creation of the
Hyper-V virtual disk.

HYPERV_WMI_CREATE_DISK_TIMEOUT = 48

More information on this configuration option is available in theNetBackup for Hyper-V
Administrator's Guide.

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

INCOMPLETE_JOB_CLEAN_INTERVAL option for NetBackup
servers and clients

This option indicates the number of days a failed restore job can remain in the
incomplete state before it is moved to the done state.

Table 3-116 INCOMPLETE_JOB_CLEAN_INTERVAL information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

INCOMPLETE_JOB_CLEAN_INTERVAL = number_of_days

The default is 7 days.

Where x is a value between 0 and 365. A value of 0 indicates that failed, incomplete
jobs are never automatically moved to the done state.

This entry should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers or Clients >
Double-click on server > Clean-up > Move restore job from incomplete state to
done state.

See “Clean-up properties” on page 66.

Equivalent Administration
Console property
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INITIAL_BROWSE_SEARCH_LIMIT option for NetBackup servers
and clients

This option specifies the number of days back that NetBackup searches for files to
restore. It can improve performance when large numbers of backups are performed.

Table 3-117 INITIAL_BROWSE_SEARCH_LIMIT information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

INITIAL_BROWSE_SEARCH_LIMIT = number_of_days

The default is that NetBackup includes files from the time of the last full backup through
the latest backup for the client. If the client belongs to more than one policy the browse
starts with the earliest of the set of last full backups.

This entry should appear only once in the configuration file.

When this option is specified on a UNIX client, it applies only to that client. The option
can reduce the size of the Search window from what is specified on the server (the
client setting cannot make the window larger).

How to use

The following example limits the browse range to the seven days before the current
date.

INITIAL_BROWSE_SEARCH_LIMIT = 7

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Universal Settings > Browse timeframe for restores.

See “Universal Settings properties” on page 241.

Equivalent Administration
Console property

INITIATE_REVERSE_CONNECTION for servers
The INITIATE_REVERSE_CONNECTION option lets the master server or the
media server publish the messages to the message queue broker during
communication with NAT clients.
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Table 3-118 INITIATE_REVERSE_CONNECTION information

DescriptionUsage

On NetBackup servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide. Use the following format:

How to use

No equivalent exists in the NetBackup Administration
Console host properties.

Equivalent Administration
Console

IP_ADDRESS_FAMILY option for NetBackup servers
The IP_ADDRESS_FAMILY option indicates whether NetBackup on this host supports
only IPv4 or both IPv4 and IPv6.

If any of the SERVER entries do not support IPv4, NetBackup uses the setting that
indicates both IPv4 and IPv6.

Table 3-119 IP_ADDRESS_FAMILY information

DescriptionUsage

On NetBackup servers or clients.Where to use

On the hosts that use both IPv4 and IPv6, use this option to indicate which address
family to use.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

IP_ADDRESS_FAMILY = AF_INET | AF_UNSPEC

AF_INET indicates that the host supports only IPv4.

AF_UNSPEC indicates that the host supports both IPv4 and IPv6.

This entry should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Network Settings.

See “Network Settings properties” on page 173.

Equivalent Administration
Console property
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JOB_PRIORITY option for NetBackup servers and clients
Use this option to set the priority for a job type.

Table 3-120 JOB_PRIORITY information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

JOB_PRIORITY = P1 P2 P3 P4 P5 P6 P7 P8 P9 P10 P11
P12 P13 P14 P15 P16 P17 P18 P19 P20 P21 P22 P23 P24

Variables P1, P2, and so on indicate the priority for each backup type.

Table 3-121 shows the default priority values.

The actual default values for the option appear as follows:

JOB_PRIORITY = 0 0 90000 90000 90000 90000 85000 85000
80000 80000 80000 80000 75000 75000 70000 70000 50000
50000 0 0 0 0 0 0

This entry should appear only once in the configuration file.

How to use

To give backup jobs a priority of 50000 and duplication jobs a priority of 30000, change
the JOB_PRIORITY entry as follows:

JOB_PRIORITY = 50000 0 90000 90000 90000 90000 85000 85000
80000 80000 80000 80000 75000 75000 70000 70000 30000
50000 0 0 0 0 0 0

Example

NetBackup Management > Host Properties > Master Servers or Clients >
Double-click on server > Default Job Priorities > Job Priority.

See “Default Job Priorities properties” on page 100.

Equivalent Administration
Console property

Table 3-121 lists the order of the job types and the various job type defaults.

Table 3-121 Default job type priorities

DefaultRepresents this actionField

0Performing a backupP1
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Table 3-121 Default job type priorities (continued)

DefaultRepresents this actionField

0Performing a database backup (a catalog backup)P2

90000Performing a restoreP3

90000Recovering a catalogP4

90000Performing a staging operationP5

90000Performing the duplication jobs that Vault startsP6

85000Cleaning up imagesP7

85000Importing imagesP8

80000Requesting tapesP9

80000Cleaning a tapeP10

80000Tape formattingP11

80000Performing device diagnosticsP12

75000Verifying an imageP13

75000Running a media contents reportP14

70000Labeling tape mediaP15

70000Erasing mediaP16

50000Running a duplication jobP17

50000Performing an inventoryP18

0This field is not currently in useP19

0This field is not currently in useP20

0This field is not currently in useP21

0This field is not currently in useP22

0This field is not currently in useP23

0This field is not currently in useP24
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KEEP_LOGS_SIZE_GB for NetBackup servers and clients
The KEEP_LOGS_SIZE_GB option specifies the size of the NetBackup logs that you
want to retain. When the NetBackup log size grows up to this configuration value,
the older logs are deleted.

Table 3-122 KEEP_LOGS_SIZE_GB information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Initially, the bp.conf file does not contain KEEP_LOGS_SIZE_GB
entry.

Enable the Keep logs up to GB option in the Logging dialog box
on the NetBackup Administration Console to set the log retention
in GB. A corresponding entry is added in the bp.conf file as follows:

KEEP_LOGS_SIZE_GB = 25

If you disable the Keep logs up to GB option, the bp.conf file
shows the corresponding entry as follows:

KEEP_LOGS_SIZE_GB = 0

To set it to a different value, update the bp.conf file using the
nbsetconfig command.

Use the following format to set KEEP_LOGS_SIZE_GB to a new
value in the bp.conf file:

KEEP_LOGS_SIZE_GB = X

'X' indicates the log size in GB.

Note: For NetBackup servers, the recommended value for the
KEEP_LOGS_SIZE_GB option is 25 GB or greater.

For NetBackup clients, the recommended value for the
KEEP_LOGS_SIZE_GB option is 5 GB or greater.

This entry should appear only once in the bp.conf configuration
file.

How to use
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Table 3-122 KEEP_LOGS_SIZE_GB information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers or
Clients >Double-click on server > Logging > Keep logs up to GB.

See “Logging properties” on page 148.

Equivalent
Administration
Console property

LIMIT_BANDWIDTH option for NetBackup servers
This option specifies a limit for the network bandwidth that NetBackup clients use
on a network. The actual limiting occurs on the client side of the backup connection.
This option limits only backups. Restores are unaffected. The default is that the
bandwidth is not limited.

Note: LIMIT_BANDWIDTH applies only to IPv4 networks. Use the
THROTTLE_BANDWIDTH option to limit IPv6 networks.

See “THROTTLE_BANDWIDTH option for NetBackup servers” on page 346.

See “Throttle Bandwidth properties” on page 236.

MAX_LOGFILE_SIZE option for NetBackup servers and clients for
legacy logging

The MAX_LOGFILE_SIZE option specifies the maximum size that you want to set for
a log file. When the log file size in NetBackup matches the MAX_LOGFILE_SIZE

setting, the next logs are stored in a new log file.

See “About robust logging” on page 251.

Table 3-123 MAX_LOGFILE_SIZE information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-123 MAX_LOGFILE_SIZE information (continued)

DescriptionUsage

Use the nbgetconfig (or bpgetconfig) and the nbsetconfig (or bpsetconfig)
commands to view, add, or change the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format to set MAX_LOGFILE_SIZE to a new value in the bp.conf
file:

MAX_LOGFILE_SIZE = X

'X' indicates maximum size of a NetBackup log file in MB.

Note: MAX_LOGFILE_SIZE should be set to an integer number, which should be
greater than '0'. If you have set MAX_LOGFILE_SIZE to an invalid value such as 0 or
-100, it is automatically set to the default value (500 MB).

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

MAX_NUM_LOGFILES option for NetBackup servers and clients for
legacy logging

The MAX_NUM_LOGFILES option specifies the maximum number of log files that you
want to be retained in a NetBackup log directory. When the number of log files in
the directory matches the MAX_NUM_LOGFILES setting, the oldest log file is deleted.

See “About robust logging” on page 251.

Table 3-124 MAX_NUM_LOGFILES information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-124 MAX_NUM_LOGFILES information (continued)

DescriptionUsage

Use the nbgetconfig (or bpgetconfig) and the nbsetconfig (or bpsetconfig)
commands to view, add, or change the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format to set MAX_NUM_LOGFILES to a new value in the bp.conf
file:

MAX_NUM_LOGFILES = X

'X' indicates maximum number of NetBackup log files that are created in a log directory.

MAX_NUM_LOGFILES should be set to a number that should be greater than one (1).
If you have set MAX_NUM_LOGFILES to an invalid value such as 0 or 1, it is automatically
set to the default value, which is infinite. However, in the bp.conf file, the
MAX_NUM_LOGFILES entry appears as follows:

MAX_NUM_LOGFILES = 0

Zero (0) indicates an infinite value.

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

MEDIA_UNMOUNT_DELAY option for NetBackup servers
When MEDIA_UNMOUNT_DELAY is specified, the media unload is delayed for the
specified number of seconds after the requested operation has completed. (Applies
only to user operations.)

Table 3-125 MEDIA_UNMOUNT_DELAY information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-125 MEDIA_UNMOUNT_DELAY information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

MEDIA_UNMOUNT_DELAY = seconds

The default is a media mount delay time of 180 seconds.

This entry should appear only once in the configuration file.

How to use

The delay is set to 120 seconds in the following example:

MEDIA_UNMOUNT_DELAY = 120

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Media > Media unmount delay.

See “Media properties” on page 163.

Equivalent Administration
Console property

MEDIA_REQUEST_DELAY option for NetBackup servers
This option specifies the number of seconds that NetBackup waits for a non-robotic
drive to become ready.

Table 3-126 MEDIA_REQUEST_DELAY information

DescriptionUsage

On NetBackup master servers.Where to use

Change the MEDIA_REQUEST_DELAY by using the nbemmcmd command.

For information about these commands, see the NetBackup Commands Reference
Guide.

The default is that NetBackup does not wait for non-robotic drives to become ready.

This option should appear only once in the configuration file.

How to use

The following command indicates to NetBackup to wait 150 seconds for a non-robotic
drive to become ready for use.

nbemmcmd -changesetting -MEDIA_REQUEST_DELAY 150

Example
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Table 3-126 MEDIA_REQUEST_DELAY information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Media > Media request delay.

See “Media properties” on page 163.

Equivalent Administration
Console property

MEDIA_SERVER option for NetBackup servers
This option is similar to the SERVER option.

A host that is listed as a MEDIA_SERVER can back up and restore clients. However,
if the host is not specified as a SERVER, the host has limited administrative
capabilities.

Table 3-127 MEDIA_SERVER information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

MEDIA_SERVER = media_server_name

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Servers > Media Servers.

See “Servers properties” on page 214.

Equivalent Administration
Console property

MPX_RESTORE_DELAY option for NetBackup servers
This option applies to multiplexed restores. The MPX_RESTORE_DELAY specifies how
long the server waits for restore requests of files and raw partitions. In this case,
the option applies to the files and raw partitions in a set of multiplexed images on
the same tape. All of the restore requests that are received within the delay period
are included in the same restore operation (one pass of the tape).
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Table 3-128 MPX_RESTORE_DELAY information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

http://www.veritas.com/docs/DOC5332

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

MPX_RESTORE_DELAY = seconds

The default is 30 seconds.

This option should appear only once in the configuration file.

How to use

The following example configures a server to wait 15 minutes.

MPX_RESTORE_DELAY = 900

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > General Server > Delay on multiplexed restores.

See “General Server properties” on page 132.

Equivalent Administration
Console property

MUST_USE_LOCAL_DRIVE option for NetBackup servers
This option instructs NetBackup that if the client is also a media server and this
option is present, backups for this client must occur on a local drive. If all drives are
down, another may be used. If the client is not a media server, this option has no
effect.

Table 3-129 MUST_USE_LOCAL_DRIVE information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbemmcmd command to change the option. For example:

nbemmcmd -changesetting -MUST_USE_LOCAL_DRIVE yes

For information about these commands, see the NetBackup Commands Reference
Guide.

This option should appear only once in the configuration file.

How to use
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Table 3-129 MUST_USE_LOCAL_DRIVE information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers > Double-click on
server > General Server > Must use local drive.

See “General Server properties” on page 132.

Equivalent Administration
Console property

NBRNTD_IDLE_TIMEOUT option for NetBackup servers
The NBRNTD_IDLE_TIMEOUT option specifies the number of seconds to wait before
the Remote Network Transport Service (nbrntd) shuts itself down. The Remote
Network Transport Service provides resilient network connections. After it is shut
down, NetBackup must restart the service if a new resilient connection for backups
or restores is required.

Table 3-130 NBRNTD_IDLE_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

NBRNTD_IDLE_TIMEOUT = seconds

The default timeout is 300 seconds (five minutes).

By default, this entry is not present in the configuration file.

How to use

In the following example, the Remote Network Transport Service shuts off after 15
minutes.

NBRNTD_IDLE_TIMEOUT = 900

Example

See “RESILIENT_NETWORK option for NetBackup master servers and clients”
on page 334.

OPS_CENTER_SERVER_NAME option for NetBackup servers
The OPS_CENTER_SERVER_NAME option
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Table 3-131 OPS_CENTER_SERVER_NAME information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format: OPS_CENTER_SERVER_NAME = OpsCenter_server_name

By default, this entry is not present in the configuration file.

Note: The OpsCenter server name should be configured against the
OPS_CENTER_SERVER_NAME configuration option. If the OpsCenter server name is
configured against the SERVER configuration option, the connection between themaster
server and the OpsCenter server may not be established.

How to use

NetBackupManagement > Host Properties >Master ServersDouble-click onmaster
server Servers > OpsCenter Server.

Equivalent Administration
Console property

PREFERRED_NETWORK option for NetBackup servers
The PREFERRED_NETWORK option is not needed in an environment if NetBackup is
configured with appropriate host names. The operating system must resolve to the
correct IP addresses and then route the addresses correctly.

When external constraints prevent the environment from being corrected,
PREFERRED_NETWORK entries can be useful in the following situations:

■ To prevent NetBackup from connecting to specific destination addresses.

■ To cause NetBackup to connect only to specific destination addresses.

■ To request a subset of local interfaces for source binding when outbound
connections are made.
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Caution:When used for source binding, the operating system may not honor the
source binding list provided by NetBackup. If the operating system implements the
weak host model, asymmetrical network routing may result. If asymmetrical routing
occurs, the remote host may reject the inbound connection if it implements the
strong host model. Similarly, stateful network devices may also drop asymmetrical
connections. To ensure the use of specific outbound interfaces for specific remote
hosts or networks, make sure that the OS name resolution and routing configurations
are correct; create static host routes if needed. Ensure that all network drivers
properly implement the IP and TCP networking protocols.

The local PREFERRED_NETWORK entries do not affect the forwarding profile that the
local host returns to a remote host during initial CORBA connection setup; it will
contain all the local plumbed interfaces. However, the End Point Selection algorithm
within the remote process will utilize its local PREFERRED_NETWORK entries to evaluate
the profile when selecting the destination for the subsequent CORBA connection.

Table 3-132 PREFERRED_NETWORK information

DescriptionUsage

On NetBackup servers or clients.Where to use
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Table 3-132 PREFERRED_NETWORK information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

The option uses the following syntax:

PREFERRED_NETWORK = target[/subnet] directive [source[/subnet]]

Note: The source option is not allowed for the PROHIBITED directive.

Multiple PREFERRED_NETWORK entries can be specified. During evaluation, the entries
are sorted by length of target subnet. Entries with the largest (more precise) subnet
are compared before entries with a shorter (less precise) subnet. If two entries have
equal subnet specification, they are compared in the order configured, from the top of
the list to the bottom.

If a subnet is not specified, the default is /128 when the address is non-zero and /0
when the address is 0. This applies to both target and source addresses.

A subnet of /0 cannot be used with a non-zero address because it effectively negates
all of the bits in the address, making the target or the sourcematch every address.
For example, 0/0.

The following topics describe details about each option:

■ See “target[/subnet]” on page 320.
■ See “directive” on page 321.
■ See “source[/subnet]” on page 322.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Preferred Network.

See “Preferred Network properties” on page 178.

Equivalent Administration
Console property

See “PREFERRED_NETWORK examples” on page 323.

target[/subnet]
The target[/subnet] option indicates a host name or range of addresses to be
compared to the prospective source or destination addresses being evaluated. The
following are examples of how to indicate a target or a subnet:

myserver.domainA host name
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10.82.105.11An IP address

10.82.105.0/21A network with subnet

0.0.0.0Any IPv4 address

0::0Any IPv6 address

0/0Any address

A host or a network name that cannot resolve causes the target to be ignored.
However, any associated source is added to the source binding list.

directive
The directive option determines how the target is compared to the source and/or
the destination address that is being evaluated. The following directives can be
used:

Applies to destination addresses.

If the address that is being evaluated matches the target, then the address
is immediately selected to be used and evaluation stops. If the target is
not matched, evaluation continues with the next entry.

MATCH

Applies to destination addresses.

If the address that is being evaluated does not match the target, it is not
used and evaluation stops for this address. If this was the only potential
destination, the connection is not attempted. If there is an additional potential
destination, it is evaluated starting over with the first entry.

ONLY

The target applies to both source and destination addresses. If a source
is specified, it is ignored and the target is prohibited.

If the matched address is a destination address, evaluation stops. If this was
the only potential destination, the connection is not attempted. If there are
additional potential destinations, they are evaluated starting over with the
first entry.

If the matched address is a source address, it is removed from the binding
list. However, if source entries exist, the shortened binding list may not be
used. (See “source[/subnet]” on page 322.)

Caution: On some platforms, prohibiting a local interface may cause
unexpected results when connecting to remote hosts. Prohibiting a local
interface does not affect connections that are internal to the host.

PROHIBITED
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source[/subnet]
source[/subnet] is optional and indicates a host name or IP address range that
is requested to be used as the local interface for outbound connection to addresses
in the target.

source[/subnet] is applicable to the directives ONLY and MATCH, but not to the
directive PROHIBITED.

Notes:

■ The operating system may not honor the source request.

■ NetBackup does not request a source which has already been PROHIBITED.

■ A host or network name that cannot be resolved, or that is not local to the host,
is ignored, but the evaluation status of the target is still used.

Source binding evaluation
The prospective source binding list is provided by the operating system and consists
of all of the local plumbed interfaces that are not loopback (127.0.0.0/8, ::1) and
not link-local (169.254.0.0/16, fe80::/64).

The PREFERRED_NETWORK entries are then evaluated in the sort order by longest
subnet first, then position when subnets are equal. Any local interfaces that match
a source entry are moved to a second list if still present in the first list. Any local
interfaces that match a target PROHIBITED entry are removed from the first list if
not already moved to the second list.

If local interfaces were moved to the second list, that list becomes the tentative
binding list. If the second list is empty, and interfaces were removed from the first
list, then the shortened first list becomes the tentative binding list.

If a destination matches the target of an entry with a source, the tentative binding
list is searched for the first match to an entry in source. If a match is found, that
interface becomes the source requested by NetBackup for the outbound connection.

Otherwise, if the tentative binding list is the shortened first list, then it becomes the
source binding list for the outbound connection.

Otherwise, ANY becomes the source binding list for the outbound connection.

Note: If the source binding list is not ANY, most operating systems will arbitrarily
use the first interface in the list provided by the application. Because of this behavior,
it is best to not use PROHIBITED entries for local interfaces and to minimize the use
of source entries.
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PREFERRED_NETWORK examples
Table 3-133 Basic examples

EntryDescription

PREFERRED_NETWORK = 12.34.0.0/16 MATCHAllows connectivity to the host names that resolve to
12.34.0.0 through 12.34.255.255. It does not affect
outbound interface selection:

PREFERRED_NETWORK = 12.34.56.78 MATCH
98.76.54.32

Allows connectivity to the host name that resolves to
12.34.56.78, and requests that the operating system use
98.76.54.32 as the outbound interface.

PREFERRED_NETWORK = 0/0 MATCH Host_AInstructs the host to use the interface IPs of Host_A for all
IPv4 and IPv6 addresses.

PREFERRED_NETWORK = 12.34.56.78/24 ONLYPrevents NetBackup from connecting to any destination
address outside the range of 12.34.56.0 through
12.34.56.255. The source interface will be ANY unless one
or more are PROHIBITED.

PREFERRED_NETWORK = 12.34.56.78/24 ONLY
98.76.54.32

Prevents NetBackup from connecting to any destination
address outside the range of 12.34.56.0 through
12.34.56.255. Requests that the operating system use
98.76.54.32 as the outbound interface.

PREFERRED_NETWORK = 2001:1234:1efc::/48
ONLY

Prevents NetBackup from connecting to any destination
addresses outside of the indicated IPv6 subnet. The source
interface will be ANY unless one or more are PROHIBITED.

PREFERRED_NETWORK = 12.34.56.78/16
PROHIBITED

Prevents NetBackup from using any address between
12.34.0.0 and 12.34.255.255 as the source or destination
for a connection.

If it matches a local interface, NetBackup will provide an
ordered list of the remaining interfaces as the source
binding list for the outbound interface when other entries
do not specify a source. Using PROHIBITED with local
interfaces is discouraged. See the details in the following
topic:

See “directive” on page 321.

PREFERRED_NETWORK = 0.0.0.0 PROHIBITEDPrevents the host from using IPv4 addresses.

PREFERRED_NETWORK = 0::0 PROHIBITEDPrevents the host from using IPv6 addresses.

PREFERRED_NETWORK = production_server
PROHIBITED

Prevents the host from using the address of the
production_server.
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Using bplocaladdrs to troubleshoot
Use the bplocaladdrs command to observe the local interfaces that are provided
to NetBackup by the operating system and the order in which they are provided.

bplocaladdrs returns the following output for the host (bob) in the examples in the
following topics.

$ bplocaladdrs

10.82.105.11

10.82.105.8

10.82.10.10

Using bptestnetconn to troubleshoot
Use the bptestnetconn command to observe the order in which entries are
evaluated and the evaluation results. The TGT or SRC indicates whether the
destination is permitted and which source binding list NetBackup provides to the
operating system. A value of ANY indicates that the outbound interface is not
constrained by NetBackup.

$ bptestnetconn -asp -v6

...

FL: mymaster -> 10.82.105.14 : 5 ms FAST (< 5 sec) TGT PROHIBITED

FL: mymedia -> 10.81.40.61 : 6 ms FAST (< 5 sec) SRC:

10.82.10.10

...

PREFERRED_NETWORK rules are applied in this order:

[0] PREFERRED_NETWORK = 10.82.105.14 PROHIBITED

[1] PREFERRED_NETWORK = 10.81.40.0/24 MATCH 10.82.10.10

$ bptestnetconn -asp -v6 -H myclient

...

FL: myclient -> 10.81.40.127 : 6 ms FAST (< 5 sec) SRC: ANY

PREFERRED_NETWORK rules are applied in this order:

[0] PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.0/24

[1] PREFERRED_NETWORK = 10.82.105.0/29 PROHIBITED

[2] PREFERRED_NETWORK = 10.82.104.0/24 MATCH 10.82.105.5

Complex examples
The following examples are more complex and use a NetBackup server (bob), that
uses the following network interfaces:
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eri0: flags=1000843<UP,BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2

inet 10.82.105.11 netmask fffff800 broadcast 10.82.111.255

eri0:1: flags=1000843<UP,BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2

inet 10.82.105.8 netmask fffff800 broadcast 10.255.255.255

eri1: flags=1000843<UP,BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 3

inet 10.82.10.10 netmask fffff800 broadcast 10.82.15.255

Normal outbound connectivity to the following four hosts (billcat, muzzy, beetle,
lilo), uses the first interface. Internal connections use the destination interface as
the source interface.

$ bptestbpcd -host billcat

10.82.105.11:54129 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy

10.82.105.11:54152 -> 10.82.105.14:13724

$ bptestbpcd -host beetle

10.82.105.11:54135 -> 10.82.104.249:13724

$ bptestbpcd -host lilo

10.82.105.11:54139 -> 10.82.56.79:1556

$ bptestbpcd -host 10.82.105.11

10.82.105.11:54144 -> 10.82.105.11:1556

$ bptestbpcd -host 10.82.105.8

10.82.105.8:52148 -> 10.82.105.8:1556

Example 1
Using a local interface as the target for MATCH entries has no affect. In this example,
the source interface is unaffected by the local MATCH entry.

PREFERRED_NETWORK = 10.82.105.8/32 MATCH

$ bptestbpcd -host billcat

10.82.105.11:54202 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy

10.82.105.11:54206 -> 10.82.105.14:13724

$ bptestbpcd -host beetle

10.82.105.11:54300 -> 10.82.104.249:13724
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$ bptestbpcd -host lilo

10.82.105.11:54302 -> 10.82.56.79:1556

$ bptestbpcd -host 10.82.105.11

10.82.105.11:54306 -> 10.82.105.11:1556

$ bptestbpcd -host 10.82.105.8

10.82.105.8:54309 -> 10.82.105.8:1556

Example 2
Similar to Example 1, using a local interface as the target for ONLY entries has no
affect on source binding. It does, however, prevent connections to destination
addresses (in the absence of other directives that more closely MATCH the
destinations). Connections internal to the host are not affected.

PREFERRED_NETWORK = 10.82.105.8/32 ONLY

$ bptestbpcd -host billcat

<16> bptestbpcd main: ConnectToBPCD(billcat) failed:

25 cannot connect on socket

$ bptestbpcd -host muzzy

<16> bptestbpcd main: ConnectToBPCD(muzzy) failed:

25 cannot connect on socket

$ bptestbpcd -host beetle

<16> bptestbpcd main: ConnectToBPCD(beetle) failed:

25 cannot connect on socket

$ bptestbpcd -host lilo

<16> bptestbpcd main: ConnectToBPCD(lilo) failed:

25 cannot connect on socket

$ bptestbpcd -host 10.82.105.11

10.82.105.11:54306 -> 10.82.105.11:1556

$ bptestbpcd -host 10.82.105.8

10.82.105.8:54309 -> 10.82.105.8:1556

Example 3
Using MATCH entries, the outbound connections to a specific host or network can
be preferred over the defaults. In this example, connections to a specific host and
a separate network are requested to use the second outbound network interface.

326Configuring Host Properties
Configuration options for NetBackup servers



PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.8

PREFERRED_NETWORK = 10.82.104.0/24 MATCH 10.82.105.8

$ bptestbpcd -host billcat (Preferred by the first entry)

10.82.105.8:54192 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy (Implicitly permitted using defaults)

10.82.105.11:54196 -> 10.82.105.14:13724

$ bptestbpcd -host beetle (Preferred by the second entry)

10.82.105.8:54200 -> 10.82.104.249:13724

$ bptestbpcd -host lilo (Implicitly permitted using defaults)

10.82.105.11:54202 -> 10.82.56.79:1556

Example 4
Adding an ONLY entry prevents connections to any other hosts that are not on the
specified network, or matched by prior entries.

PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.8

PREFERRED_NETWORK = 10.82.104.0/24 MATCH 10.82.105.8

PREFERRED_NETWORK = 10.82.56.0/24 ONLY

$ bptestbpcd -host billcat (Preferred by first entry)

10.82.105.8:54209 -> 10.82.105.15:13724

<16> bptestbpcd -host 10.82.105.14 (Does not match 1 or 2, excluded by 3)

<16> bptestbpcd main: ConnectToBPCD(muzzy) failed: 25 cannot connect

on socket

$ bptestbpcd -host beetle (Preferred by second entry)

10.82.105.8:54214 -> 10.82.104.249:13724 (Required by third entry)

10.82.105.11:54216 -> 10.82.56.79:1556

Example 5
Changing the ONLY to PROHIBITED explicitly excludes connections with those
destination hosts and implicitly allows connections to unspecified hosts. The
PROHIBITED network is non-local and does not affect source binding.

PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.8

PREFERRED_NETWORK = 10.82.104.249/32 MATCH 10.82.105.8

PREFERRED_NETWORK = 10.82.56.0/24 PROHIBITED
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$ bptestbpcd -host billcat (Preferred by the first entry)

10.82.105.8:54224 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy (Implicitly permitted)

10.82.105.11:54228 -> 10.82.105.14:13724

$ bptestbpcd -host beetle (Preferred by the second entry)

10.82.105.8:54232 -> 10.82.104.249:13724

$ bptestbpcd -host 10.82.56.79 (Does not match 1 or 2, prohibited by 3)

<16> bptestbpcd main: ConnectToBPCD(lilo) failed: 25 cannot connect

on socket

Example 6
Conversely, moving the ONLY to the top of the list does not prevent the MATCH entries
from being evaluated because the ONLY is for a less restrictive IP range than the
MATCH entries. The latter are evaluated first for those hosts.

PREFERRED_NETWORK = 10.82.104.0/24 ONLY

PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.11

PREFERRED_NETWORK = 10.82.104.249/32 MATCH 10.82.105.8

$ bptestbpcd -host billcat (Preferred by the second entry)

10.82.105.11:54392 -> 10.82.105.15:13724

$ bptestbpcd -host 10.82.105.14 (Does not match 2 or 3, excluded by 1)

<16> bptestbpcd main: ConnectToBPCD(muzzy) failed: 25 cannot connect

on socket

$ bptestbpcd -host beetle (Preferred by 3 before required by 1)

10.82.105.8:54396 -> 10.82.104.249:13724

$ bptestbpcd -host 10.82.56.79 (Does not match 2 or 3, excluded by 1)

<16> bptestbpcd main: ConnectToBPCD(lilo) failed: 25 cannot connect

on socket

Example 7
The subnet on this ONLY entry matches both billcat and muzzy, but does not affect
the outbound interface confirming that ONLY is used for destination address filtering
and not source address filtering. Otherwise, all connections would fail because both
local interfaces, 10.82.105.11 and 10.82.105.8, are not in that subnet.
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PREFERRED_NETWORK = 10.82.105.14/31 ONLY

PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.8

$ bptestbpcd -host billcat (Preferred by second entry)

10.82.105.8:54209 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy (Preferred by first entry)

10.82.105.11:45662 -> 10.82.105.14:13724

$ bptestbpcd -host 10.82.104.249 (Excluded by first entry)

<16> bptestbpcd main: ConnectToBPCD(beetle) failed: 25 cannot connect

on socket

Example 8
Here, all three remote hosts are reachable, but notice that the source interface is
the one remaining after 10.82.105.11 is PROHIBITED. This includes the apparent
target MATCH for billcat, which actually failed to match because the source was
previously PROHIBITED. Notice that internal connections are not affected by
PROHIBITED.

PREFERRED_NETWORK = 10.82.105.11/32 PROHIBITED

PREFERRED_NETWORK = 10.82.105.15/32 MATCH 10.82.105.11

$ bptestbpcd -host billcat (Matched second, but first prohibited that source)

10.82.105.8:54202 -> 10.82.105.15:13724

$ bptestbpcd -host muzzy (Implicit match and pruned source)

10.82.105.8:54206 -> 10.82.105.14:13724

$ bptestbpcd -host beetle (Implicit match and pruned source)

10.82.105.8:54300 -> 10.82.104.249:13724

$ bptestbpcd -host 10.82.105.11 (Not affected by first entry)

10.82.105.11:54306 -> 10.82.105.11:1556

$ bptestbpcd -host 10.82.105.8

10.82.105.8:54309 -> 10.82.105.8:1556

Example 9
This example demonstrates two nuances of source binding evaluation that result
in the use of ANY interface instead of the non-prohibited interfaces. The second
entry removes the 10.82.10.10 local interface from the source binding list before
the third entry is processed making that source unavailable. The source on the
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first entry causes the shortened list created by the second entry to be ignored during
all evaluations.

PREFERRED_NETWORK = 10.82.104.249 MATCH 10.82.105.0/24

PREFERRED_NETWORK = 10.82.10.10 PROHIBITED

PREFERRED_NETWORK = 10.82.56.0/24 MATCH 10.82.10.10

FL: billcat -> 10.82.105.15 ... SRC: ANY (First source implicitly negates
second target)

FL: muzzy -> 10.82.105.14 ... SRC: ANY (First source implicitly negates second
target)

FL: beetle -> 10.82.104.249 ... SRC: 10.82.105.11 (Matched first, used
first in range)

FL: lilo -> 10.82.56.79 ... SRC: ANY (Second target explicitly negates third
source)

In Example 8, the source on the first entry matches two local interfaces. The
10.82.105.11 interface was chosen over 10.82.105.8 as the source when
connecting to beetle because that interface was returned first by the operating
system as shown in the bplocaladdrs output for this example. (See the section
called “Using bplocaladdrs to troubleshoot” on page 324.)

Example 10
This example shows how the binding list is shortened by prohibiting a local interface.
When ANY was the default source binding list, the outbound interface for these
destinations was 10.82.105.11. (See the section called “Example 1” on page 325.)
Prohibiting a different local interface causes NetBackup to provide a shortened list
and the operating system selected 10.82.10.10 as the source IP. Because this
operating system uses the strong host model, that interface is not valid for these
destination IPs and the connection attempts fail.

PREFERRED_NETWORK = 10.82.105.8 PROHIBITED

FL: billcat -> 10.82.105.15 ... SRC: 10.82.10.10,10.82.105.11

FL: lilo -> 10.82.56.79 ... SRC: 10.82.10.10,10.82.105.11

$ bptestbpcd -host billcat

<16> bptestbpcd main: ConnectToBPCD(billcat) failed:

25 cannot connect on socket

$ bptestbpcd -host lilo

<16> bptestbpcd main: ConnectToBPCD(lilo) failed:

25 cannot connect on socket
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If the operating system is changed to the weak host model, the TCP SYN for each
connection is transmitted out the default interface (10.10.82.105.11) onto the
10.82.104.0 network, but with a source IP of 10.82.10.10. If there is a network
route from the 10.82.104.0 network to the destination hosts, then the SYN will
reach the destinations. But the reply is only successful if there is an asymmetrical
route back to the 10.82.8.0 network from the destination host. Notice the spoofed
source IP in the successful connection which does not reflect the network onto
which the TCP SYN packet was actually sent.

$ bptestbpcd -host billcat

<16> bptestbpcd main: ConnectToBPCD(billcat) failed:

25 cannot connect on socket

$ bptestbpcd -host lilo

10.82.10.10:52842 -> 10.82.56.79:1556

Compatibility
Any legacy Required Interface or Required Network configuration is automatically
converted to a Preferred Network representation internally.

Consider master server bob, as described in a previous topic. (See
“PREFERRED_NETWORK examples” on page 323.)

REQUIRED_INTERFACE = bob

This entry is equivalent to the following entry for IPv4:

PREFERRED_NETWORK = 0/0 MATCH 10.82.105.11

If IPv6 is enabled, using IP_ADDRESS_FAMILY = AF_UNSPEC, the following is
equivalent for IPv6:

PREFERRED_NETWORK = 0/0 MATCH fc44:53f9:cb30:201:250:56ff:febc:e85f

Both bind the specified source interface for all outbound connections because 0/0
matches all destinations. But notice the length of subnet (/0): any other directive
with a source binding and a longer target subnet will supersede these entries.
Similarly, because both the IPv4 and IPv6 examples have the same subnet length,
only the first of these two would be honored if both were configured.

Similarly, if a required network was configured:

REQUIRED_NETWORK = 10.82.105/21

It translates to the following:

PREFERRED_NETWORK = 10.82.105/21 ONLY
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Which restricts destination addresses to the specified network without affecting
source interface selection.

Notes:

■ In the event that both REQUIRED_INTERFACE and PREFERRED_NETWORK are
specified and if they conflict, REQUIRED_INTERFACE overrides.

■ Unlike REQUIRED_INTERFACE, PREFERRED_NETWORK does not change the
requesting_client or destination_client fields in user-directed requests
to bprd for image list or restore.

RANDOM _PORTS option for NetBackup servers and clients
This option specifies whether NetBackup chooses port numbers randomly or
sequentially when it requires one for communication with NetBackup on other
computers.

Table 3-134 RANDOM _PORTS information

DescriptionUsage

On NetBackup master servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

■ If RANDOM_PORTS = YES (default), NetBackup chooses port numbers randomly
from those that are free in the allowed range. For example, if the range is from 1024
through 5000, it chooses randomly from the numbers in this range.

■ If RANDOM_PORTS = NO, NetBackup chooses numbers sequentially, starting with
the highest number available in the allowed range. For example, if the range is from
1024 through 5000, NetBackup chooses 5000 (if the number is available). If 5000
is not available, port 4999 is chosen.

By default, this option is not present in the configuration file and NetBackup uses the
random method for selecting port numbers.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Port Ranges > Use random port assignments.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property
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RE_READ_INTERVAL option for NetBackup servers
The RE_READ_INTERVAL option determines how often NetBackup checks disk storage
units for available capacity.

Table 3-135 RE_READ_INTERVAL information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

RE_READ_INTERVAL = seconds

The default is 300 seconds (5 minutes).

This entry should appear only once in the configuration file.

How to use

The reread interval is changed to 15 minutes in the following example:

RE_READ_INTERVAL = 900

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > General Server > Check the capacity of disk storage units.

See “General Server properties” on page 132.

Equivalent Administration
Console property

REQUIRED_NETWORK option for NetBackup servers
The REQUIRED_NETWORK option specifies the required route for backup traffic in an
environment where the network traffic is segregated.

For example, an environment can contain a production network at 145.21.14.0
and a backup network at 192.132.28.0.

Table 3-136 REQUIRED_NETWORK information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-136 REQUIRED_NETWORK information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

REQUIRED_NETWORK = IP_address

This entry should appear only once in the configuration file.

Note: If the variable is set and the network is not available, all connections fail and
no backups are performed.

How to use

The required network is set to 192.132.28.0 in the following example:

REQUIRED_NETWORK = 192.132.28.0

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Preferred Network > Only.

See “Preferred Network properties” on page 178.

Equivalent Administration
Console property

RESILIENT_NETWORK option for NetBackup master servers and
clients

The RESILIENT_NETWORK option specifies the computers that should use a resilient
connection for backups and restores.

Table 3-137 RESILIENT_NETWORK information

DescriptionUsage

On NetBackup master servers or clients.Where to use
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Table 3-137 RESILIENT_NETWORK information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use any of the following formats:

RESILIENT_NETWORK = hostname ON|OFF

RESILIENT_NETWORK = ip_address ON|OFF

RESILIENT_NETWORK = network address/network_mask ON|OFF

You can mix IPv4 addresses and ranges with IPv6 addresses and subnets.

By default, RESILIENT_NETWORK is not present in the configuration file.

How to use

The following are examples of valid forms for this entry:

RESILIENT_NETWORK = client.veritas.org ON

RESILIENT_NETWORK = 192.0.2.0 ON

RESILIENT_NETWORK = 192.0.2.0/26 OFF

RESILIENT_NETWORK = 2001:db8:0:0:0:0:0:0 ON

Examples

NetBackup Management > Host Properties > Master Servers or Clients >
Double-click on server > Resilient Network.

See “Specifying resilient connections” on page 196.

Equivalent Administration
Console property

Note: The order is significant for the items in the list of resilient networks. If a client
is in the list more than once, the first match determines its resilient connection
status. For example, suppose you add a client and specify the client IP address
and specifyOn for Resiliency. Suppose also that you add a range of IP addresses
asOff, and the client IP address is within that range. If the client IP address appears
before the address range, the client connection is resilient. Conversely, if the IP
range appears first, the client connection is not resilient.

See “NBRNTD_IDLE_TIMEOUT option for NetBackup servers” on page 317.
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RESUME_ORIG_DUP_ON_OPT_DUP_FAIL option for NetBackup
servers

The RESUME_ORIG_DUP_ON_OPT_DUP_FAIL option specifies that NetBackup should
perform normal duplication if an OpenStorage optimized duplication fails.

Table 3-138 RESUME_ORIG_DUP_ON_OPT_DUP_FAIL information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE | FALSE

By default, this entry is not present and NetBackup does not perform normal duplication
when an optimized duplication fails.

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

REVERSE_NAME_LOOKUP option for NetBackup servers and
clients

This option lets administrators allow, restrict, or prohibit reverse host name lookup.

Table 3-139 REVERSE_NAME_LOOKUP information

DescriptionUsage

On NetBackup servers or clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

REVERSE_NAME_LOOKUP = ALLOWED | RESTRICTED | PROHIBITED

This entry should appear only once in the configuration file.

How to use
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Table 3-139 REVERSE_NAME_LOOKUP information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers or Clients >
Double-click on server > Network Settings > Reverse Host Name Lookup.

See “Network Settings properties” on page 173.

Equivalent Administration
Console property

SECURE_PROXY_CIPHER_LIST option for NetBackup servers and
clients

The SECURE_PROXY_CIPHER_LIST option configures the ciphers that NetBackup
uses for OpenSSL to encrypt communication through the vnetd network daemon.
The SECURE_PROXY_CIPHER_LIST option is a colon-separated list of permitted
OpenSSL cipher strings. For the permitted cipher strings, requirements, and
limitations, see the OpenSSL cipher documentation.

You can use this option to change the ciphers that NetBackup uses. If you configure
this option, NetBackup writes a message about your configured cipher strings to
the vnetd nbpxyhelper VxUL logs. The following is an example:

"Using user configured cipher list: cipher_string:cipher_string:...

Warning: Be careful when you configure the SECURE_PROXY_CIPHER_LIST option.
Permitted OpenSSL lower-level primitives may overlap with the ciphers that provide
no authentication or no encryption. Hosts that do not have a cipher in common in
their cipher lists cannot communicate with each other.

Table 3-140 SECURE_PROXY_CIPHER_LIST information

DescriptionUsage

On NetBackup master servers, media server, or clients.Where to use
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Table 3-140 SECURE_PROXY_CIPHER_LIST information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

SECURE_PROXY_CIPHER_LIST =
cipher_string:cipher_string:cipher_string:...

Replace cipher_string with a permitted OpenSSL cipher string.

By default, the SECURE_PROXY_CIPHER_LIST option is not present in the configuration
file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

SERVER option for NetBackup servers
The first SERVER option in the bp.conf file must point to the master server where
the bp.conf option resides. During installation, SERVER is automatically set to the
name of the system where the NetBackup master server software is installed.

Table 3-141 SERVER information

DescriptionUsage

On NetBackup master servers and media servers.

Note: For a Fibre Transport (FT) media server that has multiple network interfaces
for VLANs, ensure that the FT server’s primary host name appears before any other
interface names for that FT media server host.

For more information, see the NetBackup SAN Client and Fibre Transport Guide.

Where to use
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Table 3-141 SERVER information (continued)

DescriptionUsage

An entry for the SERVER option must be present in the configuration file on all NetBackup
servers and clients. It is the only required NetBackup option. This option is not used
in $HOME/bp.conf files on a client.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Note: This topic discusses the bp.conf entries on the server. However, note that
every SERVER option in a client bp.conf file must be a NetBackup master or media
server. That is, each system that is listed as a SERVER must have either NetBackup
master or media server software installed. The client service on some clients cannot
be started if the client name is incorrectly listed as a server.

If you configure NetBackup media servers for a master server, the bp.conf file on
the master server must have a SERVER entry or MEDIA_SERVER entry for each. As
previously mentioned, the first SERVER entry in the list designates the master server
itself. The SERVER entry or the MEDIA_SERVER entries should be added after the first,
self-referencing option.

A NetBackup master server can be backed up as a NetBackup client by the servers
that belong to another cluster. In that case the bp.conf file on the master server
should have SERVER entries for those servers as well.

How to use
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Table 3-141 SERVER information (continued)

DescriptionUsage

Example
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Table 3-141 SERVER information (continued)

DescriptionUsage

The following is an example entry on a master server:

SERVER = Master_server (this master server itself)

SERVER = NB_server (master server of another cluster)

SERVER = Media_server_#1

MEDIA_SERVER = Media_server_#2

.

.

.

Note: The OpsCenter server name should be configured against the
OPS_CENTER_SERVER_NAME configuration option. If the OpsCenter server name is
configured against the SERVER option, the connection between the master server and
the OpsCenter server may not be established.

See “OPS_CENTER_SERVER_NAME option for NetBackup servers” on page 317.

The first SERVER entry on all the media servers must point to the master server for
those media servers. A media server can have only one master server. However, a
media server can be backed up as a NetBackup client by the servers that belong to
another cluster, in which case the configuration file on the media server should have
SERVER entries for those servers as well.

The following is an example entry on a media server:

SERVER = Master_server (for this media server)

SERVER = NB_server (master server of another cluster)

SERVER = Media_server_#1

MEDIA_SERVER = Media_server_#2

.

.

.

The SERVER entries must be the same on all servers in a master and a media server
cluster.

If a SERVER entry is added or modified in the bp.conf file on the master server, stop
and restart bprd and bpdbm so that NetBackup recognizes the change. (The NetBackup
request daemon and NetBackup database manager.)

Note: If the first SERVER entry (the master server) is modified on a media server, the
Enterprise Media Manager (EMM) also needs to be updated. To update EMM, run
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Table 3-141 SERVER information (continued)

DescriptionUsage

nbemmcmd -updatehost to change the master server for a media server.

NetBackup Management > Host Properties > Master Servers or Media Servers >
Double-click on server > Servers.

See “Servers properties” on page 214.

See “FAILOVER_RESTORE_MEDIA_SERVERS option for NetBackup servers”
on page 301.

Equivalent Administration
Console property

SERVER_CONNECT_TIMEOUT option for NetBackup servers
SERVER_CONNECT_TIMEOUT specifies the number of seconds that the master server
waits before it times out when it connects to a media server.

Table 3-142 SERVER_CONNECT_TIMEOUT information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

SERVER_CONNECT_TIMEOUT = seconds

The default timeout period is 30 seconds.

This entry should appear only once in the configuration file.

How to use

The example permits a timeout of 60 seconds:

SERVER_CONNECT_TIMEOUT = 60

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Timeouts > Server connect timeout.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property
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SERVER_PORT_WINDOW option for NetBackup servers
The SERVER_PORT_WINDOW option specifies the range of non-reserved ports on which
NetBackup processes on this computer accept connections from NetBackup on
other computers when the inbound connection is not to a well known port. This
primarily applies to bpcd call-back when vnetd is disabled in the connect options
for the remote NetBackup server or client and that host is configured for
non-reserved ports. This also applies to NDMP call-back to the media server during
remote NDMP backups.

Table 3-143 SERVER_PORT_WINDOW information

DescriptionUsage

On NetBackup master servers or media servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

SERVER_PORT_WINDOW = start_port end_port

The default range is from 1024 through 5000.

This entry should appear only once in the configuration file.

How to use

The following example permits ports from 4900 through 5000:

SERVER_PORT_WINDOW = 4900 5000

Example

NetBackup Management > Host Properties > Master Servers or Media Servers >
Double-click on server > Port Ranges > Server port window.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property

SERVER_RESERVED_PORT_WINDOW option for NetBackup
servers and clients

This option specifies the range of local reserved ports on which this computer
accepts connections from NetBackup on other computers when the inbound
connection is not to a well known port. This primarily applies to bpcd call-back when
vnetd is disabled in the connect options for the remote NetBackup server or client.

The SERVER_RESERVED_PORT_WINDOW option applies when a server connects to a
client that is configured to accept only reserved ports. This option is generally not
useful on clients.
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Table 3-144 SERVER_RESERVED_PORT_WINDOW information

DescriptionUsage

On NetBackup master servers or media servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

SERVER_RESERVED_PORT_WINDOW = start_port end_port

The default range is from 512 through 1023.

This entry should appear only once in the configuration file.

How to use

The following example permits ports from 900 through 1023:

SERVER_RESERVED_PORT_WINDOW = 900 1023

Example

NetBackup Management > Host Properties > Master Servers or Media Servers >
Double-click on server > Port Ranges > Server reserved port window.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property

SKIP_RESTORE_TO_SYMLINK_DIR option for NetBackup servers
The SKIP_RESTORE_TO_SYMLINK_DIR option forces NetBackup to check all directories
on a UNIX client into which files are restored. If the file to be restored is under a
symbolically linked directory, NetBackup does not restore the file.

Table 3-145 SKIP_RESTORE_TO_SYMLINK_DIR information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-145 SKIP_RESTORE_TO_SYMLINK_DIR information (continued)

DescriptionUsage

This option should appear only once in the configuration file.

For example, if the UNIX client requests a restore for /home/user/.cshrc and
/home/user is a symbolic link, NetBackup does not restore .cshrc.

The addition of SKIP_RESTORE_TO_SYMLINK_DIR helps minimize potential security
and data loss problems if the restore is performed with root permissions. Without
SKIP_RESTORE_TO_SYMLINK_DIR in the bp.conf file, NetBackup follows any
symbolically linked directories and restores files to that location.

Note: Restore job performance is reduced by using this option.

SKIP_RESTORE_TO_SYMLINK_DIR and UNLINK_ON_OVERWRITE do not affect each
other if both are specified, with one exception:

When the following options are enabled:

■ Overwrite existing files option
■ SKIP_RESTORE_TO_SYMLINK_DIR

■ UNLINK_ON_OVERWRITE

Then, when a restore job comes across a symbolic link, the link is unlinked before the
job checks, and the files and directory are restored.

For example, /home/user/ is backed up as a directory and, when restored, it is a
symbolic link to a directory.

These settings have the following outcomes:

■ With SKIP_RESTORE_TO_SYMLINK_DIR set (and Overwrite existing files
indicated), no files are restored into the directory the symbolic link points to, and
the symbolic link remains.

■ With both UNLINK_ON_OVERWRITE and SKIP_RESTORE_TO_SYMLINK_DIR (and
Overwrite existing files indicated), the symbolic link directory is unlinked, the
original directory is restored, and all files within the directory are also restored.

■ With neither option set (andOverwrite existing files indicated), NetBackup follows
the symbolic link and restore all files into the directory to which the symbolic link
points.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Port Ranges > Server reserved port window.

See “Port Ranges properties” on page 175.

Equivalent Administration
Console property

TELEMETRY_UPLOAD option for NetBackup servers
TELEMETRY_UPLOAD allows NetBackup to collect data about how the product is used
in a NetBackup environment. The information that Veritas receives becomes part
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of a continuous quality improvement program (NetBackup Product Improvement
Program) that helps Veritas understand how customers configure, deploy, and use
the NetBackup product. The data is restricted to NetBackup and OpsCenter
development at Veritas.

The telemetry collection agent runs on every NetBackup server and every OpsCenter
server. The telemetry collection agent does not run on NetBackup clients.

Table 3-146 TELEMETRY_UPLOAD information

DescriptionUsage

On NetBackup master and media servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

TELEMETRY_UPLOAD = YES | NO

The default is YES.

This entry should appear only once in the configuration file.

How to use

During the OpsCenter installation process, a prompt or check box appears that asks
for the users' agreement to participate in the Product Improvement Program.

Equivalent Administration
Console property

THROTTLE_BANDWIDTH option for NetBackup servers
This option specifies a limit for the network bandwidth or transfer rate that NetBackup
clients use on a network. The actual limiting occurs on the client side of the backup
connection. This option limits only backups. Restores are unaffected. The default
is that the bandwidth is not limited.

While LIMIT_BANDWIDTH associates a bandwidth or transfer rate with all client IP
addresses in a range between two IP addresses, THROTTLE_BANDWIDTH is more
useful in an IPv6 environment. THROTTLE_BANDWIDTH associates a bandwidth setting
with a subnet description.

For example, the following subnet will get 400kbs bandwidth:
2001:db8:cb30:120::/64 400
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Table 3-147 THROTTLE_BANDWIDTH information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format in a single line:

THROTTLE_BANDWIDTH = xxxx:xxxx:xxxx:xxxx:

yyyy:yyyy:yyyy:yyyy::/nnn zzz

Each THROTTLE_BANDWIDTH option specifies the bandwidth value and the IP address
of the clients and networks to which it applies.

The following variables are defined:

■ xxxx.xxxx.xxxx.xxxx is the subnet portion (64-bits) of the IPv6 address range. (For
example, 2001:db8:1:110.)

■ yyyy.yyyy.yyyy.yyyy is the host portion (64-bits) of the IPv6 address range. (For
example, 0:0:0:8b72.)

■ nnn is the number of mask bits that, when applied to the IPv6 address, identifies
the range of addresses that are considered for throttling. The valid range is 0 to
128. Mask bits are applied left to right across the address range.

■ zzz is the bandwidth limitation in kilobytes per second. (For example, 200.) A value
of 0 disables throttling IPv6 addresses covered by this option.

How to use

The following are LIMIT_BANDWIDTH examples:

■ Configure a bandwidth limit of 500 kilobytes per second for all computers on the
subnet 2001:db8:1:110 as follows:
LIMIT_BANDWIDTH = 2001:db8:1:110::/64 500

■ Configure a bandwidth limit of 700 kilobytes per second for a particular client
(2001:db8:1:110:0:0:0:8b72) as follows:
LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 700

■ To disable bandwidth limiting for a client in a subnet that has a bandwidth limit,
specify 0 for the kilobytes per second:
LIMIT_BANDWIDTH = 2001:db8:1:110::/64 500

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 0

In this case, no limiting occurs for the client with IPv6 address
2001:db8:1:110:0:0:0:8b72

Bandwidth examples
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Table 3-147 THROTTLE_BANDWIDTH information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Bandwidth.

See “Bandwidth properties” on page 61.

Equivalent Administration
Console property

IPv6 address rules for NetBackup clients
The IPv6 address ranges can specify individual clients or entire subnets.

■ An IPv6 address can take the following forms:

■ a.b.c.d.
Where a, b, c, and d are hexadecimal integers in the range 0-ffff.

■ a

A 32-bit integer that represents the full IP address in network byte order.
(The big endian, the most significant byte is first on the wire.)

■ Enter IPv6 addresses as hexadecimal numbers.

■ Neither the subnet nor the host part of an IPv6 address can be zero.

■ Only ordinary IPv6 addresses are accepted.

■ Do not create multiple entries that specify the same range of IPv6 addresses.
If multiple entries are created, NetBackup uses the last one found.
In the following example, NetBackup uses the second entry:

LIMIT_BANDWIDTH = 2001:db8:1:110::/48 500

LIMIT_BANDWIDTH = 2001:db8:1:110::/48 200

This rule also applies to multiple entries that specify an exact client address, as
follows:

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 200

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 100

■ Do not specify IPv6 address ranges that overlap one another.
Consider the following:

LIMIT_BANDWIDTH = 2001:db8:1:110::/48 500

LIMIT_BANDWIDTH = 2001:db8:1:110::/48 500

The ranges overlap, and bandwidth limiting results are unpredictable.
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■ Specify a range of addresses in one entry and an address for a specific client
in other entries.
If a client is covered by an entry that specifies its exact IPv6 address and by
another entry that specifies a range of IPv6 addresses, NetBackup uses the
bandwidth value in the entry with the exact IP address.
The following sets the bandwidth for a range of IPv6 addresses:

LIMIT_BANDWIDTH = 2001:db8:1:110::/48 500

The following sets the bandwidth for a specific address that is within the range:

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 200

In this case, NetBackup uses the specific entry (bandwidth of 200) for the client
whose address is 2001:db8:1:110:0:0:0:8b72. This capability can also be used
to exclude specific clients from bandwidth limiting. The order of the range and
specific address entries in the bp.conf file is not significant.

Rules for setting bandwidth values for NetBackup clients
Set bandwidths for individual clients to one of the following values:

■ 0 (no bandwidth limiting), or

■ Less than or equal to any value that is set for the IPv6 address range that
contains the IP address for the client.
For example, the following is valid:

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/64 500

LIMIT_BANDWIDTH = 2001:db8:1:110:0:0:0:8b72::/128 300

If the bandwidth is set higher for a client than is set for the range, NetBackup ignores
the individual setting. NetBackup uses the value for the range instead. In this case,
the client receives a share of the bandwidth that is specified for the network.

If the bandwidth limit for a client is equal to or lower than the value for the range,
the client uses the lower of the following settings:

■ Its share of the network bandwidth value.

■ Its individual bandwidth value.

The bandwidth value that NetBackup uses for a client is always at least one kilobyte
per second.
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TRUSTED_MASTER option for NetBackup servers
The TRUSTED_MASTER option lets administrators indicate a specific storage lifecycle
policy in a target master server domain to configure Auto Image Replication. The
ability to replicate to a specific target domain SLP is supported between MSDP
storage servers and PDDO storage servers.

Table 3-148 TRUSTED_MASTER information

DescriptionUsage

On NetBackup master servers or media servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Add TRUSTED_MASTER on the master server in the source domain and the master
server in the target domain.

How to use

On the source domain master server, enter the name of the target master server:

TRUSTED_MASTER = Target_Server_Name

On the target domain master server, enter the name of the source master server:

TRUSTED_MASTER = Source_Server_Name

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Servers > Inter-domain Master Servers tab.

See “Servers properties” on page 214.

Equivalent Administration
Console property

ULINK_ON_OVERWRITE option for NetBackup servers
When a UNIX client indicates Overwrite existing files as a restore option, the
UNLINK_ON_OVERWRITE option forces NetBackup to perform the following actions:

■ Check for the existence of a file to be restored.

■ Unlink the file if it exists.

■ Restore the file.

The file can be any normal file, symbolic link, hard link, or empty directory.

The addition of UNLINK_ON_OVERWRITE helps minimize potential security and data
loss problems from following existing symbolic links. It also guarantees that files
are restored exactly as they were backed up.
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Table 3-149 ULINK_ON_OVERWRITE information

DescriptionUsage

On NetBackup master servers.Where to use

This option should appear only once in the configuration file.

Note: Restore job performance is reduced by using this option.

If the UNLINK_ON_OVERWRITE option is not indicated in the bp.conf file but the
Overwrite existing files option is specified, the behavior of NetBackup is different
when it restores symbolic links. (Or, if the option is set to NO.) NetBackup unlinks
existing files or empty directories when it restores symbolic links, hard links, or special
files (CHR, BLK, and FIFO).

However, NetBackup does not unlink when it restores normal files or directories, which
can be problematic. NetBackup follows the symbolic link and creates or replaces the
files that the symbolic link points to. Or, it replaces the directory that the symbolic link
points to.

SKIP_RESTORE_TO_SYMLINK_DIR and UNLINK_ON_OVERWRITE do not affect
each other if both are specified, with one exception:

When the following options are enabled:

■ Overwrite existing files option
■ SKIP_RESTORE_TO_SYMLINK_DIR

■ UNLINK_ON_OVERWRITE

Then, when a restore job comes across a symbolic link, the link is unlinked before the
job checks, and the files and directories are restored.

How to use

For example, if the /home/user/ path was backed up as a directory and, when restored,
it is a symbolic link to a directory:

■ With SKIP_RESTORE_TO_SYMLINK_DIR set (and Overwrite existing files
indicated), no files are restored into the directory the symbolic link points to, and
the symbolic link remains.

■ With both UNLINK_ON_OVERWRITE and SKIP_RESTORE_TO_SYMLINK_DIR (and
Overwrite existing files indicated), the symbolically linked directory is unlinked,
the original directory is restored, and all files within the directory are also restored.

■ With neither set (and Overwrite existing files indicated), NetBackup follows the
symbolic link and restore all files into the directory the symbolic link points to.

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property
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USE_AUTHENTICATION option for NetBackup servers
The USE_AUTHENTICATION option can be used to audit user information without
enabling NetBackup Access Control (NBAC).

Table 3-150 USE_AUTHENTICATION information

DescriptionUsage

On NetBackup master servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

USE_AUTHENTICATION = ON | OFF

The option uses the following parameters:

■ ON

(Default.) The user is authenticated and is audited. Authentication is achieved
without enabling NBAC.

■ OFF

The user is not authenticated and is not allowed to perform any operation. Only a
root user is allowed to make changes and is audited accordingly.

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

USE_VXSS option for NetBackup servers and clients
The USE_VXSS option specifies whether the local system uses NetBackup product
authentication and authorization.

Table 3-151 USE_VXSS information

DescriptionUsage

On NetBackup master servers or clients.Where to use
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Table 3-151 USE_VXSS information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

USE_VXSS = REQUIRED | PROHIBITED | AUTOMATIC

The option uses the following parameters:

■ REQUIRED

Indicates that the local system always uses NetBackup product authentication and
authorization. Connections from the systems that do not use NetBackup product
authentication and authorization are rejected.

■ PROHIBITED

(Default.) Indicates that the local system never uses NetBackup product
authentication and authorization. Connections from the systems that use NetBackup
product authentication and authorization are rejected.

■ AUTOMATIC

Indicates that the local system negotiates with the remote system whether to use
NetBackup product authentication and authorization.
If the USE_VXSS = AUTOMATIC option is specified, VXSS_NETWORK entries can
be used to require or prohibit NetBackup product authentication and authorization
connections with specified remote systems.
See “VXSS_NETWORK option for NetBackup servers” on page 355.

This entry should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Access Control > NetBackup product authentication and authorization.
Change this option to Required.

See “Network Attributes tab of the Access Control properties” on page 58.

Equivalent Administration
Console property

VERBOSE option for NetBackup servers and clients
Used for debugging purposes, the VERBOSE option controls the amount of information
NetBackup includes in its legacy logs.

Table 3-152 VERBOSE information

DescriptionUsage

On NetBackup master servers or clients.Where to use
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Table 3-152 VERBOSE information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

VERBOSE = [ 0 | 1 | 2 | 3 | 4 | 5 ]

By default, this option is disabled.

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Logging > Global logging level.

See “Logging properties” on page 148.

Equivalent Administration
Console property

VMWARE_AUTODISCOVERY_INTERVAL option for NetBackup
servers

This option controls how often NetBackup scans the vCenter servers to discover
virtual machines to display in the NetBackup web UI.

NetBackup attempts autodiscovery first with the same host for which the last
discovery attempt was successful. If autodiscovery fails with that host, NetBackup
tries again with other hosts in the following order:

■ The NetBackup master server

■ The access host, client, or proxy server

■ The media server

Table 3-153 VMWARE_AUTODISCOVERY_INTERVAL information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-153 VMWARE_AUTODISCOVERY_INTERVAL information
(continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

The default is 8 hours. The minimum is 5 minutes, the maximum 1 year. If set to zero,
autodiscovery is disabled for all the VMware servers.

Use the following format:

VMWARE_AUTODISCOVERY_INTERVAL = number of seconds

For example:

VMWARE_AUTODISCOVERY_INTERVAL = 100000

This entry should appear only once in the configuration file.

Note: After changing this option, stop and restart the NetBackup services. For VM
discovery, the NetBackup Discovery Framework service must be running.

How to use

No equivalent exists in the NetBackup Administration Console or web UI.Equivalent Administration
Console property

VXSS_NETWORK option for NetBackup servers
This option identifies whether a specific network or remote system must or must
not use NetBackup product authentication and authorization with the local
system.

If a media server or client does not define a NetBackup product authentication
and authorization network, it uses the NetBackup product authentication and
authorization networks of its master server.

Table 3-154 VXSS_NETWORK information

DescriptionUsage

On NetBackup master servers.Where to use
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Table 3-154 VXSS_NETWORK information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

VXSS_NETWORK = hostname | IP_address | .domain | network.
[AUTOMATIC | REQUIRED | PROHIBITED]

VXSS_NETWORK is relevant only if USE_VXSS is set to AUTOMATIC (USE_VXSS =
AUTOMATIC). More than one VXSS_NETWORK option can be specified.

See “USE_VXSS option for NetBackup servers and clients” on page 352.

The option uses the following parameters:

■ hostname

The host name of the remote system.
■ IP_address

The IP address of the remote system.
■ .domain

A dot followed by the Internet domain name of the remote systems.
■ network.

The network for the remote systems, followed by a dot.

The optional second value can be one of the following keywords:

■ AUTOMATIC

■ REQUIRED

■ PROHIBITED

Note: If multiple VXSS_NETWORK entries specify one particular system, the first
occurrence takes precedence.

How to use
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Table 3-154 VXSS_NETWORK information (continued)

DescriptionUsage

USE_VXSS = AUTOMATIC
VXSS_NETWORK = fred.mycompany.com
VXSS_NETWORK = 10.0.0.37 REQUIRED
VXSS_NETWORK = 10.0.0. PROHIBITED
VXSS_NETWORK = .theircompany.com
VXSS_NETWORK = wilma.theircompany.com PROHIBITED
VXSS_NETWORK = barney.mycompany.com PROHIBITED

In the example, NetBackup product authentication and authorization is required
for connections between the local system and the system with host
fred.mycompany.com.

NetBackup product authentication and authorization is required for connections
between the local system and the system with IP address 10.0.0.37.

NetBackup product authentication and authorization is prohibited for connections
between the local system and systems in the 10.0.0 network except for 10.0.0.37.

NetBackup product authentication and authorization is required for connections
between the local system and systems within the theircompany.com Internet domain.

NetBackup product authentication and authorization is required for connections
between the local system and the systemwith host name wilma.theircompany.com
despite the PROHIBITED option for wilma.theircompany.com. The REQUIRED
option for .theircompany.com takes precedence.

NetBackup product authentication and authorization is prohibited for connections
between the local system and the system with host name barney.mycompany.com

Example

NetBackup Management > Host Properties > Master Servers > Double-click on
server > Access Control. Change the networks list property.

See “Network Attributes tab of the Access Control properties” on page 58.

Equivalent Administration
Console property

WEB_SERVER_TUNNEL_ENABLE option for NetBackup servers
In a demilitarized zone (DMZ), the client tries to communicate with the master
directly, and if the connection fails, tries to communicate using an HTTP tunnel on
the media server. You can use the WEB_SERVER_TUNNEL_ENABLE option to
disable the HTTP tunnel on a specific media server. You can use this option if the
media server takes a backup of clients that are not in a DMZ.

For more information, refer to the About the communication between a
NetBackup client located in a demilitarized zone and a master server through
an HTTP tunnel section in the NetBackup Security and Encryption Guide.
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Table 3-155 WEB_SERVER_TUNNEL_ENABLE information

DescriptionUsage

On NetBackup media servers.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

WEB_SERVER_TUNNEL_ENABLE = 1 | 0

The option uses the following parameters:

■ 1 for using the HTTP tunnel. This value is considered as default.
■ 0 for disabling the communication using the HTTP tunnel. This value ensures that

the HTTP tunnel process does not start.

By default, the WEB_SERVER_TUNNEL_ENABLE option is not present in the
configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED for
servers and clients

The VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED option enables the
validation of virtualization server certificates using its root or intermediate certificate
authority (CA) certificates.

Table 3-156 VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED
information

DescriptionUsage

On NetBackup master server or all access hosts.Where to use
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Table 3-156 VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED
information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view,
add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

By default, the
VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED is set to
UNDEFINED, but the security certificate validation is enabled for RHV
and Nutanix AHV servers and disabled for VMware servers.

Use the following format to enable certificate validation for the RHV,
VMware, or Nutanix AHV servers:

VIRTUALIZATION_HOSTS_SECURE_CONNECT_ENABLED = YES

How to use

No equivalent exists in the NetBackup Administration Console
host properties.

Equivalent
Administration
Console property

VIRTUALIZATION_CRL_CHECK for NetBackup servers and clients
The VIRTUALIZATION_CRL_CHECK option lets you specify the revocation check level
for external certificates of the virtualization server. Based on the check, revocation
status of the virtualization server certificate is validated against the certificate
revocation list (CRL) during host communication.

By default, the VIRTUALIZATION_CRL_CHECK option is disabled. If you want to validate
the revocation status of the virtualization server certificate against certificate
revocation list (CRL), set the option to a different value.

You can choose to use the CRLs from the directory that is specified for the
ECA_CRL_PATH configuration option or the CRL distribution point (CDP).

See “ECA_CRL_PATH for NetBackup servers and clients” on page 291.

Table 3-157 VIRTUALIZATION_CRL_CHECK information

DescriptionUsage

On NetBackup master server or all access hosts.Where to use
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Table 3-157 VIRTUALIZATION_CRL_CHECK information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

VIRTUALIZATION_CRL_CHECK = CRL check

You can specify one of the following:

■ DISABLE (or 0) - Revocation check is disabled. Revocation
status of the certificate is not validated against the CRL during
host communication. This is the default value.

■ LEAF (or 1) - Revocation status of the leaf certificate is
validated against the CRL.

■ CHAIN (or 2) - Revocation status of all certificates from the
certificate chain are validated against the CRL.

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console property

Configuration options for NetBackup clients
The following topics are about configuration options for NetBackup clients. Nearly
all of these options can also be set in the Host Properties in the NetBackup
Administration Console.

See “Configuration options not found in the Host Properties” on page 250.

ACCEPT_REVERSE_CONNECTION for clients
The ACCEPT_REVERSE_CONNECTION option lets you start the subscriber service on
a NAT client.

Once the option is enabled, you must restart the client services.

Table 3-158 ACCEPT_REVERSE_CONNECTION information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-158 ACCEPT_REVERSE_CONNECTION information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

Use the following format:

ACCEPT_REVERSE_CONNECTION = TRUE

How to use

No equivalent exists in the NetBackup Administration
Console host properties.

Equivalent Administration
Console

APP_PROXY_SERVER option for NetBackup clients
The APP_PROXY_SERVER entry specifies the name of the client as a backup host for
whitelisting.

Table 3-159 APP_PROXY_SERVER information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig
commands to view, add, or change the option.

For information about these commands, see the
NetBackup Commands Reference Guide.

Use the following format:

APP_PROXY_SERVER = clientname

How to use

No equivalent exists in theNetBackupAdministration
Console host properties.

Equivalent Administration Console

BACKUP_BTRFS_SNAPSHOT option for NetBackup clients
This option indicates that the contents of the BTRFS file system (BTRFS) snapshots
are to be backed up.
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Table 3-160 BACKUP_BTRFS_SNAPSHOT information

DescriptionUsage

On NetBackup clients.Where to use

By default, BACKUP_BTRFS_SNAPSHOT is not present in the
configuration file. When the option is not enabled, only the
BTRFS subvolumes are backed up, but not the BTRFS
snapshots.

When the option is present and enabled (1), the contents of
the BTRFS snapshots on the client are backed up.

Use the following format:

BACKUP_BTRFS_SNAPSHOT = 1

This entry should appear only once in the configuration file.

How to use

The following format ensures that the contents of the BTRFS
snapshots are backed up:

BACKUP_BTRFS_SNAPSHOT = 1

Example

No equivalent exists in the NetBackup Administration
Console host properties.

Equivalent Administration
Console property

The option is applicable for only BTRFS. By default, the
contents of the BTRFS snapshots are not backed up. To
ignore the snapshot paths, the libbtrfsutil package
(version 4.17 onwards) must be present on the client
computer. If the libbtrfsutil package is not present on
the client computer, the read-only snapshot or subvolume
backup is ignored.

Additional information

BACKUP_FIFO_FILES option for NetBackup clients
This option indicates that the contents of a named pipe are to be backed up. A
named pipe–also known as a FIFO–is a method of Inter-Process Communication
that uses the file system interface to transfer data.

Table 3-161 BACKUP_FIFO_FILES information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-161 BACKUP_FIFO_FILES information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

By default, BACKUP_FIFO_FILES is not present in the configuration file. When the
option is not enabled, only the metadata of the named pipe files is backed up, but not
the data in the files.

When the option is present and enabled (1), the contents of the named pipe files on
the client are backed up.

Use the following format:

BACKUP_FIFO_FILES = 1

This entry should appear only once in the configuration file.

How to use

The following format ensures that the contents of the named pipe files on the client are
backed up:

BACKUP_FIFO_FILES = 1

Example

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

For the contents of the files to be backed up, the write process must close the pipe.
As long as data is passing through the pipe, the backup continues.

If the third-party process writing to the named pipe file does not close the pipe,
NetBackup fails the backup job with a non-zero status code (typically 13 or 41). Server
resources are then allocated to other jobs. In the case of restore jobs, the job fails with
status code 2800. In either case, the client processes continue waiting until they are
terminated.

To back up the script or executable that is responsible for writing to the named pipe,
add the program file instead of the named pipe file to the Backup Selections list. To
avoid backing up named pipes, but still having the contents of other pipes read, add
the named pipe to an exclude list or avoid the files entirely in the Backup Selections
list.

Additional information

BPARCHIVE_POLICY option for NetBackup clients
The BPARCHIVE_POLICY entry specifies the name of the policy to use for user
archives.
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Table 3-162 BPARCHIVE_POLICY information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPARCHIVE_POLICY = policy_name

By default, BPARCHIVE_POLICY is not present in the configuration file. By default,
NetBackup uses the first policy that it finds that has the client and a user archive
schedule.

If it is used, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence, if it exists.

See “Type of backup (schedule attribute)” on page 791.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BPARCHIVE_SCHED option for NetBackup clients
This entry specifies the name of the schedule for user archives.

Table 3-163 BPARCHIVE_SCHED information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-163 BPARCHIVE_SCHED information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPARCHIVE_SCHED = schedule_name

By default, BPARCHIVE_SCHED is not present in the configuration file. By default,
NetBackup uses the first archive schedule in the first policy that it finds that contains
this client.

If it is used, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence if it exists.

See “Considerations for user schedules” on page 799.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BPBACKUP_POLICY option for NetBackup clients
This entry specifies the name of the policy to use for user backups.

Table 3-164 BPBACKUP_POLICY information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-164 BPBACKUP_POLICY information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPBACKUP_POLICY = policy_name

By default, BPBACKUP_POLICY is not present in the configuration file. By default,
NetBackup uses the first policy it finds that has both the client and a user backup
schedule.

If present, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence if it exists.

See “Type of backup (schedule attribute)” on page 791.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BPBACKUP_SCHED option for NetBackup clients
This entry specifies the name of the schedule to use for user backups.

Table 3-165 BPBACKUP_SCHED information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-165 BPBACKUP_SCHED information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BPBACKUP_SCHED = schedule_name

By default, BPBACKUP_SCHED is not present in the configuration file. By default,
NetBackup uses the first policy it finds that contains both the client and a user backup
schedule.

If present, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence if it exists.

See “Considerations for user schedules” on page 799.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

BUSY_FILE_ACTION option for NetBackup clients
The BUSY_FILE_ACTION entry directs the action that NetBackup performs on busy
files when busy-file processing is enabled.

Table 3-166 BUSY_FILE_ACTION information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-166 BUSY_FILE_ACTION information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

BUSY_FILE_ACTION = filename_template action_template

■ filename_template
The absolute pathname and file name of the busy file. The shell language
metacharacters *, ?, [], [ - ] can be used for matching patterns of file names or parts
of file names.

■ action_template

Use one of the following parameters:
■ MAIL | mail

Directs NetBackup to email a busy file notification message to the user that the
BUSY_FILE_NOTIFY_USER option specifies.

■ REPEAT | repeat [repeat_count]

Directs NetBackup to retry the backup on the specified busy file. A repeat count
can be specified to control the number of backup attempts. The default repeat
count is 1.

■ IGNORE | ignore

Directs NetBackup to exclude the busy file from processing.

Multiple BUSY_FILE_ACTION entries are allowed.

The value in the user’s $HOME/bp.conf file takes precedence if it exists.

How to use

NetBackup Management > Host Properties > Double-click on client > Busy File
Settings.

See “Busy File Settings properties” on page 63.

Equivalent Administration
Console property

BUSY_FILE_DIRECTORY option for NetBackup clients
The BUSY_FILE_DIRECTORY entry specifies the path to the busy-files working directory
when busy-file processing is enabled.

Table 3-167 BUSY_FILE_DIRECTORY information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-167 BUSY_FILE_DIRECTORY information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BUSY_FILE_DIRECTORY = pathname

By default, BUSY_FILE_DIRECTORY is not present in the configuration file. By default,
NetBackup creates the busy_files directory in /usr/openv/netbackup.

If present, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence, if it exists.

How to use

NetBackup Management > Host Properties > Double-click on client > Busy File
Settings.

See “Busy File Settings properties” on page 63.

Equivalent Administration
Console property

BUSY_FILE_NOTIFY_USER option for NetBackup clients
The BUSY_FILE_NOTIFY_USER entry specifies who receives a notification when the
BUSY_FILE_ACTION entry is set to MAIL.

Table 3-168 BUSY_FILE_NOTIFY_USER information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BUSY_FILE_NOTIFY_USER = email

By default, BUSY_FILE_NOTIFY_USER is not present in the configuration file. By
default, the email recipient is root.

If present, this option should appear only once in the configuration file.

The value in the user’s $HOME/bp.conf file takes precedence, if it exists.

How to use
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Table 3-168 BUSY_FILE_NOTIFY_USER information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Double-click on client > Busy File
Settings.

See “Busy File Settings properties” on page 63.

Equivalent Administration
Console property

BUSY_FILE_PROCESSING option for NetBackup clients
The BUSY_FILE_PROCESSING entry lets the administrator control what NetBackup
does when a file changes while it is in the process of being backed up.

Table 3-169 BUSY_FILE_PROCESSING information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

BUSY_FILE_PROCESSING = yes

By default, BUSY_FILE_PROCESSING is not present in the configuration file and
busy-file processing does not occur.

If present, this option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Busy File
Settings.

See “Busy File Settings properties” on page 63.

Equivalent Administration
Console property

CLIENT_NAME option for NetBackup clients
The CLIENT_NAME entry specifies the name of the client as it's known to NetBackup.

Table 3-170 CLIENT_NAME information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-170 CLIENT_NAME information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CLIENT_NAME = clientname

This option should appear only once in the configuration file.

If more than one entry appears, NetBackup observes only the last CLIENT_NAME entry
that is listed for the option. The client name in a policy that backs up the client should
match the client name that is specified with CLIENT_NAME.

Note: Do not use an IP address as a client name in a policy or the backup may fail.
Specify a host name instead.

The bp.conf of the master server does not require the addition of other clients, other
than the master server as CLIENT_NAME = master server name. The name is
added by default.

During a restore, the default is to restore to the client that is named in the policy that
was used for the backup. For an alternate client restore, indicate the name of the
alternate client in the Backup, Archive, and Restore user interface. (Within the user
interface, theDestination client for restores field is located in the Specify NetBackup
Machines and Policy Type dialog box.)

To use the bprestore command, a parameter can be given to bprestore to indicate
the destination client.

See “About client-redirected restores” on page 1207.

The client installation procedures automatically set CLIENT_NAME to the value that is
specified in ftp_to_client command or install_client command in the
installation scripts.

If the value is not in any bp.conf file, NetBackup uses the value that the
gethostname() library function returns.

See “Client Name properties” on page 68.

How to use

NetBackup Management > Host Properties > Double-click on client > Client Name.Equivalent Administration
Console property
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COMPRESS_SUFFIX option for NetBackup clients
The COMPRESS_SUFFIX entry specifies a list of file extensions. During a backup,
NetBackup does not compress files with these extensions because the file may
already be in a compressed format.

Table 3-171 COMPRESS_SUFFIX information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

COMPRESS_SUFFIX = .suffix

By default, COMPRESS_SUFFIX is not present in the bp.conf file. This option has a
reasonable default. Change only if problems result.

Multiple COMPRESS_SUFFIX entries are allowed.

Do not use wildcards to specify these extensions. Do not specify .A* or .A [1-9] (For
example, specify .A1)

How to use

NetBackupManagement > Host Properties > ClientsDouble-click on client > Client
Settings.

See “Client Settings properties for UNIX clients” on page 84.

Equivalent Administration
Console property

CRYPT_CIPHER option for NetBackup clients
The CRYPT_CIPHER entry applies to clients with the NetBackup Encryption option
installed.

Table 3-172 CRYPT_CIPHER information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-172 CRYPT_CIPHER information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_CIPHER = value

Where value is one of the following:

■ AES-128-CFB (used when no method is specified; default)
■ AES-256-CFB

■ BF-CFB

■ DES-EDE-CFB

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

For information about NetBackup encryption, see the NetBackup Security and
Encryption Guide.

Equivalent Administration
Console property

CRYPT_KIND option for NetBackup clients
The CRYPT_KIND entry on the client determines whether the standard encryption or
legacy encryption is used in the backup. Normally, CRYPT_KIND is set automatically.

The CRYPT_KIND entry applies to clients with the NetBackup Encryption option
installed.

See the NetBackup Security and Encryption Guide.

Table 3-173 CRYPT_KIND information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-173 CRYPT_KIND information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_KIND = type

The following values can be entered:

■ NONE

No encryption is used on the client (default)
■ LEGACY

Legacy pertains to 40-bit and 56-bit data encryption standard (DES). Legacy
encryption is not recommended.

■ STANDARD

Standard pertains to 128-bit and 256-bit encryption (AES, 3DES, Blowfish cipher).
Standard encryption is recommended.

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

Equivalent Administration
Console property

CRYPT_OPTION option for NetBackup clients
The CRYPT_OPTION entry specifies the encryption options on NetBackup clients.
NetBackup creates this entry automatically in the /usr/openv/netbackup/bp.conf
file on a UNIX client when the bpinst_crypt command is run on the NetBackup
master server.

The CRYPT_OPTION entry applies to clients with the NetBackup Encryption option
installed.

See the NetBackup Security and Encryption Guide.

Do not alter the entry or create this file manually unless it was accidentally deleted.

Table 3-174 CRYPT_OPTION information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-174 CRYPT_OPTION information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_OPTION = type

The following values can be entered:

■ DENIED|denied

Specifies that the client does not permit encrypted backups. If the server requests
an encrypted backup, it is considered an error. This option is the default for a client
that has not been configured for encryption.

■ ALLOWED|allowed

Specifies that the client allows either encrypted or unencrypted backups.
■ REQUIRED|required

Specifies that the client requires encrypted backups. If this value is specified and
the server requests an unencrypted backup, it is considered an error.

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

Equivalent Administration
Console property

CRYPT_STRENGTH option for NetBackup clients
The CRYPT_STRENGTH entry specifies the encryption strength on NetBackup clients.
It applies to clients with the NetBackup Encryption option installed.

See the NetBackup Security and Encryption Guide.

Table 3-175 CRYPT_STRENGTH information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-175 CRYPT_STRENGTH information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_STRENGTH = value

The allowable values are as follows:

■ DES_40|des_40

Specifies 40-bit DES encryption. 40-bit is the default value for a client that has not
been configured for encryption.

■ DES_56|des_56

Specifies 56-bit DES encryption.

NetBackup creates this entry automatically on a UNIX client when the bpinst_crypt
command is run on the NetBackup master server. This entry should appear only once
in the configuration file.

Do not alter the entry or create it manually unless it was accidentally deleted.

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

Equivalent Administration
Console property

CRYPT_LIBPATH option for NetBackup clients
The CRYPT_LIBPATH entry specifies the directory that contains the encryption libraries
for NetBackup clients. NetBackup creates this entry automatically in the
/usr/openv/netbackup/bp.conf file on a UNIX client when the bpinst_crypt

command is run on the NetBackup master server.

The CRYPT_LIBPATH entry applies to clients with the NetBackup Encryption option
installed. Do not alter the entry or create it manually unless it was accidentally
deleted. This entry should appear only once in the configuration file.

See the NetBackup Security and Encryption Guide.

Table 3-176 CRYPT_LIBPATH information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-176 CRYPT_LIBPATH information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_LIBPATH = directory

If necessary, create the entry in the following locations:

■ The default value on Windows systems is install_path\bin\
Where install_path is the directory where NetBackup is installed and by default is
C:\Program Files\Veritas.

■ The default value on UNIX systems is /usr/openv/lib/

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

Equivalent Administration
Console property

CRYPT_KEYFILE option for NetBackup clients
The CRYPT_KEYFILE entry specifies the file that contains the encryption keys on
NetBackup clients. NetBackup creates this entry automatically in the
/usr/openv/netbackup/bp.conf file on a UNIX client when the bpinst_crypt

command is run on the NetBackup master server.

See the NetBackup Security and Encryption Guide.

Table 3-177 CRYPT_KEYFILE information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-177 CRYPT_KEYFILE information (continued)

DescriptionUsage

The CRYPT_KEYFILE entry applies to clients with the NetBackup Encryption option
installed. Do not alter the entry or create it manually unless it was accidentally deleted.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

CRYPT_KEYFILE = directory

The default values follow:

■ On Windows systems
install_path\bin\keyfile.dat

Where install_path is the directory where NetBackup is installed and by default is
C:\Program Files\Veritas.

■ On UNIX systems
/usr/openv/netbackup/keyfile

This entry should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Encryption.

See “Encryption properties” on page 104.

Equivalent Administration
Console property

DO_NOT_RESET_FILE_ACCESS_TIME option for NetBackup
clients

The DO_NOT_RESET_FILE_ACCESS_TIME entry specifies that if a file is backed up,
its access time (atime) displays the time of the backup. The default is that
NetBackup preserves the access time by resetting it to the value it had before the
backup.

Table 3-178 DO_NOT_RESET_FILE_ACCESS_TIME information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-178 DO_NOT_RESET_FILE_ACCESS_TIME information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

DO_NOT_RESET_FILE_ACCESS_TIME

This option should appear only once in the configuration file.

How to use

NetBackupManagement > Host Properties >Double-click on client >Client Settings.

See “Client Settings properties for UNIX clients” on page 84.

Equivalent Administration
Console property

ENABLE_DATA_CHANNEL_ENCRYPTION for clients
The ENABLE_DATA_CHANNEL_ENCRYPTION option specifies if the data channel
encryption is enabled for communication with NAT clients.

By default, the data channel encryption is enabled.

Table 3-179 ENABLE_DATA_CHANNEL_ENCRYPTION information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

To disable data channel encryption, use the following format:

ENABLE_DATA_CHANNEL_ENCRYPTION = FALSE

How to use

No equivalent exists in theNetBackupAdministrationConsole
host properties.

Equivalent Administration
Console

IGNORE_XATTR option for NetBackup clients
By default, extended attribute files (Solaris 9 or later) and named data streams are
backed up. Use IGNORE_XATTR to exclude extended attributes and named data
streams from backups. (IGNORE_XATTR was formerly IGNORE_XATTR_SOLARIS.)
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Table 3-180 IGNORE_XATTR information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

IGNORE_XATTR

NetBackup does not check for extended attributes or named data streams if the
IGNORE_XATTR entry is present in the bp.conf file.

This option should appear only once in the configuration file.

See “About backing up and restoring extended attribute files and named data streams”
on page 864.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

Backing up and restoring the ACLs, extended attributes,
and metadata attributes for GPFS volumes
NetBackup recognizes the access control lists, extended attributes, and metadata
attributes of General Parallel File System files and folders. By default, NetBackup
backs up and restores all of these for GPFS volumes. No additional configuration
is necessary.

Restoring files with GPFS Extended Attributes to operating systems other than AIX
or RHEL or file systems other than GPFS may generate errors or failed jobs. The
errors occur because the restore target does not recognize the metadata.

Preventing the backup or restore of the ACL and extended
attributes for a GPFS volume
■ To prevent backups of GPFS extended attributes:

Add the IGNORE_XATTR entry to the bp.conf file on the client:
/usr/openv/netbackup/bp.conf

The entry does not require a value setting; the entry is only IGNORE_XATTR.

■ To prevent backups of the GPFS ACL:
Add the IGNORE_ACL touch file to the client:
/usr/openv/netbackup/IGNORE_ACL
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Note: If extended attributes are allowed to be backed up, the ACL is also backed
up, regardless of whether or not the IGNORE_ACL touch file is present.

■ To prevent restores of GPFS extended attributes (provided that they were backed
up in the first place):
Add the IGNORE_XATTR touch file to the client:
/usr/openv/netbackup/IGNORE_XATTR

■ To prevent restores of the GPFS ACL (provided that it was backed up in the
first place):
Add the IGNORE_ACL touch file to the client:
/usr/openv/netbackup/IGNORE_ACL

Note: If extended attributes are allowed for restore, the ACL is also restored,
regardless of whether or not the IGNORE_ACL touch file is present.

Considerations when backing up and restoring GPFS
extended attributes
■ Upon restore of a file or folder that has an ACL or extended attributes, the ACL

and extended attributes are also restored if they were originally backed up.
However, if the restore job was interrupted, the last file that was in-process may
be skipped when the restore job resumes. In that case, the ACL and the extended
attributes of that file and all subsequent files will not be restored.

■ The IGNORE_XATTR option instructs NetBackup to ignore extended attributes
when backing up files and folders that have extended attributes. In case of a
NetBackup Accelerator initial backup, if IGNORE_XATTR is added to the bp.conf
file or the registry and then is later removed for subsequent backups, perform
a backup with the Accelerator forced rescan option enabled.
See “Accelerator forced rescan option (schedule attribute)” on page 801.

■ If the ACL interface is used to change ACL permissions after a backup is
performed, the restore may not preserve the ACL upon restore.

Support for GPFS metadata attributes: storage pools,
metadata replication, and data replication
NetBackup has added support for the backup and restore of the following GPFS
metadata attributes: storage pools, metadata replication, and data replication. By
default, NetBackup backs up and restores the ACLs, the extended attributes, and
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these additional metadata attributes for GPFS volumes. No additional configuration
is necessary.

The following information is pertinent if, after restoring a file, the illplaced or the
illreplicated flags display in the status of the file. (View the status of the file by
using the GPFS mmlsattr command.)

The illplaced flag displays if the file was restored to a different GPFS storage
pool than where it was when it was backed up. The change could be due to a
change in creation rules or the result of migration rules in the GPFS file placement
policy. Or the GPFS administrator may have used the mmchattr command to
manually move the file to a different storage pool.

The illreplicated flag displays when the storage pool containing the restored
file has fewer failure groups than required by the data replication setting or the
system pool has fewer failure groups than the metadata replication setting.

The GPFS administrator can rebalance the replication factor of the file and resolve
the illplaced or illreplicated flags by running one of two GPFS commands,
depending on the number of the files that are involved and the network traffic:

■ For a single file: mmrestripefile

■ For the complete file system: mmrestripefs

Note: Restoring files with GPFS attributes and ACLs to an alternate platform does
not restore the metadata attributes or the ACLs. The restore may generate an error
such as “Invalid system call.” (Extended attributes can be restored to the alternate
platform, however.)

INFORMIX_HOME option for NetBackup clients
The INFORMIX_HOME entry specifies the path to the Informix home directory and is
required when the client uses NetBackup for Informix.

Table 3-181 INFORMIX_HOME information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-181 INFORMIX_HOME information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

INFORMIX_HOME

This option should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

KEEP_DATABASE_COMM_FILE option for NetBackup clients
The KEEP_DATABASE_COMM_FILE entry causes NetBackup to keep database agent
logs for seven days. The default is that NetBackup keeps database agent logs for
only one day.

Table 3-182 KEEP_DATABASE_COMM_FILE information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

KEEP_DATABASE_COMM_FILE

For example, add it to a client that runs NetBackup for Informix.

This option should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

KEEP_LOGS_DAYS option for NetBackup clients
The KEEP_LOGS_DAYS entry specifies how long to keep job and progress logs for
Backup, Archive, and Restore. The default is 3 days.
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NetBackup writes these files in the following directories:

■ /usr/openv/netbackup/logs/user_ops/username/jobs

■ /usr/openv/netbackup/logs/user_ops/username/logs

A directory exists for each user that uses the Backup, Archive, and Restore
console. This entry also controls how long to keep the log files generated by the
NetBackup Administration Console.

The log files are located in /usr/openv/netbackup/logs/user_ops/nbjlogs.

Table 3-183 KEEP_LOGS_DAYS information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option file.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

KEEP_LOGS_DAYS

This option should appear only once in the configuration file.

How to use

NetBackupManagement > Host Properties >Double-click on client >Client Settings.

See “Client Settings properties for UNIX clients” on page 84.

See “Client Settings properties for Windows clients” on page 89.

Equivalent Administration
Console property

LIST_FILES_TIMEOUT option for NetBackup clients
The LIST_FILES_TIMEOUT entry specifies how long to wait for a response from the
server when it lists files by using the client-user interface or bplist. If this time is
exceeded, the user receives a socket read failed error even if the server
continues to process the user’s request. The default is that LIST_FILES_TIMEOUT
is not in any bp.conf file and NetBackup uses a value of 30 minutes.

Table 3-184 LIST_FILES_TIMEOUT information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-184 LIST_FILES_TIMEOUT information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

LIST_FILES_TIMEOUT

This option should appear only once in the configuration file.

The value in the $HOME/bp.conf file takes precedence if it exists.

How to use

NetBackup Management > Host Properties > Double-click on client > Timeouts.

See “Timeouts properties” on page 238.

Equivalent Administration
Console property

LOCKED_FILE_ACTION option for NetBackup clients
The LOCKED_FILE_ACTION entry specifies the behavior of NetBackup when it backs
up a file that has mandatory file locking enabled in its file mode. (See chmod(1)).
If this entry is set to SKIP, NetBackup skips the files that currently have mandatory
locking set by another process. NetBackup logs a message to this effect.

Table 3-185 LOCKED_FILE_ACTION information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

LOCKED_FILE_ACTION = SKIP

This option should appear only once in the configuration file.

Note: SKIP is the only legal value for this entry. The default is that NetBackup waits
for files to become unlocked.

How to use

NetBackupManagement > Host Properties >Double-click on client >Client Settings.

See “Client Settings properties for UNIX clients” on page 84.

Equivalent Administration
Console property
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MEDIA_SERVER option for NetBackup clients
The MEDIA_SERVER entry specifies that the listed computer is a media server only.
Computers that are listed as media servers can back up and restore clients, but
have limited administrative privileges.

Table 3-186 MEDIA_SERVER information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

MEDIA_SERVER = media_server_name

This option should appear only once in the configuration file.

How to use

NetBackup Management > Host Properties > Double-click on client > Servers.

See “SERVER option for NetBackup servers” on page 338.

Equivalent Administration
Console property

MEGABYTES_OF_MEMORY option for NetBackup clients
The MEGABYTES_OF_MEMORY entry specifies how much memory is available on the
client to use to compress files during backup. If compression is selected, the client
software uses this value to determine how much space to request for the
compression tables. The more memory that is available to the compress code, the
greater the compression. The percentage of computer resources that are used is
also greater. If other processes also need memory, use a maximum value of one
half the actual physical memory on a computer to avoid excessive swapping.

Table 3-187 MEGABYTES_OF_MEMORY information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-187 MEGABYTES_OF_MEMORY information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

MEGABYTES_OF_MEMORY = memory_value

The default is that NetBackup assumes a value of zero megabytes.

This option should appear only once in the configuration file.

Note: The MEGABYTES_OF_MEMORY entry has a reasonable default. Change it only
if problems are encountered.

How to use

NetBackupManagement > Host Properties >Double-click on client >Client Settings.

See “Client Settings properties for UNIX clients” on page 84.

Equivalent Administration
Console property

NFS_ACCESS_TIMEOUT option for NetBackup clients
The NFS_ACCESS_TIMEOUT entry specifies the number of seconds that the backup
process waits to process an NFS mount table. After the time is exceeded, the
process considers an NFS file system to be unavailable.

Table 3-188 NFS_ACCESS_TIMEOUT information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

NFS_ACCESS_TIMEOUT = seconds

By default, NFS_ACCESS_TIMEOUT is set to five seconds.

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console or web UI.Equivalent Administration
Console property
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OLD_VNETD_CALLBACK option for NetBackup clients
The OLD_VNETD_CALLBACK entry specifies that the client should use the client-direct
restore path rather than use the bptm process on a NetBackup media server. The
client-direct restore path bypasses the NetBackup media server for the restore jobs.
Configure this entry on the NetBackup clients that you want to receive data directly
from a Media Server Deduplication Pool storage server.

Before you decommission amedia server that hosts aMedia Server Deduplication
Pool, deactivate MSDP on that media server. See the NetBackup Deduplication
Guide for your release.

Table 3-189 OLD_VNETD_CALLBACK information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

OLD_VNETD_CALLBACK = YES

This entry should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

REPORT_CLIENT_DISCOVERIES option for NetBackup clients
By default, the NetBackup Discovery Service (nbdisco) runs on all clients in the
NetBackup environment. The service helps you build Intelligent Policies by reporting
to the master server when it finds instances of applications (such as Oracle).

Table 3-190 REPORT_CLIENT_DISCOVERIES information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-190 REPORT_CLIENT_DISCOVERIES information (continued)

DescriptionUsage

By default, REPORT_CLIENT_DISCOVERIES is not present in the configuration file.
When REPORT_CLIENT_DISCOVERIES is not present, the NetBackup Discovery
Service is enabled.

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

REPORT_CLIENT_DISCOVERIES = TRUE | FALSE

This option should appear only once in the configuration file.

■ If the entry is set to FALSE, the nbdisco process on that client stops reporting
discoveries to the master server. The service shuts down within 10 minutes after
being set to FALSE and remains down.

■ To turn on the Discovery Service again, either change the entry on that client to
REPORT_CLIENT_DISCOVERIES = TRUE or remove the entire option. Then, run
bp.start_all on the client to restart the service.

■ To set this value on a client remotely, run the following command from the master
server:
nbsetconfig -h clientname

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

RESTORE_RETRIES option for NetBackup clients
The RESTORE_RETRIES entry specifies the number of times to retry a restore after
a failure.

Table 3-191 RESTORE_RETRIES information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-191 RESTORE_RETRIES information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

RESTORE_RETRIES = number_of_retries

The default is 0 (no retries).

This option should appear only once in the configuration file.

Note: The RESTORE_RETRIES entry has a reasonable default. Change it only if
problems are encountered.

How to use

NetBackup Management > Host Properties > Double-click on client > Universal
Settings > Restore retries.

See “Universal Settings properties” on page 241.

Equivalent Administration
Console property

RMAN_OUTPUT_DIR for NetBackup clients
The RMAN_OUTPUT_DIR specifies which directory to place the RMAN input and output
locally on the client for Oracle Intelligent Policy backups. NetBackup does not clean
up the log files so the Oracle user has to clean up the log files manually. The log
is only created when a backup is run using an Oracle Intelligent Policy. Only one
RMAN_OUTPUT_DIR entry per client is allowed in a Windows environment. In a UNIX
environment, each user can place the output in a different location by adding the
RMAN_OUTPUT_DIR entry to $HOME/bp.conf file. The value in the $HOME/bp.conf

file takes precedence if it exists.

The following are examples of RMAN_OUTPUT_DIR entries:

Windows: install_path\oracle\oracle_logs\RMAN

UNIX: /oracle/oracle_logs/rman

For information about RMAN_OUTPUT_DIR, see the NetBackup for Oracle
Administrator’s Guide.

Table 3-192 RMAN_OUTPUT_DIR information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-192 RMAN_OUTPUT_DIR information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

RMAN_OUTPUT_DIR = directory_name

The directory_name is a directory to which the Oracle user has permission to write.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

SERVER option for NetBackup clients
The SERVER entry defines the list of NetBackup master servers and media servers
that can access the NetBackup client. During client installation, SERVER is
automatically set to the name of the primary master server for this client.

The SERVER entries must be added for other master servers and for media servers
for this client. The client needs to have certificates from all the master servers to
communicate with the server. To get the certificate, the client should have entries
of all the connected master servers in the client bp.conf file.

Table 3-193 SERVER information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Note: Every SERVER entry in a client bp.conf file must be a NetBackup master or
media server. That is, each system that is listed as a SERVER must have either
NetBackup master or media server software installed. The client service on some
clients cannot be started if the client name is incorrectly listed as a server.

If you configure media servers, each media server must have a SERVER or a
MEDIA_SERVER entry in the bp.conf file of the client.

How to use
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Table 3-193 SERVER information (continued)

DescriptionUsage

The following is an example bp.conf file on a client:

SERVER = Master_server (default master server)

SERVER = NB_server (other master server)

SERVER = Media_server_#1

MEDIA_SERVER = Media_server_#2

.

.

.

The first SERVER entry denotes the master server to which the client connects to by
default for any requests. (For example, to back up, to list, or to restore files). The
SERVER entry must be present in the /usr/openv/netbackup/bp.conf file on all
UNIX clients. The SERVER entry is the only required entry in the bp.conf file for clients.
The SERVER entry is not used in a $HOME/bp.conf file. On NetBackup UNIX servers,
the SERVER entry applies to both client and the server.

See “RESUME_ORIG_DUP_ON_OPT_DUP_FAIL option for NetBackup servers”
on page 336.

See “MEDIA_SERVER option for NetBackup clients” on page 386.

Example

NetBackup Management > Host Properties > Double-click on client > Servers.

See “SERVER option for NetBackup servers” on page 338.

Equivalent Administration
Console property

SUBSCRIBER_HEARTBEAT_TIMEOUT for clients
The SUBSCRIBER_HEARTBEAT_TIMEOUT option enables the subscriber service on a
NAT client to send heartbeats (or signals) for communication with the master server.

The option value is defined in seconds.

Table 3-194 SUBSCRIBER_HEARTBEAT_TIMEOUT information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-194 SUBSCRIBER_HEARTBEAT_TIMEOUT information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to
view, add, or change the option.

For information about these commands, see the NetBackup
Commands Reference Guide.

If the option is set to a value other than zero, the subscriber
service sends heartbeats.

To disable the heartbeats, use the following format:

SUBSCRIBER_HEARTBEAT_TIMEOUT = 0

How to use

No equivalent exists in theNetBackup Administration Console
host properties.

Equivalent Administration
Console

SYBASE_HOME option for NetBackup clients
The SYBASE_HOME entry specifies the path to the Sybase home directory. The entry
is required for NetBackup to use Sybase to back up Sybase databases.

Table 3-195 SYBASE_HOME information

DescriptionUsage

On a NetBackup for Sybase client.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

SYBASE_HOME = path_to_Sybase_home_directory

The default is that SYBASE_HOME is not in the configuration file.

This option should appear only once in the configuration file.

Note: This entry is not required to back up the Sybase SQL Anywhere database that
NetBackup uses as part of the NetBackup catalog.

For additional information, see the NetBackup for Sybase Administrator's Guide.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property
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USE_CTIME_FOR_INCREMENTALS option for NetBackup clients
The USE_CTIME_FOR_INCREMENTALS entry changes how NetBackup determines
whether or not a file has changed. This entry causes the client software to use both
modification time and inode change time during incremental backups to determine
if a file has changed. (mtime and ctime.)

Table 3-196 USE_CTIME_FOR_INCREMENTALS information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

USE_CTIME_FOR_INCREMENTALS

This option should appear only once in the configuration file.

By default, NetBackup uses only mtime.

See “DO_NOT_RESET_FILE_ACCESS_TIME option for NetBackup clients”
on page 378.

How to use

NetBackupManagement > Host Properties >Double-click on client > Client Settings
> Reset file access time to the value before backup.

Equivalent Administration
Console property

USE_FILE_CHG_LOG option for NetBackup clients
The USE_FILE_CHG_LOG entry specifies whether NetBackup uses the file change
log on VxFS clients. The default is off.

Table 3-197 USE_FILE_CHG_LOG information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-197 USE_FILE_CHG_LOG information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

USE_FILE_CHG_LOG

This option should appear only once in the configuration file.

How to use

NetBackupManagement > Host Properties >Double-click on client > Client Settings
> Use VxFS File Change Log for Incremental Backups.

See “VxFS file change log for incremental backups property” on page 87.

Equivalent Administration
Console property

USEMAIL option for NetBackup clients
The USEMAIL entry specifies the email address where NetBackup sends status on
the outcome of operations for a UNIX client.

Table 3-198 USEMAIL information

DescriptionUsage

On NetBackup UNIX clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

USEMAIL = name1@xxx.com,name2@xxx.com,name3@xxx.com

Note: Separate multiple email addresses using a comma, with no spaces.

Add USEMAIL as follows:

■ If the USEMAIL specifies an address, NetBackup sends automatic backup and
manual backup status to that address.

■ If the $HOME/bp.conf file specifies an address, NetBackup also sends status on
the success or failure of user operations to that address.

This option should appear only once in the configuration file.

How to use
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Table 3-198 USEMAIL information (continued)

DescriptionUsage

NetBackup Management > Host Properties > Double-click on client > Universal
Settings.

See “Universal Settings properties” on page 241.

Equivalent Administration
Console property

VXSS_NETWORK option for NetBackup clients
This entry identifies whether a specific network or remote system must or must not
useNetBackup product authentication and authorizationwith the local system.
It can be configured on NetBackup servers and clients.

See “VXSS_NETWORK option for NetBackup servers” on page 355.

See “Network Attributes tab of the Access Control properties” on page 58.

UNIX client examples
The following is an example of a bp.conf file of a UNIX client:

SERVER = server1

CLIENT_NAME = client1

USEMAIL = abc@bdev.com

COMPRESS_SUFFIX = .Addrs

COMPRESS_SUFFIX = .Counts

VERBOSE = 1

RESTORE_RETRIES = 1

BPBACKUP_POLICY = U1userdir

BPBACKUP_SCHED = userbackups

BPARCHIVE_POLICY = U1userdir

BPARCHIVE_SCHED = userarchives

LOCKED_FILE_ACTION = SKIP

Nonroot users on UNIX clients can have a personal bp.conf file in their home
directory: $HOME/bp.conf.

Note: A root user cannot have a personal bp.conf file. For root users, NetBackup
uses the /usr/openv/netbackup/bp.conf file.

A personal bp.conf file can have any of the following options:

USEMAIL = abc@bdev.com

BPBACKUP_POLICY = user1
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BPBACKUP_SCHED = userback

BPARCHIVE_POLICY = user1

BPARCHIVE_SCHED = userarch

LIST_FILES_TIMEOUT = 10

CLIENT_NAME = alternate_client_name

Specify CLIENT_NAME only when doing restores to an alternate client.

See “Configuration options for NetBackup clients” on page 360.

WEB_SERVER_TUNNEL option for NetBackup clients
Add theWEB_SERVER_TUNNEL option to use a specific media server that creates
the HTTP tunnel for connecting to a specific master server. This option overrides
the media and master server list that is automatically generated on the client for
sending web service connection requests.

For more information, refer to the About the communication between a
NetBackup client located in a demilitarized zone and a master server through
an HTTP tunnel section in the NetBackup Security and Encryption Guide.

Table 3-199 WEB_SERVER_TUNNEL information

DescriptionUsage

On NetBackup clients.Where to use
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Table 3-199 WEB_SERVER_TUNNEL information (continued)

DescriptionUsage

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

WEB_SERVER_TUNNEL = <master> <media>

The option uses the following parameters:

■ master is the hostname or IP address or FQDN of the master server that should
be the recipient of the web service connection requests.

■ media is the hostname or IP address or FQDN of the media server that sets up
the connection via an HTTP tunnel.

For a multi-domain setup, you can add multiple entries on separate lines. These entries
can include a single master server and different media servers or different identities
of the media servers like IP addresses, host names, and Fully Qualified Domain Names
(FQDN).

For example,

WEB_SERVER_TUNNEL=<master> <media>

WEB_SERVER_TUNNEL=<master1> <media1>

WEB_SERVER_TUNNEL=<master1> <media1_IP address>

By default, the WEB_SERVER_TUNNEL option is not present in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property

WEB_SERVER_TUNNEL_USE option for NetBackup clients
In a demilitarized zone (DMZ), the client uses a sequence of steps to set up
communication with the master server. By default, the client tries to communicate
with the master directly, and if the connection fails, tries to communicate using an
HTTP tunnel on themedia server. You can use the WEB_SERVER_TUNNEL_USE option
to change the default behavior.

For more information, refer to the About the communication between a
NetBackup client located in a demilitarized zone and a master server through
an HTTP tunnel section in the NetBackup Security and Encryption Guide.
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Table 3-200 WEB_SERVER_TUNNEL_USE information

DescriptionUsage

On NetBackup clients.Where to use

Use the nbgetconfig and the nbsetconfig commands to view, add, or change
the option.

For information about these commands, see the NetBackup Commands Reference
Guide.

Use the following format:

WEB_SERVER_TUNNEL_USE = AUTO | ALWAYS | NEVER

The option uses the following parameters:

■ AUTO is the default value that uses an auto-routing algorithm.
■ ALWAYS defines that the connection should always use an HTTP tunnel. You can

use this option for NetBackup clients that are in a DMZ.
■ NEVER defines that the connection should not use an HTTP tunnel. You can use

this option for NetBackup clients that are not in a DMZ.

By default, the WEB_SERVER_TUNNEL_USE option is not present in the configuration
file.

This option should appear only once in the configuration file.

How to use

No equivalent exists in the NetBackup Administration Console host properties.Equivalent Administration
Console property
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Configuring server groups
This chapter includes the following topics:

■ About NetBackup server groups

■ Creating or deleting a NetBackup server group

About NetBackup server groups
A server group is a group of NetBackup servers that are used for a common purpose.
A NetBackup Media Sharing group is a server group that shares tape media for
write purposes (backups).

A Media Sharing group can contain the following:

■ NetBackup master server

■ NetBackup media servers

■ NDMP tape servers

Servers can be in more than one group. All members of a Media Sharing server
group must have the same NetBackup master server.

See “About media sharing” on page 553.

See “Configuring media sharing with a server group” on page 554.

See “Creating or deleting a NetBackup server group” on page 400.

Creating or deleting a NetBackup server group
Use the following procedure to configure a server group.
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Caution: NetBackup allows a server group name to be the same as the name of
a media server. To avoid confusion, Veritas recommends that you do not use the
same name for a server group and a media server.

See “About NetBackup server groups” on page 400.

To configure a server group

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices > Server Groups.

2 In the Actions menu, select New > Server Group.

■ Server group name: Specify the name of the server group. You cannot
change the name of an existing server group. Veritas recommends that
server group names be unique. That is, do not use the same name for a
server group that you use for a host such as a media server. If you do, you
may not be able to determine easily if a tape is restricted to a specific media
server or to a specific media server group.

■ Server group type: Specify the type of server group.

■ State: Select the state from the drop-down menu:
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Active. The server group is available for use.■

■ Inactive. The server group is not available for use.

■ Description: Describe the server group.

■ Servers in group: Specify the servers that belong to the group.

■ Servers not in group: Specify the servers that do not belong to the group.

3 In the New Server Group dialog box, enter or select the appropriate
information.

To add a server to the group, select it in the Servers Not in Group window
and click Add.

To remove a server from the group, select it in the Servers in Group window
and click Remove.

4 Click OK to save the server group.

Deleting a server group
Use the following procedure to delete a server group.

To delete a server group

1 In the NetBackup Administration Console, select Media and Device
Management > Devices > Server Groups.

2 Select the group to delete.

3 Select Edit > Delete.

4 Click OK.
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Enabling support for NAT
clients in NetBackup

This chapter includes the following topics:

■ About NAT support in NetBackup

■ Important notes

■ Workflow to enable NAT clients in NetBackup domain

■ Configuring the NetBackup Messaging Broker service

■ Removing NAT support from NetBackup

■ Communication with clients other than NAT clients

■ Performance characteristics of NAT support

About NAT support in NetBackup
NetBackup now supports NetBackup clients in a private network that are connected
to NetBackup servers in a public network via a device that performs Network Address
Translation (NAT). This document refers to such NetBackup clients as NAT clients.

NetBackup supports NAT clients in a network topology where the following conditions
are met:

1. The NAT clients should be able to resolve the host names of the NetBackup
servers and initiate connections to them. It is not required that the NetBackup
servers be able to initiate connections to the NAT clients.

2. The NetBackup client name assigned to a NAT client should be a host name
that is resolvable in the private network. It is not required that the NetBackup
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client name of the NAT client be resolvable from the NetBackup servers in the
public network.

3. Bi-directional connectivity should exist between the master server and all media
servers.

4. The NetBackup software on the NetBackup servers and NAT clients must be
configured for NAT support as described in this document.

When working with NAT clients, NetBackup software ensures that all network
connections are initiated from the NAT client to the NetBackup servers. In other
words, no connections are directly initiated from the NetBackup servers to the NAT
clients. NAT client support relies on a new NetBackup Messaging Broker
(nbmqbroker) service on the master server and a subscriber service on each NAT
client that maintains a persistent connection to the messaging broker service on
the master server. This enables the NetBackup servers to send commands to the
NAT clients via themessaging service. When a NetBackup server needs to connect
to a NAT client (for example to perform a backup) it sends a 'reverse connection
request' message to the NAT client via themaster server. On receiving this message,
the NAT client initiates a connection to the requesting NetBackup server.

Here is how a connection between a media server and a NAT client takes place:

1. The NetBackup Messaging Broker (nbmqbroker) service starts on the master
server if NAT support is enabled.

2. The subscriber service starts on the NAT client along with other client services
and subscribes to nbmqbroker service on the master server if NAT support is
enabled on the client.

3. When a media server wants to connect to a NAT client, it publishes the NAT
client's reverse connection request message to the message broker that exists
on the master server.

4. The message broker delivers the message to the subscriber service on the
NAT client.

5. The subscriber service initiates a connection from the NAT client to the
requesting media server.

6. The media server uses this connection to communicate with the NAT client.

See “Workflow to enable NAT clients in NetBackup domain” on page 405.

Support for client-initiated connections in NetBackup
NetBackup NAT support can also be used in the following non-NAT environments
where it is desirable or mandatory for the NetBackup clients to initiate all connections
to the NetBackup servers:

■ Clients are behind a firewall that is configured to disallow incoming connections
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■ Clients’ host names cannot be resolved to an IP address from the NetBackup
servers, for example DHCP clients without a Dynamic DNS

■ Clients to which media or master servers cannot directly connect for any reason

Important notes
Review the following notes while you enable support for NAT clients in NetBackup.

■ Youmust provide an authorization token during NetBackup certificate deployment
on a NAT client, irrespective of the certificate deployment security level that is
set on the master server. This is required because the master server cannot
resolve the client host name that is part of the certificate deployment request to
the NAT device’s IP address from which the request appears to be coming.

■ Automatic host ID-to-host name mapping is disabled for NAT clients. A NAT
client should be referenced in backup policies and NetBackup commands using
the host name that is already mapped to its host ID. The initial hostname
mappings are established for a client during NetBackup certificate deployment
or external certificate enrolment. If you want a NAT client to use an alternative
name for connection, you have to manually map the required host names using
the Host Management node.

■ In a NetBackup domain that comprises application hosts such as SharePoint,
Microsoft Exchange server, or Application Clusters, the application host name
or data availability group (DAG) namemay be different than the one that is used
during NetBackup client installation. In some cases the Fully Qualified Domain
Name (FQDN) of the host is used during NetBackup client installation. Therefore,
connection between the NetBackup server and the client (or application host)
may fail. To resolve this issue, map both the names of the NetBackup client
using the Host Management node.

For more details on the security certificates and certificate deployment levels, refer
to the NetBackup Security and Encryption Guide.

Workflow to enable NAT clients in NetBackup
domain

The following workflow requires the master server, media server, and client software
to be at version NetBackup 8.2 or later.
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Install NetBackup 8.2 or later software on the master server, media
server, and client computers or upgrade the existing software.

Install or upgrade
NetBackup

Do the following:

1 Configure the NetBackup Messaging Broker (or nbmqbroker)
service.

See “Configuring the NetBackup Messaging Broker service”
on page 407.

2 Set the INITIATE_REVERSE_CONNECTION configuration option
to TRUE on the master server using the nbsetconfig command.

See “INITIATE_REVERSE_CONNECTION for servers” on page 306.

3 Restart the master server services.

Prepare master
server for NAT
support

Do the following:

1 Set the INITIATE_REVERSE_CONNECTION configuration option
to TRUE on the media server using the nbsetconfig command.

See “INITIATE_REVERSE_CONNECTION for servers” on page 306.

2 Restart the media server services.

Prepare media
server for NAT
support

Do the following:

1 Set the ACCEPT_REVERSE_CONNECTION configuration option to
TRUE on the client using the nbsetconfig command.

See “ACCEPT_REVERSE_CONNECTION for clients” on page 360.

2 Restart the client services.

In case of silent installation, you need to set the
ACCEPT_REVERSE_CONNECTION option in the answer file only once
so that the configuration takes place simultaneously for all clients.

For UNIX, ensure that the NBInstallAnswer.conf file is updated
with the ACCEPT_REVERSE_CONNECTION option.

For Windows, ensure that the silentclient.cmd script is edited with
the required information about the ACCEPT_REVERSE_CONNECTION
option.

For more information on the silent installation, refer to the NetBackup
Installation Guide.

Prepare
NetBackup client
for NAT support
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Configuring the NetBackup Messaging Broker
service

To enable the NetBackup master server for NAT client support, you must configure
the NetBackup Messaging Broker (nbmqbroker) service on the master server. The
service is required to initiate the connection between NAT clients and the NetBackup
master server or the media server.

To configure the service

◆ Run the configureMQ -defaultPorts command on the master server.

For more information on the command, refer to the NetBackup Commands
Reference Guide.

In a cluster configuration, run the configureMQ command only on the active
node.

Run the following command to enable the cluster to monitor the nbmqbroker

service that you have added to a NetBackup cluster group:

configureMQ -enableCluster -defaultPorts

Removing NAT support from NetBackup
Use this section to remove the NAT support from NetBackup.

To remove NAT support

1 Ensure that no NAT clients exist in your NetBackup domain.

2 Use the nbsetconfig command to set the INITIATE_REVERSE_CONNECTION

configuration option to FALSE on the master server and the media server.

See “INITIATE_REVERSE_CONNECTION for servers” on page 306.

3 Use the nbsetconfig command to set the ENABLE_MQBROKER flag to FALSE on
the master server.

See “ENABLE_MQBROKER for servers” on page 300.

4 Shutdown the NetBackup Messaging Broker (nbmqbroker) service on the
master server.
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Communication with clients other than NAT
clients

When NAT support is enabled on a NetBackup server, the default behaviour of the
server is to perform all client connections via the NetBackup messaging broker
service on the master server. This requires all clients that the server communicates
with to have NAT support enabled. In this default configuration, the server will fail
to communicate with any clients that have NAT support disabled or those running
a version of NetBackup lacking NAT support. It is possible to instruct the server to
attempt a direct connection to such clients by setting the
ENABLE_DIRECT_CONNECTION option to TRUE. Setting this option allows a NetBackup
server to work with clients that have NAT enabled (using reverse connections) and
those that have NAT disabled (using direct connections).

See “ENABLE_DIRECT_CONNECTION for servers” on page 299.

In an AIR setup, both source and target master servers must be enabled for direct
connection.

Performance characteristics of NAT support
Since NAT support can be used to backup and restore NetBackup clients across
insecure networks like the internet, data channel encryption is enabled by default
for communication with NAT clients. This follows the 'secure by default' principle.

NetBackup does not currently offer data channel encryption for the clients for which
NAT support is disabled. Data channel encryption secures the data in-flight between
the NAT client and the media server and does not encrypt the data at-rest. The
data channel is secured using the secure communications infrastructure that was
introduced with NetBackup 8.1.

The current implementation of data channel encryption incurs significant performance
overhead. You can disable data channel encryption for NAT clients that do not
communicate with NetBackup servers over an insecure network.

Set the ENABLE_DATA_CHANNEL_ENCRYPTION configuration option to FALSE on a NAT
client to disable data channel encryption.

When data channel encryption is disabled, the backup and restore performance of
NAT clients is similar to the clients for which NAT support is disabled.

See “ENABLE_DATA_CHANNEL_ENCRYPTION for clients” on page 379.
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Configuring host
credentials

This chapter includes the following topics:

■ About configuring credentials

■ About configuring Snapshot Management server in NetBackup

About configuring credentials
Credentials appears only if a feature that requires external credentials is licensed.

UseMedia and Device Management > Credentials to manage log on credentials
for the following:

■ Cloud storage credentials.
Configure the credentials when you configure the storage server.
See the NetBackup Cloud Administrator's Guide:
http://www.veritas.com/docs/DOC5332

■ NetBackup Deduplication Engine credentials.
Create the credentials when you configure the storage server.
See the NetBackup Deduplication Guide:
http://www.veritas.com/docs/DOC5332

■ NDMP hosts.
See the NetBackup for NDMP Administrator’s Guide:
http://www.veritas.com/docs/DOC5332

■ OpenStorage storage servers.
Configure the credentials when you configure the storage server.
See the NetBackup OpenStorage Solutions Guide for Disk.
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See the NetBackup Replication Director Solutions Guide.
http://www.veritas.com/docs/DOC5332

■ Virtual machine server credentials.
See the NetBackup for VMware Administrator’s Guide.

■ WebSocket Server credentials
See the NetBackup WebSocket Service (NBWSS) Reference Guide:
http://www.veritas.com/docs/000003214

■ Nutanix Acropolis Cluster credentials

About configuring Snapshot Management server
in NetBackup

You can configure the CloudPoint server as a snapshot management server. To
configure the CloudPoint server in NetBackup you need to add the credentials of
the CloudPoint server.

You can configure the CloudPoint server one of the following:

■ NetBackup Administration Console

■ The -tpconfig command line. See, Veritas NetBackup Commands Reference
Guide.

Registering a CloudPoint server in NetBackup
To register a CloudPoint server as snapshot management server in NetBackup you
need to add the credentials of the CloudPoint server. Veritas recommends that you
add, update, or delete the CloudPoint server from NetBackup.

To register the CloudPoint server

1 Log on to the NetBackup Administration Console.

2 In the left navigation pane, go to Media and Device Management >
Credentials > Snapshot Management Server.

The Snapshot Server Management pane is displayed.

3 Select Actions > New > New Snapshot Server.

4 Enter the snapshot server host name and click OK.

Note: The host name address must be DNS resolvable. Also, IP address is
not supported for CloudPoint server name as an input.
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5 (Optional) Select the Connect using Port number check box, if you want to
connect using a specific port.

6 Click Validate Server to retrieve the CA certificate of the snapshot server.

7 Verify the CA fingerprint and click Yes.

8 Enter the CloudPoint server user name and password.

9 Click OK.

A success message is displayed.

10 Click OK.

The registered CloudPoint server is displayed under the Snapshot
Management Servers table.

To update the CloudPoint server credentials

1 Log on to the NetBackup Administration Console.

2 In the left navigation pane, go to Media and Device Management >
Credentials > Snapshot Management Server.

The Snapshot Server Management pane is displayed.

3 In the Host Name column, right-click on the server you want to update.

4 In the menu, click Change.

5 In the Change CloudPoint Server dialog box, update the credentials.

6 Enter the CloudPoint server user name and password.

7 Select the cloud providers you want to associate with the CloudPoint server.

For on-premises deployment, select None.

Note: You can associate multiple providers with a server, but you cannot
associate multiple servers with the same provider.

8 Click OK.

A success message is displayed.

9 Click OK

Configuring CloudPoint plug-ins in NetBackup
The CloudPoint plug-in you have installed on the CloudPoint server must be
registered and configured in NetBackup with the associated CloudPoint server.
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To register a CloudPoint plug-in

1 Log on to the NetBackup Administration Console.

2 In the left navigation pane, go to Media and Device Management >
Credentials > Snapshot Management Server.

The Snapshot Server Management pane is displayed.

3 Click on the server where you want to add the plug-in. TheCloudPoint Plugins
pane is refreshed.

4 In the CloudPoint Plugins pane, right-click on a blank row.

5 In the menu, click New CloudPoint Plugin.

6 In the Add New Plugin dialog box, from the Available Plugins list, select the
plug-in you want to add.

7 Click Next.

8 In the Configure CloudPlugin dialog box, enter the plug-in ID.

Note: The plug-in ID must be unique and must comprise of A-Z, a-z, 0-9, + ,.
, _ , - characters.

9 Enter the credential details.

Note: The fields are different for different plug-in types.

10 Click OK.

A success message is displayed.

11 Click OK.

The newly added plug-in is listed in the CloudPoint Plugins pane.

To modify CloudPoint plug-in credentials

1 Log on to the NetBackup Administration Console.

2 In the left navigation pane, go to Media and Device Management >
Credentials > Snapshot Management Server.

The Snapshot Server Management pane is displayed.

3 Click in the server under which the plug-in is added. The CloudPoint Plugins
pane displays all the associated plug-ins.

4 Right-click on the CloudPoint plug-in you want to modify.
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5 In the menu, click Change Plugin.

6 In the Selected CloudPlugin dialog box, update the credential details.

Note: You cannot change the plug-in type and plug-in ID.

Warning: If you enter incorrect credentials, the existing snapshot related
information available within CloudPoint is lost, which can lead to restore failures.
This information can be regenerated if you again enter the right credentials.

7 Click OK.
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Managing media servers
This chapter includes the following topics:

■ Activating or deactivating a media server

■ Adding a media server

■ Registering a media server

■ Deleting all devices from a media server

■ Removing a device host from the EMM database

■ About decommissioning a media server

■ Previewing references to a media server

■ Decommissioning a media server

Activating or deactivating a media server
When you activate a media server, NetBackup can use it for backup and restore
jobs. You can deactivate a media server. A common reason to do so is to perform
maintenance. When a media server is deactivated, NetBackup does not send job
requests to it.

When you deactivate a media server, the following things occur:

■ Current jobs are allowed to complete.

■ If the host is part of a shared drive configuration, it does not scan drives.
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To activate or deactivate a media server

1 In the NetBackup Administration Console, expand Media and Device
Management > Media Servers.

2 From theMedia Servers pane, select themedia server to activate or deactivate.

3 On the Actions menu, select Activate or Deactivate.

Adding a media server
The following table describes an overview of how to add a media server to an
existing NetBackup environment.

Note: The NetBackup Enterprise Media Manager service must be active when a
media server is added, devices and volumes are configured, and clients are backed
up or restored.

Table 7-1 Adding a media server

SectionProcedureStep

See the vendor’s documentation.On the new media server host, attach the devices and install
any software that is required to drive the storage devices.

Step 1

See the NetBackup Device Configuration
Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

On the new media server host, prepare the host’s operating
system.

Step 2

See “Servers properties” on page 214.On the master server, add the newmedia server to theMedia
Servers list of the master server. Also, add the new media
server to the Additional Servers list of the clients that the
new media server backs up.

If the new media server is part of a server group, add it to
theAdditional Servers list on all media servers in the group.

Note: Ensure that the name you use in NetBackup is the
same as the host name in the TCP/IP configuration.

Step 3

See the NetBackup Installation Guide,
available at the following URL:

http://www.veritas.com/docs/DOC5332

Install the NetBackupmedia server software on the new host.Step 4

See “Configuring robots and tape drives by
using the wizard” on page 443.

On the master server, configure the robots and drives that
are attached to the media server.

Step 5
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Table 7-1 Adding a media server (continued)

SectionProcedureStep

See “About adding volumes” on page 493.On the master server, configure the volumes.Step 6

See “Creating a storage unit” on page 590.On the master server, add storage units to the media server.
Always specify the media server as the media server for the
storage unit.

The Device Configuration Wizard can create storage units
when you configure robots and drives. Therefore, if you
created storage units already, skip this step.

Step 7

See “About the Policies utility” on page 709.On the master server, configure the NetBackup policies and
schedules to use the storage units that are configured on the
media server.

Step 8

See “Performing manual backups”
on page 896.

Test the configuration by performing a user backup or a
manual backup that uses a schedule that specifies a storage
unit on the media server.

Step 9

Registering a media server
If the master server is not running when you install a media server, the media server
is not registered. You cannot discover, configure, and manage the devices of that
media server. You must register the media server with the master server.
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To register a media server

1 Start the EMM service on the master server.

2 On themaster server, run the following command. (For hostname, use the host
name of the media server.)

On Windows:

install_path\NetBackup\bin\admincmd\nbemmcmd -addhost -machinename

hostname -machinetype media -masterserver server_name

-operatingsystem os_type -netbackupversion

level.major_level.minor_level

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbemmcmd -addhost -machinename

hostname -machinetype media -masterserver server_name

-operatingsystem os_type -netbackupversion

level.major_level.minor_level

Note: Ensure that the name you use in NetBackup is the same as the host
name in the TCP/IP configuration.

Information about nbemmcmd command usage is available.

See the NetBackup Commands Reference Guide, available at the following
URL:

http://www.veritas.com/docs/DOC5332

Deleting all devices from a media server
You can delete all devices from a media server. The media server can be up, down,
or failed and unrecoverable. All devices include robots, drives, and disk pools.

Two procedures exist: one to delete all robots and drives and the other to delete
disk pools.
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To delete all robots and drives from a media server

◆ Enter the following command on the master server:

On Windows:

install_path\NetBackup\bin\admincmd\nbemmcmd -deletealldevices

-machinename server_name -machinetype media

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbemmcmd -deletealldevices

-machinename server_name -machinetype media

Replace server_name with the name of the media server.

To delete disk pools from a media server

1 If the media server has disk pools configured, remove the media server from
the storage units that use those disk pools. For each storage unit, run the
following command on the master server:

On Windows:

install_path\NetBackup\bin\admincmd\bpsturep -label

storage_unit_label -delhost host_name

On UNIX:

/usr/openv/netbackup/bin/admincmd/bpsturep -label

storage_unit_label -delhost host_name

Replace storage_unit_label with the name of the storage unit and host_name
with the name of the media server.

2 If the media server is the only storage server for the disk pools, change the
state of the disk pools to DOWN. To do so, enter the following command on
the master server for each disk pool:

On Windows:

install_path\NetBackup\bin\admincmd\nbdevconfig -changestate

-stype server_type -dp disk_pool_name -state DOWN

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbdevconfig -changestate -stype

server_type -dp disk_pool_name -state DOWN

Replace server_typewith the type of storage server: AdvancedDisk, PureDisk,
or the vendor string that identifies the OpenStorage server type.

Replace disk_pool_name with the name of the disk pool.

3 For each disk pool, do the following:
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■ Remove the media server from disk pool access by entering the following
command on the master server:
On Windows:
install_path\NetBackup\bin\admincmd\nbdevconfig -changedp -dp

-disk_pool_name -stype server_type -del_storage_servers

storage_server

On UNIX:
/usr/openv/netbackup/bin/admincmd/nbdevconfig -changedp -dp

disk_pool_name -stype server_type -del_storage_servers

storage_server

Replace disk_pool_name with the name of the disk pool.
Replace server_type with the type of storage server: AdvancedDisk,
PureDisk, or the vendor string that identifies the OpenStorage server type.
Replace storage_server with the name of the media server.

■ If the disk pool is on disk storage available only to the media server and is
no longer required, delete the disk pool as follows:
On Windows:
install_path\NetBackup\bin\admincmd\nbdevconfig -deletedp -dp

disk_pool_name -stype server_type

On UNIX:
/usr/openv/netbackup/bin/admincmd/nbdevconfig -deletedp -dp

disk_pool_name -stype server_type

You cannot delete a disk pool that has unexpired backup images. You must
first expire the images and delete the image fragments, as follows:

■ Expire the image as follows:
On Windows:
install_path\NetBackup\bin\admincmd\bpexpdate -dp

disk_pool_name -stype server_type -nodelete

On UNIX:
/usr/openv/netbackup/bin/admincmd/bpexpdate -dp

disk_pool_name -stype server_type -nodelete

■ Determine the media IDs in the disk pool as follows:
On Windows:
install_path\NetBackup\bin\admincmd\bpimmedia -dp

disk_pool_name -stype server_type -nodelete

On UNIX:
/usr/openv/netbackup/bin/admincmd/bpimmedia -dp

disk_pool_name -stype server_type

■ Delete each media ID in the disk pool as follows:
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On Windows:
install_path\NetBackup\bin\nbdelete -dt disk_type -media_id

name

On UNIX:
/usr/openv/netbackup/bin/nbdelete -dt disk_type -media_id

name

Removing a device host from the EMM database
Use the following procedure to remove a device host from the Enterprise Media
Manager (EMM) in the NetBackup database.

To remove a device host from the EMM database

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Devices > Media Servers.

2 Select the host.

3 On theActionsmenu, selectEnterpriseMediaManager Database > Remove
Device Host.

4 Click Yes in the confirmation dialog box.

About decommissioning a media server
You can use the NetBackup nbdecommission to decommission a media server.
The command launches a text-based wizard that guides you through the
decommission process. The wizard removes the references to a media server from
a NetBackup domain. (You may have to remove some references manually; the
wizard provides instructions to do so in most cases.)

The nbdecommission command helps in the following scenarios:

■ You retire a server that is no longer required. After all of the backup images on
the old server expire, you can use the nbdecommission to remove the old server
from the NetBackup environment.

■ You replace an old server with a new server and keep the same storage. You
want to access all of the old server storage and backup images from the new
server.

■ The old server fails, and you need to replace it with a new server.

■ You tried to decommission a media server manually and references to it still
remain. The wizard may clean up any references that remain.
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Throughout this documentation, the media server to be decommissioned is referred
to as the old server.

Warning: Be careful when you use the nbdecommission command. Because the
command may expire images, data loss may occur. Therefore, you should
understand completely what the command does before you use it. Veritas
recommends that you first preview all of the references to a media server before
you decommission it.

See “Previewing references to a media server” on page 426.

The following topics provide more information and provide guidance for the entire
process.

See “About decommissioning limitations” on page 421.

See “Before you decommission a media server” on page 422.

See “Decommission actions” on page 423.

See “Post decommission recommendations” on page 423.

See “Previewing references to a media server” on page 426.

See “Decommissioning a media server” on page 427.

About decommissioning limitations
The following are the limitations of the nbdecommission command:

■ Does not decommission clustered media servers. Those include NetBackup
failover media servers or application clusters.

■ Does not process the Media Server Deduplication Pools.
Before you decommission a media server that hosts a Media Server
Deduplication Pool, you must deactivate MSDP on that media server.
See the NetBackup Deduplication Guide, available at the following URL:
http://www.veritas.com/docs/DOC5332

■ Does not update the vm.conf files on the NetBackup servers in your environment.
Therefore, the old server may remain in the vm.conf files on the NetBackup
servers.

■ Does not update the configuration files on the clients. Therefore, the old server
may remain in the server lists on the clients. If you replace an old server with a
new server, the new server is not added to the server list of the new client.
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■ Does not process the NetBackup Vault profiles. If NetBackup Vault profiles exist
that refer to the storage units on the old server, update the Vault profiles
manually.

■ Does not notify you about orphaned resources.

■ Does not restart the daemons and services on other servers that the
decommissioning affects.

■ Requires that you shut down all daemons and services on the old server after
it is decommissioned.

■ Requires that you reconfigure devices on the new server manually (if required).

■ Requires that you know which jobs are running on the old server. You must kill
them or let them run to completion before you run the decommission process.

■ The -list_ref option only reports on the references that it removes explicitly.
The command removes some items implicitly and it does not report them. For
example, host aliases and host credentials are removed but not reported.

■ Requires that you move any media ID generation rules that exist on the old
server. You must move them manually to the media server that performs robot
inventory.

■ Moves the old server to an Administrative Pause state so that no new jobs are
started. However, NetBackup still can start backup and restore jobs for basic
disk; they obtain resources differently than do jobs for other storage destinations.
Also, the nbdecommission command may clear the Administrative Pause to
expire images (depending on your responses to the wizard). Jobs may start
during this period.

Before you decommission a media server
Before you decommission a media server, Veritas recommends that you do the
following:

■ Preview the actions of the nbdecommission command.
See “Previewing references to a media server” on page 426.
Analyze the output of the preview operation to ensure that the command captures
all references to the old server. If it did not, make a list of the items that the
command does not cover and fix them manually later.

■ Back up the NetBackup catalog before you begin. You can use it to return your
environment to the pre-decommission state if something goes wrong or you
have to abort the decommission.

■ Run the command during a maintenance window when the load on the
NetBackup environment is minimal.
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Post decommission recommendations
Veritas recommends the following actions after you run the nbdecommission

command:

■ Follow all of the instructions the command provides.
The command may provide instructions for performing the actions that it cannot
perform. For example, it may provide instructions to cancel the backup jobs that
are active on the old server.

■ Move the physical storage (if needed) and then reconfigure and reinventory
those devices.

■ Examine the vm.conf files on all of the NetBackup servers in your environment.
Remove references to the old server and add references to the new server
where necessary.

■ Remove the old server from the server lists on the clients and add the new
server where necessary.
The nbdecommission command outputs a list of clients that refer to old server.

■ Verify that the old server was removed correctly. Examine the various logical
components (backup policies, storage units, and so on) to make sure that the
old server references have been removed.

■ Back up the NetBackup catalog as soon as possible.

Decommission actions
The nbdecommission command deletes the configuration for the old server from
the EMMdatabase, the NetBackup image catalog, and configuration files on servers.

The following table shows the actions it performs for the components that reference
the media server. The table is organized in the order in which the command
processes the component.

Table 7-2 nbdecommission command actions

ActionComponent

Deletes the following tape storage units:

■ Those in which the Storage device attribute specifies a robot for which the old server is the
robot control host.

■ Those in which the Media server attribute specifies the old server.
■ Those in which the Media server attribute specifies Any Available and the old server is the

only server that can access the storage unit.

Storage unit - Tape
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Table 7-2 nbdecommission command actions (continued)

ActionComponent

Deletes the tape drive path for each tape drive that is attached to the old server. If the path on
the old server is the only path, it also deletes the tape drive.

If a path to a drive exists on more than one media server, the tape drive may become unusable.
You may have to connect the tape drive to a different media server and then reconfigure it in
NetBackup. For example, if the old server is a scan host for a shared drive, NetBackup cannot
use the drive if no other host can scan.

Tape drive

Deletes all of the robotic libraries that are attached to the old server.

If the old server is the robot control host for a shared library, the drives and media become
standalone and unusable. You must reconfigure and re-inventory the library.

Robotic library

Specifies if you want to expire the following tape media or move them to another media server:

■ Those assigned to the old server.
■ Those owned by a media sharing group in which the old server is the only member of the

group.
■ Those that have no specific Media owner and the last write host is same as the old server.

Tape media

Deletes the storage unit if no images exist on it. If images exist, the wizard lets you choose one
of the following options:

■ Expire the images and delete the storage unit.
■ Move the images to the new server. The wizard also updates the Media server field in the

storage unit.
The BasicDisk storage must be shared, and the same disk path must be available on the
new server.

Storage unit -
BasicDisk

Specifies that if more than one media server can access the disk pool that is the destination of
the storage unit, it does the following:

■ Removes the old server from the Media Servers list of the storage unit.
■ Deletes the old server as a storage server.

If the old server is the only server that can access the disk pool, the wizard lets you choose to
do one of the following:

■ Move the storage and images to the new server and delete the old server as a storage server.
The disk volumes must be available on the new server at the same path as the old server.

■ Expire the images (if any), delete any storage units that reference the disk pool, delete the
disk pool, and delete the storage server. (A reference is when the disk pool appears in the
Select disk pool setting of a storage unit.)

Storage unit -
AdvancedDisk
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Table 7-2 nbdecommission command actions (continued)

ActionComponent

Specifies that if more than one media server can access the disk pool that is the destination of
the storage unit, it does the following:

■ Removes the old server from the Media Servers list of the storage unit.
■ Deletes the media server as an OpenStorage storage server.

If the old server is the only server that can access the disk pool, the wizard lets you choose to
do one of the following:

■ Transfer the credentials to the new server and update the Media server field in the storage
unit if required.

■ Expire the images (if any), delete any storage units that reference the disk pool, and delete
the disk pool. (A reference is when the disk pool appears in the Select disk pool setting of
a storage unit.)

Storage unit -
OpenStorage

Specifies that if the nbdecommission command deletes all of the storage units in a storage unit
group, it also deletes the storage unit group. Deleting the storage unit group also may affect
backup policies and storage lifecycle policies.

See “Backup policy and schedule” and “Storage lifecycle policy” in this table.

Storage unit group

Deactivates any backup policy in which the storage destination (directly or indirectly) is a storage
unit that the command deletes. Specifically, deactivates any backup policy that meets any of the
following conditions:

■ The destination is a storage unit that the nbdecommission command deleted.
■ The destination is a storage unit group that contains only one storage unit and the

nbdecommission command deleted that storage unit.
■ The destination is a storage lifecycle policy and the nbdecommission command deleted the

storage unit that is a Backup operation of the storage lifecycle policy.

Backup policy and
schedule

Specifies that for each storage lifecycle policy in which one or more operations uses a storage
unit that the command deleted, it does the following:

■ If images under the SLP control are in-process or yet to be processed, displays the commands
to cancel the SLP jobs and then exits. After you cancel the jobs (or wait until the jobs complete),
rerun the nbdecommission command to continue with the decommissioning.

■ If all of the images under SLP control are processed, deactivates the storage lifecycle policy.
■ If a deleted storage unit was used by aBackup or Snapshot operation, deactivates all backup

policies with the storage lifecycle policy as the destination.

Storage lifecycle
policy

Displays the commands necessary to delete the old server as an FT media server and then exits.

After you delete the old server as an FT media server, rerun the nbdecommission command
to continue with the decommissioning.

Fibre Transport
media server
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Table 7-2 nbdecommission command actions (continued)

ActionComponent

On UNIX NetBackup servers, removes the old server from the following bp.conf file entries:

■ SERVER

■ MEDIA_SERVER

■ CLIENT_NAME

■ BROWSER

OnUNIXmaster servers, also removes the old server from the FORCE_RESTORE_MEDIA_SERVER
and FAILOVER_RESTORE_MEDIA_SERVERS entries.

bp.conf file

On Windows NetBackup servers, removes the old server from the following registry keys:

■ SERVER

■ MEDIA_SERVER

■ CLIENT_NAME

■ BROWSER

On Windows master servers, also removes the old server from the
FORCE_RESTORE_MEDIA_SERVER and FAILOVER_RESTORE_MEDIA_SERVERS keys.

Windows registry

Lists the clients on which the old server appears in their server lists. You must remove the
references to the old server manually.

Clients

Previewing references to a media server
Use the following procedure to preview the associations and references to a media
server that you want to decommission. Veritas recommends that you preview the
references to a media server before you decommission it.

The old server does not have to be up and responsive.

See “About decommissioning a media server” on page 420.

See “Decommissioning a media server” on page 427.
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To preview references to a media server

1 Run the nbdecommission command on the master server or on a media server.
The following is the command syntax:

On Windows:

install_path\NetBackup\bin\admincmd\nbdecommission -list_ref

-oldserver OldServer > file.txt

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbdecommission -list_ref

-oldserver OldServer > file.txt

Replace OldServer with the name of the host to be decommissioned. Replace
file with a name that denotes its contents or purpose.

2 Analyze the output of the preview operation to ensure that the command
captures all references to the old server. If it did not, make a list of the items
that the command does not cover and fix them manually later.

Decommissioning a media server
This topic is part of a group of topics the provide information about decommissioning
a NetBackup media server.

See “About decommissioning a media server” on page 420.

Your path through the nbdecommission wizard depends on how you respond to
the wizard prompts. Depending on your environment and how you respond to
prompts, the wizard may advise you to perform an action and then exit. To continue
in the wizard, you must run the wizard again after you perform the advised action.
You may have to exit and rerun the wizard several times.

If active jobs exist on the media server, you must cancel them before the command
can begin to decommission the media server. Alternatively, you can wait until they
finish.

The OldServer does not have to be up and responsive.

Veritas recommends that you preview the media server references before you
decommission a media server.

See “Previewing references to a media server” on page 426.

The nbdecommission command logs to the standard NetBackup administrator
commands log directory.

Two procedures exist, as follows:
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See “To replace an old media server with a
new media server” on page 428.

Replace an old media server with a new
media server

See “To decommission a media server”
on page 429.

Decommission a media server

To replace an old media server with a new media server

1 Run the nbdecommission command on the master server or on a media server
that is not the object of this operation. The following is the command syntax:

On Windows:

install_path\NetBackup\bin\admincmd\nbdecommission -oldserver

OldServer [-newserver NewServer] [-file decom_ops.txt]

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbdecommission -oldserver

OldServer [-newserver NewServer] [-file decom_ops.txt]

Replace OldServer with the name of the host to be decommissioned.

-newserver is optional. If you specify a new server, the new server becomes
the default media server for the replacement operations. If you do not specify
a new server, the wizard prompts you for the new server for each storage type
that contains valid backup images. This method is useful if you want to move
backup images to different media servers. For example, you can move backup
images from tape storage to one media server and backup images from disk
storage to another media server.

-file is optional. It writes the command operations to the specified file. Replace
decom_ops.txt with a name that denotes its purpose or contents. Veritas
recommends that you use the -file option tomaintain a record of the command
operations.

2 Follow the prompts and perform the requested actions.

For example, the command may make changes on the master server and on
multiple media servers. You may be required to restart the NetBackup services
on those servers so that the changes take effect.
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To decommission a media server

1 Run the following command on the master server or on a media server that is
not the object of this operation. The OldServer does not have to be up and
responsive.

On Windows:

install_path\NetBackup\bin\admincmd\nbdecommission -oldserver

OldServer

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbdecommission -oldserver

OldServer

Replace OldServer with the name of the host to be decommissioned.

2 Follow the prompts and perform the requested actions.
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Configuring storage

■ Chapter 8. Configuring disk storage

■ Chapter 9. Configuring robots and tape drives

■ Chapter 10. Configuring tape media

■ Chapter 11. Inventorying robots

■ Chapter 12. Configuring storage units

■ Chapter 13. Staging backups

■ Chapter 14. Configuring storage unit groups
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Configuring disk storage
This chapter includes the following topics:

■ About configuring BasicDisk storage

■ About configuring disk pool storage

■ Inventorying a NetBackup disk pool

■ Changing OpenStorage disk pool state

About configuring BasicDisk storage
A BasicDisk type storage unit consists of a directory on locally-attached disk or
network-attached disk. The disk storage is exposed as a file system to a NetBackup
media server. NetBackup stores backup data in the specified directory.

No special configuration is required forBasicDisk storage. You specify the directory
for the storage when you configure the storage unit.

See “Creating a storage unit” on page 590.

About configuring disk pool storage
You can configure disk pools if you license a NetBackup feature that uses disk
pools.

For more information, see the NetBackup online Help or the following guides:

■ The NetBackup AdvancedDisk Storage Solutions Guide.

■ The NetBackup Cloud Administrator's Guide.

■ The NetBackup Deduplication Guide.

■ The NetBackup OpenStorage Solutions Guide for Disk.
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■ The NetBackup Replication Director Solutions Guide.

The Guides are available through the following URL:

http://www.veritas.com/docs/DOC5332

Inventorying a NetBackup disk pool
An inventory of a NetBackup disk pool reads the capacity of the disk volumes in
the pool. An inventory operation lets you update NetBackup with the new capacity
values if you do the following:

■ Increase or decrease the size of the disk volumes in a disk pool.

■ Add volumes to or remove volumes from a disk pool.

How you increase or decrease the underlying storage capacity depends on your
storage implementation. You must complete that process before you inventory the
disk pool.

To inventory a NetBackup disk pool

1 in the NetBackup Administration Console, select Media and Device
Management > Devices > Disk Pools.

2 On the Actions menu, select Inventory Disk Pools.

3 In the Inventory Disk Pool dialog box, select the disk pool to inventory and
then click Start Inventory.

4 To update the NetBackup catalog with the capacity values returned by the
inventory, click Update Configuration.

5 To inventory another disk pool, go to step 3.

6 To exit, click Close.

Changing OpenStorage disk pool state
Disk pool state is UP or DOWN.

To change the state to DOWN, the disk pool must not be busy. If backup jobs are
assigned to the disk pool, the state change fails. Cancel the backup jobs or wait
until the jobs complete.

To change OpenStorage disk pool state

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Device Monitor.

2 At the bottom of the right pane, select the Disk Pools tab.
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3 Select the disk pool.

4 Select either Actions > Up or Actions > Down.
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Configuring robots and
tape drives

This chapter includes the following topics:

■ NetBackup robot types

■ About the device mapping files

■ Downloading the device mapping files

■ About configuring robots and tape drives in NetBackup

■ Configuring robots and tape drives by using the wizard

■ Updating the device configuration by using the wizard

■ Adding a robot to NetBackup manually

■ Managing robots

■ Adding a tape drive to NetBackup manually

■ Configuring drive name rules

■ Adding a tape drive path

■ Adding a shared tape drive to a NetBackup environment

■ Correlating tape drives and SCSI addresses on Windows hosts

■ Correlating tape drives and device files on UNIX hosts

■ Managing tape drives

■ Performing device diagnostics

9Chapter



■ Verifying the device configuration

■ About automatic path correction

■ Enabling automatic path correction

■ Replacing a device

■ Updating device firmware

■ About the NetBackup Device Manager

■ About external access to NetBackup controlled devices on UNIX

■ Stopping and restarting the device manager

NetBackup robot types
A robot is a peripheral device that moves tape volumes into and out of tape drives.
NetBackup uses robotic control software to communicate with the robot firmware.

NetBackup classifies robots according to one or more of the following characteristics:

■ The communication method the robotic control software uses; SCSI and API
are the two main methods.

■ The physical characteristics of the robot. Library refers to a large robot, in terms
of slot capacity or number of drives.

■ The media type commonly used by that class of robots. HCART (1/2-inch
cartridge tape) is an example of a media type.

Table 9-1 lists the NetBackup robot types that are supported in release 8.2, with
drive and slot limits for each type.

To determine which robot type applies to the model of robot that you use, see the
hardware compatibility list for your NetBackup version:

http://www.netbackup.com/compatibility

Table 9-1 NetBackup robot types in release 8.2

NoteSlot limitsDrive limitsDescriptionRobot type

API control. The ACS library
software host determines the
drive limit.

No limit1680Automated Cartridge SystemACS

SCSI control.32000No limitTape library DLTTLD
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Note: The user interface for NetBackup may show configuration options for the
peripheral devices that are not supported in that release. Those devices may be
supported in an earlier release, and a NetBackup master server can manage the
hosts that run earlier NetBackup versions. Therefore, the configuration information
for such devices must appear in the user interface. The NetBackup documentation
also may describe the configuration information for such devices. To determine
which versions of NetBackup support which peripheral devices, see the hardware
compatibility list:

http://www.netbackup.com/compatibility

For information about the robots that NetBackup supports, see the hardware
compatibility for your release available through the following URL:

http://www.netbackup.com/compatibility

About the device mapping files
NetBackup uses several files to determine which protocols and settings to use to
communicate with storage devices. NetBackup also uses the files during device
discovery and configuration.

The device mapping files are available for download from the following webpage:

http://www.netbackup.com/compatibility

The download packages contain the following files:

■ external_robotics.txt

■ external_types.txt

■ Readme.txt

In some cases, you can add support for new or upgraded devices without waiting
for a release update from Veritas. To do so, download the current device mapping
files package from the website and configure NetBackup to use that file. For
instructions, see the Readme.txt file that is supplied with the device mapping file
package.

Note: The contents of the device mapping files do not indicate support for any of
the devices, only the ability to recognize and automatically configure them.

See “Downloading the device mapping files” on page 437.

See “About configuring robots and tape drives in NetBackup” on page 437.
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Downloading the device mapping files
Use the following procedure to download the current device mapping files and
update the NetBackup Enterprise Media Manager database with their information.

See “About the device mapping files” on page 436.

To download the current device mapping files

1 Open the NetBackup compatibility lists knowledge base article at the following
URL:

http://www.netbackup.com/compatibility

2 In the NetBackup Device Mapping Files row in the table in the Solutions
section, select the link for your operating system.

A Veritas Knowledge Base article appears that contains installation instructions
and an archive file of the device mappings.

3 Download the archive file, either a .tar or .zip depending on operating system.

4 Follow the instructions in the Readme.txt file in the archive to update the device
mappings. The Readme.txt file contains instructions for both Windows and
UNIX operating systems.

About configuring robots and tape drives in
NetBackup

Before you configure robots and tape drives in NetBackup, they must be attached
to the computer and recognized by the operating system. The server platforms that
NetBackup supports may require operating system configuration changes to allow
device discovery.

The NetBackup Device Configuration Guide provides information about how to
configure device drivers for the systems that NetBackup supports. See the Guide
at the following URL:

http://www.veritas.com/docs/DOC5332

Configure robots and tape drives in NetBackup as follows:
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Veritas recommends using the Device Configuration Wizard to add,
configure, and update the following types of devices in NetBackup:

■ Robots, including those attached to NDMP hosts
■ Tape drives, including those attached to NDMP hosts
■ Shared drives (for NetBackup Shared Storage Option configurations

only)

See “Configuring robots and tape drives by using the wizard”
on page 443.

The wizard discovers the devices that are attached to the media servers
and helps to configure them.

See “About configuring robots and tape drives in NetBackup”
on page 437.

Device
Configuration
Wizard

Alternatively, add robots and drives manually as follows:

■ Use menu options in the NetBackup Administration Console.
See “Adding a robot to NetBackup manually” on page 444.
See “Adding a tape drive to NetBackup manually” on page 452.

■ Use NetBackup commands.
See the NetBackup Commands Reference Guide, available at the
following URL:
http://www.veritas.com/docs/DOC5332

Manual methods do not use device discovery.

To add a robot and drives, first add the robot and then add the drives
that are in the robot.

Manually

Before configuring robots and drives, read the following topics to understand the
process.

See “About device serialization” on page 439.

See “About adding devices without discovery” on page 440.

See “About robot control” on page 440.

See “About drive name rules” on page 442.

See “Correlating tape drives and device files on UNIX hosts” on page 463.

See “Correlating tape drives and SCSI addresses onWindows hosts” on page 461.

About device discovery
Device discovery is an exploratory method that determines which peripheral devices
a host can detect. Detection depends on physical attachment (SCSI, Fibre Channel,
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and so on) and device state (on and responding or off and not responding). Detection
also depends on host operating system device-layer configuration.

The goal of device discovery is to provide information to enable fully or partially
automatic configuration of peripherals for use with NetBackup. Device discovery
provides data that correlates the devices that are interconnected across multiple
hosts or multiple host bus adapters on the same host.

To discover devices, NetBackup issues SCSI pass-through commands through
operating system device files (on UNIX) or APIs (onWindows). The storage devices
must be attached to the computer and recognized by the operating system. A
pass-through path to a device must exist.

The operating systems that NetBackup supports may require configuration changes
to allow device discovery.

The NetBackup Device Configuration Guide provides information about how to
configure device drivers for the systems that NetBackup supports. See the
NetBackup Device Configuration Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

NetBackup can discover the following types of devices:

■ SCSI-based robotic libraries (such as changers, autoloaders, and stackers)

■ SCSI-based tape drives

■ Native parallel SCSI, Fibre Channel Protocol (FCP) and FC-AL (loop) connections

■ SCSI over IP (reported)

■ API type robots, such as ACS, TLM, and TLH robots

■ NDMP devices that run NDMP version 3 or later

See “Enabling automatic path correction” on page 477.

About device serialization
Device serialization is a firmware feature that allows device identification and
configuration. A unique serial number identifies a device.

NetBackup determines device relationships by comparing serial numbers from
multiple sources that refer to the same device. If both a robotic library and a drive
fully support serialization, NetBackup can determine the drive's position (or address)
in the robotic library.

Most robots and drives support device serialization.

If a device supports serialization, the following actions occur when NetBackup
queries the device:
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■ Each robot and each drive return a unique serial number.

■ Each robot also returns the number of drives and the serial number for each of
the drives in the robot. NetBackup uses the information to determine the correct
drive number for each drive in the robot.

If a device does not support serialization, ask the vendor for a new firmware revision
that returns serial numbers. Even with the proper firmware, some devices require
the vendor to perform other actions to enable serialization for the device.

If you know that the devices do not support serialization, make sure that you follow
the maximum configuration limits that the devices allow. You also must coordinate
the drives to their device files or SCSI addresses so you can configure them
correctly.

See “Correlating tape drives and SCSI addresses onWindows hosts” on page 461.

See “Correlating tape drives and device files on UNIX hosts” on page 463.

The more devices in the configuration that do not support serialization, the greater
the chance of configuration problems by using the Device Configuration Wizard.

About adding devices without discovery
NetBackup supports some devices that cannot be discovered automatically.
NetBackup also supports some devices that require user intervention during the
discovery process. To add and configure those devices, select NetBackup
Administration Console > Media and Device Management or use the tpconfig
command.

For the devices that NetBackup cannot discover or that do not have serial numbers,
automatic device path correction is limited.

About robot control
When you add a robot to NetBackup manually, you must configure how the robot
is controlled. The New Robot dialog box includes a section named Robot control,
in which you configure the control options.

See “Robot control (robot configuration options)” on page 447.

The following table lists the information that is required to configure the three robot
control types (local, NDMP, and remote). The information that is required depends
on the robot type and the media server type.
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Table 9-2 Robot control information

Information required for configurationRobot
control

Media server typeRobot
type

NDMP host name and robot deviceNDMPWindows, Solaris SPARC, and Linux (except
Linux64)

ACS

ACSLS hostRemoteAllACS

Robotic device fileLocalUNIXTL4

Robot device or SCSI coordinatesLocalWindowsTL4

Robotic device fileLocalUNIXTL8

Robot device or SCSI coordinatesLocalWindowsTL8

NDMP host name and robot deviceNDMPWindows, Solaris SPARC, and Linux (except
Linux64)

TL8

Robot control hostRemoteAllTL8

Robotic device fileLocalUNIXTLD

Robot device or SCSI coordinatesLocalWindowsTLD

NDMP host name and robot deviceNDMPWindows, Solaris SPARC, and Linux (except
Linux64)

TLD

Robot control hostRemoteAllTLD

Library nameLocalAll (except Solaris Opteron, HP IA64, Linux,
and Linux64)

TLH

NDMP host name and robot deviceNDMPWindows, Solaris SPARC, and Linux (except
Linux64)

TLH

Robot control hostRemoteAll (except Solaris Opteron, Linux64)TLH

DAS/SDLC serverRemoteAll (except Linux64 and HP IA64)TLM

Library sharing example
Figure 9-1 shows library sharing with two servers using two drives in a TLD robot.

The robotic control for the robot is on the host that is named eel. One drive in the
robot is connected to eel and the other is connected to the host shark.

Host eel is the robot control host. To configure this robot on host eel, select Robot
is controlled locally by this device host. To configure this robot on host shark,
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select Robot control is handled by a remote host. Then, enter eel for the Robot
control host.

Figure 9-1 Robot control host example

sharkeel

Drive 2Drive 1TLD Robotic
Control

TLD robot (HP EML E-Series)

About drive name rules
The drive name rules define the rules NetBackup uses to name drives.

The default, global drive name rule creates names in the following format:

vendor ID.product ID.index

If you use the default global rule when you add Quantum DLT8000 drives, the drives
are named as follows: The first one that you add is namedQUANTUM.DLT8000.000,
the second one QUANTUM.DLT8000.001, and so on.

You can change the default, global drive name rule.

You also can create drive name rules for specific device hosts (each device host
can have its own rule). Host-specific rules override the global rule for the devices
that are attached to the specified host.

Only one global rule can exist; it is used for all connected device hosts. The global
rule is used for the drive name unless a host-specific rule or local rule is specified.

Drive names are limited to 48 characters.

Use any of the following drive attributes as part of a drive name rule:

■ Host name

■ Robot number

■ Robot type

■ Drive position
Drive position information varies depending on the robot type. Drive position
information can be ACS coordinates, TLM or TLH vendor drive name, or the
robot drive number.

■ Drive type
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■ Serial number

■ Vendor ID

■ Product ID

■ Index

A Custom Text field is also available which accepts any of the allowable drive
name characters.

See “Configuring drive name rules” on page 457.

Configuring robots and tape drives by using the
wizard

Veritas recommends that you use the NetBackup Device Configuration Wizard
to configure robots and drives. However, you can add robots and drives manually.

To configure robots and drives by using the wizard

1 In the NetBackup Administration Console, in the left pane, clickMedia and
Device Management.

2 In the right pane, click the Configure Storage Devices and follow the wizard
instructions.

The properties you can configure depend on the robot type, the host type, and
the robot control.

Updating the device configuration by using the
wizard

Veritas recommends that you use the Device Configuration Wizard to update the
NetBackup device configuration when hardware changes occur.

Update the configuration for all storage device changes. For example, if you add
or delete a robot or drive or add a new SCSI adapter in a host, update the
configuration.

Do not update the device configuration during backup or restore activity.
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To update the device configuration by using the wizard

1 In the NetBackup Administration Console, select Media and Device
Management > Devices.

2 From the list of wizards in the Details pane, click Configure Storage Devices
and follow the wizard instructions.

Adding a robot to NetBackup manually
When you add a robot manually, you must specify how the robot is controlled.

See “NetBackup robot types” on page 435.

See “About robot control” on page 440.

After you add a robot, you should add the robot's drives.

See “Adding a tape drive to NetBackup manually” on page 452.

Note: Veritas recommends that you use the Device Configuration Wizard to add
and update tape storage devices.
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To add a robot using the Actions menu

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 On the Actions menu, select New > Robot.

3 In the New Robot dialog box, specify the properties for the robot.

The properties you can configure depend on the robot type, the host type, and
the robot control.

See “Robot configuration options” on page 446.
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4 After you specify properties, click OK.

After you click OK, the Stop/Restart Media Manager Device Daemon dialog
box appears.

5 If you intend to make other changes, click Cancel in the Stop/Restart Media
Manager Device Daemon dialog box. You can restart the Device Manager or
the device daemon after you make the final change.

If the device changes are complete, restart the device daemon by clickingOK
in the Stop/Restart Media Manager Device Daemon dialog box.

If you restart the device daemon, any backups, archives, or restores that are
in progress also may be stopped.

Robot configuration options
The following topics describe the robot properties that you can configure. The
properties that you can configure depend on the robot type, host type, and robot
control selections that you make in the dialog box.

Device host (robot configuration option)
Specifies the host to which the device is attached.

Robot type (robot configuration option)
Specifies the type of robot. To locate the robot type to use for specific vendors and
models, see the Veritas compatibility list website:

http://www.netbackup.com/compatibility

Robot number (robot configuration option)
Specifies a unique, logical identification number for the robotic library. This number
identifies the robotic library in displays (for example, TLD (21)) and is also used
when you add media for the robot.

■ Robot numbers must be unique for all robots on all hosts in the configuration,
regardless of the robot type or the host that controls them. For example, if you
have two robots, use different robot numbers even if different hosts control them.

■ If you add a robot that is controlled by a remote device host, use the same robot
number for that robot on all device hosts.

■ If the robot has its robotic control and drives on different hosts, specify the same
robot number in all references to that library. That is, use the same robot number
on the hosts with the drives as you do on the host that has the robotic control.
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A Tape Library DLT robot is one that allows separate robotic control and drive
hosts.
Examples are available in theNetBackup Device Configuration Guide, available
at the following URL:
http://www.veritas.com/docs/DOC5332

Robot control (robot configuration options)
The Robot control section of the dialog box specifies the type of control for the
robot. The options that you configure depend on the robot type and the media server
type.

Table 9-3 Robot configuration properties

DescriptionProperty

Specifies that an NDMP host controls the robot.

You must configure other options (depending on the robot type and device host type).

Robot control is
attached to an NDMP
host

Specifies that the host to which the robot is attached controls the robot.

You must configure other options (depending on the robot type and device host type).

Robot is controlled
locally by this device
host

Specifies that a host other than the device host controls the robot.

You must configure other options (based on the selected robot type and device host platform).

Robot control is
handled by a remote
host
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Table 9-3 Robot configuration properties (continued)

DescriptionProperty

Specifies the name of the Sun StorageTek ACSLS host; the ACS library software resides
ACSLS host. On some UNIX server platforms, this host can also be a media server.

The ACS library software component can be any of the following:

■ Automated Cartridge System Library Software (ACSLS)
Examples are available in the NetBackup Device Configuration Guide, available at the
following URL:
http://www.veritas.com/docs/DOC5332

■ STK Library Station
■ Storagenet 6000 Storage Domain Manager (SN6000).

This STK hardware serves as a proxy to another ACS library software component (such
as ACSLS).

Note: If the device host that has drives under ACS robotic control is a Windows server, STK
LibAttach software must also be installed. Obtain the appropriate LibAttach software from
STK.

For compatibility information, see the Hardware Compatibility List:

http://www.netbackup.com/compatibility

An overview of ACS robots is available in theNetBackup Device Configuration Guide, available
at the following URL:

http://www.veritas.com/docs/DOC5332

ACSLS host

The following applies only to a TLH robot:

For UNIX device hosts, specifies the library name that is configured on the UNIX host.

For Windows devices hosts, do the following:

■ Determine the library name by viewing the C:\winnt\ibmatl.conf file.
For example, in the following example entry in that file, 3494AH is the library name:
3494AH 176.123.154.141 ibmpc1

■ Enter the library name.

An overview of TLH robots is available in the NetBackup Device Configuration Guide. See
the NetBackup Device Configuration Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

Library name

Specifies the name of the Library Manager Control Point device file name for TLH robot types.
Use the same name that is configured on the AIX device host.

LMCP device file

Specifies the name of the NDMP host to which the robot is attached.NDMP host name
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Table 9-3 Robot configuration properties (continued)

DescriptionProperty

Specifies the host that controls the robot.

The name of the host on which the robot information is defined for TL8, TLD, or TLH robots.

Robot control host

The following applies to a Windows device host only. Specifies the name of the robot device.

Click Browse and then select a robot from the list that appears in the Devices dialog box.

If the discovery operation fails to discover a robot, clickMore in the Devices dialog box. Enter
either the Port, Bus, Target, and LUN numbers or the device name in the next dialog box.
If the browse operation fails for any other reason, a dialog box appears that lets you enter
the information.

Use the Windows management tools to find the Port, Bus, Target, and LUN numbers.

If the browse operation does not find attached robots, an error dialog box appears.

Robot device

UNIX device host only. Specifies the device file that is used for SCSI connections. The device
files are located in the /dev directory tree on the device host.

To specify the robotic device file, click Browse and then select a robotic device file from the
list that appears in the Devices dialog box.

If the browse operation fails to show all of the attached robots, click More. Enter the path of
the device file in the robotic device file field.

If the browse operation fails to show all of the attached robots, click Other Device. Enter the
path of the device file in the next dialog box.

If the browse operation does not find attached robots, an error dialog box appears.

Information about how to add device files is available in the NetBackup Device Configuration
Guide. See the NetBackup Device Configuration Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

Robotic device file

NDMP host only. Specifies the name of the robotic device that is attached to the NDMP host.Robot device path

Windows hosts only. The Port, Bus, Target, and LUN are the SCSI coordinates for the robotic
device. To specify the SCSI coordinates of the device, enter the Port, Bus, Target, and LUN.

Port, Bus, Target,
LUN

Managing robots
You can perform various tasks to manage your robots.

Changing robot properties
Use the following procedure to change the configuration information for a robot.
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To change robot properties

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices > Robots.

2 In the Robots pane, select the robotic library you want to change.

3 Click Edit > Change.

4 In the Change Robot dialog box, change the properties as necessary.

The properties that you can change depend on the robot type, the host type,
and the robot control.

See “Robot configuration options” on page 446.

5 If the device changes are complete, select Yes on theRestart DeviceManager
dialog box or the Media and Device Management dialog box to restart the
Device Manager or the device daemon.

If you intend to make other changes, click No; you can restart the Device
Manager or the device daemon after you make the final change.

If you restart the Device Manager or the device daemon, any backups, archives,
or restores that are in progress also may be stopped.

Deleting a robot
Use the following procedure to delete a robot or robots when the media server is
up and running.

Any drives that are configured as residing in a robot that you delete are changed
to standalone drives.

Any media in the deleted robot is also moved to standalone. If the media is no
longer usable or valid, delete it from the NetBackup configuration.

See “Deleting a volume” on page 534.

If the media server is down or the host has failed and cannot be recovered, you
can delete its robots by using a different procedure.

See “Deleting all devices from a media server” on page 417.

To delete a robot

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 Select Robots in the tree pane.

3 In the Robots pane, select the robot or robots you want to delete.
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4 On the Edit menu, select Delete.

5 At the prompt, click Yes.

Moving a robot and its media to a new media server
Use the following process to move a robot and its media from one server (the
old_server) to a different media server (the new_server).

Table 9-4 Move a robot and media to a new server overview

ProcedureTask

Run the following bpmedialist command:

bpmedialist -mlist -l -h old_server

The -l option produces one line of output per tape.

Determine which tapes on the old_server
contain NetBackup images that have not
expired.

See “Moving volumes by using the Actions menu” on page 546.Move the tapes in the robot that is attached to
the old_server to non-robotic status
(standalone).

If both the old_server and the new_server are at NetBackup 6.0 or
later, run the following command:

bpmedia -movedb -allvolumes -oldserver old_server
-newserver new_server

If either server runs a NetBackup version earlier than 6.0, run the
following command for each volume that has active images:

bpmedia -movedb -ev media_ID -oldserver old_server
-newserver new_server

For themedia that has active images, see the bpmedialist command
output from the first step of this process.

Move the media logically from the old_server
to the new_server.

See “Forcing restores to use a specific server” on page 135.Configure NetBackup so that restore requests
are directed to the new_server.

See the vendor's documentation.Shut down both the old_server and the
new_server.

See the vendor's documentation.Disconnect the robot from the old_server.

See the vendor's documentation.Connect the robot to the new_server. Verify
that the operating system on the new media
server recognizes the robots.

See “Creating a storage unit” on page 590.Create the appropriate NetBackup storage
units.
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Table 9-4 Move a robot and media to a new server overview (continued)

ProcedureTask

See “Updating the NetBackup volume configuration with a robot's
contents” on page 569.

Inventory the robots that are attached to the
new_server. The inventory updates the
location of all tapes in the robot.

Adding a tape drive to NetBackup manually
Use the following procedures to add a tape drive manually.

Note: Veritas recommends that you use the Device Configuration Wizard to add
and update tape storage devices.

To add a drive using the Actions menu

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 On the Actions menu, select New > Tape Drive.
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3 For the drive name, do one of the following:

■ Enter a name for the drive in the Drive name field.
See “Drive name (tape drive configuration option)” on page 453.

■ Select Use drive name rules. This option uses rules to name the drive
automatically.
See “About drive name rules” on page 442.
See “Configuring drive name rules” on page 457.

4 To configure the host and the path information, click Add in the Host and path
information area of the dialog box.

See “Host and path information (tape drive configuration options)” on page 454.

5 In the Drive information area of the dialog box, configure the drive properties.

The properties depend on the drive type and host server type.

See “Drive information (tape drive configuration options)” on page 454.

6 After you configure all of the properties, click OK.

7 If the device changes are complete, select Yes on theRestart DeviceManager
dialog box or the Media and Device Management dialog box to restart the
Device Manager or the device daemon.

If you intend to make other changes, click No; you can restart the Device
Manager or the device daemon after you make the final change.

If you restart the Device Manager or the device daemon, any backups, archives,
or restores that are in progress also may be stopped.

Tape drive configuration options
You can specify properties when you add a tape drive or change the properties of
a drive. The properties that you can specify depend on the drive type, server
platforms, or NetBackup server types.

Drive name (tape drive configuration option)
Specifies the name of the drive. Each drive name must be unique. Veritas
recommends that you use descriptive names. Drive names are limited to 48
characters.

Alternatively, use the drive name rules to create a unique drive name.
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Use drive name rules (tape drive configuration option)
Adds a drive only. Select to use drive name rules to assign names to drives
automatically.

To configure drive name rules, click Configure.

See “About drive name rules” on page 442.

See “Configuring drive name rules” on page 457.

Host and path information (tape drive configuration
options)
Use the Host and path information group box to add or change paths to the drive.
You can specify multiple paths to the same physical device. If you specify multiple
paths for a drive, it becomes a shared drive.

To add a drive path, click Add.

To change a drive path, click Change.

To delete a drive path, click Remove.

See “About SCSI reserve on drive paths” on page 459.

See “Drive path options” on page 459.

Drive information (tape drive configuration options)
The Drive information group box includes drive properties. The properties that
you can specify depend on the drive type, server platforms, and NetBackup server
types.

The following table describes the tape drive configuration options.
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Table 9-5 Tape drive configuration options

DescriptionOption

Specifies the type of drive. The following are the valid drive types:

■ 4MM (4mm cartridge)
■ 8MM (8mm cartridge)
■ 8MM2 (8mm cartridge 2)
■ 8MM3 (8mm cartridge 3)
■ DLT (DLT cartridge)
■ DLT2 (DLT cartridge 2)
■ DLT3 (DLT cartridge 3)
■ DTF (DTF cartridge)
■ HCART (1/2-inch cartridge)
■ HCART2 (1/2-inch cartridge 2)
■ HCART3 (1/2-inch cartridge 3)
■ QSCSI (1/4-inch cartridge)

Drive type

Specifies that the drive is in a robot. If the drive is a standalone drive (it is not in a robot), do
not select this option.

If you select this option, configure the Robotic library and Robot drive number fields.

Drive is in a robotic
library

Specifies the frequency-based cleaning for the drive. NetBackup does not support drive cleaning
in some robot types.

If you want to configure a frequency-based cleaning schedule for the drive, set the number of
mount hours between each drive cleaning. When you add a drive or reset the mount time to
zero, NetBackup records the amount of time that volumes have been mounted in that drive.
The default frequency is zero.

When the accumulated mount time exceeds the time you specify for the cleaning frequency,
drive cleaning occurs if the following are true:

■ If the drive is in a robotic library that supports drive cleaning
■ If a cleaning cartridge is defined in that robotic library
■ If the cleaning cartridge is compatible with the drive that needs to be cleaned
■ If the cleaning cartridge has a nonzero number of cleanings that remain

NetBackup resets the mount time when the drive is cleaned.

Drives can also be cleaned from the Device Monitor.

If you do not specify a cleaning frequency, you can still use automated drive cleaning with the
TapeAlert feature. Information about TapeAlert drive cleaning is available.

See the NetBackup Administrator's Guide, Volume II:

http://www.veritas.com/docs/DOC5332

Cleaning Frequency
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Table 9-5 Tape drive configuration options (continued)

DescriptionOption

On UNIX only.

Specifies the availability of the drive.

When you add a drive, the default drive status is UP, which means the drive is available. When
a drive is UP, the default mode is AVR (Automatic Volume Recognition).

To change the drive status, click UP or DOWN.

You can also change the drive status by using the commands on the Actionsmenu in Device
Monitor.

Drive Status

A read-only field that shows the serial number of the drive.Serial Number

Specifies a robot that controls the drive. You can select any configured robot that can control
the drive.

Robotic library

Specifies the physical location in the robot of the drive. When you add more than one drive to
a robot, you can add the physical drives in any order. For example, you can add drive 2 before
drive 1.

The correct robot drive number is critical to the proper mounting and utilization of media. You
must determine which logical device name (Windows) or the device file (UNIX) identifies which
physical drive in the robot. You should correlate the drive serial number with drive serial number
information from the robot, as follows:

■ On Windows: You must determine which physical drive in the robot is identified by the
logical device name.
See “Correlating tape drives and SCSI addresses on Windows hosts” on page 461.

■ On UNIX: You must determine which physical drive in the robot is identified by the device
file name.
See “Correlating tape drives and device files on UNIX hosts” on page 463.

NetBackup does not detect incorrect drive number assignment during configuration; however,
an error occurs when NetBackup tries to mount media on the drive.

Note: The Robot drive number property does not apply when you add drives to API robots.
API robots are ACS, TLH, and TLM type in NetBackup.

Robot drive number
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Table 9-5 Tape drive configuration options (continued)

DescriptionOption

Specify the drive locations within an ACS robot.

The following information applies only to the ACS robot drive. The ACS property specifies the
physical location of the drive within the robot. During installation, the correlation between the
physical drive in the robot and the device file you specified earlier represents. You establish
this correlation during installation.

The drive location properties are as follows:

■ ACS Number - specifies the index (in ACS library software terms) that identifies the robot
that has this drive.

■ LSM Number - specifies the Library Storage Module that has this drive.
■ Panel Number - specifies the robot panel where this drive is located.
■ Drive Number - specifies the physical number of the drive (in ACS library software terms).

ACS, LSM, Panel,
Drive

Specifies the IBM device number of the drive within the robot. This property applies only to
the TLH robot drive.

IBM device number

Specifies the DAS/SDLC drive name of the drive within the robot. This property applies only
to the TLM robot drive.

DAS drive name

Configuring drive name rules
Use the following procedure to configure the rules that NetBackup uses to name
tape drives. The procedure describes how to configure the rules in the NetBackup
Administration Console.

Alternatively, if you use the NetBackup Device Configuration Wizard, click
Configure Drive Name Rules in the Device Hosts screen. The same Configure
Drive Name Rules dialog box that is described in the following procedure.

To configure drive name rules

1 In the NetBackup Administration Console, expand Media and Device
Management > Drives.

See “Adding a tape drive to NetBackup manually” on page 452.

2 On the Actions menu, select New > Tape Drive.
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3 In the New Drive dialog box, click Configure.

4 In theConfigure Drive NameRules dialog box, configure the rules for naming
drives:

■ To change the global rule, select Global Rule.

■ To create a local rule, select the check box for the device host.

■ Select the fields from which to create the drive name from the list of available
fields. Click Add>> to make a field part of the rule.

■ To add own text to the drive name rule, enter the text in the Custom Text
field and click the Add button.

■ Use theMove Up andMove Down buttons to change the order of the fields
that are defined for the rule.

■ Click Create Rule to finalize the rule.

If you use <host name> in the rule and the drive is a shared drive, the name
of the first host that discovers the drive is used as the host name. The name
for a shared drive must be identical on all servers that share the drive.

See “About drive name rules” on page 442.

458Configuring robots and tape drives
Configuring drive name rules



Adding a tape drive path
Usually, you add a tape drive path when you add a drive to NetBackup. Use the
following procedure to add a drive path.

To add a tape drive path

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices > Drives.

2 Select Add a New Drive. In the dialog box, click Add.

3 In the Add Path dialog box, configure the properties for the drive path.

The properties that you can specify depend on drive type, server platform, or
NetBackup server type.

See “About SCSI reserve on drive paths” on page 459.

See “Drive path options” on page 459.

About SCSI reserve on drive paths
NetBackup lets you configure exclusive access protection to tape drives so that
other host bus adaptors (HBAs) cannot control the drives during the reservation.
The Enable SCSI Reserve host property configures the protection for each media
server.

See “Media properties” on page 163.

More information about howNetBackup reserves drives is available in theNetBackup
Administrator's Guide, Volume II:

http://www.veritas.com/docs/DOC5332

Drive path options
The following table describes the options to add a drive path.

Table 9-6 Add drive path options

DescriptionOption

Specifies the device host for the drive.Host name (Windows)

Device host (UNIX)

Specifies that the path is active and that NetBackup can use it for backups and restores.Enable host path
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Table 9-6 Add drive path options (continued)

DescriptionOption

Specifies the NDMP host for the device (if an NDMP host is configured in your NetBackup
environment).

See the NetBackup for NDMP Administrator’s Guide for additional information about NDMP
drives:

http://www.veritas.com/docs/DOC5332

NDMP host

Specifies the SCSI reserve override setting for the drive path.

■ Server Default. Use the SCSI reserve protection setting configured for the media server.
If the media server default is no protection, other HBAs can send the commands that can
cause a loss of data to the tape drives.

■ SPC-2 SCSI Reserve. This option provides SCSI reserve and release protection for the
SCSI devices that conform to the reserve and the release management method. That
method is defined in the SCSI Primary Commands - 2 (SPC-2) standard.

■ SCSI Persistent Reserve. This option provides SCSI persistent reserve in and persistent
reserve out protection for the SCSI devices that conform to the SCSI Primary Commands
- 3 (SPC-3) standard.

Global SCSI reserve properties are configured in the Media host properties.

See “Media properties” on page 163.

Override SCSI Reserve
settings

On UNIX hosts.

Specifies the path of the character-mode, no rewind device file on the specified host.

You can either type-in or browse and select one of the existing devices on the host. The
Browse button is not available if the This path is for a Network Attached Storage Device
option is selected.

See “About no rewind device files on UNIX” on page 461.

Device files are in the /dev directory on the UNIX host. If the entries do not exist, see the
NetBackup Device Configuration Guide for information about how to create them:

http://www.veritas.com/docs/DOC5332

Path

On Windows hosts.

You can browse and select one of the existing devices on the host. When you select a device,
Port, Bus, Target, and LUN are auto-filled. The Browse button is not available if the This
path is for a Network Attached Storage Device option is selected.

To specify the SCSI coordinates of the device, enter the Port, Bus, Target, and LUN.

The device attributes on Windows systems cannot change during a NetBackup operation.

Port, Bus, Target, and
LUN
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Table 9-6 Add drive path options (continued)

DescriptionOption

Specifies that the path is for a Network Attached Storage (NAS) device.This path is for a
Network Attached
storage device

About no rewind device files on UNIX
Although both rewind and no rewind on close device files are usually available,
NetBackup requires only the no rewind device file. A no rewind device remains at
its current position on a close operation. On some versions of UNIX, the device file
name may be preceded or followed by the letter n.

Device files are in the /dev directory on the UNIX host. If the entries do not exist,
you must create them. See the NetBackup Device Configuration Guide, available
at the following URL:

http://www.veritas.com/docs/DOC5332

Adding a shared tape drive to a NetBackup
environment

Veritas recommends that you use the Device Configuration Wizard to add,
configure, and update shared drives. TheNetBackupDevice ConfigurationWizard
is the easiest method for adding shared drives in a Shared Storage Option
configuration.

For more information about the Shared Storage Option, see the NetBackup
Administrator's Guide, Volume II:

http://www.veritas.com/docs/DOC5332

Correlating tape drives and SCSI addresses on
Windows hosts

If your tape drives do not support device serialization, you may have to determine
which logical device name or SCSI address matches the physical drive. You also
may have to do so if you add the tape drives manually.
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To correlate tape drives and SCSI addresses on Windows hosts

1 Note the SCSI target of the drive.

2 Correlate the SCSI target to the drive address by using the robot’s interface
panel. Alternatively, examine the indicators on the rear panel of the tape drive.

3 Determine the physical drive address (for example, number) by checking labels
on the robot.

4 Configure the robot in NetBackup and then add the drives.

When you add the drives, ensure that you assign the correct drive address to
each set of SCSI coordinates.

Optionally, use the appropriate NetBackup robotic test utility to verify the
configuration.

Information about the robotic test utilities is available.

See NetBackup Troubleshooting Guide:

http://www.veritas.com/docs/DOC5332

To verify the device correlation Windows

1 Stop the NetBackup Device Manager (ltid).

2 Restart ltid, which starts the Automatic Volume Recognition process (avrd).
Stop and restart ltid to ensure that the current device configuration has been
activated.

If robotic control is not local to this host, also start the remote robotic control
daemon.

3 Use the robotic test utility to mount a tape on a drive.

4 Use the NetBackup Device Monitor to verify that the tape was mounted on the
correct robot drive.

For Windows hosts only.

Assume that a TLD robot includes three drives at the following SCSI addresses:

5,0,0,0Drive 1

5,0,1,0Drive 2

5,0,2,0Drive 3

Windows device correlation example
Also assume that you requested that the tape be mounted on drive 1.
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If the SCSI coordinates for the drive are configured correctly, the Administration
Console Device Monitor shows that the tape is mounted on drive 1.

If the Device Monitor shows that the tape is mounted on a different drive, the SCSI
coordinates for that drive are not correctly configured. For example, if the Device
Monitor shows that the tape is mounted on drive 2, the SCSI coordinates for drive
1 are incorrect. Replace the drive 1 SCSI coordinates (5,0,0,0) with the correct
SCSI coordinates (5,0,1,0) for drive 2. You also know that the SCSI coordinates
for drive 2 are incorrect. Possibly, the SCSI coordinates were swapped during
configuration.

Use the robotic test utility to unload and unmount the tape from drive 1. Repeat the
test for each drive.

If the data path to the drive in which the tape is mounted is not on the robot control
host, you may have to unload the drive. To do so, use a command on another host
or use the drive’s front panel.

Correlating tape drives and device files on UNIX
hosts

If your tape drives do not support device serialization, you may have to determine
which device file or SCSI address matches the physical drive. You also may have
to do so if you add the tape drives manually.

Correlate device files to physical drives when you create the device files for each
drive.

To correlate tape drives and device files on UNIX

1 Determine the physical location of each drive within the robotic library. The
location usually is shown on the connectors to the drives or in the vendor’s
documentation.

2 Physically connect the drives to SCSI adapters in the host.

3 Record the adapter and SCSI addresses to which you connected each drive.
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4 Create device files for each drive by using the SCSI addresses of the drives
and adapters.

Add the device file by using the notes from a previous step to complete the
correlation between device files and physical drive location.

5 Configure the robot in NetBackup and then add the drives.

When you add the drives, verify that you assign the correct drive address (for
example, robot drive number) to each device path.

Optionally, use the appropriate NetBackup robotic test utility to verify the
configuration.

Information about the robotic test utilities is available.

See NetBackup Troubleshooting Guide:

http://www.veritas.com/docs/DOC5332

To verify the device correlation on UNIX

1 Stop the NetBackup device daemon (ltid).

2 Start ltid, which starts the Automatic Volume Recognition daemon (avrd).
Stop and restart ltid to ensure that the current device configuration is activated.

If robotic control is not local to this host, also start the remote robotic control
daemon.

3 Use the robotic test utility to mount a tape on a drive.

4 Use the NetBackup Administration Console Device Monitor to verify that
the tape was mounted on the correct robot drive.

UNIX device correlation example
On UNIX only.

Assume a TLD robot includes three drives and the operating system includes the
following device paths:

/dev/rmt/0cbnDrive 1

/dev/rmt/1cbnDrive 2

/dev/rmt/3cbnDrive 3

Also assume that you requested that the tape be mounted on drive 1.
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If the device path for the drive is configured correctly, the NetBackup
Administration Console Device Monitor shows that the tape is mounted on drive
1.

If the Device Monitor shows that the tape is mounted on a different drive, the device
path for that drive is not configured correctly. For example, if the Device Monitor
shows that the tape is mounted on Drive 2, the device path for drive 1 is incorrect.
Replace the drive 1 device path (/dev/rmt/0cbn) with the correct device path
(/dev/rmt/1cbn) for drive 2. You may need to use a temporary device path while
you make these changes. You also know that the device path for drive 2 is incorrect.
Possibly, the device paths were swapped during configuration.

Use the robotic test utility to unload and unmount the tape from drive 1. Repeat the
test for each drive.

If the path to the drive where the tape is mounted is not on the host with direct
robotic control, you may have to unload the drive with a command from another
host or from the drive’s front panel.

Managing tape drives
You can perform various tasks to manage tape drives.

Changing a drive comment
You can change the comment that is associated with a drive. Drive comments
appear in the Drive Status pane.

To change a drive comment

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive or select multiple drives.

4 On theActionsmenu, selectChange Drive Comment. The dialog box shows
the current comment (if any is currently configured).

5 (Shared Storage Option.) For a shared drive, select the host and the device
path to the selected drive that you want to change. You can change the
comment for any or all of the host and the device paths.

6 Add a comment or change the current drive comment.

See “NetBackup naming conventions” on page 1163.

7 Click OK.
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About downed drives
NetBackup downs a drive automatically when there are read or write errors that
surpass the threshold within the time window. The default drive error threshold is
2. That is, NetBackup downs a drive on the third drive error in the default time
window (12 hours).

Common reasons for write failures are dirty write heads or old media. The reason
for the action is logged in the NetBackup error catalog (view the Media Logs report
or the All Log Entries report). If NetBackup downs a device, it is logged in the system
log.

You can use the NetBackup nbemmcmd command with the -drive_error_threshold
and -time_window options to change the default values.

Additional information about nbemmcmd is available.

See the NetBackup Commands Reference Guide:

http://www.veritas.com/docs/DOC5332

To reverse a down action, in the NetBackup Administration Console, expand
Media and Device Management > Device Monitor to set the device to Up.

See “Changing a drive operating mode” on page 466.

Changing a drive operating mode
Usually you do not need to change the operating mode of a drive. When you add
a drive, NetBackup sets the drive state to UP in Automatic Volume Recognition
(AVR) mode. Other operating mode settings are used for special purposes.

The drive operating mode is displayed and changed in theDevice Monitorwindow.

To change the mode of a drive

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive or select multiple drives.

4 From the Actions menu, choose the command for the new drive operating
mode.

Note that Up Drive, Operator control applies only to standalone drives.

5 If the drive is configured with multiple device paths or is a shared drive (Shared
Storage Option), a dialog box appears that contains a list of all device paths
to the drive. Select the path or paths to change.

6 Click OK.
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Changing a tape drive path
Use the following procedure to change a drive path.

See “Changing a drive path operating mode” on page 467.

To change a drive path

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices > Drives. Double-click the drive that you want to
change.

2 In the Change Tape Drive dialog box, select the drive path in the Host and
Path information list. Click Change.

3 In the Change Path dialog box, configure the properties for the drive path.

The properties you can change depend on drive type, server platform, or
NetBackup server type.

See “About SCSI reserve on drive paths” on page 459.

See “Drive path options” on page 459.

4 Click OK to save the changes.

Changing a drive path operating mode
In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor. In the right pane of the Device Monitor dialog
box, the Drive Paths pane shows path information for drives if one of the following
is true:

■ Multiple (redundant) paths to a drive are configured

■ Any drives are configured as shared drives (Shared Storage Option)

To change a drive path operating mode

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Paths pane, select a path or select multiple paths.

4 On the Actions menu, choose a command for the path action, as follows:

■ Up Path

■ Down Path

■ Reset Path
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Changing tape drive properties
Use the following procedure to change the configuration information for a drive.

To change drive properties

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices > Drives.

2 In the details pane, select the drive you want to change.

3 Click Edit > Change.

4 In the Change Tape Drive or the Change Drive dialog box, change the
properties of the drive.

The properties depend on the drive type and host server type.

See “Tape drive configuration options” on page 453.

5 If the device changes are complete, select Yes on theRestart DeviceManager
dialog box or the Media and Device Management dialog box to restart the
Device Manager or the device daemon.

If you intend to make other changes, click No; you can restart the Device
Manager or the device daemon after you make the final change.

If you restart the Device Manager or the device daemon, any backups, archives,
or restores that are in progress also may be stopped.

The initial drive status is UP, so the drive is available as soon as you restart
the device daemon.

6 After you change the properties, click OK.

Changing a tape drive to a shared drive
Change a drive to a shared drive by adding paths to a currently configured drive.

To configure and use a shared drive, a Shared Storage Option license is required
on each master server and media server.

To change a drive to a shared drive

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 Select Drives in the tree pane.

3 Select the drive you want to change in the Drives pane.

4 Click Edit > Change.

468Configuring robots and tape drives
Managing tape drives



5 In the Change Tape Drive dialog box, click Add.

6 In the Add Path dialog box, configure the properties for the hosts and paths
that share the drive.

Cleaning a tape drive from the Device Monitor
When you add a drive to NetBackup, you can configure the automatic,
frequency-based cleaning interval.

You can also perform an operator-initiated cleaning of a drive regardless of the
cleaning frequency or accumulated mount time of the drive. However, appropriate
cleaning media must be added to NetBackup.

After you clean a drive, reset the mount time.

See “Resetting the mount time of a drive” on page 471.

See the NetBackup Administrator's Guide, Volume I:

http://www.veritas.com/docs/DOC5332

Drive cleaning functions can also be performed from the Activity Monitor.

See “Cleaning tape drives from the Activity Monitor” on page 1126.

To clean a tape drive

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If a license that activates disk-based features is installed, select the Drives
tab.

3 In the Drive pane, select the drive to clean.

4 On the Actions menu, expand Drive Cleaning > Clean Now. NetBackup
initiates drive cleaning regardless of the cleaning frequency or accumulated
mount time.

TheClean Now option resets themount time to zero, but the cleaning frequency
value remains the same. If the drive is a standalone drive and it contains a
cleaning tape, NetBackup issues a mount request.

5 For a shared drive (Shared Storage Option), do the following:

In the list of hosts that share the drive, choose only one host on which the
function applies. TheClean Now function can take several minutes to complete,
so the cleaning information in theDrive Details dialog box may not be updated
immediately.
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Deleting a drive
Use the following procedure to delete a drive or drives when the media server is
up and running.

If the media server is down or the host has failed and cannot be recovered, you
can delete its drives by using a different procedure.

See “Deleting all devices from a media server” on page 417.

To delete a drive

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 Select Drives in the tree pane.

3 Select the drive or drives that you want to delete from the Drives pane.

4 On the Edit menu, select Delete.

5 At the prompt, click Yes.

Resetting a drive
Resetting a drive changes the state of the drive.

Usually you reset a drive when its state is unknown, which occurs if an application
other than NetBackup uses the drive. When you reset the drive, it returns to a known
state before use with NetBackup. If a SCSI reservation exists on the drive, a reset
operation from the host that owns the reservation can help the SCSI reservation.

If the drive is in use by NetBackup, the reset action fails. If the drive is not in use
by NetBackup, NetBackup tries to unload the drive and set its run-time attributes
to default values.

Note that a drive reset does not perform any SCSI bus or SCSI device resets.

Use the following procedure to reset a drive.

To reset a drive

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive or select multiple drives.

4 Select Actions > Reset Drive. If the drive is in use by NetBackup and cannot
be reset, restart the NetBackup Job Manager to free up the drive.

5 Determine which job controls the drive (that is, which job writes to or reads
from the drive).
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6 In the NetBackup Administration Console, click on Activity Monitor. In the
right pane of the Activity Monitor dialog box, select the Jobs tab and cancel
the job.

7 In the Activity Monitor, restart the NetBackup Job Manager, which cancels
all NetBackup jobs in progress.

Resetting the mount time of a drive
You can reset the mount time of the drive. Reset the mount time to zero after you
perform a manual cleaning.

To reset the mount time

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive.

4 Select Actions >Drive Cleaning > Reset Mount Time. The mount time for
the selected drive is set to zero.

5 If you use the Shared drive (Shared Storage Option), do the following:

In the list of hosts that share the drive, choose only one host on which the
function applies.

Setting the drive cleaning frequency
When you add a drive to NetBackup, you configure the automatic, frequency-based
cleaning interval. In the NetBackup Administration Console, expandMedia and
Device Management > Device Monitor to change the cleaning frequency that
was configured when you added the drive.

To set the cleaning frequency

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive.
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4 On the Actions menu, expand Drive Cleaning > Set Cleaning Frequency.

5 Enter a time (hours) or use the arrow controls to select the number of mount
hours between drive cleaning.

The Cleaning Frequency option is not available for the drives that do not
support frequency-based cleaning. This function is not available for shared
drives.

The drive cleaning interval appears in the Drive Details dialog box (Actions
> Drive Details).

Viewing drive details
You can obtain detailed information about drives (or shared drives), such as drive
cleaning, drive properties, drive status, host, and robotic library information.

Use the following procedure to view the drive details.

To view the drive details

1 In the NetBackup Administration Console, select Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Drive Status pane, select a drive.

4 Select Actions > Drive Details.

5 If you use the Shared drive for shared drives, you can view the drive control
mode and drive index for each host that shares a drive. You also can view a
list of hosts that share a drive.

Performing device diagnostics
Diagnostic functions let you run and manage drive and robot diagnostic tests.
Diagnostics are executed in an ordered sequence to verify the functionality of
hardware devices. These tests can help you to troubleshoot drive or robot problems.

Running a robot diagnostic test
Use this procedure to run diagnostic tests on TLD or TL8 robotic libraries.

Ensure that the library to be tested is properly configured for use with NetBackup.
The existing NetBackup robotic control daemons or processes are used for the test.
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Note: NetBackup does not support diagnostic tests for API-attached robotic tape
libraries and other types of SCSI-attached libraries.

To run a robot diagnostic test

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 On the Actions menu, select Robot Diagnostics.

3 In theRobot Diagnostics dialog box, select the media server that is theDevice
Host for the robot that you want to test.

4 In the Robot Name field, select the robot that you want to diagnose.
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5 Click Start to start the diagnostic tests.

The Results window shows results of each step in the test.

Operator intervention is required if the State column of the Results window
containsWaiting. For example, a test step may prompt you to load a new tape
into a drive before the test can continue.

6 If operator intervention is required, select the test step in the Results window
and click Details to determine what you must do. Complete the requested
operation task and then clickContinue in the Test Details dialog box to resume
the test

To stop a test and change the device

1 Click Stop.

The test ends after it performs any necessary clean-up work and updates the
test records to reflect that the test run has been stopped.

2 In the Device Host and the Robot Name boxes, select the host and the robot
that you want to test.

3 Click Start to restart the diagnostic test.

Running a tape drive diagnostic test
NetBackup diagnostic functions let you run andmanage diagnostic tests. Diagnostics
are performed in an ordered sequence to verify the functionality of hardware devices.
These tests can help you to troubleshoot drive problems.

To run a tape drive diagnostic test

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 On the Actions menu, select Drive Diagnostics.

3 In the Drive Diagnostics dialog box, select the media server that contains the
drive that you want to test in the Device Host box.

4 In the Drive Name box, select the drive.
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5 Click Start to start the diagnostic tests.

For robotic drives, the test media is loaded automatically.

For a standalone drive, insert the prelabeled test tape that is shown in the Step
Information column of the Results window.

The Results window shows results of each step in the test.

6 If operator intervention is required, the State column of the Results window
displays Waiting. For example, a test step may require that you to load a new
tape into a drive before the test can continue.

Complete the intervention and then click Continue.

Select the test step in the Results window and click Details to determine what
you must do. Complete the requested operation task and then click Continue
in the Test Details dialog box to resume the test

To stop a test and change the device

1 Click Stop.

The test ends after it performs any necessary clean-up work and updates the
test records to reflect that the test run has been stopped.

2 In the Device Host and the Drive boxes, select the host and the drive that you
want to test.

3 Click Start to restart the diagnostic test.

Managing a diagnostic test step that requires operator intervention
Operator intervention is required if theStatus column of theResults display contains
Waiting. For example, a test step may prompt for a new tape to be loaded into a
drive before the test continues.

To manage a diagnostic step

1 Complete the requested operations task.

2 Click Continue to resume the test.

If you clicked Details for a test step that requires operator intervention, you
can click Continue from the Test Details dialog box.

Obtaining detailed information for a diagnostic test step
You can get information for a test step at any time during the test.
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To obtain detailed information for a diagnostic test step

1 Select a test step in the Results display.

2 Click Details. A dialog box appears that displays information for the step.

The information includes a brief explanation of the checks that are performed
by a specific step and the instructions that are associated with any step that
requires manual intervention. For example, a step may prompt for a new tape
to be loaded into a tape drive before the diagnostic session continues.

3 Click Close to return to the Device Diagnostics dialog box.

Verifying the device configuration
Verify the device configuration by running the Device ConfigurationWizard. However,
some details of a device configuration cannot be validated without attempting tape
mounts. Use the NetBackup robtest utility to mount tapes and validate the
configuration.

To verify robots and drives by using the wizard

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 From the list of wizards in the Details pane, click Configure Storage Devices
and follow the wizard instructions.

About automatic path correction
NetBackup automatic path correction recognizes if you change a device because
the serial number of the new device is different than the serial number of the old
device. NetBackup updates the device configuration automatically.

NetBackup recognizes device changes as follows:

■ When the NetBackupDeviceManager (ltid) performs automatic path correction.
See “About the NetBackup Device Manager” on page 480.

■ When the Windows Plug-n-Play feature performs serial number checks.

By default, Windows and Linux systems are configured for automatic path correction.
On other operating systems, you must enable it.

See “Enabling automatic path correction” on page 477.

In some circumstances, NetBackup may be unable to determine the correct serial
number in a small number of tape drives and robotic libraries. For example,
NetBackup may configure serialized devices as unserialized or configure a device
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with the wrong serial number. If so, a device may be unusable (such as the tape
drive may be downed).

To resolve such a problem, do one of the following actions:

■ Configure the new device by using the NetBackup Device Configuration
Wizard.
The server operating systemmust recognize the device before you can configure
it in NetBackup. Device configuration can require remapping, rediscovery, and
possibly a restart of the operating system.
See theNetBackup Device Configuration Guide, available at the following URL:
http://www.veritas.com/docs/DOC5332

■ Disable the automated device discovery by using the vm.conf file
AUTO_PATH_CORRECTION option.

Enabling automatic path correction
You can enable automatic device path correction in NetBackup. To do so, use the
following procedure.

See “About automatic path correction” on page 476.

To configure automatic path correction

1 Use a text editor to open the following file:

On Windows:

install_path\Veritas\Volmgr\vm.conf

On UNIX:

/usr/openv/volmgr/vm.conf

2 Add the following AUTO_PATH_CORRECTION entry to the file:

AUTO_PATH_CORRECTION = YES

If it already exists but is set to NO, change the value to YES.

3 Save the file and exit the text editor.

Replacing a device
Two processes exist for replacing a device, as follows:

See Table 9-7 on page 478.Replace a device on a single host

See Table 9-8 on page 478.Replace a shared device
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Table 9-7 To replace a device on a single host

InstructionsTask

See “Changing a drive operating mode” on page 466.If the device is a drive, change the drive state to DOWN.

See the vendor's documentation.Replace the device. Specify the same SCSI ID for the new
device as the old device.

See “Changing a drive operating mode” on page 466.If the device is a drive, change the drive state to UP.

See “Configuring robots and tape drives by using the
wizard” on page 443.

If either of the following are true, configure the new device
by using the NetBackup Device Configuration Wizard:

■ You replaced a drive with a different drive type.
■ You replaced a serialized drive with an unserialized

drive.

Table 9-8 To replace a shared device

InstructionsTask

See “Changing a drive operating mode” on page 466.If the device is a drive, change the drive state to DOWN.

See the vendor's documentation.Replace the device. Specify the same SCSI ID for the new
device as the old device.

The following command scans for new hardware and
produces a report that shows the new and the replaced
hardware:

On Windows:

install_path\Veritas\Volmgr\bin\tpautoconf
-report_disc

On UNIX:

/usr/openv/volmgr/bin/tpautoconf
-report_disc

Produce a list of new and missing hardware.

See “Starting or stopping a daemon” on page 1117.Ensure that all servers that share the new device are up
and that all NetBackup services are active.
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Table 9-8 To replace a shared device (continued)

InstructionsTask

If the device is a robot, run the following command:

On Windows:

install_path\Veritas\Volmgr\bin\tpautoconf
-replace_robot robot_number -path
robot_path

On UNIX:

/usr/openv/volmgr/bin/tpautoconf
-replace_robot robot_number -path
robot_path

If the device is a drive, run the following commands:

On Windows:

install_path\Veritas\Volmgr\bin\tpautoconf
-replace_drive drive_name -path path_name

On UNIX:

/usr/openv/volmgr/bin/tpautoconf
-replace_drive drive_name -path path_name

Read the serial number from the new device and update
the EMM database.

See “Configuring robots and tape drives by using the
wizard” on page 443.

If the new device is an unserialized drive, run the
NetBackup Device Configuration Wizard on all servers
that share the drive.

If the new device is a robot, run the NetBackup Device
Configuration Wizard on the server that is the robot
control host.

See “Changing a drive operating mode” on page 466.If the device is a drive, change the drive state to UP.

Updating device firmware
By default, NetBackup recognizes if you update the firmware of a device.

The following table describes an overview of how to update device firmware.
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Table 9-9 How to update device firmware

InstructionsTask

See “Changing a drive operating mode” on page 466.If the device is a drive,
change the drive state to
DOWN.

See the vendor's documentation.Update the firmware.

See “Changing a drive operating mode” on page 466.If the device is a drive,
change the drive state to UP.

About the NetBackup Device Manager
The NetBackup Device Manager (ltid) manages robot and tape processes for
NetBackup. The Device Manager processes requests to mount and unmount tapes
in robotically controlled devices through the robotic control processes. NetBackup
starts ltid on the hosts that have storage devices configured. The Device Manager
starts the VolumeManager (vmd), the automatic volume recognition process (avrd),
and any robotic processes as needed.

In the NetBackup Administration Console, the NetBackup Device Manager is
exposed as follows:

For Windows hosts, as the NetBackup Device
Manager.

For UNIX hosts, as ltid.

In the Activity Monitor

As the Media Manager Device Daemon.On the Actions menu

Note: If you stop and restart the Device Manager, any backups, archives, or restores
that are in progress may fail.

See “Stopping and restarting the device manager” on page 481.

About external access to NetBackup controlled
devices on UNIX

On UNIX hosts, the NetBackup Device Manager restricts access to drives that are
in an UP state by changing the permissions of the device files for those drives. The
Device Manager changes the permissions to 0600 when it starts and back to their
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original settings when it is terminated. The permissions also are returned to their
original settings when a drive’s state is changed to DOWN.

See “About the NetBackup Device Manager” on page 480.

Do not modify the permissions of these device files when the Device Manager is
active. The automatic volume recognition process (avrd) periodically tries to rewind
and read data from media in the drives that are UP and are not currently assigned
in NetBackup.

To ensure reliable operation, do not use UNIX tape and drive commands on the
drives that are UP and controlled by the Device Manager. Users can use the
NetBackup tpreq and tpunmount commands and the drive_mount_notify and
drive_unmount_notify scripts on those drives.

See “NetBackup notify scripts” in the NetBackup Administrator's Guide, Volume II

http://www.veritas.com/docs/DOC5332

Stopping and restarting the device manager
Use the following procedure to stop and restart the NetBackup Device Manager.

See “About the NetBackup Device Manager” on page 480.

To start or stop the Device Manager

1 In the NetBackup Administration Console, expand Media and Device
Management > Devices.

2 On theActionsmenu, select Stop/Restart Media Manager Device Daemon.

3 In the Stop/Restart Media Manager Device Daemon dialog box, do the
following:

In the Device host list, select the media server that you want to restart.1

Select the Action: Start, Stop, or Stop/Restart.

The actions that are available depend on the state of the device manager or
daemon.

2

Select the wantedOptions: Eject media from standalone drive(s) or Enable
verbose logging.

3

Click Apply or OK, depending on the following results:

■ Apply does not close the dialog box so you can select device hosts and
actions for more than another device host.

■ OK closes the dialog box.

4
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Configuring tape media
This chapter includes the following topics:

■ About NetBackup tape volumes

■ About NetBackup volume pools

■ About NetBackup volume groups

■ NetBackup media types

■ About WORM media

■ About adding volumes

■ About configuring media name and attribute rules

■ Adding volumes by using the wizard

■ About media settings rules

■ Configuring media settings

■ About barcodes

■ Configuring barcode rules

■ About media ID generation rules

■ Configuring media ID generation rules

■ About media type mapping rules

■ Adding volumes by using the Actions menu

■ Configuring media type mappings

■ Managing volumes
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■ Managing volume pools

■ Managing volume groups

■ About media sharing

■ Configuring unrestricted media sharing

■ Configuring media sharing with a server group

About NetBackup tape volumes
A tape volume is a data storage tape or a cleaning tape. NetBackup assigns
attributes to each volume and uses them to track and manage the volumes.
Attributes include the media ID, robot host, robot type, robot number, and slot
location.

NetBackup uses two volume types, as follows:

Volumes that are located in a robot.

The robotic library moves the volumes into and out from the
robotic drives as necessary.

Robotic volumes

Volumes that are allocated for the drives that are not in a robot.

Operator intervention is required to load volumes into and eject
volumes from standalone drives.

Standalone volumes

NetBackup uses volume pools to organized volumes by usage.

See “About NetBackup volume pools” on page 483.

You can use WORM media with NetBackup.

See “About WORM media” on page 489.

Volume information is stored in the EMM database.

See “About the Enterprise Media Manager (EMM)” on page 927.

About NetBackup volume pools
A volume pool identifies a set of volumes by usage. Volume pools protect volumes
from access by unauthorized users, groups, or applications. When you add media
to NetBackup, you assign them to a volume pool (or assign them as standalone
volumes, without a pool assignment).

By default, NetBackup creates the following volume pools:
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The default pool to which all backup images are written (unless you
specify otherwise).

NetBackup

For DataStore use.DataStore

For NetBackup catalog backups.

Catalog backup volumes are not a special type in NetBackup. They
are the data storage volumes that you assign to the CatalogBackup
volume pool. To add NetBackup catalog backups, use any of the add
volume methods. Ensure that you assign them to the volume pool
you use for catalog backups. After adding volumes, use the
NetBackup Catalog Backup wizard to configure a catalog backup
policy.

See “About the NetBackup catalog” on page 920.

CatalogBackup

For the volumes that are not assigned to a pool.None

You can add other volume pools. For example, you can add a volume pool for each
storage application you use. Then, as you add volumes to use with an application,
you assign them to that application’s volume pool. You can also move volumes
between pools.

You also can configure a scratch pool from which NetBackup can transfer volumes
when a volume pool has no volumes available.

See “About scratch volume pools” on page 485.

The volume pool concept is relevant only for tape storage units and does not apply
to disk storage units.

You can use any of the approved characters for volume pools names.

See “NetBackup naming conventions” on page 1163.

NetBackup uses several special prefixes for volume pool names.

See “About reserved volume pool name prefixes” on page 484.

Examples of volume pool usage are available in the NetBackup Administrator’s
Guide, Volume II:

http://www.veritas.com/docs/DOC5332

About reserved volume pool name prefixes
NetBackup reserves the following prefixes (case sensitive) for the names of the
volume pools that contain media for specific purposes:
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For volumes on which NetBackup encrypts the data. The volumes in a volume
pool that uses this name prefix must be targeted to encrypting tape drives.

See the NetBackup Security and Encryption Guide.

ENCR

For WORM volumes on which NetBackup encrypts the data. The volumes
in a volume pool that uses this name prefix must be targeted to encrypting
tape drives.

See “About NetBackup encryption options” on page 752.

See the NetBackup Security and Encryption Guide.

See the NetBackup Commands Reference Guide

WENCR

For WORM volumes. NetBackup does not encrypt the data.

See “About using volume pools to manage WORM media” on page 490.

WORM

NetBackup examines the volume pool names to determine if they are special
purpose volume pools. If a volume pool name begins with one of the special prefixes,
NetBackup processes the media in that pool according to the requirements for that
pool. If not, NetBackup does not use special processing for that volume pool’s
media.

When you create a volume pool for any of these purposes, youmust use uppercase
characters. For readability, it may be beneficial to use an underscore character
after the prefix, for example WORM_ or ENCR_.

About scratch volume pools
The scratch pool is an optional pool that contains the media that NetBackup can
allocate to other pools as needed. If you configure a scratch pool, NetBackupmoves
volumes from that scratch pool to other pools that do not have volumes available.

Only one scratch pool is allowed. You cannot add a scratch pool if one exists.

You cannot change theNetBackup orDataStore pools to be scratch volume pools.

If you create a scratch pool, be aware of the following conditions:

■ If the scratch pool contains assigned volumes, these volumes remain in the
scratch pool.
NetBackup does not move assigned volumes to other pools as it does with
unassigned volumes.

■ NetBackup does not assign volumes while they are in a scratch pool.
For example if a NetBackup policy or schedule specifies the scratch pool, all
requests for those volumes are denied.
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■ NetBackup returns expired media to the scratch volume pool automatically
(media that is returned must have been originally in the same scratch pool).

■ To use NetBackup to manage the allocation of volumes to volume pools, do the
following:

■ Create volume pools as required, but do not add any volumes to the pools.

■ Define a scratch pool and add all of the volumes to it. NetBackup moves
volumes to the other pools as volumes are needed.

See “About NetBackup volume pools” on page 483.

See “Configuring media settings” on page 496.

See “About media settings rules” on page 496.

About NetBackup volume groups
A volume group identifies a set of volumes that reside at the same physical location.
The location can be either the robot in which the volumes reside, standalone storage,
or off-site storage if you use the NetBackup Vault option.

When you add media to NetBackup, NetBackup assigns all volumes in a robot to
that robot's volume group. Alternatively, you can assign the media to a different
group.

Volume groups are convenient for tracking the location of volumes, such as the
case when a volume is moved off site. Volume groups let you perform operations
on a set of volumes by specifying the group name rather than each individual media
ID of each volume. Operations include moves between a robotic library and a
standalone location or deletions from NetBackup.

If you move a volume physically, you also must move it logically. A logical move
means to change the volume attributes to show the new location.

The following are the rules for assigning volume groups:

■ All volumes in a group must be the same media type.
However, a media type and its corresponding cleaning media type are allowed
in the same volume group (such as DLT and DLT_CLN).

■ All volumes in a robotic library must belong to a volume group.
You cannot add volumes to a robotic library without specifying a group or having
Media Manager generate a name for the group.

■ The only way to clear a volume group name is to move the volume to standalone
and not specify a volume group.

■ More than one volume group can share the same location.
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For example, a robotic library can contain volumes from more than one volume
group and you can have more than one standalone volume group.

■ All volumes in a group must be in the same robotic library or be standalone.
That is, you cannot add a group (or part of a group) to a robotic library if it already
exists in another robotic library.

Examples of volume group usage are available.

See the NetBackup Administrator’s Guide, Volume II:

http://www.veritas.com/docs/DOC5332

NetBackup media types
NetBackup uses media types to differentiate the media that have different physical
characteristics. Each media type may represent a specific physical media type.

The NetBackup media types are also known as Media Manager media types.

The following table describes the NetBackup media types.

Table 10-1 NetBackup media types

DescriptionMedia type

4MM cartridge tape4MM

4MM cleaning tape4MM_CLN

8MM cartridge tape8MM

8MM cleaning tape8MM_CLN

8MM cartridge tape 28MM2

8MM cleaning tape 28MM2_CLN

8MM cartridge tape 38MM3

8MM cleaning tape 38MM3_CLN

DLT cartridge tapeDLT

DLT cleaning tapeDLT_CLN

DLT cartridge tape 2DLT2

DLT cleaning tape 2DLT2_CLN

DLT cartridge tape 3DLT3
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Table 10-1 NetBackup media types (continued)

DescriptionMedia type

DLT cleaning tape 3DLT3_CLN

DTF cartridge tapeDTF

DTF cleaning tapeDTF_CLN

1/2 inch cartridge tapeHCART

1/2 inch cartridge tape 2HCART2

1/2 inch cartridge tape 3HCART3

1/2 inch cleaning tapeHC_CLN

1/2 inch cleaning tape 2HC2_CLN

1/2 inch cleaning tape 3HC3_CLN

1/4 inch cartridge tapeQCART

NetBackup writes media in a format that allows the position to be verified before
NetBackup appends new backup images to the media.

Note: The user interface for NetBackup may show configuration options for the
media types that are not supported in that release. Those types may be supported
in an earlier release, and a NetBackup master server can manage the hosts that
run earlier NetBackup versions. Therefore, the configuration information for such
types must appear in the user interface. The NetBackup documentation also may
describe the configuration information for such types. To determine which versions
of NetBackup support which media types, see the NetBackup hardware compatibility
list:

http://www.netbackup.com/compatibility

Alternate NetBackup media types
Alternate media types let you define more than one type of tape in the same library.
You can use the alternate types to differentiate between different physical cartridges.

The following are examples of alternate media types:

■ DLT, DLT2, DLT3

■ HCART, HCART2, HCART3
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For example, if a robot has DLT4000 and DLT7000 drives, you can specify the
following media types:

■ DLT media type for the DLT4000 tapes

■ DLT2 media type for the DLT7000 tapes

NetBackup then does not load a tape that was written in a DLT4000 drive into a
DLT7000 drive and vice versa.

You must use the appropriate default media type when you configure the drives.
(When you configure drives in NetBackup, you specify the default media type to
use in each drive type.)

In a robot, all of the volumes (of a specific vendor media type) must be the same
NetBackup media type. For example, for an ACS robot that contains 3490E media,
you can assign either NetBackup HCART, HCART2, or HCART3 media type to that
media. You cannot assign HCART to some of themedia and HCART2 (or HCART3)
to other of the media.

See "Media formats" in the NetBackup Administrator’s Guide, Volume II, available
at the following URL:

http://www.veritas.com/docs/DOC5332

About WORM media
You can use WORM (Write-Once-Read-Many) media to protect key data from
unwanted modification or to meet compliance regulations.

NetBackup uses the QIC/WORM tape format for WORM media. This format lets
NetBackup append images to WORM tape.

See "Media formats" in the NetBackup Administrator’s Guide, Volume II, available
at the following URL:

http://www.veritas.com/docs/DOC5332

Tape error recovery is disabled for WORMmedia. NetBackup has job resume logic,
which tries to resume a job that has been interrupted (such as an interruption on
the Fibre Channel). However, NetBackup fails a job that uses WORM media and
then retries the failed job. Veritas recommends that you use checkpoint and restart
for backups.

The bplabel command labels only LTO-3 WORM tapes. All other WORM media
cannot be labeled because the label cannot be overwritten when the media is used.

The following are the limitations for WORM tape:

■ Third-party copy backups are not supported with WORM media.
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■ NetBackup does not support resume logic with WORM tape. NetBackup fails a
job that uses WORM media and then retries the failed job. Alternatively, if
checkpoint and restart are used, NetBackup restarts the job from the last
checkpoint. Veritas recommends that you use checkpoint and restart for backups.

NetBackup provides two methods to manage WORM media, as follows:

■ Assign a reserved prefix to WORM volume pool names.
See “About using volume pools to manage WORM media” on page 490.

■ Assign a specific drive type to all WORM drives and a specific media type to all
WORM media.
See “About using unique drive and media types to manage WORM media”
on page 491.

About using volume pools to manage WORM media
You can dedicate volume pools for WORM media. This method lets a
WORM-capable tape drive back up and restore standard and WORM media.
NetBackup uses two reserved volume pool prefixes to indicate that the volumes in
a pool are for WORM drives, as follows:

■ WORM (uppercase letters) denotes WORM media.

■ WENCR (uppercase letters) denotesWORMmedia on which NetBackup should
encrypt the data.

See “About reserved volume pool name prefixes” on page 484.

For more information about encrypting data on your media, see the NetBackup
Security and Encryption Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

When you create a volume pool for WORM media, specify one of the reserved
prefixes as the first characters of the pool name. NetBackup examines the volume
pool names to determine if they begin with a reserved prefix. For readability, it may
be beneficial to use an underscore character after the prefix, for exampleWORM_.

See “Adding or deleting a volume pool” on page 549.

Note the following cases:

■ If the drive contains WORM media and the media is in a WORM volume pool,
NetBackup writes the media as WORM.

■ If the drive contains WORM media and the media is not in a WORM volume
pool, NetBackup freezes the media.

■ If the drive contains standard media and the media is in a WORM volume pool,
NetBackup freezes the media.
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■ If the drive contains the Quantum media that has never been used or all of its
NetBackup images have expired, NetBackup uses the media.

See “About using a WORM scratch pool” on page 491.

See “About WORM media” on page 489.

See “About using unique drive and media types to manage WORM media”
on page 491.

About using a WORM scratch pool
For all supported WORM-capable drives (except the Quantum drive), the scratch
pool must only contain one type of media. Veritas recommends that you add the
most commonly used media to the scratch pool. For example, if most NetBackup
jobs use standard media, put standard media in the scratch pool.

If the scratch pool contains standard media, ensure that the WORM volume pool
does not run out of media to complete backup jobs.

If the WORM volume pool runs out of media, NetBackup performs the following
actions:

■ Moves the standard media from the scratch pool into the WORM pool.

■ Loads the standard media into a WORM-capable drive.

■ Freezes the media.

NetBackup repeats this process until all of the standard media in the scratch pool
is frozen.

The opposite also is true. If a standard volume pool runs out of media and the
scratch pool containsWORMmedia, standard backups can fail because appropriate
media are unavailable.

About using unique drive and media types to manageWORMmedia
You can assign a different drive and media type to all WORM drives and media.
For example, configure standard drives and media as HCART andWORM-capable
drives and media as HCART2.

This method lets you add both types of media in the scratch pool because NetBackup
selects the correct media type for the drive type.

However, because each drive is limited to backups and restores with a specific type
of media, optimal drive usage may not be achieved. For example, the
WORM-capable drives cannot be used for backups with standard media even if no
WORM backups are in progress.
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Because Quantum drives use only a single media type, this method for managing
the WORM media is unnecessary.

See “About WORM media and the Quantum drive” on page 492.

If you use unique drive and media types to manage WORM media, disable the
WORM volume pool name verification.

See “Disabling WORM volume pool name verification” on page 492.

Disabling WORM volume pool name verification
If you use unique drive and media types to manage WORM media, disable
NetBackup volume pool name verification. WORM volume pool name verification
is used only for the WORM volume pool method of managing WORM media.

See “About using unique drive and media types to manage WORM media”
on page 491.

See “About using volume pools to manage WORM media” on page 490.

To disable the volume pool name verification

◆ Create the following touch file on the media server of the WORM drive:

On Windows:

install_path\NetBackup\db\config\DISABLE_WORM_POOLCHECK

On UNIX:

/usr/openv/netbackup/db/config/DISABLE_WORM_POOLCHECK

About WORM media and the Quantum drive
When you use the Quantum drive, only one kind of media can be used as either
standard media or WORM media.

If a WORM volume pool runs out of media, media are moved from the scratch
volume pool into the WORM pool. NetBackup determines whether the media are
configured as standard or WORMmedia. For a standard media volume, NetBackup
reads the tape label and verifies that the media is unused or that all images are
expired. NetBackup also verifies that the media is not currently assigned to a server.
After verification, NetBackup configures the media as WORMmedia and continues
with the NetBackup job.

Supported WORM drives
NetBackup requires a SCSI pass-through driver to use WORM tape drives.
NetBackup queries the drive to verify that drive is WORM-capable and that the
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media in the drive is WORM media. SCSI pass-through paths are provided on the
server platforms NetBackup supports. SCSI pass-through paths may require special
operating system configuration changes.

See the NetBackup Device Configuration Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

For information about the drives that NetBackup supports for WORM media, see
the Hardware Compatibility List at the following URL

http://www.netbackup.com/compatibility

All of the vendors except Quantum require the use of special WORM media.

Quantum lets NetBackup convert standard tape media to WORM media. To use
Quantum drives for WORM media on Solaris systems, modify the st.conf file.

Information is available about how to configure nonstandard tape drives and how
to edit the st.conf file.

See the NetBackup Device Configuration Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332

About adding volumes
Adding volumes is a logical operation that assigns NetBackup attributes to physical
media. The media can reside in storage devices already, or you can add them to
the storage devices when you add them to NetBackup. How you add volumes
depends on the type of volume: robotic or standalone.

See “About adding robotic volumes” on page 493.Volumes in a robotic library

See “About adding standalone volumes” on page 494.Standalone volumes

NetBackup uses the rules to assign names and attributes to volumes.

See “About configuring media name and attribute rules” on page 495.

About adding robotic volumes
The robotic volumes are the volumes that are located in a robotic tape library. The
following table describes the methods for adding robotic volumes.
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Table 10-2 Methods for adding robotic volumes

DescriptionMethod

See “Adding volumes by using the wizard”
on page 496.

The Volume Configuration Wizard

See “About robot inventory” on page 556.

See “Updating the NetBackup volume configuration
with a robot's contents” on page 569.

Robot inventory

See “Adding volumes by using the Actions menu”
on page 519.

The Actions menu

See theNetBackup Commands Reference Guide,
available at the following URL:

http://www.veritas.com/docs/DOC5332

NetBackup commands

About adding standalone volumes
Standalone volumes are the volumes that reside in the drives that are not in a robot
or are allocated for standalone drives.

Because NetBackup does not label volumes until it uses them, you can add volumes
even though they do not reside in a drive. The additional volumes are available for
use if the volume in a drive becomes full or unusable. For example, if a volume in
a standalone drive is full or unusable because of errors, NetBackup ejects (logically)
the volume. If you add other standalone volumes, NetBackup requests that volume;
NetBackup does not generate an out of media error.

The easiest way to add standalone volumes is to use the Volume Configuration
Wizard. Then, when NetBackup requests one of the volumes, insert it into the
standalone drive and NetBackup labels it.

The DISABLE_STANDALONE_DRIVE_EXTENSIONS option of the nbemmcmd command
can turn off the automatic use of standalone volumes.

Table 10-3 Methods for adding standalone volumes

DescriptionMethod

See “Adding volumes by using the wizard” on page 496.The Volume Configuration Wizard

See “Adding volumes by using the Actions menu”
on page 519.

The Actions menu
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Table 10-3 Methods for adding standalone volumes (continued)

DescriptionMethod

See the NetBackup Commands Reference Guide,
available at the following URL:

http://www.veritas.com/docs/DOC5332

NetBackup commands

About configuringmedia name and attribute rules
NetBackup uses the default settings and rules to name and assign attributes to
new removeable media. NetBackup uses these rules when you do the following:

■ Use the Volume Configuration Wizard to add new media.

■ Use theRobot Inventory dialog box to inventory a robot. If NetBackup discovers
new media in the robot, it adds that media to NetBackup.

For most configurations, the default settings work well. However, you can change
the default settings and rules that NetBackup uses. Change the settings only if you
have special hardware or usage requirements. You can change the settings from
the Volume Configuration Wizard or from the Robot Inventory dialog box.

The following table shows the rules that you can configure:

Table 10-4 Attributes for media

WhereWhat

See “About media settings rules” on page 496.

See “Configuring media settings” on page 496.

Media settings

See “About barcodes” on page 506.

See “Configuring barcode rules” on page 509.

Barcode rules

See “Aboutmedia ID generation rules” on page 514.

See “Configuring media ID generation rules”
on page 515.

Media ID generation rules

See “Aboutmedia typemapping rules” on page 518.

See “Configuring media type mappings”
on page 523.

Map media for API robots
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Adding volumes by using the wizard
The easiest way to add volumes is to use the Volume Configuration Wizard.
NetBackup assigns media IDs and labels the volumes automatically.

To configure volumes by using the wizard

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Devices.

2 From the list of wizards in the right pane, click Configure Volumes and follow
the wizard instructions.

You can change the default settings and rules that NetBackup uses to name
and assign attributes to new removeable media.

See “About configuring media name and attribute rules” on page 495.

About media settings rules
The NetBackup media settings rules depend on the following:

■ For existing media, the volume group to which the volumes belong.

■ For new media, the media ID prefix, the media type, and the pool to which the
volume should be assigned.

You can change the default rules.

See “Configuring media settings” on page 496.

See “Media settings options” on page 498.

Configuring media settings
Use theMedia Settings tab of the NetBackupAdvancedRobot Inventory Options
dialog box to configure the attributes for existing and new media.

See “About media settings rules” on page 496.

To configure media settings

1 Open the Advanced Robot Inventory Options dialog box, as follows:
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1 In the NetBackup Administration Console, expand
Media and Device Management > Media > Robots in
the left pane.

2 Select the robot that you want to inventory.

3 On the Actions menu, select Inventory Robot.

4 Click either Preview volume configuration changes
or Update volume configuration.

5 Click Advanced Options.

From the Robot
Inventory dialog box

1 In the NetBackup Administration Console, in the left
pane, expand Media and Device Management >
Devices.

2 From the list of wizards in the right pane, click
Configure Volumes and follow the wizard instructions.

3 On the Robot Inventory panel of the Volume
Configuration Wizard, click Advanced Options.

From the Volume
Configuration Wizard

2 In the Advanced Robot Inventory Options dialog box, click the Media
Settings tab.
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3 Configure the settings, as follows:

In theMedia which have been removed from the robot should be assigned
to the volume group list, select a volume group for the media that are removed
from the robot.

See “Media which have been removed from the robot... (existing media setting)”
on page 499.

a.

In the Media which have been moved into or within the robot should be
assigned to the volume group list, select a volume group for the media that
are in or are added to the robot.

See “Media which have been moved into or within the robot... (existing media
setting)” on page 499.

b.

If the robotic library supports barcodes and the volume has readable barcodes,
NetBackup creates media IDs automatically from the barcodes. You do not
need to configure a prefix.

However, if the media in the robotic library has unreadable barcodes or if the
robot does not support barcodes, NetBackup assigns a default media ID prefix.

To use a media ID prefix other than the DEFAULT, click Browse in the Use
the following Media ID prefix field. Then, specify or choose a media ID prefix
in the Media ID Prefix dialog box.

See “Use the following Media ID prefix (new media setting)” on page 500.

c.

To use your barcode rules to assign attributes to new volumes, select Use
barcode rules.

See “Use barcode rules (new media setting)” on page 502.

d.

To override your barcode rules for the new media in the robotic library, select
a Media type from the list.

See “Media type (new media setting)” on page 502.

e.

To override the default volume pool for the new media in the robotic library,
select a Volume pool from the list.

See “Volume pool (new media setting)” on page 505.

f.

4 Click OK.

Media settings options
The following are the settings for the new media in a robot that you add to your
NetBackup volume configuration.
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Media which have been removed from the robot... (existing
media setting)
For the media that already exist in your volume configuration, you can specify the
volume group if the media are removed from the robot. Media which have been
removed from the robot should be assigned to the volume group.

The Media which have been removed from the robot should be assigned to
the volume group drop-down box contains the following selections:

NetBackup automatically generates a new volume group.AUTOGENERATE

If there is an existing group with a compatible residence for the volume,
the volume is added to that group. If a suitable volume group does not
exist, NetBackup generates a new volume group name.

DEFAULT

The media are not assigned to a volume group.NO VOLUME
GROUP

Other selections may be available, depending on the setting of theMedia type field
of the New media section of the dialog box, as follows:

TheMedia which have been removed from the robot should
be assigned to the volume group dropdown box includes the
volume groups that are valid for the robot’s default media type.

If the Media type field is
DEFAULT

TheMedia which have been removed from the robot should
be assigned to the volume group dropdown box includes the
volume groups that are valid for the specified media type.

To specify a volume group other thanDEFAULT, enter a volume
group name or select one from the list.

If the Media type field is
other than DEFAULT

See “Media type (new media setting)” on page 502.

Media which have been moved into or within the robot...
(existing media setting)
You can specify the volume group for the existing media that have been moved
into or within a robot.

The volume group to assign to the existing media that you have inserted into the
robot (or moved to a new location within the robot).

TheMedia which have beenmoved into or within the robot should be assigned
to the volume group drop-down box contains the following selections:
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NetBackup automatically generates a new volume group.AUTOGENERATE

If there is an existing group with a compatible residence for the volume,
the volume is added to that group. If a suitable volume group does not
exist, NetBackup generates a new volume group name.

DEFAULT

The following other selections may be available depending on the setting of the
Media type field of the New media section of the dialog box:

The Media which have been moved into or within the robot
should be assigned to the volume group drop-down box
includes the volume groups that are valid for the robot’s default
media type.

If the Media type field is
DEFAULT

The Media which have been moved into or within the robot
should be assigned to the volume group drop-down box
includes the volume groups that are valid for the specified media
type.

To specify a volume group other thanDEFAULT, enter a volume
group name or select one from the list.

If the Media type field is
other than DEFAULT

If the robotic library contains multiple media types, Veritas recommends a DEFAULT
setting. If you specify a volume group and volumes of different media types were
moved into or within the robot, the new update fails. Volumes of different media
types cannot have the same volume group.

See “Media type (new media setting)” on page 502.

Use the following Media ID prefix (new media setting)
if the media has unreadable barcodes or if the robot does not support barcodes,
by default NetBackup assigns media ID prefixes as follows:

■ If MEDIA_ID_PREFIX entries are defined in the vm.conf file, NetBackup assigns
the last MEDIA_ID_PREFIX entry as the media ID prefix.

■ If no MEDIA_ID_PREFIX entries are defined in the vm.conf file, NetBackup uses
the letter A as the media ID prefix.

To configure NetBackup to use a media ID prefix other than the default, select Use
the following Media ID prefix field in the Advanced Robot Inventory Options
dialog box and then click Browse. The Media ID Prefix dialog box appears.
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Figure 10-1 Media ID Prefix dialog box

The following are the alternative NetBackup media ID assignment behaviors that
you can configure in the dialog box:

Deselect the Use a media ID prefix for media with
unreadable barcodes or if the robot does not support
barcodes option.

To not use a media ID prefix

Select theUse amedia ID prefix formedia with unreadable
barcodes or if the robot does not support barcodes
option.

To use a media ID prefix

Select the Specify the media ID prefix for the current
session only option then enter the media ID prefix. You can
specify a prefix of one to five alphanumeric characters.
NetBackup assigns the remaining numeric characters to
create a six character media ID.

NetBackup uses the prefix only for the current operation.

To use a specific media ID
prefix for the current operation
only

Select the Choose from the Media ID prefix list (stored in
vm.conf file) option and then select the prefix from the list.

To configure a media ID prefix
to use for the current session
and future sessions

Select the Choose from the Media ID prefix list (stored in
vm.conf file) option and then enter the prefix in the New
media ID prefix field. Click Add.

To add a new media ID prefix
to the vm.conf file
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Select the Choose from the Media ID prefix list (stored in
vm.conf file) option, select the prefix from the list, and then
lick Remove.

To remove a media ID prefix
from the vm.conf file

Information about the vm.conf file is available.

See the NetBackup Administrator’s Guide, Volume II:

http://www.veritas.com/docs/DOC5332

Use barcode rules (new media setting)
Specifies whether or not to use barcode rules to assign attributes for new media.

To enable barcode rule support for API robots, add an API_BARCODE_RULES entry
to the vm.conf file.

See “About barcodes” on page 506.

See “Configuring barcode rules” on page 509.

Information about the vm.conf file is available.

See the NetBackup Administrator’s Guide, Volume II, available at the following
URL:

http://www.veritas.com/docs/DOC5332

Media type (new media setting)
Specifies the type for the new media that are added to a robot. The list includes
the media types that are valid for the robot.

How NetBackup determines the new media type depends on the Use barcode
rules setting, as follows:

■ Use barcode rules is selected.
See “Media type when using barcode rules” on page 502.

■ Use barcode rules is not selected.
See “Media type when not using barcode rules” on page 504.

Note: For API robots, the Media type is always set to DEFAULT. To specify a
media type for API robots, use the Media Type Mappings tab of the dialog box.

See “Configuring media type mappings” on page 523.

Media type when using barcode rules
If you use barcode rules in NetBackup, choose one of the following:
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NetBackup uses the barcode rules to determine the media type that is
assigned.

Each media type to be added should have a barcode rule. For example,
assume that you want to add DLT and half-inch cartridges to a TLD
robot with a single update operation. First create separate barcode
rules for DLT and half-inch cartridges and then select the specific media
types when you create the barcode rules. Finally, select DEFAULT on
the Media Settings tab. The correct media type is assigned to each
media.

If you choose DEFAULT on the Media Settings tab and DEFAULT in
the barcode rule, NetBackup assigns the default media type for the
robot.

DEFAULT

You can use a single barcode rule to add media of different types, such
as DLT and half-inch cartridges (HCART) to a TLD robot. First, select
a specific media type on the Media Settings tab. Second, select
DEFAULT for the barcode rule media type when you create the barcode
rule. You can perform one update for DLT and another for half-inch
cartridge, and the barcode rule assigns the correct media type.

If you specify a value other than DEFAULT, the barcode rule media type
must be the same as the media or be DEFAULT. If not, the barcode rule
does not match the media (except for cleaning media).

Table 10-5 shows some combinations of media types on the Media
Settings tab and barcode rule media types for a TLD (non-API) robot.
It also shows the results when the media are added to the volume
configuration.

A specific media
type from the list.

Table 10-5 Example media type and barcode rule combinations

Media type added
to volume
configuration

Rule matches?Barcode rule
media type

Media type on
Media Settings
tab

DLTYesDEFAULTDLT

HCARTYesDEFAULTHCART

DLTYesDLTDLT

DLT_CLNYesDLT_CLNDLT

DLT_CLNNoDLTDLT_CLN

DLT_CLNYesDLT_CLNDLT_CLN

DLT_CLNYesDEFAULTDLT_CLN
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Table 10-5 Example media type and barcode rule combinations (continued)

Media type added
to volume
configuration

Rule matches?Barcode rule
media type

Media type on
Media Settings
tab

DLTNo8MM, 4MM, and so onDLT

DLTYesDEFAULTDEFAULT

DLTYesDLTDEFAULT

DLT_CLNYesDLT_CLNDEFAULT

Depends on robot typeNo8 MM, 4 MM, and so
on

DEFAULT

The fourth row in the table shows how both cleaning cartridges and regular volumes
are added using one update operation.

All the following conditions must be true:

■ The media type on the Media Settings tab is for regular media (DLT, in this
example).

■ The barcode matches a barcode tag.

■ The media type for the barcode rule is cleaning media (DLT_CLN).

Another example is available:

The sixth row and seventh row in the table show how to add only a cleaning tape.
In the sixth row, you specify the cleaning media type on the Media Settings tab
and in the barcode rule. In the seventh, specify the cleaning media on the Media
Settings tab and specify default when you configure the barcode rule.

See “Configuring barcode rules” on page 509.

Media type when not using barcode rules
Choose one of the following if the barcode rules in NetBackup are not used:

NetBackup uses the media type that is configured for the drives if:

■ The drives in the robot are configured on the robot control host
■ All drives the same type
■ At least one drive is configured on the robot control host

If the drives are not the same type, NetBackup uses the default media
type for the robot.

DEFAULT
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If the robot supports multiple media types and you do not want to use
the default media type, select a specific type.

Select a specific media type if: the drives are not configured on the
robot control host and the drives are not the default media type for the
robot.

A specific media
type

The following table shows the default media types for robots when drives are not
configured on the robot control host:

Table 10-6 Default media types for non-API robots

Default media typeRobot type

4 MM cartridge tape.Tape Library 4 MM
(TL4)

8 MM cartridge tape.

Also supports 8 MM cartridge tape 2 and 8 MM cartridge tape 3.

Tape Library 8 MM
(TL8)

DLT cartridge tape.

Also supports the following:

■ DLT cartridge tape 2 and 3, 1/2-inch cartridge tape
■ 1/2-inch cartridge tape 2, 1/2-inch cartridge tape 3
■ 8 MM cartridge tape, 8 MM cartridge tape 2, 8 MM cartridge tape 3
■ DTF cartridge tape
■ 1/4-inch cartridge tape

Tape Library DLT
(TLD)

Volume pool (new media setting)
The volume pool for the new media. The actions depend on whether you use
barcode rules to assign media attributes, as follows:

DEFAULT. If you select DEFAULT and:

■ Use barcode rules, the barcode rules determine the volume pool to
which new volumes are assigned

■ Do not use barcode rules, NetBackup assigns data tapes to the
NetBackup pool but does not assign cleaning tapes to a volume
pool

DEFAULT

If you use barcode rules, this volume pool setting always overrides the
rule.

A specific volume
pool.
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About barcodes
When a robotic library has a barcode reader, it scans the media for barcodes and
saves the results. The results associate the slot number and the barcode with the
media in that slot. NetBackup obtains the barcode and slot information from the
robotic library.

In the robots that have barcode readers, NetBackup verifies the barcode to ensure
that the robot loads the correct volume.

If the barcode on the volume does not match the barcode in the EMM database,
NetBackup does one of the following:

■ Assigns the request a pending status (for media-specific jobs such as a restore)

■ Uses another volume (for backup or duplicate jobs)

If a requested volume is not in a robot, a pending request message appears in the
NetBackup Administration Console Device Monitor.

The operator must find the volume and do one of the following:

■ Check the Device Monitor to find a suitable drive and mount the requested
volume in that drive.

■ Move the volume into the robot, update the volume configuration to reflect the
correct location for the media, and resubmit the request.

If the volume is labeled, the automatic volume recognition daemon reads the label
and the drive is assigned to the request. If the volume is unlabeled and not
associated with a robot, the operator manually assigns the drive to the request.

Barcode advantages
NetBackup functions well whether or not barcodes are used. However, Veritas
suggests using media with barcodes in the robots that can read barcodes.

Barcodes offer the following advantages:

■ Automatic media ID assignment
When you add new media to a robot, NetBackup is able to assign media IDs
according to specified criteria.

■ More accurate tracking of volume location
A robot inventory update can determine which volumes are in a robot.

■ Increased performance
Not using barcodes can adversely affect performance for some robots. A robot
that reads barcodes performs a scan each time it moves a tape. The robot stores
the correct barcode in memory or verifies a previously saved barcode. However,
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if a tape does not have a barcode, the robot retries the scan multiple times,
degrading performance.

Barcode best practices
Consider the following practices when you select barcodes for volumes:

■ Barcodes usually appear on the labels that are attached to the outside of tape
volumes.

■ The maximum barcode length that NetBackup supports depends on the type of
robot.
See theNetBackup Device Configuration Guide, available at the following URL:
http://www.veritas.com/docs/DOC5332

■ Always follow the robotic library vendor’s recommendations when purchasing
barcode labels for use with NetBackup.
Ensure that the barcodes have the correct number of characters.

■ Barcodes can represent any combination of alpha and numeric characters, but
different robots support different lengths of barcodes.
See the robot vendor’s documentation to determine the requirements for a
specific robot type.

■ Use barcodes without spaces (at the beginning, at the end, or between any
characters).
Otherwise, the robot or NetBackup may not read them correctly.

■ Volumes in an API robot have a real or a logical barcode.
This volume identifier is used as the NetBackupmedia ID. This volume identifier
is the volume serial number in ACS, TLH, and TLM robots.

■ For API robots, the barcode for a volume must be identical to the NetBackup
media ID.
Match barcodes to media IDs by getting custom labels in the same series as
themedia IDs. For example, to match a set of media IDs from AA0000 to ZZ9999,
get barcode labels in that series.

■ When a robotic library can contain more than one media type, assign specific
characters in the barcode to different media types. Do so by using media ID
generation rules.
Also, use barcodes to differentiate between data tapes and cleaning tapes or
to differentiate between volume pools.
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About barcode rules
A barcode rule specifies criteria for assigning attributes to new robotic volumes.
NetBackup assigns these attributes by using the barcode for the volume that the
robotic library provides and your barcode rules.

In NetBackup, you choose whether to use barcode rules when you set up the robot
inventory update operation. The barcode rules are stored on the master server.

Note: NetBackup does not use barcode rules if a volume already uses a barcode.

About NetBackup actions for barcodes
When a robot inventory update operation uses NetBackup barcode rules and a new
barcode is detected in the robot, NetBackup does the following:

■ Searches the list of rules (from first to last) for a rule that matches the new
barcode.

■ If the barcode matches a rule, NetBackup verifies that the media type in the rule
is compatible with the media type specified for the update.

■ If the media types match, NetBackup assigns the attributes in the rule to the
volume. The attributes include the media type, volume pool, maximum number
of mounts (or number of cleanings), and description.

Example barcode rules
The following table shows some example barcode rules. Rules are sorted first
according to the number of characters in the barcode tag and then by the order
added. Two exceptions are the <NONE> and <DEFAULT> rules, which are always
located at the end of the list.

Table 10-7 Example barcode rules

DescriptionMax mounts
and cleanings

Volume poolMedia typeBarcode tag

New 008
volumes

55b_pool8MM0080

DLT backup200d_poolDLTDLT

DLT cleaning30NoneDLT_CLNCLD

8-mm cleaning20None8MM_CLNCLT

8-mm backup0t_pool8MMTL8
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Table 10-7 Example barcode rules (continued)

DescriptionMax mounts
and cleanings

Volume poolMedia typeBarcode tag

8-mm no pool0None8MMTL

No barcode0NoneDEFAULT<NONE>

Other barcodes0NetBackupDEFAULT<DEFAULT>

Assume that you select the following media settings (update options) for the update
operation for a new 8-mm volume in a TL8 robot:

Media type = 8MM

Volume group = 00_000_TL8

Use barcode rules = YES

Volume pool = DEFAULT

If a new volume in this robotic library has a barcode of TL800001, NetBackup uses
the rule with the barcode tag of TL8. NetBackup assigns the following attributes to
the volume:

■ Media ID = 800001 (last six characters of barcode)

■ Volume group = 00_000_TL8

■ Volume pool = t_pool

■ Maximum mounts = 0 (no maximum)

If a new volume has a barcode of TL000001, NetBackup uses the rule with the
barcode tag of TL. NetBackup assigns the following attributes to the volume:

■ Media ID = 000001 (last six characters of barcode)

■ Volume group = 00_000_TL8

■ Volume pool = None

■ Maximum mounts = 0 (no maximum)

Configuring barcode rules
Use the Barcode Rules tab of the Advanced Robot Inventory Options dialog
box to configure rules for assigning attributes to the new volumes that are added
to a robot. NetBackup assigns barcodes when you select Use barcode rules on
the Media Settings tab.
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To enable barcode rule support for API robots, add an API_BARCODE_RULES entry
to the vm.conf file.

Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

Information about the vm.conf file is in the NetBackup Administrator's Guide, Volume
II:

http://www.veritas.com/docs/DOC5332

See “About barcodes” on page 506.

To configure barcode rules

1 Open the Advanced Robot Inventory Options dialog box, as follows:

1 In the NetBackup Administration Console, expand
Media and Device Management > Media > Robots in
the left pane.

2 Select the robot that you want to inventory.

3 On the Actions menu, select Inventory Robot.

4 Click either Preview volume configuration changes
or Update volume configuration.

5 Click Advanced Options.

From the Robot
Inventory dialog box
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1 In the NetBackup Administration Console, in the left
pane, expand Media and Device Management >
Devices.

2 From the list of wizards in the right pane, click
Configure Volumes and follow the wizard instructions.

3 On the Robot Inventory panel of the Volume
Configuration Wizard, click Advanced Options.

From the Volume
Configuration Wizard

2 In the Advanced Robot Inventory Options dialog box, click the Barcode
Rules tab.
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3 To configure the rules, do any of the following:

Click New and then configure the rule in the dialog box.Add a rule

Select the rule, click Change, and then change the rule in the
Change Barcode Rule dialog box.

You cannot change the barcode tag of a barcode rule. You first must
delete the old rule and then add a rule with a new barcode tag.

Change a rule

Select the rule, click Delete, and click OK in the Delete Barcode
Rules dialog box. You can select and delete multiple rules with one
operation.

Delete a rule

See “Barcode rules settings” on page 512.

4 When you are finished configuring rules, click OK.

Barcode rules settings
The following table describes the settings you can configure for barcode rules.
NetBackup uses these rules to assign barcodes to new media.
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Table 10-8 Barcode rule settings

DescriptionBarcode rule setting

A unique string of barcode characters that identifies the type of media.

For example, use DLT as the barcode tag for a barcode rule if the following is true:

■ You use DLT on the barcodes to identify DLT tapes
■ DLT is not used on any other barcodes in the robot

Similarly, if you use CLND for DLT cleaning media, use CLND as the barcode tag for
the rule for DLT cleaning media.

The barcode tag can have from 1 to 16 characters but cannot contain spaces.

The following are the special barcode rules that can match special characters in the
barcode tags:

■ NONE
Matches when rules are used and the volume has an unreadable barcode or the
robot does not support barcodes.

■ DEFAULT
For volumes with barcodes, this tag matches when none of the other barcode tags
match. However, the following must be compatible: the media type in the DEFAULT
rule and the media type on the Media Settings tab.

You cannot change the barcode tag of a barcode rule. Instead, first delete the old rule,
then add a rule with a new barcode tag.

Use the Media Settings tab to set up the criteria for a robot update.

See “Configuring media settings” on page 496.

Barcode tag

A description of the barcode rule. Enter from 1 to 25 characters.Description

The maximum number of mounts (or cleanings) that are allowed for the volume.

For data volumes, a value of zero means the volume can be mounted an unlimited
number of times.

For cleaning tapes, zero means that the cleaning tape is not used. Veritas recommends
that you use barcodes for the cleaning media that cannot be confused with barcodes
for data media. Doing so can avoid a value of 0 for cleaning tapes.

Maximum mounts
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Table 10-8 Barcode rule settings (continued)

DescriptionBarcode rule setting

The media type to assign to the media.

Themedia type that is specified on theMedia Settings tab always overrides the media
type of the barcode rule. If you specify a value other than DEFAULT on the Media
Settings tab, the barcode rule media type must be the same as the media or be
DEFAULT. If not, the barcode rule does not match themedia (except for cleaningmedia).

See “Media type when using barcode rules” on page 502.

Note: When a media type is selected, the maximum mounts value may revert to the
default value for the specified media type. For example, it may revert to 0 for unlimited
when you select a non-cleaning media type.

See “NetBackup media types” on page 487.

Media type option

The volume pool for the new media. The actions depend on whether you use barcode
rules to assign media attributes.

Select from the following:

■ DEFAULT

If DEFAULT is selected, NetBackup performs the following actions:
■ If you use barcode rules, the barcode rules determine the volume pool to which

new volumes are assigned.
■ If you do not use barcode rules, NetBackup assigns data tapes to the NetBackup

pool but does not assign cleaning tapes to a volume pool.
■ A specific volume pool

This volume pool setting always overrides any barcode rules.

Volume pool

About media ID generation rules
Use media ID generation rules to override the default media ID naming method
NetBackup uses. The default method uses the last six characters of the barcode
the robot provides to generate the media ID.

Note: To use media ID generation rules, the robot must support barcodes and the
robot cannot be an API robot. Media ID generation rules are saved in the Media
Manager configuration file (vm.conf). Information about the vm.conf file is in the
NetBackup Administrator's Guide, Volume II.

For example, two eight-character barcodes are S00006L1 and 000006L1. Without
any media ID generation rules NetBackup uses the last six characters of the barcode
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to generate media IDs. In this example, the same media ID for the two barcodes
is created (0006L1).

Use a rule to control how NetBackup creates media IDs by specifying which
characters of a barcode are used in the media ID. Or, specify that alphanumeric
characters are to be inserted into the ID.

Define multiple rules to accommodate the robots and the barcode lengths. Define
rules to specific robots and for each barcode format that has different numbers or
characters in the barcode. Multiple rules allow flexibility for the robots that support
multiple media types.

Configuring media ID generation rules
For non-API robots only. Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

Use the Media ID Generation tab of the NetBackup Advanced Robot Inventory
Options dialog box to configure the rules that override the default naming method.
To use media ID generation rules, the robot must support barcodes and the robot
cannot be an API robot.

See “About media ID generation rules” on page 514.

To configure media ID generation rules

1 Open the Advanced Robot Inventory Options dialog box, as follows:

1 In the NetBackup Administration Console, expand
Media and Device Management > Media > Robots in
the left pane.

2 Select the robot that you want to inventory.

3 On the Actions menu, select Inventory Robot.

4 Click either Preview volume configuration changes
or Update volume configuration.

5 Click Advanced Options.

From the Robot
Inventory dialog box
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1 In the NetBackup Administration Console, in the left
pane, expand Media and Device Management >
Devices.

2 From the list of wizards in the right pane, click
Configure Volumes and follow the wizard instructions.

3 On the Robot Inventory panel of the Volume
Configuration Wizard, click Advanced Options.

From the Volume
Configuration Wizard

2 In the Advanced Robot Inventory Options dialog box, click the Media ID
Generation tab.
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3 To configure the rules, do any of the following:

Click New and then configure the rule in the dialog box.Add a rule

Select the rule, click Change, and then change the rule in the dialog
box.

You cannot change the robot number or barcode length of a rule.
To change those properties, first delete the old rule and then add a
rule.

Change a rule

Select the rule, click Delete, and click OK in the confirmation dialog
box. You can select and delete multiple rules with one operation.

Delete a rule

See “Media ID generation options” on page 517.

4 When you are finished configuring rules, click OK.

Media ID generation options
NetBackup uses rules to generate the IDs for media in robots. The default rule uses
the last six characters of the barcode label from the tape.

You can configure media ID generation rules to override the default rule. Control
howNetBackup createsmedia IDs by defining the rules that specify which characters
of a barcode label to use for the media ID.

The following subsections describe the media ID generation rule options.

The following list describes the media ID generation rule options:

■ Bar code length
The Barcode length is the number of characters in the barcode for tapes in the
robot.
You cannot change the barcode length of a rule. Rather, first delete the rule and
then add a new rule.

■ Media ID generation rule
AMedia ID generation rule consists of a maximum of six colon-separate fields.
Numbers define the positions of the characters in the barcode that are to be
extracted. For example, the number 2 in a field extracts the second character
(from the left) of the barcode. You can specify numbers in any order.
To insert a specific character in a generated media idea, precede the character
by a pound sign (#). Any alphanumeric characters that are specified must be
valid for a media ID.
Use rules to create media IDs of many formats. However, it may be difficult to
managemedia if the label on themedia and the generatedmedia ID are different.
The table shows some examples of rules and the resulting media IDs.
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Generated media IDMedia ID generation ruleBarcode on
tape

0329451:2:3:4:5:6032945L1

2945L3:4:5:6:7032945L1

N32945#N:2:3:4:5:6032945L1

9431#9:2:3:4543106L1

5431P1:2:3:4:#P543106L1

■ Robot number
The number of the robot to which the rule applies.
You cannot change the robot number of a rule. Rather, first delete the rule and
then add a new rule.

About media type mapping rules
Applies to API robots only. Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

For API robots, NetBackup contains default mappings from a vendor's media types
to NetBackup media types. API robots are ACS, TLH, or TLM robot types.

You can change the default mappings. Changes apply only to the current volume
configuration update.

You also can add media type mappings.

See “About adding media type mapping entries” on page 525.

See “Default and allowable media types” on page 525.

See “NetBackup media types” on page 487.

Note: You can write a barcode rule that contains the media types that are
incompatible with vendor media types. However, the robot inventory update may
assign NetBackup media types that are inconsistent with the vendor media types.
Avoid this problem by grouping barcode rules by media type.
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Adding volumes by using the Actions menu
Veritas recommends that you use the Volume Configuration Wizard or the robot
inventory option to add volumes.

Be careful when you specify properties. You cannot change some properties later,
such as the media ID or type. If you specify them incorrectly, you must delete the
volume and add it again.

To add volumes by using the Actions menu

1 For new volumes in a robotic library, insert them into the proper slots.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

3 On the Actions menu, select New > Volumes.

4 In the New Volumes dialog box, specify the properties for the volumes.

The properties that appear in the dialog box vary.

See “Volume properties” on page 520.

5 Click Apply or OK.

If the robot has a barcode reader, NetBackup performs the following actions:

■ Adds the volume to the EMM database using the specified media ID.
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■ Reads the barcode of each new volume.

■ Adds the barcodes as attributes in the EMM database.
The Apply option adds the volume without closing the dialog box or
refreshing the display. You can then add more volumes.

Volume properties
Table 10-9 describes the properties for volumes in NetBackup. The properties
depend on whether you add, change, or move volumes.

The properties are arranged alphabetically.

Table 10-9 Volume properties

OperationDescriptionProperty

Add, moveThe name of the NetBackup media server to which the robot is attached.Device host

ChangeThe following does not apply to cleaning tapes.

The date after which the volume is too old to be reliable.

When the expiration date has passed, NetBackup reads data on the volume but
does not mount and write to the volume. You should exchange it for a new volume.

See “About exchanging a volume” on page 536.

When you add a new volume, NetBackup does not set an expiration date.

The expiration date is not the same as the retention period for the backup data on
the volume. You specify data retention periods in the backup policies.

Expiration date

AddThis property appears only if the number of volumes is more than one.

The ID of the first volume in the range of volumes. Media IDs can be from 1 to 6
characters in length. Valid only when you add a range of volumes.

Use the same pattern that you chose in theMedia ID naming style box. NetBackup
uses the pattern to name the remaining volumes by incrementing the digits.

NetBackup allows specific characters in names.

See “NetBackup naming conventions” on page 1163.

First media ID

Add, moveThe number of the first slot in the robot in which the range of volumes resides. If
you add or move more than one media, NetBackup assigns the remainder of the
slot numbers sequentially.

Note: You cannot enter slot information for volumes in an API robot. The robot
vendor tracks the slot locations for API robot types.

First slot number
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Table 10-9 Volume properties (continued)

OperationDescriptionProperty

AddThe maximum number of times NetBackup should mount the volume or use the
cleaning tape.

To determine the maximum mount limit to use, consult the vendor documentation
for information on the expected life of the volume.

Maximum
cleanings

Add, changeThe following topic does not apply to cleaning tapes.

The Maximum mounts property specifies the number of times that the selected
volumes can be mounted.

When the limit is reached, NetBackup reads data on the volume but does not mount
and write to the volume.

A value of zero (the default) is the same as Unlimited.

To help determine the maximum mount limit, consult the vendor documentation
for information on the expected life of the volume.

Maximummounts

Add, changeA description of the media, up to 25 character maximum.

NetBackup allows specific characters in names.

See “NetBackup naming conventions” on page 1163.

Media description

Add, changeThis property appears only if the number of volumes is one.

The ID for the new volume. Media IDs can be from 1 to 6 characters in length.

Media IDs for an API robot must match the barcode on the media (for API robots,
NetBackup supports barcodes from 1 to 6 characters). Therefore, obtain a list of
the barcodes before you add the volumes. Obtain this information through a robotic
inventory or from the robot vendor’s software.

NetBackup allows specific characters in names.

See “NetBackup naming conventions” on page 1163.

Media ID

AddThe style to use to name the range of volumes. Media IDs can be from 1 to 6
characters in length. Using the pattern, NetBackup names the remaining volumes
by incrementing the digits.

NetBackup media IDs for an API robot must match the barcode on the media. For
API robots, NetBackup supports barcodes from 1 to 6 characters. Therefore, obtain
a list of the barcodes before you add the volumes. Obtain this information through
a robotic inventory or from the robot vendor’s software.

NetBackup allows specific characters in names.

See “NetBackup naming conventions” on page 1163.

Media ID naming
style

521Configuring tape media
Adding volumes by using the Actions menu



Table 10-9 Volume properties (continued)

OperationDescriptionProperty

AddThe media type for the volume to add.

Select the type from the drop-down list.

See “NetBackup media types” on page 487.

Media type

AddThe number of volumes to add. For a robotic library, enough slots must exist for
the volumes.

Number of
volumes

Add, moveThe robotic library to add or move the volumes to.

To add volumes for a different robot, select a robot from the drop-down list. The
list shows robots on the selected host that can contain volumes of the selected
media type.

Robot

Add, moveIf you specified a robot, select from a volume group already configured for that
robot. Alternatively, enter the name for a volume group; if it does not exist,
NetBackup creates it and adds the volume to it.

If you do not specify a volume group (you leave the volume group blank), the
following occurs:

■ Standalone volumes are not assigned to a volume group.
■ NetBackup generates a name for robotic volumes by using the robot number

and type. For example, if the robot is a TL8 and has a robot number of 50, the
group name is 000_00050_TL8.

See “About NetBackup volume groups” on page 486.

See “About rules for moving volumes between groups” on page 531.

Volume group

Add, moveWhen you add a volume:

■ If the volume is in a robot, select Volume is in a robotic library.
■ If the volume is a standalone volume, do not select Volume is in a robotic

library.

When you move a volume:

■ To inject a volume into a robotic library, select Volume is in a robotic library.
Then, select a robot and the slot number (First slot number) for the volume.

■ To eject a volume from a robot, clear Volume is in a robotic library.

Volume is in a
robotic library

522Configuring tape media
Adding volumes by using the Actions menu



Table 10-9 Volume properties (continued)

OperationDescriptionProperty

Add, changeThe pool to which the volume or volumes should be assigned.

Select a volume pool you created or one of the following standard NetBackup
pools:

■ None.
■ NetBackup is the default pool name for NetBackup.
■ DataStore is the default pool name for DataStore.
■ CatalogBackup is the default pool name used for NetBackup catalog backups

of policy type NBU-Catalog.

When the images on a volume expire, NetBackup returns it to the scratch volume
pool if it was allocated from the scratch pool.

See “About NetBackup volume pools” on page 483.

Volume pool

MoveThe Volumes to move section of the dialog box shows the media IDs of the
volumes that you selected to move.

Volumes to move

Configuring media type mappings
Applies to API robots only. Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

Use theMedia Type Mappings tab of the NetBackup Advanced Robot Inventory
Options dialog box to configure the attributes for existing and new media.

See “About media type mapping rules” on page 518.

To configure media type mappings

1 Open the Advanced Robot Inventory Options dialog box, as follows:

1 In the NetBackup Administration Console, expand
Media and Device Management > Media > Robots in
the left pane.

2 Select the robot that you want to inventory.

3 On the Actions menu, select Inventory Robot.

4 Click either Preview volume configuration changes
or Update volume configuration.

5 Click Advanced Options.

From the Robot
Inventory dialog box
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1 In the NetBackup Administration Console, in the left
pane, expand Media and Device Management >
Devices.

2 From the list of wizards in the right pane, click
Configure Volumes and follow the wizard instructions.

3 On the Robot Inventory panel of the Volume
Configuration Wizard, click Advanced Options.

From the Volume
Configuration Wizard

2 In the Advanced Robot Inventory Options dialog box, click the Media Type
Mappings tab.

The mappings that appear are only for the robot type that was selected for
inventory. The default mappings and any mappings you added or changed
appear.

3 Select the row that contains the robot-vendor media type mapping that you
want to change and click Change Mapping.

4 In the Change Media Mapping dialog box, select a media type from the list
of allowed selections.

5 Click OK.

To reset the mappings to the default, click Reset to Defaults.
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About adding media type mapping entries
Applies to API robots only. Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

The default media type mappings may not provide the wanted mappings. If not,
add robot-specific media mappings to the vm.conf file on the host on which you
run the NetBackup Administration Console.

Information about the vm.conf file is in theNetBackup Administrator's Guide, Volume
II:

http://www.veritas.com/docs/DOC5332

Table 10-10 Examples of robot-specific media mappings

Robot default without a vm.conf
entry

Resultvm.conf entry

HCARTMaps the ACS 3490E to the HCART2
media type.

ACS_3490E = HCART2

DLT for all ACSDLTmedia types, including
DLTIV

Maps ACS DLTIV to the DLT2 media type.ACS_DLTIV = DLT2

HCARTMaps the TLH 3490E to the HCART2
media type.

TLH_3490E = HCART2

Default and allowable media types
Applies to API robots only. Robot types are described in a different topic.

See “NetBackup robot types” on page 435.

The default media types on the Media Type Mappings tab are the media types
provided by each robot vendor.

The following tables contain the default and allowable media types for the API robots
as follows:

■ NetBackup ACS type robots: Table 10-11

■ NetBackup TLH type robots: Table 10-12

■ NetBackup TLM type robots: Table 10-13

The following items provide information to help you understand the tables:

■ The first column of each table shows the vendor's media type.

■ The second column of each table shows the default media type in NetBackup.
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■ The third column shows the media types to which you can map the defaults. To
do so, first add the allowable mapping entries to the vm.conf file.
Some map entries are not allowed. For example, you cannot specify either of
the following map entries for ACS robots:

ACS_DD3A = DLT

ACS_DD3A = HCART4

The following table shows the default media types and the allowable media types
for ACS robots.

Table 10-11 Default and allowable media types for ACS robots

Allowablemedia types
through mappings

Default media typeACS media type

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)3480

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)3490E

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

DD3A

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

DD3B

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

DD3C

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape 2 (HC2_CLN)

DD3D

DLT, DLT2, DLT3Digital Linear Tape (DLT)DLTIII

DLT, DLT2, DLT3Digital Linear Tape (DLT)DLTIIIXT

DLT, DLT2, DLT3Digital Linear Tape (DLT)DLTIV

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)EECART

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)JLABEL

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)KLABEL
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Table 10-11 Default and allowable media types for ACS robots (continued)

Allowablemedia types
through mappings

Default media typeACS media type

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)LTO_100G

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)LTO_10GB

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART2)LTO_200G

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)LTO_35GB

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

LTO_400G

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

LTO_400W

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

LTO_50GB

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

LTO_800G

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

LTO_800W

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

LTO_1_5T

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

LTO_1_5W

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

LTO_2_5T

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

LTO_2_5W

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

LTO_6_4T

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

LTO_6_4W
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Table 10-11 Default and allowable media types for ACS robots (continued)

Allowablemedia types
through mappings

Default media typeACS media type

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

LTO_CLN1

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

LTO_CLN2

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

LTO_CLN3

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

LTO_CLNU

DLT, DLT2, DLT3Digital Linear Tape 3 (DLT3)SDLT

DLT, DLT2, DLT3Digital Linear Tape (DLT)SDLT_2

DLT, DLT2, DLT3Digital Linear Tape (DLT)SDLT_4

DLT, DLT2, DLT3Digital Linear Tape 2 (DLT2)SDLT_S1

DLT, DLT2, DLT3Digital Linear Tape (DLT)SDLT_S2

DLT, DLT2, DLT3Digital Linear Tape (DLT)SDLT_S3

DLT, DLT2, DLT3Digital Linear Tape (DLT)SDLT_S4

HCART, HCART2,
HCART3

1/2-inch cartridge (HCART)STK1R

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

STK1U

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape (HC_CLN)

STK1Y

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

STK2P

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape 2 (HC2_CLN)

STK2W

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000CC

HC_CLN, HC2_CLN,
HC3_CLN

1/2-inch cartridge cleaning
tape 3 (HC3_CLN)

T10000CL
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Table 10-11 Default and allowable media types for ACS robots (continued)

Allowablemedia types
through mappings

Default media typeACS media type

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000CT

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000T1

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000T2

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000TS

HCART, HCART2,
HCART3

1/2-inch cartridge tape 3
(HCART3)

T10000TT

HCART, HCART2,
HCART3, DLT, DLT2,
DLT3

1/2-inch cartridge tape 2
(HCART2)

UNKNOWN (for unknown ACS
media types)

HCART, HCART2,
HCART3

1/2-inch cartridge tape
(HCART)

VCART

HCART, HCART2,
HCART3

1/2-inch cartridge tape 2
(HCART2)

VIRTUAL

The following table shows the default and allowable media types for TLH robots.

Table 10-12 Default and allowable media types for TLH robots

Allowable media types
through mappings

Default Media Manager
media type

TLHmedia type

HCART, HCART2, HCART31/2-inch cartridge (HCART)3480

HCART, HCART2, HCART31/2-inch cartridge (HCART)3490E

HCART, HCART2, HCART31/2-inch cartridge (HCART)3590J

HCART, HCART2, HCART31/2-inch cartridge (HCART)3590K

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JA

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JB

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JX
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Table 10-12 Default and allowable media types for TLH robots (continued)

Allowable media types
through mappings

Default Media Manager
media type

TLHmedia type

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JJ

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JR

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)3592JW

HCART, HCART2, HCART31/2-inch cartridge tape 2 (HCART2)UNKNOWN (for
unknown TLH
media types)

The following table shows the default and allowable media types for TLM robots.

Table 10-13 Default and allowable media types for TLM robots

Allowable media types
through mappings

Default media typeTLMmedia type

HCART, HCART2, HCART31/2-inch cartridge (HCART)3480

NONENONE

(OD_THICK is translated to media
type REWR_OPT for robot
contents reports. OD_THICK is
ignored for all other robotic
inventory operations)

OD_THICK

DLT, DLT2, DLT3Digital Linear Tape (DLT)DECDLT

8MM, 8MM2, 8MM38mm cartridge (8MM)8MM

4MM4mm cartridge (4MM)4MM

HCART, HCART2, HCART31/2-inch cartridge (HCART)3590

DTFDTF cartridge (DTF)DTF

8MM, 8MM2, 8MM38mm cartridge (8MM)SONY_AIT

HCART, HCART2, HCART31/2-inch cartridge (HCART)LTO

HCART, HCART2, HCART3, DLT,
DLT2, DLT3, 8MM, 8MM2, 8MM3

1/2-inch cartridge tape 2 (HCART2)UNKNOWN

(for unknown TLM
media types)
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Note: The following TLM media types are not supported: OD_THIN, D2, VHS, CD,
TRAVAN, BETACAM, AUDIO_TAPE, BETACAMCL, DVCM, and DVCL.

Managing volumes
The following sections describe the procedures to manage volumes.

Changing the group of a volume
If you move a volume physically to a different robot, change the group of the volume
to reflect the move.

See “About rules for moving volumes between groups” on page 531.

To change the group of a volume

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select the volumes that you want to
change the volume group assignment for.

3 On the Actions menu, select Change Volume Group.

4 In theNew volume group name field, enter the name of the new volume group
or select a name from the list of volume groups.

5 Click OK.

The name change is reflected in the volume list entry for the selected volumes.
If you specified a new volume group (which creates a new volume group), the
group appears under Volume Groups in the left pane.

About rules for moving volumes between groups
The following are the rules for moving volumes between groups:

■ The target volume group must contain the same type of media as the source
volume group. If the target volume group is empty: The successive volumes
that you add to it must match the type of media that you first add to it.

■ All volumes in a robotic library must belong to a volume group. If you do not
specify a group, NetBackup generates a new volume group name by using the
robot number and type.

■ More than one volume group can share the same location. For example, a
robotic library can contain volumes from more than one volume group and you
can have more than one standalone volume group.
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■ All members of a group must be in the same robotic library or be standalone.
That is, if volume group already exists in another robotic library, you cannot add
it (or part of it) to a robotic library.

See “About NetBackup volume groups” on page 486.

See “About moving volumes” on page 545.

Changing the owner of a volume
You can change the media server or server group that owns the volume.

See “About NetBackup server groups” on page 400.

See “About media sharing” on page 553.

To change the owner of a volume

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the Volumes list, select the volume that you want to change.

3 On the Actions menu, select Change Media Owner.

4 In the Media Owner field, select one of the following:

Allows NetBackup to choose the media owner. NetBackup
chooses a media server or a server group (if one is
configured).

Any (default)

Specifies that the media server that writes the image to the
media owns the media. No media server is specified explicitly,
but you want a media server to own the media.

None

Specify a server group. A server group allows only those
servers in the group to write to the media on which backup
images for this policy are written. All server groups that are
configured in the NetBackup environment appear in the
drop-down list.

A server group

5 Click OK.

Changing volume properties
You can change some of the properties of a volume, including the volume pool.
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To change volume properties

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select a volume or volumes.

3 On the Edit menu, select Change.

4 In the Change Volumes dialog box, change the properties for the volume.

See “Volume properties” on page 520.

5 Click OK.

About assigning and deassigning volumes
An assigned volume is one that is reserved for exclusive use by NetBackup. A
volume is set to the assigned state when either application writes data on it for the
first time. The time of the assignment appears in the Time Assigned column for
the volume in the NetBackup Administration Console Volumes pane. When a
volume is assigned, you cannot delete it or change its volume pool.

A volume remains assigned until NetBackup deassigns it.
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To determine which application currently uses a volume, see the Application
column of the right pane, labeled Volumes.

NetBackup deassigns a volume only when the data is no longer required, as follows:

■ For regular backup volumes, when the retention period has expired for all the
backups on the volume.

■ For catalog backup volumes, when you stop using the volume for catalog
backups.

To deassign a volume, you expire the images on the volume. After you expire a
volume, NetBackup deassigns it and does not track the backups that are on it.
NetBackup can reuse the volume, you can delete it, or you can change its volume
pool.

See “Expiring backup images” on page 1026.

You can expire backup images regardless of the volume state (Frozen, Suspended,
and so on).

NetBackup does not erase images on expired volumes. You can still use the data
on the volume by importing the images into NetBackup (if the volume has not been
overwritten).

See “About importing backup images” on page 1027.

Note: Veritas recommends that you do not deassign NetBackup volumes. If you
do, be certain that the volumes do not contain any important data. If you are
uncertain, copy the images to another volume before you deassign the volume.

Deleting a volume
You can delete volumes from the NetBackup configuration.

Note: You cannot delete a volume if it is still assigned.

For example, if any of the following situations apply, you may want to delete the
volume:

■ A volume is no longer used and you want to recycle it by relabeling it with a
different media ID.

■ A volume is unusable because of repeated media errors.

■ A volume is past its expiration date or has too many mounts, and you want to
replace it with a new volume.

■ A volume is lost and you want to remove it from the EMM database.
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After a volume is deleted, you can discard it or add it back under the same or a
different media ID.

Before you delete and reuse or discard a volume, ensure that it does not have any
important data. You cannot delete NetBackup volumes if they are assigned.

See “About assigning and deassigning volumes” on page 533.

To delete volumes

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select the volume or volumes that you
want to delete.

You cannot delete a volume if it is still assigned.

3 On the Edit menu, select Delete.

4 In the Delete Volumes dialog box, click OK.

5 Remove the deleted volume or volumes from the storage device.

Erasing a volume
You can erase the data on a volume if the following are true:

■ The volume is not assigned.

■ The volume contains no valid NetBackup images.

After NetBackup erases the media, NetBackup writes a label on the media.

If you erase media, NetBackup cannot restore or import the data on the media.

If a volume contains valid NetBackup images, deassign the volume so NetBackup
can label it.

See “About assigning and deassigning volumes” on page 533.

The following table describes the types of erase.

Table 10-14 Types of erase

DescriptionType of erase

Rewinds the media and the data is overwritten with a known data
pattern. A SCSI long erase is also called a secure erase because it
erases the recorded data completely.

Note: A long erase is a time-consuming operation and can take as
long as two hours to three hours. For example, it takes about 45 minutes
to erase a 4-mm tape on a standalone drive

SCSI long erase
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Table 10-14 Types of erase (continued)

DescriptionType of erase

Rewinds the media and an erase gap is recorded on the media. The
format of this gap is drive dependent. It can be an end-of-data (EOD)
mark or a recorded pattern that the drive does not recognize as data.

Some drives do not support a quick erase (such as QUANTUM
DLT7000). For the drives that do not support a quick erase, the new
tape header that is written acts as an application-specific quick erase.

SCSI quick erase

Note: NetBackup does not support erase functions on NDMP drives.

To erase a volume

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select a volume or volumes that you want
to erase.

If you select multiple volumes, they must all be in the same robot.

3 Select either Actions > Quick Erase or Actions > Long Erase.

4 In the erase dialog box, specify the name of the media server to initiate the
erase operation.

To overwrite any existing labels on the media, do not select Verify media label
before performing operation.

5 Click OK.

A dialog box warns you that this action is irreversible.

6 Click OK if you are certain you want to start the erase action.

A dialog box reminds you to use the Activity Monitor to view the progress
and status of the action. (For many types of drives, you may not be able to
cancel a label or erase media job from the Activity Monitor.) Click OK.

If you selected Verify media label before performing operation and the
actual volume label does not match the expected label, the media is not erased.

About exchanging a volume
You should exchange a volume (replace one volume with another volume) if a
volume meets any of the following conditions:
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■ Full (in this case, to exchange a volume means to remove the volume from a
robotic tape library).

■ Past the maximum number of mounts.

■ Old (past the expiration date).

■ Unusable (for example, because of repeated media errors).

Depending on whether you want to reuse the old media ID or not, follow one of the
exchange volumes processes in the following subsections.

Exchanging a volume and using a new media ID
Use this procedure when the following are true:

■ The volume contains current and valid NetBackup images.

■ You require slots in the robotic library for additional backups, duplications, vault
functions, or other purposes.

The following table describes the procedure that used to exchange a volume and
use a new media ID.

Table 10-15 Exchange a volume and using a new media ID

InstructionsTaskStep

See “About moving volumes”
on page 545.

Move the volume to another location

If the volume is in a robotic library, remove it from the robotic library
and move it to a standalone group.

Step 1

See “About adding volumes”
on page 493.

Add a new volume or move an existing volume in as a replacement
for the volume you removed.

If you add a new volume, specify a new media ID. Specify the
same values for the other attributes as the removed volume (such
as robotic residence, volume pool, and the media type).

Step 2

Beyond the scope of the NetBackup
documentation.

Physically replace the old volume.

Do not delete the old volume in case you need to retrieve the data
on the volume.

Step 3

Exchanging a volume and using the old media ID
You can exchange a volume and reuse the samemedia ID, whichmay be convenient
in some instances.

Reuse a media ID only if all data on the old volume is not required and you recycle
or discard the volume.
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Warning: If you exchange a media ID for a volume that has unexpired backup
images, serious operational problems and data loss may occur.

The following table describes the procedure to exchange a volume and use the old
media ID.

Table 10-16 Exchange a volume and use the old media ID

InstructionsTaskStep

See “Deleting a volume” on page 534.Delete the volume.Step 1

See “About injecting and ejecting volumes”
on page 539.

Remove the old volume from the storage device.
Physically add the new volume to the storage device.

Step 2

See “About adding volumes” on page 493.Add the new volume to the NetBackup volume
configuration and specify the same attributes as the
old volume, including the old media ID.

Step 3

See “Changing volume properties” on page 532.Set a new expiration date for the volume.Step 4

See “Labeling a volume” on page 544.Optionally, label the volume. Although you do not
have to label the volume, the label process puts the
media in a known state. The external media label
matches the recorded media label, and the mode is
known to be compatible with the drives in the robotic
library.

Step 5

About frozen media
Frozen media is the media that NetBackup does not use for backups. NetBackup
stops directing the backups and the archives to frozen media. NetBackup never
deletes a frozen media ID from the NetBackup media catalog, even after the
retention period ends for all backups on the media. NetBackup does not unassign
a frozen volume from the NetBackup volume pool when its backup images expire.

All unexpired backup images on frozen media continue to be available for restores.

NetBackup freezes the tape volumes for a variety of reasons, as follows:

■ NetBackup freezes a volume when read or write errors surpass the threshold
within the time window. The default media error threshold is 2. That is, NetBackup
freezes media on the third media error in the default time window (12 hours).
Common reasons for write failures are dirty write heads or old media. The reason
for the action is logged in the NetBackup error catalog (view the Media Logs
report or the All Log Entries report).
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You can use the NetBackup nbemmcmd command with the
-media_error_threshold and -time_window options to change the default
values.
Additional information about the nbemmcmd is available in the NetBackup
Commands Reference Guide:
http://www.veritas.com/docs/DOC5332

■ NetBackup freezes a volume if a write failure makes future attempts at positioning
the tape unreliable.

■ NetBackup freezes the catalog volumes during catalog recovery.

■ NetBackup freezes the volumes in some circumstances with write once read
many (WORM) media or WORM-capable drives.
See “About using volume pools to manage WORM media” on page 490.

You can unfreeze the frozen volumes manually.

Freezing or unfreezing a volume
NetBackup freezes volumes under circumstances.

Use the following procedure to manually freeze or unfreeze a volume.

To freeze or unfreeze media

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select the volume that you want to freeze
or unfreeze.

3 On the Actions menu, select Freeze or Unfreeze.

4 In the dialog box, click OK.

About injecting and ejecting volumes
Media access port (MAP) functionality differs between robotic libraries. For many
libraries, NetBackup opens and closes the MAP as needed. However, some libraries
have the front-panel inject and the eject functions that conflict with NetBackup’s
use of the media access port. And for other libraries, NetBackup requires front-panel
interaction by an operator to use the media access port.

Read the operator manual for the library to understand the media access port
functionality. Some libraries may not be fully compatible with the inject and eject
features of NetBackup unless properly handled. Other libraries may not be
compatible at all.
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Injecting volumes into robots
You can inject volumes into the robots that contain media access ports.

Any volumes to be injected must be in the media access port before the operation
begins. If no volumes are in the port, you are not prompted to place volumes in the
media access port and the update operation continues.

Each volume in the MAP is moved into the robotic library. If the MAP contains
multiple volumes, they are moved to empty slots in the robotic library until the media
access port is empty or all the slots are full.

After the volume or volumes are moved, NetBackup updates the volume
configuration.

Some robots report only that media access ports are possible. Therefore, Empty
media access port prior to update may be available for some robots that do not
contain media access ports.

Inject volumes into the robots that contain media access ports

1 Load the volumes in the MAP.

2 Inventory the robot

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

3 Select Empty media access port prior to update on the Robot Inventory
dialog box.

Ejecting volumes
You can eject single or multiple volumes.

You cannot eject multiple volumes with one operation if they reside in multiple
robots.

Operator intervention is only required if the robotic library does not contain a media
access port large enough to eject all of the selected volumes. For these robot types,
NetBackup prompts an operator to remove the media from the media access port
so the eject operation can continue.

See “Media ejection timeout periods” on page 541.

To eject volumes

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select one or more volumes that you
want to eject.
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3 On the Actions menu, select Eject Volumes From Robot.

4 In the Eject Volumes dialog box, do one of the following actions:

Select the media access port to use for the ejection, then
click Eject.

ACS and TLM robots
only

Click Eject.All other robots

The robotic library may not contain a media access port large enough to eject
all of the selected volumes. For most robot types, you are prompted to remove
the media from the media access port so the eject can continue with the
remaining volumes.

See “NetBackup robot types” on page 435.

Media ejection timeout periods
The media ejection period (the amount of time before an error condition occurs)
varies depending on the capability of each robot.

The following table shows the ejection timeout periods for robots.

Table 10-17 Media ejection timeout periods

Timeout periodRobot types

One weekAutomated Cartridge System (ACS)

Tape Library Multimedia (TLM)

30 minutes.Tape Library 8MM (TL8)

Tape Library DLT (TLD)

None. The robot allows an unlimited amount
of time to remove media.

Tape Library Half-inch (TLH)

Note: If the media is not removed and a timeout condition occurs, the media is
returned to (injected into) the robot. Inventory the robot and eject the media that
was returned to the robot.

Some robots do not contain media access ports. For these robots, the operator
must remove the volumes from the robot manually.

Note: After you add or remove media manually, use NetBackup to inventory the
robot.
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About rescanning and updating barcodes
You can rescan the media in a robot and then update NetBackup with the barcodes
of that media.

You should rescan and update only in certain circumstances.

Note: Rescan and update barcodes does not apply to volumes in API robot types.

See “NetBackup robot types” on page 435.

Rescan and update barcodes only to add the barcodes that are
not in the EMM database.

For example: if you add a new volume but do not insert the tape
into the robot, NetBackup does not add the barcode to the
database. Use this command to add the barcode after you insert
the tape into the robotic library.

When to rescan and to
update barcodes

Do not rescan and update to correct the reports that show amedia
ID in the wrong slot.

To correct that problem, perform one of the following actions:

■ Logically move the volume by selecting a volume and then on
the Actions menu select Move.

■ Logically move the volume by updating the volume
configuration.
See “Updating the NetBackup volume configuration with a
robot's contents” on page 569.

■ Physically move the volume into the correct slot.

To obtain an inventory of the robot without updating the barcode
information in the database, inventory the robot and use the show
contents option.

See “Showing the media in a robot” on page 562.

When not to rescan and
to update barcodes

See “About barcodes” on page 506.

Rescanning and updating barcodes
Use the following procedure to rescan the media in a robot and to update NetBackup
with the barcodes.

Note: Rescan and update barcodes does not apply to volumes in API robot types.

See “NetBackup robot types” on page 435.
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See “About rescanning and updating barcodes” on page 542.

To rescan barcodes and update the EMM database

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Robots.

2 Select the robotic library that contains the volumes that you want to scan and
update.

3 In the right pane, in the Volumes list, select the volumes.

4 On the Actions menu, select Rescan/Update Barcodes.

5 Click Start.

The results of the update appear in the output section of the dialog box.

About labeling NetBackup volumes
When NetBackup labels a volume, it writes a record on the magnetic tape of the
volume; the record (or label) includes the NetBackup media ID.

Normally, NetBackup controls the labeling of its volumes. In most cases, NetBackup
labels a volume the first time it is used for a backup.

The volume label depends on whether or not the media has a barcode, as follows:

■ If the robot supports barcodes and the media has barcodes, NetBackup uses
the last six characters of the barcode for the media ID.
To change this default action, specify and select specific characters by using
Media ID generation rules.
See “Configuring media ID generation rules” on page 515.

■ For volumes without barcodes, by default NetBackup uses a prefix of the letter
A when it assigns a media ID to a volume (for example, A00001).
To change the default prefix, use the MEDIA_ID_PREFIX configuration option in
the vm.conf file. Information about the vm.conf file is available in theNetBackup
Administrator’s Guide, Volume II:
http://www.veritas.com/docs/DOC5332

Media is not labeled automatically in the following situations:

■ They were last used for NetBackup catalog backups.
Do not label catalog backup volumes unless they are no longer used for catalog
backups.

■ They contain data from a recognized non-NetBackup application and NetBackup
is configured to prohibit media overwrite for that media type.

To label these media types, the following must be true:
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■ NetBackup has not assigned the media

■ The media contains no valid NetBackup images

Labeling a volume
If a volume contains valid NetBackup images, deassign the volume so that it can
be labeled.

See “About assigning and deassigning volumes” on page 533.

If you want to label media and assign specific media IDs (rather than allow
NetBackup to assign IDs), use the bplabel command.

Note: If you label a volume, NetBackup cannot restore or import the data that was
on the media after you label it.

Note: For many types of drives, you may not be able to cancel a label job from the
Activity Monitor.

See “About labeling NetBackup volumes” on page 543.

To label a volume

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select a volume or the volumes that you
want to label.

If you select multiple volumes, they all must be in the same robot.

3 On the Actions menu, select Label.

4 In the Label dialog box, specify the following properties for the label operation.

Enter tname of the media server that controls the drive
to write the label.

Media server

Select this option to verify that the media in the drive is
the expected media.

To overwrite any existing labels on the media, do not
select Verify media label before performing
operation.

Verify label before
performing operation
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5 Click OK.

6 In the warning dialog box, click OK.

If you selected Verify media label before performing operation and the
actual volume label does not match the expected label, the media is not
relabeled.

About moving volumes
When you move volumes in or out of a robotic library or from one robot to another,
move the volumes physically and logically, as follows:

■ Physically move volumes by inserting or by removing them. For some robot
types, use the NetBackup inject and eject options.

■ Logically move volumes using NetBackup, which updates the EMM database
to show the volume at the new location.

When you move volumes from one robotic library to another robotic library, perform
the following actions:

■ Move the volumes to stand alone as an intermediate step.

■ Move the volumes to the new robotic library.

The following types of logical moves are available:

■ Move single volumes.

■ Move multiple volumes.

■ Move combinations of single and multiple volumes.

■ Move volume groups.

You cannot move volumes to an invalid location (for example, move DLT media to
an 8-mm robot).

Veritas recommends that you perform moves by selecting and by moving only one
type of media at a time to a single destination.

The following are several examples of when to move volumes logically:

■ When a volume is full in a robotic library and no slots are available for new
volumes in the robotic library. Move the full volume to stand alone, remove it
from the robot, then configure a new volume for the empty slot or move an
existing volume into that slot. Use the same process to replace a defective
volume.

■ Moving volumes from a robotic library to an off-site location or from an off-site
location into a robotic library. When you move tapes to an off-site location, move
them to stand alone.
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■ Moving volumes from one robotic library to another (for example, if a library is
down).

■ Changing the volume group for a volume or volumes.

See “About NetBackup volume groups” on page 486.

Moving volumes by using the robot inventory update
option
Use this procedure for the following:

The robot must have a barcode reader and the volumes must
contain readable barcodes.

To move volumes within
a robot.

Use this procedure even if the volumes do not contain barcodes
or if the robot does not have a reader.

To remove volumes
from a robot.

To move volumes by using a robot inventory update

1 Physically move the volumes to their new location.

2 On the Actions menu, select Inventory Robot.

3 In the Robot Inventory dialog box, select Update volume configuration.

4 Select other options as appropriate.

See “About robot inventory” on page 556.

Moving volumes by using the Actions menu
If you move a volume to a robotic library that has a barcode reader, NetBackup
updates the EMM database with the correct barcode.

To move volumes by using the Actions menu

1 Physically move the volumes to their new location.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

3 In the right pane, in the Volumes list, select the volumes that you want to move.

4 On the Actions menu, select Move.

5 In the Move Volumes dialog box, specify the properties for the move.

If you move a single volume, the dialog box entries show the current location
of the volume.

See “Volume properties” on page 520.
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About recycling a volume
If you recycle a volume, you can use either the existing media ID or a new media
ID.

Caution: Recycle a volume only if all NetBackup data on the volume is no longer
needed or if the volume is damaged and unusable. Otherwise, you may encounter
serious operational problems and a possible loss of data.

Recycling a volume and using the existing media ID
NetBackup recycles a volume and returns it to the volume rotation when the last
valid image on the volume expires.

To recycle a volume that contains unexpired backup images, you must deassign
the volume.

See “About assigning and deassigning volumes” on page 533.

Recycling a volume and using a new media ID
Recycle a volume if it is a duplicate of another volume with the same media ID.
Also recycle a volume if you change how you name volumes and you want to match
the barcodes on the volume.

The following table describes the procedure to recycle a volume and use a new
media ID.

Table 10-18 Recycling a volume and using a new media ID

DescriptionActionStep

See “Ejecting volumes” on page 540.Physically remove the volume from the storage
device.

Step 1

See “About moving volumes” on page 545.If the volume is in a robotic library, move it to stand
alone.

Step 2

See the values in the Media (Media and Device
Management > Media in the NetBackup
Administration Console).

Record the current number of mounts and expiration
date for the volume.

Step 3

See “Deleting a volume” on page 534.Delete the volume entry.Step 4
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Table 10-18 Recycling a volume and using a new media ID (continued)

DescriptionActionStep

See “Adding volumes by using the Actions menu”
on page 519.

Because NetBackup sets the mount value to zero for
new volume entries, you must adjust the value to
account for previous mounts.

Set the maximum mounts to a value that is equal to
or less than the following value:

The number of mounts that the manufacturer
recommends minus the value that you recorded
earlier.

Add a new volume entry.Step 5

See “Injecting volumes into robots” on page 540.Physically add the volume to the storage device.Step 6

Set the number of mounts to the value you recorded
earlier by using the following command:

On Windows hosts:

install_path\Volmgr\bin\vmchange -m
media_id -n number_of_mounts

On UNIX hosts:

/usr/openv/volmgr/bin/vmchange -m
media_id -n number_of_mounts

Configure the number of mountsStep 7

See “Changing volume properties” on page 532.Set the expiration date to the value you recorded
earlier.

Step 8

Suspending or unsuspending volumes
You cannot use a suspended volume for backups until retention periods for all
backups on it have expired. At that time, NetBackup deletes the suspended volume
from the NetBackup media catalog and unassigns it from NetBackup.

A suspended volume is available for restores. If the backups have expired, import
the backups first.

To suspend or unsuspend media

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Media.

2 In the right pane, in the Volumes list, select the volume or volumes that you
want to suspend or unsuspend.
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3 On the Actions menu, select Suspend or Unsuspend.

4 In the dialog box, click OK.

Managing volume pools
The following sections describe the operations you can perform to manage volume
pools.

Adding or deleting a volume pool
Use this procedure to add a new volume pool.

To add a volume pool

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 On the Actions menu, select New > Volume Pool.

3 In the New Volume Pool dialog box, specify the properties for the volume
pool.

See “Volume pool properties” on page 550.

4 Add volumes to the pool by adding new volumes to NetBackup or by changing
the pool of existing volumes.

See “Adding volumes by using the Actions menu” on page 519.

See “Adding volumes by using the wizard” on page 496.

See “Changing volume properties” on page 532.

You cannot delete any of the following pools:

■ A volume pool that contains volumes

■ The NetBackup volume pool

■ The None volume pool

■ The default CatalogBackup volume pool

■ The DataStore volume pool

Use this procedure to delete a volume pool.

To delete a volume pool

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Volume Pools.

2 Select a volume pool from the pools in the Volume Pools list.
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3 Ensure that the volume pool is empty. If the pool is not empty, change the pool
name for any volumes in the pool. If the volumes are not needed, delete them.

4 On the Edit > menu, select Delete.

5 Click Yes or No in the confirmation dialog box.

Changing the properties of a volume pool
Use this procedure to change the properties of a volume pool. The properties you
can change include the pool type (scratch pool or catalog backup pool).

To change a volume pool

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Media > Volume Pools.

2 Select a pool in the Volume Pools list.

3 Select Edit > Change.

4 In the Change Volume Pool dialog box, change the attributes for the volume
pool.

See “Volume pool properties” on page 550.

Volume pool properties
You can specify various properties for a volume pool.

The following table describes the properties that you can configure for volume pools,
either when you add a new pool or change an existing one.

Table 10-19 Volume pool properties

DescriptionProperty

Select this option to use this volume pool for catalog backups. This check box creates
a dedicated catalog backup pool to be used for NBU-Catalog policies. A dedicated
catalog volume pool facilitates quicker catalog restore times.

Multiple catalog backup volume pools are allowed.

Catalog backup pool

Provides a brief description of the volume pool.Description
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Table 10-19 Volume pool properties (continued)

DescriptionProperty

Does not apply to the None pool, catalog backup pools, or scratch volume pools.

Specifies the number of partially full media to allow in the volume pool for each of the
unique combinations of the following in that pool:

■ Robot
■ Drive type
■ Retention level

The default value is zero, which does not limit the number of full media that are allowed
in the pool.

Maximum number of
partially full media

The Pool name is the name for the new volume pool. Volume pool names are
case-sensitive and can be up to 20 characters.

See “About reserved volume pool name prefixes” on page 484.

Pool name

Specifies that the pool should be a scratch pool.

Veritas recommends that you use a descriptive name for the pool and use the term
scratch pool in the description.

Add sufficient type and quantity of media to the scratch pool to service all scratch media
requests that can occur. NetBackup requests scratch media when media in the existing
volume pools are allocated for use.

Scratch pool

Managing volume groups
These topics describe operations you can perform to manage volume groups.

Moving a volume group
You can move a volume group from a robotic library to standalone storage or from
standalone storage to a robotic library.

Moving a volume group changes only the residence information in the EMM
database. You must move the volumes physically to their new locations.

To move a volume group

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the right pane, select the volume group that you want to move.

3 On the Actions menu, select Move.

4 In the Move Volume Group dialog box, specify the properties for the move.
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You can only specify the properties that apply for the move type.

The dialog box shows a move from standalone to the robot TL4(0) on host
prize.

DescriptionProperty

The destination for the move, as follows:

■ If you move the volume group from a robotic library, Standalone
is selected as the destination.

■ If you move the volume group from standalone, Robot is selected
as the destination.

Destination

The host that controls the robotic library.Device host

The destination robotic library.Robot

The volume group to move.

Displays "---" when you move standalone volumes.

Volume group

5 After you move the volume group logically, physically move the volumes to
their new locations.

Deleting a volume group
Use the following procedure to delete a volume group.
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To delete a volume group

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media.

2 In the volumes list, verify that all of the volumes in the group are unassigned.
You cannot delete the group until the application unassigns the volumes. If the
Time Assigned column contains a value, the volume is assigned.

See “About assigning and deassigning volumes” on page 533.

3 Select a volume group in the right pane.

4 On the Edit menu, select Delete.

5 In the confirmation dialog box, confirm the action.

6 Remove the deleted volumes from the storage device.

About media sharing
Media sharing allows media servers to share media for write purposes (backups).

Media sharing provides the following benefits:

■ Increases the utilization of media by reducing the number of partially full media.

■ Reduces media-related expenses because fewer tape volumes are required
and fewer tape volumes are vaulted (NetBackup Vault option).

■ Reduces administrative overhead because you inject fewer scratch media into
the robotic library.

■ Increases the media life because tapes are mounted fewer times. Media are
not repositioned and unmounted between write operations from different media
servers.
Reducing media mounts requires appropriate hardware connectivity between
the media servers that share media and the drives that can write to that media.
Appropriate hardware connectivity may include Fibre Channel hubs or switches,
SCSI multiplexors, or SCSI-to-fibre bridges.

You can configure the following media sharing:

■ Unrestricted media sharing.
See “Configuring unrestricted media sharing” on page 554.

■ Media media sharing with server groups.
See “Configuring media sharing with a server group” on page 554.\
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Note: The access control feature of Sun StorageTek ACSLS controlled robots is
not compatible with media sharing. Media sharing restricts volume access by the
requesting hosts IP address. Use caution when you implement media sharing in
an ACSLS environment.

Configuring unrestricted media sharing
Unrestricted media sharing means that all NetBackup media servers and NDMP
hosts in your NetBackup environment can share media for writing.

Note:Do not use both unrestricted media sharing and media sharing server groups.
If you use both, NetBackup behavior is undefined.

To configure unrestricted media sharing

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties > Master Servers.

2 In the right pane, double-click the master server.

3 Select Media

4 Select Enable Unrestricted Media Sharing for All Media Servers.

If you allow unrestricted allow media sharing in your NetBackup environment,
you do not need to create media sharing groups.

5 Click OK.

Configuring media sharing with a server group
Media sharing with a server group restricts the sharing to members of the group.

See “About NetBackup server groups” on page 400.

Table 10-20 outlines the process for configuring media sharing with a server group.

Note:Do not use both unrestricted media sharing and media sharing server groups.
If you use both, NetBackup behavior is undefined.
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Table 10-20 Configuring media sharing with a server group process overview

DescriptionActionStep

Beyond the scope of the NetBackup
documentation.

Ensure the appropriate connectivity
between and among the media
servers and robots and drives.

Step 1

See “Creating or deleting a NetBackup
server group” on page 400.

Configure the media sharing server
group.

Step 2

Set the Maximum number of partially full
media property for those pools.

See “Adding or deleting a volume pool”
on page 549.

See “Changing the properties of a volume
pool” on page 550.

Optionally, configure the volume
pools for media sharing.

Step 3

Set the Policy Volume Pool and Media
Owner properties of the backup policies.

See “Creating a backup policy” on page 718.

Configure the backup policies that
use the volume pools and media
sharing groups.

Step 4
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Inventorying robots
This chapter includes the following topics:

■ About robot inventory

■ When to inventory a robot

■ About showing a robot's contents

■ Showing the media in a robot

■ About comparing a robot's contents with the volume configuration

■ Comparing media in a robot with the volume configuration

■ About previewing volume configuration changes

■ Previewing volume configuration changes for a robot

■ About updating the NetBackup volume configuration

■ Updating the NetBackup volume configuration with a robot's contents

■ Robot inventory options

■ About the vmphyinv physical inventory utility

■ Example volume configuration updates

About robot inventory
Robot inventory is a logical operation that verifies the presence of media. (Robot
inventory does not inventory the data on the media.)

After you physically add, remove, or move volumes in a robot, use a robot inventory
to update the NetBackup volume configuration.
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The following table describes the NetBackup Administration Console robot
inventory options for the robotic libraries that contain barcode readers and contain
barcoded media.

Table 11-1 Robot inventory options

DescriptionInventory option

Queries the robot for its contents and displays the media in the selected robotic
library; does not check or change the EMM database.

See “About showing a robot's contents” on page 559.

For the robotic libraries without barcode readers (or that contain media without
barcodes ), you can only show the contents of a robot. However, more detailed
information is required to perform automated media management. Use the
vmphyinv physical inventory utility to inventory such robots.

See “About the vmphyinv physical inventory utility” on page 572.

Show contents

Queries the robot for its contents and compares the contents with the contents
of the EMM database. Does not change the database.

See “About comparing a robot's contents with the volume configuration”
on page 563.

Compare contents with volume
configuration

Queries the robot for its contents and compares the contents with the contents
of the EMM database. If differences exist, NetBackup recommends changes to
the NetBackup volume configuration.

See “About previewing volume configuration changes” on page 565.

Preview volume configuration
changes

Queries the robot for its contents; if necessary, updates the database to match
the contents of the robot. If the robot contents are the same as the EMM database,
no changes occur.

See “About updating the NetBackup volume configuration” on page 568.

Update volume configuration

When to inventory a robot
The following table describes the criteria to use to determine when to inventory a
robot and which options to use for the inventory.
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Table 11-2 Robot inventory criteria

Inventory option to useAction

Use the Show contents option to determine the media in a robot and possibly
their barcode numbers.

See “Showing the media in a robot” on page 562.

To determine the contents of a
robot

For the robots with barcode readers and the robots that contain media with
barcodes, use the Compare contents with volume configuration option.

See “Comparing media in a robot with the volume configuration” on page 564.

To determine if volumes were
moved physically within a robot

For any robot NetBackup supports, use theUpdate volume configuration option.

The update creates media IDs (based on barcodes or a prefix that you specify).

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

To add new volumes to a robot (a
new volume is one that does not
have a NetBackup media ID)

Use the Preview volume configuration changes option, which compares the
contents of the robot with the NetBackup volume configuration information.

After you examine the results, use the Update volume configuration option to
update the volume configuration if necessary.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

To determine whether new media
have barcodes before you add
them to NetBackup

If the robot supports barcodes and the volumes have readable barcodes, use the
Update volume configuration option. NetBackup updates the residence
information to show the new robotic location. NetBackup also updates the robot
host, robot type, robot number, and slot location. Specify the volume group to which
the volume is assigned.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

If the robot does not support barcodes or the volumes do not contain readable
barcodes, move the volumes or use the physical inventory utility.

See “About moving volumes” on page 545.

See “About the vmphyinv physical inventory utility” on page 572.

To insert existing volumes into a
robot (an existing volume is one
that already has a NetBackup
media ID)

If the robotic library supports barcodes and the volumes have readable barcodes,
use the Update volume configuration option. NetBackup updates the residence
information to show the new robotic or standalone location.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

To move existing volumes
between robotic and standalone
(an existing volume is one that
already has a NetBackup media
ID)
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Table 11-2 Robot inventory criteria (continued)

Inventory option to useAction

If the robot supports barcodes and the volumes have readable barcodes, use the
Update volume configuration option. NetBackup updates the residence
information to show the new slot location.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

If the robot does not support barcodes or if the volumes do not contain readable
barcodes, move the volumes or use the physical inventory utility.

See “About moving volumes” on page 545.

See “About the vmphyinv physical inventory utility” on page 572.

To move existing volumes within
a robot (an existing volume is one
that already has a NetBackup
media ID)

If the robotic library supports barcodes and the volumes have readable barcodes,
use theUpdate volume configuration option. NetBackup updates the NetBackup
volume configuration information.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

If the robots do not support barcodes or the volumes do not contain readable
barcodes, move the volumes or use the physical inventory utility.

See “About moving volumes” on page 545.

See “About the vmphyinv physical inventory utility” on page 572.

For either operation, perform the following updates:

■ First move the volumes to standalone
■ Then move the volumes to the new robot

If you do not perform both updates, NetBackup cannot update the entries and
writes an "Update failed" error.

To move existing volumes from
one robot to another (an existing
volume is one that already has a
NetBackup media ID)

For any robot NetBackup supports, use the Update volume configuration option
to update the NetBackup volume configuration information.

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

To remove existing volumes from
a robot (an existing volume is one
that already has a NetBackup
media ID)

About showing a robot's contents
Show contents inventories the selected robotic library and generates a report.
This operation does not check or change the EMM database. Use this option to
determine the contents of a robot.

The contents that appear depend on the robot type.
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The following table describes the report contents.

Note: On UNIX: If a volume is mounted in a drive, the inventory report lists the slot
from which the volume was moved to the drive.

Table 11-3 Show contents description

Report contentsRobot and media

Shows if each slot has media and lists the
barcode for the media.

The robot has a barcode reader and the robot
contains media with barcodes.

Shows if each slot has media.The robot does not have a barcode reader or
the robot contains media without barcodes.

Shows a list of the volumes in the robot.

See “About inventory results for API robots”
on page 560.

API robot.

The following figure shows an example of the report.

Figure 11-1 Show contents report

See “Showing the media in a robot” on page 562.

About inventory results for API robots
The following table describes the contents of the robot inventory for the API robots.
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Table 11-4 API robot report contents

Report contentsRobot type

The results, received from ACS library software, show the following:

■ The ACS library software volume ID. The NetBackup media ID
corresponds to the ACS library software volume ID.

■ The ACS media type.
■ The NetBackup Media Manager media type.
■ The mapping between the ACS library software media type and the

corresponding NetBackup Media Manager media type (without
considering optional barcode rules).

ACS

The results, received from the Automated Tape Library (ATL) library
manager, show the following:

■ The volume serial number (volser). The Media Manager media ID
corresponds to the ATL volser.

■ The ATL media type.
■ The Media Manager media type.
■ The mapping between the ATL media type and the corresponding

Media Manager media type (without considering optional barcode
rules).

TLH

The results, received from the DAS/SDLC server, show the following:

■ The volume serial number (volser). The Media Manager media ID
corresponds to the DAS/SDLC volser.

■ The DAS/SDLC media type
■ The Media Manager media type.
■ The mapping between the DAS/SDLC media type and the

corresponding Media Manager media type (without considering
optional barcode rules).

TLM

The following figure shows the results for an ACS robot; the results for other API
robots are similar.
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Figure 11-2 Show contents report (API robot)

Showing the media in a robot
Use the following procedure to show the media that is in a robot.

See “About robot inventory” on page 556.

See “Robot inventory options” on page 571.

To show the media in a robot

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Robots.

2 Select the robot you want to inventory.
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3 On the Actions menu, select Inventory Robot.

4 In the Robot Inventory dialog box, select Show contents.

5 Click Start to begin the inventory.

About comparing a robot's contents with the
volume configuration

Compare contents with volume configuration compares the contents of a robotic
library with the contents of the EMMdatabase. Regardless of the result, the database
is not changed.

Table 11-5 Compare contents description

Report contentsRobot and media

The report shows the differences between
the robot and the EMM database

The robot can read barcodes
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Table 11-5 Compare contents description (continued)

Report contentsRobot and media

The report shows only whether a slot contains
a volume

If the media cave barcodes, this operation is
useful for determining if volumes have been
physically moved within a robot.

The robot cannot read barcodes

The media ID and media type in the EMM
database are compared to the information
that is received from the vendor’s robotic
library software.

For API robots

If the results show that the EMM database does not match the contents of the
robotic library, perform the following actions:

■ Physically move the volume.

■ Update the EMM database. Use Actions > Move or use the Update volume
configuration option.

See “About updating the NetBackup volume configuration” on page 568.

The following figure shows a sample compare report.

Figure 11-3 Compare contents report (API robot)

See “Comparing media in a robot with the volume configuration” on page 564.

Comparing media in a robot with the volume
configuration

Use the following procedure to compare themedia in a robot with the EMMdatabase.
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See “About robot inventory” on page 556.

See “Robot inventory options” on page 571.

To compare media in a robot with the volume configuration

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Robots.

2 Select the robot that you want to inventory.

3 On the Actions menu, select Inventory Robot.

4 In the Robot Inventory dialog box, select Compare contents with volume
configuration.

5 Click Start to begin the inventory.

About previewing volume configuration changes
Use this option to preview the changes before you update the EMM database. This
option lets ensure that all new media have barcodes before you add them to the
EMM database.
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Note: If you preview the configuration changes first and then update the EMM
database, the update results may not match the results of the preview operation.
Possible causes may be the changes that occur between the preview and the
update. Changes can be to the state of the robot, to the EMM database, to the
barcode rules, and so on.

Figure 11-4 Preview volume configuration changes (non-API robot)

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

Previewing volume configuration changes for a
robot

Use the procedure in this topic to preview any volume configuration changes for a
robot.

See “About previewing volume configuration changes” on page 565.

See “Robot inventory options” on page 571.

To preview the volume configuration changes for a robot

1 If necessary, insert new volume(s) into the robotic library.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Robots.

3 Select the robot you want to inventory.
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4 On the Actions menu, select Inventory Robot.

5 In the Robot Inventory dialog box, select Preview volume configuration
changes.

Note: If you preview the configuration changes first and then update the EMM
database, the update results may not match the results of the preview operation.
Possible causes may be the changes that occur between the preview and the
update. Changes can be to the state of the robot, to the EMM database, to the
barcode rules, and so on.

6 To change the default settings and rules that NetBackup uses to name and
assign attributes to new media, click Advanced Options.

See “About configuring media name and attribute rules” on page 495.

7 To inject any media that is in the media access port before the preview
operation, click Empty media access port prior to update.

8 Click Start to begin the inventory preview.
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About updating the NetBackup volume
configuration

The Update volume configuration robot inventory option updates the database
to match the contents of the robot. If the robot contents are the same as the EMM
database, no changes occur.

For a new volume (one that does not have a NetBackup media ID), the update
creates a media ID. The media ID depends on the rules that are specified on the
Advanced Robot Inventory Options dialog box.

See “Robot inventory options” on page 571.

For API robots, the update returns an error if the volume serial number or the media
ID contain unsupported characters.

For robots without barcode readers, the new media IDs are based on a media ID
prefix that you specify. Similarly, for volumes without readable barcodes, the new
media IDs are based on a media ID prefix that you specify

Figure 11-5 is an example for an ACS robot. Results for other API robots are similar.

Robot inventory update returns an error if it encounters unsupported characters in
the volume serial number or media identifier from API robots.

See “Volume update prerequisites” on page 568.

Figure 11-5 Update volume configuration for API robot report

See “Updating the NetBackup volume configuration with a robot's contents”
on page 569.

Volume update prerequisites
The following are the robot prerequisites and media prerequisites for updating the
volume configuration:
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■ The robotic library must read barcodes.

■ Volumes in the library must have readable barcodes.

You can check the barcode capabilities of the robotic library and the volumes by
comparing the robot contents with the NetBackup volume configuration.

See “Comparing media in a robot with the volume configuration” on page 564.

If the robotic library does not support barcodes or the volumes do not have readable
barcodes, save the results of the compare operation. The results can help you
determine a media ID prefix if you use the Media Settings tab of the Advanced
Options dialog box to assign a prefix.

Updating the NetBackup volume configuration
with a robot's contents

Use the procedure in this topic to update the EMM database with the contents of
a robot.

See “About updating the NetBackup volume configuration” on page 568.

See “Robot inventory options” on page 571.

To update the volume configuration with a robot's contents

1 If necessary, insert new volume(s) into the robotic library.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Media > Robots.

3 Select the robot you want to inventory.
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4 On the Actions menu, select Inventory Robot.

5 In the Robot Inventory dialog box, select Update volume configuration.

Note: If you preview the configuration changes first and then update the EMM
database, the update results may not match the results of the preview operation.
Possible causes may be the changes that occur between the preview and the
update. Changes can be to the state of the robot, to the EMM database, to the
barcode rules, and so on.

6 To change the default settings and rules that NetBackup uses to name and
assign attributes to new media, click Advanced Options.

See “About configuring media name and attribute rules” on page 495.

7 To inject any media that is in the media access port before the update operation,
click Empty media access port prior to update.

8 Click Start to begin the inventory update.
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Robot inventory options
The following table shows the robot inventory options when you use theNetBackup
Administration Console:

Table 11-6 Robot inventory options

DescriptionOption

Advanced Options is active if Preview volume configuration changes or
Update volume configuration is selected.

This button opens the Advanced Robot Inventory Options dialog box, from
which you can configure more options.

See “About configuring media name and attribute rules” on page 495.

Advanced options

The Device host option is the host that controls the robot.Device host

The Empty media access port prior to update operation is active only for the
robots that support that function.

To inject volumes in the robot’s media access port into the robot before you begin
the update, select Empty media access port prior to update.

The volumes to be injected must be in the media access port before the operation
begins. If you select Empty media access port prior to update and the media
access port is empty, you are not prompted to place volumes in the media access
port.

Note: If you use NetBackup to eject volumes from the robot, remove the volumes
from the media access port before you begin an inject operation. Otherwise, if
the inject port and eject port are the same, the ejected volumes may be injected
back into the robotic library.

Empty media access port prior
to update

Use the Robot option to select a robot to inventory.

If you selected a robot in the NetBackup Administration Console, that robot
appears in this field.

Robot

Displays the media in the selected robotic library; does not check or change the
EMM database.

See “About showing a robot's contents” on page 559.

Show contents

Compares the contents of a robotic library with the contents of the EMM database
but does not change the database.

See “About comparing a robot's contents with the volume configuration”
on page 563.

Compare contents with volume
configuration
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Table 11-6 Robot inventory options (continued)

DescriptionOption

Compares the contents of a robotic library with the contents of the EMM database.
If differences exist, NetBackup recommends changes to the NetBackup volume
configuration.

See “About previewing volume configuration changes” on page 565.

Preview volume configuration
changes

Updates the database to match the contents of the robot. If the robot contents
are the same as the EMM database, no changes occur.

See “About updating the NetBackup volume configuration” on page 568.

Update volume configuration

About the vmphyinv physical inventory utility
For the following robotic libraries, theNetBackup Administration Console reports
only the presence of media:

■ For the robots without barcode readers

■ For the robots that contain media without barcodes

More detailed information is required to perform automated media management.
For such robots, use the vmphyinv physical inventory utility.

The vmphyinv physical inventory utility inventories non-barcoded tape libraries by
performing the following actions:

■ Mounts each tape

■ Reads the tape header

■ Identifies the tape in each slot

■ Updates the NetBackup volume configuration
Use the vmphyinv -verbose option to display more information about the
suggested changes. The -verbose option shows the number of drives available,
the contents of each tape, if the media is a catalog tape. (The media format
column of the summary contains NetBackup database for NetBackup catalog
tapes.)
This verbose information is written to stderr. To save the information, redirect
stderr to a file.

vmphyinv is a command-line utility. Additional information about the syntax of the
vmphyinv command is available.

See the NetBackup Commands Reference Guide, available at the following URL:

http://www.veritas.com/docs/DOC5332
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Table 11-7 vmphyinv features, requirements, restrictions, and when to use

DescriptionItem

The vmphyinv utility has the following features:

■ Can be run from any master server, media server, or SAN media server.
■ Can be used with barcoded tape libraries because it verifies the contents of the

media.
■ Recognizes the NetBackup tape formats.
■ Supports the remote administration. You do not need to run vmphyinv from the

host to which the drives are attached.
■ Tries to use multiple drives in a robot even if the drives are attached to different

hosts.
■ Works with shared drives (NetBackup Shared Storage Option).
■ Supports all supported SCSI-based robot types.
■ Can be used to inventory a single media in a standalone drive. Use the -u option

or the -n option to specify the drive; the drive must contain media and it must be
ready.

vmphyinv features

The vmphyinv utility has the following requirements and restrictions:

■ It cannot distinguish between the volume records based on the application type.
■ When you move the media from robotic drives to standalone drives, you cannot

specify a new volume group for the media.

vmphyinv requirements and
restrictions

Use vmphyinv to update the EMM database for NetBackup in the following cases:

■ You want to inventory a robot that does not have a barcode reader or that contains
non-barcoded media.

■ You insert new media into a robotic library and no NetBackup volume records
correspond to the media. Use the slot range or list option of vmphyinv to perform
the inventory operation. You do not need to add volume records to the EMM
database.

■ You insert some media that have unknown media IDs or globally unique identifiers
(GUIDs) into a robot.
For example, you insert 10 media from a different tape library in slots 11 to 20. You
do not know the IDs on the tapes. Use the slot range or list option of vmphyinv to
perform the inventory operation. The vmphyinv utility mounts the media, reads
the tape header, determines the media ID, and adds media records to the EMM
database.

■ Some of the media are misplaced and the EMM database does not reflect the
correct physical location of these media. Inventory the robot or inventory a subset
of media in the robot by using options in vmphyinv.

When to use vmphyinv

See “How vmphyinv performs a physical inventory” on page 574.

573Inventorying robots
About the vmphyinv physical inventory utility



How vmphyinv performs a physical inventory
For a physical inventory, the vmphyinv utility performs the following sequence of
operations:

■ Obtains a list of drives to mount the media
See “About the vmphyinv list of drives” on page 574.

■ Obtains a list of media to mount
See “About the media that vmphyinv mounts” on page 574.

■ Mounts the media and reads the tape headers
See “How vmphyinv mounts the media and reads the tape header” on page 575.

■ Updates the EMM database
See “How vmphyinv updates the EMM database” on page 577.

About the vmphyinv list of drives
The list of drives the vmphyinv utility uses to mount the media is obtained from the
EMM database. The drives do not need to be configured locally.

You cannot specify which drives to use. However, you can specify the maximum
number of drives to use, which lets you reserve drives for NetBackup backup or
restore operations. Specify the number of drives by using the -drv_cnt drive_count
option.

About the media that vmphyinv mounts
The vmphyinv command accepts several options for the media to be mounted, as
follows:

■ NetBackup robot number (-rn robot_number).
The vmphyinv utility obtains a list of volume records for that robot and inventories
each of the media in the list.
To use this option, the NetBackup configuration must contain a volume record
that corresponds to the robot number in the EMM database for the robot.

■ NetBackup robot number with filter options.
If you do not want to inventory all of the media in a robot, specify a subset of
the media by using filter options. Some filter options are volume pool, volume
group, or slot range. To use these options, NetBackup volume records must
exist.
The following are some filter examples.

Mounts the media only in robot 4 and in the
volume pool bear.

vmphyinv -rn 4 -pn bear
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Mounts the media in robot 2 and in the volume
group moon.

vmphyinv -rn 2 -v moon

Mounts the media in robot 1 and slot range 2
to 4.

vmphyinv -rn 1 -rc1 2 -number
3

Mounts the media in robot 5, slot range 2 to 7,
in volume group mars, and in the NetBackup
volume pool.

vmphyinv -rn 5 -pn NetBackup
-v mars -rc1 2 -number 6

■ NetBackup robot number and a list of media that belong to a specific robot.
For example, if the -rn robot_number and -ml A00001:A00002:A00003 options
are specified, only the three specified media are inventoried. If any of these
media do not belong to the specified robot, the media are skipped and are not
inventoried. To use this option, NetBackup volume records must exist.

■ NetBackup robot number and a slot range or list.
Sometimes, media from a different robot or some other source are moved to a
robot and the media ID on the tape is unknown. In these cases, specify a slot
range option or list option.
With these options, the NetBackup volume record does not need to exist in the
EMM database. However, you must specify the density (using the -d option).

Note: For a robot that supports multiple media types, specify the density carefully.
If you specify the incorrect density, vmphyinv cannot complete the mount and
permanent drive failure can occur.

The following are some filter examples.

Mounts the media in slot range 2 to 10 in
robot 1.

vmphyinv -rn 1 -slot_range 2 10
-d dlt

Mounts the media in slots 3, 4, and 5 in
robot 0.

vmphyinv -rn 0 -slot_list 3:4:5
-d 8mm

Mounts the media in slots 2, 3, 4, 5, 6, and
7 in robot 2.

vmphyinv -rn 2 -slot_range 2 4
-slot_list 5:6:7 -d dlt

See “About the vmphyinv physical inventory utility” on page 572.

How vmphyinv mounts the media and reads the tape
header
The following sequence of operations explains the mount process:
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■ The vmphyinv utility contacts the NetBackup VolumeManager, vmd, on the local
host or remote host depending on where the drive is attached.

■ The NetBackup Volume Manager starts a process, oprd.

■ The vmphyinv utility communicates with oprd and sends the mount request to
oprd. After oprd receives the request, it issues a mount request to ltid.

■ The vmphyinv utility reads the tape header to determine the recorded media
ID or globally unique identifier (GUID).

Note: The default mount timeout is 15 minutes. Specify a different mount time
by using the -mount_timeout option.

See “About the media that vmphyinv does not recognize” on page 576.

See “How vmphyinv processes cleaning media” on page 576.

About the media that vmphyinv does not recognize
If the media is not NetBackup media, the media is unmounted and the next media
is mounted. vmphyinv does not generate a new record in the EMM database. To
generate volume records for that media, use the vmupdate command.

How vmphyinv processes cleaning media
If the following conditions are all true, vmphyinv does not try to mount the media
and the next media in the list is mounted:

■ You do not specify the vmphyinv slot range or list option.

■ The robot contains cleaning media.

■ The media type is specified as cleaning media in the volume record (such as
4mm_clean or dlt_clean).

If the robot contains cleaning media and any of the following conditions are true,
vmphyinv tries to determine if the media is cleaning media:

■ You use the slot range or list option and the media type of volume record in the
EMM database is not a cleaning media type.

■ You use the slot range or list option, and the EMM database does not contain
a volume record that corresponds to the cleaning media.

■ You do not use the slot range or list option, and the EMM database does not
contain a volume record that corresponds to the cleaning media.

The vmphyinv utility tries to determine if the media is cleaning media. It uses the
SCSI parameters (sense keys, tape alert flags, and physical (SCSI) media types)
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returned by the robot. If vmphyinv cannot determine if the media is cleaning media,
it tries to mount the media until the mount request times out.

Note: NetBackup may not detect the presence of cleaning media for all drives.
Some drives report the presence of cleaning media in a manner NetBackup cannot
read.

How vmphyinv updates the EMM database
After all of the media are mounted and the tape headers are read, vmphyinv displays
a list of recommended changes. Accept or reject the changes. If you accept the
changes, vmphyinv updates the EMM database.

Table 11-8 vmphyinv criteria and actions

DescriptionCriteria or action

For valid media types, vmphyinv performs the following actions:

■ Changes the residence fields and description fields of any NetBackup media record
if those fields do not match the media header.

■ Conditionally changes the media type of an unassigned NetBackup volume record.
The media type is changed only if the new media type belongs to the same family
of media types as the old media type. For example, the media type DLT can only
be changed to DLT2 or DLT3.

■ Never changes the volume pool, media type, and ADAMM_GUID of an assigned
record.

■ Never unassigns an assigned NetBackup volume.

The vmphyinv update
criteria

The vmphyinv utility searches the EMM database. It checks if the media ID from the
tape is present in the media ID field of any record in the EMM database. If the media
ID exists, vmphyinv updates the NetBackup volume record that corresponds to the
media ID. If the media ID does not exist, vmphyinv creates a new NetBackup volume
record that corresponds to the NetBackup media.

How vmphyinv updates
NetBackup media
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Table 11-8 vmphyinv criteria and actions (continued)

DescriptionCriteria or action

The vmphyinv utility may not be able to update the EMM database correctly in the
following cases. These cases are reported as errors.

If any of the following cases are encountered, you must intervene to continue:

■ Duplicate media IDs are found.
Two or more media in the same robot have the same media ID.

■ A NetBackup volume record that belongs to a different robot is found.
It contains the same media ID as the media ID read from the tape header.

■ The media type, media GUID, or volume pool of an assigned volume record needs
to be changed.

■ The barcode of an existing volume record needs to be changed.

vmphyinv error cases

See “About the vmphyinv physical inventory utility” on page 572.

Example volume configuration updates
The following examples show different types of volume configuration updates. The
examples include only the relevant volume attributes.

Example 1: Removing a volume from a robot
The following is an example of how to remove a volume from a robotic library. It
does not matter whether the robot supports barcodes.

The following are the attributes for media ID 800001:

800001Media ID

8MM cartridge tapeMedia type

TL800001Barcode

TL8 backup volumeMedia description

NetBackupVolume pool

TL8 - Tape Library 8MMRobot type

EXB220Volume group

0 (unlimited)Maximum mounts allowed

Assume that you remove the volume from the robotic library, specify the following
on the Media Settings tab, then run the update:
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DEFAULTMedia type

NONROB_8MMVolume group

DEFAULTVolume pool

The resulting volume attributes for media ID 800001 are as follows:

800001Media ID

8MM cartridge tapeMedia type

TL800001Barcode

TL8 backup volumeMedia description

NetBackupVolume pool

NONE - Not RoboticRobot type

NONROB_8MMVolume group

0 (unlimited)Maximum mounts allowed

The new residence information in the EMM database shows a standalone location
in the volume group. The volume group is specified on the Media Settings tab.
The media type and volume pool remain unchanged.

The results are the same for a volume that does not have a barcode.

Example 2: Adding existing standalone volumes to a robot
The following is an example of how to add a standalone volume that has a barcode
to a robotic library that supports barcodes (TL8).

When youmove volumes from one robot to another robot, perform separate updates.

The following are the volume attributes for media ID 800021, which has a readable
barcode and already exists as a standalone volume:

800021Media ID

8MM cartridge tapeMedia type

TL800021Barcode

8MM standaloneMedia description

NoneVolume pool

None (standalone)Robot type
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NONROB_8MMVolume group

0 (unlimited)Maximum mounts allowed

Assume that you insert the volume into a TL8 robot, specify the following on the
Media Settings tab, then run the update:

DEFAULTMedia type

EXB220Volume group

YES (selected)Use barcode rules

NetBackupVolume pool

Assume that the barcode rules in Table 11-9 exist.

Table 11-9 Example barcode rules

DescriptionMax mounts/
cleanings

Volume poolMedia typeBarcode tag

DLT cleaning30NoneDLT_CLNCLND

8mm cleaning20None8MM_CLNCLN8

TL8 backup0NetBackup8MMTL8

DLT backup200d_poolDLTDLT

8mm no pool0None8MMTS

No barcode0NoneDEFAULT<NONE>

Other barcodes0NetBackupDEFAULT<DEFAULT>

NetBackup recognizes that the media ID exists and changes the EMM database
to reflect the new robotic location. NetBackup does not create a new media ID.

The volume attributes for media ID 800021 are as follows:

800021Media ID

8MM cartridge tapeMedia type

TL800021Barcode

8MM standaloneMedia description

NONEVolume pool
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TL8 - Tape Library 8MMRobot type

0Robot number

1Robot slot

sharkRobot host

EXB220Volume group

0 (unlimited)Maximum mounts allowed

The barcode matches the barcode of an existing standalone volume in the
configuration. Therefore, NetBackup updates the residence information in the EMM
database to reflect the new robotic location. Because the volume is not new, barcode
rules are ignored.

The only setting used on the Media Settings tab is the volume group for added or
moved volumes. The media type setting was not used because this example was
for a single existing volume that already had a media type.

Example 3: Moving existing volumes within a robot
The following is an example of how to move a volume from one slot to another slot
within the same robot. The robot supports barcodes and the volume has a readable
barcode.

Note: Tomove volumes within a robotic library, useUpdate volume configuration
only if the robotic library supports barcodes and the volumes have readable
barcodes. Otherwise, NetBackup cannot properly recognize the move.

The following are the attributes for media ID 800002, which currently resides in slot
1 of the robotic library:

800002Media ID

8MM cartridge tapeMedia type

TL800002Barcode

TL8 backupMedia description

NetBackupVolume pool

TL8 - Tape Library 8MMRobot type

0Robot number
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1Robot slot

sharkRobot host

EXB220Volume group

0 (unlimited)Maximum mounts allowed

Assume that you move the volume to empty slot 10, specify the following on the
Media Settings tab, then run the update.

DEFAULTMedia type

EXB220Volume group

NO (not selected)Use barcode rules

DEFAULTVolume pool

The resulting volume attributes are the following:

800002Media ID

8MM cartridge tapeMedia type

TL800002Barcode

TL8 backupMedia description

NetBackupVolume pool

TL8 - Tape Library 8MMRobot type

0Robot number

10Robot slot

sharkRobot host

EXB220Volume group

0 (unlimited)Maximum mounts allowed

The updated volume attributes show the new slot number, but all other information
is unchanged.

Example 4: Adding new volumes to a robot
The following is an example of how to add new volumes with barcodes to a robot
that supports barcodes.
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Assume the following:

■ The new volume is an 8MM tape with a readable barcode of TL800002.

■ No media generation rules are defined.

■ The drives in the robot all have a drive type of 8MM or no drives are configured
on the robot control host.

Specify the following on the Media Settings tab and run the update:

DEFAULTMedia type

EXB2220Volume group

YES (selected)Use barcode rules

DEFAULTVolume pool

The following table contains the example barcode rules.

Table 11-10 Example barcode rules

DescriptionMax mounts/
cleanings

Volume poolMedia typeBarcode tag

DLT cleaning30NoneDLT_CLNCLND

8mm cleaning20None8MM_CLNCLN8

TL8 backup0NetBackup8MMTL8

DLT backup200d_poolDLTDLT

8mm no pool0None8MMTS

No barcode0NoneDEFAULT<NONE>

The barcode on the media matches the barcode rule named TL8 and the resulting
volume attributes for the new volume are as follows:

800002Media ID

8MM cartridge tapeMedia type

TL800002Barcode

tl8 backupMedia description

NetBackupVolume pool
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TL8 - Tape Library 8MMRobot type

0Robot number

1Robot slot

sharkRobot host

EXB220Volume group

0 (unlimited)Maximum mounts allowed

No media ID generation rules exist. Therefore, the media ID is from the last six
characters of the barcode. The new residence information in the EMM database
shows the robot host, robot type, robot number, slot, and host. The volume group
is from the Media Settings tab. The volume pool and the max mounts allowed are
from the barcode rule.

If barcode rules (or barcodes) are not used, the media description, volume pool,
and max mounts allowed are set to the following defaults:

Added by NetBackupMedia description

NetBackup for data tapes or None for cleaning tapesVolume pool

0 (unlimited)Maximum mounts allowed

Note: If the robot does not support barcodes or the barcode is unreadable, specify
a Media ID prefix on the Media Settings tab. Alternatively, specify DEFAULT for
the media ID. If you do not, NetBackup does not add new media IDs.

Example 5: Adding cleaning tapes to a robot
A special case exists when you add cleaning tapes. For example, assume that you
update a TLD robot.

The tapes you inserted include regular tapes with barcodes that range from
DLT00000 to DLT00010 and a cleaning tape with a barcode of CLN001.

The following table contains the example barcode rules.

Table 11-11 Example barcode rules

DescriptionMax mounts/
cleanings

Volume poolMedia typeBarcode tag

DLT cleaning30NoneDLT_CLNCLN
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Table 11-11 Example barcode rules (continued)

DescriptionMax mounts/
cleanings

Volume poolMedia typeBarcode tag

DLT backup200d_poolDLTDL

No barcode0NoneDEFAULT<NONE>

Specify the following on the Media Settings tab, then run the update.

DLTMedia type

STK7430Volume group

YES (selected)Use barcode rules

The barcodes on the regular tapes match the DL barcode rule. The media type of
the DL barcode rule matches the Media type on theMedia Settings tab. The tapes
are added as DLT.

The cleaning tape matches the CLN barcode rule. NetBackup recognizes that
DLT_CLN is the cleaning tape for DLT. NetBackup adds the cleaning tape CLN001
as DLT_CLN type media along with the regular volumes.

This example shows NetBackup’s ability to add cleaning cartridges along with
regular volumes when you use Update volume configuration.

If the volumes you insert include a cleaning tape, NetBackup adds the volumes
correctly if the following are true:

■ The Media type on the Media Settings tab is the regular media (DLT in this
example).

■ The barcode on the volume matches a barcode tag (CLN in this example).

■ The media type for the barcode rule is the correct cleaning media (DLT_CLN
in this example).

To add only cleaning media, specify the cleaning media type on theMedia Settings
tab and in the barcode rule (DLT_CLN in this example).

Example 6: Moving existing volumes between robots
When you move volumes from one robot to another and the volumes in both robots
are in the same EMM database, perform two separate updates.

These updates move the volumes to stand alone, as an intermediate step, and then
to the new robot. Otherwise, NetBackup is unable to update the entries and you
receive an "Update request failed" error.
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This example assumes that robot 2 is able to read barcodes and the volume has
readable barcodes. If not, NetBackup cannot manage the volumes.

To move existing volumes between robots, use the following process:

■ Remove the volume from robot 1 and insert the volume in robot 2.

■ Perform an Update volume configuration on robot 1. This action updates the
volume attributes to show the volume as standalone.

■ Perform an Update volume configuration on robot 2. This action updates the
configuration to show the volume in robot 2.

This example is not recommended and is included only to illustrate the undesirable
results.

The following is an example of how to add an existing standalone volume to a TL4
robot. A TL4 robot supports media inventory (detects media presence), but not
barcodes.

The following are the attributes for media ID 400021, which already exists as a
standalone volume:

400021Media ID

4MM cartridge tapeMedia type

-----------Barcode

4MM standaloneMedia description

NoneVolume pool

NONE - Not RoboticRobot type

NONROB_4MMVolume group

0 (unlimited)Max mounts allowed

Example 7: Adding existing volumes when barcodes are
not used
Assume that you insert the volume into the robot, specify the following on theMedia
Settings tab, and run the update:

DEFAULTMedia type

00_000_TL4Volume group

C4Media ID prefix

586Inventorying robots
Example volume configuration updates



DEFAULTVolume pool

The resulting volume attributes are as follows:

C40000Media ID

4MM cartridge tapeMedia type

-----------Barcode

Added by NetBackupMedia description

NetBackupVolume pool

TL4 - Tape Library 4MMRobot type

0Robot number

1Robot slot

sharkRobot host

00_000_TL4Volume group

0 (unlimited)Maximum mounts allowed

Note that NetBackup assigned a new media ID to the volume (C40000). This
undesired result occurs if you use Update volume configuration and the volumes
do not contain readable barcodes or the robot does not support barcodes. Without
a barcode, NetBackup cannot identify the volume and assumes that it is new. The
media ID C40000 is generated from the media ID prefix that is specified on the
Media Settings tab.

The old media ID (400021) remains in the configuration. The information for the
new media ID (C40000) shows the robotic location, which includes the robot host,
robot type, number, slot, and host. The volume group and volume pool are configured
according to the Media Settings tab selections. The maximum mounts allowed is
set to the default (0).

For this situation, use the physical inventory utility.

See “About the vmphyinv physical inventory utility” on page 572.
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Configuring storage units
This chapter includes the following topics:

■ About the Storage utility

■ Creating a storage unit

■ About storage unit settings

About the Storage utility
The data that is generated from a NetBackup job is recorded into a type of storage
that NetBackup recognizes.

NetBackup recognizes the following storage configurations, all of which are
configured in the Storage utility:

Storage units
A storage unit is a label that NetBackup associates with physical storage. The label
can identify a robot, a path to a volume, or a disk pool. Storage units can be included
as part of a storage unit group or a storage lifecycle policy.

See “Creating a storage unit” on page 590.

Storage unit groups
Storage unit groups let you identify multiple storage units as belonging to a single
group. The NetBackup administrator configures how the storage units are selected
within the group when a backup or a snapshot job runs.

See “About storage unit groups” on page 634.

Storage lifecycle policies
Storage lifecycle policies let the administrator create a storage plan for all of the
data in a backup or snapshot.
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See “About storage lifecycle policies” on page 645.

Using the Storage utility
To use the storage utility

◆ In theNetBackupAdministrationConsole, expandStorage >Storage Units,
Storage Unit Groups, or Storage Lifecycle Policies.

The storage destinations that were created for the selected server are displayed
in the right pane.

The storage configuration can be displayed for other master servers.

See “Accessing remote servers” on page 1173.

Figure 12-1 Storage Unit node of the Storage utility

1

2

7

3

4
5

6

Table 12-1 Storage Unit utility

DescriptionNumber

Currently selected master server.1

Click to create a new storage unit.

See “About storage unit settings” on page 604.

2

Click to create a new storage unit group.

See “Creating storage unit groups for backups” on page 635.

3
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Table 12-1 Storage Unit utility (continued)

DescriptionNumber

Click to copy a storage unit.

See “Creating a storage unit by copying a storage unit” on page 593.

4

Click to initiate a data management job when using basic disk staging.

See “About basic disk staging” on page 621.

5

Click to create a new storage lifecycle policy.

See “Creating a storage lifecycle policy” on page 646.

6

Right-click in the right pane to view the shortcut menu.7

Creating a storage unit
A storage unit is a label that NetBackup associates with physical storage. The label
can identify a robot, a path to a volume, or a disk pool. Storage unit creation is part
of several other wizards. However, a storage unit can be created directly from the
Storage utility in the NetBackup Administration Console.

Figure 12-2 shows the different storage unit types and the option that needs to be
installed, if necessary.
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Figure 12-2 Storage unit types

AdvancedDisk
Points to a disk pool (storage directly attached to a
media server). (Data Protection Optimization
Option)

BasicDisk
Points to a directory.

Cloud Storage (VendorName)
Points to a disk pool of the type identified by
VendorName where VendorName can be the name
of a cloud storage provider.

OpenStorage (StorageName)
Points to a disk pool of the type identified by
StorageName. (OpenStorage Disk Option)

PureDisk
Points to a disk pool. (Data Protection Optimization
Option)

Media Manager

Points to a robot
or a standalone
drive

NDMP

Points to an
NDMP host
(NDMP Option)

Disk

To create a storage unit

1 In the NetBackup Administration Console, select the Storage utility.

2 Select Actions > New > New Storage Unit.

3 Enter a Storage unit name.

See “NetBackup naming conventions” on page 1163.

4 Select the Storage unit type. The selection specifies the type of storage that
the storage unit uses: Media Manager, Disk, or NDMP.

5 For disk storage units:

■ Select a disk type from the Disk type drop-down menu.
The Disk type identifies the type of storage unit destination:

The destination is a disk pool.AdvancedDisk
storage unit

The destination is a path to a volume on a host.BasicDisk
storage unit
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The destination is a disk pool of the type that includes a
VendorName string. VendorName can be the name of a cloud
storage provider.

The values also can contain a _crypt suffix (for example,
Amazon_crypt). The _crypt suffix indicates encrypted storage.

Cloud storage
unit

The destination is an NDMP host. The NDMP protocol is used to
perform backups and recoveries.

NDMP storage

The destination is a disk pool of the type that includes a
VendorName string. The vendor supplies theStorageName string.

OpenStorage
storage unit

The destination is a Media Server Deduplication Pool or a
PureDisk Deduplication Pool.

See the NetBackup Deduplication Guide.

PureDisk
storage unit

■ Select the disk pool for this storage unit.
See “Select disk pool storage unit setting” on page 617.

■ Select a media server in theMedia server drop-down menu. The selection
indicates that the media server has permission to write to the storage unit.

■ Absolute pathname to directory or Absolute pathname to volume
setting.
See “Absolute pathname to directory or absolute pathname to volume
setting for storage units” on page 604.

■ Maximum concurrent jobs
See “Maximum concurrent jobs storage unit setting” on page 608.

■ Reduce fragment size
See “Reduce fragment size storage unit setting” on page 616.

■ High water mark
See “High water mark storage unit setting” on page 606.

■ Low water mark
See “Low water mark storage unit setting” on page 607.

■ Enable block sharing
See “Enable block sharing storage unit setting” on page 605.

■ Enable Temporary staging area
See “Enable temporary staging area storage unit setting” on page 618.

6 For Media Manager storage units, data is written to tape robots and standalone
tape drives:
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■ Select a storage device from the Storage Device drop-down menu.

■ Select a media server in theMedia server drop-down menu. The selection
indicates that the media server has permission to write to the storage unit.

■ Maximum concurrent write drives
See “Maximum concurrent write drives storage unit setting” on page 607.

■ Enable multiplexing
See “Enable multiplexing storage unit setting” on page 606.

■ Reduce fragment size
See “Reduce fragment size storage unit setting” on page 616.

7 Click OK to save the storage unit configuration.

Creating a storage unit by copying a storage unit
The following procedure describes how to create a storage unit by copying a storage
unit.

To create a storage unit by copying an existing storage unit

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage.

2 In the right pane, select a storage unit.

3 Click Actions > Copy Storage Unit.

4 Type a unique name for the new storage unit. For example, describe the type
of storage. Use this name to specify a storage unit for policies and schedules.

See “NetBackup naming conventions” on page 1163.

5 Complete the fields in the Copy Storage Unit dialog box.

See “About storage unit settings” on page 604.

Changing storage unit settings
Veritas suggests that changes be made only during periods when no backup activity
is expected for the policies that use the affected storage units.
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To change storage unit settings

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage > Storage Units.

2 In the right pane, double-click the storage unit you want to change.

To select multiple storage units, hold down the Control or Shift key.

3 Complete the fields on the Change Storage Unit dialog box.

See “About storage unit settings” on page 604.

Deleting storage units
To delete a storage unit from a NetBackup configuration means to delete the label
that NetBackup associates with the physical storage.

Deleting a storage unit does not prevent files from being restored that were written
to that storage unit, provided that the storage was not physically removed and the
backup image has not expired.

To delete a BasicDisk or Media Manager storage unit

1 Use the Catalog utility to expire any images that exist on the storage unit. This
action removes the image from the NetBackup catalog.

See “Expiring backup images” on page 1026.

■ Do not manually remove images from the BasicDisk or Media Manager
storage unit.

■ Once the images are expired, they cannot be restored unless the images
are imported.
See “About importing backup images” on page 1027.

NetBackup automatically deletes any image fragments from a disk storage unit
or a disk pool. This deletion generally occurs within seconds of expiring an
image. However, to make sure that all of the fragments are deleted, check the
directory on the storage unit to make sure that it is empty.

2 Select Storage > Storage Units.

3 In the right pane, select the storage unit you want to delete. Hold down the
Control or Shift key to select multiple storage units.

4 Select Edit > Delete.

5 In the confirmation dialog box, select the storage units to delete.
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6 Click OK.

7 Modify any policy that uses a deleted storage unit to use another storage unit.

If a storage unit points to disk pool, the storage unit can be deleted without
affecting the disk pool.

Media Manager storage unit considerations
To create a storage unit of a tape robot or a standalone tape drive, select Media
Manager as the Storage unit type.

See “About storage unit settings” on page 604.

Figure 12-3 Media Manager storage unit settings
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WhenNetBackup sends a job to aMedia Manager storage unit, it requests resources
from the Enterprise Media Manager (EMM). Then NetBackup requests that Media
Manager mount the volume in a drive.

If a standalone drive does not contain media or if a required volume is not available
to a robot, a mount request appears in the Pending Requests pane of the Device
Monitor. An operator can then find the volume, mount it manually, and assign it to
the drive.

Take the following items into consideration when adding a Media Manager storage
unit:

■ Where to add the storage unit depends on which version of NetBackup is in
use.

■ Add the storage unit to the master server. Specify the media server where
the drives attach.

■ If using NetBackup Server, add the storage unit to the master server where
the drives attach. The robotic control must also attach to that server.

■ The number of storage units that you must create for a robot depends on the
robot’s drive configuration.

■ Drives with identical densities must share the same storage unit on the same
media server. If a robot contains two drives of the same density on the same
media server, add only a single storage unit for the robot. Set theMaximum
concurrent write drives setting to 2.
See “Maximum concurrent write drives storage unit setting” on page 607.

■ Drives with different densities must be in separate storage units. Consider
an STK SL500 library that is configured as a Tape Library DLT (TLD). It can
have both half-inch cartridge and DLT drives. Here, you must define a
separate storage unit for each density.

■ If a robot’s drives and robotic control attach to different NetBackup servers,
specify the server where the drives attach as the media server. Always
specify the same robot number for the drives as is used for the robotic control.

■ Standalone drives with identical densities must be in the same storage unit.
If a server contains two 1/4-inch qscsi drives, add a storage unit withMaximum
concurrent write drives set to 2. The media and device selection logic chooses
the drive to use when NetBackup sends a backup to this storage unit. The logic
is part of the Enterprise Media Management (nbemm) service or daemon.

■ Standalone drives with different densities must be in different storage units.

■ A robot and a standalone drive cannot be in the same storage unit.
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Disk storage unit considerations
NetBackup permits the creation of an unlimited number of disk storage units.

Table 12-2 describes the different disk types that NetBackup can use as disk media.

Table 12-2 Disk media descriptions

DescriptionType of disk storage unit

An AdvancedDisk disk type storage unit is used for a dedicated disk that is directly
attached to a NetBackup media server. An AdvancedDisk selection is available only
when the Data Protection Optimization Option is licensed.

NetBackup assumes the exclusive ownership of the disk resources that comprise an
AdvancedDisk disk pool. If the resources are shared with other users, NetBackup
cannot manage disk pool capacity or storage lifecycle policies correctly.

For AdvancedDisk, the NetBackup media servers function as both data movers and
storage servers.

See the NetBackup AdvancedDisk Storage Solutions Guide.

AdvancedDisk

A BasicDisk type storage unit consists of a directory on a locally-attached disk or a
network-attached disk that is exposed as a file system to a NetBackup media server.
NetBackup stores backup data in the specified directory.

Notes about the BasicDisk type storage unit:

■ Do not include the same volume or file system in multiple BasicDisk storage units.
■ BasicDisk storage units cannot be used in a storage lifecycle policy.

BasicDisk

A Cloud Storage disk type storage unit is used for storage in a cloud, usually provided
by a third-party vendor. The actual name of the disk type depends on the cloud storage
vendor. A Cloud Storage selection is available only when the Data Protection
Optimization Option is licensed.

The storage is integrated into NetBackup through an API. The cloud storage vendor
partners with Veritas to integrate the storage into NetBackup.

A vendor host on the Internet is the storage server. The NetBackup media servers
function as the data movers.

See the NetBackup Cloud Administrator's Guide.

Cloud Storage
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Table 12-2 Disk media descriptions (continued)

DescriptionType of disk storage unit

An OpenStorage disk type storage unit is used for disk storage, usually provided by
a third-party vendor. The actual name of the disk type depends on the vendor. An
OpenStorage selection is available only when the OpenStorage Disk Option is licensed.

The storage is integrated into NetBackup through an API. The storage vendor partners
with Veritas to integrate the storage into NetBackup.

The storage host is the storage server. The NetBackup media servers function as the
data movers. The storage vendor's plug-in must be installed on each media server that
functions as a data mover. The logon credentials to the storage server must be
configured on each media server.

See the NetBackup OpenStorage Solutions Guide for Disk.

OpenStorage

A PureDisk disk type storage unit is used for deduplicated data for a Media Server
Deduplication Pool. PureDisk appears as a selection when the NetBackup Data
Protection Optimization Option is licensed.

PureDisk

Not all settings are available on each disk storage unit type.

See “About storage unit settings” on page 604.

Note: Veritas recommends that you do not impose quotas on any file systems that
NetBackup uses for disk storage units. Some NetBackup features may not work
properly when file systems have quotas in place. (For example, the
capacity-managed retention selection in storage lifecycle policies and staging to
storage units.)

About the disk storage model
The NetBackup model for disk storage accommodates all Enterprise Disk Options.
That is, it is the model for all disk types except for the BasicDisk type.

The following items describe components of the disk storage model:

Data mover
An entity that moves data between the primary storage (the NetBackup client) and
the storage server. NetBackup media servers function as data movers.

Depending on the disk option, a NetBackup media server also may function as a
storage server.
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Storage server
An entity that writes data to and reads data from the disk storage. A storage server
is the entity that has a mount on the file system on the storage.

Depending on the NetBackup option, the storage server is one of the following:

■ A computer that hosts the storage. The computer may be embedded in the
storage device.

■ A storage vendor's host on the Internet that exposes cloud storage to NetBackup.
Alternatively, private cloud storage can be hosted within your private network.

■ A NetBackup media server that hosts storage.

Disk pool
A collection of disk volumes that are administered as an entity. NetBackup
aggregates the disk volumes into pools of storage (a disk pool) you can use for
backups.

A disk pool is a storage type in NetBackup. When you create a storage unit, you
select the disk type and then you select a specific disk pool.

Configuring credentials for CIFS storage and disk storage
units
For Common Internet File System (CIFS) storage with AdvancedDisk and BasicDisk
storage units, the following two NetBackup services onWindows computers require
matching account credentials:

The NetBackup Client Service is either bpcd.exe or
bpinetd.exe, depending on NetBackup release level.
Regardless of the binary file name, the service requires the
credentials.

NetBackup Client Service

The NetBackup Remote Manager andMonitor Service binary
file name is nbrmms.exe.

NetBackup Remote Manager
and Monitor Service

The following items describe the requirements for the account and credentials:

■ Both of the services must run under the same Windows user account.

■ The account must be the same account that the Windows operating system
uses for read and write access to the CIFS share.

■ Configure the account and the credentials on the media server or media servers
that have a file system mount on the CIFS storage. Then, configure Windows
so that the two aforementioned services use that account.
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If account credentials are not configured properly, NetBackup marks all CIFS
AdvancedDisk and BasicDisk storage units that use the UNC naming convention
as DOWN.

To configure service credentials for CIFS storage and disk storage units

◆ In Windows, configure both the NetBackup Client Service and the NetBackup
RemoteManager andMonitor Service so theymeet the credential requirements.
Those requirements are described previously in this document.

See your Windows operating system documentation for the procedures. How
to configure Windows is beyond the scope of the NetBackup documentation.

Disk storage units in storage lifecycle policies
Figure 12-4 is an example of how storage lifecycle policies can interact with volumes
in a disk pool that a storage unit references.

Two backup policies are created as follows:

■ A backup policy named Policy_gold has a gold classification. For storage, it is
configured to use an SLP named Lifecycle_Gold, which has a gold data
classification.

■ A backup policy named Policy_silver has a silver classification. For storage, it
is configured to useAny Available. That means it can use any available storage
unit or any SLP that has a silver classification.

Two storage units are available to both backup policies as follows:

■ DSU_1 is an operation in Lifecycle_Gold and references DiskPool_A.

■ DSU_2 is not in an SLP and references DiskPool_A.

DiskPool_A contains three disk volumes. Both the gold and the silver images can
be written to any disk volume in the pool.
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Figure 12-4 Storage lifecycle policies and disk storage units referencing disk
pools

Storage unit DSU_2
Storage unit DSU_1

Disk volume Disk volume

DiskPool_A

Disk volume

Backup policy Policy_Silver

The data classification for this backup
policy is silver. The policy is configured
to write to any available storage unit.

Policy_Silver writes to DSU_2.
DSU_2 references DiskPool_A.

Backup policy Policy_Gold

The data classification for this backup
policy is gold. The policy is configured to
write to Lifecycle_Gold.

SLP Lifecycle_Gold

Lifecycle_Gold contains a backup operation
that writes to storage unit DSU_1.

DSU_1 references DiskPool_A.

Gold image

Gold image

Silver image

Gold image

Silver image

Gold image

Both backup policies may
write to any volume in the
disk pool that matches the
data classification of the
policy.

In this way, a single disk
pool may contain images
with different data
classifications.

See “About storage lifecycle policies” on page 645.

Maintaining available disk space on disk storage units
Disk storage units can be managed so that they do not become entirely full and
cause backups to fail.

Create space for more images on a disk storage unit in the following ways:

■ Add new disk space.

■ Set the High water mark to a value that best works with the size of backup
images in the environment.
See “High water mark storage unit setting” on page 606.

Maintain space on basic disk staging storage units in the following ways:

■ Increase the frequency of the relocation schedule. Or, add resources so that all
images can be copied to a final destination storage unit in a timely manner.

■ Run the nb_updatedssu script.
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Upon NetBackup installation or upgrade, the nb_updatedssu script runs. The
script deletes the .ds files that were used in previous releases as pointers to
relocated data. Relocated data is tracked differently in the current release and
the .ds files are no longer necessary. Under some circumstances, a .ds file
cannot be deleted upon installation or upgrade. In that case, run the script again:
On Windows: install_path\NetBackup\bin\goodies\nb_updatedssu
On UNIX: /usr/openv/netbackup/bin/goodies/nb_updatedssu

■ Determine the potential free space.
See “Finding potential free space on a BasicDisk disk staging storage unit”
on page 629.

■ Monitor disk space by enabling the Check the capacity of disk storage units
host property.
This General Server host property determines how often NetBackup checks 6.0
disk storage units for available capacity. Subsequent releases use internal
methods to monitor disk space more frequently.
See “General Server properties” on page 132.

NDMP storage unit considerations
The NetBackup for NDMP license must be installed on the media server to use the
hosts as storage units. Media Manager controls NDMP storage units but the units
attach to NDMP hosts.

See “About storage unit settings” on page 604.
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Figure 12-5 NDMP storage unit settings

Create NDMP storage units for drives directly attached to NAS filers. Any drive that
is attached to a NetBackup media server is considered a Media Manager storage
unit, even if used for NDMP backups.

Note: Remote NDMP storage units may already be configured on a media server
from a previous release. Upon upgrade of the media server, those storage units
are automatically converted to Media Manager storage units.

See the NetBackup for NDMP Administrator’s Guide for more information.
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About storage unit settings
The following topics describe the settings that appear for all types of storage units.
The settings are listed alphabetically. Each setting does not appear for each storage
unit type.

Absolute pathname to directory or absolute pathname to volume
setting for storage units

Absolute pathname to directory or Absolute pathname to volume is available
for any storage unit that is not based on disk pools.

The setting specifies the absolute path to a file system or a volume available for
backups to disk. Enter the path directly in the field, then click Add. Use any location
on the disk, providing that sufficient space is available.

Use platform-specific file path separators (/ and \) and colon (:) within a drive
specification.

The Properties button displays properties for the directory or volume.

See “Properties option in the Change Storage Units dialog box” on page 614.

Do not configure multiple BasicDisk storage units to use the same volume or file
system. Not only do the storage units compete for space, but different Low water
marks can cause unexpected behaviors.

If the BasicDisk storage unit is used as a disk staging storage unit, Veritas
recommends dedicating a disk partition or file system to it. Dedicating space allows
the disk staging space management logic to operate successfully. Or, consider
defining AdvancedDisk storage units, which use the disk pools that are composed
of the disk volumes that are dedicated file systems for disk backup.

See “NetBackup naming conventions” on page 1163.

See “Low water mark storage unit setting” on page 607.

Directory can exist on the root file system or system disk
setting for storage units
This setting allows the user to specify a directory on the root file system (UNIX) or
on a system drive (Windows) in the Absolute pathname to directory field.

When this setting is checked, the directory is created automatically. If a storage
unit is configured on C drive and this option is not checked, backups fail with status
code 12 (file open failed).
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Note:With this setting checked, the root file system or the system drive can fill up.

A job fails under the following conditions:

■ If the setting is not checked, and if the directory already exists on the root file
system or on a system drive.

■ If the setting is not checked, and the requested directory is to be created on the
root file system or on a system drive.

See “Absolute pathname to directory or absolute pathname to volume setting for
storage units” on page 604.

Density storage unit setting
The Storage device selection determines the mediaDensity. This setting appears
for Media Manager and NDMP storage units only.

Disk type storage unit setting
The Disk type storage unit setting identifies the type of storage unit.

A disk storage unit can be one of the following types:

■ AdvancedDisk (NetBackup Data Protection Optimization Option needed)

■ BasicDisk

■ Cloud Storage (NetBackup Data Protection Optimization Option needed)

■ OpenStorage (vendor name) (NetBackup OpenStorage Disk Option needed)

■ PureDisk (NetBackup Data Protection Optimization Option needed)

Note: The null_stu storage unit type is available only when Veritas Support uses
the NullOST plug-in to identify and isolate data transfer bottlenecks. The null_stu
storage unit type is used for troubleshooting purposes only. Do not select null_stu
as a storage unit type because the data that is written to a null storage unit cannot
be restored.

Enable block sharing storage unit setting
The Enable block sharing storage unit setting allows the sharing of data blocks
that have not changed from one backup to the next. Sharing data blocks can
significantly save disk space in the storage unit.
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Enable multiplexing storage unit setting
The Enable multiplexing storage unit setting allows multiple backups to multiplex
onto a single drive in a storage unit.

Caution: For MS-SQL-Server policies, do not enable multiplexing for a schedule
that is also configured to backup with multiple stripes. Restores fail whenmultiplexing
is enabled for a schedule that uses more than one stripe.

High water mark storage unit setting
The High water mark storage unit setting applies to BasicDisk storage units and
to disk pools.

Note: High water mark does not apply to cloud storage disk pools. This value is
derived from the storage capacity, which cannot be fetched from the cloud provider.

TheHigh water mark setting (default 98%) is a threshold that triggers the following
actions:

■ When an individual disk volume of the underlying storage reaches the High
watermark, NetBackup considers the volume full. NetBackup chooses a different
volume in the underlying storage to write backup images to.

■ When all volumes in the underlying storage reach the High water mark, the
BasicDisk storage is considered full. NetBackup fails any backup jobs that are
assigned to a storage unit in which the underlying storage is full. NetBackup
also does not assign new jobs to a BasicDisk storage unit in which the
underlying storage is full.

■ NetBackup begins image cleanup when a volume reaches theHighwatermark;
image cleanup expires the images that are no longer valid. NetBackup again
assigns jobs to the storage unit when image cleanup reduces any disk volume's
capacity to less than the High water mark.
If the storage unit is in a capacity-managed storage lifecycle policy, other factors
affect image cleanup.
See “Capacity managed retention type for SLP operations” on page 678.

See “Maximum concurrent jobs storage unit setting” on page 608.

For more information, see the following guides:

■ NetBackup Deduplication Guide.

■ NetBackup Administrator's Guide, Volume II.
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Low water mark storage unit setting
The Low water mark setting has no effect unless backups are written through a
storage lifecycle policy, using the Capacity managed retention type. NetBackup
copies expired images to a final destination storage unit to create space.

Note: Low water mark does not apply to cloud storage disk pools. This value is
derived from the storage capacity, which cannot be fetched from the cloud provider.

Once the High water mark is reached, space is created on the disk storage unit
until the Low water mark is met. The default setting is 80%.

See “Capacity managed retention type for SLP operations” on page 678.

The Low water mark setting cannot be greater than the High water mark setting.

For the disk storage units that reference disk pools, the Low water mark applies
to the disk pool.

Note: Basic disk staging storage units may already be configured on a media server
of a previous release. Upon upgrade, the disk storage units are set with the Low
water mark at 100%. To make the best use of upgraded storage units, adjust the
level.

For more information, see the following:

■ NetBackup Deduplication Guide.

■ NetBackup Administrator's Guide, Volume II.

Maximum concurrent write drives storage unit setting
The Maximum concurrent write drives storage unit setting specifies the number
of tape drives that NetBackup can use at one time for jobs to this storage unit. The
number of tape drives available is limited to the maximum number of tape drives
in the storage device. If a job contains multiple copies, each copy applies toward
the Maximum concurrent write drives count.

When selecting the value forMaximum concurrent write drives, use the following
guidelines:

■ Storage unit that contains only standalone tape drives
Specify a number that is less than or equal to the number of tape drives that
are in the storage unit.

■ Robot
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Specify a number that is less than or equal to the number of tape drives that
attach to the NetBackup media server for the storage unit.

Assume that you have two standalone drives of the same density and specify 1.
Both tape drives are available to NetBackup but only one drive can be used for
backups. The other tape drive is available for restores and other non-backup
operations. (For example, to import, to verify, and to duplicate backups as source.)

Note: To specify a Maximum concurrent write drives setting of 0 disables the
storage unit.

Maximum concurrent jobs storage unit setting
TheMaximumconcurrent jobs storage unit setting specifies themaximum number
of jobs that NetBackup can send to a disk storage unit at one time. The default
setting is one job.

The maximum number of jobs that NetBackup can run concurrently is dependent
on several factors and is not exclusively regulated by this setting. These factors
include the following: the risk of reaching a disk full situation, the scheduling or
capacity polling overhead, the media server I/O bandwidth, and various
characteristics of the disk storage. No definitive method exists that can predict when
a critical limit will be exceeded in a given system.

Note: To specify a Maximum concurrent jobs setting of 0 disables the storage
unit.

For example, three backup jobs are ready to be sent to the storage unit and
Maximum concurrent jobs is set to two. The first two jobs start while the third job
waits. If a job contains multiple copies, each copy applies toward the Maximum
concurrent jobs count.

Note: Increase the Maximum concurrent jobs setting if the storage unit is used
for catalog backups as well as non-catalog backups. Increase the setting to ensure
that the catalog backup can proceed while regular backup activity occurs. Where
disk pools are used, increase the setting if more than one server is in the storage
unit.

The Maximum concurrent jobs setting uses and dependencies are as follows:

■ Can be used to balance the load between disk storage units. A higher value
(more concurrent jobs) means that the disk may be busier than if the value was
set for fewer jobs.
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The media server load balancing logic considers all storage units and all activity.
A storage unit can indicate three media servers. If Maximum concurrent jobs
is set to three and two of the media servers are busy or down, the third media
server is assigned all three jobs.

■ This setting depends on the available disk space and the server’s ability to run
multiple backup processes. Where disk pools are used, the setting also depends
on the number of media servers in the storage unit.
If multiple storage units reference the same disk pool, the number of concurrent
jobs that can access the pool is the sum of the Maximum concurrent jobs
settings on all of the disk storage units. The setting applies to the storage unit
and not to the disk pool. Therefore, the job load is automatically spread across
the media servers that the storage unit configuration indicates.

■ OnWindows systems, even with multiple concurrent jobs, the time that is required
for a job to complete depends on other factors:

■ The number of other jobs that are started at the same time.

■ The sequence in which the jobs were started.

■ The time that is required to complete each job.

See “Impact when two disk storage units reference one disk pool” on page 609.

Impact when two disk storage units reference one disk
pool
Figure 12-6 shows how the Maximum concurrent jobs settings are combined
when two disk storage units share one disk pool.

In the example, DSU_1 is configured as follows:

■ To use MediaServer_A

■ To have a Maximum concurrent jobs setting of two

■ To reference Disk_pool1

DSU_2 is configured as follows:

■ To use MediaServer_B

■ To have a Maximum concurrent jobs setting of three

■ To reference Disk_pool1

Both storage units reference the same disk pool. Combined, the storage units have
a Maximum concurrent jobs setting of five. However, only two jobs can run
concurrently on MediaServer_A; three on MediaServer_B.
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Figure 12-6 Impact when disk storage units use one disk pool but different
media servers

DSU_1

The maximum concurrent jobs
that can use the disk pool is 5.

Maximum
concurrent jobs
setting: 2

MediaServer_A

DSU_2 Maximum
concurrent jobs
setting: 3

MediaServer_BMediaServer_A
selected to move
data to the pool

MediaServer_B
selected to move
data to the pool

Disk_pool1

If the storage units were configured to use both media servers, the media servers
could run five concurrent jobs: two from DSU_1 and three from DSU_2.

See “About storage unit settings” on page 604.

Maximum streams per drive storage unit setting
The Maximum streams per drive storage unit setting determines the maximum
number of concurrent, multiple client backups that NetBackup can multiplex onto
a single drive. The range is from 2 to 32.

See “Media multiplexing (schedule attribute)” on page 815.

Media server storage unit setting
The Media server storage unit setting specifies one of the following:

■ The NetBackup media server where the drives in the storage unit attach.

■ The NetBackup media server that controls the disk storage unit.

■ The NetBackup media servers that can write data to and read data from the
disk pool.

■ The NetBackup media servers that can move data to and from the disk pool.

■ The NetBackup media servers that function as deduplication servers.

To make this storage unit available to any media server (default), select Any
Available. NetBackup selects the media server dynamically at the time the policy
is run.

Consider the following, depending on the type of storage.
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Table 12-3 Media server setting details

ConsiderationsStorage unit type

To configure a disk storage unit, select a single media server.BasicDisk

The Media server setting specifies the NetBackup media servers that can write data
to and read data from the disk pool.

The media servers that are configured as storage servers appear in the media servers
list. The disk storage must be directly attached to the media server that is configured
as the storage server.

NetBackup selects a media server when the policy runs.

AdvancedDisk

The Media server setting specifies the NetBackup media servers that can move data
to or from the cloud vendor storage server.

To allow any media server in the media server list to move data to the storage server,
check Use Any Available Media Server.

To restrict the media servers that can move data to the storage server, check Only
Use The Following Media Servers. Then select the media servers that are allowed
to move the data.

Any media server in the list can receive data from the storage server; it does not have
to be selected. A media server receives data for restore jobs and for storage monitoring
purposes.

Only the media servers on which storage server credentials are configured appear in
the media servers list. If a server does not appear, verify that the software plug-in is
installed and that login credentials are configured for that media server.

NetBackup selects a media server when the policy runs.

Cloud storage

The Media server setting specifies the name of the media server that is to back up
the NDMP host. Only those media servers that can talk to the specified NDMP storage
device appear in the drop-down menu.

An NDMP host can be authenticated on multiple media servers. Select Any Available
to have NetBackup select the media server and storage unit at the time the policy is
run.

NDMP

611Configuring storage units
About storage unit settings



Table 12-3 Media server setting details (continued)

ConsiderationsStorage unit type

The Media server setting specifies the NetBackup media servers that can move data
to or from the storage server.

To allow any media server in the media server list to move data to the storage server,
check Use Any Available Media Server.

To restrict the media servers that can move data to the storage server, check Only
Use The Following Media Servers. Then select the media servers that are allowed
to move the data.

Any media server in the list can receive data from the storage server; it does not have
to be selected. A media server receives data for restore jobs and for storage monitoring
purposes.

Each media server that moves the data must meet the following requirements:

■ The vendor’s software plug-in is installed.
■ The login credentials to the storage server are configured.

Only the media servers on which storage server credentials are configured appear in
the media servers list. If a server does not appear, verify that the software plug-in is
installed and that login credentials are configured for that media server.

Note: Run the tpconfig command line utility directly on the media server to configure
and verify credentials.

NetBackup selects a media server when the policy runs.

OpenStorage

To allow any media server in the list to deduplicate data, select Use Any Available
Media Server.

To restrict the media servers that can deduplicate data, selectOnly Use The Following
Media Servers. Then select the media servers that are allowed to deduplicate the
data.

Each media server must be configured as a deduplication media server.

See the NetBackup Deduplication Guide.

PureDisk (Media Server
Deduplication Pool)

See “Use any available media server storage unit setting” on page 619.

See “Only use the following media servers storage unit setting” on page 613.

NDMP host storage unit setting
The NDMP host storage unit setting specifies the NDMP tape server that is used
to write data to tape. Select the host name from the drop-down menu or click Add
to add a host.
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On demand only storage unit setting
The On demand only storage unit setting specifies whether the storage unit is
available exclusively on demand—that is, only when a policy or schedule is explicitly
configured to use this storage unit. UncheckOn demand only to make the storage
unit available to any policy or schedule.

Note: If On demand only is selected for all storage units, be sure to designate a
specific storage unit for each policy or schedule. Otherwise, NetBackup is unable
to find a storage unit to use.

Only use the following media servers storage unit setting
TheOnly use the followingmedia servers storage unit setting restricts the media
servers that are earmarked for storage. Check this setting and select the media
servers that you want to use.

The following table describes the media server functionality for each type of storage.

Table 12-4 Media server functionality

FunctionalityMedia server type

The media servers are both storage servers and
data movers. The media servers that are
configured as the storage servers and data movers
appear in the media servers list.

AdvancedDisk storage media server

The media servers that are configured as data
movers for the cloud storage implementation
appear in the media server list. (For cloud storage,
NetBackup media servers function as data
movers.)

Cloud storage media server
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Table 12-4 Media server functionality (continued)

FunctionalityMedia server type

The media servers that are configured as data
movers for the OpenStorage implementation
appear in the media server list. (For OpenStorage,
NetBackup media servers function as data
movers.) If a media server does not appear in the
list, verify that the software plug-in is installed and
that logon credentials are created.

Each media server that accesses the storage must
meet the following requirements:

■ The vendor’s software plug-in is installed.
■ The login credentials to the storage server are

configured.

OpenStorage media server

The media servers function as deduplication
servers.

NetBackup deduplication must be configured.

PureDisk media server (Media Server
Deduplication Pool)

See “Use any available media server storage unit setting” on page 619.

See “Only use the following media servers storage unit setting” on page 613.

Properties option in the Change Storage Units dialog box
Click Properties to display information about the volume or the disk pool, as follows:

Note: The following properties do not apply to cloud storage disk pools: Available
space,Capacity,High water mark, Lowwater mark,Raw size, andUsable size.

All these values are derived from the storage capacity, which cannot be fetched
from the cloud provider.
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Table 12-5 Storage Units Properties

DescriptionProperty

This value reflects the space that remains for storage on a disk storage unit. The
following equation determines the available space:

Available space = free space + potential free space - committed space

The df command may report a value for the available space that is slightly different
from the actual free space value that appears as a result of the nbdevquery command:

nbdevquery -listdv -stype server_type -dp disk_pool

The available space that the df command lists does not include the space that the
operating system reserves. Since NetBackup runs as root, the nbdevquery command
includes the reserved space in the available space equation.

Available space

The Capacity value reflects the total amount of space that the disk storage unit or pool
contains, both used and unused.

Capacity

Comments that are associated with the disk pool.Disk pool comments

The high water mark for the disk pool applies to both the individual disk volumes in the
pool and the disk pool:

■ Individual volumes
When a disk volume reaches the high water mark, new jobs are not assigned to
the volume. This behavior happens for all disk types except BasicDisk staging
storage units. The high water mark event triggers the deletion of images that have
been relocated, attempting to bring the used capacity of the disk volume down to
the low water mark

■ Disk pool
When all volumes are at the high water mark, the disk pool is full. When a disk pool
approaches the high water mark, NetBackup reduces the number of jobs that are
allowed to write to the pool.
NetBackup does not assign new jobs to a storage unit in which the disk pool is full.
The default setting is 99%.

High water mark

The low water mark for the disk pool. Once a disk volume fills to its high water mark,
NetBackup attempts to delete enough relocated images to reduce the used capacity
of the disk volume down to the low water mark. The low water mark setting cannot be
greater than the high water mark setting.

Note: The Low water mark setting has no effect unless backups are written through
a storage lifecycle policy, using the capacity-managed retention type.

Low water mark

The name of the disk pool.Name

The number of disk volumes in the disk pool.Number of volumes
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Table 12-5 Storage Units Properties (continued)

DescriptionProperty

The percentage of storage that is currently in use on the volume.

The df command may report a percentage used (Use%) value that is different from
the % full value. (See the preceding Available Storage topic for a description of why
the values appear differently.)

% full

The raw, unformatted size of the storage in the disk pool.Raw size

The amount of usable storage in the disk pools.Usable size

Reduce fragment size storage unit setting
The Reduce fragment size storage unit setting specifies the largest fragment size
that NetBackup can create to store backups.

If an error occurs in a backup, the entire backup is discarded. The backup restarts
from the beginning, not from the fragment where the error occurred. (An exception
is for backups where checkpoint restart is enabled. In that case, fragments before
and including the last checkpoint are retained; the fragments after the last checkpoint
are discarded.)

Maximum fragment size for Media Manager storage units
The default maximum fragment size for a Media Manager storage unit is 1000 GB.
To specify a maximum fragment size other than the default, checkReduce fragment
size. Then enter a value from 50 megabytes to 1,048,575 megabytes.

Fragmenting multiplexed tape backups can expedite restores. Fragments allow
NetBackup to skip to the specific fragment before searching for a file. Generally,
NetBackup starts at the beginning of the multiplexed backup and reads tar headers
until it finds the file.

Maximum fragment size for disk storage units
The default maximum fragment size for a disk storage unit is 524,288 megabytes.
To specify a maximum fragment size other than the default, enter a value from 20
megabytes to 524,288 megabytes.

For aMedia Server Deduplication Pool, you can enter a value from 20megabytes
to 51200 megabytes.

Backups to disk are usually fragmented to ensure that the backup does not exceed
the maximum size that the file system allows.

The Reduce fragment size setting is intended primarily for storing large backup
images on a disk type storage unit.
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Note: OpenStorage vendors may have special requirements for the maximum
fragment size. Consult the vendor's documentation for guidance.

Note: Basic disk staging units with different maximum fragment sizes may already
be configured on a media server from a previous release. Upon upgrade, the disk
storage units are not automatically increased to the new default of 524,288
megabytes. To make the best use of upgraded storage units, increase the fragment
size on the upgraded storage units.

Robot number storage unit setting
The Robot number storage unit setting indicates the number of robots the storage
unit contains. The Storage device selection determines the Robot number. It is
the same robot number used in the Media Manager configuration.

Robot type storage unit setting
The Robot type storage unit setting indicates the type of robot (if any) that the
storage unit contains. The Storage device setting determines the Robot type.

NetBackup robot types are described in a different topic.

See “NetBackup robot types” on page 435.

Select disk pool storage unit setting
The Select disk pool storage unit setting specifies disk pool for the storage unit.

The following table describes which disk pools appear in the drop-down list:

All NetBackup disk pools appear in the Disk pool list.For AdvancedDisk

Only the disk pools that the cloud storage vendor exposes
appear in the list.

For cloud storage

Only the disk pools that the OpenStorage vendor exposes
appear in the list.

For OpenStorage

The Media Server Deduplication Pools appear in the list.For PureDisk

Staging schedule option in Change Storage Units dialog
Click the Staging Schedule option to configure the relocation schedule for this
storage unit. A schedule is what makes the disk storage unit a basic disk staging
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storage unit. During the relocation schedule, the backup image is duplicated from
the temporary staging area to the final destination storage unit.

See “Disk Staging Schedule dialog box” on page 630.

See “Enable temporary staging area storage unit setting” on page 618.

See “About basic disk staging” on page 621.

See “About staging backups” on page 620.

Storage device setting for storage units
The Storage device list contains all possible storage devices available. Storage
units can be created for the listed devices only.

The Storage device selection determines the mediaDensity. This setting appears
for Media Manager and NDMP storage units only.

Storage unit name setting
The Storage unit name setting defines a unique name for the new storage unit.
The name can describe the type of storage. The Storage unit name is the name
used to specify a storage unit for policies and schedules.

The storage unit name cannot be changed after creation. The Storage unit name
is inaccessible when changing settings for a storage unit.

See “NetBackup naming conventions” on page 1163.

Storage unit type setting
The Storage unit type setting specifies the type of storage that this storage unit
uses, as follows:

See “Disk storage unit considerations” on page 597.Disk

See “MediaManager storage unit considerations” on page 595.Media Manager

See “NDMP storage unit considerations” on page 602.NDMP

Enable temporary staging area storage unit setting
The Enable temporary staging area storage unit setting allows this storage unit
to be used as a temporary staging area. Check Enable Temporary Staging Area
and then configure the staging schedule.

See “Staging schedule option in Change Storage Units dialog” on page 617.
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The Staging column in the Storage units details pane indicates whether or not the
unit is used as a temporary staging area for basic disk staging. Not all columns
display by default.

See “About basic disk staging” on page 621.

See “Staging schedule option in Change Storage Units dialog” on page 617.

Use any available media server storage unit setting
When checked, the Use any available media server storage unit setting allows
any media server in the media server list to access the storage (default).

The following table describes the media server functionality for each type of storage.

Table 12-6 Media server functionality

FunctionalityStorage unit type

The media servers are both storage servers and data movers. The media
servers that are configured as the storage servers and data movers appear
in the media servers list.

AdvancedDisk storage media server

The media servers that are configured as data movers for the cloud storage
implementation appear in themedia server list. (For cloud storage, NetBackup
media servers function as data movers.)

Cloud storage media server

The media servers that are configured as data movers for the OpenStorage
implementation appear in themedia server list. (For OpenStorage, NetBackup
media servers function as data movers.) If a media server does not appear
in the list, verify that the software plug-in is installed and that logon credentials
are created.

The following is required on each media server that accesses the storage:

■ The vendor’s software plug-in is installed.
■ The login credentials to the storage server are configured.

OpenStorage media server

The media servers function as deduplication servers.

NetBackup deduplication must be configured.

PureDisk media server (Media Server
Deduplication Pool)
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Staging backups
This chapter includes the following topics:

■ About staging backups

■ About basic disk staging

■ Creating a basic disk staging storage unit

■ Configuring multiple copies in a relocation schedule

■ Disk staging storage unit size and capacity

■ Finding potential free space on a BasicDisk disk staging storage unit

■ Disk Staging Schedule dialog box

■ Initiating a relocation schedule manually

About staging backups
In the staged backups process, NetBackup writes a backup to a storage unit and
then duplicates it to a second storage unit. Eligible backups are deleted on the initial
storage unit when space is needed for more backups.

This two-stage process allows a NetBackup environment to leverage the advantages
of disk-based backups for recovery in the short term.

Staging also meets the following objectives:

■ Allows for faster restores from disk.

■ Allows the backups to run when tape drives are scarce.

■ Allows the data to be streamed to tape without image multiplexing.

NetBackup offers the following methods for staging backups.
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Table 13-1 Methods for staging backups

DescriptionStaging method

Basic disk staging consists of two stages. First, data is stored on the initial storage unit
(disk staging storage unit). Then, per a configurable relocation schedule, data is copied
to the final location. Having the images on the final destination storage unit frees the
space on the disk staging storage unit as needed.

See “About basic disk staging” on page 621.

The following storage unit types are available for basic disk staging: BasicDisk and
tape.

Basic disk staging

Staged backups that are configured within the Storage Lifecycle Policies utility also
consist of two stages. Data on the staging storage unit is copied to a final destination.
However, the data is not copied per a specific schedule. Instead, the administrator can
configure the data to remain on the storage unit until either a fixed retention period is
met, or until the disk needs additional space, or until the data is duplicated to the final
location.

No BasicDisk or disk staging storage unit can be used in an SLP.

See “About storage lifecycle policies” on page 645.

Staging using the Storage
Lifecycle Policies utility

About basic disk staging
Basic disk staging is conducted in the following stages.

Table 13-2 Basic disk staging

DescriptionStage

Clients are backed up by a policy. The Policy storage selection in the policy indicates a storage unit that
has a relocation schedule configured. The schedule is configured in theNew orChange Storage unit dialog
box by clicking Staging Schedule.

Stage I

Images are copied from the Stage I disk staging storage unit to the Stage II storage unit. The relocation
schedule on the disk staging storage unit determines when the images are copied to the final destination.
Having the images on the final destination storage unit frees the space on the disk staging storage unit as
needed.

Stage II

The image continues to exist on both the disk staging storage unit and the final
destination storage units until the image expires or until space is needed on the
disk staging storage unit.

Figure 13-1 shows the stages in basic disk staging.
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Figure 13-1 Stage I and II of basic disk staging

Client
Disk staging
storage unit

Stage I

The relocation schedule on the disk
staging storage unit copies data to the
final destination storage unit

Stage II

Final destination
storage unit

A policy backs up client data to a
disk staging storage unit

When the relocation schedule runs, NetBackup creates a data management job.
The job looks for any data that can be copied from the disk staging storage unit to
the final destination. The Job Details in the Activity Monitor identify the job as one
associated with basic disk staging. The Job Details list displays Disk Staging in the
job’s Data Movement field.

When NetBackup detects a disk staging storage unit that is full, it pauses the backup.
Then, NetBackup finds the oldest images on the storage unit that successfully
copied onto the final destination. NetBackup expires the images on the disk staging
storage unit to create space.

Note: The basic disk staging method does not support backup images that span
disk storage units.

To avoid spanning storage units, do not use Checkpoint restart on a backup policy
that writes to a storage unit group that contains multiple disk staging storage units.

See “Take checkpoints every __ minutes (policy attribute)” on page 736.

Creating a basic disk staging storage unit
Use the following processes to create a basic disk staging storage unit.

To create a basic disk staging storage unit

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage > Storage Units.

2 Click Actions > New > Storage Unit or New Storage Unit.

3 In the New Storage Unit dialog box, name the storage unit.

See “Storage unit name setting” on page 618.

622Staging backups
Creating a basic disk staging storage unit



4 Select Disk as the Storage unit type.

See “Storage unit type setting” on page 618.

5 Select the Disk type of disk storage unit that is to be a disk staging storage
unit: BasicDisk.

6 Select a media server.

See “Media server storage unit setting” on page 610.

7 Browse or specify the absolute path to the directory to be used for storage.

See “Absolute pathname to directory or absolute pathname to volume setting
for storage units” on page 604.

8 Select whether this directory can reside on the root file system or system disk.

See “Directory can exist on the root file system or system disk setting for storage
units” on page 604.

9 Enter the maximum concurrent jobs that are allowed to write to this storage
unit at one time.

See “Maximum concurrent jobs storage unit setting” on page 608.

10 Enter a High water mark value.

The high water mark works differently for the BasicDisk disk type. NetBackup
assigns new jobs to a BasicDisk disk staging storage unit, even if it is over the
indicated high water mark. For BasicDisk, the high water mark is used to trigger
the deletion of images that have been relocated. NetBackup continues to delete
images until the disk reaches the low water mark.

Note: The Low water mark setting does not apply to disk staging storage
units.

11 Check the Enable temporary staging area option. Once the option is enabled,
create a schedule so that disk staging can occur.

Creating a schedule for a basic disk staging storage unit
The Disk Staging Schedule dialog box is similar to the Add New Schedule dialog
box used to configure schedules in backup policies. The differences appear on the
Attributes tab.
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To define the disk staging schedule

1 Click Staging Schedule.

2 The schedule name defaults to the storage unit name.

In the Disk Staging Schedule or the Disk Staging dialog box, select the
priority that the relocation jobs that are started from this schedule have
compared to other types of jobs.

See “Disk Staging Schedule dialog box” on page 630.

3 Select whether to create multiple copies. When the Multiple copies attribute
is checked, NetBackup can create up to four copies of a backup simultaneously.

See “Multiple copies (schedule attribute)” on page 806.

4 Select a storage unit to contain the images from this storage unit upon
relocation.

5 Select a volume pool to contain the images from this storage unit upon
relocation.

6 Select a media owner to own the images from this storage unit upon relocation.

7 Select whether to use an alternate server for the images from this storage unit
upon relocation.

8 Click OK to accept the disk staging schedule.

Configuring multiple copies in a relocation
schedule

To configure a relocation schedule for basic disk staging to create multiple copies,
use the following procedure.

To configure a relocation schedule for basic disk staging to create multiple
copies

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Storage > Storage Units.

2 Perform one of the following actions:

■ Select the storage unit to change.
■ On the Edit menu, click Change.

To change an existing basic
disk storage unit
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■ On the Actions menu, click New > Storage Unit.
■ Name the storage unit.
■ From the Storage unit type list, select Disk.
■ Check Enable Temporary Staging Area.
■ Configure the other storage unit settings as

necessary.
■ See “Creating a basic disk staging storage unit”

on page 622.

To create a new basic disk
storage unit

See “About staging backups” on page 620.

3 Click the Staging Schedule option.

4 In the Add Schedule or Change Schedule dialog box that appears, on the
Attributes tab, specify a priority in the field Priority of relocation jobs started
from this schedule (0 to 99999).

5 Select a schedule type and schedule when the policy should run.

6 Check Use alternate read server, and select an alternate server from the
drop-down list. The alternate server can read a backup image originally written
by a different media server.

7 Select Multiple copies and click Configure.
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8 In theCopies field, specify the number of copies to create simultaneously. The
number must be between 1 and 4.

Copy 1 is the primary copy. If Copy 1 fails, the first successful copy is the
primary copy.

Usually, NetBackup restores from the primary copy of an image. However, it
is possible to restore from a specific backup copy other than the primary copy.
To do so, use the bprestore command.

See “Configure Multiple Copies dialog box” on page 807.

See “About configuring multiple copies” on page 806.

9 Specify the storage unit where each copy is stored. If a Media Manager storage
unit has multiple drives, it can be used for both the source and the destination.

10 Specify the volume pool where each copy is stored.

11 Select one of the following from the If this copy fails list:

Continues making the remaining copies.

Note: Note: If Take checkpoints every __ minutes is
selected for this policy, only the last failed copy that contains
a checkpoint can be resumed.

See “Take checkpoints every __ minutes (policy attribute)”
on page 736.

continue

Fails the entire job.fail all copies
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12 For tape media, specify who should own the media onto which NetBackup
writes the images:

NetBackup selects the media owner, either a media server
or server group.

Any

Specifies that the media server that writes to the media owns
the media. No media server is specified explicitly, but you
want a media server to own the media.

None

Specifies that a media server group allows only those media
servers in the group to write to the media on which backup
images for this policy are written. All media server groups
that are configured in the NetBackup environment appear in
the list.

A server group

These settings do not affect images residing on disk. One media server does
not own the images that reside on shared disks. Any media server with access
to the shared pool of disk can access the images.

13 Click OK.

Disk staging storage unit size and capacity
To take advantage of basic disk staging requires that the NetBackup administrator
understand the life expectancy of the image on the Stage I storage unit.

The size and use of the file system of the Stage I storage unit directly affects the
life expectancy of the image before it is copied to the Stage II storage unit. Veritas
recommends a dedicated file system for each disk staging storage unit.

Consider the following example: A NetBackup administrator wants incremental
backups to be available on disk for one week.

Incremental backups are done Monday through Saturday, with full backups done
on Sunday. The full backups are sent directly to tape and do not use basic disk
staging.

Each night’s total incremental backups are sent to a disk staging storage unit and
average from 300 MB to 500 MB. Occasionally a backup is 700 MB. Each following
day the relocation schedule runs on the disk staging storage unit and copies the
previous night’s incremental backups to the final destination, a Media Manager
(tape) storage unit.

The following items give more information about determining disk size for a basic
disk staging storage unit.
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Minimum disk size
The minimum disk size is the smallest size that is required for the successful
operation of the disk staging logic.

The minimum size must be greater than or equal to the largest combined size of
the backups that are placed on the storage unit between runs of the disk staging
schedule. (In our example, the disk images remain on the disk for one week.)

In this example, the relocation schedule runs nightly, and the largest nightly backup
is 700 MB. Veritas recommends that you double this value to allow for any problems
that may occur when the relocation schedule runs. To double the value gives the
administrator an extra schedule cycle (one day) to correct any problems.

To determine the minimum size for the storage unit in this example, use the following
formula:

Minimum size = Max data per cycle × (1 cycle + 1 cycle for safety)

For example: 1.4 GB = 700 MB × (1+1)

Average disk size
The average disk size represents a good compromise between the minimum and
the maximum sizes.

In this example, the average nightly backup is 400 MB and the NetBackup
administrator wants to keep the images for one week.

To determine the average size for the storage unit in this example, use the following
formula:

Average size = Average data per cycle × (number of cycles to keep data + 1 cycle
for safety)

2.8 GB = 400 MB × (6 + 1)

Maximum disk size
Themaximum disk size is the recommended size needed to accommodate a certain
level of service. In this example, the level of service is that disk images remain on
disk for one week.

To determine themaximum size for the storage unit in this example, use the following
formula:

Maximum size = Max data per cycle × (# of cycles to keep data + 1 cycle for safety)

For example: 4.9 GB = 700 MB × (6 + 1)
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Finding potential free space on a BasicDisk disk
staging storage unit

Potential free space is the amount of space on a disk staging storage unit that
NetBackup could free if extra space on the volume is needed. The space is the
total size of the images that are eligible for expiration plus the images ready to be
deleted on the volume.

To find the potential free space on a BasicDisk storage unit, use the bpstulist

and the nbdevquery commands as follows:

■ Run bpstulist -label to find the disk pool name.
Note that the name of the storage unit and disk pools are case-sensitive. In the
case of BasicDisk storage units, the name of the disk pool is the same as the
name of the BasicDisk storage unit. In the following example, the name of the
storage unit is NameBasic:

bpstulist -label basic

NameBasic 0 server1 0 -1 -1 1 0 "C:\" 1 1 524288 *NULL* 0 1 0 98 80 0 NameBasic server1

■ Run the nbdevquery command to display the status for the disk pool, including
the potential free space.
Use the following options, where:

Specifies the vendor-specific string that
identifies the storage server type. For a
BasicDisk storage unit, enter BasicDisk.

-stype server_type

Specifies the disk pool name. For a basic
disk type, the disk pool name is the name
of the BasicDisk storage unit.

-dp

So the complete command might look like the following.

nbdevquery -listdv -stype BasicDisk -dp NameBasic -D

The value is listed as potential_free_space.

Disk Volume Dump

name : <Internal_16>

id : <C:\>

diskpool : <NameBasic::server1::BasicDisk>

disk_media_id : <@aaaaf>

total_capacity : 0

free_space : 0
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potential_free_space: 0

committed_space : 0

precommitted_space : 0

nbu_state : 2

sts_state : 0

flags : 0x6

num_read_mounts : 0

max_read_mounts : 0

num_write_mounts : 1

max_write_mounts : 1

system_tag : <Generic disk volume>

Disk Staging Schedule dialog box
Click Staging Schedule to display the Disk Staging Schedule dialog box. The
dialog box is similar to the scheduling dialog box that appears when a policy is
configured.

The schedule that is created for the disk staging storage unit is not listed under
Schedules in the NetBackup Administration Console when the Policies utility
is selected.

Figure 13-2 shows the disk staging schedule for a basic disk staging storage unit.

Figure 13-2 Disk Staging Schedule for a basic disk staging storage unit
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The Attributes tab on the Disk Staging Schedule dialog box differs from the
Attributes tab of a regular policy. The differences are described in the following
table.

Table 13-3 The Attributes tab settings

DescriptionAttribute

The Name on the Disk Staging Schedule dialog box automatically defaults to the
name of the storage unit.

Name

The Priority of relocation jobs started from this schedule field indicates the priority
that NetBackup assigns to relocation jobs for this policy. Range: 0 to 99999 (highest
priority). The default value that is displayed is the value that is set in the Default Job
Priorities host properties for the Staging job type.

See “Default Job Priorities properties” on page 100.

Priority of relocation jobs
started from this schedule

If the backups that use a disk staging storage unit run more frequently than expected,
compare the retention level 1 setting with the Frequency setting. Internally, NetBackup
uses the retention level 1 setting for scheduling purposes with disk staging storage
units.

Make sure that the frequency period is set to make the backups occur more frequently
than the retention level 1 setting indicates. (The default is two weeks.)

For example, a frequency of one day and a retention level 1 of 2 weeks should work
well.

Retention levels are configured in the Retention Periods host properties.

See “Retention Periods properties” on page 203.

See “Frequency (schedule attribute)” on page 803.

Frequency

If the schedule is a relocation schedule, a Final destination storage unit must be
indicated. (A relocation schedule is created as part of a basic disk staging storage unit
configuration.) A Final destination storage unit is the name of the storage unit where
the images reside after a relocation job copies them.

To copy images to tape, NetBackup uses all of the drives available in the Final
destination storage unit. However, the Maximum concurrent write drives setting
for that storage unit must be set to reflect the number of drives. The setting determines
how many duplication jobs can be launched to handle the relocation job.

NetBackup continues to free space until the Low water mark is reached.

See “Low water mark storage unit setting” on page 607.

See “Maximum concurrent write drives storage unit setting” on page 607.

See “About staging backups” on page 620.

Final destination storage
unit
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Table 13-3 The Attributes tab settings (continued)

DescriptionAttribute

If the schedule is a relocation schedule, a Final destination volume pool must be
indicated. (A relocation schedule is created as part of a basic disk staging storage unit
configuration.) A Final destination volume pool is the volume pool where images are
swept from the volume pool on the basic disk staging storage unit.

See “About staging backups” on page 620.

Note: The relocation schedule that was created for the basic disk staging storage unit
is not listed under Schedules in the NetBackup Administration Console when the
Policies utility is selected.

Final destination volume
pool

If the schedule is a relocation schedule, a Final destination media owner must be
indicated. (A relocation schedule is created as part of a basic disk staging storage unit
configuration.) A Final destinationmedia owner is the media owner where the images
reside after a relocation job copies them.

Specify one of the following:

■ Any lets NetBackup choose the media owner. NetBackup chooses a media server
or a server group (if one is configured).

■ None specifies that the media server that writes the image to the media owns the
media. No media server is specified explicitly, but you want a media server to own
the media.

■ A server group. A server group allows only those servers in the group to write to
the media on which backup images for this policy are written. All server groups that
are configured in the NetBackup environment appear in the Final destination
media owner drop-down list.

Final destination media
owner
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Table 13-3 The Attributes tab settings (continued)

DescriptionAttribute

An alternate read server is a server allowed to read a backup image originally written
by a different media server.

The path to the disk or directory must be identical for each media server that is to
access the disk.

If the backup image is on tape, the media servers must share the same tape library or
the operator must find the media.

If the backup image is on a robot that is not shared or a standalone drive, the media
must be moved to the new location. An administrator must move the media, inventory
the media in the new robot, and execute bpmedia -oldserver -newserver or
assign a failover media server.

To avoid sending data over the network during duplication, specify an alternate read
server that meets the following conditions:

■ Connected to the storage device that contains the original backups (the source
volumes).

■ Connected to the storage device that contains the final destination storage units.

If the final destination storage unit is not connected to the alternate read server, data
is sent over the network.

Use alternate read server

Initiating a relocation schedule manually
A relocation schedule may be startedmanually to copy images to the final destination
before the schedule is due to run.

To initiate a relocation schedule

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage > Storage Units.

2 In the right pane, select a basic disk staging storage unit.

3 Select Actions > Manual Relocation or Manual Relocation to Final
Destination to initiate the schedule.

If the relocation schedule finds data that can be copied, NetBackup creates a
job to copy the data to the final destination storage unit.

The image then exists on both storage units until the disk staging (Stage I)
storage unit becomes full and the oldest images are deleted.

See “Maintaining available disk space on disk storage units” on page 601.
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Configuring storage unit
groups

This chapter includes the following topics:

■ About storage unit groups

■ Creating storage unit groups for backups

■ Creating storage unit groups for snapshots

■ Deleting a storage unit group

■ Storage unit selection criteria within a group

■ About disk spanning within storage unit groups

About storage unit groups
Storage unit groups let you identify specific storage units as a group. You can
specify a storage unit group name as the storage for a policy in the same way that
you specify individual storage units. When you specify a storage unit group, the
policy directs backups or snapshots only to those storage units in the designated
group.

Storage unit groups can be one of the following types:

■ Backup storage unit groups
A backup storage unit group contains only the storage units that can contain
backups. Furthermore, for Media Server Deduplication Pool and third-party
disk appliance (OpenStorage) storage, all storage units in the group must be of
the same type of storage.
See “Creating storage unit groups for backups” on page 635.
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■ Snapshot storage unit groups
A snapshot storage unit group contains only the storage units that can contain
snapshots. All storage units in the groupmust have the sameDisk type selected.
See “Creating storage unit groups for snapshots” on page 637.

NetBackup does not support storage unit groups for the following use cases:

■ As a target for optimized duplication.
If you use a storage unit group as a destination for optimized duplication of
deduplicated data, NetBackup uses regular duplication.

■ As a source of or a target for Auto Image Replication.

■ As a target for optimized synthetic backups.
If NetBackup cannot produce the optimized synthetic backup, NetBackup creates
the more data-movement intensive synthetic backup.

■ As a target for OpenStorage direct-to-tape operations.
See the NetBackup OpenStorage Solutions Guide for Disk.

Creating storage unit groups for backups
The following procedure describes how to create a storage unit group that consists
of the storage units that can contain backups.

To create a storage unit group

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Storage.

2 Right-click Storage Unit Groups and select New Storage Unit Group.

3 Enter a storage unit group name for the new storage unit group. The storage
unit group name is case-sensitive.

See “NetBackup naming conventions” on page 1163.

4 For the storage unit group to contain backups, selectBackup in the drop-down
menu.

5 Add backup storage units to or remove backup storage units from the group:

■ To add storage units to the group, select the storage units from the Storage
units not in the group list and click Add.

■ To remove storage units from the group, select the storage units from the
Storage units in group list and click Remove.

■ To change the priority of a storage unit, select the storage unit and click
Move Up or Move Down. The units at the top of the list have the highest
priority in the group.
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Note: For Media Server Deduplication Pool and third-party disk appliance
(OpenStorage) storage, all storage units in the group must be of the same type
of storage.

6 Choose how storage units are selected within the group:

■ Prioritized. Choose the first storage unit in the list that is not busy, down,
or out of media.

■ Failover. Choose the first storage unit in the list that is not down or out of
media.
Veritas recommends that you select Failover for the following storage types:
AdvancedDisk, Media Server Deduplication Pool, and OpenStorage
(VendorName).

■ Round Robin. Choose the least recently selected storage unit in the list.

■ Media server load balancing. Choose a storage unit based on a
capacity-managed approach.
Veritas recommends the Media server load balancing criteria for disk
staging storage units within a storage unit group.
See “Media server load balancing” on page 640.

See “Storage unit selection criteria within a group” on page 639.

One exception to the selection criteria is in the case of a client that is also a
media server with locally connected storage units.

See “Exception to the storage unit selection criteria” on page 642.

7 Click OK.

See “About storage unit groups” on page 634.
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Figure 14-1 Backup storage unit group configuration dialog box

Creating storage unit groups for snapshots
Creating storage unit groups is optional. A snapshot storage unit group must be
comprised of storage units that have matching properties.

The following procedure describes how to create a storage unit group that consists
of the storage units that can contain snapshots.

To create a snapshot storage unit group

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Storage.

2 Right-click Storage Unit Groups and select New Storage Unit Group.

3 Enter a storage unit group name for the new storage unit group. The storage
unit group name is case-sensitive.

See “NetBackup naming conventions” on page 1163.

4 For the storage unit group to contain snapshots, select Snapshot in the
drop-down menu.

5 A storage unit group can contain only those storage units that share similar
properties. NetBackup filters the storage units for selection so that dissimilar
storage units are not combined in one storage unit group.
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Note: The properties of the underlying storage units are read-only. You cannot
change the storage unit properties from this dialog box.

Select one or more properties to filter the storage units in the list. Only those
storage units that have the selected properties are displayed. For example,
selectReplication source andReplication target to display only those storage
units that are configured to act as both replication sources and replication
targets.

Filter the storage units on the following properties:

■ Primary
Enable Primary to display the storage units that can contain the initial
snapshot of primary data.

■ Replication source
Enable Replication source to display the storage units that can serve as
a source for a replicated snapshot.

■ Replication target
Enable Replication target to display the storage units that can receive
replicated snapshots from a replication source.

■ Mirror
Optionally, enable Mirror to display the storage units that can serve as
a mirrored replication target. (For example, NetApp SnapMirror.)

■ Independent
Optionally, enable Independent to display the storage units that can
act as either a Mirror replication target (SnapMirror) or a non-mirror
replication target (SnapVault).

For more information about snapshot properties, see the NetBackup Replication
Director Solutions Guide.

6 Add or remove storage units from the group:

■ To add storage units to the group, select the storage units from the
Available storage units list and click Add.

■ To remove storage units from the group, select the storage units from the
Storage units to be used in the group list and click Remove.

■ To change the priority of a storage unit, select the storage unit and click
Move Up or Move Down. The units at the top of the list have the highest
priority in the group.

7 Click OK to save and close the dialog box.
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Figure 14-2 Snapshot storage unit group configuration dialog box

Deleting a storage unit group
The following procedure describes how to delete a storage unit group.

To delete a storage unit group

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage > Storage Unit Groups.

2 In the right pane, from the list of storage unit groups, select the storage unit
group you want to delete. Hold down theControl or Shift key to select multiple
storage units.

3 Select Edit > Delete.

4 Click OK.

Storage unit selection criteria within a group
The storage unit selection criteria determines the order in which storage units are
selected within a storage unit group.

The only difference between the selection criteria options is the order in which the
storage units are selected.

Choose from one of the following selection criteria.
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DescriptionSelection

If the Prioritized option is selected, NetBackup chooses the
next available storage unit in the list. Prioritized is the default
selection.

If a storage unit is unavailable, NetBackup examines the next
storage unit until it finds one that is available.

Prioritized

If the Failover option is selected, when a job must queue for
a storage unit, the job queues rather than try another storage
unit in the group.

Failover

If the Round robin option is selected, NetBackup chooses
the least recently selected storage unit in the list as each new
job is started.

If a storage unit is unavailable, NetBackup examines the next
storage unit until it finds one that is available.

Round robin

If the Media server load balancing option is selected,
NetBackup selects a storage unit based on a
capacity-managed approach. In this way, NetBackup avoids
sending jobs to busy media servers.

If a storage unit is unavailable, NetBackup examines the next
storage unit until it finds one that is available.

See “Media server load balancing” on page 640.

Media server load balancing

A queue can form for a storage unit if the storage unit is unavailable.

The following are some reasons why a storage unit can be considered unavailable:

■ The storage unit is busy.

■ The storage unit is down.

■ The storage unit is out of media.

■ The storage unit has no available space.

■ The storage unit has reached the Maximum concurrent jobs setting.
See “Maximum concurrent jobs storage unit setting” on page 608.

See “Exception to the storage unit selection criteria” on page 642.

Media server load balancing
TheMedia server load balancing option indicates that NetBackup select a storage
unit based on a capacity-managed approach. In this way, NetBackup avoids sending
jobs to busy media servers.
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If a storage unit is unavailable, NetBackup examines the next storage unit until it
finds one that is available.

The selection is based on the following factors:

■ The rank of the media server.
NetBackup considers the number of processes that are running on each CPU
along with the memory thresholds on each server to determine the rank of a
media server. If the free memory drops below a determined threshold, or if the
number of running processes per CPU rises over a determined threshold, then
the overall rank of the media server drops.

■ The number of jobs on the media server.
NetBackup considers the number of scheduled jobs on each media server.

■ Whether themedia server has enough disk space to accommodate the estimated
size of the image. (Physical and virtual tapes ignore this requirement.)
NetBackup estimates the size of any of the new or any current jobs on each
media server. It then determines whether the jobs fit on a given volume.
NetBackup estimates the amount of space that the job may require, based on
previous backup history. If no history is available, the high water mark for the
storage unit serves as a guide.

Media server load balancing cannot be selected for a storage unit group that
includes a BasicDisk storage unit. Also, a BasicDisk storage unit cannot be included
in an existing storage unit group with Media server load balancing enabled.

Note: Veritas recommends that you select Media server load balancing for disk
staging storage units within a storage unit group.

The following methods also work to distribute the backup workload:

■ Change the Limit jobs per policy policy attribute for one or more of the
policies that are sent to a media server. Specifying a lower limit reduces
the workload on a media server on a specific network segment.
See “Limit jobs per policy (policy attribute)” on page 739.

■ Reconfigure policies or schedules to use storage units on other media
servers.

■ Consider changing theBandwidth host properties on one or more clients.
See “Storage unit selection criteria within a group” on page 639.

Adjust the backup load on a media
server.

Reconfigure policy schedules so that they write backups to storage units on
the media servers that can handle the load (assuming that master servers
and media servers are on separate hosts).

Distribute the backup load on media
servers during peak periods.
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Change theMaximum jobs per client global attribute. For example, raising
theMaximum jobs per client limit increases the number of concurrent jobs
that any one client can process and therefore increases the load.

See “Storage unit selection criteria within a group” on page 639.

Adjust the backup load on the client.

Increase the number of jobs that clients can perform concurrently, or use
multiplexing. Another possibility is to increase the number of jobs that the
media server can perform concurrently for the policies that back up the
clients.

Reduce the time that is needed to back
up clients.

Increase the Limit jobs per policy attribute for the preferred policy relative
to other policies. Or, increase the priority for the policy.

See “Limit jobs per policy (policy attribute)” on page 739.

Give preference to a policy.

Increase the Limit jobs per policy andMaximum jobs per client for policies
and clients in a faster network. Decrease these numbers for slower networks.
Another solution is to use the NetBackup capability to limit bandwidth.

See “Limit jobs per policy (policy attribute)” on page 739.

See “Storage unit selection criteria within a group” on page 639.

Adjust the load between fast and slow
networks.

Use multiplexing. Allow as many concurrent jobs per storage unit, policy,
and client as possible without causing server, client, or network performance
problems.

Maximize the use of devices.

■ Place some drives in a down state or limit the number that are used
concurrently in a specific storage unit. For example, if there are four drives
in a robot, allow only two to be used concurrently.

■ Do not place all devices under Media Manager control.

Prevent backups frommonopolizing tape
devices.

Exception to the storage unit selection criteria
The only exception to the storage unit selection criteria order is in the case of a
client that is also a media server with locally connected storage units. The locally
available storage units take precedence over the defined sequence of storage units
in the group.

You may have set up a storage unit to beOn demand only. If the unit is in a storage
unit group that a policy requires, the On demand only option is satisfied and the
device is used.

See “On demand only storage unit setting” on page 613.

See “Storage unit selection criteria within a group” on page 639.
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About disk spanning within storage unit groups
A backup may span storage units if a disk full condition is detected. Backups can
span from one BasicDisk storage unit to another BasicDisk storage unit if the storage
units are in the same storage unit group. The storage units must also share the
same media server.

See “Storage unit selection criteria within a group” on page 639.
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Configuring storage lifecycle
policies (SLPs)

■ Chapter 15. Configuring storage lifecycle policies

■ Chapter 16. Storage operations

■ Chapter 17. Retention types for SLP operations

■ Chapter 18. Storage lifecycle policy options

■ Chapter 19. Using a storage lifecycle policy to create multiple copies

■ Chapter 20. Storage lifecycle policy versions
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Configuring storage
lifecycle policies

This chapter includes the following topics:

■ About storage lifecycle policies

■ Creating a storage lifecycle policy

■ Deleting a storage lifecycle policy

■ Lifecycle operation administration using the nbstlutil command

About storage lifecycle policies
A storage lifecycle policy (SLP) is a storage plan for a set of backups. An SLP is
configured within the Storage Lifecycle Policies utility.

An SLP contains instructions in the form of storage operations, to be applied to the
data that is backed up by a backup policy. Operations are added to the SLP that
determine how the data is stored, copied, replicated, and retained. NetBackup
retries the copies as necessary to ensure that all copies are created.

SLPs offer the opportunity for users to assign a classification to the data at the
policy level. A data classification represents a set of backup requirements, which
makes it easier to configure backups for data with different requirements. For
example, email data and financial data.

SLPs can be set up to provide staged backup behavior. They simplify data
management by applying a prescribed behavior to all the backup images that are
included in the SLP. This process allows the NetBackup administrator to leverage
the advantages of disk-based backups in the near term. It also preserves the
advantages of tape-based backups for long-term storage.
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TheSLPParameters properties in theNetBackupAdministration Console allow
administrators to customize how SLPs are maintained and how SLP jobs run.

See “SLP Parameters properties” on page 230.

Best-practice information about SLPs appears in the following document:

http://www.veritas.com/docs/TECH208536

Creating a storage lifecycle policy
A storage lifecycle policy (SLP) is a storage plan for a set of backups. The operations
in an SLP are the backup instructions for the data. Use the following procedure to
create an SLP that contains multiple storage operations.

To add a storage operation to a storage lifecycle policy

1 In theNetBackup Administration Console, selectNetBackupManagement
> Storage > Storage Lifecycle Policies.

2 Click Actions > New > Storage Lifecycle Policy.

3 In the New Storage Lifecycle Policy dialog box, enter a Storage lifecycle
policy name.

See “NetBackup naming conventions” on page 1163.
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4 Add one or more operations to the SLP. The operations are the instructions
for the SLP to follow and apply to the data that is specified in the backup policy.

If this is the first operation added to the SLP, click Add.

If this is not the first operation in the SLP, add an operation that is either
hierarchical or non-hierarchical:

To create a hierarchical operation, select an operation to become the source
of the next operation. Click Add. The new operation is a child of the selected
operation. The child is indented under the parent operation.

To create a non-hierarchical operation, do not select an operation. A
non-hierarchical operation means that the operation does not have a parent
and child relationship with another operation. The new operation is not indented.

5 In the Properties tab of the New Storage Operation dialog box, select an
Operation type. If you're creating a child operation, the SLP displays only
those operations that are valid based on the parent operation that you've
selected.

The name of the operation reflects its purpose in the SLP:

■ Backup
See “Backup operation in an SLP” on page 653.

■ Backup From Snapshot
See “Backup From Snapshot operation in an SLP” on page 655.

■ Duplication
See “Duplication operation in an SLP” on page 657.

■ Import
See “Import operation in an SLP” on page 659.
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■ Index From Snapshot
See “Index From Snapshot operation in an SLP” on page 661.

■ Replication
See “Replication operation in an SLP” on page 664.
See “About NetBackup Auto Image Replication” on page 1051.

■ Snapshot
See “Snapshot operation in an SLP” on page 667.
See “About NetBackup Replication Director” on page 1093.

6 Configure the properties for the operation.

See “Properties tab of the Storage Operation dialog box” on page 688.

7 TheWindow tab displays for the following operation types: Backup From
Snapshot, Duplication, Import, Index From Snapshot, and Replication. If
you'd like to control when the secondary operation runs, create a window for
the operation.

See “Window tab of the Storage Operation dialog box” on page 692.

8 Click the Advanced button in the Properties tab to display options about how
the window should behave if the window closes and a secondary operation is
not yet complete.

9 Click OK to create the operation.

10 Add additional operations to the SLP as needed. (See step 4.)

11 Change the hierarchy of the operations in the SLP if necessary.

See “Modifying the hierarchy of operations in a storage lifecycle policy”
on page 649.

12 ClickOK to create the SLP. NetBackup validates the SLP when it is first created
and whenever it is changed.

See “Storage lifecycle policy validation dialog box” on page 696.

See “Storage lifecycle policy Validation Report tab” on page 697.

13 Configure a backup policy and select a storage lifecycle policy as the Policy
storage.

See “Creating a backup policy” on page 718.

See “Policy storage (policy attribute)” on page 731.
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Modifying the hierarchy of operations in a storage lifecycle policy
In some cases, the hierarchy of operations in an SLP can be modified. Use the
arrows to move it in the hierarchy.

Note: Veritas recommends that users do not modify automanaged storage lifecycle
policies. If a user begins to modify an automanaged SLP, a dialog appears that
warns users about the possible consequences.

See “Warning about modifying or deleting automanaged policies or storage lifecycle
policies” on page 723.

Note: The order of the operations at the time that the SLP is saved may differ from
the next time the SLP is opened. NetBackup reorders the operations while it stores
them in the catalog configuration file. How the hierarchy works is not changed,
however, and the parent-child relationships are preserved.

Modify the order of the operation in the operation list if needed.

■ Click the arrows to move the operation into the new position.

■ Up arrow
Swaps the position of the selected operation with the sibling above it, if one
exists.
Using the up arrow does not change the source of the selected operation. The
up arrow also moves the children of an operation and preserves their relationship
with the selected operation.
The up arrow is disabled if no sibling appears above the selected operation.

■ Down arrow
Swaps the position of the selected operation with the sibling below it, if one
exists.
Using the down arrow does not change the source of the selected operation.
The down arrow also moves the children of an operation and preserves their
relationship with the selected operation.
The down arrow is disabled if no sibling appears below the selected operation.

■ Right arrow
Moves the operation right in the hierarchy, making the sibling above the operation
the source for the operation.
If no sibling exists above the operation in the hierarchy, the right arrow is
disabled. It is always disabled for Backup and Snapshot operations.
Moving the operation to the right does not change the position number of the
operation in the list.
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The right arrow also moves the children of the operation and preserves their
relationship with the selected operation.

■ Left arrow
Moves the operation to the left in the hierarchy, turning the parent into a sibling.
The left arrow is enabled for some operations. For the left arrow to be enabled,
the selected operation must be either the first or last in a list of siblings.
If the operation is the first sibling of a parent, click the left arrow to make it into
a sibling of its parent.
Note that the left arrow also moves the children along with the selected operation
to preserve the relationship with the operation.
The left arrow is disabled for Backup and Snapshot operations.

Deleting a storage lifecycle policy
To delete a storage lifecycle policy, use the following procedure. Note that to delete
an SLP deletes all versions of the SLP.

Note: Veritas recommends that users do not modify or delete automanaged storage
lifecycle policies. If a user begins to modify or delete an automanaged SLP, a dialog
appears that warns users about the possible consequences.

See “Warning about modifying or deleting automanaged policies or storage lifecycle
policies” on page 723.

To delete a storage lifecycle policy

1 Remove the SLP from all backup policies to prevent new backup jobs from
writing to the SLP.

2 Wait for all in-process backup jobs to the SLP to complete, or cancel the jobs
using the Activity Monitor or the command line.

3 To prevent new jobs or cancel any existing duplication jobs from writing to the
SLP, run the following command:

nbstlutil cancel -lifecycle name

4 Use the Activity Monitor to cancel in-process jobs that use the SLP.

5 Once all of the operations are complete, delete the SLP using one of the
following methods:

■ The NetBackup Administration Console

■ Expand Storage > Storage Lifecycle Policies.

■ Select the SLP name.
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■ Select Edit > Delete.

■ In the Delete Storage Lifecycle Policies dialog box, select the SLP
name and click OK.

■ The nbstl command
nbstl storage_lifecycle_name -delete

If the administrator tries to delete an SLP with active images, status code 1519
appears (Images are in process). Wait several minutes and try to delete the
SLP again until the error no longer appears.

Note: If orphaned images are detected due to a system error, NetBackup logs
the fact that the images exist and alerts the administrator to address the
situation.

Lifecycle operation administration using the
nbstlutil command

The NetBackup storage lifecycle policy utility command (nbstlutil) gives
administrators the ability to intervene between pending SLP operations. Specifically,
the nbstlutil command can be used to cancel, inactivate, or activate the
processing of existing SLP-managed images.

nbstlutil cannot affect the jobs that are currently running or queued. Use the
Activity Monitor to intervene in the jobs that are running or queued.

Table 15-1 nbstlutil details

Detailsnbstlutil information

The command is found in the following location:

On Windows:

install_path\NetBackup\bin\admincmd\nbstlutil

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbstlutil

Where to find
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Table 15-1 nbstlutil details (continued)

Detailsnbstlutil information

Use nbstlutil to perform the following administrative actions:

■ List the status of SLP-managed images. The EMM table that tracks the status of
SLP-processed images can be printed. Support may request this information to
troubleshoot an SLP problem.

■ Cancel pending duplication operations on the selected images or image copies.
When a duplication is canceled, NetBackup considers the image or image copy to
be SLP complete. It does not attempt to create any more copies of the backup
image.

■ Deactivate (suspend) pending and future SLP operations on selected images or
image copies. NetBackup retains the image information so that processing can be
resumed by the administrator at a later time.

■ Activate (resume) suspended SLP operations on selected images or image copies.

See the NetBackup Commands Reference Guide for a description of all the options
available for nbstlutil.

How to use

NetBackup starts a duplication session every five minutes to copy data from a backup
operation for a duplication operation. Five minutes is the default frequency of the Image
processing interval parameter in the SLP Parameters host properties.

For example, a duplication job fails because the library has a hard failure. It may take
longer than two hours to repair the library. The administrator may not want duplication
jobs to begin every two hours. Use the nbstlutil command to inactivate the SLP
while the library is repaired. When ready, the SLP can be activated and duplication
jobs can begin.

Note: Once the job is reactivated, the administrator may want to temporarily change
the Extended image retry interval parameter to one hour to begin duplication jobs
sooner.

When to use
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Storage operations
This chapter includes the following topics:

■ Operation types in a storage lifecycle policy

■ Backup operation in an SLP

■ Backup From Snapshot operation in an SLP

■ Duplication operation in an SLP

■ Import operation in an SLP

■ Index From Snapshot operation in an SLP

■ Replication operation in an SLP

■ Snapshot operation in an SLP

■ Creating a hierarchy of storage operations in a storage lifecycle policy

Operation types in a storage lifecycle policy
The Operation selections are the instructions in the storage lifecycle policy. The
following topics describe the purpose of each operation.

Backup operation in an SLP
Use the Backup operation in a storage lifecycle policy to create a backup. All
Backup operations in a single storage lifecycle policy must be on the same media
server.

A Backup operation creates a tar-formatted image. To create a snapshot image,
select a Snapshot operation.
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Figure 16-1 Backup operation in the New Storage Operation dialog box

Table 16-1 Backup operation characteristics

DescriptionCharacteristic

The selection must be a backup storage unit or a backup storage unit
group (see the following note).

The selection cannot be a snapshot storage unit or a snapshot storage
unit group.

Note: If creating an SLP for Auto Image Replication, do not select a
storage unit group. Auto Image Replication does not support replicating
from a storage unit group. That is, the source copy cannot be in a storage
unit group.

See “About NetBackup Auto Image Replication” on page 1051.

Storage unit
selection

A Backup operation cannot serve as the child of any other operation.
Therefore, do not click on any other operation in the SLP when adding
a Backup operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

A Backup operation can be the source of a Duplication operation. (See
Figure 16-2.)

Source for

If a Backup operation appears in an SLP, it must be the first operation.

An SLP can contain a maximum of four Backup operations.

Hierarchy notes
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Table 16-1 Backup operation characteristics (continued)

DescriptionCharacteristic

A Backup operation generates a Backup job in the Activity Monitor.Job type

Backup operations do not offer the option to create an SLP window.

See “Window tab of the Storage Operation dialog box” on page 692.

Window

Figure 16-2 SLP that contains a Backup operation

Backup
storage unit

Duplication

tar-formatted

Backup
storage unit

tar-formatted

Backup operation
Duplication
operation

Backup From Snapshot operation in an SLP
Use the Backup From Snapshot operation to create a tar-formatted copy of the
snapshot. The new copy is a backup copy. The process is sometimes referred to
as a snapdupe job.
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Figure 16-3 Backup From Snapshot operation in the New Storage Operation
dialog box

Table 16-2 Backup From Snapshot operation characteristics

DescriptionCharacteristic

The selection must be a backup storage unit or a backup storage unit
group.

The selection cannot be a snapshot storage unit or a snapshot storage
unit group.

Storage unit
selection

A Backup From Snapshot operation must use a Snapshot operation
as its source.

Therefore, click on the Snapshot operation in the SLP when adding a
Backup From Snapshot operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

ABackup FromSnapshot operation can be the source for aDuplication
operation. (See Figure 16-4.)

Source for

An SLP may contain more than one Backup From Snapshot operation.
If the firstBackup From Snapshot operation fails with an unrecoverable
error, NetBackup does not attempt the second one.

Note: The SLPmay contain only oneBackup FromSnapshot operation
if the SLP is used by an NDMP policy (or a Standard or MS-Windows
policy with NDMP Data Mover enabled).

Hierarchy notes
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Table 16-2 Backup From Snapshot operation characteristics (continued)

DescriptionCharacteristic

A Backup From Snapshot operation generates a Backup job in the
Activity Monitor.

The Backup job that results from the Backup From Snapshot operation
is under the control of the SLP Manager. If an SLP window is configured,
the Backup job runs during the configured SLP window. If no SLP window
is configured, the Backup job can run at any time; possibly outside of the
backup window as configured in the backup policy. Users may experience
a slight degradation in performance on the client or the client storage
device while NetBackup accesses the snapshot.

Job type

An SLP window can be created for aBackup FromSnapshot operation.

See “Window tab of the Storage Operation dialog box” on page 692.

Window

Figure 16-4 SLP that contains a Backup From Snapshot operation
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Duplication operation in an SLP
Use the Duplication operation to create a copy of a Backup, a Backup from
Snapshot, or anotherDuplication operation. Amedia server performs the operation
and writes the copy.

Note: Use the Replication operation to create a copy of a Snapshot operation.

See “Replication operation in an SLP” on page 664.
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Figure 16-5 Duplication operation in the New Storage Operation dialog box

Table 16-3 Duplication operation characteristics

DescriptionCharacteristic

The selection must be a backup storage unit or a backup storage unit
group.

The selection cannot be a snapshot storage unit or a snapshot storage
unit group.

Storage unit
selection

A Duplication operation can be the child of the following operations:

■ Backup operation
■ Backup From Snapshot operation
■ A Duplication operation

Therefore, click on one of these operations in the SLP when adding a
Duplication operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

A Duplication operation can be the source for a Duplication operation.
(See Figure 16-6.)

Source for

When a Duplication operation appears in an SLP, it cannot be the first
operation.

Hierarchy notes
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Table 16-3 Duplication operation characteristics (continued)

DescriptionCharacteristic

A Duplication operation generates a Duplication job in the Activity
Monitor.

Job type

An SLP window can be created for a Duplication operation.

See “Window tab of the Storage Operation dialog box” on page 692.

Window

Figure 16-6 SLP that contains one Backup operation and two Duplication
operations
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Import operation in an SLP
Use the Import operation as part of Auto Image Replication. An Import operation
in an SLP indicates that the SLP is to automatically import images into the target
master domain. An SLP that contains an Import operation is referred to as an
Import SLP.
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Figure 16-7 Import operation in the New Storage Operation dialog box

Table 16-4 Import operation characteristics

DescriptionCharacteristic

An Import operation can import only from a backup storage unit or a
backup storage unit group. It cannot import from a snapshot storage unit
or a snapshot storage unit group.

Storage unit
selection

An Import operation cannot serve as the child of any other operation.
Therefore, do not click on any other operation in the SLP when adding
a Import operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

An Import operation can be the source of a Duplication operation.

At least one operation in the SLPmust use the Target retention retention
type.

Source for

If an SLP contains an Import operation, it must be the first in the
operations list and the only Import operation.

Hierarchy notes

An Import operation generates an Import job in the Activity Monitor.Job type

An SLP window can be created for an Import operation.

See “Window tab of the Storage Operation dialog box” on page 692.

Window
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TheOverride job priority option can be selected. It allows administrators to specify
a job priority for any import jobs which use this SLP.

Index From Snapshot operation in an SLP
The Index From Snapshot operation indexes the contents of existing snapshots.
When NetBackup indexes a snapshot, it creates an image .f file in the NetBackup
catalog for each snapshot. The presence of an image .f file assists the user when
a file needs to be restored from the snapshot, as described in Table 16-5.

The Backup From Snapshot operation also creates an image .f file. An Index
fromSnapshotmay not be required if aBackup FromSnapshot occurs frequently
enough for the restore needs in your environment. For example, if the Backup
From Snapshot runs once per week but file restores are required daily, consider
using the Index from Snapshot.

The actual restore of the snapshot requires that the snapshot bemounted, regardless
of whether an Index from Snapshot has been performed or not.

Table 16-5 Restore operations

RequirementsDescriptionWhere performedType of restore

No .f file needs to be present in
the NetBackup catalog.

During a live browse restore,
NetBackup automatically mounts
the snapshot so that the user can
see what files it contains. Mounting
and unmounting the snapshot can
be time-consuming.

The user navigates the directory
structure to locate and select the
files for restore.

■ NetBackup
Backup, Archive,
and Restore
interface

■ NetBackup
OpsCenter
Console

Live browse restore

The .f file must be present in the
NetBackup catalog.

■ The user can search for files
based on partial file name.
Knowing the name of the client
or of the policy that created the
backup is not necessary.

■ Offers several filters to narrow
search.

■ Search results display all the
recovery points available to the
user for both backups and
snapshots.

NetBackupOpsCenter
Console

Search for restore

(Also referred to as a
Simplified File Restore
or an Operational
Restore)
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Table 16-6 Index From Snapshot operation characteristics

DescriptionCharacteristic

The Index From Snapshot operation does not write data to a storage unit. However, a storage
unit selection is needed to select the media server that to be used to access the snapshot. As a
best practice, use the storage unit from the Snapshot or Replication operation that is the source
for this operation.

Storage unit
selection

When an Index From Snapshot operation appears in an SLP, it must be the child of a Snapshot
or Replication operation.

Therefore, click on either a Snapshot or aReplication operation in the SLP when adding an Index
From Snapshot operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

While an Index From Snapshot operation cannot be the source for any operation, a Replication
operation can follow it.

Source for

The Index From Snapshot operation can consume system resources and requires that each
snapshot be mounted to create the .f file.

See “Determining where and when the Index From Snapshot operation occurs” on page 663.

Hierarchy notes

An Index From Snapshot operation generates an Index From Snapshot job in the Activity
Monitor.

Job type

An SLP window can be created for an Index From Snapshot operation.

See “Window tab of the Storage Operation dialog box” on page 692.

Window

Consider the following items before using the Index From Snapshot operation:

■ The Index From Snapshot operation is supported only in a Replication Director
configuration.

■ Standard,MS-Windows,NDMP, and VMware backup policy types support the
use of storage lifecycle policies that contain the Index FromSnapshot operation.

Note: However, a Standard or MS-Windows policy with NDMP Data Mover
enabled is not supported.

■ The Index From Snapshot operation can run from a full or an incremental
schedule. The file entries that are added to the .f file for either schedule are
the full set of files since all files can be restored from that snapshot. To do so
allows for the most efficient restore, however, more space is consumed in the
NetBackup catalog by the .f file.
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Determining where and when the Index From Snapshot operation
occurs

Including the Index From Snapshot operation requires some consideration as the
operation can consume system resources and require additional time to perform.
For example, to perform the operation can require that a snapshot be mounted or
that NetBackup gather content details from the file system to populate the catalog.

To help mitigate the extra resource and time that the operation may take, the system
administrator can control when and where the Index From Snapshot operation
runs:

■ Use the storage lifecycle policyWindow tab to schedule when the Index From
Snapshot operation can run. Schedule the operation to run when it is least likely
to interfere with other jobs.
See “Window tab of the Storage Operation dialog box” on page 692.

■ Use the following points to determine where to position the Index From
Snapshot operation in the SLP operations list:

■ Each NetBackup environment needs to determine where the operation works
best in a specific SLP. To place the Index From Snapshot operation too
early (toward the top of the operations list), may consume time when the
restore capabilities are not needed. To place the operation toward the end
of the operations list may cause the administrator to delay a restore until
earlier snapshots or replications complete.

■ Use the Index From Snapshot operation in an SLP only once. A restore
can be performed from any snapshot after one image .f file is created.

■ Any operations list that includes a Backup From Snapshot operation does
not need an Index FromSnapshot operation. TheBackup FromSnapshot
operation creates an image .f file. The only exception is if the index is
needed for restores before the Backup From Snapshot operation occurs.

■ An Index From Snapshot operation cannot have any dependents. An SLP
cannot validate an Index FromSnapshot operation with children. Figure 16-8
shows an SLP with a valid configuration.
Figure 16-9 is also a valid configuration. A Replication operation follows
the Index FromSnapshot operation, but it is not indented. TheReplication
operation is a child of the Snapshot operation, not a child of the Index From
Snapshot operation.
To add a Replication operation after an Index From Snapshot operation,
click on the Snapshot operation, and then click Add.
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Figure 16-8 Example 1 of a valid placement of the Index From Snapshot
operation

Figure 16-9 Example 2 of a valid placement of the Index From Snapshot
operation

Replication operation in an SLP
Use the Replication operation for the following types of replication:

■ NetBackup Replication Director to replicate a snapshot, as shown in
Figure 16-10.
See “About NetBackup Replication Director” on page 1093.

■ NetBackup Auto Image Replication to replicate a backup, as shown in
Figure 16-11.
See “About the storage lifecycle policies required for Auto Image Replication”
on page 1068.
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Table 16-7 Replication operation characteristics

DescriptionCharacteristic

Under Destination storage attributes:

■ For Replication Director, select the Storage that is configured to
contain replicated snapshots.

■ For Auto Image Replication, choose to either:
■ Replicate the backup to storage servers in all target NetBackup

domains.
■ Replicate the backup to a specific master server in a specific

domain. This type of Auto Image Replication is known as targeted
A.I.R.

Storage unit
selection

Click on the appropriate operation when adding aReplication operation.

A Replication operation can be the child of any of the following
operations:

■ Snapshot operation for NetBackup Replication Director to replicate
a snapshot.

■ Another Replication operation.
■ Backup operation for NetBackup Auto Image Replication.

See “Creating a storage lifecycle policy” on page 646.

Child of

AReplication operation can be the source for the following operations:

■ Replication
■ Backup From Snapshot

See “Backup From Snapshot operation in an SLP” on page 655.

Source for

A Replication operation generates a Replication job in the Activity
Monitor.

Job type

An SLP window can be created for a Replication operation.

See “Window tab of the Storage Operation dialog box” on page 692.

Window
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Figure 16-10 Replication operation following a Snapshot operation

Figure 16-11 Replication operation following a Backup operation
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Snapshot operation in an SLP
A Snapshot operation creates a point-in-time, read-only, disk-based copy of data.
NetBackup provides several types of snapshots, depending on the device where
the snapshot occurs.

Use a Snapshot operation as the first operation in a storage lifecycle policy for a
NetBackup Replication Director configuration.

Figure 16-12 Snapshot operation in the New Storage Operation dialog box
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Table 16-8 Snapshot operation characteristics

DescriptionCharacteristic

The following topics describe the types of snapshot storage units that
can be used as the storage for a snapshot operation:

■ See “Primary snapshot storage unit” on page 671.
■ See “Primary + Replication source snapshot storage unit” on page 671.
■ See “Replication source + Replication target snapshot storage unit”

on page 672.
■ See “Replication target snapshot storage unit” on page 672.
■ See “Replication source + Replication target + Mirror snapshot storage

unit” on page 673.
■ See “Replication source + Replication target + Mirror snapshot storage

unit” on page 673.

A Storage unit selection is necessary in the following situations:

■ If the Snapshot is to be used by a subsequentReplication operation.
The storage unit that is specified for the Snapshot operation must
be a snapshot-capable storage unit that represents the primary
storage.

■ If the SLP contains only one operation and that is a Snapshot
operation, specify a storage unit. NetBackup uses that storage unit
to determine which media server to use to launch the snapshot job.

If neither situation applies to the SLP, the administrator may select No
storage unit or may simply make no selection. NetBackup uses the
storage unit that is selected for the Backup From Snapshot operation.

Storage unit
selection

A Snapshot operation cannot serve as the child of any other operation.
Therefore, do not click on any other operation in the SLP when adding
a Snapshot operation.

See “Creating a storage lifecycle policy” on page 646.

Child of

A Snapshot operation can be the source for the following operations:

■ Backup From Snapshot
■ Index From Snapshot
■ Replication operation

Source for

If a Snapshot operation appears in an SLP, it must be first in the
operations list.

Hierarchy notes

ASnapshot operation generates aSnapshot job in theActivity Monitor.Job type

Snapshot operations do not offer the option to create an SLP window.

See “Window tab of the Storage Operation dialog box” on page 692.

Window
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See “About configuring storage lifecycle policies for snapshots and snapshot
replication” on page 669.

About configuring storage lifecycle policies for snapshots and
snapshot replication

A storage lifecycle policy (SLP) contains instructions in the form of storage
operations, to be applied to the data. Operations are added to the SLP that determine
how the data is stored and copied or replicated. For example, the NetBackup
administrator creates an operation that determines where the data exists as a
snapshot, as a replication, or as a duplication. The administrator also determines
the retention of the data at each storage unit or storage unit group.

Storage operations that are defined in the SLP use storage units that represent
disk pools. An SLP that is configured for snapshots or snapshot replication must
contain a specific, hierarchical combination of operations.

The following figure represents an SLP for a replication scenario. In the example,
the following operations are used:

■ A Snapshot operation creates a snapshot.

■ A Replication operation replicates the snapshot to another volume.

■ A Backup From Snapshot operation creates a tar-formatted backup from the
snapshot.

■ A Duplication operation copies the backup to tape.

Table 16-9 describes the four types of operations that are required in this example
replication scenario.

Backup
storage unit

Duplication

Backup
storage unit

BackupReplication Replication
target

Snapshot

Primary/
Replication
source

Snapshot

Snapshot
storage unit

Snapshot
storage unit

Snapshot
operation

Replication
operation

Backup From Snapshot
operation

Duplication
operation

tar-formattedtar-formatted
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Table 16-9 Example of a storage lifecycle policy configured for snapshots
and snapshot replication

DescriptionOperationOperation
order in SLP

Operation 1 creates a snapshot in the primary storage. The snapshot serves as the
source for the other operations in the SLP.

■ The operation must be a Snapshot operation.
■ The storage must be a snapshot storage unit that has the following properties

set: Primary and Replication source.

Note: Only one operation to a Primary storage unit is permitted in an SLP.

Snapshot1

Operation 2 replicates the snapshot that the first operation created.

■ The operation must be a Replication operation and it must be the replication
partner to the source storage unit.

■ The retention type determines what replication method is used. For example, if
retention type Fixed or Expire after copy is selected for a NetApp storage
system, the SnapVault replication method is used.

■ The storage must be a snapshot storage unit that has the Replication target
property set. Since no other replica is created from this operation in this example,
it does not need to have the Replication source property set.

Replication2

(Child to

operation 1)

Operation 3 creates a tar-formatted backup copy of the snapshot.

■ The operation must be a Backup From Snapshot operation. This operation
creates a backup image from the snapshot.

■ The storage must be a backup storage unit.

Backup
From
Snapshot

3

(Child to

operation 2)

Operation 4 makes a duplicate copy from the tar-formatted backup copy. In this
example, the copy is duplicated to tape media.

■ The operation must be aDuplication operation. This operation creates a backup
copy of the tar-formatted image.

■ The storage must be a backup storage unit.

Duplication4

(Child to

operation 3)

After the SLP is configured for different operations, the NetBackup administrator
configures a backup policy that points to the snapshot SLP.

The SLP Parameters host properties in the NetBackup Administration Console
allow administrators to customize how SLPs are maintained and how SLP jobs run.

See “SLP Parameters properties” on page 230.

Best-practice information about SLPs appears in the following document:

http://www.veritas.com/docs/TECH208536
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Primary snapshot storage unit
A snapshot operation can use a Primary snapshot storage unit. That is, the storage
unit represents a disk pool that contains the volumes that have only the Primary
property set.

Figure 16-13 shows an SLP that contains one primary-only Snapshot operation,
one Backup From Snapshot operation, and one Duplication operation. The
Backup From Snapshot operation is used to create a backup from the snapshot
on the primary-only Snapshot operation. After the backup is created, it is duplicated
to a Duplication operation.

Figure 16-13 SLP that contains a Snapshot operation, a Backup From
Snapshot operation, and a Duplication operation
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Primary

Snapshot
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Snapshot
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Duplication
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Primary + Replication source snapshot storage unit
An SLP operation can use a Primary + Replication source snapshot storage unit.
That is, the storage unit represents a disk pool that contains volumes that have
both the Primary property and the Replication source property set.

Figure 16-14 shows an SLP that contains aPrimary +Replication source snapshot
storage unit as one operation and one Replication target snapshot storage unit
as another operation. The Primary +Replication source storage unit can replicate
to the Replication target storage unit.
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Figure 16-14 SLP that contains a Snapshot operation and a Replication
operation

Replication
operation

Replication Replication
target

Snapshot
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operation
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Replication source + Replication target snapshot storage unit
An SLP operation can use a snapshot storage unit that represents a disk pool that
contains volumes that have the following properties: Replication source and
Replication target.

A snapshot storage unit with these properties can serve as both the Replication
source for another operation in the SLP, and as the Replication target for another
operation in the SLP.

Figure 16-15 SLP that contains a Snapshot operation and two Replication
operations
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Replication target snapshot storage unit
An SLP operation can use a snapshot storage unit that represents a disk pool that
contains volumes that have only the Replication target property set.
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An operation with this property can serve only as a Replication target for another
operation in the SLP. It cannot serve as source for a replica, but it can serve as the
source for a Duplication operation.

Figure 16-16 SLP that contains a Snapshot operation, a Replication operation,
a Backup From Snapshot operation, and a Duplication operation
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Replication source + Replication target + Mirror snapshot storage
unit

An SLP can use a snapshot storage unit that represents a disk pool that contains
volumes that have the following properties:Replication source,Replication target,
and Mirror.

An operation with these properties can serve as both:

■ A Replication source in a cascading configuration.

■ A mirrored Replication target in a cascading configuration. A mirrored
Replication target must have a forced Mirror retention type.

Replication target + Mirror snapshot storage unit
An SLP can use a snapshot storage unit that represented a disk pool that contains
volumes that have the following properties: Replication target and Mirror.

A mirrored Replication target must have a forced Mirror retention type.

Creating a hierarchy of storage operations in a
storage lifecycle policy

The list of operations in the storage lifecycle policy acts as a list of instructions to
NetBackup about the data that the SLP protects. In some cases, one operation
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depends on another operation. For example, a snapshot may serve as the source
for a replication. Or, a backup may serve as the source of a duplication.

The operation hierarchy in the Storage Lifecycle Policy dialog box represents a
parent and child relationship.

Figure 16-17 is an example of how the operation list uses indentation to indicate
the relationship between a parent operation and a child operation.

Figure 16-17 Hierarchical storage operations in an SLP

One copy can be the source for many other copies. Figure 16-18 shows how after
the first copy is created, all subsequent copies can be made locally from that source,
without tying up network resources.

Figure 16-18 Hierarchical operations

Data domain 1
Data domain 2

Duplication operations

Snapshot
operation Backup from

Snapshot
operation
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Changing the location of an operation in the hierarchy changes the storage unit
that serves as the source for the subsequent copies. Changing the hierarchy cannot
change the operation type. (For example, change a backup operation into a
duplication operation.)
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Retention types for SLP
operations

This chapter includes the following topics:

■ Retention types for storage lifecycle policy operations

■ Capacity managed retention type for SLP operations

■ Expire after copy retention type for SLP operations

■ Fixed retention type for SLP operations

■ Maximum snapshot limit retention type for SLP operations

■ Mirror retention type for SLP operations

■ Target retention type for SLP operations

Retention types for storage lifecycle policy
operations

The Retention type for an operation in a storage lifecycle policy determines how
long the data is kept on that storage media.

Table 17-1 describes which retention types are valid selections for the various
operations.
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Table 17-1 Operation and retention type configurations

Duplication
operation

Backup From
Snapshot
operation

Replication
operation

Snapshot
operation

Backup
operation

Retention
type

ValidValidValidValidValidFixed

ValidValidValidValidValidExpire after
copy

InvalidInvalidInvalidValid; SLP
honors the policy
setting.

InvalidMaximum
Snapshot limit

Valid for snapshot
storage only

InvalidValid for
snapshot storage
only

InvalidInvalidMirror

Valid if the first
operation in the SLP
is an Import.

InvalidValid if the first
operation in the
SLP is an Import
and if the storage
is of the backup
type.

InvalidInvalidTarget retention

Valid; AdvancedDisk
default; set on the
storage server.

InvalidInvalidInvalidValid;
AdvancedDisk
default; set on
the storage
server.

Capacity
managed

Note:Retention is not associated with the Index FromSnapshot operation because
the operation does not create any copy.

Mixing retention types
Veritas does not recommend allowing capacity-managed images and fixed-retention
images to be written to the same volume in a disk storage unit. The volume may
fill with fixed-retention images and not allow the space management logic to operate
as expected.

Keep in mind the following points when configuring SLP operations or selecting the
storage location for a policy:

■ All SLPs that write to a volume in a disk storage unit should write images of the
same retention type: fixed or capacity-managed.
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■ Do not write images both to a volume in a disk storage unit within an SLP and
to the same volume (by the storage unit) directly from a policy.

■ Mark all disk storage units that are used with SLPs as On demand only.

■ Check any storage unit groups to make sure that fixed and capacity-managed
images cannot be written to the same volume in a disk storage unit.

Capacity managed retention type for SLP
operations

A Capacity managed operation means that NetBackup automatically manages
the space on the storage, based on the High water mark setting for each volume.
Capacity managed is not available to tape storage units since tape capacity is
considered to be infinite.

The High water mark and Low water mark settings on the disk storage unit or
disk pool determine how the space is managed.

See “High water mark storage unit setting” on page 606.

See “Low water mark storage unit setting” on page 607.

An image copy with a Capacity Managed retention is not eligible for expiration
until its dependent copies have been created.

If space is needed for new images, NetBackup removes expired backup images
from a capacity-managed disk volume in two passes, as follows:

NetBackup removes any backup images that are past the Desired cache
period setting. NetBackup removes images until the lowwater mark is reached
or all images that are past the Desired cache period are removed.

Pass one

Pass two processing is initiated if the outcome of the pass one processing is
one of the following:

■ The disk pool remains over the high water mark.
■ The number of volumes in the disk pool under the high water mark is less

than the number of media servers that access the disk pool.

NetBackup removes images until the low water mark is reached or all images
that are not past the Desired cache period are removed.

An image may be deleted if it has not been duplicated for all operations in a
storage lifecycle policy. If the operating system time is past the date that
matches the longest retention period for an image, the image is eligible for
deletion.

Pass two
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To see exactly when the storage reaches the low water mark value is difficult. A
backup can occur at the same time as the expiration process occurs. After the
backup is complete, the low water mark may be slightly greater than its lowest
possible value.

The retention period for capacity managed storage is not assured as it is for a fixed
retention period. TheDesired cache period becomes a target that NetBackup tries
to maintain. If the space is not required, the backup data could remain on the storage
longer than the Desired cache period indicates.

Rules and recommendations for using the Capacity Managed
retention type

Use the following recommendations and rules when configuring storage operations
or when selecting the storage location for a policy:

■ Veritas does not recommend allowing Capacity Managed images and Fixed
retention images to be written to the same volume in a disk storage unit. The
volumemay fill with fixed-retention images and not allow the space management
logic to operate as expected.

■ All SLPs that write to a volume in a disk storage unit should write images of the
same retention type: Fixed or Capacity Managed.

■ Do not write images both to a volume in a disk storage unit within a storage
lifecycle policy and to the same volume (by the storage unit) directly from a
policy.

■ Mark all disk storage units that are used with SLPs as On demand only.

■ Check any storage unit groups to make sure that fixed and capacity-managed
images cannot be written to the same volume in a disk storage unit.

Capacity managed retention type and disk types that support SIS
Capacity managed is selectable for any disk storage unit that is allowed in an SLP.
However, for the disk types that support single-instance storage (SIS), Capacity
managed functions to various degrees. In order forCapacity managed to operate,
NetBackup must know how much space a backup image uses. With SIS enabled
on the storage unit, NetBackup cannot know exactly how much space a particular
backup image occupies.

The following storage unit configurations use SIS:

■ Media Server Deduplication Pool storage units

■ Some OpenStorage storage units, depending on the vendor characteristics.
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Expire after copy retention type for SLP
operations

The Expire after copy retention indicates that after all direct (child) copies of an
image are successfully duplicated to other storage, the data on this storage is
expired. The last operation in the SLP cannot use the Expire after copy retention
type because no subsequent copy is configured. Therefore, an operation with this
retention type must have a child.

Veritas recommends that you not enable Expire after copy retention for any storage
units that are to be used with SLPs with either of the following: Accelerator or
synthetic backups. The Expire after copy retention can cause images to expire
while the backup runs. To synthesize a new full backup, the SLP backup needs the
previous backup image. If the previous image expires during the backup, the backup
fails.

Note: Although synthetic backups do support the use of storage lifecycle policies,
SLPs cannot be used for the multiple copy synthetic backups method.

See “Using the multiple copy synthetic backups method” on page 915.

If a policy is configured to use an SLP for the backup, the retention that is indicated
in the SLP is the value that is used. The Retention attribute in the schedule is not
used.

An image copy with an Expire after copy retention is expired as soon as all of its
direct child copies have been successfully created. Any mirrored children must also
be eligible for expiration.

Fixed retention type for SLP operations
The Fixed retention indicates that the data on the storage is retained for the specified
length of time, after which the backups or snapshots are expired.

An image copy with a Fixed retention is eligible for expiration when all of the
following criteria are met:

■ The Fixed retention period for the copy has expired.

■ All child copies have been created.

■ All child copies that are mirror copies are eligible for expiration.

The Fixed retention period is always marked from the original backup time of the
image. For example, if a tape device is down, causing a 2-day delay in creating a
duplicate tape copy, the expiration time of the duplicate copy is not different due to
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the 2-day delay. The expiration time of the duplicate copy is still x days from the
time that the original backup was completed. It does not matter when the copy was
created.

Maximum snapshot limit retention type for SLP
operations

TheMaximum snapshot limit determines the maximum number of snapshots that
can be stored for a particular policy and client pair.

When the maximum is reached, the next snapshot causes the oldest job-complete
snapshot to be deleted. A snapshot job is considered to be complete once all of its
configured dependent copies are complete. (Dependent copies are created as a
result of Backup From Snapshot, Index From Snapshot, or Replication
operations.) The practice is referred to as rotation. This retention type applies only
to snapshots, and not to backups.

For example, Policy P1 contains two clients: C1 and C2. After the policy runs four
times, it creates four snapshot images for C1 and four images for C2. If the
Maximum snapshot limit is set to four, when the policy runs for the fifth time,
NetBackup deletes the first snapshot that was created for both C1 and C2 to
accommodate the fifth snapshot.

TheMaximum Snapshots parameter in the Replication Director Options dialog
box determines the maximum number of snapshots. To access the dialog box, click
Options in the backup policy.
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Figure 17-1 Replication Director Options dialog box

See “Snapshot Client and Replication Director (policy attributes)” on page 787.

Mirror retention type for SLP operations
A mirror replica of a snapshot is eligible for expiration as soon as:

■ All immediate child copies are successfully created.

■ All immediate child copies that are mirrors are eligible for expiration.

The selection of the Mirror retention indicates that NetApp volume SnapMirror is
to be used as the replication method. If any non-mirror retention type such as Fixed
or Expire after copy is selected for the Replication operation, the NetApp
SnapVault replication method is used.
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In mirror replication, the replica copy is dependent on the existence of the source.
(The source can be the original snapshot or another replica.) Therefore, the retention
of the replica depends on the retention of the source. If the source is deleted, the
mirror is automatically deleted.

In non-mirror replication, the replica is independent of the source and can have an
independent retention. If the source is deleted, the non-mirror replica is not affected
and can be used longer than the source. Or, if the replica is deleted first, it is not
recreated and the source can be kept longer than the replica.

Target retention type for SLP operations
This setting is used in Auto Image Replication in an Import storage lifecycle policy.
Every Import SLP must have at least one operation with a Target retention.

The Target retention is enforced at the target domain, but the actual retention for
the data is specified by the administrator at the source domain.

Target retention indicates that the data at the target master shall use the expiration
date that was imported with the image. The date is fixed because the copy must
have a fixed retention.

Similar to the Fixed retention, an image copy with a Target retention retention is
eligible for expiration when all of the following criteria are met:

■ The Fixed retention period for the copy has expired.

■ All child copies have been created.

■ All child copies that are mirror copies are eligible for expiration.

See “About NetBackup Auto Image Replication” on page 1051.
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Storage lifecycle policy
options

This chapter includes the following topics:

■ Storage Lifecycle Policy dialog box settings

■ New or Change Storage Operation dialog box settings

■ Storage lifecycle policy validation dialog box

■ Storage lifecycle policy Validation Report tab

Storage Lifecycle Policy dialog box settings
TheNew Storage Lifecycle Policy dialog box and theChange Storage Lifecycle
Policy dialog box contain the following settings.
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Figure 18-1 Storage Lifecycle Policy tab

Table 18-1 Storage Lifecycle Policy tab

DescriptionSetting

The Storage lifecycle policy name describes the SLP. The name cannot be modified after
the SLP is created.

Storage lifecycle
policy name
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Table 18-1 Storage Lifecycle Policy tab (continued)

DescriptionSetting

The Data classification defines the level or classification of data that the SLP is allowed
to process. The drop-down menu contains all of the defined classifications as well as the
Any classification, which is unique to SLPs.

TheAny selection indicates to the SLP that it should preserve all images that are submitted,
regardless of their data classification. It is available for SLP configuration only and is not
available to configure a backup policy.

In an Auto Image Replication configuration where the master server domains run different
versions of NetBackup, see the following topic for special considerations:

See “About the storage lifecycle policies required for Auto Image Replication” on page 1068.

The Data classification is an optional setting.

One data classification can be assigned to each SLP and applies to all operations in the
SLP.

If a data classification is selected (other than Any), the SLP stores only those images from
the policies that are set up for that data classification. If no data classification is indicated,
the SLP accepts images of any classification or no classification.

The Data classification setting allows the NetBackup administrator to classify data based
on relative importance. A classification represents a set of backup requirements. When data
must meet different backup requirements, consider assigning different classifications.

For example, email backup data can be assigned to the silver data classification and financial
data backup may be assigned to the platinum classification.

A backup policy associates backup data with a data classification. Policy data can be stored
only in an SLP with the same data classification.

Once data is backed up in an SLP, the data is managed according to the SLP configuration.
The SLP defines what happens to the data from the initial backup until the last copy of the
image has expired.

Data classification

The Priority for secondary operations option is the priority that jobs from secondary
operations have in relationship to all other jobs. The priority applies to the jobs that result
from all operations except for Backup and Snapshot operations. Range: 0 (default) to
99999 (highest priority).

For example, you may want to set the Priority for secondary operations for a policy with
a gold data classification higher than for a policy with a silver data classification.

The priority of the backup job is set in the backup policy on the Attributes tab.

See “Job priority (policy attribute)” on page 741.

Priority for secondary
operations
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Table 18-1 Storage Lifecycle Policy tab (continued)

DescriptionSetting

Use the Add, Change, and Remove buttons to create a list of operations in the SLP. An
SLP must contain one or more operations. Multiple operations imply that multiple copies
are created.

See “About writing multiple copies using a storage lifecycle policy” on page 699.

The list also contains the columns that display information about each operation. Not all
columns display by default.

For column descriptions, see the following topic:

See “New or Change Storage Operation dialog box settings” on page 688.

Operations

Use the arrows to indicate the indentation (or hierarchy) of the source for each copy. One
copy can be the source for many other copies.

See “Creating a hierarchy of storage operations in a storage lifecycle policy” on page 673.

See “Modifying the hierarchy of operations in a storage lifecycle policy” on page 649.

Arrows

The Active and Postponed options appear under State of Secondary Operation
Processing and refer to the processing of all duplication operations in the SLP.

Note: The Active and Postponed options apply to duplication operations that create
tar-formatted images. For example, those created with bpduplicate. The Active and
Postponed options do not affect the images that are duplicated as a result of OpenStorage
optimized duplication, NDMP, or if one or more destination storage units are specified as
part of a storage unit group.

■ EnableActive to let secondary operations continue as soon as possible. When changed
from Postponed to Active, NetBackup continues to process the images, picking up
where it left off when secondary operations were made inactive.

■ Enable Postponed to postpone the secondary operations for the entire SLP. Postponed
does not postpone the creation of duplication jobs, it postpones the creation of images
instead. The duplication jobs continue to be created, but they are not run until secondary
operations are active again.
All secondary operations in the SLP are inactive indefinitely unless the administrator
selects Active or until the Until option is selected and an activation date is indicated.

Active

and

Postponed

Click this button to see how changes to this SLP can affect the policies that are associated
with this SLP. The button generates a report that displays on the Validation Report tab.

This button performs the same validation as the -conflict option performs when used
with the nbstl command.

See “Storage lifecycle policy Validation Report tab” on page 697.

Validate Across
Backup Policies button
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New or Change Storage Operation dialog box
settings

The Storage Operation dialog box contains two tabs:

■ Properties tab
The following topic describes the options in the Properties tab:
See “Properties tab of the Storage Operation dialog box” on page 688.

■ Window tab
Create a window during which a secondary operation can run. The following
topic describes the options in theWindow tab:
See “Window tab of the Storage Operation dialog box” on page 692.

Properties tab of the Storage Operation dialog box
Table 18-2 describes the options available to configure for the various operations
in a storage lifecycle policy. Not all options are available for each operation.

Table 18-2 Properties tab of the Storage Operation dialog box

DescriptionSetting

Indicates the storage unit that is the source for the operation.

The Source displays for the following operation types: Backup From Snapshot, Replication,
Duplication, and Index From Snapshot.

Source

The Operation selection determines which options appear in the dialog box.

See “Operation types in a storage lifecycle policy” on page 653.

See “About writing multiple copies using a storage lifecycle policy” on page 699.

Operation

Select a Retention type from the following options:

■ See “Capacity managed retention type for SLP operations” on page 678.
■ See “Expire after copy retention type for SLP operations” on page 680.
■ See “Fixed retention type for SLP operations” on page 680.
■ See “Maximum snapshot limit retention type for SLP operations” on page 681.
■ See “Mirror retention type for SLP operations” on page 682.
■ See “Target retention type for SLP operations” on page 683.

See “Retention types for storage lifecycle policy operations” on page 676.

Retention type
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Table 18-2 Properties tab of the Storage Operation dialog box (continued)

DescriptionSetting

Specifies how long NetBackup retains the backup or copy. To set the retention period, select a
time period (or level) from the list. When the retention period expires, NetBackup deletes
information about the expired backup or copy. After expiration, the files are unavailable for restores.
For example, if the retention is set to two weeks, data can be restored from a backup that this
schedule performs for two weeks after the backup.

See “Retention Periods properties” on page 203.

Retention period

Indicates that the copy of the image is to be created in a different master server domain. The
target master server manages the storage where the image is to be copied.

If Target master is selected for a Replication operation, the operation becomes an operation
for Auto Image Replication.

Target master

Indicate the storage unit to be used.

Select from the following storage units:

■ Media Manager storage units (tape)
■ Disk storage units (no BasicDisk or disk staging storage units)
■ Storage unit groups (may contain no BasicDisk or disk staging storage units). A storage

lifecycle policy can point to a storage unit group that contains a BasicDisk storage unit.
However, NetBackup does not select BasicDisk storage units from a storage group for a
lifecycle policy.

Storage units or storage unit groups may appear in more than one storage lifecycle policy. Storage
units or storage unit groups may be used in a storage lifecycle policy while also being used as
standalone units.

Local storage

Indicate the storage unit to be used.

Select from the following storage units:

■ Media Manager storage units (tape)
■ Disk storage units (no BasicDisk or disk staging storage units)
■ Storage unit groups (may contain no BasicDisk or disk staging storage units). A storage

lifecycle policy can point to a storage unit group that contains a BasicDisk storage unit.
However, NetBackup does not select BasicDisk storage units from a storage group for a
lifecycle policy.

■ No storage unit
A storage unit selection is necessary if the snapshot is to be used by a subsequentReplication
operation or if the SLP contains only one operation. If neither situation applies to the SLP,
the administrator may select No storage unit or may simply make no selection.

Storage units or storage unit groups may appear in more than one lifecycle. Storage units or
storage unit groups may be used in a storage lifecycle while also being used as standalone units.

Storage unit

The Volume pool option is enabled for tape storage units or virtual tape libraries (VTL).Volume pool
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Table 18-2 Properties tab of the Storage Operation dialog box (continued)

DescriptionSetting

A Media owner is a group of NetBackup servers that are used for a common purpose. By
specifying a Media owner, you allow only those media servers to write to the media on which
backup images for a policy are written.

Media owner

AnAlternate read server specifies the name of the server that is allowed to read a backup image
originally written by a different media server. This option is available for Duplication operations
only.

Alternate read
server

The Preserve Multiplexing option is available for the duplication operations that use tape media
or virtual tape libraries (VTL). If the backup to be duplicated is multiplexed and you want the
backups to remain multiplexed, check Preserve Multiplexing.

To preserve multiplexing significantly improves performance of duplication jobs because it
eliminates the need to request the write-side duplication media for every image.

Preserve
multiplexing

The Override job priority option is available for an Import operation. The job priority that is
indicated is the job priority for any import jobs which use this storage lifecycle policy.

Override job
priority

Enable this option to defer the job until the source for the duplication is about to expire. When
this option is enabled, the job begins 4 hours before the source is to expire. This default can be
changed by changing the Deferred duplication offset time in the SLP Parameters host
properties.

See “SLP Parameters properties” on page 230.

Postpone
creation of this
copy until the
source copy is
about to expire

690Storage lifecycle policy options
New or Change Storage Operation dialog box settings



Table 18-2 Properties tab of the Storage Operation dialog box (continued)

DescriptionSetting

If a window closes and the jobs for an SLP have not completed, NetBackup attempts to suspend
the images that are in progress. When the window reopens, NetBackup resumes those jobs at
the point they were when suspended.

Not all images can be suspended. The image must be the result of a duplication job where both
the source and target of the duplication resides on either an AdvancedDisk or Media Manager
storage unit.

In addition, the duplication job must meet the following conditions:

■ The storage units must not be part of a storage unit group.
■ The duplications were not created using optimized duplication, NDMP duplication, or

OpenStorage duplication.

See “Duplication operation in an SLP” on page 657.

Note: The closing of the window does not stop preliminary operations for some jobs. For example,
NetBackup continues to extend the catalog for Exchange Granular Recovery after the window
closes, but does not start duplications.

Images that result from all other operations (such as Replication operations), are not suspended.

Click the Advanced button to display theWindow close preference options. The selections
apply to the images that NetBackup does not suspend automatically.

Select what NetBackup should do if images are not completed by the time the window closes
and if the images cannot be suspended:

■ Finish processing the active images.
The window closes, but NetBackup continues to process the active images until they are
finished. NetBackup does not begin to process any other images until the window reopens.

■ Cancel the processing of the active images.
The window closes and NetBackup immediately stops processing the active images. When
the window reopens, NetBackup begins to process the images where it left off.

Advanced button
andWindowclose
preference options
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Figure 18-2 Windows close preference selections for secondary operations

Window tab of the Storage Operation dialog box
TheWindow tab appears for secondary operations in a storage lifecycle policy.

Creating a window for a secondary operation is optional. However, creating a window
can better define when the job for the operation can run. In this way, the job from
a secondary operation does not interfere with jobs of a higher priority, such as
backup jobs. Without a window defined, the job for an operation can run at any
time, on any day.
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Figure 18-3 Window tab for secondary operations in a storage lifecycle policy

Table 18-3 Window tab of the Storage Operation dialog box

DescriptionSetting

You can either assign an existing window to the operation or create a
new window for the operation.

To use an existing window, select this option and then select a window
from the drop-down menu.

Select from saved
windows

Select this option to create a new window for this operation to use.Create new

Enter a name for the new window.Window name

This option generates an Impact Report which lists the names of the
storage lifecycle policies that currently use the window. The Impact
Report also lists the operation that uses the window, and the source
and the destination storage for the operation.

View Impact
Report option
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Table 18-3 Window tab of the Storage Operation dialog box (continued)

DescriptionSetting

The Start Window grid is grayed out and cannot be modified if the
Default_24x7_Window is selected.

The Start Window grid is active if a saved window is selected or when
a new window is created.

If the Start Window grid is changed for a saved window, click the View
Impact Report option to display information about other operations in
other SLPs that use the window.

See “Creating a new window for a storage lifecycle policy operation”
on page 694.

Start Window tab

Use the Exclude Days tab to exclude specific dates from a window.

See “Excluding days from a window for a storage lifecycle policy
operation” on page 695.

Exclude Days tab

Creating a new window for a storage lifecycle policy operation
To create a new window for SLP operations

1 In theWindow tab of the storage operation dialog box, enable Create new.

2 Select the Start Window tab.

3 The days of the week appear along the left side of the grid. The time of day
appears along the top of the grid in 24-hour time.

To change the increments available for selecting start times or end times,
change the value in the Resolution field.

4 Indicate the opening and closing times of the window for each day. The following
lists several methods to do so:

■ Drag the cursor along the Start Window grid on each day you want the
window to open and close.

■ Use the drop-down menus to select a Start day and an End day. Then
select a Start time and an End time.

■ Use the drop-down menu to select a Start day and the Duration of the
window for that day in hours and minutes. Adjust the Start time for your
environment.

To create multiple time windows:

■ First, create one window.

694Storage lifecycle policy options
New or Change Storage Operation dialog box settings



■ Click Duplicate.
The window is duplicated to any days without existing schedules. Duplication
stops when it reaches a day that already contains a window.

■ On days that you do not want the time window to be open, select the window
and click Delete.

5 Use the buttons under the Start Window grid to do the following:

Adjust the Start time or End time.To change the start time or
end time

Select a time window and click Delete.To delete a time window

Click Clear.To delete all the time windows

Click Undo.To erase the last action

6 Click OK to save the window and the operation.

Excluding days from a window for a storage lifecycle policy operation
Use the Exclude Days tab to exclude specific days from a window. If a day is
excluded from a window, jobs do not run on that day. The tab displays a calendar
of three consecutive months. Use the lists at the top of the calendar to change the
first month or year displayed.

To exclude a day from the storage lifecycle policy window

1 In theWindow tab, select the name of an existing window from the drop-down
menu.

2 Select the Exclude Days tab.

3 Use one or more methods to indicate the days to exclude:

■ Select the day(s) on the 3-month calendar that you want to exclude. Use
the drop-down lists at the top of the calendar to change the months or year.

■ To indicate Recurring Week Days:

■ Click Select All to select all of the days in every month for every year.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select a specific day to exclude for every
month.

■ Click the column head of a day of the week to exclude that day every
month.
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■ Click the 1st, 2nd, 3rd, 4th, or Last row label to exclude that week every
month.

■ To indicate Recurring Days of the Month:

■ Click Select All to select all of the days in every month.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select that day to exclude each month.

■ Click Last Day to exclude the last day of every month.

■ To indicate Specific Dates:

■ Click New. Enter the month, day, and year in the Date Selection dialog
box. Click OK.
The date appears in the Specific Dates list.

■ To delete a date, select the date in the list. Click Delete.

4 Add additional dates as necessary, and then click OK to save the window and
the operation.

Storage lifecycle policy validation dialog box
The Storage Lifecycle Policy validation dialog box may appear if NetBackup cannot
save the SLP as configured because of problems with the operations in the SLP.
The dialog box may also appear after the administrator clicks Validate Across
Backup Policies, before the Validation Report tab displays.

The Storage Lifecycle Policy validation dialog box displays the errors that must be
corrected before the SLP can be saved. For example, errors regarding the hierarchy
of operations in the SLP or errors concerning the storage units that the operations
indicate.

The dialog box contains the following information about any validation errors:

The operation in the SLP that contains errors. The index number is the
operation's order in the SLP. For example, the second operation has an
index number of two.

Index

The type of operation where the error occurs in the SLP.Operation

The storage name that is indicated in the operation where the error occurs.Storage

The NetBackup status code. Use the NetBackup Troubleshooter or the
NetBackup Status Codes Reference Guide to determine corrective actions.

See “Running the Troubleshooter” on page 44.

Error code
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The vendor-specific error code and a description of the error.Error
description

Figure 18-4 Storage Lifecycle Policy validation dialog box

Storage lifecycle policy Validation Report tab
NetBackup validates the SLP when it is first created and whenever it is changed.
The Validation Report tab lists the conflicts between the proposed changes to the
operations in a storage lifecycle policy and any backup policy that uses the SLP.

Likewise, when a policy is created that indicates an SLP as the Policy storage, a
similar validation report may display. The report lists any conflicts between the
policy and the SLP that it has indicated.

The conflicts that are listed must be resolved in order for a job that references the
SLP to run successfully. Use the Troubleshooter or the online Help on this tab for
a list of common status codes that result from SLP conflicts.

Note: The Request has timed out message may appear in environments with
very busy servers.

To increase the timeout to account for the latency in connectivity, increase the
NBJAVA_CORBA_DEFAULT_TIMEOUT value in the following files:

On Windows: The setconf.bat configuration file
(Install_path\java\setconf.bat).

On UNIX: The nbj.conf configuration file (/usr/openv/java/nbj.conf).

The report checks for the following conflicts between the selected SLP and the
backup policies that use it:

697Storage lifecycle policy options
Storage lifecycle policy Validation Report tab



■ The data classification in the storage lifecycle policy does not match that in the
referencing backup policies.

■ The SLP contains a Snapshot operation, but the referencing backup policies
do not have Perform snapshot backups enabled.

■ The SLP does not contain a Snapshot operation, but the referencing backup
policies have the Perform snapshot backups enabled.

■ The SLP contains a Snapshot operation, but the referencing backup policies
cannot enable the Retain snapshots for Instant Recovery option.

■ The policy is of the NBU-Catalog backup type, but the SLP configuration does
not indicate a CatalogBackup volume pool.

■ The policy is not of the NBU-Catalog backup type, but the SLP configuration
indicates a CatalogBackup volume pool

To generate a validation report using the command line, run the following command:

nbstl SLP_name -impact

Figure 18-5 Validation Report tab of the Storage Lifecycle Policy dialog box
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Using a storage lifecycle
policy to create multiple
copies

This chapter includes the following topics:

■ About writing multiple copies using a storage lifecycle policy

■ How the order of the operations determines the copy order

■ About ensuring successful copies using lifecycles

About writing multiple copies using a storage
lifecycle policy

A storage lifecycle policy can be used to create multiple copies of backups and
snapshots.

NetBackup permits only one method to create multiple copies to be in use at one
time. Use only one of the following methods:

■ Enable the Multiple copies option in a policy configuration.
If a policy has the Multiple copies option enabled, the policy cannot select a
storage lifecycle policy as the Policy storage.
See “Multiple copies (schedule attribute)” on page 806.

■ Add multiple Backup operations or one or more Duplication or Replication
operations to the operations list of the SLP.
See “New or Change Storage Operation dialog box settings” on page 688.

The same criteria for creating copies applies to both methods.
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The following topics are considerations when storage lifecycle policies are used to
create multiple copies.

How the order of the operations determines the
copy order

The order in which the operations appear in a storage lifecycle policy determines
the copy number.

For example, in Figure 19-1 a lifecycle is configured to create three copies:

■ Two copies as part of two different backup operations.

■ One copy as part of a duplication operation.

To make sure that copy 1 is written to disk, place the Backup operation that writes
to a disk storage unit before the Backup operation that writes to a tape storage
unit.

Figure 19-1 Operation order determines copy order

Copy 1 on disk

Copy 2 on tape

Copy 3 on disk

About ensuring successful copies using lifecycles
The process to create copies as part of a storage lifecycle policy differs from the
process to create copies as set up in a policy. The policy’s Configure Multiple
Copies dialog box includes the option to Fail all copies. That option means that
if one copy fails, the remaining copies can be set to either continue or fail.

In an SLP, all copies must be completed. An SLP initially tries three times to create
a copy. If no copy is created, NetBackup continues to try, but less frequently.

The successful completion of copies is important because an SLP does not allow
a copy to be expired before all copy operations in the SLP are complete. NetBackup
changes the retention period of a copy to Infinity until all copies are created. After
all copies are complete, the retention returns to the level as set in the policy.

To create successful copies, a Backup operation may be required to duplicate a
backup onto the storage unit for another Backup operation.
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Consider the following example: The operations list for an SLP contains twoBackup
operations to two storage units (BU_1, BU_2) and three Duplication operations.

The backup to BU_1 is successful, but the backup to BU_2 is unsuccessful.

To fulfill the backup on BU_2, NetBackup creates a duplication job from BU_1 to
BU_2. The duplication job is in addition to the jobs that are run for the three
duplication operations.

Duplication jobs can be controlled by using the nbstlutil command.

See “Lifecycle operation administration using the nbstlutil command” on page 651.
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Storage lifecycle policy
versions

This chapter includes the following topics:

■ About storage lifecycle policy versions

■ Storage lifecycle changes and versioning

■ When changes to storage lifecycle policies become effective

■ Deleting old storage lifecycle policy versions

About storage lifecycle policy versions
Once a storage lifecycle policy is configured, it runs according to a single
configuration or definition. The definition affects the operations once they begin to
run as well as the copies once the image is in process.

The ability to create SLP versions lets administrators safely modify a definition
without waiting until all of the copies that are associated with the SLP have been
processed. Each copy that an SLP manages is tagged with the SLP name and the
SLP version number. These two attributes are written into the image header, in the
NetBackup image catalog. Whenever an administrator creates or changes an SLP,
NetBackup creates a new version (between 0 and n). New jobs use the most recent
SLP version.

When a new job is submitted to the Activity Monitor, the job is tagged with the most
recent SLP version number. The processing of a copy that is associated with a
version remains fixed according to that version of the SLP definition. It is fixed at
job time and does not change, unless the administrator uses the nbstl command
to modify an existing version.
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An SLP version remains as long as there are any incomplete images that refer to
the version.

Storage lifecycle changes and versioning
Administrators can make changes to a storage lifecycle policy in one of the following
ways:

■ Using the NetBackup Administration Console.
Any change that an administrator makes to an SLP using the NetBackup
Administration Console creates a new SLP version. The new version is created
when the changes to the SLP are committed or saved. The NetBackup
Administration Console always displays the most recent version.

■ Using the nbstl command.
If an administrator uses nbstl to change an SLP, nbstl creates a new version
by default.
However, the nbstl command contains options to view different versions and
to modify the definitions of existing SLP versions without creating a new version.
The options are as follows:

Use to display all versions of an SLP definition. Without
specifying this option, only the most recent version is
displayed by default.

-all_versions

Use to display a specific version.-version number

Use with most nbstl configuration options to make changes
to the current SLP version without creating a new version.
Knowing the current version number is not necessary if this
option is used.

-modify_current

Use with most nbstl configuration options to make changes
to a specific version without creating a new version.

-modify_version
-version number

Use -modify_current or -modify_version to change any of the following
configuration options:

The duplication priority.-dp

The storage unit to be used for each operation.-residence

The volume pool for each operation.-pool

The server group for each operation.-server_group
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The retention level for each operation.-rl

The alternate read server for each operation.-as

The preserve multiplexing option for duplication copies.-mpx

Some fields require values for all of the operations in the SLP. Make sure that the
number of values that are specified for the fields matches the existing operation
count.

For example, in an SLP that contains three operations, to change the value of one,
a value must be given for all three operations. Note that the values for all three
operations are replaced. To change the value for the second operation, provide the
existing values for the first and the third operations.

Some configuration options cannot be changed using -modify_current or
-modify_version. To change any of the following options, you must create an
entirely new SLP version:

The type of the operation.-uf

The retention type for the operation: Fixed, Capacity
managed, or Expire after copy.

-managed

The source of an operation, used primarily in hierarchical
SLP configurations.

-source

The data classification of an existing version.-dc

The number of operations. You cannot add an operation or
remove an operation from the SLP definitions.

See “Creating a storage lifecycle policy” on page 646.

You cannot instruct an SLP to follow the configuration of a previous version that
has been superseded. To revert to the behavior of a previous version, change the
definition to match the earlier definition. The change creates a version with the
same content as the previous version, but with a new version number.

When changes to storage lifecycle policies
become effective

For the changes to become effective for a backlog of jobs, it may be necessary to
cancel the applicable jobs.
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When the nbstl command is used to alter an existing storage lifecycle policy
version, those changes may not become effective immediately. The images that
are managed by the SLP version that was altered may already belong to a job that
is Active or Queued, as seen in the Activity Monitor. Once a job is queued, the
characteristics (SLP attributes) are fixed for that job and subsequent changes to
the definition have no effect. To make changes effective for a backlog of jobs, cancel
the duplication jobs. The storage lifecycle policy manager creates and submits new
duplication jobs for those images, using the changes to the configuration.

The following are conditions under which changes to an existing version are not
immediately effective:

■ Changes to a Backup operation have no effect because the backup job is
already underway or completed.

■ Changes to a Duplication operation do not affect the copies that previous
duplication jobs created.

■ Changes to a Duplication operation do not affect the copies that have already
been submitted and are currently represented by a duplication job in the Activity
Monitor, whether it be Active or Queued. If you want your changes to apply to
those active duplication jobs,cancel the applicable duplication jobs. Once the
job is canceled, nbstserv re-forms and re-submits new duplication jobs for
these copies, using the changes to the appropriate version of the SLP.

■ Changes to a Duplication operation affect the copies that have not yet been
created and have not yet been submitted. (That is, they are not yet represented
by a duplication job in the Activity Monitor). Your changes become effective for
the next duplication session. Whenever nbstserv begins a new session, it
re-reads the definitions for processing instructions.

■ If a duplication job does not complete successfully, unfinished images in the job
are submitted as part of a new job. Changes to the version affect the resubmitted
job.

Deleting old storage lifecycle policy versions
When a version of a storage lifecycle policy is no longer the active (or most recent)
version, the version is subject to deletion. NetBackup automatically deletes the
inactive version after all the copies that refer to it have finished processing. When
the copies are complete, they are considered SLP-complete.

By default, NetBackup deletes an inactive SLP version after 14 days.

The following parameters in the SLP Parameters host properties apply to version
deletion:

■ Cleanup interval (SLP.CLEANUP_SESSION_INTERVAL)
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■ Unused SLP definition version cleanup delay
(SLP.VERSION_CLEANUP_DELAY)

See “SLP Parameters properties” on page 230.
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Configuring backups

■ Chapter 21. Creating backup policies

■ Chapter 22. Synthetic backups

■ Chapter 23. Protecting the NetBackup catalog

■ Chapter 24. About the NetBackup relational database

■ Chapter 25. Managing backup images
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Creating backup policies
This chapter includes the following topics:

■ About the Policies utility

■ Planning for policies

■ Creating a backup policy

■ Adding or changing schedules in a policy

■ Changing multiple policies at one time

■ Warning about modifying or deleting automanaged policies or storage lifecycle
policies

■ Copying or moving policy items to another policy

■ Copying a policy to create a new policy

■ Copying a schedule into the same policy or different policy

■ Deleting schedules, backup selections, or clients from a policy

■ Policy Attributes tab

■ Schedules tab

■ Schedule Attributes tab

■ Start Window tab

■ Excluding days from a schedule

■ Include Dates tab

■ How NetBackup determines which schedule to run next

■ About schedule windows that span midnight
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■ How open schedules affect calendar-based and frequency-based schedules

■ About the Clients tab

■ Backup Selections tab

■ VMware Policy tab

■ Hyper-V Policies tab

■ Exclude Disks tab

■ Disaster Recovery tab

■ Creating a Vault policy

■ Creating a BigData policy

■ Performing manual backups

■ Active Directory granular backups and recovery

About the Policies utility
Backup policies provide the instructions that NetBackup follows to back up clients.
Use the Policies utility to provide the following instructions for a backup:

See “Policy Attributes tab” on page 726.What type of client to back up.

See “Policy Attributes tab” on page 726.Where to store the backup.

See “Schedules tab” on page 789.When and how frequently to perform the
backup.

See “About the Clients tab” on page 838.Which clients to back up.

See “Backup Selections tab” on page 841.Which client files and directories to back up.

Using the Policies utility
To navigate in the Policies utility

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 To display the policy details of a single
policy:

In the center pane, select a policy name.
The policy details display in the right pane.
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In the center pane, double-click on the
policy name. The Change Policy dialog
box opens.

To open a policy:

In the center pane, click on the tree
element next to the policy name to expand
the policy configuration areas:

■ Attributes
■ Schedules
■ Clients
■ Backup Selections

In the center pane, under a policy name,
select one of the configuration areas to see
a detailed view of that area.

To display specific configuration
information:

In the center pane, click Summary of All
Policies.

To display information about all policies on
the current master server:

Expand Summary of All Policies >
Clients to display all of the clients that are
in policies. Select multiple clients in the
right pane. While the clients are selected,
right-click and select Host Properties.

To simultaneously change the host
properties of multiple clients from
Summary of All Policies:

Planning for policies
Policy configuration is flexible enough to meet the various needs of all the clients
in a NetBackup environment. To take advantage of this flexibility, take time to plan
before starting to configure the policies in the Policies utility.

The following table outlines the steps to take to ensure that you get optimal results
from your policy configurations.
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Table 21-1 Steps for planning policies

DescriptionActionStep

Gather the following information about each client:

■ The client name.
■ The approximate number of files on each client to be backed up.
■ The typical file size of the files.

One client may be a file server that contains a large amount of data while
the other clients are workstations. To avoid long backup times, include the
file server in one policy and the workstations in another policy. It may be
beneficial to create more than one policy for the file server.

Gather client informationStep 1

Divide the clients into groups according to the different backup and archive
requirements.

The groups can be based on the type of work that the clients perform. Clients
that are used for similar tasks generally have similar backup requirements.
For example, most clients in an engineering department create the same
types of files at similar levels of importance. In some instances, create a
single policy for each group of clients. In other cases, subdivide the clients
and include them in the separate policies that are based on their backup
requirements.

A backup policy can apply to one or more clients. Every client must be in at
least one backup policy so that it can be backed up.

Group the clients based on
backup requirements

Step 2

The NetBackup environment may have some special storage requirements
that the backup policies must accommodate.

The storage unit and volume pool settings apply to all the files that are backed
up by a policy. If files have special storage requirements, create separate
policies for the files, even if other factors are the same, such as schedules.

If it is necessary to keep backups for some files on separate media, create
a policy that specifies a unique volume pool for those backups. Then, add
the media for that volume pool.

See “Windows example of one client in multiple policies” on page 713.

Consider the storage
requirements

Step 3
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Table 21-1 Steps for planning policies (continued)

DescriptionActionStep

Create additional backup policies if the schedules in one policy do not
accommodate all clients and files.

Consider the following factors when deciding to create additional policies:

■ Best times for backups to occur.
To back up different clients on different schedules may require additional
policies with different time schedules. For example, create different
policies for night-shift and day-shift clients.

■ How frequently the files change.
If some files change more frequently than others, the difference may be
enough to warrant creating another policy with a different backup
frequency.

■ How long backups need to be retained.
Each schedule includes a retention setting that determines how long
NetBackup keeps the files that are backed up by the schedule. Because
the schedule backs up all the files in the backup selection list, all files
should have similar retention requirements. Do not include the files whose
full backups must be retained forever, together in a policy where full
backups are retained for only four weeks.

Consider the backup
schedule

Step 4

Create separate policies for the clients that require similar policy attribute
settings.

See “Policy attributes that affect how clients are grouped in policies”
on page 714.

Group clients by common
attributes

Step 5

Create separate policies as necessary to maximize the benefits of multiplexed
backups.

To maximize drive use, multiplex the slower clients that produce small
backups. The higher-performance clients that produce long backups are
likely to use drives fully and not benefit from multiplexing.

See “Media multiplexing (schedule attribute)” on page 815.

Maximize multiplexed
backups

Step 6
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Table 21-1 Steps for planning policies (continued)

DescriptionActionStep

Evaluate total backup times for each schedule and further subdivide policies
to reduce backup times to an acceptable level.

For example, if the backup of /usr, /h001, and /h002/projects on UNIX
client1 takes too much time, create a new policy for /h002/projects.

In addition to reducing the backup time for each policy, separate policies
can reduce the total backup time for the server. NetBackup processes files
within a backup selection list in the order they appear in the backup selection
list. However, separate policies are processed in parallel if enough drives
are available and theMaximum jobs per client host property is set to allow
it.

See “Global Attributes properties” on page 136.

The Multiplexing and Allow multiple data streams policy attributes also
allow backup policies to be processed in parallel.

See “Allow multiple data streams (policy attribute)” on page 758.

Evaluate backup timesStep 7

See “About the Policies utility” on page 709.

See “Policy Attributes tab” on page 726.

Windows example of one client in multiple policies
The following table shows that the files in two different subdirectories on one client
can be stored in two different locations.

■ Policy1 sends backups of E:\h002\projects to 8mm storage.

■ Policy2 sends backups of E:\h002\DevExp and E:\h002\DesDoc to DLT storage.

Table 21-2 One client in multiple policies

StorageFilesClientPolicies

8mmC:\
D:\User
D:\h001
E:\h002\Projects

client1Policy1

DLTE:\h002\DevExp
E:\h002\DesDoc

client1

client1

Policy2
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Policy attributes that affect how clients are grouped in policies
The following table lists the attributes that may determine which clients are grouped
in the same policy.

Table 21-3 Policy attributes that affect how clients are grouped in policies

DescriptionAttribute

Each client must be in a policy of the correct policy type. For example, Windows clients must
be in a policy of a MS-Windows policy type.

See “Policy type (policy attribute)” on page 727.

Policy Type

All of the data that the policy generates is sent to the same destination that is indicated in
the policy. The data must share the same Data Classification, Policy storage, and Policy
volume pool.

See “Data classifications (policy attribute)” on page 731.

See “Policy storage (policy attribute)” on page 731.

See “Policy volume pool (policy attribute)” on page 734.

Destination

This attribute determines the priority for the backups of all of the clients in the policy.

See “Job priority (policy attribute)” on page 741.

Job Priority

Select this attribute if a UNIX client has NFSmounted files to be backed up. Consider placing
these clients in a separate policy so problems with NFS do not affect the other clients.

See “Follow NFS (policy attribute)” on page 743.

Follow NFS

This attribute lets NetBackup cross file system boundaries for all clients in the policy.

See “Cross mount points (policy attribute)” on page 746.

Cross mount points

This attribute lets NetBackup back up the files that all clients in the policy store on network
drives. (Applies only to the MS-Windows policy type.)

See “Backup Network Drives (policy attribute)” on page 744.

Backup Network
Drives

This attribute indicates that all clients in the policy are to compress their backups before they
send them to the server. Note that the time to compress can increase backup time and make
it unsuitable to use for all clients. Consider creating a different policy for those clients.

See “Compression (policy attribute)” on page 750.

Compression

About Microsoft DFSR backups
Microsoft Distributed File System Replication (DFSR) service is a multi-master
replication engine that is used to keep folders synchronized on multiple servers.
To do this, each of these independent DFSR servers maintains a database which
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is essential in providing this service but is independent of the DFSR data that is
being replicated. AlthoughNetBackup protects this database, as well as the DFSR
data, there are some things to consider when restoring both.

A DFSR server maintains information in its database that is used by other DFSR
servers to identify and validate replication changes that may be needed. One bit of
information is a globally unique version number (GVSN), which increases
monotonically with every replicated file or folder alteration. It can be thought of as
a version or generation number for each DFSR database on each replicated volume.

A problem occurs if a DFSR server is restored to an earlier database version. The
other servers, which monitor and remember each other’s numbers, will be confused
when presented with the older number. At this point replication is impossible and
will stop until this is corrected. Consider carefully if your restore actually needs to
include the DFSR database, in addition to the DFSR data. This is likely to happen
if you have a virtualized DFSR server and you restore it to a snapshot that had
been taken earlier. Please refer to the Microsoft documentation on managing and
using DFSR for additional details.

In an environment that has DFSR, two changes occur in NetBackup, as follows:

■ To preserve data integrity, the folder or folders that host the Shared Replica
DFSR data are excluded automatically by NetBackup from normal file system
backups.

■ The top-level DFSR shared folders become part of the Shadow Copy
Components. Therefore, the data is snapped consistently by Windows Volume
Shadow Copy Service (VSS) before each backup.

Microsoft supports only the VSS writer for DFSRmanaged data backups. The VSS
writer stops and restarts the DFS Replication service automatically. Veritas
recommends that you schedule the backups to coincide with a period of low activity.
(If you stop the replication service manually, Microsoft change journal problems
may occur. Specifically, Update Sequence Number (USN) Journal wrap may occur.)

Veritas recommends that you back up DFSR data based on the amount of data
under DFSR control as described in Table 21-4.
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Table 21-4 Microsoft DFSR backup recommendations

Veritas recommendationAmount of data

Configure one policy as follows:

■ Choose the DFSR server host as the client.
See “Adding, changing, or deleting clients in a policy” on page 838.

■ Choose ALL_LOCAL_DRIVES as the Directive in the Backup Selections for the policy.
TheALL_LOCAL_DRIVES directive includes theShadowCopyComponents:\ automatically.
See “Adding backup selections to a policy” on page 843.

One policy can back up the data within a reasonable time window.

Less than 50 GBs

716Creating backup policies
Planning for policies



Table 21-4 Microsoft DFSR backup recommendations (continued)

Veritas recommendationAmount of data

Configure one backup policy for each DFSR server, and in that policy specify only the replication
folders. A policy for each host's replication data ensures that the DFSR data is backed up within
a reasonable time window.

For each DFSR server host, do the following:

■ Create a global exclude list for All Policies and All Schedules. Exclude the following DFSR
top-level folder:
Shadow Copy Components:\User Data\Distributed File System
Replication\DfsrReplicatedFolder

The global exclude list ensures that the DFSR components are not backed up accidentally
by other backup policies for the client.
See “Exclude Lists properties” on page 113.

■ Create a backup policy for the DFSR data, as follows:
■ For the client, specify the DFSR server host. For the servers that are hosted in a cluster,

specify the DFSR cluster name rather than the local host name.
See “Adding, changing, or deleting clients in a policy” on page 838.

■ For theBackup Selections for the policy, specify the absolute path to each of the top-level
DFSR folders on that host. The following is an example path:
Shadow Copy Components:\User Data\Distributed File System
Replication\DfsrReplicatedFolders\folder_name

Tip: Use the Backup, Archive, and Restore interface to browse the Shadow Copy
Components for the DfsrReplicatedFolders folder. The interface shows the path to
each DFSR folder that you need to enter as a backup selection.
See “Adding backup selections to a policy” on page 843.

■ For the backup policy, create an exception to the exclude list and specify the top-level DFSR
directory, as follows:
Shadow Copy Components:\User Data\Distributed File System
Replication\DfsrReplicatedFolders

For the exception Policy, specify the backup policy for the DFSR data. Also specify All
Schedules for the Schedule.
If DFSR is hosted in a cluster, create the exception for each host in the cluster.
The exception ensures that the Shadow Copy Components DFSR paths are included for
backup after NetBackup processes the global exclude list.
See “Adding an exception to the exclude list” on page 118.

More than 50 GBs

The DFSR servers must be configured forWindows Open File Backup. The
snapshot provider must be Volume Shadow Copy Service. Configure these
properties in theNetBackupAdministrationConsolemaster server host properties
Client Attributes tab.

See “Windows Open File Backup tab of the Client Attributes properties” on page 78.
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During a backup, Windows writes the following event ID messages to the application
event log of a DFSR host:

Event ID=1102

Severity=Informational

The DFS Replication service has temporarily stopped replication

because another application is performing a backup or restore

operation. Replication will resume after the backup or restore

operation has finished.

Event ID=1104

Severity=Informational

The DFS Replication service successfully restarted replication

after a backup or restore operation.

To restore DFSR data, use the NetBackup Backup, Archive and Restore client
interface to browse the Shadow Copy Components for the files or folders to restore,
as follows:

Shadow Copy Components:\User Data\Distributed File System

Replication\DfsrReplicatedFolders\folder_name

The following Veritas article provides a more detailed procedure about configuring
DFSR backups:

http://www.veritas.com/docs/HOWTO65638

Creating a backup policy
The easiest method to set up a backup policy is to use the Policy Configuration
Wizard. This wizard guides you through the setup process by automatically choosing
the best values for most configurations.

Not all policy configuration options are presented through the wizard. For example,
calendar-based scheduling and the Data Classification setting. After the policy is
created, modify the policy in the Policies utility to configure the options that are not
part of the wizard.

Note:Do not use the Policy ConfigurationWizard to configure policies for Replication
Director.

Using the Policy Configuration Wizard to create a backup
policy
Use the following procedure to create a backup policy with the Policy Configuration
Wizard.
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To create a backup policy with the Policy Configuration Wizard

1 In theNetBackup Administration Console, in the left pane, clickNetBackup
Management.

2 In the right pane, click Create a Policy to begin the Policy Configuration
Wizard.

3 Select the type of policy that you want to create:

■ A policy to back up File systems, databases, or applications.

■ A policy to protect VMware or Hyper-V virtual machines.

■ A policy to back up NDMP hosts.

■ A policy to back up Oracle data.

4 Click Next to start the wizard and follow the prompts.

Click Help on any wizard panel for assistance while running the wizard.

Creating a backup policy without using the Policy
Configuration Wizard
Use the following procedure to create a backup policy in the NetBackup
Administration Console without using the Policy Configuration Wizard.

To create a policy without the Policy Configuration Wizard

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On the Actions menu, click New > Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box.

See “NetBackup naming conventions” on page 1163.

4 If necessary, clear the Use Policy Configuration Wizard check box.

5 Click OK.

6 Configure the attributes, the schedules, the clients, and the backup selections
for the new policy.

See “Policy Attributes tab” on page 726.

See “Schedules tab” on page 789.

See “About the Clients tab” on page 838.

See “Backup Selections tab” on page 841.
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Adding or changing schedules in a policy
Change policies only when no backup activity is expected for the affected policies
and clients. Make adjustments before backups begin to ensure an orderly transition
from one configuration to another.

Changing a policy causes NetBackup to recalculate when the policy is due.

Note: Veritas recommends that users do not modify automanaged policies. If a
user begins to modify an automanaged policy, a dialog appears that warns users
about the possible consequences.

See “Warning about modifying or deleting automanaged policies or storage lifecycle
policies” on page 723.

Use the following procedure to add or change schedules in an existing NetBackup
policy.

To add or change schedules in a policy

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Expand the policy name in the middle pane, then select Schedules.

3 Perform one of the following actions:

On the Actions menu, click New > Schedule.Add a schedule

■ Expand the policy which contains a schedule that
you'd like to copy.

■ In the right pane, right-click the schedule and select
Copy.

■ Expand the policy where you'd like to paste the
schedule.

■ In the right pane, right-click anywhere in the schedule
area and select Paste.

You can also copy a schedule with the Edit > Copy to
New option:

See “Copying a schedule into the same policy or
different policy” on page 725.

Copy a schedule and paste it
into another policy

In the right pane, double-click the schedule name.Change an existing schedule
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4 Complete the entries in the Attributes tab, Start Window tab, Exclude Days
tab, and Include Dates tab (when applicable).

See “Schedule Attributes tab” on page 790.

See “Start Window tab” on page 822.

See “Excluding days from a schedule” on page 826.

See “Include Dates tab” on page 827.

5 Click OK.

6 To add more schedules, click Add or New and repeat step 4.

If this schedule is the last schedule, click OK or Close.

Changing multiple policies at one time
Use the following procedure to change more than one NetBackup policy at the
same time.

Note: Veritas recommends that users do not modify automanaged policies. If a
user begins to modify an automanaged policy, a dialog appears that warns users
about the possible consequences.

See “Warning about modifying or deleting automanaged policies or storage lifecycle
policies” on page 723.

Note: You can change Attributes, Clients, and Schedules of multiple policies at
one time. However, you cannot change Backup Selections of multiple policies at
one time.

To change multiple policies

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management and select Policies.

2 In the middle pane, expand Summary of All Policies and select the node that
you want to change.
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3 In the right pane, either hold down the Shift key and select contiguous rows,
or hold down the Ctrl key and select separate rows for multiple selection.

Note: You can change different schedules across different policies at one time.
If you are changing multiple schedules of different policy types, the Attributes
tab is disabled. A tri-state is displayed for an attribute that has different values
for multiple policies you selected.

4 On the Edit menu, click Change.

In the dialog box that appears, the settings display in one of the following states:

The setting has the same value for all selected policies, schedules, or
clients.

A value

The attribute does not have the same value for all selected policies,
schedules, or clients.

No value

The attribute is active for all the selected policies, schedules, or clients.Checked

The attribute is inactive on all the selected policies, schedules, or clients.Unchecked

The attribute is set differently on all the selected policies, schedules,
or clients.

Gray checked

5 Specify a value, enable or disable an attribute, or enter text for the attributes
you want to change. Any change that you make is applied to the field for every
selected policy.

Check the box.To enable an attribute for all
selected policies

Uncheck the box.To disable an attribute for all
selected policies

Set (or leave) the box to a gray check.To leave an attribute
unchanged for all selected
policies

See “Policy Attributes tab” on page 726.

See “Schedule Attributes tab” on page 790.

See “About the Clients tab” on page 838.

6 Click Cancel to cancel changes, or click OK to apply all changes and close
the dialog box.
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Warning about modifying or deleting
automanaged policies or storage lifecycle policies

Veritas recommends that users do not modify or delete automanaged policies or
storage lifecycle policies using the NetBackup Administration Console or the
command line. If a user begins to modify or delete an automanaged policy or SLP
using theNetBackup Administration Console, a dialog appears that warns users
about the possible consequences.

Automanaged policies and SLPs are generated when a workload administrator
protects an asset by subscribing to a protection plan. Automanaged policy and SLP
names use the prefix SLO_ENGINE_MANAGED+.

■ If the user continues to make modifications, they must make sure that the policy
or SLP continues to meet the service level objective that is defined by the
protection plan.

■ If the user continues to delete the policy or SLP, they must make sure that the
asset is added to another protection plan that meets the service level objective.

Copying or moving policy items to another policy
You can copy or move entire policies, attributes, schedules, clients, and backup
selections from one policy to another. The following procedure describes which
policy items can be copied or moved.

To copy or move items from one policy to another

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 In themiddle pane, select either theAttributes,Schedules,Clients, orBackup
Selections for a policy that you want to copy or move.

3 In the right pane, based on your selection in the previous step, select the
attributes, schedules, clients, or backup selections of a policy that you want to
copy or move.

4 Do one of the following:

On the Edit menu, click Copy.To copy an item

■ On the Edit menu, click Cut.
■ Click Yes when asked if you want to delete the

selected item from the policy.

To move an item
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5 In the middle pane, select the policy item to which you want to paste the copied
items.

6 From the Edit menu, click Paste.

When you paste items with the same name, NetBackup provides options: To
either copy and replace the existing item, or copy but keep the existing item,
or to not copy.

Note: If the schedules do not match the policy type, the schedules are not
copied. The action is indicated in a dialog box.

When you paste attributes, the existing attributes of the policy are always
replaced. Whereas, when you paste backup selections, the backup selection
is always copied to the policy, and not replaced.

The copying or moving feature is also applicable to instances and instance
groups of Oracle and SQL type of backup policies.

Copying a policy to create a new policy
Use theCopy to New option to save time creating policies. This option is especially
useful for the policies that contain many of the same policy attributes, schedules,
clients, or backup selections.

To copy a policy to create a new one

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 In the middle pane, select the policy to copy.

3 On the Edit menu, click Copy to New

4 In the Copy a Policy dialog box, enter the name of the policy that you want to
copy. You can indicate a policy other than the one that is selected

5 Enter the name for the new policy.

6 Click OK. The only difference between the new policy and the copied policy is
the name.
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Copying a schedule into the same policy or
different policy

Use the Copy to New option to save time creating schedules. Use this option to
copy a schedule into the same policy or different policy.

To copy a schedule to create a new one

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 In the middle pane, expand a policy and select the Schedules node that
contains the schedule that you want to copy.

3 In the right pane, select the schedule that you want to copy.

4 On the Edit menu, click Copy to New

5 In the Copy Schedule dialog box, enter the name of the new schedule.

6 Use the menu to select the name of the policy to which you want to paste the
schedule. You can paste the schedule into the same policy or a different policy.

7 Click OK. The Change Schedule dialog box opens for the new schedule.

Deleting schedules, backup selections, or clients
from a policy

Use the following procedure to delete schedules, backup selections, or clients from
a NetBackup policy.

Note: Veritas recommends that users do not modify or delete automanaged policies.
If a user begins to modify or delete an automanaged policy, a dialog appears that
warns users about the possible consequences.

See “Warning about modifying or deleting automanaged policies or storage lifecycle
policies” on page 723.

To delete a schedule, backup selections, or clients from a policy

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Expand the policy name in the middle pane, and then select Attributes,
Schedules, Backup Selections, or Clients.

3 In the right pane, select the item you want to delete.
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4 On the Edit menu, click Delete.

5 Click Yes when asked if you want to delete the selected item from the policy.

When a client is deleted from the client list, the NetBackup client software is not
deleted or uninstalled from the client. Backups for the client can be recovered until
the backups expire. Also, when a file is deleted from a backup selection list, the
actual file is not deleted from the client.

Policy Attributes tab
Use the policy Attributes tab to configure backup settings when you add a new
policy or change an existing policy. When you create a policy, you give the policy
a name and select a policy type. The policy type you select typically depends on
the type of client you want to back up. The number of policy types available varies
depending on which NetBackup options are installed. Each policy type has a unique
combination of attributes. Not all attributes apply to every policy type. When you
select a policy type, the attributes that apply to that policy type are active. The
unavailable attributes are grayed out.

Figure 21-1 shows the Attributes tab of a NetBackup policy.
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Figure 21-1 Policy Attributes tab

The following topics describe the settings on the policy Attributes tab.

Policy type (policy attribute)
The Policy type attribute determines the purpose of the policy. Select a policy type
from the list. The policy type you select typically depends on the type of client to
be backed up. Some policy types are not used for client backups. For example,
NBU-Catalog is not used for client backups.

The list of policy types changes depending on the NetBackup options that have
been installed. Each policy type offers a unique combination of attributes. When
you select a policy type, only the attributes that apply to that policy type are active.

You can change the policy type of an existing policy. However, the schedules for
the policy may become invalid. If the schedules become invalid, NetBackup displays
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a warningmessage and then deletes the invalid schedules or changes the schedules
to an equivalent type.

When you change the policy type of an existing policy, other selections or features
of the policy may become invalid as well.

Table 21-5 describes all the types of NetBackup policies.

Table 21-5 NetBackup policy types

DescriptionPolicy type

Use as a policy type to schedule and run a job for big data applications. For example,
Hadoop Distributed File System (HDFS) or Nutanix Acropolis Hypervisor. This policy
type requires the Enterprise Client license.

See “Creating a BigData policy” on page 894.

For information about the plug-ins that NetBackup supports, and which are available
to download and install, see:

https://www.veritas.com/support/en_US/article.000127427

BigData

Use for the policies that contain only clients with the NetBackup for SQL-BackTrack
agent. For information on setting up this policy type, see the guide for this option.

DataTools-SQL-BackTrack

(UNIX only)

This policy type is reserved for use by Veritas or its partners to provide agents for new
applications or databases.

DataStore

Use for the policies that contain only clients with the NetBackup for DB2 agent. For
information on setting up this policy type, see the guide for this option.

DB2

Use as a policy type to schedule and run an Enterprise Vault job.Enterprise-Vault

Combines the speed of raw-partition backups with the ability to restore individual files.

This policy type applies to UNIX clients only. Requires the Enterprise Client license.

For information on setting up this type of policy, see the NetBackup Snapshot Client
Administrator's Guide.

FlashBackup

(UNIX only)

Combines the speed of raw-partition backups with the ability to restore individual files.
This policy type applies to Windows clients only. Requires the Enterprise Client license.

For information on setting up this type of policy, see the NetBackup Snapshot Client
Administrator's Guide.

FlashBackup-Windows

(Windows only)
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Table 21-5 NetBackup policy types (continued)

DescriptionPolicy type

To back up the virtual machines that reside on Windows Hyper-V servers, by means
of on-host or off-host backups. This policy type requires the Enterprise Client license.

Users can upgrade pertinent policies to the Hyper-Vpolicy type using one of the
following methods:

■ Change the policy type in the NetBackup Administration Console for one policy
at a time.

■ Change the policy type for multiple policies at one time using the bpplconvert
script that is located in the following location:
On Windows: install_path\NetBackup\bin\goodies
On UNIX: usr/openv/netbackup/bin/goodies

For information on setting up this type of policy, see the NetBackup for Hyper-V Guide.

Hyper-V

Use for the policies that contain only clients with the NetBackup for Informix agent. For
information on setting up this policy type, see the guide for this option.

Informix-On-BAR

(UNIX only)

Use for the policies that contain only clients with the NetBackup for Lotus Notes agent.
For information on setting up this policy type, see the guide for this option.

Lotus-Notes

Use for the policies that contain only clients with the NetBackup for Exchange Server
agent. For information on setting up this policy type, see the guide for this option.

This policy type applies to Windows clients only.

MS-Exchange-Server

(Windows only)

Use to configure a policy NetBackup for SharePoint Server.

This policy type applies to Windows clients only.

MS-SharePoint

(Windows only)

Use for the policies that contain only clients with the NetBackup for SQL Server agent.
For information on setting up this policy type, see the guide for this option.

MS-SQL-Server

Use for the policies that contain only Windows clients of supported Windows operating
system levels.

Standard and MS-Windows policy types are the only policy types that support the
following options:

■ Checkpoint restart for backups or restores
See “Take checkpoints every __ minutes (policy attribute)” on page 736.

■ Synthetic backups
See “Policy type (policy attribute)” on page 727.

■ Collect disaster recovery information for Bare Metal Restore
See “Collect disaster recovery information for Bare Metal Restore (policy attribute)”
on page 753.

MS-Windows
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Table 21-5 NetBackup policy types (continued)

DescriptionPolicy type

Use for catalog backup jobs.NBU-Catalog

Use for the policies that contain only clients with the NetBackup NDMP option. This
policy type is available only when the NetBackup NDMP is installed and licensed. For
information on setting up this policy type, see the guide for this option.

NDMP

Use for the policies that contain only clients with the NetBackup for Oracle agent. For
information on setting up this policy type, see the guide for this option.

Oracle

Use for the policies that contain only clients with the NetBackup SAP Agent. For
information on setting up this policy type, see the guide for this option.

SAP

Use for UNIX clients (including supported Mac clients), except for those clients that
are covered by specific products, such as Oracle.

Standard and MS-Windows policy types are the only policy types that support the
following options:

■ Checkpoint restart for backups or restores
■ Synthetic backups
■ Collect disaster recovery information for Bare Metal Restore

Standard

Use for the policies that contain only clients with the NetBackup for Sybase agent. For
information on setting up this policy type, see the guide for this option.

Sybase

Use as a policy type to schedule and run a Vault job. This policy type is available only
when Vault is licensed.

Vault

For backup of any virtual machines that reside on VMware vSphere servers, by means
of off-host backups. This policy type requires the Enterprise Client license.

Users can upgrade pertinent policies to the VMware policy type using one of the
following methods:

■ Change the policy type in the NetBackup Administration Console for one policy
at a time.

■ Change the policy type for multiple policies at one time using the bpplconvert
script that is located in the following location:
On Windows: install_path\NetBackup\bin\goodies
On UNIX: usr/openv/netbackup/bin/goodies

For information on setting up this type of policy, see the NetBackup for VMware Guide.

VMware

For more details on off-host backups, refer to the NetBackup Snapshot Client
Administrator’s Guide.
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For information about off-host backups, see the NetBackup Snapshot Client
Administrator's Guide.

Data classifications (policy attribute)
The Data Classification attribute specifies the classification of the storage lifecycle
policy that stores the backup. For example, a backup with a gold classification must
go to a storage unit with a gold data classification. By default, NetBackup provides
four data classifications: platinum, gold, silver, and bronze.

This attribute is optional and applies only when the backup is to be written to a
storage lifecycle policy. If the list displays No data classification, the policy uses
the storage selection that is displayed in the Policy storage list. If a data
classification is selected, all the images that the policy creates are tagged with the
classification ID.

See “Storage Lifecycle Policy dialog box settings” on page 684.

See “Data Classification properties” on page 97.

See “Creating a Data Classification” on page 99.

See “About storage lifecycle policies” on page 645.

Policy storage (policy attribute)
The Policy storage attribute specifies the storage destination for the policy’s data.
Select a specific storage unit, storage lifecycle policy, or storage unit group from
the list.

When NetBackup looks for an available storage unit, it selects the first storage unit
that meets the following requirements:

■ The storage unit must not be designated as On demand only.

■ The storage unit must have available drives.

■ The storage unit must have media available in the required volume pool.

However, NetBackup makes an exception when a client is also a media server with
locally-attached storage units. In that case, NetBackup selects the locally-attached
storage units first.

See “About staging backups” on page 620.
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Select the name of the storage unit that is to be the storage
destination for the policy data. It can be disk or tape-based.

If it is configured to do so, the storage unit determines which
type of disk staging is used for the policy.

See “Creating a storage unit” on page 590.

Storage unit

Select the name of the storage lifecycle policy that is to be
the storage destination for the policy data.

The drop-down list includes only those lifecycles that have
the same data classification as the policy. For example, gold
backup images cannot be sent to a silver storage lifecycle.
Images that belong to a specific data classification cannot
be sent to a storage lifecycle that lacks a classification. Data
classification is optional.

See “Global Attributes properties” on page 136.

If it is configured to do so, the storage lifecycle policy
determines which type of disk staging is used for the policy.

If setting up snapshot replication with Replication Director,
select a storage lifecycle policy that contains a
snapshot-capable storage unit.

See “About storage lifecycle policies” on page 645.

Storage lifecycle policy

Select the name of the storage unit group that is to be the
storage destination for the policy data.

See “About storage unit groups” on page 634.

Storage unit group

If Any Available is selected, NetBackup tries to store data
on locally-attached storage units first. To force NetBackup
to use only a locally-attached drive, select Must use local
drive in the General Server properties. If a local device is
not found orMust use local drive is not selected, NetBackup
tries to find an available storage unit alphabetically.

NetBackup does not select a null_stu storage unit if Any
Available is selected. A null_stu storage unit is created
only when Veritas Support uses the NullOST plug-in to
identify and isolate data transfer bottlenecks.

Any Available
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Figure 21-2 Icons indicate type of storage

Storage unit (tape device)

Storage unit (disk)

Storage unit group

Storage lifecycle policy

Note: If different storage is selected for the Override policy storage option on the
Schedule Attributes tab, that selection overrides the Policy storage attribute.

See “Override policy storage (schedule attribute)” on page 810.

See “Considerations for selecting a destination for Policy storage” on page 733.

Considerations for selecting a destination for Policy
storage
Consider the following scenarios before selecting a destination from the Policy
storage list on the policy Attributes tab.

Table 21-6

ActionScenario

Do one of the following:

■ Specify Any Available for the Policy storage attribute.
■ Do not specify a storage unit at the schedule level.

See “Override policy storage (schedule attribute)” on page 810.
■ Do not set all storage units toOn demand only. NetBackup may not find

an available storage unit for the backups.
See “Changing storage unit settings” on page 593.
See “On demand only storage unit setting” on page 613.

The site contains one storage unit, or
there is no storage unit preference.

Consider changing the destination to Any Available since backups cannot
run for those policies and the schedules that require the unit.

A specific storage unit is designated but
the unit is unavailable.

Be aware that any basic disk storage unit that is not assigned to a storage
group is considered available for disk spanning.

See “Media properties” on page 163.

Any Available is selected.
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Table 21-6 (continued)

ActionScenario

Do one of the following:

■ Select a storage unit group that contains only the units you want the
policy to use.

■ Limit the storage units by doing the following:
■ Create a volume pool that contains the volumes that are available

only to the specific storage units. Disable Scratch pool for the volume
pool. If Scratch pool is enabled, any storage unit has access to the
volumes in the volume pool.
See “Adding or deleting a volume pool” on page 549.
See “About scratch volume pools” on page 485.

■ In the policy, set Policy volume pool to the volume pool that is
defined in the previous step.

■ For all policies, set Policy storage attribute to Any Available.
■ If the policy specifies a storage unit group, set the storage units within

the group to On demand only to satisfy the policy requirement.
See “Changing storage unit settings” on page 593.
See “On demand only storage unit setting” on page 613.

You want to limit the storage units
available to a policy.

Policy volume pool (policy attribute)
The Policy volume pool attribute specifies the default volume pool where the
backups for the policy are stored. A volume pool is a set of media that is grouped
for use by a single application. The volume pool is protected from access by other
applications and users.

The available volume pools appear on the list. Whenever a new volume is required,
it is allocated from the volume pool indicated.

If you select a volume pool on the Schedule tab, that selection overrides the Policy
volume pool selection on the Attributes tab.

See “Override policy storage (schedule attribute)” on page 810.

See “Example of overriding the policy volume pool” on page 735.

The following table describes the default volume pools that NetBackup defines.

Table 21-7 Default volume pools defined by NetBackup

DescriptionVolume pool

The default pool for applications, other than NetBackup.None
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Table 21-7 Default volume pools defined by NetBackup (continued)

DescriptionVolume pool

The default pool for DataStore.DataStore

Unless otherwise specified in the policy, all backups use
media from the NetBackup pool. One exception is the
NBU-Catalog policy type.

NetBackup

This pool is selected by default for the NBU-Catalog policy
type. It is used exclusively for catalog backups. Catalogs are
directed to a single, dedicated pool to facilitate faster catalog
restores.

CatalogBackup

The following table describes the additional volume pools that are useful to create.

Table 21-8 Additional volume pools

DescriptionVolume pool

Allows NetBackup to automatically transfer volumes when
another volume pool does not have media available.

Scratch volume pool

Used by automatic backups.Auto volume pool

Used by user backups.User volume pool

Media is assigned to the volume pools for Media Manager storage devices. Disk-type
storage devices are not allocated to a volume pool.

See “About NetBackup volume pools” on page 483.

See “Adding or deleting a volume pool” on page 549.

See “About scratch volume pools” on page 485.

Example of overriding the policy volume pool
The following example shows how to override the policy volume pool from the policy
Schedule tab. In this example, we change a policy named Backup-Archive. Until
now, all schedules in the policy have used the Backups volume pool. Change the
policy so that the user-archive schedule uses the Archive pool instead.
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To override the Policy volume pool attribute

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies

2 In the left pane, select the Backup-Archive policy and on the Edit menu, click
Change.

3 In the policy Attributes tab, on the Policy volume pool list, select Backups.

4 Click the Schedules tab.

5 Select the schedules that use the Backups volume pool, and click Properties.

6 Make sure that Override policy volume pool is unchecked, and click OK to
save the change in the schedule.

7 Select the user-archive schedule that you want assigned to the Archive volume
pool, and click Properties.

8 Check Override policy volume pool.

9 Underneath the check box, select Archive from the list.

10 Click OK to save the change in the schedule.

11 Click OK to save the change in the policy.

Take checkpoints every __ minutes (policy attribute)
By taking checkpoints during a backup, you can save time if the backup fails. By
taking checkpoints periodically during the backup, NetBackup can retry a failed
backup from the beginning of the last checkpoint. This is often quicker rather than
restarting the entire job.

The checkpoint frequency indicates how often NetBackup takes a checkpoint during
a backup. The default is 15 minutes. The administrator determines checkpoint
frequency on a policy-by-policy basis. When you select the checkpoint frequency,
balance the loss of performance due to frequent checkpoints with the possible time
lost when failed backups restart. If the frequency of checkpoints affects performance,
increase the time between checkpoints.

Checkpoints are saved at file boundaries and point to the next file in the list.
Checkpoint restart is only available for theMS-Windows or Standard policy types.
Check Take checkpoints every __ minutes to enable checkpoint restart. When
the box is checked, NetBackup takes checkpoints during a backup job at the
frequency you specify. If the box is not checked, no checkpoints are taken and a
failed backup restarts from the beginning of the job. Checkpoint restart can also be
used for restore jobs.

See “Checkpoint restart for restore jobs” on page 738.
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TheGlobal Attributes property, Schedule backup attempts, indicates the number
of times that NetBackup tries to restart a failed backup.

See “Global Attributes properties” on page 136.

Note: Checkpoints are saved at file boundaries and point to the next file in the list
to be backed up. Checkpoints cannot occur in the middle of a file. After the file is
backed up, the checkpoint is saved.

Note:Checkpoints are not taken for a user-archive backup. If a user-archive backup
resumes, it restarts from the beginning.

In the following situations, NetBackup starts a new job instead of resuming an
incomplete job:

■ If a new job is due to run, or, for calendar-based scheduling, another run day
has arrived.

■ If the time since the last incomplete backup was longer than the shortest
frequency in any schedule for the policy.

■ If the time indicated by the Clean-up property, Move backup job from
incomplete state to done state, has passed.

The following table describes the level of support for various policy attributes,
storage, and clients for checkpoint restart. For an agent or option not listed, refer
to the manual for that agent or option.

Table 21-9 Support for checkpoint restart

DescriptionItem

Checkpoint restart is supported for Stage I. Checkpoint restart is not supported for
Stage II.

See “About basic disk staging” on page 621.

See “About staging backups” on page 620.

Basic disk staging
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Table 21-9 Support for checkpoint restart (continued)

DescriptionItem

The following pertain to Windows clients:

■ Checkpoint restart is not supported for the backup selections that are indicated by
a UNC path.

■ No checkpoints are taken during a system state backup.
■ No checkpoints are taken during a Windows disk image (raw) backup.
■ No checkpoints are taken for the remainder of the backup after NetBackup

encounters Single-instance Store (SIS).

When an incremental backup resumes and completes successfully, the archive bits
are cleared for the files that were backed up after the job resumes. However, the archive
bits are not cleared for the files that were backed up before the resume. Since the
archive bits remain, the files that were backed up before the backup resumes are
backed up again during the next incremental backup.

MS-Windows (policy type)

Checkpoint restart is supported for the policies that are configured to create multiple
backup copies.

See “Multiple copies (schedule attribute)” on page 806.

The last failed copy that contains a checkpoint can be resumed if a copy is configured
to allow other copies to continue the job if the copy fails and subsequent checkpoints
occur.

Multiple copies (schedule
attribute)

Checkpoint restart is supported for use with local or alternate client backups. However,
the following policy attributes are not supported:

■ Block Level incremental backups
■ Media server Copy
■ Third-Party Copy Device
■ Instant Recovery backup

See “Snapshot Client and Replication Director (policy attributes)” on page 787.

Snapshot Client (policy
attribute)

Checkpoint restart is supported for UNIX clients.Standard (policy type)

Checkpoint restart is not supported.

See “Synthetic backup (schedule attribute)” on page 800.

Synthetic backups
(schedule attribute)

Checkpoint restart for restore jobs
Checkpoint restart for restore jobs saves time by letting NetBackup resume a failed
restore job. The job resumes automatically from the start of the file that was last
checkpointed rather than starting from the beginning of the entire restore job.
NetBackup automatically takes checkpoints once every minute during a restore
job.

738Creating backup policies
Policy Attributes tab



The following host properties affect checkpoint restart for restore jobs.

This Clean-up host property indicates the
number of days that a failed restore job can
remain in an Incomplete state.

See “Clean-up properties” on page 66.

Move restore job from incomplete state to
done state

This Universal Setting host property
specifies the number of attempts that a client
has to restore after a failure.

See “Universal Settings properties”
on page 241.

Restore retries

Checkpoint restart for restore jobs has the following limitations:

■ The restore restarts at the beginning of the last checkpointed file, not within the
file.

■ Only the backups that are created usingMS-Windows or Standard policy types
are supported.

■ Third Party Copy and the Media Server Copy images that use Standard policy
types are supported. However, they cannot be suspended or resumed if the
backup image has changed blocks.

A NetBackup administrator can choose to suspend a checkpointed restore job and
resume the job at a later time. For example, while an administrator runs a restore
job for several hours, the administrator receives a request for a second restore.
The request is of a higher priority and requires the resources in use by the first job.
The administrator can suspend the first job, start the second restore job and let it
complete. The administrator can then resume the first job from the Activity Monitor
and let the job complete.

Consider a situation in which a checkpointed restore that has no end date is
suspended and then resumed. If a new backup occurs before the resume is initiated,
the files from the new backup are included in the restore. For example, a user
request the restore of a directory. The restore begins, but is suspended. The request
is resumed the next day after another backup of the directory is performed. The
files that are restored are from the latest backup.

See “Take checkpoints every __ minutes (policy attribute)” on page 736.

Limit jobs per policy (policy attribute)
The Limit jobs per policy attribute limits the number of jobs that NetBackup
performs concurrently when the policy is run. By default, the box is unchecked, and
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NetBackup performs an unlimited number of backup jobs concurrently. Other
resource settings can limit the number of jobs.

A configuration can contain enough devices so that the number of concurrent
backups affects performance. To specify a lower limit, check the box and specify
a value from 1 to 999.

Figure 21-3 Limit jobs per policy attribute

Client B

Server Tape Drive 1

Client A and Client B backups can occur concurrently and back up to different devices

Tape Drive 2

Client A

This attribute operates differently for VMware policies, depending on how the policy
selects virtual machines.

For more information, see the NetBackup for VMware Administrator's Guide.

Table 21-10 describes the factors that affect the number of concurrent backup jobs
that NetBackup can perform.

Table 21-10 Factors affecting the number of concurrent backup jobs

DescriptionItem

The limit does not apply to concurrent jobs if the jobs are from different policies.

For example, if three policies limit concurrent jobs to two, NetBackup can start two jobs
from each policy. A total of six policies can be running at one time in this situation.

Jobs from different policies

If multiplexing is used, set the limit high enough to support the specified level of
multiplexing.

Lower values can limit multiplexing within a policy if jobs from different schedules exist
within the policy. For example, the limit is set to two and an incremental backup schedule
is due to run for four clients. Only two clients are backed up at one time, regardless of
the multiplexing settings.

Multiplexing
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Table 21-10 Factors affecting the number of concurrent backup jobs
(continued)

DescriptionItem

The available bandwidth of the network determines how many backups can occur
concurrently. If you encounter loading problems, consider multiple networks for backups.
Or, configure the backup policy to use the Compression attribute.

See “Compression (policy attribute)” on page 750.

When the client that is backed up is also a server, it is a special case. In this instance,
the network load is not a factor because the network is not used. However, the load
on the client and server is still a factor.

Network load

To process more than one backup job at a time, the configuration must include one of
the following:

■ Multiple storage units.
■ A storage unit with enough drives to perform more than one backup at a time.
■ Storage units that are configured to multiplex.

With removable media devices such as tape drives, the number of concurrent jobs
depends on the total number of drives in the storage units. With disk storage, the
storage device is defined as a file path and the available disk space determines how
many paths are possible.

Number of storage devices
available and multiplexing
limits

Parent jobs do not count toward the limit. Only the children jobs count toward the limit.

The following are examples of the jobs that produce a parent job and children jobs:

■ Multistreamed jobs
■ Catalog backups
■ Snapshot Client snapshots
■ Bare Metal Restore jobs

See “About the Jobs tab” on page 1100.

This attribute operates differently for VMware policies, depending on how the policy
selects virtual machines.

For more information, see the NetBackup for VMware Administrator's Guide.

Parent job and children jobs

Too many concurrent backups interfere with the performance of the server. The best
number depends on the hardware, operating system, and applications that are running.

Server speed

Job priority (policy attribute)
The Job priority attribute specifies the priority that a policy has as it competes with
other policies for resources. Enter a value from 0 to 99999. The higher the number,
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the greater the priority of the job. NetBackup assigns the first available resource to
the policy with the highest priority.

In the Default Job Priorities host properties, you can set a job priority default for
a job type.

See “Default Job Priorities properties” on page 100.

Media Owner (policy attribute)
The Media Owner attribute specifies which media server or server group should
own the media that backup images for this policy are written to.

This attribute is active under the following conditions:

■ A Media Manager storage unit is used.

■ The Policy storage attribute is set to Any Available

You can specify the following for the Media Owner:

Allows NetBackup to select the media owner. NetBackup selects a
media server or a server group (if one is configured).

Any (default)

Specifies that the media server that writes the image to the media owns
the media. No media server is specified explicitly, but you want a media
server to own the media.

None

Allows only those servers in the group to write to the media on which
backup images for this policy are written. All server groups that are
configured appear in the list.

A server group

See “About media sharing” on page 553.

See “Creating or deleting a NetBackup server group” on page 400.

Go into effect at (policy attribute)
The Go into effect at attribute specifies when the policy can begin to schedule
backups. For example, if today is Monday and you enter Wednesday at 12:00 A.M.,
the policy does not run until that time or later. Use this attribute to configure a series
of policies in advance of when the policies need to become active.

To activate the policy, check Go into effect at. The policy must be active for
NetBackup to use the policy.

To deactivate a policy, uncheck the box. Inactive policies appear are unavailable
in the NetBackup Administration Console. Inactive policies remain on the list of
policies in the left pane of the NetBackup Administration Console. To resume
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backups, recheck the box. Make sure that the date and time are set to the time that
you want to resume backups.

If the schedule is to be used for a catalog archive, the policy must not be active.
Clear the check box to deactivate the policy.

See “Creating a catalog archiving policy” on page 951.

Follow NFS (policy attribute)
The Follow NFS (Network File System) attribute specifies whether NetBackup is
to back up or archive any NFS-mounted files. These files are named in the backup
selection list or by the user, in the case of a user backup or archive. Uncheck the
box to prevent the backup or archive of NFS-mounted files.

Note: This attribute applies only to UNIX clients in certain policy types. NetBackup
allows it to be selected in those instances only.

This attribute eliminates the need to locate and log on to the systems where the
files reside. If the files are mounted on the NetBackup client, you can back up,
archive, and restore them by working from the NetBackup client. You must have
the necessary permissions on the NFS mount. Use this capability to back up the
systems that the NetBackup client software does not support.

Generally, do not back up NetBackup clients over NFS. Back up and archive files
on the NFS server where the files physically reside. NFS backups have lower
performance and sometimes encounter problems. If Follow NFS is selected, you
may want to use the policy only for the files and clients that are backed up or
archived over NFS.

Note: If Follow NFS is not selected, the backup process reads the client’s mount
table and evaluates each item in the table. NetBackup resolves any links to the true
path. NetBackup must resolve the links so it can accurately avoid backing up any
files that reside on NFS-mounted file systems.

If NetBackup cannot access a Network File System when it evaluates the mount
table, it assumes that the file system is unavailable. (The default time to access the
file system is five seconds.) To change the default, change the UNIX master server
host property, NFS_ACCESS_TIMEOUT in the usr/openv/netbackup/bp.conf file.

See “NFS_ACCESS_TIMEOUT option for NetBackup clients” on page 387.
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Note:NetBackup specifically excludes mapped directories even if FollowNFS and
Cross mount points are enabled. To back up mapped directories, include the
directories in the file list.

Consider the following before enabling this attribute:

Table 21-11 Issues that affect Follow NFS

DescriptionItem

The behavior of Follow NFS can vary depending on how it is used in combination with
Cross mount points.

See “Examples of using Cross mount points and Follow NFS in combination”
on page 748.

See “Cross mount points (policy attribute)” on page 746.

Cross mount points (policy
attribute)

This attribute has no effect on raw partitions. The Network File Systems that are
mounted in a raw partition are not backed up. Nor can you back up raw partitions from
other computers that use NFS mounts to access the raw partitions. The devices are
not accessible on other computers through NFS.

Note: NetBackup does not support raw partition backups on unformatted partitions.

Raw partitions

This attribute causes files in automounted file systems to be backed up. Automounted
directories can be excluded to allow the backup of other NFS mounts. To do so, add
an entry for the automounter’s mount directory to the exclude list on the client.

Automounted directories

Backup Network Drives (policy attribute)
The Backup Network Drives attribute is for use on single user systems, Win95,
Win98, and ME. These operating systems are not supported with this version of
NetBackup. For a computer that is not a NetBackup client, the preferred method
for backing up data is to use UNC paths. UNC paths are more precise and indicate
exactly what should be backed up.

When you use Backup Network Drives or UNC paths, the network drives must
be available to the service account that the NetBackup Client service logs into at
startup. By default, the startup account is set to System. You must change this
account on each Windows client that is backed up that contains data that is shared
from another computer.

This attribute must be enabled for the policies that back up to CD ROM drives. For
scheduled backups, the file list must indicate at least the first level of folders to be
backed up. For example, D:\Folder1 instead of only D:\
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Note:Mapped drive letters cannot be backed up. Drive letters do not appear in the
Backup, Archive, and Restore console when backups are browsed.

Example of using UNC paths to back up a shared folder
The following example gives the steps for backing up a shared folder using a UNC
path. The procedure backs up the folder TestData on win_PC through win_client.
Consult the following descriptions before you review the example.

NetBackup master servermaster1

Windows NetBackup clientwin_client

Windows computer (not necessarily a NetBackup client)win_PC

A shared folder on win_PCTestData

Table 21-12 Using UNC paths to back up a shared folder on win_PC

DescriptionActionStep

On master1 create a policy for win_client.Create a policyStep 1

Add \\win_PC\TestData to the file list of the policy. This step is not
necessary if the policy is only used for user-directed backups.

Add the folder name to the
policy

Step 2

Perform the following actions:

■ On win_client, change the NetBackup Client Service to Start Up or
Log On with the same account as the user that performs the backup.
This user account must have read permissions for the share that is to be
backed up. The account must have write permission to perform restores.

■ Stop and start the NetBackup Client Service so the new account takes
effect.

See “Configuring the NetBackup Client Service” on page 1161.

Configure the NetBackup
Client Service

Step 3

Backups run as scheduled or when a manual backup is performed.

See “Performing manual backups” on page 896.

Perform a backupStep 4

Example of using Backup Network Drives (policy attribute)
to back up a shared folder
The following example gives the steps for backing up a shared folder using the
Backup Network Drives policy attribute. The procedure backs up the folder share
onwin_PC throughwin_client. Consult the following descriptions before you review
the example.
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NetBackup master servermaster1

Windows NetBackup clientwin_client

Windows computer (not necessarily a NetBackup client)win_PC

A shared folder on win_PCshare

Table 21-13 Using Backup Network Drives to back up a shared folder on
win_PC

DescriptionActionStep

Onmaster1 create a policy forwin_client, and checkBackup network drives
in the policy attributes tab.

Create a policyStep 1

Perform the following actions:

■ On win_client, change the NetBackup Client Service to Start Up or
Log On with the same account as the user that performs the backup.
This user account must have read permissions for the share that is to be
backed up. The account must have write permission to perform restores.

■ Stop and start the NetBackup Client Service so the new account takes
effect.

See “Configuring the NetBackup Client Service” on page 1161.

Configure the NetBackup
Client Service

Step 2

Create a batch file bpstart_notify.bat that does the following:

■ Maps a drive on win_client to \\win_PC\share.
■ Includes the following command (where X: is the mapped drive letter):

net use X: \\win_PC\share

Create a batch fileStep 3

Backups run as scheduled or when a manual backup is performed.

See “Performing manual backups” on page 896.

Perform a backupStep 4

Cross mount points (policy attribute)
TheCrossmount points attribute controls whether NetBackup crosses file system
boundaries to back up or archive all files and directories in the selected path. For
example, if root (/) is specified as the file path on a UNIX system, NetBackup backs
up root (/) and all files and directories under root in the tree.

When this attribute is disabled, only the files that are in the same file system as the
selected file path are backed up. By disabling, you also prohibit NetBackup from
crossing mount points to back up root (/) without backing up all the file systems
that are mounted on root. (For example, /usr and /home.)
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In some cases, consider creating separate policies for the backups that cross mount
points and those that do not. For example, in one policy, disable Cross mount
points and include root (/) in the backup selection list. As a result, only the root
file system is backed up, and not the file systems that are mounted on it. In another
policy, enable Cross mount points and include root (/) in the backup selection
list. As a result, all the data on the client is backed up.

Note:NetBackup specifically excludes mapped directories even if FollowNFS and
Cross mount points are enabled. To back up mapped directories, include the
directories in the file list.

The following table lists items to consider when you use this policy attribute.

Table 21-14 Considerations for Cross mount points (policy attribute)

DescriptionItem

The behavior of Cross mount points can vary depending on how it is used in
combination with Follow NFS.

See “Examples of using Cross mount points and Follow NFS in combination”
on page 748.

See “Follow NFS (policy attribute)” on page 743.

Follow NFS (policy attribute)

The following backup selection entries behave in the following manner for Windows
and UNIX computers when the Cross mount points attribute is used:

■ /

Valid for UNIX clients. For Windows clients, the forward slash expands to
ALL_LOCAL_DRIVES.

■ :\

Valid for Windows clients. For UNIX clients, this entry creates a status 69 (Invalid
filelist specification).

■ *:\

Valid for Windows clients. For UNIX clients, this entry creates a status 69 (Invalid
filelist specification).

Backup selection entries

This attribute has no effect on UNIX raw partitions. If a raw partition is the root partition
and contains mount points for other file systems, the other file systems are not backed
up when Cross mount points is enabled.

UNIX raw partitions
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Table 21-14 Considerations for Cross mount points (policy attribute)
(continued)

DescriptionItem

Do not use Cross mount points in policies on UNIX computers where you use the
ALL_LOCAL_DRIVES directive in the backup selection list.

Enabling Cross mount points can cause multiple backups of mounted volumes.

If you require the backup to traverse file system boundaries, do not use the
ALL_LOCAL_DRIVES backup selection directive on UNIX clients. Instead, specify a
forward slash (/) within the policy backup selection list and ensure that Cross mount
points is selected in the policy Attributes.

ALL_LOCAL_DRIVES
directive

Do not cross mount points to back up a media server that uses mount points to any
disk storage that contains backup images. If the policy crosses mount points, the
NetBackup backup images that reside on that disk storage are backed up. The
NetBackup disk storage unit type uses mount points for disk storage.

Mount points to disk storage

Examples of using Cross mount points and Follow NFS
in combination
By using Cross mount points and Follow NFS in combination, you can get a
variety of results. Table 21-15 summarizes the possible results.

Table 21-15 Results of using Cross mount point and Follow NFS in
combination

ResultFollow NFSCross mount
points

No crossing of mount points (default).DisabledDisabled

Back up NFS files if the file path is (or is
part of) an NFS mount.

EnabledDisabled

Cross local mount points but not NFS
mounts.

DisabledEnabled

Follow the specified path across mount
points to back up files and directories
(including NFS), regardless of the file
system where they reside.

EnabledEnabled

Note:NetBackup specifically excludes mapped directories even if FollowNFS and
Cross mount points are enabled. To back up mapped directories, include the
directories in the file list.
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Example 1 and Example 2 assume that the client disks are partitioned as shown
in Figure 21-4.

Figure 21-4 Example configuration of client disks

d1

d2 d3Disks on
Local System

Disk on
Remote System

/(root)

/usr /home
/home/njr

/net
/net/freddie
/net/freddie/home

NFS

Table 21-16 Legend

DescriptionDisks

Contains /(root), /usr, and /home in separate partitions.d1

Contains a file system named /home/njr. Mounted on /home, which
is a partition on d1.

d2

Contains a directory named /net/freddie/home that is NFS-mounted
on /net/freddie

d3

Example 1:

■ Cross mount points and Follow NFS are not selected.

■ The backup selection list contains the following entry:
//usr/home

■ In this case, NetBackup considers only the directories and files that are in the
same file system as the backup selection list entry. It does not back up
/home/njr or /net/freddie/home.

Example 2:

■ Cross mount points and Follow NFS are selected.

■ The backup selection list only contains a forward slash:
/

■ In this case, NetBackup backs up all the files and directories in the tree, including
those under /home/njr and /net/freddie/home.
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To back up only /usr and individual files under /, leave / out of the list and
separately list the files and directories you want to include. For example:

/usr

/individual_files_under_root

Compression (policy attribute)
TheCompression attribute specifies that the backups use the software compression
that is possible, based on the policy type. Check the box to enable compression.
By default, compression is disabled.

Note: The Compression attribute is independent of the VxFS compression state.

See “About the backup and restore of compressed files on VxFS file systems”
on page 1220.

Compression reduces the size of a backup by reducing the size of files in the backup.
In turn, the smaller backup size decreases the number of media that is required for
storage. Compression also decreases the amount of data that travels over the
network as well as the network load. However, compression increases the overhead
computing on the client and increases backup time due to the time required to
compress the files. The lower transfer rate that is associated with compression on
the client reduces the ability of some tape devices (notably 8mm) to stream data.
The effect of the lower transfer rate causes additional wear on those devices.

The savings in media and network resources continue to make compression
desirable unless total backup time or client computing resources become a problem.
If total backup time is a problem, consider multiplexing. The NetBackup multiplexing
feature backs up clients in parallel, reducing the total time to back them up.

See “Media multiplexing (schedule attribute)” on page 815.

The degree to which a file can be compressed depends on the data type. A backup
usually involves more than one type of data. Examples include stripped and
unstripped binaries, ASCII, and the non-unique strings that repeat. Some data types
are more favorable to compression.

Note:When compression is not used, the server may receive more data than the
space that exists on the client. The discrepancy is due to client disk fragmentation
and the file headers that the client adds. (To tell how much space a file occupies,
run the du command. To tell how much free disk space is available, run the df

command.)
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Table 21-17 describes the various factors to consider when you choose to use
Compression.

Table 21-17 Considerations regarding compression

DescriptionItem

Programs, ASCII files, and unstripped binaries (typically 40% of the original size).

Best-case compression: Files that are composed of the strings that repeat can sometimes
be compressed to 1% of their original size.

Data types that
compress well

Stripped binaries (usually 60% of original size).

Worst-case compression: Files that are already compressed become slightly larger if
compressed again.

Data types that do not
compress well

File size has no effect on the amount of compression. However, it takes longer to compress
many small files than a single large one.

Effect of file size

Compression requires client computer processing unit time and as much memory as the
administrator configures.

Client resources that
are required

Compression uses as much of the computer processing unit as available and affects other
applications that require the computer processing unit. For fast CPUs, however, I/O rather
than CPU speed is the limiting factor.

Effect on client
performance

NetBackup does not compress the following files:

■ Files that are equal to or less than 512 bytes, because that is the tar block size.
■ On UNIX clients, files with the following suffixes:

.arc .gz .iff .sit.bin

.arj .hqx .pit .tiff

.au .hqx.bin .pit.bin .Y

.cpt .jpeg .scf .zip

.cpt.bin .jpg .sea .zom

.F .lha .sea.bin .zoo

.F3B .lzh .sit .z

.gif .pak

■ On UNIX clients, if a compressed file has a unique file extension, exclude it from
compression by adding it under the Client Settings (UNIX) properties.

Files that are not
compressed

If compressed data is written to a storage unit that has single-instance store (SIS) capabilities,
the storage unit may not be able to use data deduplication on the compressed or the encrypted
data. In data deduplication, only one instance of the file is stored. Subsequent instances of
the file reference the single file.

Effect of using with
storage units with SIS
capabilities
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Note: If compressed data is written to a storage unit that has deduplication
capabilities, the storage unit may not be able to deduplicate the data.

Encryption (policy attribute)
The Encryption attribute determines whether the backup should be encrypted by
the client. When the server initiates the backup, it passes on the Encryption policy
attribute to the client in the backup request.

The client compares the Encryption policy attribute to the Encryption host
properties for the client. If the encryption permissions for the client are set to
REQUIRED or ALLOWED, the policy can encrypt the backups for that client.

See “Encryption properties” on page 104.

For additional encryption configuration information, see the NetBackup Security
and Encryption Guide.

Note: If encrypted data is written to a storage unit that has deduplication capabilities,
the storage unit may not be able to deduplicate the encrypted data.

About NetBackup encryption options
NetBackup provides several methods for encrypting backups, as described in the
following table.

Table 21-18 NetBackup encryption options

DescriptionOption

The NetBackup client encryption option is a software-based
solution that encrypts the data on the client. The data is encrypted
in transit and at rest. Each client manages its own encryption
keys.

To enable client encryption, select the backup policy Encryption
attribute.

See “Encryption (policy attribute)” on page 752.

Client encryption
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Table 21-18 NetBackup encryption options (continued)

DescriptionOption

With hardware-based tape drive encryption, an encrypting tape
drive encrypts the data. The data is encrypted at rest only. The
NetBackup Key Management Service manages the encryption
keys.

See the “Data at rest key management” chapter in the NetBackup
Security and Encryption Guide.

One method to manage the volumes for hardware-based tape
encryption is to use a reserved prefix on the volume pool name.
The storage devicemust have encrypting tape drives. The storage
unit must specify the storage device that has the encrypting tape
drives. The backup policy must specify the correct storage unit
and volume pool.

See “About reserved volume pool name prefixes” on page 484.

Tape drive encryption

A plug-in in the NetBackup OpenStorage stack encrypts the data.
The data is encrypted at rest only. The NetBackup Key
Management Service manages the encryption keys.

See the NetBackup AdvancedDisk Storage Solutions Guide.

AdvancedDisk encryption

A plug-in in the NetBackup OpenStorage stack encrypts the data.
The data is encrypted at rest only (by default, NetBackup uses
SSL for read and write operations). The NetBackup Key
Management Service manages the encryption keys.

See the NetBackup Cloud Administrator’s Guide.

Cloud storage encryption

TheMSDP deduplication plug-in encrypts the data. The data can
be encrypted in transit and at rest or at rest only. The NetBackup
deduplication plug-in manages the encryption keys.

See the NetBackup Deduplication Guide.

Media Server
Deduplication Pool
encryption

Collect disaster recovery information for Bare Metal Restore (policy
attribute)

The Collect disaster recovery Information for Bare Metal Restore attribute
specifies whether the BMR client agent runs on each client. If the attribute is enabled,
the BMR client agent runs before each backup to save the configuration information
of the client. The Activity Monitor displays the activity as a job separate from the
backup.
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Only policy types MS-Windows (for Windows clients) and Standard (for UNIX
clients) support this policy attribute. This attribute is enabled by default when one
of these policy types is used to create a policy on a master server that is licensed
for BMR.

For more information, see the Bare Metal Restore Administrator’s Guide.

Collect true image restore information (policy attribute) with and
without move detection

The Collect true image restore information attribute specifies whether the policy
collects the information necessary to perform a true image restore. A true image
restore (TIR) restores the contents of a directory to reflect the contents of the
directory at the time of an incremental or a full backup. Files that were deleted
before the backup are not restored.

With the attribute enabled, a restore based on an incremental backup includes all
files that were backed up since the last full backup. The restore also includes those
files that were deleted at any time during that period.

NetBackup starts to collect the true image restore information with the next full or
incremental backup for the policy. The true image restore information is collected
for each client regardless of whether any files were changed.

NetBackup does not provide true image restores based on the time of a user backup
or archive. However, NetBackup uses a user backup for a true image restore if the
backup is more recent than the latest automatic full or incremental backup.

For true image incremental backups, enableWith move detection to include the
files that were moved, renamed, or newly installed in the directories. These files
may be from a tar or a zip archive. (Depending on how the files were packaged and
how they were installed, some newly installed files are not backed up by non-TIR
incremental backups.

NetBackup detects changes by comparing path names and inode numbers with
those from the previous full or incremental backup. If either the name or an inode
number is new or changed, the file or directory is backed up. NetBackup begins to
collect the information for move detection with the next full or incremental backup
for the policy. This first backup after the attribute is set always backs up all files,
even if it is an incremental backup.

Note: With move detection must be enabled to create a synthetic backup.

See “Synthetic backup (schedule attribute)” on page 800.
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The following examples show howmove detection backs up the files that otherwise
would not be backed up:

■ On Windows:

■ A file that is named C:\pub\doc is moved to or installed in C:\spec\doc.
The archive bit is unchanged but C:\spec\doc is new in the C:\spec\

directory and is backed up.

■ A directory that is named C:\security\dev\ is renamed as
C:\security\devices\. The archive bit is unchanged but
C:\security\devices\ is a new directory and is backed up.

■ On UNIX:

■ A file that is named /home/pub/doc is moved to /home/spec/doc. The
modification time is unchanged but /home/spec/doc is new in the
/home/spec/ directory and is backed up.

■ A directory that is named /etc/security/dev is renamed as
/etc/security/devices. The modification time is unchanged but
/etc/security/devices is a new directory and is backed up.

■ A file that is named /home/pub/doc is installed when extracted from a UNIX
tar file. The modification time is before the time of the last backup. The file
is new in the /home/pub/ directory and is backed up.

■ A file that is named docA is removed, and then a file that is named docB is
renamed as docA. The new docA has the same name but since its inode
number has changed, it is backed up.

NetBackup begins to collect the information that is required for move detection with
the next full or incremental backup for the policy. This first backup after the attribute
is set always backs up all files, even if it is an incremental backup.

Move detection consumes space on the client and the backup can fail if there is
not enough disk space available.

Example of true image restores
The following table lists the files that were backed up in the /home/abc/doc/

directory of a UNIX client during a series of backups between 12/01/2015 and
12/04/2015. Collect true image restore information was enabled for the policy
that performed the backups.
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Table 21-19 Sample backups taken before a true image restore

Files that are backed up in /home/abc/docType of
backup

Day

file1 file2 dirA/fileA dirB/fileB file3Full12/01/2015

file1 file2 dirA/fileA ---------- -----Incremental12/02/2015

file1 file2 dirA/fileA ---------- -----Incremental12/03/2015

file1 file2 dirA/fileA ---------- ----- dirC/fileC file4User backup12/04/2015

file1 file2 ---------- ---------- ----- ---------- file4Incremental12/04/2015

Note: Dashes ( ------ ) indicate that the file was deleted before this backup.

A restore of the 12/04/2015 version of the /home/abc/doc/ directory produces
following results:

The restored directory contains all files and directories that ever
existed in /home/abc/doc/ from 12/01/2015 (last full backup)
through 12/04/2015:

file1
file2
dirA/fileA
dirB/fileB
file3
dirC/fileC
file4

After a regular restore
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The restored directory contains only the files and directories that
existed at the time of the incremental backup:

file1
file2
file4

NetBackup does not restore any of the files that were deleted before
the 12/04/2015 incremental backup.

The restored directory does not include the subdirectories dirA
and dirC, even though they were backed up on 12/04/2015 with
a user backup.

NetBackup did not restore these directories because they did not
exist at the time of the incremental backup. The incremental backup
was the reference for the true image restore.

After a true image
restore

Consider the following points to use either Collect true image restore or Collect
true image restore with move detection:

■ NetBackup collects additional information for the incremental backups that collect
true image restore information. Policies that use move detection require even
more space.

■ Incremental backups are slower for a policy in which true image restore
information is collected.

■ Configure the period of time that NetBackup retains the true image restore
information. Set the Keep true image restoration (TIR) information property
in the Clean-up properties dialog box.
See “Clean-up properties” on page 66.

■ Only directories can be listed and selected. In true image restore mode, the
client interface does not display individual files. Refer to the online Help in the
Backup, Archive, and Restore client interface for more information on true
image restores.

■ A true image restore preserves the files that are currently in the directory but
were not present when the backup was completed. If you created a file file5

after an incremental backup on 12/04/2015 but before a restore, the contents
of the restored directory would be as follows:

file1

file2

file4

file5
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Allow multiple data streams (policy attribute)
The Allow multiple data streams attribute specifies that NetBackup can divide
automatic backups for each client into multiple jobs. The directives, scripts, or
templates in the backup selection list specify whether each job can back up only a
part of the backup selection list. Because the jobs are in separate data streams,
they can occur concurrently.

The directives, scripts, or templates in the backup selection list determine the
number of streams (backup jobs) that start for each client. The list also determines
how the backup selection list is divided into separate streams.

The following settings determine the number of streams that can run concurrently:

■ Number of available storage units

■ Multiplexing settings

■ Maximum jobs parameters

Multistreamed jobs consist of a parent job to perform stream discovery and children
jobs for each stream. Each child job displays its own job ID in the Job ID column
in the Activity Monitor. The job ID of the parent job appears in the Parent Job ID
column, which is not displayed by default. Parent jobs display a dash (-) in the
Schedule column.

Note: If this attribute is enabled, and a file system is in a client’s exclude list, a
NetBackup job appears in the Activity Monitor for the excluded file system.
However, no files in the excluded file system are backed up by the job.

The following table describes the reasons to use multiple data streams.
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Table 21-20 Reasons to use multiple data streams

DescriptionReason

Multiple data streams can reduce the backup time for large backups by
splitting the backup into multiple streams. Use multiplexing, multiple drives,
or a combination of the two to process the streams concurrently.

Configure the backup so each device on the client is backed up by a separate
data stream that runs concurrently with streams from other devices.

For best performance, use only one data stream to back up each physical
device on the client. Multiple concurrent streams from a single physical device
can adversely affect backup times. The heads must move back and forth
between the tracks that contain files for the respective streams.

Figure 21-5 shows why multiple concurrent streams from a single device are
not recommended.

To reduce backup time

Because the backup streams run independently, the use of multiple data
streams can shorten the retry time in the event of a backup failure. A single
failure only terminates a single stream. NetBackup can restart the failed
stream without restarting the others.

For example, assume the backup for a 10-gigabyte partition is split into five
streams, each containing 2 gigabytes. If the last stream fails after it writes
1.9 gigabytes (a total of 9.9 gigabytes is backed up), NetBackup retries only
the last gigabyte stream. If the 10-gigabyte partition is backed up without
multiple data streams and a failure occurs, the entire 10-gigabyte backup
must be retried.

The Schedule backup attempts property in the Global Attributes
properties, applies to each stream. For example, if the Schedule backup
attempts property is set to 3, NetBackup retries each stream a maximum
of three times.

The Activity Monitor displays each stream as a separate job. Use the job
details view to determine the files that are backed up by each of these jobs.

See “Global Attributes properties” on page 136.

To reduce retry time for backup failures

Use multiple data streams in a configuration that contains large file servers
with many file systems and volumes. Multiple data streams provide more
backups with fewer policies than are otherwise required.

To reduce administration by running
more backups with fewer policies
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Figure 21-5 Multiple stream recommendations
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The following table describes the aspects of multiple data streams that are
adjustable.

Table 21-21 Adjustable aspects of multiple data streams

DescriptionItem

The backup selection list determines the total number of streams that are started. The
NEW_STREAM directive lets you configure a fixed number of streams, or you can
allow the client dynamically define the streams.

See “About the directives on the Backup Selections list” on page 867.

Note: For best performance, use only one data stream to back up each physical device
on the client. Multiple concurrent streams from a single physical device can adversely
affect backup times. Backup times are affected because the device heads must move
between the tracks that contain files for the respective streams.

The total number of streams
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Table 21-21 Adjustable aspects of multiple data streams (continued)

DescriptionItem

The following factors determine the number of streams that can run concurrently for a
policy or client:

■ Number of the drives that are available.
■ Maximum concurrent jobs settings for the policy and client.
■ Storage unit and schedule multiplexing limit.

Each storage unit and each schedule have a maximum multiplexing setting. The
lower of the two settings is the limit for a specific schedule and storage unit. The
maximum streams are limited to the sum of the multiplexing limits for all drives
available in the storage unit and schedule combinations.
For example, assume that two storage units have one drive in each. Multiplexing
on storage unit 1 is set to 3 and multiplexing on storage unit 2 is set to 5. If
multiplexing is set to 5 or greater in the schedules, 8 streams can run concurrently.
See “Media multiplexing (schedule attribute)” on page 815.

The number of streams that
run concurrently

The maximum jobs settings limit the maximum number of streams as follows:

Table 21-22 Job settings that limit the maximum number of streams

Access methodItem

■ In the left pane, expand NetBackup Management > Host Properties.
■ Select Master Servers, and in the right pane, double-click the master server you

want to modify.
■ In the properties dialog box, in the left pane, click Global Attributes.

See “Global Attributes properties” on page 136.

See “Media multiplexing (schedule attribute)” on page 815.

Maximum jobs per client
(host property)

■ In the left pane, expand NetBackup Management > Policies.
■ In the right pane, double-click a policy you want to modify.

See “Limit jobs per policy (policy attribute)” on page 739.

Limit jobs per policy (policy
attribute)

■ In the left pane, expand NetBackup Management > Host Properties.
■ Select Master Servers, and in the right pane, double-click the master server you

want to modify.
■ In the properties dialog box, in the left pane, click Client Attributes.

See “General tab of the Client Attributes properties” on page 71.

Maximum data streams
(host property)

Job settings also affect the maximum number of streams. The following table
describes the interdependency of these settings.
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Table 21-23 Interdependency of job settings

DescriptionItem

NetBackup uses the value that is specified by eitherMaximum jobs per client or Limit
jobs per policy, whichever is lower.

Maximum data streams
property is disabled.

NetBackup ignoresMaximum jobs per client. Instead, NetBackup uses the value that
is specified by either Maximum data streams or Limit jobs per policy, whichever is
lower.

Maximum data streams
property is enabled.

See “About the directives on the Backup Selections list” on page 867.

Disable client-side deduplication (policy attribute)
The Disable client-side deduplication attribute appears only if the NetBackup
Data Protection Optimization Option license is active.

The clients that are configured for client-side deduplication behave as follows when
this attribute is enabled or disabled:

The clients do not deduplicate their own data and do not send their
backup data directly to the storage server. The NetBackup clients send
their data to a deduplication media server. That server deduplicates
the data and then sends it to the storage server.

Enabled

The clients deduplicate their own data. They also send it directly to the
storage server. Media server deduplication and data transport are
bypassed.

Disabled

The Deduplication property configures clients for client-side deduplication. The
Disable client-side deduplication policy attribute overrides the Deduplication
property. The Deduplication property is found on the General tab of the Client
Attributes host properties.

Note: NetBackup Client Direct deduplication is supported in a CloudCatalyst
duplication to cloud scenario. However, Client Direct deduplication is not supported
in a scenario where the backup is uploaded directly to the cloud and no duplication
is configured.

See “Where deduplication should occur” on page 75.

See the NetBackup Deduplication Guide.
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Enable granular recovery (policy attribute)
The Enable granular recovery attribute is available for the following policy types:

■ MS-Exchange-Server

■ MS-SharePoint

■ MS-Windows (for Active Directory)

With this option enabled, users can restore the individual objects that reside within
a database backup image, such as:

■ A user account from an Active Directory database backup

■ Email messages or folders from an Exchange database backup

■ A document from a SharePoint database backup

NetBackup does not support the compression or encryption of backups that use
Granular Recovery Technology (GRT). When the Enable granular recovery option
is enabled, the Compression option and the Encryption option are automatically
disabled.

Granular-level restores can be performed only if the backup was written to a disk
storage unit.

For more information on how to configure NetBackup to perform granular-level
backups, see the following:

■ NetBackup for SharePoint Server Administrator’s Guide

■ NetBackup for Exchange Server Administrator’s Guide

■ See “Active Directory granular backups and recovery” on page 897.

Use Accelerator (policy attribute)
NetBackup Accelerator increases the speed of full backups. The increase in speed
is made possible by change detection techniques on the client. The client uses the
change detection techniques and the client's current file system to identify the
changes that occurred since the last backup. The client sends the changed data
to the media server in a more efficient backup stream. The media server combines
the changed data with the rest of the client's data that is stored in previous backups.

If a file or portion of a file is already in storage and has not been changed, the media
server uses the copy in storage rather than reading it from the client. The end result
is a full NetBackup backup.

Accelerator has the following advantages:

■ Reduces the I/O and CPU overhead on the client. The result is a faster backup
and less load on the client.
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■ Creates a compact backup stream that uses less network bandwidth between
client and server.

■ Creates a full image that contains all data that is needed for restore.

Note: Accelerator operates differently when used for backup of virtual machines,
NDMP, and databases.

For full details on Accelerator for VMware, see the NetBackup for VMware
Administrator's Guide.

For full details on Accelerator for NDMP, see the NetBackup for NDMP
Administrator's Guide.

For full details on Accelerator for Oracle, SharePoint, Exchange, or SQL Server,
see the NetBackup guide for that agent.

How the NetBackup Accelerator works
TheNetBackup Accelerator creates the backup stream and backup image as follows:

■ If the client has no previous backup, NetBackup performs a full backup and
creates a track log. The track log contains information about the client's data,
for comparison at the next backup.

■ At the next backup, NetBackup identifies data that has changed since the
previous backup. To do so, it compares information from the track log against
information from the file system for each file. For NTFS and ReFS file systems,
it also uses the Windows change journal to help identify the data that has
changed since the last backup.
Accelerator uses theWindows change journal in two ways: To check for changes
in the file system metadata, and to help detect which files have changed since
the last backup.
See “Accelerator and the Windows change journal” on page 766.

■ The NetBackup client sends to the media server a backup stream that consists
of the following: The client's changed blocks, and the previous backup ID and
data extents (block offset and size) of the unchanged blocks.

■ The media server receives the client's changed blocks and the backup ID and
data extents of the unchanged blocks. From the backup ID and file system
descriptors, the media server locates the rest of the client's data in existing
backups.

■ The media server directs the storage server to write the changed blocks and
the unchanged blocks in a new full image.

Figure 21-6 shows how an Accelerator backup stream is composed.
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Figure 21-6 NetBackup client: Accelerator backup stream
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Figure 21-7 shows how the media server constructs a backup image from the
Accelerator stream and from previous backups:

Figure 21-7 NetBackup media server constructs backup image
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Figure 21-8 recaps Accelerator details in the context of the principal NetBackup
processes.
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Figure 21-8 Process overview of Accelerator backup
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Accelerator and the Windows change journal
For Windows NTFS and ReFS file systems, the Accelerator uses the Windows
change journal to help identify the files that changed since the previous backup.

The extent to which the Windows change journal is used depends on the following:

■ Whether the Use Change Journal option has been enabled for the NetBackup
client.

■ Whether the policy contains a schedule with the Accelerator forced rescan
option enabled.
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Note: Regardless of the Use Change Journal setting or the Accelerator forced
rescan setting, the Windows change journal always helps determine if a file has
changed.

Table 21-24 How Accelerator uses the Windows change journal

Accelerator use of change journalNetBackup configuration

For full backups and incremental backups, NetBackup examines the metadata for
every file to determine if the file has changed. Even without the Use Change
Journal option, theWindows change journal helps determine if a file has changed.

The Use Change Journal option
is not enabled

The Windows change journal helps determine if a file has changed during both full
backups and incremental backups.

■ During incremental backups, the Windows change journal is used exclusively
to determine if a file has changed. NetBackup does not examine the file
metadata.

■ During full backups, NetBackup examines the metadata for every file, to
determine whether the file has changed. In addition, NetBackup uses the
Windows change journal to help determine whether a file has changed.

The Use Change Journal option
is enabled but the Accelerator
forced rescan option is not
enabled on any of the policy's
schedules

The Windows change journal helps determine if a file has changed during both full
backups and incremental backups.

■ During incremental backups, the Windows change journal is used exclusively
to determine if a file has changed. NetBackup does not examine the file
metadata.

■ During full backups:
■ For a full backup schedule that does not enable the Accelerator forced

rescan option:
The Windows change journal is used exclusively to determine if a file has
changed. NetBackup does not examine the file metadata.

■ For a full backup schedule that enables the Accelerator forced rescan
option:
NetBackup examines the metadata for every file, to determine whether the
file has changed. In addition, NetBackup uses the Windows change journal
to help determine whether a file has changed.

The Use Change Journal option
is enabled and the Accelerator
forced rescan option is enabled
on at least one of the policy's
schedules

Accelerator notes and requirements
Note the following about the NetBackup Accelerator:

■ NetBackup Accelerator requires the Data Protection Optimization Option license.
For the latest information on licensing, contact your Veritas sales or partner
representative.
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■ Supports the disk storage units only. Supported storage includesMedia Server
Deduplication Pool, NetBackup appliance, cloud storage, and qualified
third-party OST storage.
See the NetBackup Hardware Compatibility List for supported storage types.

■ Storage unit groups are supported only if the storage unit selection in the group
is Failover.

■ Supports the MS-Windows and Standard policy types. Supports all features of
NetBackup that work with the MS-Windows or Standard policy types.

Note: Accelerator operates differently when used for backup of virtual machines,
NDMP, or Oracle databases. For full details, see the following:

NetBackup for VMware Administrator's Guide

NetBackup for NDMP Administrator's Guide

NetBackup for Oracle Administrator's Guide

The guides are available from the following location:

http://www.veritas.com/docs/DOC5332

■ Accelerator backups ignore the policy attribute that resets the atime on files
after backup.
By default, NetBackup records the file access time (atime) for each UNIX file
that it backs up, and then resets the atime after the file is backed up. Resetting
the atime in this way causes the change time (ctime) to update as well. The
Reset file access time to the value before backup policy attribute normally
controls this behavior (the default is enabled).
When NetBackup Accelerator is used to perform backups, NetBackup does not
reset the atime after the file is backed up, regardless of the policy attribute
setting. NetBackup does not reset the atime (which avoids updating the ctime)
because a ctime update would require a loss in Accelerator optimization.
See “Client Settings properties for UNIX clients” on page 84.

■ Supports the full backups and incremental backups.
See “Accelerator backups and the NetBackup catalog” on page 770.

■ Supports all platforms, file systems, and logical volumes that NetBackup
supports.

■ Supports theWindows NTFS and ReFS change journal (Use Change Journal)
but does not support the VxFS change journal.

■ For every policy that enables the Use Accelerator option, Veritas recommends
at a minimum the following backup schedules:
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A full backup schedule with the Accelerator forced rescan option enabled.
Another full backup schedule without the Accelerator forced rescan option
enabled.
See “Accelerator forced rescan option (schedule attribute)” on page 801.

■ If Collect true image restore information is enabled in the policy, NetBackup
performs a regular file system scan to determine the files and folders to include
in the backup. It also queries the change journal to help determine which files
have changed.
More information is available on the Use change journal option and the
Accelerator:
See “Accelerator and the Windows change journal” on page 766.

■ If a previous backup of the client does not exist, NetBackup performs a full
backup and creates a track log on the client. This initial backup occurs at the
speed of a normal (not accelerated) full backup. Subsequent Accelerator backups
of the client use the track log for accelerated backup speed.

Note:When you first enable a policy to use Accelerator, the next backup
(whether full or incremental) is in effect a full backup: It backs up all files in the
Backup Selections tab. If that backup was scheduled as an incremental, it may
not complete within the backup window. For example, when you upgrade policies
to 7.7 and first enable the Use Accelerator option, note: Make sure that the
next backup window is large enough for a full backup.

■ NetBackup retains track logs for future Accelerator backups. Whenever you
change the policy's backup selections list, NetBackup does a full non-accelerated
backup of the selections that were changed or added in the list. The unchanged
backup selections are processed as normal Accelerator backups.

■ If the storage unit that is associated with the policy cannot be validated when
you create the policy, note: The storage unit is validated later when the backup
job begins. If Accelerator does not support the storage unit, the backup fails. In
the bpbrm log, a message appears that is similar to one of the following:

Storage server %s, type %s, doesn't support image include.

Storage server type %s, doesn't support accelerator backup.

■ Accelerator requires that the storage have the OptimizedImage attribute enabled.

■ Veritas recommends that you not enable Expire after copy retention for any
storage units that are used with storage lifecycle policies (SLP) in combination
with Accelerator. The Expire after copy retention can cause images to expire
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while the backup runs. To synthesize a new full backup, the SLP backup needs
the previous backup image. If the previous image expires during the backup,
the backup fails.

Accelerator backups and the NetBackup catalog
Use of Accelerator does not affect the size of the NetBackup catalog. A full backup
with Accelerator generates the same catalog size as a full backup of the same data
without Accelerator. The same is true of incremental backups: use of Accelerator
does not require more catalog space than the same backup without Accelerator.

A potential catalog effect does exist, depending on how often you use Accelerator
with full backups. A full backup with Accelerator completes faster than a normal
full. It may therefore be tempting to replace your incremental backups with
Accelerator full backups. Note: Since a full backup requires more catalog space
than an incremental, replacing incrementals with fulls increases the catalog size.
When changing your incrementals to fulls, you must weigh the advantage of
Accelerator fulls against the greater catalog space that fulls require compared to
incrementals.

See “Configuring Accelerator” on page 770.

Configuring Accelerator
The following table outlines the procedure to configure the full backups that use
the NetBackup Accelerator.

Table 21-25 To configure Accelerator on full backups

Procedure and notesTask

Accelerator supports disk storage units only. Supported storage unit types are
PureDisk (Media Server Deduplication Pool and NetBackup appliance), cloud
storage, and qualified third-party OST storage.

The NetBackup device mapping files contain a complete list of supported storage
units (see the next task).

Note: Storage unit groups are supported only if the storage unit selection in the
group is Failover.

Make sure that you have a
storage unit that supports
Accelerator.

The NetBackup device mapping files contain all storage device types that
NetBackup can use. To add support for the new devices or upgraded devices that
support Accelerator, download the current device mapping files from the Veritas
support site.

See “About the device mapping files” on page 436.

See “Downloading the device mapping files” on page 437.

Update the NetBackup device
mapping files if needed.
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Table 21-25 To configure Accelerator on full backups (continued)

Procedure and notesTask

Select the following on the policy Attributes tab:

■ A disk storage unit that supports Accelerator.
■ The Use Accelerator option.

Accelerator operates differently when used for backup of virtual machines, NDMP,
or Oracle databases. For full details, see the following guides:

■ The NetBackup for VMware Administrator's Guide.
■ The NetBackup for NDMP Administrator's Guide.
■ The NetBackup for Oracle Administrator's Guide.

The guides are available from this location:
http://www.veritas.com/docs/DOC5332

Configure a Standard,
MS-Windows, VMware, NDMP,
or Oracle backup policy.

This option provides an additional level of Accelerator change detection in the
client's data. This option reduces the speed of Accelerator.

See “Accelerator forced rescan option (schedule attribute)” on page 801.

See “Accelerator and the Windows change journal” on page 766.

To periodically establish a new
baseline of change detection on
the client, you can select the
Accelerator forced rescan
option on the Schedule Attribute
tab of the policy.

Accelerator messages in the backup job details log
A NetBackup backup that uses Accelerator writes a message similar to the following
in the job details log:

11/23/2011 10:50:27 AM - Info bpbrm(pid=412) accelerator enabled

When NetBackup uses the NTFS or ReFS change journal for the backup, messages
similar to the following appear in the job details log:

9/24/2011 8:54:14 PM - Info bpbkar32(pid=7868) change journal enabled

for <C:\>

9/24/2011 8:54:14 PM - Info bpbkar32(pid=7868) using change journal

data for <C:\>

If the NTFS or ReFS change journal cannot be used, a message of the following
form appears in the job details log:

not using change journal data for <backup selection>: <reason ...>

See “Log messages about the Use Change Journal option and Accelerator”
on page 772.
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When the Accelerator forced rescan option is used, a message similar to the
following appears in the job details log:

9/25/2011 5:46:52 PM - Info bpbrm(pid=4136) Accelerator enabled

backup with checksum based change detection needs to read each file and

calculate the checksum, and will have longer backup time.

See “Log messages about the Use Change Journal option and Accelerator”
on page 772.

NetBackup logs for Accelerator
For log messages about Accelerator, see the following NetBackup log directories.

Table 21-26 NetBackup logs that pertain to Accelerator

Resides onLog directory

NetBackupmaster or media serverWindows: install_path\NetBackup\logs\bpbrm

UNIX: /usr/openv/netbackup/logs/bpbrm

NetBackup media serverWindows: install_path\NetBackup\logs\bptm

UNIX: /usr/openv/netbackup/logs/bptm

NetBackup clientWindows: install_path\NetBackup\logs\bpbkar

UNIX: /usr/openv/netbackup/logs/bpbkar

To create the log directories, run the following command on the NetBackup servers
and client:

On Windows:

install_path\NetBackup\logs\mklogdir.bat

On UNIX:

/opt/openv/netbackup/logs/mklogdir

Log messages about the Use Change Journal option and
Accelerator
The Accelerator uses the NTFS or ReFS change journal to help identify data
changes on the Windows client. The following table describes the change journal
messages that may appear in the NetBackup job details log in the Activity Monitor.
The left column lists the messages.

For Accelerator backups, these messages indicate various impediments to the use
of the Windows change journal. In general, they indicate either of the following:
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■ That the Accelerator cannot use the change journal for the backup. To use the
change journal, you may need to reconfigure the policy.

■ That the Accelerator cannot exclusively use the change journal to detect changes
in the file system. NetBackup examines the file system metadata for each file,
to detect which files have changed. It also uses the change journal to help detect
which files have changed.

Note: In the following messages, the variable <%%s> represents the items in your
backup selections list.

The change journal messages often appear in pairs. The first message indicates
why the change journal cannot be used. For example:

not using change journal data for <%%s>: forced rescan requested

The second message indicates that the Accelerator nevertheless can use the
change journal to detect changed files:

not using change journal data for enumeration for <%%s> but will use

it for change detection

Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log)

DescriptionMessage in NetBackup
job details

NetBackup uses the change journal to help detect which files have changed. NetBackup
also examines the file system metadata for each file to help detect which files have
changed.

Note: Before this message appears, another message explains why NetBackup does
not rely entirely on the change journal data to detect changed files.

not using change
journal data for
enumeration for <%%s>
but will use it for
change detection

The Accelerator forced rescan option is enabled on the full backup schedule for the
policy. As a result, NetBackup cannot rely entirely on the change journal data to detect
changed files. NetBackup also examines the file system metadata for each file to help
detect which files have changed.

not using change
journal data for
<%%s>: forced rescan
requested
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Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log) (continued)

DescriptionMessage in NetBackup
job details

The backup uses a number of filters to determine which files and directories to include
in the backup. The filters are the following: NetBackup exclude and include lists, the
files and directories that are included in the Shadow Copy Components and in the
system state backup, and others.

During a backup, a checksum is calculated against the filters. When a new backup
runs, the checksum for the current backup is compared against the checksum of the
previous backup. If the checksums do not match, the change journal data cannot be
used. Instead, Accelerator performs a regular file system scan to determine the files
and folders to include in the backup.

No action is required. If the filters do not change between backups, the change journal
data is used at the next backup.

not using change
journal data for
<%%s>: filter checksum
calculation failed

Accelerator cannot use the Use Change Journal option in the following cases:

■ No previous backup exists: No baseline update sequence number (USN) was
established from the NTFS change journal.

■ The previous backup was not successful.

In these cases, theUse Change Journal option cannot be used. Accelerator performs
a regular file system scan to determine the files and folders to include in the backup.

No action is required. Accelerator uses the Use Change Journal option at the next
backup if all conditions are met.

not using change
journal data for
<%%s>: unable to
validate change
journal usage
<reason=%%s>

Accelerator cannot use the Use Change Journal option in the following cases:

■ Toomuch activity has occurred on the system (records were purged from the change
journal databases before they could be processed).

■ Data corruption occurred.

Instead, Accelerator performs a regular file system scan to determine the files and
folders to include in the backup.

No action is required. When records have been purged, a new baseline is created
when the current backup completes. If corruption existed, it is detected and the
databases are re-created. Accelerator uses the Use Change Journal option at the
next backup.

not using change
journal data for
<%%s>: unable to
initialize change
journal usage
<reason=%%s>

Accelerator cannot use the Use Change Journal option if a change corresponds to a
hard link or to a reparse point. Note that the change may correspond to any number
of files and directories and the NTFS change journal does not track all of them.

No action is required. If no further changes occur to hard links or reparse points, the
Use Change Journal option can be used at the next backup.

not using change
journal data for
<%%s>: hard link or
reparse point change
detected
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Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log) (continued)

DescriptionMessage in NetBackup
job details

Collect true image restore information or Collect true image restore information
with move detection is specified in the policy. To process the files and determine
which files have changed, NetBackup performs a regular file system scan to determine
the files and folders to include in the backup. It also queries the change journal to help
determine which files have changed.

not using change
journal data for
<%%s>: not supported
with true image
backups

Accelerator does not support the selected schedule type with theUse Change Journal
option.

The Use Change Journal option is supported for incremental backups (cumulative or
differential) or full backups. For full backups, Use Acceleratormust be enabled on the
policy Attributes tab.

not using change
journal data for
<%%s>: invalid
schedule type

In the backup selections, a path contains a reparse point (directory junction or a symbolic
link). The Use Change Journal option cannot be used. NetBackup must perform a
regular file system scan to back up the directories correctly.

not using change
journal data for
<%%s>: path must be
local and not contain
directory junctions
and/or symbolic links

The Use Change Journal option was recently enabled. After Use Change Journal
is first enabled, the NetBackup client may need time to process the NTFS change
journal and set up its databases.

The Use Change Journal option may be ready at the next backup.

not using change
journal data for
<%%s>: change journal
setup is not complete
(may still be in
progress)

The Use Change Journal option was recently enabled. After Use Change Journal
is first enabled, the NetBackup client may need time to process the NTFS change
journal and set up its databases.

The Use Change Journal option may be ready at the next backup.

not using change
journal data for
<%%s>: unable to
locate journal data

When many changes occur on a volume, the NetBackup Client Service may need to
increase the size of the internal databases. As a result, the databases may become
invalid.

After the databases are increased in size and are synchronized with the NTFS change
journal, they are marked as valid. The Use Change Journal option is used with the
next backup.

not using change
journal data for
<%%s>: invalid change
journal data
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Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log) (continued)

DescriptionMessage in NetBackup
job details

For a snapshot-based backup, NetBackup uses the change journal databases on the
snapshot instead of on the live volume. An error occurred when NetBackup attempted
to open the databases on the snapshot.

When the next backup runs, NetBackup creates a new snapshot and the databases
may be opened without error.

not using change
journal data for
<%%s>: unable to apply
snapshot

No previous full backup exists that used Accelerator.

NetBackup supports theUse Change Journal option with Accelerator on a full backup
only if a previous full backup exists that used Accelerator.

not using change
journal data for
<%%s>: no previous
track log

The Use Accelerator option is not enabled on the policy.

For full backups, the Use Change Journal option requires that Use Accelerator is
enabled.

not using change
journal data for
<%%s>: not supported
with regular full
backups

If a backup is partially successful (status code 1), the next Accelerator backup cannot
use the Use Change Journal option.

NetBackup can use the Use Change Journal option after the next successful backup.

not using change
journal data for
<%%s>: unable to
validate change
journal usage
<reason=previous
backup wasn't a
successful backup>

A backup selection in the policy is a resource for which the Windows change journal
is not supported. Examples of unsupported resources are FAT volumes and FAT32
volumes.

not using change
journal data for
<%%s>: not supported

The backup has attempted to use a remote frozen image. The Use Change Journal
option is not supported with remote frozen images.

not using change
journal data for
<%%s>: not supported
for remote frozen
images

The Use Change Journal option is not enabled.not using change
journal data for
<%%s>: not enabled
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Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log) (continued)

DescriptionMessage in NetBackup
job details

The Use Change Journal option is not enabled.not using change
journal data for
<%%s>: not configured
for use

An internal error occurred. The volumes to back up should be checked to ensure that
a volume GUID is associated with each volume.

not using change
journal data for
<%%s>: unable to
determine volume guid

To use the change journal data, NetBackup must be able to take a snapshot of the
backup volume to correctly identify and handle open files. This error occurs if a backup
runs before NetBackup can take a snapshot of the volume. If a snapshot can be taken
before the next backup occurs, NetBackup may be able to use change journal data at
the next backup.

not using change
journal data for
<%%s>: snapshot has
not been applied
(unable to track open
files)

The Use Change Journal option is only supported for Standard or MS-Windows
policies.

not using change
journal data for
<%%s>: invalid policy
type

On the client, NetBackup keeps track of both Accelerator backups and change
journal-based backups. If the lists of these backups do not match, one of the following
occurred:

■ An Accelerator backup occurred that did not use the change journal.
■ A change journal-based backup occurred that did not use the Accelerator.

If either case, theUse Change Journal option cannot be used until the next full backup
occurs.

not using change
journal data for
<%%s>: list of
accelerator based
backups does not match
list of change journal
based backups

The change journal databases are fixed in size: they can contain only a fixed number
of records. If the volume undergoes a lot of activity, records may be purged from the
change journal database before a backup can process them. In that case, the Use
Change Journal option cannot be used. No action is required. Accelerator uses the
Use Change Journal option at the next backup if all conditions are met.

not using change
journal data for
<%%s>: previous backup
had change journal
data that was not
complete (missing usn
records)
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Table 21-27 Accelerator messages on the Windows Use Change Journal
option (job details log) (continued)

DescriptionMessage in NetBackup
job details

The backup selection in the policy is not for a local volume. For example, the backup
selection specifies a UNC path.

not using change
journal data for
<%%s>: not supported
for non-local volumes
/ file systems

This message appears only during Accelerator full backups. To use the change journal
data during Accelerator full backups, a policy schedule with the Accelerator forced
rescan option is required.

not using change
journal data for
<%%s>: no forced
rescan schedule
configured

This message appears only during full backups, when the policy is not configured with
the Accelerator forced rescan option.

Before this message appears, another message explains why the change journal data
cannot be used.

not using change
journal data for
<%%s>: forcing rescan,
each file will be read
in order to validate
checksums

About reporting the amount of Accelerator backup data
that was transferred over the network
For Accelerator backup reporting, several NetBackup commands can report the
amount of data that is transferred over the network for each Accelerator backup.
The amount of transferred data is often much less than the size of the Accelerator
backup image.

For each Accelerator backup, NetBackup combines the client's (or VM's) changed
blocks with the unchanged data from previous backups to synthesize a backup
image. However, NetBackup sends only the changed data over the network when
the backup occurs. The resulting backup imagemay bemuch larger than the amount
of backup data that travels the network. For backup reporting, it may be important
to distinguish between the backup image size and the amount of data that was
transferred over the network.

For Accelerator backups, the network-transferred data can appear in the output of
the following NetBackup commands: bpdbjobs, bpimagelist, and bpclimagelist.

Table 21-28 lists the default location of these commands.
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Table 21-28 Default location of bpdbjobs, bpimagelist, and bpclimagelist

Default locationCommand

Windows:

install_path\NetBackup\bin\admincmd\

UNIX, Linux

/usr/openv/netbackup/bin/admincmd/

bpdbjobs,
bpimagelist

Windows:

install_path\NetBackup\bin\

UNIX, Linux

/usr/openv/netbackup/bin/

bpclimagelist

The following example uses the bpimagelist command to show the results of a
backup of acmevm2:

bpimagelist -backupid acmevm2

Example output:

In this example, the backup image size in kilobytes is 7799632, and the amount of
data that was transferred over the network is 225792.

You can use the following commands to show the amount of data that was
transferred over the network for an Accelerator backup.

bpimagelist
bpimagelist -backupid backup_id [-l | -L | -json | -json_compact]
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Brackets [ ] indicate optional elements, and the vertical bars | indicate that you can
choose only one of the options within the brackets.

Table 21-29 describes how the network-transferred data field appears in the
bpimagelist output.

Table 21-29 The bpimagelist options that show the amount of
network-transferred data for Accelerator backups

How the network-transferred data field appearsbpimagelist
option

The field is unlabeled. For example: 225792

See the bpimagelist example output earlier in this topic.

No option

The field is unlabeled (same as no option). For example: 225792-l

The field is labeled. For example:

Kilobytes Data Transferred: 225792

-L

The field is labeled. For example:

"kilobytes_data_transferred": 225792,

-json

The field is labeled. For example:

"kilobytes_data_transferred":225792,

-json_compact

bpdbjobs
bpdbjobs –jobid job_id -report –most_columns

or

bpdbjobs –jobid job_id -report –all_columns

The network-transferred data field appears at the end of the output.

bpclimagelist
bpclimagelist -client client_name

This command can only show the network-transferred data in the field that normally
shows the Accelerator backup image size. To show the network-transferred data
with this command, you must configure a NetBackup setting:

See “Replacing the Accelerator image size with the network-transferred data in
NetBackup command output” on page 781.

Additional details on these commands are available in the NetBackup Commands
Reference Guide or in the NetBackup man pages.
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Replacing the Accelerator image size with the
network-transferred data in NetBackup command output
You can configure the output of bpimagelist, bpdbjobs, and bpclimagelist to
show the amount of Accelerator backup data that was transferred over the network
instead of the backup image size.

The following is the default bpimagelist output that shows the Accelerator image
size (see the circled value 7799632). The amount of network-transferred data
appears farther down in the output (225792):

You can configure NetBackup command output to show the network-transferred
data in the image size field. In the output, the image size value is replaced with the
network-transferred data value (see the following example). A script that reads the
image size from the command output now reads the amount of network-transferred
data.

In the following bpimagelist output, the image size field shows the
network-transferred data (225792):
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Note: The same change occurs in the labeled output of the commands (such as
with the -L option of bpimagelist). For example, the Kilobytes field shows the
transferred data value (225792 in the example) rather than the Accelerator backup
image size.

To enable the reporting of network-transferred data in the Accelerator image
size field of bpimagelist, bpdbjobs, and bpclimagelist

◆ Use the bpsetconfig command to enable the output change.

To enable this change for the bpclimagelist command, enter the bpsetconfig
command on the master server. To enable this change for bpimagelist or
bpdbjobs, enter the bpsetconfig command on the server where you intend
to run bpimagelist or bpdbjobs.

Refer to Table 21-30 for the bpsetconfig command to use based on the type
of Accelerator backup that you want to report on.

Table 21-30 To enable the reporting of network-transferred data in the
Accelerator image size field of bpimagelist, bpclimagelist, or
bpdbjobs output

Enter this commandType of backup
to report on

Windows

echo REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_INC_VIRTUAL | install_path\NetBackup\bin\admincmd\bpsetconfig

UNIX, Linux

echo "REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_INC_VIRTUAL" | /usr/openv/netbackup/bin/admincmd/bpsetconfig

Incremental
Accelerator virtual
machine backups
(VMware and
Hyper-V)

Windows

echo REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_ALL_VIRTUAL | install_path\NetBackup\bin\admincmd\bpsetconfig

UNIX, Linux

echo "REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_ALL_VIRTUAL" | /usr/openv/netbackup/bin/admincmd/bpsetconfig

All Accelerator
virtual machine
backups (VMware
and Hyper-V, full
and incremental)
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Table 21-30 To enable the reporting of network-transferred data in the
Accelerator image size field of bpimagelist, bpclimagelist, or
bpdbjobs output (continued)

Enter this commandType of backup
to report on

Windows

echo REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_INC_ALL | install_path\NetBackup\bin\admincmd\bpsetconfig

UNIX, Linux

echo "REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_INC_ALL" | /usr/openv/netbackup/bin/admincmd/bpsetconfig

All incremental
Accelerator
backups (physical
clients and virtual
machines)

Windows

echo REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_ALL_ALL | install_path\NetBackup\bin\admincmd\bpsetconfig

UNIX, Linux

echo "REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED = REPLACE_IMAGE_SIZE_
FOR_ACCL_ALL_ALL" | /usr/openv/netbackup/bin/admincmd/bpsetconfig

All Accelerator
backups (full and
incremental,
physical clients
and virtual
machines)

To reset the command output to the default setting

◆ To disable the reporting of network-transferred data in the Accelerator image
size field (return to default), enter the following:

Windows

echo REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED =

REPLACE_IMAGE_SIZE_DISABLED |

install_path\NetBackup\bin\admincmd\bpsetconfig

UNIX, Linux

echo "REPLACE_IMAGE_SIZE_WITH_DATA_TRANSFERRED =

REPLACE_IMAGE_SIZE_DISABLED" |

/usr/openv/netbackup/bin/admincmd/bpsetconfig

Enable optimized backup of Windows deduplicated volumes
Select this attribute to enable optimized backups of optimized files on a Microsoft
Data Deduplication file system.
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See “About backups and restores of Microsoft Data Deduplication file systems”
on page 784.

If a client has a Microsoft Data Deduplication file system configured, NetBackup
performs an optimized backup of optimized files. (Unoptimized files are backed up
as full, intact files.) If the client does not have a Microsoft Data Deduplication file
system, a normal file backup occurs.

If you do not select this option, NetBackup still backs up the files but does so as
intact files: the files are fully reconstructed and backed up as complete files. An
unoptimized backup of optimized files is not efficient: it takes extra time and extra
disk activity to reconstruct each file. However, restores are faster because
NetBackup does not reconstruct the files (restores are unoptimized regardless of
the type of backup).

Note: For easier management, Veritas recommends creating a separate policy to
back up deduplicated volumes.

Only full backups are optimized. Incremental and user backups are backed up as
full, intact files.

This option is supported on the Microsoft operating systems that support Data
Deduplication file systems. For supported Microsoft operating systems, see the
Microsoft documentation.

See “Configuration for Microsoft Data Deduplication file system backups”
on page 786.

See “Policy Attributes tab” on page 726.

About backups and restores of Microsoft Data
Deduplication file systems
Microsoft Data Deduplication file systems store files in one of two different states,
as follows:

Files that do not qualify for optimization (that is, data deduplication
within the file system).

Unoptimized files

Files that have been deconstructed, and only their unique data
segments are stored on the file system.

Optimized files

NetBackup can do either optimized backups or unoptimized backups of theMicrosoft
Data Deduplication file systems, as follows:
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Table 21-31 Microsoft Data Deduplication file systems backup types

DescriptionType

An unoptimized backup is one in which the Enable optimized backup ofWindows deduplicated
volumes policy attribute is not selected.

NetBackup re-assembles the optimized files and backs them up as full, intact files. The storage
savings of the Data Duplication file system are not retained in the backup. The optimized files
remain optimized on the Data Deduplication file systems. The unoptimized files are backed up
as full, intact files.

NetBackup supports any type of storage destination for unoptimized backups of Microsoft Data
Deduplication file systems.

Unoptimized
backup

An optimized backup is one in which the Enable optimized backup of Windows deduplicated
volumes policy attribute is selected. Only full backups are optimized. For incremental and user
backups, each file to be backed up is reconstructed and backed up in its full form.

For optimized files, NetBackup backs up the chunk store and the metadata that maps the files
to their segments in the chunk store. The chunk store is a location in the file system that contains
the data segments that comprise the files. For unoptimized files, NetBackup backs them up as
full, intact files.

The following are the attributes for an optimized backup of Microsoft Data Deduplication file
systems:

■ The policy must be a MS-Windows policy type.
■ The storage destination must be BasicDisk storage.
■ The Enable Optimized Backup for supportedWindows File Systems policy attribute must

be selected.
See “Enable optimized backup of Windows deduplicated volumes” on page 783.

■ The system drive C: cannot be backed up. Microsoft Data Deduplication file systems cannot
be used for system drives.

■ Ensure that the Collect true image restore information policy attribute is not selected for
this policy. TIR and optimized backups cannot be mixed. If this option is selected, the backup
defaults to a non-optimized backup.

Veritas recommends the following actions for backups of Microsoft Data Deduplication file systems:

■ Run a Microsoft optimization job and a Microsoft garbage collection job before you run a full
backup of deduplicated volumes. One way to do so is to configure a Deduplication Schedule
in the Windows Server Manager.

■ If you want to restore entire volumes, configure a disk image backup of the volumes. A disk
image backup saves time and ensures that the storage requirement can be met with the
existing volume.
See “Pathname rules for Windows disk image (raw) backups” on page 854.

Optimized backups are supported on the Microsoft operating systems that support Data
Deduplication file systems. For supported Microsoft operating systems, see the Microsoft
documentation.

Optimized backups
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To restore optimized backups, use the Restore from Optimized Backup option
in the Backup, Archive, and Restore interface.

Note the following items regarding restores from optimized backups:

■ Can only be restored to Microsoft Data Deduplication file systems.

■ Restores from optimized backups of Microsoft Data Deduplication files systems
using the Microsoft deduplication API are slow. First, the imagemust be mounted
through NFS. Then, the image must be accessed through the Microsoft
deduplication API, which requests data in the amounts that may be inefficient.
The process to restore an entire drive may take a very long time.
Therefore, NetBackup restores all files as full, intact files (that is, non-optimized).
The files are then optimized during the next scheduled file system optimization
job, or you can initiate optimization manually. You should ensure that you have
adequate storage for the restored files in their unoptimized state.

Configuration for Microsoft Data Deduplication file system
backups
For NetBackup to do an optimized backup of Microsoft Data Deduplication file
systems, specific Windows software must be installed and configured, as follows:

■ Microsoft Server for NFSmust be installed on the NetBackupmedia server. Use
Windows Server Manager to add the role. Enable the NFS services. (By default,
the NFS services are not enabled.)

■ Microsoft Client for NFS must be installed on the Windows host that is to be
backed up. Use Windows Server Manager to add the role. Without Client for
NFS, restores cannot be performed.

■ The Deduplication role must be installed on the Windows host that is to be
backed up by using the Windows Server Manager interface.

Also, ensure that the NetBackup Client Service is configured to run as Administrator.
If not, restores from the optimized backups fail.

Keyword phrase (policy attribute)
The Keyword phrase attribute is a phrase that NetBackup associates with all
backups or archives based on the policy. Only the Windows and UNIX client
interfaces support keyword phrases.

Clients can use the same keyword phrase for more than one policy. The same
phrase for multiple policies makes it possible to link backups from related policies.
For example, use the keyword phrase “legal department documents” for backups
of multiple clients that require separate policies, but contain similar types of data.
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The phrase can be a maximum of 128 characters in length. All printable characters
are permitted including spaces and periods. By default, the keyword phrase is blank.

Clients can also specify a keyword phrase for a user backup or archive. A user
keyword phrase overrides the policy phrase.

Snapshot Client and Replication Director (policy attributes)
The Snapshot Client attributes are available when the NetBackup Enterprise Client
license is installed. A snapshot is a point-in-time, read-only, disk-based copy of a
client volume.

For more information about configuring snapshots, see the following guides:

■ NetBackup Snapshot Client Administrator’s Guide

■ NetBackup Replication Director Solutions Guide

■ NetBackup for VMware Administrator’s Guide

■ NetBackup for Hyper-V Administrator’s Guide

Perform block level incremental backups (policy attributes)
The Perform block level incremental backups attribute allows NetBackup to back
up only the changed data blocks of VMware virtual machines and Oracle or DB2
database files.

For details, refer to the appropriate NetBackup database agent guide or to the
NetBackup for VMware Administrator's Guide.

Use Replication Director (policy attributes)
Enable the Use Replication Director attribute when configuring a backup policy
for Replication Director. By enabling this policy attribute, NetBackup enables other
policy attributes that Replication Director requires:

■ Perform snapshot backups
Ensures that the policy creates snapshots of the disk array.

■ Retain snapshots for Instant Recovery or SLP management
Ensures that the policy retains the snapshot after the backup completes.

■ Perform off-host backup

This option is selected automatically for anNDMP policy, along with the following
selections:

■ To use Data Mover
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■ NDMP as the Machine selection.

■ Replication Director Options
Click the Options button to see the Replication Director Options dialog box
and the default Configuration Parameters as follows:

■ Auto (default): The OpenStorage partner uses the best snapshot
technology available to that partner to create the snapshot.

■ Differential: The OpenStorage partner creates a snapshot that is
completely dependent on the source. This parameter is based on
copy-on-write technology. The device creates a cache object to maintain
the original blocks of the snapshot when the blocks are modified.

■ Plex: The OpenStorage Partner creates a snapshot that is completely
independent of the source snapshot. This option is based on
mirror-break-off technology. When a mirror device is attached to the
source, the contents of the mirror device is exactly the same as the
source device. When the relationship is broken between the two, the
mirror device is separated from the source. The mirror device acts as
a point-in-time copy.

■ Clone: The OpenStorage Partner creates an independent copy of the
volume. The copy process can take some time as the entire copy must
be complete. The snapshot that is created is independent of the source.

Snapshot
Type

Sets the maximum number of Instant Recovery snapshots to be retained
at one time.When the maximum is reached, snapshot rotation occurs: The
next snapshot causes the oldest to be deleted.

Managed by SLP retention is automatically selected if the Fixed or the
Expire after Copy retention is currently selected in the SLP.

Maximum
Snapshots

For additional information about Replication Director configuration, see the
NetBackup Replication Director Solutions Guide.

See “About NetBackup Replication Director” on page 1093.

Validate Policy dialog box
The Validate Policy dialog box appears for the backup policies that are configured
for Replication Director and are not Exchange, Oracle, or VMware policies. The
dialog box appears upon selecting OK to save and close the policy.

To ensure that the backup policy can run successfully, NetBackup validates the
policy according to the validation level that you select.

Select the validation level for the policy:

■ Complete
Performs full topology validation on underlying storage with provisioning.
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Provisioning dynamically allocates NetApp storage space to each volume or
LUN as data is written.
NetBackup checks the storage space on the resource pool members and
performs SnapVault and SnapMirror access checks.

■ Basic
Performs a subset of topology validation on underlying storage without
provisioning.
NetBackup checks all policies to ensure that the client can perform a snapshot
of the data that is indicated in the Backup Selections list.
NetBackup performs license checks, performs SnapVault and SnapMirror access
status checks, and checks the CIFS/NFS status.

■ None
No topology validation or provisioning.
NetBackup does not check the topology and does not provision the underlying
storage.

If the policy validation finds no problems, the policy saves and closes. If validation
problems are found, NetBackup displays a message that contains an error code
and a description.

Perform snapshot backups (policy attributes)
ThePerform snapshot backups attribute ensures that the policy creates snapshots
of the volumes that are indicated in the policy.

Microsoft Exchange Attributes (policy attributes)
The Microsoft Exchange attributes let you indicate the database backup source
to use for the Exchange Database Availability Group.

See the NetBackup for Exchange Server Administrator’s Guide.

Schedules tab
The schedules that are defined on the Schedules tab determine when backups
occur for the selected policy. Each schedule also includes various criteria, such as
how long to retain the backups.

From the policy Schedules tab, perform the following tasks:

■ To create a new schedule, click New.

■ To edit a schedule, select the schedule and click Change.

■ To delete a schedule, select the schedule and click Delete.
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Schedule attributes appear on the following tabs:

Schedule the time and frequency at which a task runs,
along with other scheduled attributes.

See “Schedule Attributes tab” on page 790.

Attributes tab

Schedule the time of each day that a task runs.

See “Start Window tab” on page 822.

Start Window tab

Indicate the days that a job cannot run.

See “Excluding days from a schedule” on page 826.

Exclude Days tab

Schedule the run days for a task by indicating specific
dates, recurring weekdays, recurring days of the month.
(This tab appears only when Calendar is selected as
the Schedule type.)

See “Include Dates tab” on page 827.

Include Dates tab

Schedule Attributes tab
The schedule Attributes tab contains both schedule information and other
configuration options, beyond when the job is to run.
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Figure 21-9 Schedule Attributes tab

The following topics describe the options on the Attributes tab for schedules.

Name (schedule attribute)
Specify a name for the schedule by typing it in the Name attribute. The schedule
name appears on screens and messages about the schedule.

See “NetBackup naming conventions” on page 1163.

If the schedule is a relocation schedule created as part of a basic disk staging
storage unit, the schedule name cannot be changed. The name defaults to the
name of the storage unit.

See “About staging backups” on page 620.

Type of backup (schedule attribute)
The Type of backup attribute specifies the type of backup that the schedule controls.
Select a backup type from the list. The list displays only the backup types that apply
to the current policy.

If the schedule is a relocation schedule created as part of a basic disk staging
storage unit, no backup type selection is needed.
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Table 21-32 describes the types of backups that come standard with NetBackup.
Table 21-33 and Database agent backup types describe other types of backups
available in NetBackup.

Table 21-32 Standard backup types

DescriptionItem

Backs up all of the files that are specified in the backup selections list for the policy. The
files are backed up, regardless of when the files were last modified or backed up. Full
backups occur automatically according to schedule criteria. If you run incremental backups,
you must also schedule a full backup to perform a complete restore. Use this option if you
configure a policy for a raw partition backup (formatted partitions only).

Full Backup

Backs up the files that are specified in the backup selections list that changed since the
last full backup. All files are backed up if no previous backup was done. Cumulative
incremental backups occur automatically according to schedule criteria. A complete restore
requires the last full backup and the last cumulative incremental backup.

Do not combine differential incremental backups and cumulative incremental backups
within the same Windows policy when the incremental backups are based on archive bit
(default).

By default, if the time between file creation and a full or a differential incremental backup
is less than 5 minutes, the differential or cumulative incremental backup may yield
unexpected results. The backups are successful, but the additional files are backed up.

See “About incremental backups” on page 794.

Cumulative Incremental
Backup

Backs up the files that changed since the last successful incremental (differential or
cumulative) or full backup. All files are backed up if no previous backup was done.
Differential incremental backups occur automatically according to schedule criteria. A
complete restore requires the last full backup, the last cumulative incremental, and all
differential incremental backups that occurred since the last full backup.

By default, if the time between file creation and a full or a differential incremental backup
is less than 5 minutes, the differential or cumulative incremental backup may yield
unexpected results. The backups are successful, but the additional files are backed up.

See “About incremental backups” on page 794.

Differential Incremental
Backup

A user initiates a user backup through the Backup, Archive, and Restore client interface.
A user backup backs up all files that the user specifies. Users can start backups only during
the times that are allowed on the schedule Start Window tab.

For a user to be able to initiate a backup, the policy must contain a schedule of the User
Backup type.

Use this backup type for a catalog archive.

See “Considerations for user schedules” on page 799.

See “Creating a catalog archiving policy” on page 951.

User Backup
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Table 21-32 Standard backup types (continued)

DescriptionItem

A user initiates a user archive through the Backup, Archive, and Restore client interface.
A user archive backup first backs up the files that the user indicates. The archive then
deletes the files from the local disk if the backup is successful. Archive backups free local
disk space while retaining a copy for future use. The copy is kept until the retention period
expires. Users can start archives only during the times that are specified in the schedule
Start Window tab.

For a user to be able to initiate an archive, the policy must contain a schedule of the User
Archive type.

Note: The NetBackup administrator should make sure that a full backup of the client exists
before a user archives files from the client.

User Archive

Table 21-33 describes the types of backups that are available when you install
NetBackup Vault.

Table 21-33 NetBackup Vault backup types

DescriptionItem

Applies only to Vault policies. The option does not run a backup, but instead runs the
command that is specified in the Vault policy’s backup selections list. In this way it starts
an automatic, scheduled vault session or vault eject operation. Available only when Vault
is licensed.

See “Creating a Vault policy” on page 893.

Automatic Vault

Use when the schedule is for a catalog backup policy that Vault uses. Available only when
Vault is licensed.

If this type is selected, you must configure one of the two schedule attribute combinations
or the schedule cannot be saved:

■ Check and configure Multiple copies, or
■ CheckOverride policy storage selection,Override policy volume pool, and specify

the Retention.

Note: The selected storage unit selection should not be Any Available.

Vault Catalog Backup

Database agent backup types
Each database agent often has its own set of unique backup types for a schedule.
For more information, see the NetBackup guide that came with the agent.

NetBackup documentation set
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About incremental backups
The following examples show how data is included in a series of full and incremental
backups.

A differential incremental backup backs up the data that changed since the last full
or differential incremental backup.

Note: You must run a full backup before an incremental backup. If no full backup
is run, the incremental performs the role of a full backup.

Figure 21-10 shows how data is included in a series of full and differential
incremental backups between January 1 and January 4.

Figure 21-10 Full and differential incremental example

Jan 1 Jan 2 Jan 3 Jan 4 disk fails

Recovery = Jan 1 (full) + Jan 2 (incr) + Jan 3 (incr) + Jan 4 (incr)

Full backup

Diff. incremental

Diff. incremental

Diff. incremental

The January 1 full backup includes all files and directories in the policy backup
selections list. The subsequent differential incremental backups include only the
data that changed since the last full or differential incremental backup. If the disk
fails sometime on January 4 (after the backup), the full backup and all three of the
incremental backups are required for the recovery.

A cumulative incremental backup backs up the data that changed since the last full
backup. Figure 21-11 shows how data is included in a series of full and cumulative
incremental backups between January 1 and January 4. The January 1 full backup
includes all files and directories in the policy backup selections list. Each of the
cumulative incremental backups includes the data that changed since the last full
backup. If the disk fails sometime on January 4 (after the backup), the full backup
and the last cumulative incremental backup are required for the recovery.
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Figure 21-11 Full and cumulative incremental example

Jan 1 Jan 2 Jan 3 Jan 4 disk fails

Recovery = Jan 1 (full) + Jan 4 (cumulative incremental)

Full backup

Cum. incremental

Cumulative incremental

Cumulative incremental

Table 21-34 describes how to determine the retention of differential and cumulative
incremental backups to prevent a gap in backup coverage.

Table 21-34 Retention requirements for incremental backups

CommentsRetention
requirement

Type

To restore all files requires the last full backup and all the differential incremental
backups that occurred since the last full backup. Therefore, all the differentials
must be kept until the next full backup occurs.

LongerDifferential

Each cumulative incremental backup contains all the changes that occurred
since the last full backup. Therefore, a complete restore requires only the most
recent cumulative incremental in addition to the full backup.

ShorterCumulative

Table 21-35 compares the advantages and disadvantages of using differential or
cumulative incremental backups based on possible backup and restore times.

Table 21-35 Relative backup and restore times for incremental backups

CommentsRestore
time

Backup timeType

Less data in each backup, but all differential incremental backups
are required since the last full backup for a restore. This results in
a longer restore time.

LongerShorterDifferential

More data in each backup, but only the last cumulative incremental
backup is required for a complete restore (in addition to the full).

ShorterLongerCumulative

You can use a combination of cumulative and differential incremental backups
together to get the advantages of both methods. For example, assume a set of
schedules with the following backup frequencies and retention periods. (Notice that
the differential incremental backups occur more often.)
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Table 21-36 Example frequencies and retention periods

Retention periodFrequencyBackup type

2 weeks6 daysFull

4 days2 daysCumulative incremental

2 days1 dayDifferential incremental

The schedules that are described in Table 21-36 result in the following series of
backups:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8

Full FullDiff Cum Diff Cum Diff Diff

The example produces the following results:

■ Every other day a differential incremental backup occurs, which usually has a
minimum backup time.

■ On alternate days, a cumulative incremental backup occurs, which requires
more time than the differential backup, but not as much time as a full backup.
The differential backup can now be expired.

■ To recover all files may require (at most), two incremental backups in addition
to the most recent full backup. The combination of backups usually means less
restore time than if all differential incremental backups were used. The full
backups can be done less often if the amount of data being backed up by the
incremental backups is small.

How NetBackup determines when Windows files are due
for backup
On Windows clients, NetBackup performs the incremental backups when the
Perform incrementals based on archive bit setting is enabled. This setting is
found in the Backup, Archive, and Restore client interface, under File >
NetBackup Client Properties, on the General tab.

If Perform incrementals based on archive bit is enabled, incremental backups
for the client are based on the state of the archive bit of each file. The operating
system sets the bit whenever a file changes, and it remains set until cleared by
NetBackup. The conditions under which NetBackup clears the bit depend on the
type of backup being performed.
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NetBackup backs up files regardless of the state of their
archive bit. After a full backup, the archive bit is always
cleared.

Full Backup

NetBackup backs up the files that have the archive bit set
and have therefore changed. When the client receives a
response from the server that indicates that the backup was
successful (or partially successful) the archive bits are
cleared. The clear archive bit lets the next differential
incremental backup back up only the files that changed since
the previous full or differential incremental backup.

Differential Incremental
Backup

NetBackup backs up the files that have the archive bit set.
However, NetBackup does not clear the archive bits after the
backup. Without a clear archive bit, the next cumulative
incremental backup backs up changed files and the files that
were in the cumulative incremental backup.

Cumulative Incremental
Backup

If Perform incrementals based on archive bit is disabled, NetBackup includes a
file in an incremental backup only if the datetime stamp of the file has changed
since the last backup. The datetime stamp indicates when the file was last backed
up. The backup types use the datetime stamp differently.

NetBackup backs up files regardless of the datetime stamp.Full Backup

NetBackup compares the datetime stamp of the file against
the last full or incremental backup.

Differential Incremental
Backup

NetBackup compares the datetime stamp of the file against
the last full backup.

Cumulative Incremental
Backup

If files are installed or copied from another computer, the new files retain the datetime
stamp of the originals. If the original date is before the last backup date, the new
files are not backed up until the next full backup.

How NetBackup determines when UNIX files are due for
backup
Incremental backups on UNIX clients consider all files and directories to determine
if a backup is due based on a reference date. (That is, back up all the files that have
changed since date_x).

The following types of time are associated with UNIX files and directories:
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The file modification time. The file system updates the mtime for a file or
directory each time the file is modified. An application can save the mtime
of the file before it modifies it. The application then resets it with the
utime(2) system call.

mtime

The file access time. The file system updates the atime for a file or directory
each time the file is accessed (read or write). An application can save the
atime of the file before it accesses it. The application then resets it with the
utime(2) system call.

atime

The inode change time. The ctime for a file or directory is updated each
time the file or directory’s inode changes. (For example, changes due to
permissions, ownership, and link-counts changes.) The ctime for a file or
directory cannot be saved before a change, and then reset after a change.
The ctime of a file or a directory changes when the mtime and atime
(changes with the utime(2) system call) is reset.

ctime

When NetBackup reads the data for a file that is included in a backup, it does not
affect the file modification time. It does affect the access time of the file. For this
reason, NetBackup saves the atime and mtime of the file before it reads the file.
Then NetBackup resets the atime and mtime with the utime(2) system call.
NetBackup does not cause problems for storage migration products or the
administrator scripts that use file access times (atime) as criteria for their operations.
While this benefit is obvious, a side effect is that it does update the ctime of the
file.

Note:When NetBackup Accelerator is used to perform backups, NetBackup does
not reset the atime after the file is backed up. This avoids updating the ctime,
because a ctime update would require a loss in Accelerator optimization.

See “Accelerator notes and requirements” on page 767.

Customers can configure NetBackup so that it does not reset the access time of
the file after it reads a file. Customers can choose to have NetBackup use the ctime
and the mtime of the file to determine what files to include in an incremental backup.
Normally, these two options are used together, but there may be some sites that
want to use one without the other. By default, NetBackup uses only the mtime of
the file to determine what files and directories to back up.

When a file is moved from one location to another, the ctime of the file changes,
but the mtime remains unchanged. If NetBackup uses only the mtime to determine
the files that are due during an incremental backup, it does not detect these moved
files. For sites where using the mtime might create a problem, use the ctime to
determine files due to be included in an incremental backup. The ctime is used if
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the bp.conf file contains the USE_CTIME_FOR_INCREMENTALS and
DO_NOT_RESET_FILE_ACCESS_TIME entries.

See “USE_CTIME_FOR_INCREMENTALS option for NetBackup clients”
on page 394.

See “DO_NOT_RESET_FILE_ACCESS_TIME option for NetBackup clients”
on page 378.

When a directory is moved from one location to another, the ctime of the directory
changes, but the mtime remains unchanged. Neither the mtime nor the ctime are
changed for the files or directories within the moved directory. No reliable method
using file timestamps can determine that files within a moved directory need to be
included in an incremental backup.

In either case, these moved files and directories are included in subsequent full
backups.

Considerations for user schedules
In order for users to perform backups and archives, an administrator must create
a schedule that allows user backups.

User backup schedules and user archive schedules can be included in a policy that
contains automatic backup schedules. If you create separate policies for user
backups or user archives, the considerations are similar to those for automatic
backups. In user backup schedules, however, no backup selection list is necessary
because users select the objects before they start the backup or archive.

To use a specific policy or schedule for user backups or user archives, perform the
tasks that are specified for each client type:

Table 21-37 Tasks for specifying a policy or schedule for user backups or
user archives

TaskClient type

■ Start the Backup, Archive, and Restore client interface.
■ On the File menu, click NetBackup Client Properties
■ Select the Backups tab, and specify the backup policy and

backup schedule.

Microsoft Windows
clients

Specify the policy and schedule with BPARCHIVE_POLICY,
BPARCHIVE_SCHED, BPBACKUP_POLICY, or BPBACKUP_SCHED
options in the bp.conf file.

UNIX clients

Restores can be performed at any time and are not scheduled.
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Note: An archive is different from a backup. During an archive, NetBackup first
backs up the selected files, and then deletes the files from the local disk if the
backup is successful. In this topic, references to backups also apply to the backup
portion of archive operations unless otherwise noted.

How to plan schedules for user backups and user archives
To plan schedules for user backups and user archives, consider the following:

If possible, do not permit user backups and user archives when
automatic backups are running. If an automatic backup is running
when a user submits a backup or archive, NetBackup usually
queues the user job. The job is not queued if there is a limiting
setting. (For example, the Limit Jobs per Policy policy attribute
or the Maximum jobs per client Global Attributes host property.)

See “Limit jobs per policy (policy attribute)” on page 739.

See “Global Attributes properties” on page 136.

If the automatic backup continues to run, the user job may miss
the backup window depending on how the limiting settings are
configured. On the other hand, user jobs can delay automatic
backups and can cause backups to miss the backup window.

Automatic backups

Use a different storage unit to eliminate conflicts with automatic
backups.

Storage units

Use a different volume pool to manage the media separate from
the automatic backup media.

Volume pools

Consider setting the retention period for archives to infinite, since
the disk copy of the files is deleted.

See “Retention Periods with end dates beyond 2038, excluding
Infinity” on page 207.

Note: If the retention period expires for a backup, it can be difficult
or impossible to restore the archives or backups.

Retention periods

Synthetic backup (schedule attribute)
The Synthetic backup schedule attribute allows a backup to be assembled from
previous backups. A synthetic backup may be a synthetic full or a synthetic
cumulative incremental backup. The backups include one previous, traditional full
backup, and subsequent differential backups, and a cumulative incremental backup.
(A traditional full backup means a non-synthesized, full backup.) A client can then
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use the synthesized backup to restore files and directories in the same way that a
client restores from a traditional backup.

Synthetic backups can be written to tape, to disk storage units, or to a combination
of both.

See “About synthetic backups” on page 904.

Accelerator forced rescan option (schedule attribute)
The policy Schedules tab contains an option called Accelerator forced rescan.
This option creates a checksum of the content of each file during backup. It uses
the checksums for change detection. It provides a safety net by establishing a new
baseline for the next Accelerator backup.

Note: The following information is only applicable to Files and Folder (Unix/Windows)
backups and NDMP backups. The Accelerator forced rescan schedule is not
necessary for other backup types such as VMware and Hyper-V.

The Accelerator forced rescan option detects the following events:

■ The file’s data changes but the file’s metadata does not change.

■ The file's metadata becomes corrupted such that it does not indicate that the
file has changed.

■ Amalicious user or application changes the file's metadata such that it does not
indicate that the file has changed.

Note: If Accelerator forced rescan is enabled, NetBackup uses the Windows
change journal to help determine if a file has changed. NetBackup also examines
the file system metadata for each file to help detect which files have changed.

For the most efficient use of Accelerator, Accelerator policies must include at least
two full-backup schedules: one full schedule with the Accelerator forced rescan
option disabled, and another full schedule withAccelerator forced rescan enabled.
See Table 21-38.

Table 21-38 Required full-backup schedules for each Accelerator policy

Notes on schedule frequencyFull backup schedules

Configure this schedule to run most of your Accelerator full
backups.

First schedule:

Accelerator forced rescan
disabled
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Table 21-38 Required full-backup schedules for each Accelerator policy
(continued)

Notes on schedule frequencyFull backup schedules

Configure this schedule to run less often than the first
full-backup schedule.

For example: If the first full-backup schedule runs weekly,
run the second schedule (with theAccelerator forced rescan
option enabled) every few months. However, the best
frequency for this schedule depends upon your environment.

Note: If the policy has no schedule that enables the
Accelerator forced rescan option, all full backups
automatically enable that option and backup performance is
reduced.

Second schedule:

Accelerator forced rescan
enabled

Note the following about the Accelerator forced rescan option:

■ The Accelerator forced rescan option is grayed out if the Use Accelerator
option on the Attributes tab is not selected.

■ Because of the checksum processing on the client, this option reduces backup
speed as compared to the Use Accelerator option on its own. The speed
reduction depends on the client's configuration and its current processing load.
If the client is busy with many jobs when Accelerator backup begins, checksum
processing can reduce backup speed.

■ If the Windows volume is not NTFS or ReFS, and the volume has no full backup
schedule that is configured with the Accelerator forced rescan option, note:
NetBackup uses Accelerator forced rescan on every full backup. The
Accelerator forced rescan option is not enabled in the schedule but is in fact
used, as indicated in the NetBackup log messages. This option may reduce the
speed of the backup as compared to the previous backups that did not use
Accelerator forced rescan.
See Table 21-38 for recommended full-backup schedules.

■ For an MS-Windows or Standard policy (to back up files and folders), all the
data on the client is read. However, NetBackup sends only the changed data
over the network to be included in the backup image. Sending only the changed
data is similar to a regular Accelerator full backup. Thus, for an Accelerator
forced rescan backup, the optimization percentage is similar to a regular
Accelerator full backup. Note that the duration of the backup falls somewhere
between a non-Accelerator full backup and a regular Accelerator full backup.
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Calendar (schedule attribute)
Calendar-based schedules allow administrators to create a job schedule based on
a calendar view. Select Calendar to display the Include Dates tab.

See “Include Dates tab” on page 827.

A calendar-based relocation schedule determines the days that images are swept
from the disk staging storage unit to the final destination storage unit. (A relocation
schedule is created as part of a basic disk staging storage unit configuration.)

Enable Retries allowed after runday to have NetBackup attempt to complete the
schedule until the backup is successful. With this attribute enabled, the schedule
attempts to run, even after a specified run day has passed.

Frequency (schedule attribute)
Use the Frequency attribute to specify how much time must elapse between the
successful completion of a scheduled task and the next attempt.

For example, assume that a schedule is set up for a full backup with a frequency
of one week. If NetBackup successfully completes a full backup for all clients on
Monday, it does not attempt another backup for this schedule until the following
Monday.

To set the frequency, select a frequency value from the list. The frequency can be
seconds, minutes, hours, days, or weeks.

A frequency-based relocation schedule determines how often images are swept
from the basic disk staging storage unit to the final destination storage unit. (A
relocation schedule is created as part of a basic disk staging storage unit
configuration.)

NetBackup recognizes the intervals that suggest schedules based on days, even
if the job does not run daily. For example, if the frequency is 48 hours, NetBackup
tries to run the job at the same time every other day. (NetBackup checks if the
frequency is divisible by 24 hours.) If the interval is not divisible by 24, NetBackup
does not attempt to run the job at about the same time of day. Instead, NetBackup
tries to run the job at the indicated interval after the last successful backup. (For
example, 52 hours later.)

Note: Frequency does not apply to user schedules because the user can perform
a backup or archive whenever the time window is open.
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About backup frequency
To determine backup frequency, consider how often data changes. For example,
determine if files change several times a day, once a day, weekly, or monthly.

Typically, sites perform daily backups to preserve daily work. Daily backups ensure
that only one day’s work is lost in case of a disk failure. More frequent backups are
necessary when important data changesmany times during the day and the changes
would be difficult to reconstruct.

Daily backups are usually the incremental backups that record the changes since
the last incremental or full backup. Incremental backups conserve resources because
they use less storage and take less time to perform than full backups.

Full backups usually occur less frequently than incremental backups but should
occur often enough to avoid accumulating consecutive incremental backups. A
large number of incremental backups between full backups increases the time it
takes to restore a file. The time increases because of the effort that is required to
merge the incremental backups when files and directories upon restore.

Consider the following when setting the frequency for full backups:

■ Extend the time between full backups for the files that seldom change. A longer
frequency uses fewer system resources. It also does not significantly increase
recovery time because the incremental backups between full backups are
smaller.

■ Decrease the time between full backups for the files that change frequently. A
shorter frequency decreases restore time. A shorter time between full backups
can also use fewer resources. It reduces the cumulative effect of the longer
incremental backups that are necessary to keep up with frequent changes in
the files.

To achieve the most efficient use of resources, ensure that most of the files in a
given policy change at about the same rate. For example, assume that half of the
files in a policy selection list change frequently enough to require a full backup every
week. However, the remaining files seldom change and require monthly full backups
only. If all the files are in the same policy, full backups are performed weekly on all
the files. This wastes system resources because half the files need full backups
only once a month. A better approach is to divide the backups into two policies,
each with the appropriate backup schedule, or to use synthetic backups.

If more than one automatic schedule is due for a client within a policy, the backup
frequency determines the schedule that NetBackup uses as follows:

■ Jobs from the schedule with the lower frequency (longer period between backups)
always have higher priority. For example, a schedule that has a backup frequency
of onemonth takes priority over a schedule with a backup frequency of 2 weeks.

804Creating backup policies
Schedule Attributes tab



■ When two schedules are each due to run, the schedule with the schedule name
that is first in alphabetical order runs first. Alphabetical priority occurs if both of
the following are true:

■ Each schedule is within the defined time window.

■ Each schedule is configured with the same frequency value.

NetBackup prioritizes the example schedules in the following order:

Table 21-39 Examples of schedule frequency and priority

PriorityFrequencySchedule Name

FirstOne monthmonthly_full

SecondOne weekweekly_full

ThirdOne daydaily_incremental

Instant Recovery (schedule attribute)
The Instant Recovery attributes are available under the following conditions:

■ The Snapshot Client option is licensed and installed.
Refer to the NetBackup Snapshot Client Administrator’s Guide.

■ Perform snapshot backups is selected.

■ Retain snapshots for Instant Recovery is selected.

See “Snapshot Client and Replication Director (policy attributes)” on page 787.

This attribute has two options.

The snapshot persists on the client volume with a backup
copy made to the storage unit on the media server.

Snapshots and copy
snapshots to a storage unit

The snapshot is not backed up to tape or to other storage.
NetBackup creates a snapshot on disk only. This option is
required for the NAS_Snapshot method.

The snapshot is created on the same device as the one that
contains the original data if it usesVxFS_Checkpointmethod
or is VxVM space optimized. In this case, another policy can
be used to back up the data to a separate device.

Transaction logs are not truncated at the end of the backup.

Snapshots only
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The Instant Recovery attributes are grayed out if the Policy storage option on
the Policy Attributes tab refers to a storage lifecycle policy. If that is the case, the
storage lifecycle policy configuration governs the Instant Recovery attributes.

However, the Override policy storage selection attribute on the Schedule
Attributes tab overrides the Policy storage option. If a storage unit is selected on
the Schedule Attributes tab, the Instant Recovery attributes become enabled.

See “Policy storage (policy attribute)” on page 731.

See “Override policy storage (schedule attribute)” on page 810.

Multiple copies (schedule attribute)
When the Multiple copies attribute is enabled, NetBackup can create up to four
copies of a backup simultaneously. The storage units must be on the same media
server with sufficient resources available for each copy. For example, to create four
copies simultaneously in a Media Manager storage unit, the unit needs four tape
drives. (This option is sometimes referred to as Inline Copy, Inline Tape Copy, or
ITC.)

To create more than four copies, additional copies can be created at a later time
using duplication.

If multiple original images are created simultaneously, the backup time that is
required may be longer than for one copy. Also, if both Media Manager and disk
storage units are specified, the duration of disk write operations match that of slower
removable media write operations.

About configuring multiple copies
To create multiple copies, the following criteria must be met:

■ The backup destinations must share the same media server with sufficient
resources available for each copy.

■ The storage units that are used for multiple copies must be configured to allow
a sufficient number of concurrent jobs to support the concurrent copies. The
pertinent storage unit settings are Maximum concurrent jobs and Maximum
concurrent write drives.
See “Maximum concurrent jobs storage unit setting” on page 608.
See “Maximum concurrent write drives storage unit setting” on page 607.

Multiple copy operations do not support the following:

■ Third-party copies

■ NDMP storage units

■ Storage units that use a QIC (quarter-inch cartridge) drive type
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■ Synthetic backups

■ Storage lifecycle policies
Storage lifecycle policies offer their own method to create multiple copies.
See “About writing multiple copies using a storage lifecycle policy” on page 699.

Configure Multiple Copies dialog box
The Configure Multiple Copies dialog box contains the following options:

Table 21-40 Configure Multiple Copies dialog box

DescriptionField

NetBackup can create up to four copies of a backup simultaneously. The storage units must
be on the same media server and there must be sufficient resources available for each copy.

To create more than 4 copies, create additional copies at a later time by using duplication.

Copies

Indicate the priority that the duplication job (based on this schedule) has over other jobs in
the queue (0 to 99999).

Priority of duplication
job

Copy 1 is the primary copy. If Copy 1 fails for some reason, the first successful copy is the
primary copy.

See “Promoting a copy to a primary copy” on page 1018.

Primary copy

Specify the storage unit where each copy is to be stored. If a Media Manager storage unit
has multiple drives, you can use it for both the source and the destination. To let NetBackup
decide at run-time, select Any Available.

Storage unit

Indicate where each copy is to be stored.Volume pool

Specify how long NetBackup retains the backups.

See “Retention (schedule attribute)” on page 812.

Retention schedule

In the event that the copy does not complete, select whether you want the entire job to fail
(fail all copies), or whether you want the remaining copies to continue.

Regardless of how the fail or continue flag is set, all the copy jobs wait in the queue until
resources are available for all copies. The first job does not start until the copies have
resources.

If a copy is configured to allow other copies to continue the job if the copy fails, and if
Checkpoint restart for backup jobs is selected for this policy, only the last failed copy that
contains a checkpoint can be resumed.

See “Take checkpoints every __ minutes (policy attribute)” on page 736.

If this copy fails
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Table 21-40 Configure Multiple Copies dialog box (continued)

DescriptionField

Select who should own the media onto which NetBackup writes the images.

The following options are available:

■ Any
Lets NetBackup select the media owner, either a media server or server group.

■ None
Specifies that the media server that writes to the media that owns the media. No media
server is specified explicitly, but you want a media server to own the media.

■ A server group
Specify a media server group to allow only those media servers in the group to write to
the media on which backup images for this policy are written. All media server groups
that are configured in the NetBackup environment appear in the drop-down list.
See “Creating or deleting a NetBackup server group” on page 400.

Media owner

Configuring multiple copies in a policy schedule
To configure a policy schedule to create multiple copies, use the following procedure.

To configure a schedule to create multiple copies

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Do one of the following:

■ Select the policy to change.
■ On the Edit menu, click Change.

To change an existing policy

■ On the Actions menu, click New > Policy.
■ Name the policy, and click OK.

To create a new policy

3 Select the Schedules tab.

4 Double-click an existing schedule or click New to create a new schedule.

5 In the dialog box that appears, click in the Attributes tab, select Multiple
copies, and then click Configure.

If the destination for this policy is a storage lifecycle policy, theMultiple copies
box is unchecked. NetBackup does not allow the two methods for creating
multiple copies to be enabled at the same time.

See “Policy storage (policy attribute)” on page 731.

See “About writing multiple copies using a storage lifecycle policy” on page 699.
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6 In the Copies field, specify the number of copies to be created simultaneously.
The number must be between 1 and 4.

Copy 1 is the primary copy. If Copy 1 fails, the first successful copy is the
primary copy.

Usually, NetBackup restores from the primary copy of an image. However, it
is possible to restore from a specific backup copy other than the primary copy.
To do so, use the bprestore command.

To create more than four copies, create additional copies at a later time by
using duplication.

See “Configure Multiple Copies dialog box” on page 807.

See “About configuring multiple copies” on page 806.

7 In the Priority of duplication field, specify the priority of the duplication job in
comparison to the other jobs in the queue (0 to 99999).

8 Specify the storage unit where each copy is stored. Select Any Available to
allow NetBackup to select the storage unit at run-time.

If a Media Manager storage unit contains multiple drives, the storage unit can
be used for both the original image and the copies.

9 Specify the volume pool where each copy is stored.

10 Select the retention level for each copy.

See “Retention (schedule attribute)” on page 812.
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11 Select one of the following from the If this copy fails list:

Continues making the remaining copies.

Note: If Take checkpoints every __ minutes is selected
for this policy, only the last failed copy that contains a
checkpoint can be resumed.

See “Take checkpoints every __ minutes (policy attribute)”
on page 736.

continue

Fails the entire job.fail all copies

12 For tape media, specify who should own the media onto which NetBackup
writes the images:

NetBackup selects the media owner, either a media server or
server group.

Any

Specifies that the media server that writes to the media owns the
media. No media server is specified explicitly, but you want a
media server to own the media.

None

Specifies that a media server group allows only those media
servers in the group to write to the media on which backup images
for this policy are written. All the media server groups that are
configured in the NetBackup environment appear in the list.

A server group

These settings do not affect images residing on disk. One media server does
not own the images that reside on shared disks. Any media server with access
to the shared pool of disk can access the images.

13 Click OK until the policy is saved.

Override policy storage (schedule attribute)
The Override policy storage selection attribute works as follows:

Instructs the schedule to use the Policy storage as specified on the
policy Attributes tab.

Disabled

Instructs the schedule to override the Policy storage as specified on
the policy Attributes tab.

Select the storage from the list of previously configured storage units
and storage lifecycle policies. If the list is empty, no storage has been
configured.

Enabled
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See “Policy storage (policy attribute)” on page 731.

If a data classification is indicated for the policy, only those storage lifecycles with
the same data classification appear in the list.

See “Data classifications (policy attribute)” on page 731.

Note: Storage lifecycle policies cannot be selected within the Configure Multiple
Copies dialog box.

See “About configuring multiple copies” on page 806.

Override policy volume pool (schedule attribute)
The Override policy volume pool attribute works as follows:

Instructs the schedule to override the volume pool that is specified as
the Policy volume pool on the policyAttribute tab. If no policy volume
pool is specified, NetBackup uses NetBackup as the default. If the policy
is for a NetBackup catalog, NBU-Catalog policies useCatalogBackup.

Disabled

Instructs the schedule to override the volume pool that is specified as
the Policy volume pool on the policy Attribute tab. Select the volume
pool from the list of previously configured volume pools.

Enabled

See “Policy volume pool (policy attribute)” on page 734.

Override media owner (schedule attribute)
TheOverridemedia owner attribute applies only to tapemedia. It specifies whether
to use the policy media owner or another owner for the schedule. The rules for
shared disk media are more flexible so override settings are not needed for disk
media.

The attribute works as follows:

Instructs the schedule to use the media owner that is specified as the
Media Owner in the policy Attribute tab.

Disabled
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Instructs the schedule to override the media owner that is specified as
the Media Owner in the policy Attribute tab.

Select the new media owner from the list:

■ Any.
NetBackup selects the media owner, either a media server or server
group

■ None
Specifies that the media server that writes to the media owns the
media. No media server is specified explicitly, but you want a media
server to own the media.

■ A server group
Specifies that a media server group allows only those media servers
in the group to write to the media on which backup images for this
policy are written. All media server groups that are configured in the
NetBackup environment appear in the list.

Enabled

See “Media Owner (policy attribute)” on page 742.

Retention (schedule attribute)
The Retention attribute specifies how long NetBackup retains the backups. To set
the retention period, select a time period (or level) from the list. When the retention
period expires, NetBackup deletes information about the expired backup. After the
backup expires, the files in the backup are unavailable for restores. For example,
if the retention is 2 weeks, data can be restored from a backup that this schedule
performs for only 2 weeks after the backup.

If a policy is configured to back up to a storage lifecycle policy, the Retention
attribute in the schedule is ignored. The retention period that the lifecycle indicates
is followed instead.

See “Creating a storage lifecycle policy” on page 646.

See “Retention Periods properties” on page 203.

About assigning retention periods
The retention period for data depends on the likelihood of restoring information from
media after a certain period of time. Some types of data (financial records, for
example) have legal requirements that determine the retention level. Other data
(preliminary documents, for example) can probably be expired when the final version
is complete.

A backup’s retention also depends on what needs to be recovered from the backup.
For example, if day-to-day changes are critical, keep all the incremental backups

812Creating backup policies
Schedule Attributes tab



in addition to the full backups for as long as the data is needed. If incremental
backups only track work in progress toward monthly reports, expire the incremental
backups sooner. Rely on the full backups for long-term recovery.

Establish some guidelines that apply to most of the data to determine retention
periods. Note the files or the directories that have retention requirements outside
of these guidelines. Plan to create separate policies for the data that falls outside
of the retention requirement guidelines. For example, place the files and directories
with longer retention requirements in a separate policy. Schedule longer retention
times for the separate policies without keeping all policies for the longer retention
period.

The following table describes recommended retention periods for different types of
backups.

Table 21-41 Recommended retention periods for different types of backups

DescriptionType of backup

Specify a time period that is longer than the frequency setting
for the schedule. (The frequency is how often the backup
runs). For example, if the frequency is one week, specify a
retention period of 2-4 weeks. Two to 4 weeks provides
enough of a margin to ensure that the current full backup
does not expire before the next full backup occurs.

Full Backup

Specify a time period that is longer than the period between
full backups. For example, if full backups occur weekly, save
the incremental backups for 2 weeks.

Differential Incremental
Backup

Specify a time period that is longer than the frequency setting
for the schedule. (The frequency is how often the backup
runs). For example, if the frequency setting is one day, specify
a retention period of one week. One week provides enough
of a margin to ensure that the current cumulative-incremental
backup does not expire before the next successful one
occurs. A complete restore requires the previous full backup
plus the most recent cumulative-incremental backup.

Cumulative Incremental
Backup

The following table suggests several ways that you can prevent backups from
expiring earlier than desired.
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Table 21-42 Suggestions for preventing prematurely expired backups

DescriptionItem

Assign an adequate retention period. NetBackup does not
track backups after the retention period expires. Recovering
files is difficult or impossible after the retention period expires.

For the backups that must be kept for more than one year,
set the retention period to infinite.

Retention period

Assign a longer retention period to full backups than to
incremental backups within a policy. A complete restore
requires the previous full backup plus all subsequent
incremental backups. It may not be possible to restore all the
files if the full backup expires before the incremental backups.

Full backups and incremental
backups

Set the retention period to infinite.Archive schedules

Set the retention period to infinite. If infinite is unacceptable
because of NetBackup database space limitations, set the
retention period to match the length of time that the data is
to be retained.

Tape

Another consideration for data retention is off-site storage of the backup media.
Off-site storage protects against the disasters that may occur at the primary site.

Consider the following off-site storage methods as precautions for disaster recovery:

■ Use the duplication feature to make a second copy for off-site storage.

■ Send monthly or weekly full backups to an off-site storage facility.
To restore the data, request the media from the facility. To restore a total directory
or disk with incremental backups requires the last full backup plus all incremental
backups.

■ Configure an extra set of schedules to create the backups to use as duplicates
for off-site storage.

Regardless of the method that is used for off-site storage, ensure that adequate
retention periods are configured. Use the NetBackup import feature to retrieve
expired backups.

By default, NetBackup stores each backup on a tape volume that contains existing
backups at the same retention level. If a backup has a retention level of 2, NetBackup
stores it on a tape volume with other backups at retention level 2. When NetBackup
encounters a backup with a different retention level, it switches to an appropriate
volume. Because tape volumes remain assigned to NetBackup until all the backups
on the tape expire, this approach results in more efficient use of media. One small
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backup with an infinite retention prevents a volume from being reused, even if all
other backups on the volume expired.

To mix retention levels on volumes, select Allow multiple retentions per media
in the Media host properties.

If you keep only one retention level on each volume, do not use any more retention
levels than necessary. Multiple retention levels increase the number of required
volumes.

See “Media properties” on page 163.

Note: Retention levels can be mixed on disk volumes with no restrictions.

See “Changing a retention period” on page 205.

Media multiplexing (schedule attribute)
The Media multiplexing attribute specifies the maximum number of jobs from the
schedule that NetBackup can multiplex onto any one drive. Multiplexing sends
concurrent backup jobs from one or several clients to a single drive and multiplexes
the backups onto the media.

Specify a number from 1 through 32, where 1 specifies nomultiplexing. Any changes
take effect the next time a schedule runs.

Note: Some policy types and some schedule types do not support media
multiplexing. The option cannot be selected in those instances.

Caution: For MS-SQL-Server policies, do not enable multiplexing for a schedule
that is also configured to backup with multiple stripes. Restores fail whenmultiplexing
is enabled for a schedule that uses more than one stripe.

To configure multiplexed backups, multiplexing must be indicated in both the storage
unit (MaximumStreams Per Drive setting) and the schedule (Media Multiplexing
setting) configuration. Regardless of theMedia multiplexing setting, the maximum
jobs that NetBackup starts never exceeds theMaximum Streams Per Drive value
for the storage unit.

NetBackup multiplexing sends concurrent backups from one or several clients to
a single storage device. NetBackup multiplexes the backups sequentially onto the
media. Multiplexed and unmultiplexed backups can reside on the same volume.
Separate volume pools or media IDs are not necessary.
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Figure 21-12 shows the multiplexed flow of client data to a server.

Figure 21-12 Multiplexed backups

Clients

Server

Removable media or
magnetic disk

Disk

Disk

Disk

About multiplexing
Multiplexing is generally used to reduce the amount of time that is required to
complete backups. The following table describes circumstances where performance
improves by using multiplexing:

Table 21-43 Circumstances where multiplexing improves performance

DescriptionItem

Instances in which NetBackup uses software compression,
which normally reduces client performance, are also
improved.

Slow clients

The parallel data streams take advantage of whatever
network capacity is available.

Multiple slow networks

In addition to providing parallel data streams, multiplexing
reduces the time each job waits for a device to become
available. Therefore, the storage device transfer rate is
maximized.

Many short backups (for
example, incremental
backups)

No special action is required to restore a multiplexed backup. NetBackup finds the
media and restores the requested backup. Multiplexing reduces performance on
restores because it uses extra time to read the images.

To reduce the effect of multiplexing on restore times, set the storage unit maximum
fragment size to a value smaller than the largest allowed value. Also, on UNIX,
enable fast-tape positioning (locate block), if it applies to the tape drives in use.
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Consider the following configuration settings when using multiplexing.

Table 21-44 Properties and attributes that affect multiplexing

Where to find itDescriptionItem

■ In the NetBackup Administration
Console, expand NetBackup
Management > Policies.

■ In the middle pane, double-click the
Attributes node of a policy.
Or, create a new policy and select the
Attributes tab.

Limits the number of jobs that NetBackup
performs concurrently when a policy is run.
Set this attribute high enough to support the
specified level of multiplexing.

See “Limit jobs per policy (policy attribute)”
on page 739.

Limit jobs per policy
(policy attribute)
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Table 21-44 Properties and attributes that affect multiplexing (continued)

Where to find itDescriptionItem

■ In the NetBackup Administration
Console, expand NetBackup
Management >Host Properties >Master
Servers.

■ In the right pane, double-click a master
server.

■ In the Master Server Properties dialog
box, selectGlobal Attributes from the left
pane.

■ The property appears in the right pane.

Limits the number of backup jobs that can run
concurrently on any NetBackup client. This
property is part of Global Attributes host
properties.

See “Global Attributes properties” on page 136.

Usually, the client setting does not affect
multiplexing. However, consider a case where
jobs from different schedules on the same
client go to the same storage unit. In this case,
the maximum number of jobs that are
permitted on the client is reached before the
multiplexing limit is reached for the storage
unit. When the maximum number of jobs on
the client is reached, NetBackup cannot use
the storage unit’s full multiplexing capabilities.

Select a value that is based on the ability of
the central processing unit to handle parallel
jobs. Because extra buffers are required,
memory is also important. If the server cannot
perform other tasks or runs out of memory or
processes, reduce the Maximum streams
per drive setting for the storage unit.

To estimate the potential load that multiplexing
can place on the central processing unit,
consider the following limits:

■ The maximum concurrent jobs that
NetBackup can attempt equals the sum of
the concurrent backup jobs that can run
on all storage units.

■ The maximum concurrent jobs that can
run on a storage unit equals the value of
Maximum streams per drive, multiplied
by the number of drives.

See “Maximum streams per drive storage unit
setting” on page 610.

Maximum jobs per
client (host property)

818Creating backup policies
Schedule Attributes tab



Table 21-44 Properties and attributes that affect multiplexing (continued)

Where to find itDescriptionItem

■ In the NetBackup Administration
Console, expand NetBackup
Management >Host Properties >Master
Servers.

■ In the right pane, double-click a master
server.

■ In the Master Server Properties dialog
box, select Client Attributes from the left
pane.

■ The property appears in the right pane on
the General tab.

Set the maximum number of jobs that are
allowed on a specific client without affecting
other clients. This property is part of Client
Attributes host properties.

See “General tab of the Client Attributes
properties” on page 71.

Maximum data
streams (host
property)

■ In the NetBackup Administration
Console, expand NetBackup
Management >Host Properties >Master
Servers.

■ In the right pane, double-click a master
server.

■ In the Master Server Properties dialog
box, select General Server from the left
pane.

■ The property appears in the right pane.

Specifies how long the server waits for
additional restore requests of files and raw
partitions in a set of multiplexed images on
the same tape. This property is part of
General Server host properties.

See “General tab of the Client Attributes
properties” on page 71.

Delay on multiplexed
restores (host
property)

■ In the NetBackup Administration
Console, expand NetBackup
Management > Policies.

■ In the middle pane, double-click the
Schedules node of a policy.
Or, create a new policy and select the
Schedules tab.

■ Click New to create a new schedule and
configure the Media Multiplexing option.

If the limit is reached for a drive, NetBackup
sends jobs to other drives.

When NetBackup multiplexes jobs, it
continues to add jobs to a drive until the
number of jobs on the drive matches the
Media Multiplexing limit or the Maximum
streams per drive limit.

See “Media multiplexing (schedule attribute)”
on page 815.

Media Multiplexing
(policy schedule
attribute)
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Table 21-44 Properties and attributes that affect multiplexing (continued)

Where to find itDescriptionItem

■ In the NetBackup Administration
Console, expand NetBackup
Management > Storage.

■ In the left pane, click Storage Units.
■ In the right pane, double-click a storage

unit name.
Or, create a new storage unit.

■ The setting appears on the dialog box that
appears.

NetBackup can add jobs from more than one
schedule to a drive.

When NetBackup multiplexes jobs, it
continues to add jobs to a drive until the
number of jobs on the drive matches the
Maximum streams per drive limit or the
Media Multiplexing limit.

See “Maximum streams per drive storage unit
setting” on page 610.

Maximum streams
per drive (storage unit
setting)

See “MPX_RESTORE_DELAY option for NetBackup servers” on page 315.

Example of using multiplexing with schedules
Figure 21-13 provides an example of how schedules are affected when multiplexing
is active.

Figure 21-13 Multiplexing process scenario
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A gray number denotes an event that is completing.

Assume the following about Figure 21-13.

■ Schedule A begins first.
Schedules can be in the same or in different policies.
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■ Allow Multiple Data Streams is enabled.
Consequently, a client can have multiple data streams.
See “Allow multiple data streams (policy attribute)” on page 758.

Table 21-45 Description of the multiplexing process scenario

DescriptionEvent

■ Jobs A1 and A2 from client DOG start on Drive 1.
■ For Schedule A, the Media Multiplexing limit of 2 is reached for

Drive 1.

1 and 2

■ Jobs A3 and A4 from client CAT start on Drive 2.
■ For Schedule A, the Media Multiplexing limit of 2 is reached for

Drive 2.

3 and 4

■ Jobs B1 and B2 for client FOX start on Drive 1.
■ The Maximum streams per drive storage unit setting is reached

for Drive 1.

5 and 6

■ Jobs B3 and B4 from client OTTER start on Drive 2.
■ All jobs are now running for Schedule B.
■ The Maximum streams per drive storage unit setting is reached

for Drive 2.

7 and 8

■ Jobs A1 and A2 from client DOG finish on Drive 1.
■ However, jobs B1 and B2 for client FOX continue to run.
■ For Schedule A, the Media Multiplexing limit of 2 prevents job A5

from starting on Drive 1

9 and 10

■ Job A3 from client CAT finishes on Drive 2
■ Job B1 from client FOX finishes on Drive 1.
■ Job B2 is the only job currently running on Drive 1.

11 and 12

■ Job A5 from client CAT starts on Drive 1.
■ JobA5 is the last job for Schedule A.
■ For Schedule A, the Media Multiplexing limit of 2 prevents job A5

from starting on Drive 2.
■ Therefore, job A5 starts on Drive 1.

13

NetBackup attempts to addmultiplexed jobs to drives that already use multiplexing.
If multiplexed jobs are confined to specific drives, other drives are available for
non-multiplexed jobs.

If the backup window closes before NetBackup can start all the jobs in a multiplexing
set, NetBackup completes only the jobs that have started.
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For example, Figure 21-13 assumes that the Activity Monitor shows jobs A1
through A5 as queued and active.

If only jobs A1 and A2 start before the window closes, NetBackup does not perform
the other jobs that are in the set. If the window closes before any jobs start, only
the first queued and active job starts and completes. In this example: Job A1.

See “MPX_RESTORE_DELAY option for NetBackup servers” on page 315.

About demultiplexing
Demultiplexing speeds up future restores and is useful for creating a copy for off-site
storage. Use the duplication process in the Catalog utility to demultiplex a backup.

Duplication allows onemultiplexed backup at one time to be copied from the source
media to the target media. When duplication is complete, the target contains a
single demultiplexed copy of each duplicated backup. (The target can also contain
other backups.) The duplicate copy can be made into the primary copy. Do not
select Preserve Multiplexing in the Configure Multiple Copies dialog box when
backups are duplicated.

Note: If you use the bpduplicate command instead of the NetBackup
Administration Console, do not include the -mpx option on that command.

See “Duplicating backup images” on page 1020.

Start Window tab
The Start Window tab provides controls for setting time periods during which
NetBackup can start jobs when using a schedule. Time periods are referred to as
windows. Configure windows so that they satisfy the requirements necessary to
complete a job.

For example, create different windows:

■ One for the backups that open each day for a specific amount of time

■ Another for the backups that keep the window open all week

Adding, changing, or deleting a time window in a policy schedule
Use one of the following procedures to add, change, or delete a time window.
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To add or change a time window in the NetBackup Administration Console

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Expand the policy name in the middle pane, and then select Schedules.

3 Do one of the following:

■ Click Actions > New > Schedule.
■ In the Add Schedule dialog box, enter the name of a

schedule.

To add a time window

In the right pane, double-click the schedule you want to
change. The Change Schedule dialog box appears.

To change a time
window

4 Click the Start Window tab.

5 To change the increments available for selecting start times or end times,
change the value in the Resolution field. You can choose 5, 10, 15, or 30
minutes. For example, a resolution of 10 minutes allows time window
adjustments by 10-minute increments.

6 To indicate the opening of the time window, do the following:

Click the day and time when you'd like the window to
start and drag it to the day and time when you'd like the
window to close.

Drag your cursor in the time
table

■ In the Start day field, select the first day that the
window opens.

■ In the Start time field, select the time that the
window opens.

Use the settings in the dialog
box
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Time window

Times of dayStart time

Current cursor position

7 To indicate the closing of the time window, do one of the following:

Click the day and time when you'd like the window to
start and drag it to the day and time when you'd like the
window to close.

Drag your cursor in the time
table

Enter a length of time in the Duration (days, hours,
minutes) fields.

Enter the duration of the time
window

■ Select a day in the End day list.
■ Select a time in the End time field.

Indicate the end of the time
window

Time windows show as bars in the schedule display.

Specify enough time to allow all clients in the policy to complete a backup.

Consider allowing extra time in the schedule in case the schedule starts late
due to factors outside of NetBackup. (Delays due to unavailable devices, for
example.) Otherwise, all backups may not have a chance to start.
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8 As necessary, do any of the following:

Deletes the selected time window.Click Delete.

Deletes all time windows from the schedule display.Click Clear.

Replicates the time window for the entire week.Click Duplicate.

Erases the last action.Click Undo.

9 Do one of the following:

To save the time window and leave the dialog box open.Click Add.

To save the time window and close the dialog box.Click OK.

Example of schedule duration
Figure 21-14 illustrates the effect of schedule duration on two full backup schedules.
The start time for Schedule B begins shortly after the end time for the previous
Schedule A. Both schedules have three clients with backups due.

Figure 21-14 Duration example
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Figure 21-14 illustrates the following points:

Client A3 starts within the Schedule A time window but doesn’t complete
until after the Schedule B start time. However, Client A3 runs to
completion even if the window closes while the backup is running. Client
B1, on Schedule B, begins as soon as Client A3 completes.

Point 1
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Schedule A does not leave enough time for all the clients on Schedule
B to be backed up. Consequently, Client B3 is unable to start because
the time window has closed. Client B3 must wait until the next time
NetBackup runs Schedule B.

Point2

Excluding days from a schedule
Use the Exclude Days tab to exclude specific days from a schedule for a backup
policy. If a day is excluded from a schedule, jobs do not run on that day. The tab
displays a calendar of three consecutive months. Use the lists at the top of the
calendar to change the first month or year displayed.

To exclude a day from a schedule

1 Use one or more methods to indicate the days to exclude:

■ Select the day(s) on the 3-month calendar that you want to exclude. Use
the drop-down lists at the top of the calendar to change the months or year.

■ To indicate Recurring Week Days:

■ Click Select All to select all of the days in every month for every year.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select a specific day to exclude for every
month.

■ Click the column head of a day of the week to exclude that day every
month.

■ Click the 1st, 2nd, 3rd, 4th, or Last row label to exclude that week every
month.

■ To indicate Recurring Days of the Month:

■ Click Select All to select all of the days in every month.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select that day to exclude each month.

■ Click Last Day to exclude the last day of every month.

■ To indicate Specific Dates:

■ Click New. Enter the month, day, and year in the Date Selection dialog
box. Click OK.
The date appears in the Specific Dates list.
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■ To delete a date, select the date in the list. Click Delete.

2 Add additional dates as necessary, and then click OK to save the changes.

Include Dates tab
The Include Dates tab appears in the Add New Schedule or Change Schedule
dialog box. For the tab to display, you must select the Calendar option as the
Schedule type on the Attributes tab. Calendar-based schedules provide several
run day options for determining when a task runs.

Figure 21-15 Calendar selection in the Policy Attributes tab

The Calendar attribute enables the Include Days tab

The tab displays a calendar of three consecutive months. Use the lists at the top
of the calendar to change the first month or year displayed.

Calendar scheduling with the Include Dates tab
Use theCalendar option in the policyAttributes tab to create a job schedule based
on a calendar view. The Include Dates tab lets administrators configure the
schedules that run according to specific days, on recurring week days, or on
recurring days of the month.
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Note: Using the calendar schedule, if a green checkmark does not appear on a
day, the day is not included in the schedule.

If Retries allowed after runday is enabled, a job could run on a day that is not
included in the schedule.

When a new calendar schedule is created with Retries allowed after runday
enabled, the schedule runs its first job on the next day when the backup window is
open. That day may be before the first run day that is included in the schedule.

To use a calendar to schedule run days

1 In the Attributes tab, enable the Calendar attribute.

2 Select the Include Dates tab.

3 Use one or more methods to schedule the days on which jobs can run:

■ Select the day(s) on the three-month calendar that you want jobs to run.
Use the drop-down lists at the top of the calendar to change the months or
year.

■ To indicate Recurring Week Days:

■ Click Select All to select all of the days in every month for every year.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select a specific day to include for every
month.

■ Click the column head of a day of the week to include that day every
month.

■ Click the 1st, 2nd, 3rd, 4th, or Last row label to include that week every
month.

■ To indicate Recurring Days of the Month:

■ Click Select All to select all of the days in every month.

■ Click Deselect All to remove all existing selections.

■ Check a box in the matrix to select that day to include each month.

■ Click Last Day to include the last day of every month.

■ To indicate Specific Dates:

■ Click New. Enter the month, day, and year in the Date Selection dialog
box. Click OK.
The date appears in the Specific Dates list.

828Creating backup policies
Include Dates tab



■ To delete a date, select the date in the list. Click Delete.

4 Add additional dates as necessary, and then click OK to save the included
days.

How NetBackup determines which schedule to
run next

When a policy contains one schedule, the schedule that is selected to run next is
straightforward. But when a policy contains multiple schedules, choosing which
schedule to run next can become more complicated.

NetBackup performs the following tasks to determine which schedule to run next:

■ NetBackup determines the due time for each schedule. The due time depends
on the following:

■ The last backup data for each schedule based on comparable schedules.

■ The frequency that is added to each schedule to determine which schedule
is due next.

■ NetBackup checks the start time for each schedule. The schedule with the
soonest start time runs next. That is, the schedule with the next open window.

Figure 21-16 Schedule selection overview

Find last backup data

For frequency-
based schedules,
add frequency

For calendar-
based schedules,
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When any of the following events occurs, NetBackup recalculates which schedule
to run next in a policy:

■ A backup job finishes.

■ A client backup image expires.
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■ The Policy Execution Manager (nbpem) starts.

■ The administrator changes the policy.
NetBackup looks for updated policies every 10 minutes. If the policy has recently
been updated, NetBackup waits an additional minute to be sure that changes
are not currently underway. You can change the frequency that NetBackup looks
for updates by changing the Policy Update Interval in the Global Attributes
host properties.
See “Global Attributes properties” on page 136.

The due time for each schedule equals the last backup data for the schedule, plus
the schedule’s frequency:

Due time = Last backup data + Frequency

Last backup data refers to the schedule that ran most recently among comparable
schedules. NetBackup uses the date and time of that schedule to determine the
due time for all the schedules that use that schedule as the last backup data.

In some cases, the last backup data for a schedule names the schedule itself. In
other cases, the last backup data for a schedule is another comparable schedule.

NetBackup makes the following comparisons to identify a comparable schedule:

Compared to other full schedules of the same or longer
frequency.

Full schedules

Compared to the following:

■ Full schedules of the same or longer frequency.
■ Other cumulative incremental schedules of the same or

longer frequency.

Cumulative incremental
schedules

Compared to the following:

■ Full schedules of the same or longer frequency.
■ Cumulative incremental schedules of the same or longer

frequency.
■ Other differential incremental schedules of the same or

longer frequency.

Note: To have a longer frequency means that the
schedule is configured to run less often.

Differential incremental
schedules

The comparison rules ensure that no schedule is overlooked for consideration,
potentially causing a gap in backup coverage.
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Figure 21-17 Schedule coverage
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The following jobs create additional complexities in scheduling:

Each stream is scheduled independently. The data may
change in the time between the streamed backups. Two
restores that are based on the same backup may not be
identical if created from different streams.

Multistreaming jobs

NetBackup uses the previous synthetic job as the basis for
determing when the next synthetic job should run.

Synthetic backup jobs

About schedule windows that span midnight
A backup window may begin in one day and end in another. If this kind of policy is
scheduled to run each day, NetBackup does not run the job again immediately after
midnight. Instead, even though the window spans into the next day, NetBackup
considers it to be one window. NetBackup recognizes that the administrator’s
intention is usually not to have a job run again so soon after the previous backup.

Figure 21-18 shows a window that spans midnight.
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If a policy is scheduled to run each day, NetBackup looks to see if another window
opens later in the day. If another window is set up to open later, NetBackup waits
and runs the job then.

Figure 21-18 Schedule that spans midnight

The first job begins Sunday.

The job is due Monday as well. Instead of running the job again
immediately after midnight, NetBackup looks for a window later in
the day and runs the job.

If no other window is scheduled to open later in the day, NetBackup does not wait.
If the job has a daily frequency, the job runs again after midnight to meet the daily
backup frequency requirement.

How open schedules affect calendar-based and
frequency-based schedules

A single backup window can span the entire week. This kind of schedule is called
an open schedule because a job may run at any time of day or night during the
week. Open schedules affect calendar-based and frequency-based schedules
differently.

Figure 21-19 shows an open schedule.
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Figure 21-19 An open schedule

Open schedules affect calendar-based and frequency-based schedules differently:

Calendar-based schedules run whenever the calendar
schedule indicates. NetBackup assumes that an environment
requires one backup on each day that is selected on the
calendar schedule. Given an open schedule, backups run
as soon after midnight as possible to satisfy the daily backup
requirement.

Calendar-based schedules

Frequency-based schedules run when the frequency setting
indicates. For example, with a frequency of one day,
NetBackup runs backups at 24-hour intervals based on the
start time.

Frequency-based schedules

Figure 21-20 shows that the backups on a calendar-based schedule would run
Monday through Friday.
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Figure 21-20 An open schedule that is calendar-based

Figure 21-21 and Figure 21-22 show that the backups based on a frequency-based
schedule should run every day of the week, including Saturday and Sunday.
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Figure 21-21 An open schedule that is frequency-based

In Figure 21-22, backups run at 10:00 P.M. nightly based on the start time.
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Figure 21-22 Example of a frequency-based schedule with an open schedule

Click on a window to see the
start time and end time of
each day.

The start time indicates
when backups can run.

The window has a duration
of 1 day. The window is
duplicated for each day, to
create an open schedule.

Creating an open schedule in the NetBackup Administration Console
The following procedure describes how to create an open schedule in an existing
policy. In this procedure, the open schedule is configured to begin at 10:00 P.M.

To create an open schedule in the NetBackup Administration Console

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 In the middle pane, double-click on the policy name where you want to create
an open schedule.

3 Select the Schedules tab.

4 Click New or Add to create a new schedule.

5 Complete the information on the Attributes tab.

6 Select the Start Window tab.

7 Select Sunday as the Modify Day and 10:00:00 PM as the Start time.
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8 Select Monday as the End Day and 10:00:00 PM as the End time. The
Duration is then automatically set to one day.

9 Click Duplicate to copy this window to each day of the week.

10 Click OK to add the schedule to the policy.

Runtime considerations that affect backup frequency
The following items may cause a NetBackup job to run more frequently than
expected, or may prevent a job from meeting its backup frequency requirement.

Table 21-46 Items that can affect backup frequency

DescriptionItem

If the administrator changes or activates a policy, the change prompts NetBackup to
run the job as soon as possible. It does not matter if the schedule is calendar-based
or frequency-based.

Changing a policy causes the
policy to run

Whether the schedule is calendar-based or frequency-based, a job cannot run if
windows are not open on the configured rundays.

■ For calendar-based schedules, windows must be open on the specific dates,
recurring weekdays, or recurring days of the month that the calendar schedule
indicates.

Note: A frequency is not configurable for a calendar-based schedule. For this
schedule type, NetBackup assumes a daily backup frequency.

■ For frequency-based schedules, a daily frequency requires that a window is open
each day.

Window availability

A Global Attribute host property setting determines how many times a failed job can
attempt to run. The Schedule backup attempts property includes the number of
attempts and the time period in which the attempts can take place.

By default, a failed job tries to run two times every 12 hours if an open window is
available. Note that this setting supersedes any other frequency requirement and can
cause a schedule to skip an open window.

For example, if a job meets the maximum number of job attempts, NetBackup does
not try to run the job again during the retry period indicated. It does not attempt, even
in an open window and a daily backup frequency has not been met that day.

See “Global Attributes properties” on page 136.

Backup attempt limit
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About the Clients tab
The Clients tab contains a list of clients to be backed up (or acted upon) by the
selected policy. A client must be included in the list of at least one backup policy
to be backed up.

Placing a client in more than one backup policy can be useful. For example, place
the client name in two policies to back up different sets of files on the client according
to different policy rules.

The Clients tab does not appear for Vault or Catalog policy types.

Adding, changing, or deleting clients in a policy
A client must be included in the list of at least one active backup policy to be backed
up. Use the following procedures to add, change, or delete clients in an existing
NetBackup policy.

To add, change, or delete a client in a policy

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Policies.

2 Open the policy that you want to change.

3 Select the Clients tab and perform one of the following actions:

Continue to step 4.To add a new client

Double-click on the client that you want to change or select
the client and click Change. The Change Client dialog box
appears.

Click OK to accept the change and close the Change Client
dialog box. Or, click Cancel to close the dialog box without
saving the changes.

To change an existing
client

Select a client and click Delete. Hold down Shift to select
multiple clients. A confirmation dialog box appears that lists
the clients to be deleted. Click Yes to delete the clients or No
to escape the dialog box.

To delete a client

4 To add a new client, click New. The Add Client dialog box appears.

In the Add Client dialog box, enter the host name that you want to add. Or
click the Browse for Computer button, select the host from the network tree,
and click OK.
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Note: TheBrowse for clients and theDetect client operating system options
are unavailable for a BigData policy type. To add a client using the BigData
policy, enter the name of the client, manually.

Observe the following rules for assigning client names:

■ Use a name by which the server knows the client (one that you can use on
the server to ping or telnet to the client).

Note: To add a client for a Nutanix Acropolis Cluster, enter the display
name of the virtual machine. The display name of a virtual machine is
case-sensitive.

To add a client for a Hadoop cluster, enter the Fully Qualified Domain Name
(FQDN) of the Hadoop cluster or namenode.

To add a client to backup universal share data, enter the host name of the
client where the universal share is mounted.

■ If the client is in multiple policies, use the same name in each policy.

■ If the network configuration has multiple domains, use a more qualified
name. For example, use client1.null.com or client1. null rather than
only client1.

■ Add only clients with the hardware and the operating systems that this policy
supports. For example, do not add a UNIX client to anMS-Windows policy.
If you add a client to more than one policy, designate the same hardware
and operating system in each of the policies.
If the hardware and the operating system you want is not in the list,
associated client software is not installed on the server. Check the
/usr/openv/netbackup/client directory for the directories and software
that corresponds to the client you want to install. If the directories or software

839Creating backup policies
About the Clients tab



are not there, rerun the installation script on the server and select the option
to install client software.

■ Do not use an IP address as a client name in a policy or the backup may
fail. Specify a host name instead.

5 You can either select the Detect client operating system check box or select
the appropriate hardware and operating system for the client in the drop-down
menu.

6 Perform one of the following:

■ Click Add to add the client to the list and leave the dialog box open to add
another client.

■ Click OK to add the client to the list and close the dialog box.

■ Click Cancel to close the dialog box without adding the client.

7 When you are finished in the Clients tab:

■ Click OK to close and save the policy.

■ Click Cancel to close the policy without saving any additions or changes.

Browse for Hyper-V virtual machines
On the Clients tab, click New to select virtual machines.

The following table describes the options that you can use to select Hyper-V virtual
machines.

Table 21-47 Options for selecting Hyper-V virtual machines

DescriptionOption

Note: The type of name to enter depends on the Primary VM identifier setting on
the Hyper-V tab of the policy.

Enter the host name, display name, or GUID of the virtual machine. The format of the
host name or display name depends on your system. It may be the fully qualified name
or another name, depending on your network configuration and how the name is defined
in the guest OS. If NetBackup cannot find the name or GUID you enter, the policy
validation fails.

Make sure the Browse for Virtual Machines option is unchecked.

Enter the VM display name
(or VM hostname or VM
GUID)
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Table 21-47 Options for selecting Hyper-V virtual machines (continued)

DescriptionOption

Click this option to discover Hyper-V servers or cluster nodes (shown in the left pane).
You can select virtual machines from a list (in the right pane).

The virtual machine names that are listed may be derived from a cache file. Use of the
cache file is faster than rediscovering the virtual machines on the network if your site
has a large number of virtual machines. If the virtual machine is turned off but was
turned on when the cache file was last created, its name appears in the list.

If the display name of the virtual machine was recently changed in the Hyper-VManager,
note: The virtual machine name that was used for the backup does not change.

If NetBackup cannot obtain the IP address of the virtual machine, the IP address is
displayed as NONE.

Browse for Virtual
Machines

To update the cache file and re-display virtual machines, click the refresh icon to the
right of the Last Update field. This field shows the date and time of the most recent
cache file that contains the names of virtual machines.

Last Update

Backup Selections tab
The Backup Selections tab contains a list of what to back up on each client, host,
or instance when NetBackup runs an automatic schedule (for example, a full
backup). The list does not apply to user backups or archives, where users select
the objects to back up before they start the operation.

The backup selections list can contain the following:

■ Paths that identify the location of files or directories

■ Directives, which signal NetBackup to perform specific, predefined actions when
it processes the selections list

■ Scripts or templates
Administrators create scripts to define and control database backups. Templates
are used exclusively for Oracle (legacy) and DB2 database backups.
See “Registering authorized locations used by a NetBackup database
script-based policy” on page 846.

■ Database objects

■ Wildcards
Certain wildcards can be used in the selections list.
See “Wildcard use in NetBackup” on page 1164.
Windows clients support only the asterisk (*) and the question mark (?) as valid
wildcards in the Backup Selections tab.
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For information on how to use wildcards when you configure backup selections
for database agents and other options, refer to the guide for that agent or option.

The list applies to each client (or host, instance, or database) in the policy. Every
file on the list does not need to exist on all of the clients. NetBackup backs up the
files that it finds that are on the backup selections list. However, each client must
contain at least one of the files in the backup selections list. Otherwise, the backup
fails with status code 71 (none of the files in the file list exist). Use the Troubleshooter
to find the description of a status code. See “Running the Troubleshooter”
on page 44.

The policy type determines what type of backup selections appear in the list. See
Table 21-48. See “Policy type (policy attribute)” on page 727.

Table 21-48 Items allowed in the Backup Selections list for specific policy
types

Items allowedPolicy type

Paths and directivesStandard

Paths and directives

See “Creating a BigData policy” on page 894.

BigData

Paths and directivesMS-Windows

Paths and directivesLotus-Notes, MS-Exchange-Server,
MS-SharePoint

For SQL Server Intelligent policies, you can
select the whole database, file groups, or
files. For legacy SQL Server policies, you add
batch files.

MS-SQL-Server

ScriptsInformix-On-BAR, SAP, Sybase

Scripts and templatesDB2

For Oracle Intelligent Policies, you select an
Oracle database object or other option like a
backup of the Fast Recovery Area (FRA). For
legacy Oracle policies, you add scripts or
templates.

Oracle

Vault commandsVault
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Adding backup selections to a policy
Use the following procedures to add backup selections to a NetBackup policy,
without opening up the tab view of the policy.

To add backup selections to a policy

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Policies.

2 Open the policy where you want to add a backup selection.

3 Select the Backup Selections tab and perform one of the following actions:

Click Browse to browse to a specific client to specify
the path to the directory that you want to backup up. Or
enter the pathname directly in the Pathname or
directive field.

The Browse button toggles to an Add button after a
selection is made. Click Add to add the path to the
selection list.

A path may contain up to 1023 characters.

See “Pathname rules for Windows client backups”
on page 852.

See “Pathname rules for UNIX client backups”
on page 859.

Entering a path to a directory

Select or enter a directive or a directive set in the
Pathname or Directive set drop-down menu.

Click Add to add the directive to the selection list.

See “About the directives on the Backup Selections list”
on page 867.

Selecting a directive set or
directive
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■ Select or enter a script or template in the Script or
template drop-down menu.
Templates are stored in a known location on the
master server and do not need to be installed on
each client in theClients list. Enter only the template
file name, without a path. For example:
weekly_full_backup.tpl

Scripts require that you specify the full path. Be sure
that the scripts that are listed are installed on each
of the clients that are specified on the Clients tab.

■ For Oracle policies, select a template set based on
an operation from the Template set list.

■ For Oracle polices or DB2 policies, select a template
from the Script or template list, or enter the name
of a template.
Example of an Oracle script on UNIX:
install_path/netbackup/ext/db_ext/oracle/samples/

rman/cold_database_backup.sh

Example of a DB2 script on UNIX:
/myscripts/db2_backup.sh

Click Add to add the script or template to the selection
list.

Selecting a script or template

You can select multiple directories and files for backup. The policy type
determines whether the backup selections list can contain paths, directives,
scripts, templates, or a combination.
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4 Click OK to add the selection list to the Backup Selections tab in the policy.

5 When you are finished in the Backup Selections tab:

■ Click OK to close and save the policy.

■ Click Cancel to close the policy without saving any additions or changes.

How to protect and manage NetBackup Appliance
Universal Share
You can protect your data on a universal share and NetBackup can then backup
the data and manage the backups.

For example, in NetBackup Appliance, the NFS exported path (universal share) is
/shares/EXPORTED. On the NFS client server, the mounted path of the universal
share is /mounted/MOUNTED.

Where /shares/EXPORTED is the network path of the universal share data and
/mounted/MOUNTED is the network path on the NFS client where the share is
mounted.

You then back up the data on the /mounted/MOUNTED universal share.

To protect NetBackup Appliance Universal Share

1 Create a universal share in NetBackup Appliance using the command line
interface or the user interface.

For more information about the universal share feature and the supported
appliance versions, refer to the NetBackup Appliance documentation.

http://www.veritas.com/docs/DOC5332

2 Mount the exported path of the universal share on the NFS client server.

3 Copy your application data to the universal share.

4 In NetBackup, create a Standard policy.

5 Select the Backup Selections tab and perform the following actions in the
order listed:

■ (Optional) Add the NEW_STREAM directive if you require multistream backup.
See “NEW_STREAM directive” on page 875.

■ Add the USHARE directive.

■ Add the mounted path on NFS client server and the exported path of the
universal share.

■ Enter the BACKUP X USING Y directive in the Backup Selections tab.
For example: BACKUP /mounted/MOUNTED USING /shares/EXPORTED
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For example, if the universal share mounted on a Windows system,
C:\mounted\MOUNTED, use the /C:/mounted/MOUNTED format for the
BACKUP path.

You can add multiple shares in a policy. If you want to group several shares
into one backup job, use the NEW_STREAM directive.
See “NEW_STREAM directive” on page 875.

6 Enter the host name of the client where the universal share is mounted.

7 Run the Standard policy.

After the backups are created you can manage the backups with NetBackup
features, such as restore, duplication, AIR, and so on.

You can instantly access the backups with NetBackup Instant Access APIs.

For information about NetBackup APIs, see the following website:

https://sort.veritas.com/documents

Select NetBackup and then the version at the bottom of the page.

Registering authorized locations used by a NetBackup
database script-based policy
During a backup, NetBackup checks for scripts in the default script location and
any authorized locations. The default, authorized script location for UNIX is
usr/openv/netbackup/ext/db_ext and for Windows is
install_path\netbackup\dbext. If the script is not in the default script location
or an authorized location, the policy job fails. You can move any script into the
default script location or any additional authorized location and NetBackup
recognizes the scripts. You need to update the policy with the script location if it
has changed. An authorized location can be a directory and NetBackup recognizes
any script within that directory. An authorized location can also be a full path to a
script if an entire directory does need to be authorized.

If the default script location does not work for your environment, use the following
procedure to enter one or more authorized locations for your scripts. Use
nbsetconfig to enter an authorized location where the scripts reside. You can also
use bpsetconfig, however this command is only available on the master or the
media server.

846Creating backup policies
Backup Selections tab

https://sort.veritas.com/documents


Note:One recommendation is that scripts should not be world-writable. NetBackup
does not allow scripts to run from network or remote locations. All scripts must be
stored and run locally. Any script that is created and saved in the NetBackup db_ext
(UNIX) or dbext (Windows) location needs to be protected during a NetBackup
uninstall.

For more information about registering authorized locations and scripts, review the
knowledge base article:

http://www.veritas.com/docs/000126002

To add an authorized location

1 Open a command prompt on the client.

2 Use nbsetconfig to enter values for an authorized location. The client privileged
user must run these commands.

The following examples are for paths you may configure for the Oracle agent.
Use the path that is appropriate for your agent.

■ On UNIX:

[root@client26 bin]# ./nbsetconfig

nbsetconfig>DB_SCRIPT_PATH = /Oracle/scripts

nbsetconfig>DB_SCRIPT_PATH = /db/Oracle/scripts/full_backup.sh

nbsetconfig>

<ctrl-D>

■ On Windows:

C:\Program Files\Veritas\NetBackup\bin>nbsetconfig

nbsetconfig> DB_SCRIPT_PATH=c:\db_scripts

nbsetconfig> DB_SCRIPT_PATH=e:\oracle\fullbackup\full_rman.sh

nbsetconfig>

<ctrl-Z>

Note: Review the NetBackup Command Reference Guide for options, such
as reading from a text file and remotely setting clients from a NetBackup server
using bpsetconfig. If you have a text file with the script location or authorized
locations listed, nbsetconfig or bpsetconfig can read from that text file. An
entry of DB_SCRIPT_PATH=none does not allow any script to execute on a client.
The none entry is useful if an administrator wants to completely lock down a
server from executing scripts.
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3 (Conditional) Perform these steps on any clustered database or agent node
that can perform the backup.

4 (Conditional) Update any policy if the script location was changed to the default
or authorized location.

Verifying the Backup Selections list
Verify the Backup Selections list to make sure that the file paths are correct for
the clients in the policy.

Table 21-49 Steps to verify the Backup Selections list

DescriptionActionStep

Do the following:

■ If the list includes directives, verify that the syntax for the directives is
correct.

■ Check all entries against the file path rules for the clients in the policy.

See “Pathname rules for Windows client backups” on page 852.

See “Pathname rules for Windows disk image (raw) backups” on page 854.

See “Pathname rules for Windows registry backups” on page 856.

See “Pathname rules for UNIX client backups” on page 859.

Path rules for the NetBackup clients that are running separately-priced options
are covered in the NetBackup guide for the product. (For example, Snapshot
Client or NetBackup for MS-Exchange.)

Check the syntax for the
directives and the file path
rules.

Step 1

Do the following:

■ Run a set of backups.
■ Check the Problems report or the All Log Entries report for warning

messages.

The backup status code does not always indicate errors on the Backup
Selection list. Because NetBackup does not require all paths in theBackup
Selections list to be present on all clients, an error may not be especially
helpful.

See “About the Reports utility” on page 1138.

Check for warningmessages.Step 2
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Table 21-49 Steps to verify the Backup Selections list (continued)

DescriptionActionStep

Run the check_coverage script to create a File SystemBackupCoverage
Report.

The script is located in install_path\NetBackup\bin\goodies (on
Windows) or in /usr/openv/netbackup/bin/goodies (on UNIX). The
script can reveal mistakes in the selections list that make it impossible for
NetBackup to find the files. Mistakes in the selections list can result in files
being skipped in the backup.

On Windows: If a path is not found, NetBackup logs a trivial (TRV) message
or a warning (WRN) message. However, the same job can end with a backup
status code of 0 (successful). Usually, to report files missing from the backup
selections list is not helpful because not all files are expected to be present
on every client. However, check the logs or use the check_coverage script
to ensure that files are not missed due to bad or missing backup selections
list entries.

See “Example log messages from the File System Backup Coverage Report
(check_coverage)” on page 849.

Create a File System
Backup Coverage Report.

Step 3

Example log messages from the File System Backup
Coverage Report (check_coverage)
The File System Backup Coverage Report is created by running the
check_coverage script. For information on check_coverage, see the comments in
the script.

On Windows: The following example shows the log message that appears when
files expected to be on a client are not found.

Assume that the backup selections list contains the path c:\worklist that is not
present on all clients. NetBackup backs up C:\worklist on the clients where it
exists.

For other clients, the Problems report or the All Log Entries report shows a
message similar to the following:

9/1/14 8:28:17 AM carrot freddie Info from client freddie: TRV

- object not found for file system backup: C:\worklist

This message occurs if c:\worklist is not the correct path name. For example,
the directory name is c:\worklists, but c:\worklist was typed.
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Note: If the paths seem correct and the message appears, ensure that no trailing
spaces appear in the paths.

On UNIX: The following table shows examples of the log messages that appear
when files expected to be on a client are not found.

Table 21-50 Example UNIX log messages from the File System Backup
Coverage Report

DescriptionExample

Assume that the backup selections list contains a regular expression:

/home1[0123456789]

NetBackup backs up /home10 through /home19 if both exist.

If they are not present, the Problems report or the All Log Entries report displays a
message similar to the following:

02/02/14 20:02:33 windows freddie from
client freddie: TRV -
Found no matching file system for
/home1[0123456789]

Regular expressions or
wildcards

Assume that the backup selections list contains a path named /worklist that is not
present on all clients. NetBackup backs up /worklist on the clients where it exists.

For other clients, the Problems report or theAll Log Entries report displays a message
similar to the following:

02/02/14 21:46:56 carrot freddie from
client freddie: TRV - cannot
process path /worklist: No such
file or directory. Skipping

This message occurs if /worklist is not the correct path name. For example, the
directory name is /worklists, but /worklist was typed.

Note: If the paths seem correct and the message continues to appear, ensure that
no trailing spaces appear in the paths.

Path not present on all clients
or wrong path specified
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Table 21-50 Example UNIX log messages from the File System Backup
Coverage Report (continued)

DescriptionExample

Assume the backup selections list names a symbolic link. NetBackup does not follow
symbolic links and provides a message in the Problems report or the All Log Entries
report:

02/02/14 21:46:47 carrot freddie from
client freddie: WRN - /src is only
being backed up as a symbolic link

Resolve the symbolic link if you do not intend to back up the symbolic link itself.

Symbolic link

How to reduce backup time
A client can be added to multiple policies, to divide the client’s files among the
different backup selections lists. Multiple policies can reduce the backup time for
that client because the files can be backed up in parallel.

Multiple clients can be backed up in parallel in the following situations:

■ Multiple storage devices are available (or if the policies are multiplexed).

■ Maximum jobs per client (in Global Attributes host properties) and the Limit
jobs per policy policy attribute are set to allow it.
See “Global Attributes properties” on page 136.
See “Limit jobs per policy (policy attribute)” on page 739.

Note:Understand disk and controller input and output limitations before configuring
including a client in multiple policies. For example, if two file systems overload the
client when backed up in parallel, place both file systems in the same policy.
Schedule the file systems at different times or set Maximum jobs per client to 1.

Another method to reduce backup time is to select Allow multiple data streams
for a policy, and then add NEW_STREAMS directives to the backup selections list.

For example:

NEW_STREAM

file_a

file_b

file_c

NEW_STREAM

file_d

851Creating backup policies
Backup Selections tab



file_e

file_f

The example produces two concurrent data streams. The first data string contains
file_a, file_b, and file_c. The second data stream contains file_d, file_e,
and file_f.

See “Allow multiple data streams (policy attribute)” on page 758.

Note: For best performance, use only one data stream to back up each physical
device on the client. Multiple concurrent streams from a single physical device can
cause longer backup times. The disk heads must move back and forth between
the tracks that contain files for the respective streams.

A directive instructs NetBackup to perform specific actions to process the files in
the backup selections list.

Pathname rules for Windows client backups
To back upWindows clients, use the following conventions for entries in the backup
selections list.

Table 21-51 Pathname rules for Windows client backups

DescriptionItem

Enter one path per line.Paths per line

Begin all paths with the drive letter followed by a colon (:) and a backslash (\).

To specify an entire volume, append a backslash (\) to the entry to ensure that all data is
protected on that volume:

Correct entry: c:\

Incorrect entry: c:

Colons and
backslashes

The drive letter and path are case-insensitive.

The following example entries would successfully indicate the same directory:

c:\Worklists\Admin\
C:\worklists\admin\
c:\WORKLISTS\Admin\
C:\Worklists\ADMIN\

Note: If a path is listed in the Backup Selections tab more than once, the data is backed
up more than once.

Case sensitivity
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Table 21-51 Pathname rules for Windows client backups (continued)

DescriptionItem

Asterisks (*) and question marks (?) are the only wildcard characters allowed in the backup
selection list for Windows clients.

Square brackets and curly brackets are not valid for Windows clients and can cause backups
to fail with a status 71.

For Windows clients, wildcards function correctly only when they are placed at the end of the
path, in the file or directory name. For example:

C:\abc\xyz\r*.doc

Wildcard characters do not work elsewhere in the path. For example, an asterisk functions
as a literal character (not as a wildcard) in the following examples:

C:\*\xyz\myfile

C:\abc\*\myfile

See “Wildcard use in NetBackup” on page 1164.

Wildcards

To back up all local drives except for those that use removable media, specify the following:

:\

Or
*:\

Or
ALL_LOCAL_DRIVES

The following drives are not backed up: floppy disks, CD-ROMs, and any drives that are
located on remote systems but mounted on a system through the network.

All local drives

Do not specify a local drive path that is mapped to a CIFS share using the Windows Map
Network Drive option.

This holds true for a policy that contains multiple clients as well. Do not specify paths that
point to different CIFS shares.

For example:

P:
Q:
R:

Use of mapped drives
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Table 21-51 Pathname rules for Windows client backups (continued)

DescriptionItem

If a backup policy contains multiple clients that specify a UNC path as a backup selection,
the redundant backup copies are created of the same data from different clients.

Consider including the host in a policy as a client to be backed up.

For example:

\\host_name\dir1

Use of UNC path(s)

By default, NetBackup does not back up some files.

See “Files that are excluded from backups by default” on page 880.

Exclude specific files from backups by creating an exclusion list on the client.

See “About excluding files from automatic backups” on page 881.

The following backup selection list uses Windows conventions:

c:\
d:\workfiles\
e:\Special\status
c:\tests\*.exe

Omitted or excluded
files

Pathname rules for Windows disk image (raw) backups
On Windows clients, you can back up a logical disk drive as a disk image. That is,
NetBackup backs up the entire logical drive on a bit-by-bit basis rather than by
directories and files. Use the Full backup backup type to perform a disk image
backup.
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Figure 21-23 Disk image backups

Must select Full backup as
backup type

Logical drive name in the
backup selection list

To specify a disk image backup, add the logical name for the drive to the policy
backup selection list. Disk images can be included in the same backup selection
list with other backups. In the following sample backup selection list, the first entry
(\\.\c:) creates a disk image backup of a logical drive C.

\\.\c:

d:\workfiles\

e:\Special\status

HKEY_LOCAL_MACHINE:\

To restore the backup, the user clicks Select for restore > Restore from Normal
backup.

When the backups are listed, the disk image appears as a file with the same name
that was specified in the backup selection list. For the previous example, the file
name would show as follows:

\\.\c:

When you enter the destination to restore the file, use the following format:
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\\.\drive:

Where drive is the location where the partition is to be restored.

Consider the following when working with disk image backups:

NetBackup first attempts to use Windows Open File Backup
methods. If that fails, NetBackup locks the logical drive, which
ensures that no changes occur during the backup. If there
are open files on the logical drive, a disk image backup is not
performed.

Windows Open File Backup
methods

Before a disk image is backed up or restored, all applications
that have a file opened on the partition should be shut down.
If the applications are not shut down, the operation fails.
Examples of such applications are Windows Explorer or
Norton AntiVirus.

Open files

Ensure that no active COW (Copy-On-Write) snapshots are
in progress. If there is an active COW snapshot, the snapshot
process itself has a handle open to the volume.

Copy-On-Write snapshots

NetBackup does not support raw partition backups on
unformatted partitions.

Raw partitions

If the volume is configured to contain a paging file
(pagefile.sys), a raw partition backup of that volumemay
fail. In order for a raw partition backup of that volume to
succeed, the volume may need to be reconfigured so as not
to contain a paging file. The raw partition backup of the
volume may work without reconfiguration if a snapshot can
successfully be taken of that volume.

Paging file

Pathname rules for Windows registry backups
The Windows registry can be backed up for disaster recover or individual HKEYs
can be backed up. Consider the following items when configuring aWindows registry
backup.
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To ensure a successful recovery in case of a disk failure, always
back up the entire registry. That is, back up the directory that
contains the entire registry.

On most Windows systems, this directory is located at:

%systemroot%\system32\config

Where %systemroot% is the directory whereWindows is installed.

Note: To recover the registry, do not include individual registry
files or HKEY entries in the selection list that’s used to back up the
entire registry. If you use a NetBackup exclude list for a client, do
not exclude any registry files from your backups.

To restore the registry in the case of a disk failure, see the disaster
recovery chapter in the NetBackup Troubleshooting Guide.

Disaster recovery

Do not back up individual HKEYs for disaster recovery. You cannot
perform a disaster recovery by restoring HKEYs. Do not include
HKEY entries in the same policy backup selection list that is used
to back up the entire registry. However, to restore individual keys
within the registry, create a separate policy, and then specify the
specific HKEYs in the backup selection list for that policy.

The following is an example HKEY entry for a policy backup
selection list:

HKEY_LOCAL_MACHINE:\

Backups and restores are slower than if the entire registry was
backed up.

Individual HKEYs

About hard links to files and directories
A hard link is a directory entry for a file. Every file can be considered to have at
least one hard link. A hard link differs from a symbolic link in that a hard link is not
a pointer to another file. A hard link is two directory entries that point to the same
inode number.

If the backup selection list includes hard-linked files, the data is backed up only
once during a backup. NetBackup uses the first file name reference that is found
in the directory structure. If a subsequent file name reference is found, it is backed
up as a link to the name of the first file. Backup up only the link means that only
one backup copy of the data is created, regardless of the number of hard links. Any
hard link to the data works.

On most UNIX systems, only the root user can create a hard link to a directory.
Some systems do not permit hard links, and many vendors recommend that these
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links be avoided. NetBackup does not back up and restore hard-linked directories
in the same manner as files.

Hard-linked files and hard-linked directories are different in the following ways:

■ During a backup, if NetBackup encounters hard-linked directories, the directories
are backed up once for each hard link.

■ During a restore, NetBackup restores multiple copies of the hard-linked directory
contents if the directories do not already exist on the disk. If the directories exist
on disk, NetBackup restores the contents multiple times to the same disk location.

On NTFS volumes or on UNIX systems, each file can have multiple hard links.
Therefore, a single file can appear in many directories (or even in the same directory
with different names). A volume serial number (VSN) and a File Index indicate the
actual, unique file on the volume. Collectively, the VSN and File Index are referred
to as the file ID.

During a backup, if the backup selection list includes hard-linked files, the data is
backed up only once. NetBackup uses the first file name reference that is found in
the directory structure. If a subsequent file name reference is found, the reference
is backed up as a link to the name of the first file. To back up subsequent references
means that only one backup copy of the data is created, regardless of the number
of multiple hard links.

If all hard-link references are restored, the hard-linked files continue to point to the
same ID as the other files to which they are linked. However, if all the hard links
are not restored, you can encounter anomalies as shown in the following examples.

Example 1: Restoring Link2 and Link3

Assume that three hard links point to the same data. During a backup of Link2 and
Link3, Link2 is encountered first and backed up. Then Link3 is backed up as a link
to Link2. The three files are all hard-linked to the same data.

Figure 21-24 Example of hard links to the same data

Data

Link1 Link2 Link3

The original copies of Link2 and Link3 are backed up to tape, and then deleted.
Only Link1 is left on the disk.
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Figure 21-25 Example of hard links backed up to tape and disk

On Disk On Tape

Data Data

Link1 Link2 Link3

During a subsequent restore, Link2 and Link3 are restored. The restored files,
however, do not point to the same file ID as Link1. Instead, they are assigned a
new file ID or inode number and the data is written to a new place on the disk. The
data in the new location is an exact copy of what is in Link1. The duplication occurs
because the backup does not associate Link2 and L3 with Link1.

Figure 21-26 Example of restored hard links

Data Data

Link1 Link2 Link3

Example 2: Restoring Link3

Assume that this time you attempt to restore only Link3. However, NetBackup
cannot link Link3 to Link2 because Link2 does not exist. The restore can complete
only if it can link to Link2. A secondary restore request to the NetBackup server
automatically restores Link2, which contains the data. Link2 can now be successfully
restored.

Pathname rules for UNIX client backups
To back up UNIX clients, use the following conventions for entries in the backup
selections list.

Table 21-52 Pathname rules for UNIX client backups

DescriptionItem

Enter one pathname per line. NetBackup supports a maximum path length of 1023
characters for UNIX clients.

Pathnames per line

Begin all pathnames with a forward slash (/).Forward slash

859Creating backup policies
Backup Selections tab



Table 21-52 Pathname rules for UNIX client backups (continued)

DescriptionItem

The following wildcard characters are allowed:

*
?
[ ]
{ }

For UNIX clients, wildcards can appear anywhere in the path.

See “Wildcard use in NetBackup” on page 1164.

Wildcard characters

If a backup selection list entry contains trailing spaces and a matching entry is not
found, NetBackup deletes the spaces and checks again. If a match is not found,
NetBackup skips the entry and logs a message in the Problems report or the All Log
Entries report:

TRV - cannot process path pathname: No such file or directory.

Skipping TRV - Found no matching file system for pathname

Trailing spaces

Pathnames that cross mount points or that the client mounts through NFS can affect
the backup configuration. Read about the Follow NFS and Cross mount points
attributes before you create a backup selection list.

See “Follow NFS (policy attribute)” on page 743.

See “Cross mount points (policy attribute)” on page 746.

Mount points

NetBackup can back up operating system, kernel, and boot files. However, NetBackup
cannot create bootable tapes. Consult your system documentation to create a bootable
tape.

Bootable tapes

By default, NetBackup does not back up all files.

See “Files that are excluded from backups by default” on page 880.

Exclude specific files from backups by creating an exclusion list on the client.

See “About excluding files from automatic backups” on page 881.

Omitted or excluded files

TheBusy File Settings host properties for UNIX clients offers alternatives for handling
busy and locked files.

See “Busy File Settings properties” on page 63.

Busy File Settings

NetBackup backs up Access Control Lists (ACLs), where supported.

See Veritas NetBackup Hardware Compatibility List (HCL).

Access Control Lists (ACLs)

NetBackup can back up and restore Sun PC NetLink files.Sun PC NetLink
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Table 21-52 Pathname rules for UNIX client backups (continued)

DescriptionItem

NetBackup backs up Extended attribute files and named data streams, where supported.

See Veritas NetBackup Hardware Compatibility List (HCL).

See “About backing up and restoring extended attribute files and named data streams”
on page 864.

Extended attribute files and
named data streams

On Hewlett-Packard and Solaris SPARC platforms, NetBackup backs up VxFS extent
attributes.

VxFS extent attributes

NetBackup backs up the symbolic link object and does not attempt to follow the link to
back up what it may point to. To achieve a backup of the target of the symbolic link,
include that target in the file list.

Restoring the symbolic link object restores only the object and not the data to which it
may point. To restore the target data, select it from the backup image.

See “About hard links to files and directories” on page 857.

Note: If NetBackup restores a symbolic link as root, NetBackup changes the owner
and group to the original owner and group. When NetBackup restores a symbolic link
as a non-root user, the owner and group are set to the owner and the group of the
person who performs the restore. Resetting the owner and group does not cause
problems. When the UNIX system checks permissions, NetBackup uses the owner
and group of the file to which the symbolic link points.

Symbolic links

NetBackup backs up the directory junction object and does not attempt to traverse into
the directory to which it may point. To achieve a backup of the target of the directory
junction, include that target in the file list.

Restoring the directory junction link object restores only the object and not the data to
which it may point. To restore the target data, select it from the backup image.

Directory junctions

See “About the Reports utility” on page 1138.

UNIX raw partitions
Save a copy of the partition table before a raw partition backup is performed. Retain
the copy for reference. To restore the raw partition, make sure that a device file
exists. Also, the partition where the table is restored must be large enough or the
results of the restore are unpredictable.

Consider the following items when creating UNIX raw partition backups.
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Use raw partition backups only if you can ensure that the files have
not changed in any way during the backup. Or, in the case of a
database, if you can restore the database to a consistent state by
using transaction log files.

File changes during the
backup

Do not perform backup archives of raw partitions on any client. An
archive backs up the raw partition, and then deletes the device file
that is associated with the raw partition. The file system does not
recover the space that the raw partition uses.

Backup archives

Before backing up file systems as raw partitions, unmount the file
system. Unmounting the file system allows buffered changes to be
written to the disk. Also, it prevents the possibility of any changes
in the file system during the backup. Use the bpstart_notify
and the bpend_notify scripts to unmount and remount the
backed-up file systems.

File systems

The Cross mount points policy attribute has no effect on raw
partitions. If the root partition is backed up as a raw partition and
contains mount points to other systems, the file systems are not
backed up. The other file systems are not backed up, even with
Cross mount points selected.

See “Cross mount points (policy attribute)” on page 746.

The same is true for the Follow NFS policy attribute. NFS file
systems that are mounted in a raw partition are not backed up. Nor
can you back up raw partitions from other computers by using NFS
mounts to access the raw partitions. The devices are not accessible
on other computers through NFS.

See “Follow NFS (policy attribute)” on page 743.

Mount points

Specify the logical partition names for any disks that disk volume
managersmanage. (For example, Veritas VolumeManager (VxVM).

Disk volume managers

For clients in a FlashBackup policy, refer to the NetBackup
Snapshot Client Administrator’s Guide for the differences between
Standard and FlashBackup policies.

FlashBackup policy

The use of FlashBackup in aWindows Server Failover Clustering
(WSFC) environment is supported, with the following limitation:
Raw partition restores can only be performed when the disk being
restored is placed in extended maintenance mode or removed from
the WSFC resource group.

Note: Early versions of WSFC do not allow extendedmaintenance
mode functionality. If the cluster does not support placing disks in
extended maintenance mode, it is still possible to perform raw
restores to an alternate, non-shared disk.

Windows Server
Failover Clustering
(WSFC) environment
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If there are no file systems to back up and the disks are used in raw mode, back
up the disk partitions as raw partitions. For example, databases are sometimes
used in raw mode. Use bpstart_notify and bpend_notify scripts to provide the
necessary pre-processing and post-processing of databases when they are backed
up as raw partitions.

You can also perform a raw partition backup of a disk partition that is used for file
systems. A disadvantage of this method is that you must restore the entire partition
to recover a single file (unless FlashBackup is in use). To avoid overwriting the
entire partition, use the redirected restore feature to restore the raw partition to
another raw partition of the same size. Then, copy individual files to the original file
system.

Raw partition backups are also useful for backing up entire disks. Since the file
system overhead is bypassed, a raw partition backup is usually faster. The size of
the raw partition backup is the size of the entire disk, regardless of whether the
entire disk is used.

To specify a UNIX raw partition in the policy backup selection list, enter the full path
name of the device file.

For example, on a Solaris system, enter:

/devices/sbus@1,f8000000/esp@0,800000/sd@2,0:1h

Note: Do not specify wildcards (such as /dev/rsd*) in pathnames for raw partition
backups. Doing so can prevent the successful restore of entire devices if there is
overlap between the memory partitions for different device files.

You can include raw partitions in the same backup selection list as other backups.
For example:

/home

/usr

/etc

/devices/sbus@1,f8000000/esp@0,800000/sd@2,0:1h

Note: NetBackup does not distinguish between full and incremental backups when
it backs up a raw partition. The entire partition is backed up in both cases.

Raw partition backups occur only if the absolute pathname in the backup selection
list is a block or character special device file. You can specify either block or
character special device files. Character special device files are often faster because
character devices avoid the use of the buffer cache for accessed disk data. Test
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both a block and character special device file to ensure the optimum backup speed
for your platform.

Ensure that you specify the actual block-device or character-device files. Sometimes
these are links to the actual device files. If a link is specified, only the link is backed
up. If the device files are reached while backing up /dev, NetBackup backs up only
the inode files for the device, not the device itself.

To perform a raw partition backup, select Full backup for the Type of Backup
from the Schedules tab. Any other backup type does not work for backing up raw
partitions.

See “Type of backup (schedule attribute)” on page 791.

About backing up and restoring extended attribute files
and named data streams
NetBackup can back up and restore the following file attributes:

■ Extended attribute files of the Solaris UNIX file system (UFS) and temporary
file system (tmpfs)

■ Named data streams of the VxFS file system

NetBackup backs up extended attribute files and named data streams as part of
normal file system backups.

Extended attribute files and named data streams are normal files contained in a
hidden attribute directory that relate to a particular base file. The hidden directory
is stored within the file system, but can be accessed only by the base file to which
it is related. To view which files have extended attributes on Solaris 9 (or greater)
systems, enter: ls -@

Neither extended attribute files nor named data streams can be backed up or
restored individually. Rather, the files are backed up and restored all at once along
with the base file.

The presence of a large number of extended attribute files or named data streams
can cause some degradation in backup and restore speed. The speed is affected
since the base file and all associated files are backed up.

The speed is especially affected in the case of incremental backups, during which
NetBackup checks the mtime or ctime of each file individually.

On UNIX:
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Figure 21-27 Example of base file and extended attribute directory and files

Extended attribute file 1

Extended attribute file 2

Extended attribute file 3

Extended attribute file 4

Extended attributes
backed up and restored
as a group along with the
base file

Hidden attribute directory for File 1

File 1 is a base file on a Solaris or VxFS client
File 1

To back up or restore named data streams and extended attributes, the client,
media server, and master server must run the following versions:

■ NetBackup clients

■ HP 11.23 running VxFS 4.1 or greater.

Note: Access Control Lists (ACLs) are not backed up unless running VxFS
5.0 or greater.

■ AIX running VxFS 4.0 or greater.

Note: Access Control Lists (ACLs) are not backed up unless running VxFS
5.0 or greater.

■ Solaris 10 running VxFS 5.0 or greater

■ Solaris SPARC 9, 10 running VxFS 4.0 or greater

■ Linux running VxFS 5.0 or greater.

■ A NetBackup master server
A NetBackup master server of any version can back up and restore named data
streams and Solaris extended attributes.

Restored attribute files and named data streams can replace existing files if
Overwrite existing files is selected in the Backup, Archive, and Restore client
interface.

On UNIX: In the following example, File 1 is to be restored. Base File 1 currently
possesses four extended attribute files.
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Figure 21-28 Extended attribute files of Base File 1

Extended attribute file 1

Extended attribute file 2

Extended attribute file 3

Extended attribute file 4

File 1

Base file 1

On UNIX: The user restores File 1 from a backup that was created when File 1
possessed only three extended attribute files.

Figure 21-29 Backup of File 1

Extended attribute file 1 backup

Extended attribute file 2 backup

Extended attribute file 3 backup

File 1 backup

On UNIX: Since Overwrite existing files is selected as a restore option, when the
user restores File 1, extended attribute files 1, 2, and 3 are overwritten. Extended
attribute file 4 remains and is not overwritten.

Figure 21-30 Restore of File 1

Restored extended attribute file 1

Restored extended attribute file 2

Restored extended attribute file 3

Extended attribute file 4

Restored file 1

If an attempt is made to restore the following items, an error message appears in
the Restore Monitor. The error message informs the user that the extended
attributes or named data streams are not restored.

■ The extended attribute files to any non-Solaris 9 client (or greater)

■ Named data streams to any non-VxFS 4.0 client

NetBackup then continues with the restore job.

To disable the restore of extended attribute files and named data streams, add an
empty file to the client. Name the file IGNORE_XATTR and place it in the following
directory:
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/usr/openv/netbackup/

The addition affects only Solaris 9 or VxFS 4.0 clients.

File IGNORE_XATTR was formerly known as IGNORE_XATTR_SOLARIS.

On UNIX: Only nbtar that is supplied with NetBackup can restore the extended
attributes or named data streams to a client.

On UNIX: For more information, see the NetBackup Administrator's Guide, Volume
II.

Note: Extended attributes and named data streams cannot be compressed.

Pathname rules for the clients that run extension products
Path rules for the NetBackup clients that are running separately-priced options are
covered in the NetBackup guide for the product. (For example, Snapshot Client or
NetBackup for MS-Exchange.)

About the directives on the Backup Selections list
Directives on the Backup Selections list signal NetBackup to perform specific,
predefined actions when it processes the files on the selections list.

The available directives depend on the policy type and whether the Allowmultiple
data streams attribute is enabled for the policy. The following example is a backup
selections list that contains the NEW_STREAM directive. TheMS-Windows policy type
is selected, and Allow multiple data streams is enabled.

NEW_STREAM

D:\Program Files

NEW_STREAM

C:\Winnt

Note: For best performance, use only one data stream to back up each physical
device on the client. Multiple concurrent streams from a single physical device can
adversely affect backup times. The heads must move back and forth between the
tracks that contain files for the respective streams.

The following table summarizes many of the directives available on the Backup
Selections list.
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Table 21-53 Summary of directives on the Backup Selections list

Applicable operating
system

DescriptionDirective

All supported systemsInstructs NetBackup to back up all local drives except for
those drives that use removable media. This directive also
includes critical system-related components.

See “ALL_LOCAL_DRIVES directive” on page 871.

ALL_LOCAL_DRIVES

All supported Windows
systems

Instructs NetBackup to back up critical system-related
components. The exact set of system components that are
backed up depends on the operating system version and
system configuration.

See “System State:\ directive” on page 872.

System State:\

All supported Windows
systems

Instructs NetBackup to back up all writers for the Volume
Shadow Copy component. This also implies and/or includes
System State:\ if that was not also selected.

See “Shadow Copy Components:\ directive” on page 873.

Shadow Copy
Components:\

All supported Windows
systems

Active Directory Application Mode (ADAM) is a lightweight
directory service that runs as a user service. This directive
can be used to back up ADAM data on computers where it
is installed. However, it does not back up the Active Directory
itself.

Active Directory
Application Mode:\

Policy type specificApply only to specific policy types and can appear only in
backup selections lists for those policies.

See “Directives for specific policy types” on page 874.

Policy-specific directives

AllInterrupt the streaming of policy-specific directives. TheAllow
multiple data streams policy attribute must be enabled
before these directives can be used.

See “UNSET and UNSET_ALL directives” on page 879.

UNSET and UNSET_ALL

AllWhen NEW_STREAM is on the first line of the Backup
Selections list, this directive determines how a backup is
performed in the following modes:

■ Administrator-defined streaming
■ Auto-discovery streaming

The Allow multiple data streams policy attribute must be
enabled before this directive can be used.

See “NEW_STREAM directive” on page 875.

NEW_STREAM
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Table 21-53 Summary of directives on the Backup Selections list (continued)

Applicable operating
system

DescriptionDirective

Instructs NetBackup to back up the Universal Share data.

The Allow multiple data streams policy attribute must be
enabled before this directive can be used.

See “USHARE directive” on page 875.

USHARE

ALL_FILESYSTEMS and VOLUME_EXCLUDE_LIST
directives
The ALL_FILESYSTEMS directive provides a method to include all file systems and
volumes on an NDMP filer in an NDMP backup policy.

You can exclude specific volumes from an ALL_FILESYSTEMS backup selection if
you do not want to back up every volume on an NDMP filer. Use the
VOLUME_EXCLUDE_LIST directive for this purpose. You may use valid wildcard
characters in the VOLUME_EXCLUDE_LIST statement.

Note: The following examples use selections that are specific to NetApp Data
ONTAP 7-mode. For specific examples of backup selections for other configurations,
refer to the appropriate documentation.

The VOLUME_EXCLUDE_LIST statementsmust precede ALL_FILESYSTEMS statement.
For example:

VOLUME_EXCLUDE_LIST=/vol/Hr_allfiles_vol01

ALL_FILESYSTEMS

or

VOLUME_EXCLUDE_LIST=/vol/testvol*

ALL_FILESYSTEMS

To specify multiple values in a VOLUME_EXCLUDE_LIST statement, separate the
values with a comma. For example:

VOLUME_EXCLUDE_LIST=/vol/Hr_allfiles_vol01,/vol/testvol*

ALL_FILESYSTEMS

You can also specify more than one VOLUME_EXCLUDE_LIST statement with an
ALL_FILESYSTEMS directive. For example:
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VOLUME_EXCLUDE_LIST=/vol/Hr_allfiles_vol01

VOLUME_EXCLUDE_LIST=/vol/testvol*

ALL_FILESYSTEMS

A VOLUME_EXCLUDE_LIST statement may include a maximum of 256 characters.
Create multiple VOLUME_EXCLUDE_LIST statements if necessary to avoid exceeding
the limit of 256 characters. If you specify more than 256 characters, the volume list
is truncated. A truncated statement may result in a backup job failure, and the error
message Invalid command parameter(20) is displayed.

If the backup selection includes read-only volumes or full volumes, an NDMP backup
job fails with the status code 20 (Invalid command parameter(20)). If you
encounter a similar NDMP backup job error, review the ostfi logs to identify the
volumes for which the failure occurred. You can use VOLUME_EXCLUDE_LIST

statements with the ALL_FILESYSTEMS statement to exclude the read-only volumes
and the volumes with insufficient space.

In a NetBackup Replication Director environment where snapshots are replicated
to a secondary filer, Veritas recommends that you use storage lifecycle policies to
control backups on the secondary filer.

On NetApp 7-mode storage systems, it is generally not recommended for users to
store files in /vol/vol0 because the volume contains filer system files. For this
reason, vol0 should be excluded from the backup if the ALL_FILESYSTEMS directive
is used in the backup policy. The following is a backup selection list that excludes
/vol/vol0:

VOLUME_EXCLUDE_LIST=/vol/vol0

ALL_FILESYSTEMS

■ Do not use ALL_FILESYSTEMS to backup all volumes on a secondary filer.
Inconsistencies may occur when automatically created NetApp FlexClone
volumes are backed up or restored. Such volumes are temporary and used as
virtual copies or pointers to actual volumes and as such do not need to be backed
up.

■ If you must back up all volumes on a secondary filer, Veritas recommends that
you exclude the FlexClone volumes as well as replicated volumes. For example:

VOLUME_EXCLUDE_LIST=/vol/Clone_*

VOLUME_EXCLUDE_LIST=/vol/*_[0-9]

VOLUME_EXCLUDE_LIST=/vol/*_[0-9][0-9]

VOLUME_EXCLUDE_LIST=/vol/*_[0-9][0-9][0-9]

ALL_FILESYSTEMS
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This example assumes all FlexClone volumes and only FlexClone volumes
begin with /vol/Clone_. Adjust the volume specifications appropriately for your
environment.

■ VOLUME_EXCLUDE_LIST applies only to ALL_FILESYSTEMS. It does not apply to
explicit backup selections or wildcard-based backup selections.
If you use the ALL_FILESYSTEMS directive in an NDMP policy for Clustered Data
ONTAP, you must exclude each selected SVM's root volume using the
VOLUME_EXCLUDE_LIST directive. Otherwise the backups fail.
For more information, refer to the following topic:

Backups from snapshots for NDMP policies fail when the import of a snapshot fails
for volumes where logical unit numbers (LUNs) reside with status code 4213
(Snapshot import failed). To avoid this error, use the VOLUME_EXCLUDE_LIST

directive to exclude any volumes that are used to create LUNs accessed through
a storage area network (SAN).

ALL_LOCAL_DRIVES directive
Use the ALL_LOCAL_DRIVES directive to back up all local drives except for those
drives that use removable media. If this directive is used, this directive must be the
only entry in the backup selections list for the policy. No other files or directives can
be listed. The directive applies only to the following policy types:

■ MS-Windows

■ Standard

ALL_LOCAL_DRIVES gives different results depending on whether Allow multiple
data streams is enabled for the policy:

Applies only to Standard and MS-Windows policy types.
NetBackup backs up the entire client, and then splits the data
from each drive (Windows) or file system (UNIX) into its own
backup stream. NetBackup periodically preprocesses the
client to make necessary changes to the streams.

Allowmultiple data streams
enabled

NetBackup backs up the entire client and includes all drives
and file systems in the same stream.

Allowmultiple data streams
disabled

See “Allow multiple data streams (policy attribute)” on page 758.

Caution: Do not select Cross mount points for policies where you use the
ALL_LOCAL_DRIVES directive.

See “ALL_LOCAL_DRIVES example: Auto-discovery mode” on page 872.

871Creating backup policies
Backup Selections tab



See “ALL_LOCAL_DRIVES example: Without multiple data streams” on page 872.

ALL_LOCAL_DRIVES example: Auto-discovery mode
Assume that Allow multiple data streams is enabled in the auto-discovery mode.
Assume that the client is a Windows system with two drive volumes, C:\ and D:\.
The backup selections list contains the following directive:

ALL_LOCAL_DRIVES

For this backup selections list, NetBackup generates the following:

■ One stream for C:\

■ One stream for D:\

For a UNIX client, NetBackup generates a stream for each file system.

SYSTEM_STATE is also backed up because SYSTEM_STATE is included in the
ALL_LOCAL_DRIVES directive.

See “ALL_LOCAL_DRIVES example: Without multiple data streams” on page 872.

See “Allow multiple data streams (policy attribute)” on page 758.

ALL_LOCAL_DRIVES example: Without multiple data streams
Assume that Allow multiple data streams is not enabled. Assume that the client
is a Windows system with two drive volumes, C:\ and D:\. The backup selections
list contains the following directive:

ALL_LOCAL_DRIVES

For this backup selections list, NetBackup backs up the entire client in one data
stream that contains the data from both C:\ and D:\.

SYSTEM_STATE is also backed up because SYSTEM_STATE is included in the
ALL_LOCAL_DRIVES directive.

See “Allow multiple data streams (policy attribute)” on page 758.

System State:\ directive
The System State:\ can be used on all supported Windows systems.

The System State:\ directive is needed for the operating system versions which
do not support Shadow Copy Components.

The System State:\ directive creates a backup for critical system-related
components. The exact set of system components that are backed up depends on
the operating system version and system configuration.
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The list of items that are backed up can include the following:

■ Active Directory

■ COM+ Class Database

■ Cluster Database

■ IIS Database

■ Registry

■ Boot Files and protected files

■ SYSVOL

■ Certificate Server

The files that comprise the registry can be found in the following location:

%SystemRoot%\SYSTEM32\Config

At a minimum, the following files are backed up as part of the registry:

■ DEFAULT

■ SAM

■ SOFTWARE

■ SECURITY

■ SYSTEM

Shadow Copy Components:\ directive
The Shadow Copy Components:\ directive specifies that all of the Volume Shadow
Copy component writers get backed up. This directive affects the backups of the
following clients:

■ Windows 2003 Server computers that use the Volume Shadow Copy
components.

■ Windows IA64 systems with EFI System partitions.

Note: In the policies that back up Windows clients on IA64 platforms, use the
Shadow Copy components:\ directive instead of the System_State:\ directive.
The Shadow Copy components:\ directive includes System State components
and the EFI System partition automatically in the backup.
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Since the ShadowCopy Components contain SystemState information, the Shadow
Copy Components need to be backed up by a full backup.

The Volume Shadow Copy components include the following:

■ System files
■ COM+ Class Registration Database
■ SYSVOL
■ Active Directory
■ Cluster quorum
■ Certificate Services
■ Registry
■ Internet Information Services

System State
writers

■ Removable Storage Manager
■ Event logs
■ Windows Internet Name Service
■ Windows Management Instrumentation
■ Remote Storage
■ Dynamic Host Configuration Protocol
■ Terminal Server Licensing
■ Background Intelligent Transfer Service

System Service
writers

Items that the computer does not require to operate. For example,
Active Directory Application Mode andMicrosoft Distributed File System
Replication (DFSR) folders.

See “About Microsoft DFSR backups” on page 714.

User Data

A category that is intended for future NetBackup releases.Other Data

Directives for specific policy types
Some directives apply only to specific policy types and can appear only in backup
selections lists for those policies. NetBackup passes policy-specific directives to
the clients along with the backup selections list. The clients then perform the
appropriate action according to the directive. All policy-specific directives that are
passed to a client in a stream are passed in all subsequent streams.

Note: Include policy-specific directives only in backup selections lists for the policies
that support the directives or errors can occur.

The following policy types have their own backup selections list directives:

■ FlashBackup
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■ NDMP

■ Lotus-Notes

■ MS-Exchange-Server

For information on other policy types and associated backup selections list directives,
see the NetBackup guide for the option.

USHARE directive
The USHARE directive is recognized only if Allow multiple data streams is set for
the Standard policy. USHARE directives are ignored ifAllowmultiple data streams
is not set. USHARE must be on the first line if NEW_STREAM is not added.

If NEW_STREAM is added, USHARE must be in second line. The presence of USHARE
on the first line or second line of the backup selections list determines the backup
type as USHARE backup.

NEW_STREAM directive
The NEW_STREAM directive is recognized only if Allow multiple data streams is set
for the policy. NEW_STREAM directives are ignored if Allow multiple data streams
is not set.

If this directive is used in a backup selections list, the first instance of it must be on
the first line. If it appears on the first line, it can also appear elsewhere in the list.

The presence of NEW_STREAM on the first line of the backup selections list determines
how the backup is performed in the following modes: in administrator-defined
streaming or in the auto-discovery streaming.

About the administrator-defined streaming mode
If NEW_STREAM is the first line of the backup selections list, the backup is performed
in the administrator-defined streaming mode.

In this mode, the following actions occur:

■ The backup splits into a separate stream at each point in the backup selections
list where the NEW_STREAM directive occurs.

■ All file paths between NEW_STREAM directives belong to the same stream.

■ The start of a new stream (a NEW_STREAM directive) defines the end of the
previous stream.

■ The last stream in the backup selections list is terminated by the end of the
backup selections list.

875Creating backup policies
Backup Selections tab



In the following examples, assume that each stream is from a separate physical
device on the client. Multiple concurrent streams from a single physical device can
adversely affect backup times. The backup time is longer if the heads must move
back and forth between the tracks that contain files for the respective streams.

For example, consider the following backup selections list:

On Windows:

NEW_STREAM

D:\Program Files

C:\Winnt

NEW_STREAM

C:\users

D:\DataFiles

This backup selections list contains two data streams:

■ The NEW_STREAM directive at the top of the list starts administrator-defined
streaming and the first data stream. This stream backs up D:\Program Files

and C:\Winnt.

■ The second NEW_STREAM starts a second data stream that backs up
C:\users and D:\DataFiles.

On UNIX:

NEW_STREAM

/usr

/lib

NEW_STREAM

/home

/bin

This backup selection list contains two data streams:

■ The NEW_STREAM directive at the top of the list starts administrator-defined
streaming and the first stream. This stream backs up /usr and /lib.

■ The second NEW_STREAM starts a second data stream that backs up /home and
/bin.

If a backup selections list entry is added to a stream, the entry is not backed up
until the schedule is due for the policy. If the next backup due is an incremental,
only the files that changed are backed up. To ensure that a new entry gets a full
backup the first time, add it to a new stream. NetBackup performs a full backup of
new streams that are added to the backup selections list.

In the previous example, assume that you add the following:
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On Windows:

D:\Utilities

On UNIX:

/var

after

On Windows:

D:\Datafiles

On UNIX:

/bin

If an incremental backup is due that night, only changed files in D:\Utilities (on
Windows) or in /var (on UNIX) are backed up. Add a NEW_STREAM directive before
D:\Utilities (on Windows) or before /var (on UNIX), to perform a full backup of
all files in D:\Utilities (on Windows) or in /var (on UNIX), regardless of when
the files were last changed.

About the auto-discovery streaming mode
The auto-discovery streaming mode is initiated if the NEW_STREAM directive is not
the first line of the backup selections list. The list must contain either the
ALL_LOCAL_DRIVES directive or wildcards.

In this mode, the backup selections list is sent to the client, which preprocesses
the list and splits the backup into streams as follows:

■ If the backup selections list contains the ALL_LOCAL_DRIVES directive, NetBackup
backs up the entire client. However, NetBackup splits each drive volume
(Windows) or file system (UNIX) into its own backup stream.
See “ALL_LOCAL_DRIVES directive” on page 871.

■ If wildcards are used, the expansion of the wildcards results in one stream per
wildcard expansion. Wildcard usage is the same as for Windows clients.
See “Wildcard use in NetBackup” on page 1164.

If the backup selections list contains neither the ALL_LOCAL_DRIVES directive nor
wildcards, the auto-discovery mode is not used. The server preprocesses rather
than the client. Each file path in the backup selections list becomes a separate
stream.

The auto-discovery streaming mode applies to Standard and MS-Windows policy
types.
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Before the backup begins, the client uses auto-discovery to preprocess the backup
selections list to determine how many streams are required. The first backup that
a policy performs preprocesses the backup selections list. Depending on the length
of the preprocess interval, preprocessing may not occur before every backup.

About setting the preprocess interval for auto-discovery
The preprocess interval applies only to auto-discovery mode and specifies how
often preprocessing occurs. When a schedule is due and NetBackup uses
auto-discovery, NetBackup checks whether the previous preprocessing session
has occurred within the preprocess interval.

NetBackup performs one of the following actions:

■ If the preprocessing session occurs within the preprocess interval, NetBackup
does not run preprocessing on the client.

■ If the preprocessing session did not occur within the preprocess interval,
NetBackup preprocesses the client and makes required changes to the streams.

If necessary, you can change the interval by using the bpconfig command. The
default is 4 hours and is a good value for most of the sites that run daily backups.

If the interval is too long or too short, the following problems can occur:

Can cause missed backups because new streams are not added early
enough. For example, assume that the preprocess interval is set to 4
hours and a schedule has a frequency of less than 4 hours. A new
stream can be omitted from the next backup because the preprocessing
interval has not expired when the backup is due.

Interval is too long.

Can cause preprocessing to occur often enough to increase scheduling
time to an unacceptable level. A short interval is most likely to be a
problem when the server must contact a large number of clients for
preprocessing.

Interval is too
short.

Use the following form of the bpconfig command to change the interval:

On Windows:

install_path\NetBackup\bin\admincmd\bpconfig [-prep hours]

On UNIX:

/usr/openv/netbackup/bin/admincmd/bpconfig [-prep hours]

For more information on the bpconfig command, see the NetBackup Commands
Reference Guide.
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UNSET and UNSET_ALL directives
UNSET, UNSET_ALL The UNSET and UNSET_ALL directives interrupt the streaming
of policy-specific directives.

All policy-specific directives that are passed to a client in a stream are passed in
all subsequent streams. The UNSET and UNSET_ALL directives change this behavior.
These directives are recognized only if the Allow multiple data streams option is
set for the policy.

See “Directives for specific policy types” on page 874.

See “Allow multiple data streams (policy attribute)” on page 758.

The UNSET directive interrupts a policy-specific directive so it is not
passed with any additional streams. The directive that was unset can
be defined again later in the backup selections list to be included in the
current and the later streams.

In the following backup selections list, the set command is a
client-specific directive that is passed to the first and all subsequent
streams.

NEW_STREAM
set destpath=/etc/home
/tmp
/use
NEW_STREAM
/export
NEW_STREAM
/var

For the set command to be passed to the first two streams only, use
UNSET or UNSET_ALL at the beginning of the third stream. At this
location, it prevents SET from being passed to the last stream.

NEW_STREAM
set destpath=/etc/home
/tmp
/use
NEW_STREAM
/export
NEW_STREAM
UNSET set destpath=/etc/home [or UNSET_ALL]
/var

UNSET
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UNSET_ALL has the same effect as UNSET but unsets all policy-specific
directives in the backup selections list that have been defined up to this
point.

UNSET_ALL

Files that are excluded from backups by default
By default, a number of files and file states are not backed up by NetBackup.

You can also exclude specific files from automatic backups by specifying the files
or directories in an exclude list on the client.

See “About excluding files from automatic backups” on page 881.

By default, NetBackup does not back up the following files:

■ NFS files or directories. To back up NFS files, enable Follow NFS.

■ Files or directories in a different file system. To back up files in a different file
system, enable Cross mount points.

■ Files or directories with path lengths longer than 1023 characters.

■ Files or directories in which the operating system does not return inode
information (the lstat system call fails).

■ Directories that NetBackup cannot access (the cd command cannot access).

■ Socket special files. (Named pipes are backed up, however.)

■ Locked files when locked by an application that currently has the file open.

■ Busy files. If a file is open, NetBackup backs up the last saved version of the
file.

■ Files or directories beneath a bind mount (Linux).

NetBackup automatically excludes the following file system types onmost platforms:

■ cdrom (all UNIX platforms)

■ cachefs (AIX, Solaris, UnixWare)

■ devpts (Linux)

■ mntfs (Solaris)

■ proc (UNIX platforms)
Does not exclude automatically for AIX, so /proc must be added manually to
the exclude list. If /proc is not added manually, partially successful backups
may result with the ALL_LOCAL_DRIVES directive on AIX.

■ tmpfs (Linux)
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■ usbdevfs (Linux)

See “Follow NFS (policy attribute)” on page 743.

See “Cross mount points (policy attribute)” on page 746.

About host identity-specific files excluded from the backup
To proactively avoid vulnerabilities, certain host identity-specific files are excluded
from the backup.

■ To identify the files that are not backed up, you can run one the following
commands:

■ nbgetconfig -private_exld_list

■ bpgetconfig -private_exld_list

For more information about the commands see the NetBackup Commands
Reference Guide.

■ Including the files in the backup:
If you don't want to exclude certain files from the backup, you must include those
files in the include list.
For more information, see See “About excluding files from automatic backups”
on page 881.

■ Recreating the files that were not backed up:
The files that are not backed up are not restored. Ideally, the files would reside
on the original location. However, in case you want to recreate the files, some
of the key files and certificates can be recreated by restarting the NetBackup
services. If you encounter any error that is related to keys or certificates, restart
the NetBackup services and verify if the key files or the certificate is recreated.
If the key file or certificate is not created, proceed with the certificate and key
regeneration procedures that are provided in the NetBackup Commands
Reference Guide.

About excluding files from automatic backups
On most NetBackup clients, you can exclude specific files from automatic backups
by specifying the files in an exclude list on the client.

You can also create an include list to add a file(s) specifically that is excluded. The
include list is useful when, for example, an entire directory is excluded except for
one file on the include list.

Note: Exclude and include lists do not apply to user backups and archives.
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The method for specifying files in the exclude list and the include list depends on
the type of client as follows:

Specify exclude and include lists in the Backup, Archive, and
Restore client interface. Start Backup, Archive, and Restore.
On the File menu, click NetBackup Client Properties. Select
the Exclude List tab or the Include List tab. For further
instructions, see the NetBackup user’s guide for the client.

The Exclude List or the Include List can also be specified
through theNetBackup Administration Console on the master
server.

See “Exclude Lists properties” on page 113.

MicrosoftWindows clients

Create the exclude and include lists in the following files on the
client:

■ /usr/openv/netbackup/include_list

■ /usr/openv/netbackup/exclude_list

UNIX clients

Create an exclude list for a specific policy or for a policy and a
schedule combination. Create an exclude_list file with a
.policyname or .policyname.schedulename suffix. The following
two file examples use a policy that is named wkstations. The
policy contains a schedule that is named fulls:

/usr/openv/netbackup/exclude_list.wkstations
/usr/openv/netbackup/exclude_list.wkstations.fulls

The first file affects all scheduled backups in the policy that is
named wkstations. The second file affects backups only when
the schedule is named fulls.

For a given backup, NetBackup uses a single exclude list—the
list that contains the most specific name. For example, if there
are files named:

exclude_list.wkstations and
exclude_list.wkstations.fulls

NetBackup uses only:

exclude_list.wkstations.fulls

Specific policy

Files that are excluded by Microsoft Windows Backup
Windows maintains a list of files and folders that are excluded when Microsoft
Windows Backup is used to back up files. This list is known as the
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FilesNotToBackup list. NetBackup excludes those files and directories from
automatic backups even if they are not in the NetBackup exclude list for the client.
Those items also are excluded from user-directed backups (unlike items in a
NetBackup exclude list, which can be backed up by a user-directed operation).

Windows also maintains a list of registry keys that are not to be restored. NetBackup
does not restore the registry keys that are listed in theWindowsKeysNotToRestore
list.

VMware Policy tab
The VMware tab appears for policies of the VMware policy type.

The following options appear on the VMware tab.

Table 21-54 Options on the VMware tab of the policy

DescriptionOption

Specify the VMware backup host.VMware backup
host

Enable recovery of individual files. You can also recover the entire virtual machine.Enable file
recovery from VM
backup

Enable block-level backups of the virtual machine.Enable block-level
incremental backup

Reduce the size of the backup image by excluding any unused or deleted blocks within the file
system on the virtual machine.

Exclude deleted
blocks

Reduce the size of the backup image by excluding the guest OS system paging file (Windows)
or the swap file (UNIX).

Exclude swap and
paging files

Specify the type of name by which NetBackup recognizes virtual machines when it selects them
for backup.

Primary VM
identifier

Specify the action that NetBackup takes when a snapshot is discovered before NetBackup
creates a new snapshot for the virtual machine backup.

Orphanedsnapshot
handling

Options to protect applications.Application
Protection

Enable recovery of individual files from Exchange data in the virtual machine backup.Enable Exchange
Recovery

Truncates the Exchange transaction logs when the backup occurs.Truncate logs

883Creating backup policies
VMware Policy tab



Table 21-54 Options on the VMware tab of the policy (continued)

DescriptionOption

Enable recovery of individual files from SQL Server data in the virtual machine backup.Enable SQL Server
Recovery

Truncates the SQL Server transaction logs when the backup occurs.Truncate logs

Enable recovery of individual files from SharePoint data in the virtual machine backup.Enable SharePoint
Recovery

Determine how the snapshot data travels from the VMware datastore to the VMware backup
host.

Transport modes

Set additional parameters for the VMware backup.Advanced...

Figure 21-31 VMware tab

For more information about VMware, see the NetBackup for VMware Guide.
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Hyper-V Policies tab
The Hyper-V tab appears for policies of the Hyper-V policy type.

The following options appear on the Hyper-V tab.

Table 21-55 Options on the Hyper-V tab of the policy

DescriptionOption

Allows restore of individual files from the backup. With or without this option, you can restore
the entire virtual machine.

Optimizations

Enable file
recovery from VM
backup

Specifies the type of name by which NetBackup recognizes virtual machines when it selects
them for backup.

Primary VM
identifier

Determines whether NetBackup is allowed to perform an offline backup of a virtual machine.
This option is intended for guest operating systems that do not support VSS (such as Linux).

Enable offline
backup of
non-VSS VMs

Applies to backups of the virtual machines that are configured in a Microsoft Cluster that uses
cluster shared volumes (CSV).

Cluster shared
volumes timeout

Sets additional parameters for the Hyper-V backup.Advanced...

For more information about Hyper-V, see the NetBackup for Hyper-V Guide.
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Figure 21-32 Hyper-V Policies tab

Exclude Disks tab
In the Change Policy dialog box, the Exclude Disks tab appears for policies of
the VMware policy type. These options determine the kind of disks on the virtual
machine that are excluded from the backup. These options can reduce the size of
the backup, but should be used with care. These options are intended only for the
virtual machines that have multiple virtual disks.

The following options appear on the Exclude Disks tab.

Table 21-56 Options on the Exclude Disks tab of the policy

DescriptionOption

Backs up all virtual disks that are configured for the virtual machine.No disks
excluded
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Table 21-56 Options on the Exclude Disks tab of the policy (continued)

DescriptionOption

The virtual machine's boot disk (for example the C drive) is not included
in the backup. Any other disks (such as D) are backed up. Consider
this option if you have another means of recreating the boot disk, such
as a virtual machine template for boot drives.

Note: A virtual machine that is restored from this backup cannot start.
Data files are available in the restored data disks.

Exclude boot disk

The virtual machine's data disks (for example the D drive) are not
included in the backup for this policy. Only the boot disk is backed up.
Consider this option only if you have a different policy that backs up
the data disks.

Note:When the virtual machine is restored from the backup, the virtual
machine data for the data disk may be missing or incomplete.

Exclude all data
disks

Exclude disks by a VMware Custom Attribute that is applied to a virtual
machine. The VMware Custom Attribute identifies the disks that you
want to exclude from backups. If you select this option, also enter the
name of the Custom Attribute. NetBackup then excludes the disks that
are defined in that attribute. The attribute must have comma separated
values of device controllers for the disks to be excluded. For example:

scsi0-0,ide0-0,sata0-0,nvme0-0

The default value is NB_DISK_EXCLUDE_LIST. You can use this value
as the custom attribute or choose your own value.

Note: Custom Attribute based disk exclusion requires that you enter
in NetBackup the credentials for the vCenter server or servers that host
the VMs. ESXi server credentials are not sufficient.

Your VMware administrator must use a VMware interface to apply the
custom attribute to the disks that you want to exclude from the virtual
server. The Virtual Disk Exclusion wizard of the NetBackup plug-ins
for vSphere provides a method to add a Custom Attribute to a virtual
machine or virtual machines. For more information, see the NetBackup
Plug-in for VMware vSphereWeb Client Guide or theNetBackup Plug-in
for VMware vSphere Client (HTML5) Guide available through the
following URL:

http://www.veritas.com/docs/DOC5332

Perform custom
attribute based
exclusion
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Table 21-56 Options on the Exclude Disks tab of the policy (continued)

DescriptionOption

Exclude a specific disk by selecting the disk controller type and device
numbers that represent the virtual device node of the disk. Then click
Add. NetBackup adds the controller ID to the list of nodes to be
excluded. Repeat for each disk that you want to exclude.

To delete a disk from the list of disks to exclude, select the disk controller
type and device numbers, and then click Delete. The list is a
comma-separated collection of controller IDs.

Alternatively, you can add or delete specific disks by editing the contents
of the text box in which the excluded disks appear. Wildcard characters
are not supported.

Specific disks to
be excluded

Note:NetBackup does not support the exclude disks options for Replication Director
backups.

For more information about VMware, see the NetBackup for VMware Guide.

Disaster Recovery tab
TheDisaster Recovery tab appears for theNBU-Catalog policy type. TheDisaster
Recovery tab contains options for configuring disaster recovery protection methods
for the catalog data.

Note: Do not save the disaster recovery information to the local computer. Veritas
recommends that the image file be saved to a network share or a removable device.
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Figure 21-33 Disaster Recovery tab

Table 21-57 describes the options on the Disaster Recovery tab.
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Table 21-57 Options on the Disaster Recovery tab

DescriptionOption

Browse and specify the directory where the disaster recovery information is to be saved. Do not
save the disaster recovery information to the local computer. Veritas recommends that you save
the image file to a network share or a removable device.

The share must be established and available before the hot catalog backup runs.

Specify an NFS share or a UNC path (CIFS Windows share).

Note: The path cannot contain non-ASCII characters.

When indicating a UNC path, note the following:

■ A Windows master server can indicate a UNC path to a Windows computer.
■ A UNIX master server cannot indicate a UNC path to a Windows computer.
■ A UNIX master server cannot indicate a UNC path to a UNIX computer. To do so, first mount

the UNC location on the master server, and then provide the UNC path to the UNIX computer.

On UNIX: The path for the disaster recovery information cannot be to a directory that is on the
same partition as /usr/openv/netbackup. If the path is to a location on the same partition as
/usr/openv/netbackup, NetBackup displays a status 20 error message. Themessage states
that the disk path is invalid. Change the path on the Disaster Recovery tab to a directory on a
different partition.

Path

Specify the logon and password information that is required to access an established Windows
or NFS share.

If the logon information is not valid, NetBackup returns a message. The message requests that
the user either reenter the logon and password information or clear the alternate location option
to continue.

Logon

Specify the password that is required to log on to the share.Password
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Table 21-57 Options on the Disaster Recovery tab (continued)

DescriptionOption

Specify the email address where the disaster recovery report should be sent. Veritas recommends
that the disaster recovery report be sent to at least one email address. To send the information
to more than one address, separate email addresses with a comma as follows:

email1@domain.com,email2@domain.com

See “Setting up email notifications about backups” on page 141.

On Windows: The nbmail.cmd or mail_dr_info.cmd script must be configured
(Install_path\NetBackup\bin\goodies\). In addition specify the email addresses in
the Disaster Recovery tab.

On Windows: NetBackup performs the notification by passing the email addresses, subject, and
message to nbmail.cmd or mail_dr_info.cmd. The scripts use the mail program that is
specified in the script to send email to the user. See the comments in the script for configuration
instructions.

On Windows: The following points describe how mail_dr_info.cmd and nbmail.cmd interact:

■ IfInstall_path\NetBackup\bin\mail_dr_info.cmd is configured, the disaster recovery
report is sent to the email address of the administrators that are indicated in the Disaster
Recovery tab. NetBackup administrators can set up the script to send the disaster recovery
information to alternate locations.

■ If mail_dr_info.cmd is not configured, and
Install_path\NetBackup\bin\goodies\nbmail.cmd is configured, the disaster
recovery report is sent to the administrators that are indicated in the Disaster Recovery tab
by nbmail.cmd.

■ If neither file is configured, NetBackup attempts to use Microsoft internal IMAPI services.

Note: OnWindows: By default, neither nbmail.cmd nor mail_dr_info.cmd is configured to
send email.

See “Configuring the nbmail.cmd script on Windows” on page 142.

OnWindows: For more information on mail_dr_info.cmd, see the NetBackup Administrator’s
Guide, Volume II.

Send in an email
attachment

Lists the policies that are considered crucial to the recovery of a site in the event of a disaster.
The NetBackup Disaster Recovery report lists all of the media that is used for backups of critical
policies, including the most recent full backup. The NetBackup Disaster Recovery wizard warns
you if any media for critical policies are not available.

Note: The Disaster Recovery report lists the media for only incremental and full backup
schedules so critical policies should use only incremental or full backup schedules. Certain
database backups schedules, such as Oracle and Microsoft SQL Server, only use schedule types
of Application Backup and Automatic Backup. Because of the schedule types, media listings for
these backups do not appear on the Disaster Recovery report.

Critical policies
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Note: Vault protects the disaster recovery data by sending the data to the Vault
site as an email attachment of the Vault report email.

Adding policies to the Critical Policies list of a catalog backup policy
Use the following procedure to add policies to the Critical Policies list of a catalog
backup policy.

To add a policy to the critical policies list

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Do one of the following:

■ Double-click a configured catalog backup policy.

■ Create a catalog backup policy.
See “Configuring a catalog backup manually” on page 938.

3 Select the Disaster Recovery tab.

4 Near the Critical Policies list, click Add. An active field appears in the list.

5 Click the icon at the far right of the active field to display a list of configured
policies. Select a policy to add to the Critical Policies list.

6 Do any of the following:

Click Add.To add another policy

Select the policy and click Change.To change a policy

Select the policy and click Delete.To delete a policy

7 ClickOK to save theCritical policies list and the other settings on theDisaster
Recovery tab.
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Creating a Vault policy
A Vault policy differs from other policies in the following respects:

■ Vault must be specified as the policy type.

■ No clients are specified in Vault policies, so the Clients tab does not appear.

■ In the Backup Selections list, a Vault command is specified instead of files.

To create a Vault policy

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On the Actions menu, click New > Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box.
Click OK.

4 On the Attributes tab, select Vault as the policy type.

5 On the Schedules tab, clickNew to create a new schedule. The type of backup
defaults to Automatic.

The Clients tab does not appear for Vault policy types.

6 Complete the schedule.

7 On the Backup Selections tab, enter one of two Vault commands:

Use vltrun to specify the robot, vault name, and profile for the job.
The vltrun command accomplishes all the steps necessary to select,
copy, and eject media. If the vault profile name is unique, use the
following format:

vltrun profile_name

If the vault profile name is not unique, use the following format:

vltrun robot_number/vault_name/profile_name

vltrun

Use the vlteject command to eject media or to generate reports for
completed Vault sessions. For example:

vlteject -eject -report [-vault vault_name
[-sessionid id]] [-auto y|n] [-eject_delay seconds]

vlteject

Both commands are located in the following directory:

■ On Windows:
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install_path\NetBackup\bin

■ On UNIX:
/usr/openv/netbackup/bin/

For more information on Vault names, profile names, and command usage,
see the Vault Administrator’s Guide.

8 Click OK.

Creating a BigData policy
Use the BigData policy to backup big data applications or certain hyper converged
systems. For example, Hadoop or Nutanix Acropolis Hypervisor, respectively.

A BigData policy differs from other policies in the following respects:

■ You must specify BigData as the policy type.

■ The entries provided in the Clients tab and the Backup Selections tab differ
based on the application that you want to back up.

■ In the Backup Selections tab, you must specify certain parameters and their
appropriate values.

To create a BigData policy

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On the Actions menu, click New > Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box.
Click OK.

4 On the Attributes tab, select BigData as the policy type.

5 On the Schedules tab, clickNew to create a new schedule. The type of backup
defaults to Automatic.

Note:Currently, certain big data applications do not support all schedule types.
For example, Nutanix supports only full backups.

6 Complete the schedule.

7 On theClients tab, enter appropriate values according to your application type.
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8 On the Backup Selections tab, enter appropriate parameters according to
your application type.

9 Click OK.

NetBackup provides support to back up the following applications.

■ Nutanix Acropolis Cluster

■ Hadoop

To back up a Nutanix Acropolis Cluster

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On the Actions menu, click New > Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box.
Click OK.

4 On the Attributes tab, select BigData as the policy type.

5 On the Schedules tab, click New to create a new schedule. Currently,
NetBackup supports only full backups for a Nutanix Acropolis Cluster.

6 On the Clients tab, enter the display name of the virtual machine.

7 On theBackup Selections tab, enter the following parameters and their values
as shown:

■ Application_Type=Nutanix-AHV

The parameter values are case-sensitive.

■ Backup_Host=<IP address or the hostname of the backup host>

The backup host must be a Linux machine. The backup host can be a
NetBackup client or a media server.

■ Application_Server=<IP address or the hostname of the Nutanix

cluster>

8 Click OK to save the changes.

To back up a Hadoop cluster

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On the Actions menu, click New > Policy.

3 Type a unique name for the new policy in the Add a New Policy dialog box.
Click OK.

4 On the Attributes tab, select BigData as the policy type.
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5 On the Schedules tab, click New to create a new schedule.

6 On the Clients tab, enter the Fully Qualified Domain Name (FQDN) of the
Hadoop cluster or name node.

7 On theBackup Selections tab, enter the following parameters and their values
as shown:

■ Application_Type=hadoop

The parameter values are case-sensitive.

■ Backup_Host=<IP_address or hostname>

The backup host must be a Linux machine. The backup host can be a
NetBackup client or a media server.

■ File path or the directory to back up.

8 Click OK to save the changes.

For more information on using NetBackup for big data applications, refer to the
Veritas NetBackup documentation page.

Performing manual backups
A manual backup is user-initiated and is based on a policy.

A manual backup is useful in the following situations:

■ To test a configuration

■ To back up a client that missed the regular backup

■ To back up a client before new software is installed to preserve the old
configuration

■ To preserve records before a special event such as a company split or merger

■ To back up quarterly or yearly financial information

In some cases, it may be useful to create a policy and schedule that is used only
for manual backups. Create a policy for manual backups by creating a policy with
a single schedule that has no backup window. Without a backup window, the policy
can never run automatically.

To perform a manual backup

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 On Windows: Select the policy name in the left pane.

3 On UNIX: Select the policy name in the middle pane.
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4 On the Actions menu, click Manual Backup. (To perform a manual backup,
you must enable the Go into effect at attribute.)

See “Go into effect at (policy attribute)” on page 742.

If the Go into effect at attribute is set for a future date and time, the backup
does not run.

5 In theManual Backup dialog box, select the schedule and the clients that you
want to back up.

If you do not select any schedules, NetBackup uses the schedule with the
highest retention level. If you do not select any clients, NetBackup backs up
all clients.

User schedules do not appear in the schedules list. A user schedule cannot
be manually backed up because it does not have a backup selection list (the
user selects the files).

6 Click OK to start the backup.

Active Directory granular backups and recovery
Administrators can use NetBackup to restore individual objects and attributes in
the Active Directory instead of restoring the entire Active Directory. Administrators
can also restore deleted objects (tombstone objects) from the Active Directory.

The following topics describe how to configure a policy to perform recovery of an
Active Directory object:

■ System requirements necessary to perform Active Directory granular backups
and restores.

■ How to configure a policy for an Active Directory backup that allows granular
restores.

■ How to restore individual objects and attributes in the Active Directory.

System requirements for Active Directory granular NetBackup
backups and recovery

See the Operating System Compatibility List for a list of operating system versions
that support Active Directory granular restore:

http://www.veritas.com/docs/TECH76648

To perform Active Directory granular backups and restores, ensure that you meet
the following requirements:
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■ The Network File System (NFS) must be installed on the media server and all
Active Directory domain controllers or ADAM/LDS hosts.
See “About installing and configuring Network File System (NFS) for Active
Directory Granular Recovery” on page 1227.
See “About configuring Services for Network File System (NFS) on Windows
2012, 2012 R2, or 2016” on page 1228.
See “About configuring Services for Network File System (NFS) on Windows
2008 and 2008 R2” on page 1236.

■ The NetBackup Client Service must be configured to log on as an account with
domain privileges.
To perform granular backups and restores of the Active Directory, the NetBackup
Legacy Client Service (bpinetd) must run under the domain administrator
account on the Active Directory domain controller or ADAM server. By default,
bpinetd runs under the Local System account.
See “Configuring the NetBackup Client Service” on page 1161.

For information on the media server platforms that support Granular Recovery
Technology see the NetBackup compatibility lists on the Veritas NetBackup
Hardware Compatibility List (HCL).

Creating a policy that allows Active Directory granular restores
A NetBackup policy that backs up the Active Directory can be configured to allow
the restore of the objects and attributes in the Active Directory. The objects and
attributes can be restored locally or remotely without the interruption of restarting
the domain controllers where the restore is performed.

The Active Directory host properties offer additional configuration options for the
backup of Windows Server 2008 computers. Specifically, whether or not NetBackup
performs a consistency check if Microsoft Volume Shadow Copy Service (VSS) is
used as the snapshot provider.

See “Active Directory host properties” on page 59.

To create a policy to allow Active Directory restores

1 Check that the NetBackup Legacy Client Service (bpinetd) is running under
the domain administrator account on the Active Directory domain controller.
In this case, the Active Directory domain controller is the NetBackup client.

See “Configuring the NetBackup Client Service” on page 1161.

2 In the Policy dialog box, on the Attributes tab, select MS-Windows as the
policy type. Specify the other policy attributes as needed.

3 Enable the Enable granular recovery option. If this option is not enabled, the
backup still runs, but the backup cannot produce granular restores.
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4 In the Schedules tab, create schedules as needed.

Other items in the policy may use a differential or cumulative incremental
backup type, but the Active Directory items are always fully backed up.

See “Active Directory backups are full backups” on page 899.

5 In the Backup Selections tab, open the Select Directive dialog.

6 For the Directive set, selectWindows 2003 orWindows 2008.

7 To back up the Active Directory, select any one of the following directives:

■ See “System State:\ directive” on page 872.

■ See “Shadow Copy Components:\ directive” on page 873.

■ See “ALL_LOCAL_DRIVES directive” on page 871.

Note: Active Directory Application Mode (ADAM) is a lightweight directory
service that runs as a user service. This directive can be used to back up ADAM
data on computers where it is installed. However, it does not back up the Active
Directory itself.

8 In the Clients tab, select the clients as needed.

9 Save the policy.

Active Directory backups are full backups
Any Active Directory backup is always a NetBackup full backup, whether it is a
granular backup or not.

Whenever Active Directory is in a policy’s Backup Selections list, the Active
Directory portion is always fully backed up, even when the backup type is
incremental, differential or cumulative. Any other items in the Backup Selections
list may use a differential or cumulative incremental backup type as indicated. Even
though a full backup is forced for an Active Directory backup, normal incremental
rules are applied to the non-Active Directory items in the policy file list.

Restoring Active Directory objects
The following procedure describes how to restore objects from an Active Directory
backup in a non-disaster recovery situation:

To restore individual objects from an Active Directory backup

1 Open the NetBackup Backup, Archive, and Restore client interface.

2 Select File > Select Files and Folders to Restore.
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3 Expand and browse the Active Directory node.

4 Select the objects to be restored. Do not select both granular and non-granular
objects. When a user explores and expands selections, a delay can occur
during communication with the NetBackup server. The delay is a result of
dynamically determining the contents from the image on the media server. The
approach prevents the NetBackup catalog from unanticipated growth due to
numerous granular entries.

5 Select Action > Restore.

6 If an Active Directory object is selected, the Restore Marked Files dialog box
contains two tabs:

■ General tab
When an Active Directory object is selected, the Restore Destination
Choices are disabled in theGeneral tab. Configure the other restore options
as needed.

■ Active Directory tab
The Active Directory tab contains an option to recreate the objects that
have been deleted: Recreate deleted objects that cannot be restored
from the Active Directory Deleted Objects container.
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TheActive Directory tab contains an option that lets administrators recreate
the objects whose tombstone lifetimes have passed. The objects have also
been purged from the Active Directory Deleted Objects container.
To allow this capability, enable the option labeledRecreate deleted objects
that cannot be restored from the Active Directory Deleted Objects
container.

7 Click Start Restore in the Restore Marked Files dialog box.

Some restore situations require additional steps, depending on what is restored.

See “Troubleshooting granular restore issues” on page 901.

Troubleshooting granular restore issues
Some granular restore situations require additional steps to fully restore the objects.
In other situations, a granular restore of some part of the Active Directory is not
possible.

Table 21-58 describes potential problems for granular restores.
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Table 21-58 Troubleshooting restore issues

RecommendationSituation

When user and computer accounts are restored from a granular Active Directory restore,
they are sometimes disabled.

The following are possible reasons why the accounts can be disabled:

■ When objects in Active Directory are deleted, they are removed from their current
Active Directory or ADAM/AD LDS container. They are converted into tombstones
and placed in the Active Directory Deleted Objects container where their tombstone
lifetime is monitored. By default, NetBackup restores deleted objects from this
container if the tombstone lifetime has not passed.
After the tombstone lifetime passes, the tombstones are purged from the Active
Directory Deleted Objects container. Purging the tombstones has the effect of
permanently deleting the objects from the Active Directory and ADAM/AD LDS
databases.

■ When restoring user objects, you must reset the object's user password and enable
the object's user account:
■ For Active Directory user objects, use the Microsoft Active Directory Users and

Computers application.
■ For ADAM/AD LDS user objects, use ADSI Edit.

In Active Directory, computer objects are derived from user objects. Some attributes
that are associated with a computer object cannot be restored when you restore a
deleted computer object. They can only be restored if the attributes were saved
through schema changes when the computer object was originally deleted.

■ Computer object credentials change every 30 days and the credentials from the
backup may not match the credentials that are stored on the actual computer. When
a computer object is restored it is disabled if the userAccountControl property
was not preserved in the deleted object.

Use the Microsoft Active Directory Users and Computers application to reset the
account of a computer object:
■ Remove the computer from the domain.
■ Re-join the computer to the domain. The security identifiers (SID) for the

computer remains the same since it is preserved when a computer object is
deleted. However, if the tombstone expired and a new computer object was
recreated, the SID is different.

Restores that are disabled
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Table 21-58 Troubleshooting restore issues (continued)

RecommendationSituation

To restore Active Directory group membership links may require that the restore job
be run twice.

For example, consider the case where a group and its member objects are deleted.

If a restore job contains both group objects and member objects, the job restores the
objects in alphabetical order. However, the group that is restored has a link dependency
on a member that does not exist yet. When the group is restored, the link cannot be
restored.

Run the restore again to restore all forward and backward links.

Group and member objects

NetBackup does not support granular restores of Group Policy Objects.Group policy objects
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Synthetic backups
This chapter includes the following topics:

■ About synthetic backups

■ Recommendations for synthetic backups and restores

■ Synthetic full backups

■ Synthetic cumulative incremental backups

■ Schedules that must appear in a policy for synthetic backups

■ Adding clients to a policy for synthetic backups

■ Change journal and synthesized backups

■ True image restore and synthesized backups

■ Displaying synthetic backups in the Activity Monitor

■ Logs produced during synthetic backups

■ Synthetic backups and directory and file attributes

■ Using the multiple copy synthetic backups method

■ Optimized synthetic backups

■ Optimized synthetic backups for deduplication

About synthetic backups
During a traditional full backup, all files are copied from the client to a master server
or a media server. The files are copied even though those files may not have
changed since the last incremental backup.
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When NetBackup creates a synthetic full backup, NetBackup detects whether new
or changed files have been copied to the media server during the last incremental
backup. The client does not need to be running to combine the full backups and
the incremental backups on the media server to form a new, full backup. The new,
full synthetic backup is an accurate representation of the clients’ file systems at the
time of the most recent full backup.

Because processing takes place on master and media servers instead of the client,
synthetic backups help to reduce the network traffic. Files are transferred over the
network only once. After the backup images are combined into a synthetic backup,
the tapes or disk that contain the component images can be recycled or reclaimed.
Synthetic backups can reduce the number of tapes or disk space in use.

Synthetic backups can be written to tape storage units or disk storage units, or a
combination of both. If the backups use tape, the backups can be synthesized when
drives are not generally in use. For example, if backups occur primarily at night,
the drives can synthesize full backups during the day.

The Synthetic Backup option is available under the following conditions:

■ The policy type must be either Standard or MS-Windows.

■ The Collect True Image Restore Information With Move Detection option
must be selected on the Policy Attributes tab.
See “Collect true image restore information (policy attribute) with and without
move detection” on page 754.

■ The schedule that is created for a synthetic backupmust haveSynthetic Backup
selected.
See “Synthetic backup (schedule attribute)” on page 800.

■ One of the following must be available:

■ Disk storage unit(s) with adequate space available.

■ Tape library(s) with multiple drives to read and write.
See “Recommendations for synthetic backups and restores” on page 905.

■ A combination of disk storage unit(s) and tape library(s).

Recommendations for synthetic backups and
restores

The synthetic full backup is a scalable solution for backing up remote offices with
manageable data volumes and low levels of daily change.
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If the clients experience a high rate of change daily, the incremental backups are
too large. In this case, a synthetic backup is no more helpful than a traditional full
backup.

Synthetic backups are supported on all media server platforms and tier one master
server platforms.

The following items describe recommendations to use synthesized backups to full
advantage, and situations under which synthesized backups are not supported:

Recommendations concerning backups:

■ Do not multiplex any backups that are to be synthesized because it is inefficient.
To synthesize multiplexed client images requires multiple passes over the source
media—one per client.
Performance issues can also occur if multiple streams are selected for
synthesized backups. The issues are similar to those encountered while
multiplexing synthesized backups. Back up to disk whenever possible to improve
multiple stream performance issues.

■ Veritas recommends that you not enable Expire after copy retention for any
storage units that are to be used with SLPs with either of the following:
Accelerator or synthetic backups. The Expire after copy retention can cause
images to expire while the backup runs. To synthesize a new full backup, the
SLP backup needs the previous backup image. If the previous image expires
during the backup, the backup fails.

■ Reduce the gap between the last incremental backup and the synthesized
backup. Since a synthetic backup does not involve direct contact with the client,
a synthetic backup is only as current as the last incremental backup. If there is
a concern to reduce a potential gap in backup coverage, run an incremental
backup before the synthetic backup.

■ You can create multiple copies with synthetic backups by using the multiple
copies synthetic backup method.
Although synthetic backups do support the use of storage lifecycle policies,
SLPs cannot be used for the multiple copy synthetic backups method.
See “Using the multiple copy synthetic backups method” on page 915.

■ Synthetic backups are not supported if any of the component images are
encrypted.

■ A user-generated backup cannot be used to generate a synthetic image. A
backup that is generated from a User Backup schedule or a User Archive
schedule cannot be used as one of the components of a synthetic backup.

■ Synthetic backups and optimized synthetic backups do not support Auto Image
Replication.
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Recommendations concerning restores:

■ The time that is required to perform a restore from a synthetic backup does not
increase significantly over time.

■ The restore times for both a complete synthetic backup and for a single file is
the same. It is the same whether the restore is from a traditional backup or from
a synthetic backup.

■ The restore time of a single directory may increase over time when sourced
from synthetic backups. The restore time depends on the pattern of file changes
within the directory.

■ Contrast a traditional full backup, which stores the files in file system order with
a synthetic full backup, which stores the files in last-file-accessed order. The
synthetic full contains the newest files at the front of the media and the
unchanged files at the end. Over time, the processing order introduces the
potential for fragmentation of a single directory across the synthetic full image.

■ Note that the scenario is limited to single directory restores. Single file restores
and full image restores from synthetic fulls are equal or better than from traditional
full backups, as noted in previous bullets.

■ If checkpoint restart is indicated for the policy, the backups that are produced
with the synthetic backup schedule are not checkpointed. The option is enabled
if Take checkpoints on the policy Attributes tab is enabled. If the Take
checkpoints option is enabled for a synthetic backup, the property has no effect.

Table 22-1 Recommendations when using disk storage or tape storage for
synthetic backups

RecommendationsStorage unit
type

Disk-based images are more efficient for synthesizing. NetBackup processes the newest component
images first in a synthesized backup, followed by sequentially older images. When two or more
component images are written to the same tape, the tape movement can be inefficient compared to
disk-based images.

Synthetic full backups are generated more quickly when built from disk-based incremental backups.
If the synthetic full backup is also generated on disk, the run time is even faster. The disk copy then
can be duplicated to tape.

Disk storage
units
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Table 22-1 Recommendations when using disk storage or tape storage for
synthetic backups (continued)

RecommendationsStorage unit
type

If tape is used instead of disk, the tape for the synthetic image must be different from the tape where
the component images reside.

The maximum drive usage applies only to the drive that is needed for writing the synthetic backup.
If any of the component images reside on tape, an additional drive is needed for reading.

If a single tape drive device is used to generate synthetic images, place component images in a hard
drive location first. In that way, a synthetic image can be generated with the single tape drive device.

Tape storage
units

Synthetic full backups
A synthetic backup can be a synthetic full or a synthetic cumulative backup.

The images that are used to create the synthetic image are known as component
images. For instance, the component images in a synthetic full are the previous full
image and the subsequent incremental images.

Figure 22-1 illustrates the creation of synthetic full backups (B, C, D) from an existing
full backup (A) and shows the incremental backups between full backups.
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Figure 22-1 Creation of synthetic full backups
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The traditional full backup (A) and the incremental backups are created in the
traditional manner: data is scanned, and then copied from the client’s file system
to the backup media. The synthetic backups do not interact with the client system
at all, but are instead synthesized on the media server.

See “Synthetic cumulative incremental backups” on page 910.

The following is an example of a synthetic full backup:

■ Create a Standard or MS-Windows policy for the clients you want to back up.
Include the following schedules:

■ A schedule for one full, traditional backup to run at least once.

■ A schedule for daily (Monday through Saturday) differential incremental
backups.

■ A schedule for weekly full, synthetic backups.

■ Make sure that the traditional full backup runs. If the backup does not complete,
run the backup manually.
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■ Per schedule, run daily, differential incremental backups for the clients throughout
the week. The last incremental backup for the week runs on Saturday.

■ Per schedule, run synthetic full backups for the clients on subsequent Sundays.

Note: The synthetic full backups in the scenario are only as current as the Saturday
incremental backup.

Synthetic cumulative incremental backups
The scenario to create a synthetic, cumulative incremental backup is similar to the
scenario to create a synthetic full backup. Remember, a cumulative incremental
backup includes all changes since the last full backup.

If a cumulative incremental backup exists that is newer than the last full backup, a
synthetic cumulative backup image is produced by consolidating the following
component backup images:

■ All differential incremental backups that were taken since the last cumulative
backup.

■ The last cumulative incremental backup. If no cumulative incremental backup
is available, only the differential incremental backups are used for the synthetic
image.

Figure 22-2 illustrates the creation of synthetic cumulative incremental backups (A,
B, C) from the latest cumulative incremental backup and shows the subsequent
differential incremental backups.
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Figure 22-2 Creation of synthetic cumulative backups

Cumulative and
differential
incremental backups
to disk (Mon-Sat)

A

Sunday's synthetic
cumulative Incremental
backup

B

Synthetic cumulative incremental
backup (Sunday)

C

Synthetic cumulative
incremental backup
(Sunday)

Incremental backups
(Mon-Sat)

Incremental backups
(Mon-Sat)

Sunday's synthetic
cumulative incremental
backup

A

B

Synthetic cumulative incremental
backup to tape (Sunday)

The following is an example of a synthetic cumulative backup:

■ Create a Standard or MS-Windows policy for the clients (5.0 or later) you want
to back up. Include the following schedules:

■ A schedule for one full, traditional backup to run at least once.

■ A schedule for daily (Monday through Saturday) differential incremental
backups.

■ A schedule for weekly cumulative incremental synthetic backups.

■ Make certain that the traditional full backup runs. If the backup does not complete,
run the backup manually.

■ Per schedule, run daily differential incremental backups for the clients throughout
the week. The last incremental for the week runs on Saturday.

■ Per schedule, run synthetic cumulative incremental backups for the clients on
subsequent Sundays.
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Note: The synthetic cumulative backups in the scenario are only as current as the
Saturday incremental backup.

Schedules that must appear in a policy for
synthetic backups

A policy for synthetic backups must contain one of the following types of schedules:

■ At least one traditional, full backup must be run successfully to create a full
image. The synthetic backup job fails if there is not at least one previous full
image.

■ Schedule(s) for incremental backups.
Incremental backups are necessary to capture the changes in the file system
since the last full or incremental backup. The synthetic backup job receives a
status code of 1 for a policy that contains full or incremental synthetic backup
schedules, but no incremental backup schedules.
The synthetic backup synthesizes all of the incremental backups to create a
new full or cumulative backup image. Therefore, the synthetic backup is only
as current as the last incremental backup.

Note: To configure a synthetic cumulative backup for any clients that are archive
bit-based (default), use only differential incremental backups for the traditional,
non-synthesized backups.

■ One full and one cumulative backup schedule with the Synthetic Backup option
selected.
See “Synthetic backup (schedule attribute)” on page 800.

Adding clients to a policy for synthetic backups
After clients are added to a synthetic backup policy, run a traditional, full backup of
the policy. A traditional backup is necessary before a synthetic backup can be
created.

Since Collect True Image Restore Information With Move Detection is required
for synthetic backups, all of the clients in the policy must support TIR.

See “Collect true image restore information (policy attribute) with and without move
detection” on page 754.
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Change journal and synthesized backups
If the Use Change Journal host property on a Windows client is enabled, the
property has no effect when the client is backed up using the synthetic backup
schedule.

See “Client Settings properties for Windows clients” on page 89.

True image restore and synthesized backups
Since the Collect true Image restore information with move detection policy
property must be enabled for synthetic backups, all clients that are included in the
policy must support TIR.

See “Collect true image restore information (policy attribute) with and without move
detection” on page 754.

The Keep true image restoration (TIR) information property indicates how long
TIR information in the image catalog is kept before it is pruned (removed). The
property is located in the master server Clean-Up host properties.

See “Clean-up properties” on page 66.

However, if a synthetic full and synthetic cumulative schedule was defined in the
policy, the TIR information is pruned from the component images until a subsequent
traditional or synthetic full or cumulative backup image has generated successfully.

Consider a situation where Keep true image restoration (TIR) information host
specifies that TIR information is pruned from the catalog after two days. On the
third day the TIR information is pruned only if a traditional or synthetic full backup
image has been generated.

If the TIR information was pruned from a component image and you accidentally
expire the most recent synthetic image, rerun the synthetic backup job to restore
automatically the TIR information to the catalog. In case the TIR information cannot
be restored due to bad, missing, or vaulted media, the synthetic backup job fails
with error code 136 (TIR info was pruned from the image file). If the problem is
correctable, run the synthetic backup again.

Displaying synthetic backups in the Activity
Monitor

A synthetic job is distinguished from a traditional full backup by the notation that is
indicated in the Data Movement field of the Activity Monitor. Synthetic jobs display
Synthetic as the Data Movement type while traditional backups display Standard.
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Logs produced during synthetic backups
When a synthetic backup is scheduled, NetBackup starts the bpsynth program to
manage the synthetic backup process. bpsynth plans how the synthetic backup is
built from the previous backup images.

If it is needed, bpsynth schedules the tape drive resources that are needed for the
synthetic backup. If the required resources are not available, the job fails with a
status code that indicates that a resource is needed.

If the resources can be obtained eventually but not immediately, the synthetic job
waits until the resources become available. A synthetic job may wait while a backup,
restore, or another synthetic backup job uses a drive.

bpsynth passes the information to programs bptm and bpdm so that tape and disk
images can be read or written. Catalog information is managed using bpdbm. Each
of these programs has a debug log file in the logs directory.

If problems occur with synthetic backups, the following debug logs are required to
diagnose the problem:

■ On the master server: bpsynth, bpdbm, and vnetd.

■ On the media server(s): bpcd, bptm (if any images are written to or from a tape
device), and bpdm (if any images are written to or from disk).
Note that several media servers can be involved if the component images are
on different nodes.

The log files for synthetic backups are described in the NetBackup Logging
Reference Guide.

However, bpsynth is used for each stream or client. To use bpsynth can be
inefficient with tape images since bpsynth needs a tape drive to write the new
image. Also, bpsynth may use the same component image volumes. One may
need to finish before the next can proceed.

Synthetic backups and directory and file attributes
For a synthetic backup to include directory and the file attribute changes, the change
must first be picked up by a component incremental backup. (For example, changes
like Access Control Lists (ACLs).)

On UNIX, changing an object’s ACL changes the ctime (inode change time) for
the object but not the mtime (data modification time). Since mtime triggers
incremental backups, the ACL change is not reflected in an incremental backup,
and therefore not in a synthetic full backup.
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To include ACL changes in backups, enter USE_CTIME_FOR_INCREMENTALS
in the bp.conf file on each UNIX client.

See “USE_CTIME_FOR_INCREMENTALS option for NetBackup clients”
on page 394.

For eachWindows client, enable Incrementals: Based onArchive Bit. The property
is found under NetBackup Management > Host Properties > Clients > selected
client(s) >Windows Client.

See “Client Settings properties for Windows clients” on page 89.

Using themultiple copy synthetic backupsmethod
The multiple copy synthetic backups method introduces the capability to produce
a second copy of a synthetic backup at a remote site as part of a normal synthetic
backup job.

This method provides the following benefits:

■ It eliminates the bandwidth cost of copying synthetic full backups to another
site.
Instead of duplicating a local synthetic full backup to a remote site to produce
a second copy, it is more efficient to produce the second copy by using data
movements only at the remote site.

■ It provides an efficient method to establish a dual-copy disaster recovery scheme
for NetBackup backup images.

Table 22-2 emphasizes how the synthetic full backup produced at the remote site
is a clone, or a second copy, of the first copy produced at the local site.

Table 22-2 Comparing synthetic copy process with and without method
enabled

Using the multiple copy synthetic backups
method:

Without using the multiple copy synthetic
backups method:

Step

Step 1 remains the same.A full backup is performed at the local site (Site A).1

Step 2 remains the same.The full backup is duplicated to the remote site (Site
B).

2

Step 3 remains the same.An incremental backup is performed at Site A.3

Step 4 remains the same.The incremental backup is duplicated to Site B.4

Step 5 remains the same.Steps 3 and 4 are repeated each time an incremental
schedule runs.

5
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Table 22-2 Comparing synthetic copy process with and without method
enabled (continued)

Using the multiple copy synthetic backups
method:

Without using the multiple copy synthetic
backups method:

Step

Step 6 remains the same.A full synthetic backup is produced at Site A.6

A full synthetic backup is produced at Site B from
images at Site B.

The full synthetic backup at the remote site is a second
copy of the synthetic backup at the local site.

The full backup is duplicated to Site B.7

Step 8 remains the same.Steps 2 through 7 repeat per backup scheduling
needs.

8

Figure 22-3 shows how no extra bandwidth is used to copy the synthetic full backup
from Site A to Site B.

Figure 22-3 Remote creation of synthetic full backup
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Configuring multiple copy synthetic backups
To configure a multiple copy synthetic backup, create a configuration file on the
master server for each synthetic backup policy for which a second copy is to be
produced.

The configuration file is a text file that is named after the policy and schedule:

multi_synth.policy.schedule

Create the file in the following location:

■ On Windows:
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install_path\NetBackup\db\config\multi_synth.policy.schedule

■ On UNIX:
/usr/openv/netbackup/db/config/multi_synth.policy.schedule

Configuration variables for multiple copy synthetic backups
The file format uses a traditional name-pair scheme for setting configuration
preferences. Each preference uses a key name that is separated from the preference
value by an equal sign with each name-value pair residing on a single line.

For example:

NAME=VALUE

Enter all values as integers.

Table 22-3 describes the configuration entries that can be included in the
configuration file.

Table 22-3 Configuration entries

PurposeEntry

Specifies the copy number of each source component for the second synthetic backup. Every
source backup must have a copy by this number unless SRC_COPY_FALLBACK is specified.
The default is 2.

SRC_COPY

Specifies the copy number for the second synthetic backup produced. The TARGET_COPY
value must be different from the copy number of the first synthetic backup (which is 1). Default
is 2.

TARGET_COPY

COPY is an alternate specification for SRC_COPY and TARGET_COPY.

If COPY is specified and either SRC_COPY and TARGET_COPY is not specified, the value for
COPY is used.

COPY

Specifies the storage unit name or storage unit group name where the second copy synthetic
backup is to be written. Use the special identifier __ANY__ to indicate that Any Available
storage unit can be used that is not configured to be on demand only. Note that there are
two underscores before and after ANY:

TARGET_STU=__ANY__

TARGET_STU
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Table 22-3 Configuration entries (continued)

PurposeEntry

The second synthetic backup is produced immediately following the first copy synthetic
backup if no errors occur during production of the first copy. If an error occurs during the
second copy, the FAIL_MODE value specifies the fate of the first copy job and image.

Specify one of the following:

■ FAIL_MODE=ALL

ALL means that if the second copy fails, the first copy and its job also fail. (Default.)
■ FAIL_MODE=ONE

ONE means that if the second copy fails, the failure does not affect the first copy job.

FAIL_MODE

Specifies whether production of the second copy is enabled or disabled. This entry turns on
the feature.

Specify one of the following:

■ ENABLED=YES

Production of the second copy is enabled. (Default.)
■ ENABLED=NO

Production of the second copy is disabled.

ENABLED

Specifies that if a copy by the number given in SRC_COPY or COPY does not exist, the synthetic
backup should use the primary backup.

The only valid value is the following:

SRC_COPY_FALLBACK=PRIMARY

SRC_COPY_FALLBACK

Specifies the volume pool for tape media, if one is used. If no volume pool is specified,
NetBackup uses the volume pool that is specified in the policy. If a volume pool is entered
for disk, the entry is ignored.

VOLUME_POOL

Multiple copy synthetic backups configuration examples
The following multiple copy synthetic configuration example takes advantage of
default values to produce the second synthetic copy.

TARGET_STU=disk_stu

The default source of copy 2 and the default destination copy 2.

In this example, the second copy targets a tape library (tape_stu). The configuration
specifies a volume pool (Synthetics) for the target copy.

The copy number for the multiple copy synthetic backup is copy 3. If copy 3 is
unavailable, SOURCE_COPY_FALLBACK indicates that copy 3 can be produced using
the primary copy.
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If copy 3 fails, only copy 3 fails and not the job of the primary copy.

TARGET_STU=tape_stu

VOLUME_POOL=Synthetics

SOURCE_COPY_FALLBACK=PRIMARY

COPY=3

ENABLED=YES

FAIL_MODE=ONE

Optimized synthetic backups
NetBackup environments that use the Data Protection Optimization Option license
can benefit from the optimized synthetic backup method. Optimized synthetic
backups take advantage of the capabilities of the OpenStorage API.

This method constructs the synthetic image by using calls from the media server
to the storage server. The media server tells the storage server which full and
incremental images to use to create the synthetic backup. Then, the storage server
constructs (or synthesizes) the synthetic image directly on the storage server,
reducing network traffic.

For more information, see the following guides:

■ NetBackup Deduplication Guide

■ NetBackup OpenStorage Solutions Guide for Disk

Optimized synthetic backups for deduplication
NetBackup environments that use the NetBackup Data Protection Optimization
Option license can benefit from the optimized synthetic backup method.

This method constructs the synthetic image by using calls from the backup server
to the storage server. The backup server tells the storage server which full and
incremental images to use to create the synthetic backup. Then, the storage server
constructs (or synthesizes) the synthetic image directly on the storage server,
reducing network traffic.

For more information, see the following guides:

■ NetBackup Deduplication Guide

■ NetBackup OpenStorage Solutions Guide for Disk
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Protecting the NetBackup
catalog

This chapter includes the following topics:

■ About the NetBackup catalog

■ Parts of the NetBackup catalog

■ Protecting the NetBackup catalog

■ Recovering the catalog

■ Disaster recovery emails and the disaster recovery files

■ Disaster recovery packages

■ About disaster recovery settings

■ Setting a passphrase to encrypt disaster recovery packages

■ Archiving the catalog and restoring from the catalog archive

■ Estimating catalog space requirements

About the NetBackup catalog
A NetBackup catalog is the internal database that contains information about
NetBackup backups and configuration. Backup information includes records of the
files that have been backed up and the media on which the files are stored. The
catalogs also contain information about the media and the storage devices.

Since NetBackup needs the catalog information so that it can restore client backups,
configure a catalog backup before using NetBackup for regular client backups.
Schedule the catalog backups to occur on a regular basis. Without regular catalog
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backups, you risk losing regular backups if there is a problem with the disk that
contains the catalogs.

For information on how to configure catalog backups in Windows clustered
environments, see the NetBackup Clustered Master Server Administrator's Guide.

Parts of the NetBackup catalog
The NetBackup catalog resides on the NetBackup master server. It manages and
controls access to the following types of data:

■ Image metadata (information about backup images and copies (image header
files)).

■ Backup content data (information about the folders, files, and the objects in a
backup (.f files)).

■ NetBackup backup policies.

■ NetBackup licensing data.

■ The NetBackup error log.

■ The client database.

■ Cloud configuration files.
See “About the catalog backup of cloud configuration files” on page 930.

The catalog consists of the following parts:

■ Relational database files.
NetBackup uses the SQL Anywhere Relational Database Management System
to store information in the NetBackup database (NBDB). The metadata includes
information about the data that has been backed up, and about where the data
is stored.
See “About the NetBackup relational database” on page 924.

■ The image database.
The image database contains information about the data that has been backed
up.
See “About the NetBackup image database” on page 928.

■ NetBackup configuration files.
The configuration files (databases.conf and server.conf) are flat files that
contain instructions for the SQL Anywhere daemon.
See “About the NetBackup server.conf file” on page 968.
See “About the databases.conf file” on page 970.
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NetBackup is sensitive to the location of the master server components. Running
any part of NetBackup (the binaries, the logs, the database, the images) on a
network share (NFS, for example) can affect performance of even normal operations.

NetBackup can be CIFS-mounted on SAN or NAS storage as long as the average
I/O service times remain less than 20 milliseconds.

The storage must also meet certain conditions to ensure the Sybase requirement
for data integrity:

■ The order of file writes must be guaranteed.

■ When a write request is issued, the write must complete to the physical storage.
The write request must not merely be buffered when the SAN or the NAS returns
from the write call.
See the following article for more information:
http://www.veritas.com/docs/TECH158868
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Figure 23-1 Catalog configuration on Windows computers
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Figure 23-2 Catalog configuration on UNIX computers
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About the NetBackup relational database
NetBackup installs Sybase SQL Anywhere during the master server installation as
a private, non-shared server for the NetBackup database. The NetBackup database
(NBDB) is also known as the EnterpriseMedia Manager (EMM) database. It contains
information about volumes, and the robots and drives that are in NetBackup storage
units.

The same installation of Sybase SQL Anywhere is used for the optionally-licensed
product, Bare Metal Restore (BMR) database. The BMRDB database contains the
information that the NetBackup Bare Metal Restore option manages. The BMR
database is created during the BMR installation process.

See “About the NetBackup image database” on page 928.

See “About the NetBackup relational database (NBDB) installation” on page 964.

See “Post-installation tasks” on page 999.
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About the NetBackup relational database on Windows
As part of the catalog backup, the database and the configuration files for the NBDB
database (including the NetBackup Authorization database, NBAZDB) and the
BMRDB databases are protected as follows:

■ Database files:

■ install_path\NetBackupDB\data\BMR_DATA.db (if BMR is installed)

■ install_path\NetBackupDB\data\BMRDB.db (if BMR is installed)

■ install_path\NetBackupDB\data\BMRDB.log (if BMR is installed)

■ install_path\NetBackupDB\data\BMR_INDEX.db (if BMR is installed)

■ install_path\NetBackupDB\data\DARS_DATA.db

■ install_path\NetBackupDB\data\DARS_INDEX.db

■ install_path\NetBackupDB\data\DBM_DATA.db

■ install_path\NetBackupDB\data\DBM_INDEX.db

■ install_path\NetBackupDB\data\EMM_DATA.db

■ install_path\NetBackupDB\data\EMM_INDEX.db

■ install_path\NetBackupDB\data\JOBD_DATA.db

■ install_path\NetBackupDB\data\NBAZDB.db

■ install_path\NetBackupDB\data\NBAZDB.db.template

■ install_path\NetBackupDB\data\NBAZDB.log

■ install_path\NetBackupDB\data\NBDB.db

■ install_path\NetBackupDB\data\NBDB.log

■ install_path\NetBackupDB\data\SEARCH_DATA.db

■ install_path\NetBackupDB\data\SEARCH_INDEX.db

■ install_path\NetBackupDB\data\SLP_DATA.db

■ install_path\NetBackupDB\data\SLP_INDEX.db

Note: NetBackup does not support saving the NetBackup relational database
(NBDB, including NBAZDB and EMM) or the configuration files to a remote NFS
share. CIFS is supported on some SAN or NAS storage.

See “Parts of the NetBackup catalog” on page 921.
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■ Configuration files:

■ install_path\NetBackupDB\data\vxdbms.conf

■ install_path\NetBackupDB\conf\server.conf

■ install_path\NetBackupDB\conf\databases.conf

Note: The catalog backup process copies this data to
install_path\NetBackupDB\staging and backs up the copy.

About the NetBackup relational database on UNIX
As part of the catalog backup, the database and the configuration files for the NBDB
database (including the NetBackup Authorization database, NBAZDB) and the
BMRDB databases are protected as follows:

■ Database files

■ /usr/openv/db/data/BMR_DATA.db (if BMR is installed)

■ /usr/openv/db/data/BMRDB.db (if BMR is installed)

■ /usr/openv/db/data/BMRDB.log (if BMR is installed)

■ /usr/openv/db/data/BMR_INDEX.db (if BMR is installed)

■ /usr/openv/db/data/DARS_DATA.db

■ /usr/openv/db/data/DARS_INDEX.db

■ /usr/openv/db/data/DBM_DATA.db

■ /usr/openv/db/data/DBM_INDEX.db

■ /usr/openv/db/data/EMM_DATA.db

■ /usr/openv/db/data/EMM_INDEX.db

■ /usr/openv/db/data/JOBD_DATA.db

■ /usr/openv/db/data/NBAZDB.db

■ /usr/openv/db/data/NBAZDB.db.template

■ /usr/openv/db/data/NBAZDB.log

■ /usr/openv/db/data/NBDB.db

■ /usr/openv/db/data/NBDB.log

■ /usr/openv/db/data/SEARCH_DATA.db
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■ /usr/openv/db/data/SEARCH_INDEX.db

■ /usr/openv/db/data/SLP_DATA.db

■ /usr/openv/db/data/SLP_INDEX.db

Note: NetBackup does not support saving the NetBackup relational database
(NBDB, including NBAZDB and EMM) or the configuration files to a remote NFS
share. CIFS is supported on some SAN or NAS storage.

See “Parts of the NetBackup catalog” on page 921.

■ Configuration files

■ /usr/openv/db/data/vxdbms.conf

■ /usr/openv/var/global/server.conf

■ /usr/openv/var/global/databases.conf

Note: The catalog backup process copies this data to /usr/openv/db/staging
and backs up the copy.

About the Enterprise Media Manager (EMM)
The Enterprise Media Manager (EMM) is a NetBackup service that manages the
device and the media information for NetBackup. The Enterprise Media Manager
stores its managed information in a database that resides on the master server.
The NetBackup Resource Broker queries EMM to allocate storage units, drives
(including drive paths), and media.

EMM contains the following information:

■ Device attributes

■ Robotic library and standalone drive residence attributes

■ NDMP attributes

■ Barcode rule attributes

■ Volume pool attributes

■ Tape attributes

■ Media attributes

■ Storage unit attributes
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■ Storage unit group attributes

■ Hosts with assigned tape drives

■ Media and device errors

■ Disk pool and disk volume attributes

■ Storage server attributes

■ Log on credentials for storage servers, disk arrays, and NDMP hosts

■ Fibre Transport attributes

EMM ensures consistency between drives, robotic libraries, storage units, media,
and volume pools across multiple servers. EMM contains information for all media
servers that share devices in a multiple server configuration.

The NetBackup scheduling components use EMM information to select the server,
drive path, and media for jobs. When the device manager ltid starts up, it reads
device information from EMM into a shared memory segment. Components on the
same host communicate by using shared memory IPC or socket protocols. Socket
protocols are used between components across multiple hosts. Command line
interfaces are available to obtain run-time (shared memory) information and static
device configuration information.

See “About the NetBackup relational database” on page 924.

About the NetBackup image database
The image database contains subdirectories for each client that is backed up by
NetBackup, including the master server and any media servers.

The image database is located in the following location:

■ Windows: Program Files\Veritas\Netbackup\db\images

■ UNIX: /usr/openv/netbackup/db/images

The image database contains the following files:

Files that store only backup set summary information.Image files

Used to prevent simultaneous updates on images..lck files

Used to store the detailed information about each file backup.Image .f files

Used to ensure that access to the db directory is valid when the
NetBackup Database Manager starts up. Do not delete this file.

db_marker.txt
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The image database is the largest part of the NetBackup catalog. It consumes about
99% of the total space that is required for the NetBackup catalog. While most of
the subdirectories are relatively small in the NetBackup catalogs, \images (Windows)
or /images (UNIX) can grow to hundreds of gigabytes. The image database on the
master server can grow too large to fit on a single tape. Image database growth
depends on the number of clients, policy schedules, and the amount of data that
is backed up.

See “Estimating catalog space requirements” on page 955.

If the image catalog becomes too large for the current location, consider moving it
to a file system or disk partition that contains more space.

See “Moving the image catalog” on page 957.

The image database component of the NetBackup catalog uses the .f files in binary
format for Windows, Solaris, and Linux platforms.

The catalog conversion utility (cat_convert) can be used to upgrade an image
database to the binary format.

Information about the cat_convert command is available in the NetBackup
Commands Reference Guide.

See “Estimating catalog space requirements” on page 955.

About NetBackup image files
Each image file is an ASCII file, generally less than 1 kilobyte in size. An image file
contains only backup set summary information. For example, the backup ID, the
backup type, the expiration date, fragment information, and disaster recovery
information.

About NetBackup image .f files
The binary catalog contains one or more image .f files. This type of file is also
referred to as a files-file. The image .f file may be large because it contains the
detailed backup selection list for each file backup. Generally, image files range in
size from 1 kilobyte to 10 gigabytes.

The .f files are found in the following location:

Windows: install_path\NetBackup\db\images\clientname\ctime

UNIX: /usr/openv/netbackup/db/images/clientname/ctime/

The file layout determines whether the catalog contains one .f file or many .f files.
NetBackup configures the file layout automatically, based on the size of the binary
catalog. NetBackup uses one of two layouts: single file layout or multiple file layout.
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■ Image .f file single file layout
NetBackup stores file information in a single image.f file if the information for
the catalog is less than 100 megabytes.
When the backup file of one catalog backup is less than 100 megabytes,
NetBackup stores the information in a single image.f file. The image.f file is
always greater than or equal to 72 bytes, but less than 100 megabytes.
The following is a UNIX example of an .f file in a single file layout:

-rw------- 1 root other 979483 Aug 29 12:23 test_1030638194_FULL.f

■ Image .f file multiple file layout
When the file information for one catalog backup is greater than 100 megabytes,
the information is stored in multiple .f files: one main image .f file plus nine
additional .f files.
Separating the additional .f files from the image .f file and storing the files in
the catstore directory improves performance while writing to the catalog.
The main image.f file is always exactly 72 bytes.

-rw- 1 root other 72 Aug 30 00:40 test_1030680524_INCR.f

-rw- 1 root other 804 Aug 30 00:08 catstore/test_1030680524_INCR.f-list

-rw- 1 root other 1489728 Aug 30 00:39 catstore/test_1030680524_INCR.f_imgDir0

-rw- 1 root other 0 Aug 30 00:40 catstore/test_1030680524_INCR.f_imgExtraObj0

-rw- 1 root other 1280176 Aug 30 00:39 catstore/test_1030680524_INCR.f_imgFile0

-rw- 1 root other 192 Aug 30 00:40 catstore/test_1030680524_INCR.f_imgHeader0

-rw- 1 root other 0 Aug 30 00:40 catstore/test_1030680524_INCR.f_imgNDMP0

-rw- 1 root other 9112680 Aug 30 00:39 catstore/test_1030680524_INCR.f_imgRecord0

-rw- 1 root other 2111864 Aug 30 00:39 catstore/test_1030680524_INCR.f_imgStrings0

-rw- 1 root other 11 Aug 30 00:40 catstore/test_1030680524_INCR.f_imgUserGroupNames0

About the catalog backup of cloud configuration files
The following cloud configuration files are backed up during the NetBackup catalog
backup process:

■ All .txt files in the meter directory, which contain intermediate metering data

■ CloudInstance.xml

■ CloudProvider.xml

■ cloudstore.conf

■ libstspiencrypt.conf

■ libstspimetering.conf
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■ libstspithrottling.conf

■ libstspicloud_provider_name.conf

All .conf files that are specific to the cloud providers that NetBackup supports

The cloud configuration files that are backed up during the catalog backup process
reside at the following location:

install_path\Veritas\NetBackup\var\global\wmc\cloudWindows

/usr/openv/var/global/wmc/cloudUNIX

Note: The cacert.pem file is not backed up during the NetBackup catalog backup
process.

This cacert.pem file is a cloud provider-specific file. This file is installed as part of
the NetBackup installation. This file includes the certificates of NetBackup supported
Certificate Authorities (CA).

Protecting the NetBackup catalog
In order for NetBackup to restore any file, NetBackup needs information from the
catalog to determine where the backup for the file is located. Without a catalog,
NetBackup cannot restore data.

Because the catalog plays an integral part in a NetBackup environment, a special
type of backup protects the catalog. A catalog backup backs up catalog-specific
data as well as produces disaster recovery information.

A catalog backup is configured separately from regular client backups by using the
Catalog Backup Wizard. The catalog can be stored on a variety of media.

Configure a catalog backup before you run any regular backups.

Note: If portions of the catalog are relocated, note the changes so that subsequent
catalog backups are aware of the locations of all the catalog components. In the
event that a catalog recovery is needed, the same alterations must be implemented
before the recovery of the catalog.

Note: To perform a catalog backup, the master server and the media server must
both be at the same NetBackup version.

See the NetBackup Installation Guide for information about mixed version support.
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As additional protection for the catalog, consider archiving the catalog.

See “Archiving the catalog and restoring from the catalog archive” on page 949.

The NetBackup Troubleshooting Guide provides helpful setup information to aid in
disaster recovery. Since the catalog plays a critical role in the NetBackup
environment, much of the information concentrates on catalog considerations.

About catalog backups
The catalog backup is designed for active environments in which continual backup
activity occurs. The catalog backup can be performed while regular backup activity
occurs.

The catalog backup is policy-based so it has all of the scheduling flexibility of a
regular backup policy. Because the policy allows for incremental backups, catalog
backup times for large catalogs can be significantly reduced. For Sybase SQL
Anywhere, an incremental backup means a backup of the transaction log only.
Transaction logs are managed automatically and truncated after each successful
backup.

The catalog lets you recover either the entire catalog or pieces of the catalog. (For
example, the databases separately from the image catalog.)

The catalog backup performs the following tasks:

■ Backs up the catalog while continual client backups are in progress.

■ Performs a full or an incremental catalog backup.

■ Runs the scheduled catalog backups.

■ Copies the relational database files to the staging directory and then backs up
that directory.

■ Creates the disaster recovery package.

■ Catalog backups to tape also include the following items:

■ Spans multiple tapes for a catalog backup.

■ Allows for a flexible pool of catalog tapes.
Catalog backups to tape use media from the CatalogBackup volume pool
only.

■ Appends to existing data on tape.

You can configure a catalog backup by using one of the following methods:

■ By using wizards:

■ The Catalog Backup Wizard.
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See “Using the Catalog Backup Wizard to configure a catalog backup”
on page 933.

■ The Policy Configuration Wizard.
See “Using the Policy Configuration Wizard to configure a catalog backup”
on page 936.

Either wizard automatically includes all the necessary catalog files to include
the database files (NBDB, NBAZDB, and BMRDB) and any catalog configuration
files (vxdbms.conf, server.conf, databases.conf).

■ By creating a backup policy manually and indicating the NBU-Catalog policy
type.
See “Configuring a catalog backup manually” on page 938.

Note: Before you create a new catalog backup policy, you must ensure that a
passphrase for the disaster recovery package is set.

See “Disaster recovery packages” on page 945.

See “Setting a passphrase to encrypt disaster recovery packages” on page 947.

If the passphrase is not set, catalog backups fail.

Using the Catalog Backup Wizard to configure a catalog backup
Catalog backups write only to media in the CatalogBackup volume pool. This
procedure assumes that a storage device is configured and media is available in
the CatalogBackup volume pool.

Note: To perform a catalog backup, the master server and the media server must
both be at the same NetBackup version.

See the NetBackup Installation Guide for information about mixed version support.

Before you create a new catalog backup policy, you must ensure that a passphrase
for the disaster recovery package is set. If the passphrase is not set, catalog backups
may fail.
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To use the Catalog Backup Wizard to configure a catalog backup

1 In theNetBackup Administration Console, in the left pane, clickNetBackup
Management.

2 In the right pane, click Configure the Catalog Backup to launch the
NetBackup Catalog Backup Wizard.

Click Help within any wizard panel for more information on the wizard settings.

3 Click Next on theWelcome panel.

4 On the NetBackup Catalog Backup Policy panel, select a policy from the list
of existing catalog backup policies.

5 Or, to create a new catalog backup policy, selectCreate a new catalog backup
policy. Click Next.

6 In the Policy Name and Type wizard panel, enter the policy name. Notice that
NBU-Catalog is automatically selected as the policy type.

Enter a unique name for the new policy in the Add a New Policy dialog box.

See “NetBackup naming conventions” on page 1163.

Click Next.

7 On the Backup Type wizard panel, select the backup type. The User Backup
does not apply for NBU-Catalog policies. Click Next.

8 On the Rotation wizard panel, select the rotation schedule. By default, a
frequency-based schedule is selected. A frequency-based schedule ensures
that the catalog backup has an opportunity to run in busy environments where
backup jobs are running.

The selection After each backup session refers to a period when no regular
backup policy is running.

Catalog backups can be scheduled to run concurrently with other backup types
on the master server.

See “Concurrently running catalog backups with other backups” on page 941.

Click Next.

9 In the Start Window wizard panel, define a window of time during which the
catalog backup can start and click Next. The scheduled windows (Off hours,
Working hours, All day, Custom) are preset in the wizard. To change these
settings, first complete the wizard. Then, select the policy in the Policies utility.

User Window selections are disabled, as regular users (those who are not
NetBackup administrators) cannot start catalog backups.
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10 On the Catalog Disaster Recovery File wizard panel, browse or enter the
path where each disaster recovery image file can be saved on disk. The image
file contains the disaster recovery information. Enter the logon and password
information, if necessary.

Veritas recommends that you save the image file to a network share or a
removable device. Do not save the disaster recovery information to the local
computer. You must also record this location so that Veritas Catalog can be
recovered, if required.

Click Next.

11 Veritas recommends that you configure the NetBackup environment to send
the disaster recovery information to a NetBackup administrator. This
backup-specific information is sent after every catalog backup.

On the E-mail Disaster Recovery Information wizard panel, enter one or
more addresses. To send the information to more than one administrator,
separate multiple email addresses using a comma as follows:

email1@domain.com,email2@domain.com

Make sure that email notification is enabled in your environment.

See “Disaster recovery emails and the disaster recovery files” on page 944.

Note: The disaster recovery email is not sent to the address that is specified
in the Global Attributes properties. The Administrator’s email Address in
the Global Attributes properties specifies the addresses where NetBackup
sends notifications of scheduled backups or administrator-directed manual
backups.

12 The last panel of the Policy Wizard describes that once the policy is created,
you can make changes in NetBackup Management > Policies. Click Finish
to create the policy.

13 The Catalog Backup Wizard resumes, with the new catalog backup policy
listed.

14 Click Next to finish the Catalog Backup Wizard.
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15 The final Catalog Backup Wizard panel displays the total number of catalog
backup policies for this master server. Click Finish to complete the wizard.

16 You may want to add critical policies to the Critical Policies list. Specify some
policies as critical policies after the Catalog Backup Wizard is complete. A
policy that is listed on the Critical Policies list is considered crucial to the
recovery of a site in the event of a disaster.

See “Adding policies to the Critical Policies list of a catalog backup policy”
on page 892.

The NetBackup Disaster Recovery report lists the media that is used for
backups of critical policies. The report lists the media for only incremental and
full backup schedules, so critical policies should use only incremental or full
backup schedules.

See “Strategies that ensure successful NetBackup catalog backups”
on page 943.

See “Determining whether or not a catalog backup succeeded” on page 943.

Using the Policy ConfigurationWizard to configure a catalog backup
Catalog backups write only to media in the CatalogBackup volume pool. This
procedure assumes that a storage device is configured and media is available in
the CatalogBackup volume pool.

Note: To perform a catalog backup, the master server and the media server must
both be at the same NetBackup version.

See the NetBackup Installation Guide for information about mixed version support.

Before you create a new catalog backup policy, you must ensure that a passphrase
for the disaster recovery package is set. If the passphrase is not set, catalog backups
fail.

To use the Policy Configuration Wizard to configure a catalog backup

1 In theNetBackup Administration Console, in the left pane, clickNetBackup
Management.

2 In the right pane, click Create a Policy in the right pane to launch the Policy
Configuration Wizard.

Click Help within any wizard panel for more information on the wizard settings.

3 Select the Files systems, databases, applications option from the list. Click
Next.
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4 In the Policy Name and Type wizard panel, enter the policy name. Select
NBU-Catalog as the policy type.

Click Next.

See “NetBackup naming conventions” on page 1163.

5 On theBackup Typeswizard panel, select the backup type. TheUser Backup
does not apply for NBU-Catalog policies. Click Next.

6 On the Frequency and Retention wizard panel, select the rotation schedule.
By default, a frequency-based schedule is selected. A frequency-based
schedule ensures that the catalog backup has an opportunity to run in busy
environments where backup jobs are running.

The selection After each backup session refers to a period when no regular
backup policy is running.

Catalog backups can be scheduled to run concurrently with other backup types
on the master server.

See “Concurrently running catalog backups with other backups” on page 941.

Click Next.

7 In the Start Window wizard panel, define a window of time during which the
catalog backup can start and click Next. The scheduled windows (Off hours,
Working hours, All day, Custom) are preset in the wizard. To change these
settings, first complete the wizard. Then, select the policy in the Policies utility
and customize the settings.

User Window selections are disabled, as regular users (those who are not
NetBackup administrators) cannot start catalog backups.

8 On the Catalog Disaster Recovery File wizard panel, browse or enter the
path where each disaster recovery image file can be saved on disk. The image
file contains the disaster recovery information. Enter the logon and password
information, if necessary.

Veritas recommends that you save the image file to a network share or a
removable device. Do not save the disaster recovery information to the local
computer. You must also record this location so that NetBackup Catalog can
be recovered, if required.

Click Next.

937Protecting the NetBackup catalog
Protecting the NetBackup catalog



9 Veritas recommends that you configure the NetBackup environment to send
the disaster recovery information to a NetBackup administrator. This
backup-specific information is sent after every catalog backup.

To send the information to more than one administrator, separate multiple
email addresses using a comma as follows:

email1@domain.com,email2@domain.com

Make sure that email notification is enabled in your environment.

See “Disaster recovery emails and the disaster recovery files” on page 944.

Note: The disaster recovery email is not sent to the address that is specified
in the Global Attributes properties. The Administrator’s email Address in
the Global Attributes properties specifies the addresses where NetBackup
sends notifications of scheduled backups or administrator-directed manual
backups.

10 Click Finish to complete the wizard.

11 You may want to add critical policies to the Critical Policies list. Specify some
policies as critical policies after the Policy ConfigurationWizard is complete.
A policy that is listed on the Critical Policies list is considered crucial to the
recovery of a site in the event of a disaster.

See “Adding policies to the Critical Policies list of a catalog backup policy”
on page 892.

The NetBackup Disaster Recovery report lists all of the media that is used
for backups of critical policies, including the most recent full backup. The report
lists the media for only incremental and full backup schedules, so critical policies
should use only incremental or full backup schedules.

Configuring a catalog backup manually
You can configure a catalog backup manually by using the Policy utility. This
procedure assumes that a storage device is configured and media is available in
the CatalogBackup volume pool.
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To configure a catalog backup manually

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Policies.

Note: Before you create a new catalog backup policy, you must ensure that a
passphrase for the disaster recovery package is set.

See “Disaster recovery packages” on page 945.

See “Setting a passphrase to encrypt disaster recovery packages” on page 947.

If the passphrase is not set, catalog backups fail.

2 Select Actions > New > Policy.

3 Enter a unique name for the new policy in the Add a New Policy dialog box.

See “NetBackup naming conventions” on page 1163.

Click OK.

4 On the Attributes tab, complete the following entries:

■ Policy Type
Select NBU-Catalog as the policy type.

■ Policy storage
For disk storage units, increase the Maximum Concurrent Jobs storage
unit setting to ensure that the catalog backup can proceed during regular
backup activity.
See “Maximum concurrent jobs storage unit setting” on page 608.

Note: The media server that is used for catalog backups must be at the
same NetBackup version as the master server. If your installation contains
media servers of various levels, do not select Any Available for the
destination Policy Storage Unit. If media servers are at various versions,
a media server at a level other than the master server could be selected.

■ Policy volume pool
NetBackup automatically creates a CatalogBackup volume pool that is
selected by default only for NBU-Catalog policy types.

■ For other policy attribute descriptions, see the following topic:
See “Policy Attributes tab” on page 726.
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5 Select the Schedules tab to set up a schedule for a catalog backup.

See “Concurrently running catalog backups with other backups” on page 941.

See “About catalog policy schedules” on page 941.

See “Schedule Attributes tab” on page 790.

Note: The Clients tab does not apply to the NBU-Catalog policy and does not
appear.

6 The Disaster Recovery tab appears for NBU-Catalog policies only.

The tab contains information regarding the location of data crucial to disaster
recovery.

■ Browse or enter the path where each disaster recovery image file can be
saved on disk. The image file contains the disaster recovery information.
Enter the logon and password information, if necessary.
Veritas recommends that you save the image file to a network share or a
removable device. Do not save the disaster recovery information to the
local computer.

7 You may want to add critical policies to the Critical Policies list. The Critical
Policies list contains the names of policies that back up critical data. Media
that contains critical policy backups is listed on the NetBackup Disaster
Recovery Report that is generated when the catalog backup is run. The report
lists the media for only incremental and full backup schedules, so critical policies
should use only incremental or full backup schedules.

Click OK to save the policy.

Backing up NetBackup catalogs manually
Catalog backups typically run automatically per the NBU-Catalog policy. However,
a catalog backup can be started manually.

A manual catalog backup is useful in the following situations:

■ To perform an emergency backup. For example, if the system is schedule to be
moved and you cannot wait for the next scheduled catalog backup.

■ If there is only one standalone drive and the standalone drive is used for catalog
backups. In this situation, automatic backups are not convenient. The catalog
backup tape must be inserted before each catalog backup and removed when
the backup is done. (The tape swap is necessary because NetBackup does not
mix catalog and regular backups on the same tape.)
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To perform a manual catalog backup

1 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Policies.

2 Select the catalog backup policy you want to run.

3 Select Actions > Manual Backup.

See “Performing manual backups” on page 896.

You can also run the bpbackup command from the command line to perform
a catalog backup.

More information is available in the NetBackup Commands Reference Guide.

Concurrently running catalog backups with other backups
You can schedule catalog backups to run concurrently with other backup types for
the master server.

Make the following adjustments to ensure that the catalog backup can proceed
while regular backup activity occurs:

■ Set the Maximum jobs per client value to greater than one. The property is
found in the Global Attributes host properties for the master server.
See “Global Attributes properties” on page 136.

■ Increase the Maximum concurrent jobs setting on the storage unit where the
backups are sent.
See “Maximum concurrent jobs storage unit setting” on page 608.

See “Determining whether or not a catalog backup succeeded” on page 943.

See “Strategies that ensure successful NetBackup catalog backups” on page 943.

About catalog policy schedules
When you work with catalog policy schedules, consider the following:

■ The schedules that are supported in the catalog backup policy type are as
follows:

■ Full

■ Differential incremental (depends on a full schedule)

■ Cumulative incremental

■ Session-based differential incremental

■ Session-based cumulative incremental
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■ Veritas recommends that only one catalog backup policy be configured.

■ The media server that is used for catalog backups must be at the same
NetBackup version as the master server.

■ The incremental schedule depends on a full schedule.

■ The least frequent schedule runs if many schedules are due at the same time.

■ One catalog backup policy can contain multiple incremental schedules that are
session-based:

■ If one is cumulative and the others are differential, the cumulative runs when
the backup session ends.

■ If all are cumulative or all are differential, the first schedule that is found runs
when the backup session ends.

■ The queued scheduled catalog backup is skipped if a catalog backup job from
the same policy is running.

■ Session end means that no jobs are running. (This calculation does not include
catalog backup jobs.)

■ The Vault catalog backup is run whenever triggered from Vault, regardless of
whether a catalog backup job is running from the same policy.

■ When an online catalog backup is run, it generates three jobs: A parent job, a
child job for NetBackup relational database tables, and a child job for catalog
images and configuration data. The child jobs contain the actual backed up data.
Consider both child jobs to duplicate, verify, or expire the backup.

How catalog incrementals and standard backups interact on UNIX
A catalog backup policy can include both full catalog backups and incremental
catalog backups. However, incremental catalog backups differ from incremental
standard backups. Catalog backups use both mtime and ctime to identify changed
data. Standard incremental backups use only mtime to identify changed data.

Because of this difference, running a standard policy type backup that includes the
/usr/openv/netbackup/db/images/ directory can adversely affect incremental
catalog backups. When standard backups run, they reset the file access time
(atime). In turn, the reset changes the ctime for files and directories. If an
incremental catalog backup runs, it sees that the ctime has changed and backs
up the files. The backup may be unnecessary since the files may not have changed
since the last catalog backup.

To avoid additional processing during catalog backups, Veritas recommends the
following:
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If incremental catalog backups are configured, exclude the NetBackup
/usr/openv/netbackup/db/images/ directory from standard backups.

To exclude that directory, create a /usr/openv/netbackup/exclude_list file on
the master server.

See “About NetBackup master server installed directories and files” on page 967.

Determining whether or not a catalog backup succeeded
The All Log Entries, Problems, and Media Log reports, available from the Reports
utility, provide information on NetBackup catalog backups.

An email message is sent to the address that is indicated in theDisaster Recovery
settings for a catalog backup.

Configure this email with the mail_dr_info.cmd (onWindows) or the mail_dr_info
script (on UNIX).

See the Administrator’s Guide, Volume II for more information on setting up this
script.

Strategies that ensure successful NetBackup catalog backups
Use the following strategies to ensure successful catalog backups:

■ Use only the methods that are described in this chapter to back up the catalogs.
These are the only methods that can track all relevant NetBackup activities and
ensure consistency between the catalog files.

■ Back up the catalogs often. If catalog backup files are lost, the changes that
were made between the last catalog backup and the time of the disk crash are
lost.

■ If you back up your catalogs to disk, always back up to a different disk than
where the catalog files reside. If you back up the catalog to the disk where the
actual catalog resides, both catalog backups are lost if the backup disk fails.
Recovering the catalog is much more difficult. Also, ensure that the disk has
enough space for the catalogs. Backups to a full disk fail.

Note: If a catalog backup is on tape, the tape must be removed when the backup
is finished or regular backups cannot proceed. NetBackup does not mix catalog
and regular backups on the same tape.
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Recovering the catalog
Catalog recovery is discussed in the NetBackup Troubleshooting Guide.

Disaster recovery emails and the disaster
recovery files

The Catalog Backup Wizard and the Policy Configuration Wizard prompt you
to send the disaster recovery information to an email address. If the catalog backup
is configured manually using the Policy utility, this information appears on the
Disaster Recovery tab.

The disaster recovery email and the accompanying attachments that are sent
contain the following important items for a successful catalog recovery:

■ A list of the media that contains the catalog backup.

■ A list of critical policies.

■ Instructions for recovering the catalog.

■ The image file as an attachment.
If a catalog backup policy included both full backups and incremental backups,
the attached image file can be a full or an incremental catalog backup.
Recovering from an incremental catalog backup completely recovers the entire
catalog if the Automatically recover the entire NetBackup catalog option is
selected on the wizard panel. The entire catalog is recovered because the
incremental catalog backup references information from the last full backup.
You do not need to recover the last full catalog backup before you recover the
subsequent incremental backups.

■ The disaster recovery package (.drpkg file) as an attachment.

Note: If you are not able to receive the disaster recovery packages over emails
even after the disaster recovery email configuration, and then ensure the
following:

Your email exchange server is configured to have the attachment size equal to
or greater than the disaster recovery package size. You can check the size of
the package (.drpkg file size) on the disaster recovery file location that you
have specified in the catalog backup policy.

The firewall and the antivirus software in your environment allows the files with
the .drpkg extension (which is the extension of a disaster recovery package
file).
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NetBackup emails the disaster recovery file when the following events occur:

■ The catalog is backed up.

■ A catalog backup is duplicated or replicated.

■ The primary catalog backup or any copy expires automatically or is expired
manually.

On Windows: You can tailor the disaster recovery email process by providing the
mail_dr_info.cmd script in the install_path\Veritas\NetBackup\bin directory.
This script is similar to the nbmail.cmd script. See the comments in the nbmail.cmd
script for use instructions.

Disaster recovery packages
For increased security, a disaster recovery package is created during each catalog
backup. The disaster recovery package file has .drpkg extension.

The disaster recovery package stores the identity of the master server host.
NetBackup requires this package to get the identity of the master server back after
a disaster. Once you have recovered the host identity, you can perform the catalog
recovery.

The disaster recovery package contains the following information:

■ NetBackup CA-signed certificates and private keys of themaster server certificate
and the NetBackup certificate authority (CA) certificate

■ Information about the hosts in the domain

■ Security settings

Note: You must set a passphrase for the disaster recovery package for the catalog
backups to be successful.

See “About catalog backups” on page 932.

See “About disaster recovery settings” on page 945.

See “Setting a passphrase to encrypt disaster recovery packages” on page 947.

About disaster recovery settings
For increased security, a disaster recovery package is created during each catalog
backup.

See “Disaster recovery packages” on page 945.
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During each catalog backup, a disaster recovery package is created and encrypted
with the passphrase that you set. You need to provide this encryption passphrase
while you install NetBackup on the master server in a disaster recovery mode after
a disaster.

The following options are displayed on the Disaster Recovery tab:

Table 23-1 Disaster recovery settings

DescriptionSetting

Enter the passphrase to encrypt disaster recovery packages.

■ The passphrase must contain a minimum of 8 and a
maximum of 1024 characters.

■ The existing passphrase and the new passphrase must
be different.

■ Only the following characters are supported for the
passphrase: White spaces, uppercase characters (A to
Z), lowercase characters (a to z), numbers (0 to 9), and
special characters. Special characters include: ~ ! @ #
$ % ^ & * ( ) _ + - = ` { } [ ] | : ; ' , . / ? < > "

See “Setting a passphrase to encrypt disaster recovery
packages” on page 947.

Passphrase

Re-enter the passphrase for confirmation.Confirm Passphrase

Caution: Ensure that the passphrase contains only the supported characters. If
you enter a character that is not supported, you may face problems during disaster
recovery package restore. The passphrase may not be validated and you may not
be able to restore the disaster recovery package.

Note the following before you modify the passphrase for
the disaster recovery packages:
■ Subsequent disaster recovery packages are encrypted with the new passphrase

that you set.

■ If you change the passphrase anytime, it is not changed for the previous disaster
recovery packages. Only new disaster recovery packages are associated with
the new passphrase.

■ Passphrase that you provide while you install NetBackup on the master server
in a disaster recovery mode after a disaster must correspond to the disaster
recovery package fromwhich you want to recover the master server host identity.

946Protecting the NetBackup catalog
About disaster recovery settings



Setting a passphrase to encrypt disaster recovery
packages

During each catalog backup, a disaster recovery package is created and encrypted
with the passphrase that you set.

See “Disaster recovery packages” on page 945.

Workflow to set a passphrase to encrypt disaster recovery
packages and use it after a disaster:

Review the following workflow to learn about disaster recovery package restore:

1. Set an encryption passphrase for disaster recovery packages.

2. Create a catalog policy.

See “Configuring a catalog backup manually” on page 938.

Consider the following scenarios:

■ If you have not set the passphrase earlier, NetBackup prevents you from
configuring a new catalog backup policy.

■ If the catalog backup policy is upgraded from a previous version, catalog
backups continue to fail until the passphrase is set.

Note: Catalog backups may fail with status code 144 even though the
passphrase is set. This is because the passphrase may be corrupted. To
resolve this issue, you must reset the passphrase.

3. After a disaster, when you install NetBackup on the master server in a disaster
recovery mode, provide the passphrase that you have set earlier. NetBackup
decrypts the disaster recovery package using this passphrase and gets the
identity of the master server back during installation.

Caution: If you fail to provide the appropriate passphrase while you install
NetBackup on the master server after a disaster, you may need to redeploy
the security certificates on all NetBackup hosts. For more details, refer to the
following article:

http://www.veritas.com/docs/000125933
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4. Once the master server identity is back in place, the secure communication
between the master server and the media server is established and you can
perform catalog recovery.

5. After successful catalog recovery, you must set the disaster recovery package
passphrase again, because the passphrase is not recovered during the catalog
recovery. Catalog backups that you configure in a new NetBackup instance
continue to fail until you set the passphrase.

To set or modify a passphrase

1 In the NetBackup Administration Console, expand Security Management
> Global Security Settings.

2 In the details pane, click the Disaster Recovery tab.

See “About disaster recovery settings” on page 945.

3 Provide Passphrase and Confirm Passphrase.

Review the following password rules:

■ The existing passphrase and the new passphrase must be different.

■ The passphrase must contain a minimum of 8 and a maximum of 20
characters.
The passphrase must contain a minimum of 8 and a maximum of 1024
characters.

■ Only the following characters are supported for the passphrase: White
spaces, uppercase characters (A to Z), lowercase characters (a to z),
numbers (0 to 9), and special characters. Special characters include: ~ !
@ # $ % ^ & * ( ) _ + - = ` { } [ ] | : ; ' , . / ? < > "

Caution: If you enter a character that is not supported, you may face
problems during disaster recovery package restore. The passphrase may
not be validated and you may not be able to restore the disaster recovery
package.

4 Click Save. If the passphrase already exists, it is overwritten.
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To set or modify a passphrase using the command-line interface

1 The NetBackup administrator must be logged on to the NetBackup Web
Management Service to perform this task. Use the following command to log
on:

bpnbat -login -loginType WEB

2 Run the following command to set a passphrase to encrypt disaster recovery
packages:

nbseccmd -drpkgpassphrase

3 Enter the passphrase.

If a passphrase already exists, it is overwritten.

Archiving the catalog and restoring from the
catalog archive

Catalog archiving helps administrators solve the kinds of problems that large
amounts of catalog data can pose: large catalogs require a greater amount of disk
space and can be time-consuming to back up.

Catalog archiving reduces the size of online catalog data by relocating the large
catalog .f files (files files) to secondary storage. NetBackup administration continues
to require regularly scheduled catalog backups, but the backups are faster without
the large amount of online catalog data.

Catalog archiving should not be used as a method to reclaim disk space when a
catalog file system fills up. In that situation, investigate catalog compression or add
disk space to grow the file system.

For additional catalog archiving considerations, see the following topic:

See “Catalog archiving considerations” on page 954.
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To archive the catalog and restore the catalog archive

1 Use bpcatlist to determine what images are available to be archived.

Running bpcatlist alone does not modify any catalog images. Only when the
bpcatlist output is piped to bpcatarc are the .f files backed up, and only
when the output is piped to bpcatrm will the .f files be deleted from disk.

To determine what images have .f files on disk that can be archived, run the
following command. The catarcid column indicates whether the .f file is not
currently backed up (0) or the catarcid of the backup of that image.

/usr/openv/netbackup/bin/admincmd/bpcatlist -online

To determine what images have been previously archived and removed from
disk, run the following command.

/usr/openv/netbackup/bin/admincmd/bpcatlist -offline

The catalog commands are described in detail in the following topic:

See “Catalog archiving commands” on page 952.

Note: If catalog archiving has not been previously run, this command should
return: No entity was found.

For example, to display all images for a specific client before January 1, 2017,
run the following command:

bpcatlist -client name -before Jan 1 2017

To display the help for the bpcatlist command run this command.

bpcatlist -help

Once the bpcatlist output correctly lists all the images that are to be archived
or deleted, other commands can be added.
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2 Running the catalog archive.

Before running the catalog archive, create a backup policy named catarc. The
policy is required for the bpcatarc command to successfully process images.
The name of the policy reflects that the purpose of the schedule is for catalog
archiving.

See the following topic for details about configuring the catarc policy:

See “Creating a catalog archiving policy” on page 951.

To run the catalog archive, first run the bpcatlist command with the same
options used in step 1 to display images. Then pipe the output through bpcatarc
and bpcatrm.

bpcatlist -client all -before Jan 1 2017 | bpcatarc | bpcatrm

A new job appears in theActivity Monitor. The command waits until the backup
completes before it returns the prompt. The command reports an error only if
the catalog archive fails, otherwise the commands return to the prompt.

The File List: section of the Job Details in the Activity Monitor displays a list
of image files that have been processed. When the job completes with a status
0, the bpcatrm command removes the corresponding .f files. If the job fails,
no catalog .f files are removed.

If bpcatlist is piped to bpcatarc but the results are not piped to bpcatrm,
the backup occurs but the .f files are not removed from disk. The same
bpcatlist command can then be rerun and piped to bpcatrm to remove the
.f files.

3 Restoring the catalog archive.

To restore the catalog archive, first use the bpcatlist command to list the
files that need to be restored. Once bpcatlist displays the proper files to
restore, run the bpcatres command to restore the actual files.

To restore all the archived files from step 2, run the following command:

bpcatlist -client all -before Jan 1 2017 | bpcatres

This command restores all of the catalog archive files before January 1, 2017.

Creating a catalog archiving policy
The catalog archiving feature requires the presence of a policy named catarc before
the catalog archiving commands can run properly. The policy can be reused for
catalog archiving.
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To create a catalog archiving policy

1 Create a new policy and name it catarc. The catarc policy waits until bpcatarc
can activate it. Users do not run this policy. Instead, bpcatarc activates this
special policy to perform a catalog backup job, then deactivates the policy after
the job is done.

2 In theAttributes policy tab, set the Policy type to Standard orMS-Windows,
according to the platform of the master server.

3 In the Attributes policy tab, deactivate the catalog archive policy by clearing
the Go into effect at field.

See “Go into effect at (policy attribute)” on page 742.

4 Select the Schedules tab and click New to create a schedule.

In the Attributes schedule tab, the Name of the schedule is not restricted, but
the Type of backup must be User Backup.

5 Select a Retention for the catalog archive. Set the retention level for a time at
least as long as the longest retention period of the backups being archived.
Data can be lost if the retention level of the catalog archive is not long enough.

You may find it useful to set up, and then designate a special retention level
for catalog archive images.

6 Select the Start Window tab and define a schedule for the catarc policy.

The schedule must include in its window the time when the bpcatarc command
is run. If the bpcatarc command is run outside of the schedule, the operation
fails.

7 Click OK to save the schedule.

8 On the Clients tab, enter the name of the master server as it appears on the
NetBackup servers list.

9 On the Backup Selections tab, browse to the directory where catalog backup
images are placed:

On Windows: install_path\NetBackup\db\images

On UNIX: /usr/openv/netbackup/db/images

10 Save the policy.

Catalog archiving commands
The catalog archiving option relies on three commands to designate a list of catalog
.f files, then archive the files. A fourth command, bpcatres, is used to restore the
files if necessary.
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Catalog archiving uses the following commands.

Table 23-2 Catalog archiving commands

DescriptionCommand

The bpcatlist command queries the catalog data. Then, bpcatlist lists the portions of the
catalog that are based on selected parameters. For example, date, client, policy, schedule name,
backup ID, the age of the backup image, or the date range of the backup image. bpcatlist
outputs the formatted image summary information of matched images to standard output.

The other catalog archiving commands, bpcatarc, bpcatrm, and bpcatres, all depend on
input from bpcatlist by a piped command.

For example, to archive (backup and delete) all of the .f files that were created before January
1, 2012, the following would be entered:

bpcatlist -client all -before Jan 1 2012 | bpcatarc | bpcatrm

bpcatlist is also used to provide status information.

For each catalog, it lists the following information:

■ Backup ID (Backupid)
■ Backup date (Backup Date)
■ Catalog archive ID (catarcid). After one .f file is successfully backed up, a catalog archive

ID is entered into the catarcid field in the image file. This field is zero (0) if the image was
never archived.

■ Archived status (S). Indicates whether the catalog was archived (2) or was not archived (1).
■ Compressed status (C). Indicates whether the catalog was compressed (positive_value) or

was not compressed (0).
■ Catalog file name (Files file)

The following is an example of the bpcatlist output, showing all of the backups for client alpha
since October 23:

# bpcatlist -client alpha -since Oct 23
Backupid Backup Date ...Catarcid S C Files file
alpha_097238 Oct 24 10:47:12 2012 ... 973187218 1 0 alpha_097238_UBAK.f
alpha_097233 Oct 23 22:32:56 2012 ... 973187218 1 0 alpha_097233_FULL.f
alpha_097232 Oct 23 19:53:17 2012 ... 973187218 1 0 alpha_097232_UBAK.f

More information is available in the NetBackup Commands Reference Guide.

bpcatlist

The bpcatarc command reads the output from bpcatlist and backs up the selected list of
.f files. After one .f file is successfully backed up, a catalog archive ID is entered into the
catarcid field in the image file. For archiving of the.f files to proceed, a policy by the name of
catarc is required. The policy is based on aUser Backup type schedule. The schedule for catarc
must include in its window the time bpcatarc command is run.

See “Creating a catalog archiving policy” on page 951.

bpcatarc
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Table 23-2 Catalog archiving commands (continued)

DescriptionCommand

The bpcatrm command reads the output from bpcatlist or bpcatarc. If the image file has
valid catarcid entries, bpcatrm deletes selected image.f files from the online catalog.

bpcatrm does not remove one .f file unless the file has been previously backed up using the
catarc policy.

bpcatrm

Use the bpcatres command to restore the catalog. The bpcatres command reads the output
from bpcatlist and restores selected archived.f files to the catalog. For example:

bpcatlist -client all -before Jan 1 2012 | bpcatres

bpcatres

Catalog archiving considerations
Consider the following items before catalog archiving:

■ Perform catalog archiving operations when NetBackup is in an inactive state
(no jobs are running).

■ Catalog archiving modifies existing catalog images. As a result, it should never
be run when the catalog file system is 100% full.

■ To ensure that catalog backup images are not on the same tapes as user
backups, create a separate media pool for catalog archives.

■ You may find it useful to set up and then designate, a special retention level for
catalog archive images.
To specify retention levels, go toHost Properties > Master Server > Retention
Periods.
See “Retention Periods properties” on page 203.

■ Additional time is required to mount the tape and perform the restore of archived
.f files.

■ There is no simple method to determine to which tape the catalog has been
archived. The bpcatlist -offline command is the only administrative
command to determine what images have been archived. This command does
not list what tape was used for the archive. As a result, exercise caution to
ensure that the tapes used for catalog archiving are available for restoring the
archived catalog images. Either create a separate volume pool to use exclusively
for catalog archives or find a method to label the tape as a catalog archive tape.
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Extracting images from the catalog archives
The situation may arise in which a storage provider needs to extract all of a specific
client’s records. The storage provider can extract the customer images from the
catalog archive by creating the archives that are based on client name.

To extract images from the catalog archives based on a specific client

1 Create a volume pool for the client.

2 Create a catalog archiving policy. Indicate the volume pool for that client in the
Attributes tab.

3 Run bpcatlist so only the.f files from that client are listed. For example:

bpcatlist -client clientname | bpcatarc | bpcatrm

4 If you do not want to write more images to the client’s volume pool, change
the volume pool before you run another archiving catalog.

Estimating catalog space requirements
NetBackup requires disk space to store its error logs and information about the files
it backs up.

The disk space that NetBackup needs varies according to the following factors:

■ Number of files to be backed up

■ Frequency of full and incremental backups

■ Number of user backups and archives

■ Retention period of backups

■ Average length of full path of files

■ File information (such as owner permissions)

■ Average amount of error log information existing at any given time

■ Whether you have enabled the database compression option.

To estimate the disk space that is required for a catalog backup

1 Estimate the maximum number of files that each schedule for each policy backs
up during a single backup of all its clients.

2 Determine the frequency and the retention period of the full and the incremental
backups for each policy.
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3 Use the information from steps 1 and 2 to calculate the maximum number of
files that exist at any given time.

For example:

Assume that you schedule full backups to occur every seven days. The full
backups have a retention period of four weeks. Differential incremental backups
are scheduled to run daily and have a retention period of one week.

The number of file paths you must allow space for is four times the number of
files in a full backup. Add to that number one week’s worth of incremental
backups.

The following formula expresses the maximum number of files that can exist
for each type of backup (daily or weekly, for example):

Files per Backup × Backups per Retention Period = Max Files

For example:

A daily differential incremental schedule backs up 1200 files and the retention
period for the backup is seven days. Given this information, the maximum
number of files that can exist at one time are the following:

1200 × 7 days = 8400

A weekly full backup schedule backs up 3000 files. The retention period is four
weeks. The maximum number of files that can exist at one time are the
following:

3000 × 4 weeks = 12,000

Obtain the total for a server by adding the maximum files for all the schedules
together. Add the separate totals to get the maximum number of files that can
exist at one time. For example, 20,400.

For the policies that collect true image restore information, an incremental
backup collects catalog information on all files (as if it were a full backup). This
changes the calculation in the example: the incremental changes from 1200
× 7 = 8400 to 3000 × 7 = 21,000. After 12,000 is added for the full backups,
the total for the two schedules is 33,000 rather than 20,400.

4 Obtain the number of bytes by multiplying the number of files by the average
number of bytes per file record.

If you are unsure of the average number of bytes per file record, use 132. The
results from the examples in step 3 yield:

(8400 × 132) + (12,000 × 132) = 2692800 bytes (or about 2630 kilobytes)
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5 Add between 10 megabytes to 15 megabytes to the total sum that was
calculated in step 4. The additional megabytes account for the average space
that is required for the error logs. Increase the value if you anticipate problems.

6 Allocate space so all the data remains in a single partition.

NetBackup file size considerations on UNIX systems
File system limitations on UNIX include the following:

■ Some UNIX systems have a large file support flag. Turn on the flag to enable
large file support.

■ Set the file size limit for the root user account to unlimited to support large file
support.

About the binary catalog format
The catalog in a binary file format has several advantages over the catalog in a text
format:

■ The catalog is more compact. The binary representations of numbers, dates,
and other information, takes up less disk space than the text representations.

■ The catalog is much faster to browse and search, especially for large file sizes.

■ The catalog supports alternate backupmethods without the need to post-process
images, which improve catalog performance for alternate backup methods.

The following points describe size the limitations that are associated with the binary
catalog:

■ The maximum number of files that can be backed up per image:
(231) –1 files = 2,147,483,647 files = 7FFFFFFF files

■ The maximum number of different user IDs and group IDs (combined):
(231) –1 IDs = 2,147,483,647 IDs = 7FFFFFFF IDs

See “About NetBackup image .f files” on page 929.

Moving the image catalog
An image catalog may become too large for its current location. Consider moving
the image catalog to a file system or disk partition that contains more available
space.

Notes about moving the image catalog
■ NetBackup does not support saving the catalog to a remote NFS share. CIFS

is supported on some SAN or NAS storage.
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See “Parts of the NetBackup catalog” on page 921.

■ NetBackup only supports moving the image catalog to a different file system or
disk partition. It does not support moving the other subdirectories that make up
the entire NetBackup catalog.
For example, on Windows, do not use the ALTPATH mechanism to move
install_path\NetBackup\db\error.
For example, on UNIX, do not move /usr/openv/netbackup/db/error. The
catalog backup only follows the symbolic link when backing up the /images

directory. So, if symbolic links are used for other parts of the NetBackup catalog,
the files in those parts are not included in the catalog backup.

■ The directory that is specified in the ALTPATH file is not automatically removed
if NetBackup is uninstalled. If NetBackup is uninstalled, you must manually
remove the contents of this directory.

Moving the image catalog between Windows hosts
To move the image catalog on Windows

1 Back up the NetBackup catalogs manually.

A backup of the catalogs ensures that you can recover image information in
case something is accidentally lost during the move.

See “Backing up NetBackup catalogs manually” on page 940.

2 Check the Jobs tab in the Activity Monitor and ensure that no backups or
restores are running for the client.

If jobs are running, either wait for them to end or stop them by using the Jobs
tab in the Activity Monitor.

3 Use the Daemons tab in the Activity Monitor to stop the Request Manager
and the Database Manager daemons. These services are stopped to prevent
jobs from starting. Do not modify the database while this procedure is
performed.

4 Create a file named ALTPATH in the image catalog directory.

For example, if NetBackup is installed in the default location and the client
name is mars, the path to the image catalog is:

C:\Program Files\Veritas\NetBackup\db\images\mars\ALTPATH

5 Create the directory to which you intend to move the image information. For
example:

E:\NetBackup\alternate_db\images\client_name
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6 On the first line of the ALTPATH file, specify the path to the directory where you
intend to move the client’s image information. For example:

E:\NetBackup\alternate_db\images\client_name

The path is the only entry in the ALTPATH file.

7 Move all files and directories (except the ALTPATH file) that are in the current
client directory to the new directory.

For example, if the images are currently in

C:\Program Files\Veritas\NetBackup\db\images\mars

and the ALTPATH file specifies

E:\NetBackup\alternate_db\images\mars

then move all files and directories (except the ALTPATH file) to

E:\NetBackup\alternate_db\images\mars

8 Start the NetBackup Request Daemon and NetBackup Database Manager in
the Daemons tab.

Backups and restores can now resume for the client.

Moving the image catalog between UNIX hosts
To move the image catalog on UNIX

1 Check that no backups are in progress by running:

/usr/openv/netbackup/bin/bpps

2 Stop bprd by running:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

3 Stop bpdbm by running:

/usr/openv/netbackup/bin/bpdbm -terminate

4 Create the directory in the new file system. For example:

mkdir /disk3/netbackup/db/images

5 Move the image catalog to the new location in the other file system.

6 Create a symbolic link from /usr/openv/netbackup/db/images to the new
location in the other file system.

See “NetBackup file size considerations on UNIX systems” on page 957.
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About image catalog compression
The image catalog contains information about all client backups. It is accessed any
time a user lists or restores files. NetBackup lets you compress all portions of the
catalog or only older portions of the catalog. No method selectively compresses
image catalog files other than by age.

Control image catalog compression by setting the Global Attributes property,
Compress Catalog Interval. Use this property to specify how old the backup
information must be before it is compressed. Specify the number of days to defer
compression information, thus users who restore files from recent backups are
unaffected. By default, Compress Catalog Interval is set to 0 and image
compression is not enabled.

See “Global Attributes properties” on page 136.

Note: Veritas discourages manually compressing or decompressing the catalog
backups with the bpimage -[de]compress command or any other method. Manually
compressing or decompressing a catalog backup while any backup (regular or
catalog) is running results in inconsistent image catalog entries. When users list
and restore files, the results can be incorrect.

It does not make a difference to NetBackup if the backup session was successful.
The operation occurs while NetBackup expires backups and before it runs the
session_notify script and the backup of the NetBackup catalogs.

The time to perform compression depends on the server speed and the number
and size of the files being compressed. Files are compressed serially, and temporary
working space is required in the same partition.

When numerous compressed image catalog files must be processed, the backup
session is extended until compression is complete. The additional backup time is
especially noticeable the first time you perform the compression. To minimize the
effect of the initial sessions, consider compressing the files in stages. For example,
begin by compressing the records for the backups older than 120 days. Continue
to reduce the number of days over a period of time until you reach a comfortable
setting.

Compressing the image catalog accomplishes the following objectives:

■ Reduces greatly the disk space that is consumed.

■ Reduces the media that is required to back up the catalog.

The amount of space that is reclaimed varies with the types of backups you perform.
Full backups result in a larger percentage of catalog compression than incremental
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backups. Normally, more data is duplicated in a catalog file for a full backup. Using
catalog compression, a reduction of 80% is possible.

This reduction in disk space and media requirements is achieved at the expense
of performance when a user lists or restores files. Since the information is
uncompressed at each reference, performance degradation is in direct proportion
to the number and size of compressed files that are referenced. If the restore
requires numerous catalog files to be uncompressed, increase the timeout value
that is associated with list requests.

Change the timeout value by changing the List Files Timeout General property
setting on the client. Or, on UNIX clients, change the timeout value by changing
the LIST_FILES_TIMEOUT option in the bp.conf file.

Figure 23-3 List Files Timeout General property on the client

Uncompressing the NetBackup catalog
You may find it necessary to uncompress all records temporarily that are associated
with an individual client. Uncompress the records if you anticipate large or numerous
restore requests, for example.

Use the following procedure to uncompress the NetBackup catalog.

To uncompress the NetBackup catalog on Windows

1 Verify that the partition where the image catalog resides contains enough space
to accommodate the uncompressed catalog.

See “Estimating catalog space requirements” on page 955.

2 Stop the NetBackup Request Daemon service, bprd. Use the Activity Monitor
or the Services application in the Windows Control Panel.
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3 Verify that the NetBackup Database Manager, bpdbm, is running.

4 In theNetBackupAdministrationConsole, expandNetBackupManagement
> Host Properties >Master Server. Double-click the host to be uncompressed.

5 Select the Global Attributes properties.

See “Global Attributes properties” on page 136.

6 Clear the Compress Catalog Interval check box and click OK to save the
host property change.

7 Open a command prompt. Change to the following directory:

install_path\Veritas\NetBackup\bin\admincmd

Run one of the followings commands.

To decompress the records for a specific client, enter:

bpimage -decompress -client_name

To decompress the records for all clients, enter:

bpimage -decompress -allclients

8 Restart the NetBackup Request Daemon bprd.

To uncompress the NetBackup catalog on UNIX

1 Perform the following steps as root on the master server to uncompress the
NetBackup catalog.

Verify that the partition where the image catalog resides has enough space to
uncompress the client’s image records.

2 Stop the request daemon, bprd, by running:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

3 Make sure that bpdbm is running:

/usr/openv/netbackup/bin/bpps

4 Expand Host Properties > Master Servers. Open the properties of a host.
On the Global Attributes properties, clear the Compress Catalog Interval
check box.

See “Global Attributes properties” on page 136.

5 Set the Compress Catalog Interval Global Attributes property to 0.

6 Change your working directory to /usr/openv/netbackup/bin and run the
command:

admincmd/bpimage -decompress -client name
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7 Restart the request daemon, bprd, by running:

/usr/openv/netbackup/bin/initbprd

8 Perform the file restorations from the client.

9 Set the Compress Catalog After Global Attributes property to its previous
value.

The records that were uncompressed for this client are compressed after the
next backup schedule.

See “About image catalog compression” on page 960.
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About the NetBackup
relational database

This chapter includes the following topics:

■ About the NetBackup relational database (NBDB) installation

■ Using the NetBackup Database Administration utility on Windows

■ Using the NetBackup Database Administration utility on UNIX

■ Post-installation tasks

■ About backup and recovery procedures

■ Unloading the NetBackup database

■ Terminating database connections

About the NetBackup relational database (NBDB)
installation

The following information can help you to install and operate the Sybase SQL
Anywhere relational database management system.

Generally, the implementation of Sybase SQL Anywhere in the NetBackup catalog
is transparent. NetBackup installs Sybase SQL Anywhere during the master server
installation as a private, non-shared server for the NetBackup database (NBDB).
NBDB contains the NetBackup Authorization database, the Enterprise Media
Manager (EMM) data, as well as other NetBackup data that NetBackup services
use.
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The same installation of Sybase SQL Anywhere is used for the optionally-licensed
product, Bare Metal Restore (BMR) and its associated database (BMRDB). The
BMR database is created during the BMR installation process.

By default, the NetBackup relational database (NBDB) is installed on the master
server. The master server is also the default location for the Enterprise Media
Manager (EMM). Since EMM is the primary user of NBDB, the NetBackup database
always resides on the same computer as the Enterprise Media Manager.

See “About the Enterprise Media Manager (EMM)” on page 927.

Note: NetBackup does not support saving the NetBackup relational database
(NBDB, including NBAZDB and EMM) or the configuration files to a remote NFS
share. CIFS is supported on some SAN or NAS storage.

See “Parts of the NetBackup catalog” on page 921.

Installing the NetBackup database
The following procedure is performed automatically during installation in the order
presented. You can also use the same procedure to manually install the database
independently.

Installing the NetBackup database

1 As part of the NetBackup master server installation, the SQL Anywhere server
is created. The server parameters are set in the server.conf file in the following
location:

On Windows: install_path\Veritas\NetBackupDB\conf\server.conf

On UNIX: /usr/openv/var/global/server.conf

See “About the NetBackup server.conf file” on page 968.

2 On Windows: The following entry is added to the registry to set the database
location:

HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\

Config\VXDBMS_NB_DATA

See “About the NetBackup configuration entry” on page 976.

3 On UNIX: The following entry is added to the bp.conf file to set the database
location:

VxDBMS_NB_DATA = /usr/openv/db/data
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4 On Windows: The VxDBMS configuration file for NetBackup is created. This
file requires the read and write permissions of a Windows administrator:

install_path\Veritas\NetBackupDB\data\vxdbms.conf

5 On UNIX: The VxDBMS configuration file for NetBackup is created. This file
requires the read and write permissions of root:

/usr/openv/db/data/vxdbms.conf

6 The NetBackup database is created:

On Windows: install_path\Veritas\NetBackupDB\data\NBDB.db

On UNIX: /usr/openv/db/data/NBDB.db

7 DBA password is set for the NetBackup database in vxdbms.conf:

VXDBMS_NB_PASSWORD = encrypted_password

8 Additional database files are created with contiguous space pre-allocated:

■ The NetBackup system database file that is mentioned in the following step:
On Windows: install_path\Veritas\NetBackupDB\data\NBDB.db
On UNIX: /usr/openv/db/data/NBDB.db

■ The EMM database files:
On Windows:
install_path\Veritas\NetBackupDB\data\EMM_DATA.db

install_path\Veritas\NetBackupDB\data\EMM_INDEX.db

On UNIX:
/usr/openv/db/data/EMM_DATA.db

/usr/openv/db/data/EMM_INDEX.db

■ The authorization database files for NetBackup Access Control:
On Windows: install_path\Veritas\NetBackupDB\data\NBAZDB.db
On UNIX: /usr/openv/db/data/NBAZDB.db

■ The NetBackup transaction log, necessary for recovering the database:
On Windows: install_path\Veritas\NetBackupDB\data\NBDB.log
On UNIX: /usr/openv/db/data/NBDB.log
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9 The SQL Anywhere accounts and schema are created for each of the
NetBackup components that make use of the NetBackup database. (For
example, EMM_MAIN.)

10 The following command initializes the EMM data:

On Windows: install_path\Veritas\Volmgr\bin\tpext.exe

On UNIX: /usr/openv/volmgr/bin/tpext

See “About catalog backups” on page 932.

About NetBackup master server installed directories and files
SQL Anywhere is installed in the following directories:

On Windows
install_path\Veritas\NetBackupDB

install_path\Veritas\NetBackup\bin

The files in install_path\Veritas\NetBackupDB\conf can be shared within a
cluster.

On UNIX
/usr/openv/db

/usr/openv/var/global

The files in /global can be shared within a cluster.

The contents of each directory are examined in the following topics.

Relocating the NetBackup database
The NetBackup database, NBDB, and its associated files, is created on the master
server by default. For performance reasons, NBDB can be moved to another host.

On Windows: The NBDB database files can be moved from their default location
in install_path\Veritas\NetBackupDB\data.

On UNIX: The NBDB database files can be moved from their default location in
/usr/openv/db/data.

See “Moving NBDB database files after installation” on page 1000.
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Note: NetBackup does not support saving the NetBackup relational database
(NBDB, including NBAZDB and EMM) or the configuration files to a remote NFS
share. CIFS is supported on some SAN or NAS storage.

See “Parts of the NetBackup catalog” on page 921.

Note: If Bare Metal Restore is installed, BMRDB must be located on the master
server.

See “Moving NBDB database files after installation” on page 1000.

See “Moving the NetBackup database files” on page 986.

See “About the Move Database menu options” on page 996.

About the NetBackup server.conf file
Veritas recommends that this file not be edited without assistance from technical
support. NetBackup may not start if the server.conf file is edited.

On Windows
The install_path\VERITAS\NetBackupDB\conf\server.conf file is read when
the SQL Anywhere service is started. The SQL Anywhere service gets all
configuration information from this file:

-n NB_server_name

-x tcpip(LocalOnly=YES;ServerPort=13785) -gd DBA -gk DBA -gl DBA -gp

4096 -ti 0 -c 200M -ch 1365M -cl 200M -wc- -gna 1 -k -os 1M -m -o

"C:\Program Files\Veritas\NetBackupDB\log\server.log" -m

On UNIX
The /usr/openv/var/global/server.conf file is read when the SQL Anywhere
daemon is started.

The SQL Anywhere daemon gets all configuration information from the server.conf
file, as follows:

-n NB_server_name

-x tcpip(LocalOnly=YES;ServerPort=13785) -gp 4096 -gd DBA -gk DBA

-gl DBA -ti 0 -c 200M -ch 1278M -cl 200M -wc- -ua -gna 1 -k -os 1M

-m -o /usr/openv/db//log/server.log -ud
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NB_server_name indicates the name of the SQL Anywhere server. Each Sybase
server has a unique name. Use the same name that was used during installation.
If a fully qualified name was used at that time, use a fully qualified name here.

Note: If this name is changed, the Enterprise Media Manager cannot connect to
the database.

Table 24-1 Commands used in the server.conf file

DescriptionCommand

Indicates the initial memory that is reserved for caching database pages and other
server information. The value may be changed for performance reasons.

-c 200M

Indicates the maximum cache size, as a limit to automatic cache growth. The
value is calculated automatically based on memory size of the computer.

-ch 1316M

Indicates the minimum cache size, as a limit to automatic cache resizing. The
value may be changed for performance reasons.

-cl 200M

Indicates that the DBA user is the account used to start, stop, load, and unload
data.

-gd DBA

-gk DBA

-gl DBA

Enable automatic tuning of the network database server multiprogramming level.-gna 1

Indicates the maximum page size (in bytes) for the database. This parameter is
given during database creation.

-gp 4096

If -k is specified when database server is started, the database server does not
collect Performance Monitor statics.

-k

Truncates the transaction log when a checkpoint is done.

This option provides a way to automatically limit the growth of the transaction log.
Disable it using NbDbAdmin.exe (Windows) or dbadm (UNIX) by changing the
transaction mode option set to FULL from PARTIAL.

-m

On Windows: Indicates the location of server output messages. The messages
include start and stop events, checkpoints, error conditions, and cache change
size. This log is not managed, but growth is slow.

-o install_path\Veritas\

NetBackupDB\log\server.log

OnUNIX: Indicates the location of server output messages. Themessages include
start and stop events, checkpoints, error conditions, and cache change size. This
log is not managed, but growth is slow.

-o /usr/openv/db/log/

server.log

Specifies a maximum size for the database server message log file.-os 1M
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Table 24-1 Commands used in the server.conf file (continued)

DescriptionCommand

Indicates the client idle time that is allowed before shutdown. By default, no idle
time is allowed, which prevents the database from shutting down.

-ti 0

Turns off the use of asynchronous I/O.-ua

Indicates that the server should run as a daemon.-ud

Control whether checksums are enabled on write operations for the database. By
default all database pages have checksums, so the database server defaults to
-wc-.

-wc-

Indicates what kind of connections are allowed in addition to shared memory. For
example, local TCP/IP connections that use port 13785.

-x tcpip(LocalOnly

=YES;ServerPort=13785)

See “About NetBackup master server installed directories and files” on page 967.

About the databases.conf file
The Windows install_path\Veritas\NetBackupDB\conf\databases.conf
configuration file and the UNIX /usr/openv/var/global/databases.conf

configuration file contain the locations of the main database files and the database
names for automatic startup when the SQL Anywhere service is started. For
example, if NBDB and BMRDB are both located on the master server in the default
locations, databases.conf contains:

On Windows
"C:\Program Files\Veritas\NetBackupDB\data\NBDB.db" -n NBDB

"C:\Program Files\Veritas\NetBackupDB\data\NBAZDB.db" -n NBAZDB

"C:\Program Files\Veritas\NetBackupDB\data\BMRDB.db" -n BMRDB

On UNIX
"/usr/openv/db/data/NBAZDB.db" -n NBAZDB

"/usr/openv/db/data/NBDB.db" -n NBDB

"/usr/openv/db/data/BMRDB.db" -n BMRDB

About the registration.dat file on Windows
This file is created for use with Veritas NetBackup OpsCenter.

It is created in the following location:

970About the NetBackup relational database
About the NetBackup relational database (NBDB) installation



install_path\Veritas\NetBackupDB\conf\registration.dat

About the vxdbms_env.csh, vxdbms_env.sh scripts (on
UNIX)
The scripts vxdbms_env.csh and vxdbms_env.sh set-up the SQL Anywhere
environment as follows:

■ /usr/openv/db/vxdbms_env.csh

■ /usr/openv/db/vxdbms_env.sh

Other scripts and commands use vxdbms_env.csh and vxdbms_env.sh.

About the bin directory
OnWindows, NetBackup\bin contains NetBackup-specific binaries and commands
for administrating NBDB and BMRDB:

■ NbDbAdmin.exe

This file launches the NetBackup Database Administration utility, which provides
administrators with a way to perform the tasks based on the nbdb commands.
See “Using the NetBackup Database Administration utility on Windows”
on page 978.
To access the utility, the administrator must know the database password.
See “Changing the NetBackup database password” on page 999.

■ create_nbdb.exe

Used during installation and upgrades to create and upgrade the NetBackup
database, NBDB.

■ nbdb_admin.exe

Among other things, use nbdb_admin.exe to change the DBA and NetBackup
account passwords, or to start and stop individual databases.

■ nbdb_backup.exe

Use to make an online backup of the SQL Anywhere database files to a file
system directory.

Note: Using this command (or the NetBackup Database Administration utility)
to restore the NetBackup database can potentially break the consistency between
the NetBackup catalog and the database. This loss of consistency can lead to
loss of data. Use this command (or the NetBackup Database Administration
utility) to restore the NetBackup catalog only as a precautionary measure.
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■ nbdb_move.exe

Use to change the location of the SQL Anywhere database files from the default
location.

■ nbdb_ping.exe

Displays the status of the SQL Anywhere database.

■ nbdb_restore.exe

Use to recover from an online backup in a file system directory that was created
using nbdb_backup.

■ nbdb_unload.exe

Use to create a dump of all or part of the NBDB database or the BMRDB
database schema and data.

■ nbdbms_start_server.exe

Use to start and stop the SQL Anywhere service.

■ nbdb_upgrade.exe

Used internally to upgrade the NetBackup and BMR databases.

On UNIX, /usr/openv/db/bin contains SQL Anywhere commands and
NetBackup-specific commands for administrating NBDB and BMRDB:

■ dbadm

This file launches the NetBackup Database Administration utility, which provides
administrators with a way to perform the tasks based on the nbdb commands.
See “Using the NetBackup Database Administration utility on UNIX” on page 990.
To access the utility, the administrator must know the database password.
See “Changing the NetBackup database password” on page 999.

■ create_nbdb

Used during installation and upgrades to create and upgrade the NetBackup
database, NBDB.

■ nbdb_admin

Among other things, use nbdb_admin to change the DBA and NetBackup account
passwords, or to start and stop individual databases.

■ nbdb_backup

Use to make an online backup of the SQL Anywhere database files to a file
system directory.
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Note: Using this command (or the NetBackup Database Administration utility)
to restore the NetBackup database can potentially break the consistency between
the NetBackup catalog and the database. This loss of consistency can lead to
loss of data. Use this command (or the NetBackup Database Administration
utility) to restore the NetBackup catalog only as a precautionary measure.

■ nbdb_move

Use to change the location of the SQL Anywhere database files from the default
location.

■ nbdb_ping

Displays the status of the SQL Anywhere database.

■ nbdb_restore

Use to recover from an online backup in a file system directory that was created
using nbdb_backup.

■ nbdb_unload

Use to create a dump of all or part of the NBDB database or the BMRDB
database schema and data.

■ nbdbms_start_server

Use to start and stop the SQL Anywhere daemon.

■ nbdb_upgrade

Used internally to upgrade the NetBackup and BMR databases.

Note:Due to performance issues, NetBackup supports database files only on locally
attached drives.

The commands are described in the NetBackup Commands Reference Guide and
the online Help.

About the contents of the NetBackup directories
The following table describes the contents of the NetBackup directories.

Table 24-2 NetBackup directory contents

DescriptionDirectory

The following directory contains SQL Anywhere-specific information.

On Windows: install_path\Veritas\NetBackupDB\charsets

On UNIX: /usr/openv/db/charsets

charsets
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Table 24-2 NetBackup directory contents (continued)

DescriptionDirectory

On UNIX: The directory /usr/openv/db/lib contains all the SQL Anywhere shared
libraries. The directory also includes ODBC libraries, used to connect to NBDB and BMRDB.

lib

The following directory contains the SQL Anywhere server log file server.log that contains
only Sybase logs.

On Windows: install_path\Veritas\NetBackupDB\log

On UNIX: /usr/openv/db/log

log

On UNIX: The directory /usr/openv/db/res contains SQL Anywhere-specific information.res

The following directory contains the SQL Anywhere scripts that are used to create the
database. The directory also contains NetBackup SQL scripts that are used to create the
EMM and other schemas.

On Windows: install_path\Veritas\NetBackupDB\scripts

On UNIX: /usr/openv/db/scripts

Note: Do not edit the scripts that are located in this directory.

scripts

The directory that is used as a temporary staging area during catalog backup and recovery.

On Windows: install_path\Veritas\NetBackupDB\staging

On UNIX: /usr/openv/db/staging

staging

On UNIX: The directory /usr/openv/db/tix contains SQL Anywhere-specific information.tix

On Windows: The directory install_path\Veritas\NetBackupDB\WIN32 contains
SQL Anywhere commands and .dll files.

WIN32

On Windows: The directory install_path\Veritas\NetBackupDB\java contains the
components necessary to run the NetBackup Administration Console on a Windows
computer.

java

OnWindows: The directory install_path\Veritas\NetBackupDB\shared is a directory
used by Veritas NetBackup OpsCenter.

shared

About the data directory
The following directory is the default location of the NetBackup database, NBDB:

On Windows: install_path\NetBackupDB\data

On UNIX: /usr/openv/db/data

NBDB includes the following files:
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■ NBDB.db

The main NetBackup database file; considered a dbspace.

■ NBDB.log

The transaction log for the NetBackup database, necessary for recovery.
NBDB.log is automatically truncated after a successful full or incremental catalog
backup of the SQL Anywhere database.

■ JOBD_DATA.db

An additional dbspace that contains job records data.

■ NBAZDB.db

The NetBackup Authorization database.

■ EMM_DATA.db

An additional dbspace that contains EMM data.

■ EMM_INDEX.db

The file that enhances the EMM database performance.

■ SEARCH_DATA.db

Contains the metadata that is created while placing holds on backup images.

■ SEARCH_INDEX.db

The file that contains the indexes that are created in the SEARCH_DATA tables.

■ SLP_DATA.db

Contains the run-time information for storage lifecycle policies.

■ SLP_INDEX.db

The file that contains the indexes that are created in the SLP_DATA tables.

■ vxdbms.conf

The file that contains the configuration information specific to the Sybase SQL
Anywhere installation:
On Windows:

VXDBMS_NB_SERVER = NB_server_name

VXDBMS_NB_PORT = 13785

VXDBMS_NB_DATABASE = NBDB

VXDBMS_BMR_DATABASE = BMRDB

VXDBMS_AZ_DATABASE = NBAZDB

VXDBMS_NB_DATA = C:\Program Files\Veritas\NetBackupDB\data

VXDBMS_NB_INDEX = C:\Program Files\Veritas\NetBackupDB\data

VXDBMS_NB_TLOG = C:\Program Files\Veritas\NetBackupDB\data

VXDBMS_NB_PASSWORD = encrypted_password
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AZ_DB_PASSWORD = encrypted_password

VXDBMS_ODBC_DRIVER = NB SQL Anywhere

On UNIX:

VXDBMS_NB_SERVER = NB_server_name

VXDBMS_NB_PORT = 13785

VXDBMS_NB_DATABASE = NBDB

VXDBMS_AZ_DATABASE = NBAZDB

VXDBMS_BMR_DATABASE = BMRDB

VXDBMS_NB_DATA = /usr/openv/db/data

VXDBMS_NB_INDEX = /usr/openv/db/data

VXDBMS_NB_TLOG = /usr/openv/db/data

VXDBMS_NB_STAGING = /usr/openv/db/staging

VXDBMS_NB_PASSWORD = encrypted_password

AZ_NB_PASSWORD = encrypted_password

The encrypted password that is used to log into the DBA accounts for NBDB,
NBAZDB, and BMRDB, and other data accounts is stored in vxdbms.conf.
The password is set to a randomly generated password upon installation. Use
the nbdb_admin command to change it to a known password if you have not
done so already.
See “Changing the NetBackup database password” on page 999.

■ If BMR is installed, the directory also contains: BMRDB.db, BMRDB.log (transaction
log for BMR), BMR_DATA.db, BMR_INDEX.db

About the NetBackup configuration entry
The VXDBMS_NB_DATA registry entry (Windows) or the bp.conf entry (UNIX) is a
required entry and is created upon installation. The entry indicates the path to the
directory where NBDB.db, NBAZDB.db, BMRDB.db, and the vxdbms.conf files are
located.

On Windows:
HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\

Config\VXDBMS_NB_DATA

On UNIX: /usr/openv/netbackup/bp.conf:

VXDBMS_NB_DATA = /usr/openv/db/data
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Sybase SQL Anywhere server management
Upon startup, the Sybase SQL Anywhere server uses the SQL Anywhere service
to set the server parameters in the server.conf file. Then, the service starts the
databases that are indicated in the databases.conf file.

To start and stop the Sybase SQL Anywhere service on Windows, use one of the
following methods:

■ In the NetBackup Administration Console, select NetBackup Relational
Database Manager (SQLANYs_VERITAS_NB) in the Daemons tab of the
Activity Monitor.

■ From the Windows Service Manager, select NetBackup Relational Database
Manager (SQLANYs_VERITAS_NB).

■ install_path\Veritas\NetBackup\bin\bpdown -e SQLANYs_VERITAS_NB

■ install_path\Veritas\NetBackup\bin\bpup -e SQLANYs_VERITAS_NB

To start and stop the Sybase SQL Anywhere daemon on UNIX, use one of the
following methods:

■ Select NB_dbsrv in the Activity Monitor in the NetBackup Administration
Console.

■ From the command line:

■ /usr/openv/netbackup/bin/bp.kill_all | bp.start_all

The Sybase SQL Anywhere daemon is included in the stop command or the
start command, which starts and stops all NetBackup daemons.

■ /usr/openv/db/bin/nbdbms_start_server ndbms_start_server starts

the SQL Anywhere server if no option is specified.

■ /usr/openv/db/bin/nbdbms_start_server -stop -f

Stops the server; -f forces a shutdown with active connections.

■ /usr/openv/db/bin/nbdbms_start_server -stat

The -stat option tells whether the server is up or down:
SQL Anywhere Server Ping Utility Version 11.0.1.2044 Ping server

successful.

■ /usr/openv/db/bin/nbdbms_start_server -h

Use -h to display usage information about the nbdbms_start_server.

Individual databases can be started or stopped, while the SQL Anywhere service
continues. To do so, use the NetBackup Database Administration utility or the
following commands:

■ nbdb_admin [-start | -stop]
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Starts or stops NBDB without shutting down the SQL Anywhere server.
To see whether the database is up, enter nbdb_ping.

■ nbdb_admin [-start | -stop BMRDB]

Starts or stops BMRDB without shutting down the SQL Anywhere server.
To see whether the BMRDB database is up, enter nbdb_ping -dbn BMRDB.

Sybase SQL Anywhere and clustered environments
Sybase SQL Anywhere is supported in a clustered environment. Sybase SQL
Anywhere failover is included with the NetBackup server failover solution. The
software is installed on all computers in the cluster, but the database files are created
on a shared disk.

To facilitate the shared files, database and configuration files are installed on a
shared drive.

Configuration files are stored in the following location:

On Windows: Shared_drive\VERITAS\NetBackupDB\conf.

On UNIX: /usr/openv/var/global.

Using the NetBackup Database Administration
utility on Windows

The NetBackup Database Administration utility is a standalone application
(NbDbAdmin.exe) and is located in the following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

To use the utility, you must be an administrator with administrator privileges.

When you start the NetBackup Database Administration utility, enter the DBA
password. The password is set to a randomly generated password upon installation.
Use the nbdb_admin command to change it to a known password if you have not
done so already.

See “Changing the NetBackup database password” on page 999.

The NetBackup Database Administration utility displays the following information:
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Table 24-3 NetBackup Database Administration properties

DescriptionProperty

Select either the NBDB or the BMRDB database to administer.

The list of possible databases is derived from the vxdbms.conf file. The vxdbms.conf file
is located in the directory that is specified in the bp.conf file or in the Windows registry
parameter VXDBMS_NB_DATA.

The database must reside on the same computer where the NetBackup Database
Administration console runs.

One of the following status reports display for the selected database:

■ If the database is available, the screen displays Alive and well.
■ If the database is unavailable, the screen displays Not available.

Database name and
status

Shuts down the selected database.Stop

Starts the selected database.Start

Contains information about database utilization.

See “About the General tab of the NetBackup Database Administration utility” on page 980.

General tab

Contains a variety of tools to administer the selected database.

See “About the Tools tab of the NetBackup Database Administration utility” on page 984.

Tools tab

Displays the amount of free space and used space on a drive. If the database files are on
multiple drives, this view is useful to see which drive has more free space available.

The Drive Space dialog displays the following information:

■ Drive
■ Capacity
■ Used space
■ Free space
■ % Utilized
■ Space

Drive Space

Closes the Database Administration utility.Close

Provides additional assistance in the console.Help
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About the General tab of the NetBackup Database Administration
utility

The General tab contains information about database space utilization. The tab
contains tools to let the administrator reorganize fragmented database objects, add
free space to the database files, and validate and rebuild the database.

Figure 24-1 shows the General tab of the Database Administration utility after a
user logs on.

Figure 24-1 General tab of the NetBackup Database Administration utility
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Table 24-4 General tab options

DescriptionOption

Displays the information about used space and free space in pie chart format for the following
database system, data, and index files:

■ Free DBspace
The amount of free space available.

■ Total DBspace
The total amount of space that is allocated for the dbspace.

■ DB Utilization
The utilization percentage is the percentage of the Total DBSpace used for data.
When the NBDB or the BMRDB databases are created, extra space is allocated so that
contiguous space is available as needed. As a result, a low space utilization percentage
is a positive indication unless the database is very large and disk space is in short supply.

Space Utilization list

Use to display information about the selected database table or index file and elect to
defragment (reorganize) fragmented files.

Select a database table or an index file in the Space Utilization list and click Details.

■ Database tables
Select one or more tables in the Data (Table) Details dialog box and click Defragment.
The database table is evaluated for fragmentation and if any fragmentation is detected,
it is reorganized.
Select one or more database tables to reorganize and then click Defragment. Each
selected database table is evaluated for fragmentation and if any fragmentation is
detected, it is reorganized.

■ Index files
Select one or more indexes in the Index Details dialog box and click Compress. Each
selected index is evaluated for fragmentation and if any fragmentation is detected, it is
reorganized.

Click Close after defragmenting the files.

Details

Use to add additional free space to individual dbspaces. Additional free space helps to
reduce future fragmentation of the database objects that are stored in the database.

When the relational database is initially created or rebuilt, 25MB of free space is automatically
added to the data and the index dbspaces.

Click Add Space, then select one of the following amounts to add:

■ A small amount of space to add is 25MB.
■ A medium amount of space to add is 50MB.
■ A large amount of space to add is 100MB.

Click OK to add the space or Cancel to close the dialog box.

Add Space
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Table 24-4 General tab options (continued)

DescriptionOption

The location and the file size of the transaction log.Transaction log
information

The location and the file size of the mirrored log, if one exists.Mirrored log information

Displays the most current information.Refresh

This option automatically determines the database tables and indexes that are fragmented.
The option then uses the SQL Anywhere REORGANIZE command to defragment the tables
and compress the indexes.

To click Reorganize All is equivalent to running the following command:

nbdb_admin.exe -reorganize

Reorganize All

This option informs you whether or not the selected database has passed the utility’s
validation check.

Validation status
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Table 24-4 General tab options (continued)

DescriptionOption

This option performs a database validation on all of the database tables and indexes in the
selected database.

Choose one of the following validation checks in the Validate Database dialog box:

■ Standard
The Standard validation option lets you validate the indexes and keys on all of the tables
in the database. Each table is scanned, and for each row, a check is made that it exists
in the appropriate indexes. The number of rows in the table must match the number of
entries in the index.
The equivalent command is nbdb_admin.exe -validate

■ Full
In addition to the Standard validation checks, a Full validation ensures that every row
that is referenced in each index exists in the corresponding table. For foreign key indexes,
it also ensures that the corresponding row exists in the primary table.
The equivalent command is nbdb_admin.exe -validate -full

Note: To perform a full database validation, shut down NetBackup and start only the
database service.

After a validation check runs, the Results screen lists each database object. Each error is
listed next to the database object where it was found. The total number of errors are listed
at the end of the list of database objects. If no errors were found, that is indicated.

If any validation errors are reported, perform the following tasks:

■ Shut down NetBackup (all daemons and services).
■ Start only the SQL Anywhere database server (SQLANYs_VERITAS_DB, the NetBackup

Relational Database Manager).
■ Click Validate to repeat the validation check or use the nbdb_admin.exe command

line utility.

If validation errors persist, contact Veritas customer support. The administrator may be
asked to rebuild the database using theRebuild option or the nbdb_unload.exe command
line utility.

Validate
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Table 24-4 General tab options (continued)

DescriptionOption

This option unloads and reloads the database. A new database with all of the same options
is built in its place.

A Database Rebuild may be required if validation errors are reported using the Standard or
Full validation options using the Validate option.

Note: Before you rebuild the database, Veritas suggests that you create a copy of the
database files by performing a backup from the Tools tab.

To rebuild the database temporarily suspends NetBackup operations and can take a long
time depending on the database size.

The equivalent command is nbdb_unload -rebuild

Rebuild

See “About fragmentation” on page 984.

About fragmentation
Table fragmentation can impede performance. When rows are not stored
contiguously, or if rows are split into more than one page, performance decreases
because these rows require additional page accesses.

When an update to a row causes it to grow beyond the originally allocated space,
the row is split. The initial row location contains a pointer to another page where
the entire row is stored. As more rows are stored on separate pages, more time is
required to access the additional pages.

Use Defragment to defragment rows in a table or Compress to defragment the
indexes which have become sparse due to deletions.

Reorganizing may also reduce the total number of pages that are used to store the
table and its indexes. It may reduce the number of levels in an index tree.

Note that the reorganization does not result in a reduction of the total size of the
database file.

TheRebuild option on theGeneral tab completely rebuilds the database, eliminating
any fragmentation and free space. This option may result in a reduction of the total
size of the database files.

See “Estimating catalog space requirements” on page 955.

About the Tools tab of the NetBackup Database Administration utility
The Tools tab of the NetBackup Database Administration utility contains a variety
of tools to administer the selected database:
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See “Changing the DBA password using the NetBackup
Database Administration utility” on page 985.

Password section

See “Moving the NetBackup database files” on page 986.Move Database section

See “Exporting database schema and data” on page 988.Unload section

See “Copying or backing up the database files” on page 988.Backup section

See “Restoring database files from a backup” on page 989.Restore section

Figure 24-2 displays the Tools tab of the utility.

Figure 24-2 Tools tab of the Database Administration utility

Changing the DBA password using the NetBackup
Database Administration utility
To log into the Database Administration utility, you must know the current DBA
password.
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To change the password for the first time after installation, use the nbdb_admin

command. The command updates the vxdbms.conf file with the new, encrypted
string:

See “Changing the NetBackup database password” on page 999.

To change a known password to a new password, you can either use the
nbdb_admin command or the NetBackup Database Administration utility.

To change the DBA password from a known password to a new password

1 Start the NetBackup Database Administration utility that is located in the
following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

2 Enter the database logon password and click OK.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

3 Select the Tools tab.

4 In the Password section, click Change.

5 In the Change password dialog box, enter the new password and confirm the
new password. Changing the password changes it for both NBDB and BMRDB,
if a BMR database is present.

6 Enable Create a backup file of your new DBA password to keep track of
the password. Then, browse to a directory to store the file that contains the
new password.

7 Click OK.

The Change password dialog box warns you that it is important to remember
the password. Veritas may not be able to recover information within the EMM
database if the password is unavailable.

8 Restart the database for the password change to take effect.

Moving the NetBackup database files
Use the NetBackup Database Administration utility to change the location of the
database files or to split the database files into multiple directories. Changing the
location of the database files can improve performance when the database is very
large.

Note:Due to performance issues, NetBackup supports database files only on locally
attached drives.
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The database files are moved for both NBDB and BMRDB, if present.

To move the NetBackup database files

1 Start the NetBackup Database Administration utility that is located in the
following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

2 Enter the database logon password and click OK.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

3 Select the Tools tab.

4 In the Move Database section, click Move.

5 In the Move database files dialog box, select one or more of the following
options:

Use to change the location of the data dbspaces. Browse to
the new location.

Move data to

Use to change the location of the index dbspaces. Browse
to the new location.

Move index to

Use to change the location of the transaction log. The
transaction logs, NBDB.log, and BMRDB.log, are the critical
files that are used to recover the relational databases. Browse
to the new location.

Move transaction log
to

Use to create a mirrored transaction log. Create the mirrored
log in a different directory from the original log. Veritas also
recommends the mirrored transaction log be placed on a
different drive.

A mirrored transaction log offers extra protection.

Create mirrored
transaction log at

This option is displayed if a mirrored transaction log exists.

Use to change the location of the mirrored transaction log.
Browse to the new location. Create the mirrored log in a
different directory from the original log.

Move mirrored
transaction log to

This option is displayed if mirroring is used. Use this option
to stop mirroring of the transaction log. This option removes
any existing mirrored transaction log from the directory.

Stop mirroring

6 Click OK. The NetBackup operations are temporarily suspended.
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Exporting database schema and data
Use the NetBackup Database Administration utility to unload either the schema or
the schema and data from the relational database.

To export database schema and data

1 Start the NetBackup Database Administration utility that is located in the
following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

2 Enter the database logon password and click OK.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

3 Select the Tools tab.

4 In the Unload section, click Export.

5 In the Export database dialog box, browse to a destination directory.

6 Select one or more of the following options:

Unload only the database schema. The schema is unloaded
as a file that is named reload.sql in the named directory.

Schema

Unload both the database schema and the data. The data is
unloaded as a set of files in comma-delimited format. One
file is created for each database table.

Schema and data

7 Click OK.

Copying or backing up the database files
Use the NetBackup Database Administration utility to back up the relational database
to a specified directory.

Veritas recommends creating a backup copy of the database files in the following
situations:

See “Moving the NetBackup database files”
on page 986.

Before you move the database.

See “About the General tab of the NetBackup
Database Administration utility” on page 980.

Before you rebuild the database.

Before you add data space.
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See “About the General tab of the NetBackup
Database Administration utility” on page 980.

Before you add index space.

Note: Using the NetBackup Database Administration utility to back up and restore
the NetBackup database can potentially break the consistency between the
NetBackup catalog and the database. This loss of consistency can lead to loss of
data. Use the tool to back up and restore the NetBackup catalog only as a
precautionary measure.

To copy or back up the database files

1 Start the NetBackup Database Administration utility that is located in the
following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

2 Enter the database logon password and click OK.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

3 Select the Tools tab.

4 In the Backup section, click Copy.

5 In the Copy database files dialog box, browse to a destination directory.

The destination directory contains the files that the backup creates. A copy of
all of the database files is made in this directory. This directory is also the
location of the database files that the Restore option uses.

Note: This is not a catalog backup, performed as part of regular NetBackup
operations.

See “Restoring database files from a backup” on page 989.

6 Click OK.

Restoring database files from a backup
Use the NetBackup Database Administration utility to restore a database from a
backup copy.

The restore overwrites the current database files. The database is shut down and
restarted after the restore is completed.

A database restore causes NetBackup activity to be suspended, so do not perform
a database restore while active backups or other restores run.
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Note: Using the Database Administration utility to back up and restore the
NetBackup database can potentially break the consistency between the NetBackup
catalog and the database. This loss of consistency can lead to loss of data. Use
the tool to back up and restore the NetBackup database only as a precautionary
measure.

To restore database files from a backup

1 Start the NetBackup Database Administration utility that is located in the
following directory:

install_path\NetBackup\bin\NbDbAdmin.exe

2 Enter the database logon password and click OK.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

3 Select the Tools tab.

4 In the Restore section, click Restore.

5 In the Restore database dialog box, browse to the directory that contains the
backup database.

See “Copying or backing up the database files” on page 988.

6 Click OK.

Using the NetBackup Database Administration
utility on UNIX

The NetBackup Database Administration utility is a standalone application (dbadm)
and is installed in the following location:

/usr/openv/db/bin

To use the NetBackup Database Administration utility, you must be an administrator
with root user privileges.

When you start the NetBackup Database Administration utility, enter the DBA
password. The password is set to a randomly generated password upon installation.
Use the nbdb_admin command to change it to a known password if you have not
done so already.

See “Changing the NetBackup database password” on page 999.

Enter y to change the password or n to proceed without changing the password.
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After you log on, the NetBackup Database Administration utility displays the following
information about the current database:

Table 24-5 NetBackup Database Administration utility properties

DescriptionProperty

The selected database: NBDB or BMRDBSelected database

The status of the selected database: UP or DOWNStatus

The validation state of the selected database: OK, NOT_OK, or DOWN

This information can also be obtained running the following command:

nbdb_admin -validate

Note: To perform a full database validation, shut down NetBackup and start only the database
service.

Consistency

Space Utilization is a measure of the amount of used space as a percentage of the file system
space allocated for the database. When the NBDB or the BMRDB databases are initially
created, extra space is allocated so that contiguous space is available as needed. As a result,
a low Space Utilization is a positive indication unless the database is very large and disk
space is in short supply.

Space Utilization

The initial screen also displays the following Database Administration main menu:

Table 24-6 Database Administration main menu options

DescriptionOption

This option displays the menu where you can select a database to start or stop, and to change
database passwords.

See “About the Select/Restart Database and Change Password menu options” on page 992.

Select/Restart
Database and Change
Password

This option displays the menu where you can perform the following actions:

■ Generate a database space utilization report
■ Reorganize fragmented database objects
■ Add free space to the database files
■ Modify database server memory cache settings

See “About the Database Space and Memory Management menu options” on page 993.

Database Space and
Memory Management

This option displays the menu where you can truncate the transaction log of the database.
You can also change the database's transaction log mode.

Transaction Log
Management

This option displays the menu where you can validate and rebuild the selected database.

See “About the Database Validation Check and Rebuild menu options” on page 995.

Database Validation
Check and Rebuild
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Table 24-6 Database Administration main menu options (continued)

DescriptionOption

This option displays the menu where you can change the location of the database files. You
can also split the files into multiple directories.

See “About the Move Database menu options” on page 996.

Move Database

This option displays the menu where you can unload either the schema or the schema and
data from the database.

See “About the Unload Database menu options” on page 997.

Unload Database

This option displays the menu where you can choose the backup and restore options for the
database.

See “About the Backup and Restore Database menu options” on page 998.

Backup and Restore
Database

This option refreshes the Status, Consistency, and Space Utilization in the main menu.Refresh Database
Status

Online Help is available from all screens by selecting the h option from the main
menu.

About the Select/Restart Database and Change Password menu
options

Select this option to display the Select/Restart Database and Change Password
menu.

The Select/Restart Database and Change Password menu contains the following
options.

Table 24-7 Select/Restart Database and Change Password options

DescriptionOption

Select NBDB and then view or modify the database using the other dbadm menu options.NBDB

Select BMRDB and then view or modify the database using the other dbadm menu options.BMRDB

Starts the selected database.Start Selected
Database

Stops the selected database.Stop Selected
Database
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Table 24-7 Select/Restart Database and Change Password options
(continued)

DescriptionOption

Changes the password for the databases. The password is changed for both NBDB and
BMRDB, if applicable. Restart the database for the password change to take effect.

To log into the Database Administration utility, you must know the current DBA password.

To change the password for the first time after installation, use the nbdb_admin command.
The command updates the vxdbms.conf file with the new, encrypted string:

See “Changing the NetBackup database password” on page 999.

To change a known password to a new password, you can either use the nbdb_admin
command or the NetBackup Database Administration utility.

Change Password

About the Database Space andMemory Management menu options
You can use the Database Space and Memory Management option to perform the
following functions:

■ To report on database space utilization

■ To reorganize fragmented database objects

■ To add free space to the database files

TheDatabase Space andMemoryManagementmenu contains the following options.

Table 24-8 Database Space and Memory Management options

DescriptionOption

Select this option to generate a report on space utilization for the currently selected database.

The report contains the dbspaces and the physical pathnames of the relational database.

For each dbspace, the report displays the name, the amount of free space in KBytes, the file
size in KBytes, and the space utilization. The report also displays the transaction log file size
and the amount of free space that remains on each of the file systems being used for the
database.

Report on Database
Space
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Table 24-8 Database Space and Memory Management options (continued)

DescriptionOption

Select this option to reorganize fragmented database tables and indexes.

These actions are performed from the Database Reorganize menu as follows:

■ 1) Defragment All

This option automatically determines the database tables and indexes that are fragmented.
It then uses the SQL Anywhere REORGANIZE command to defragment the tables and
compress the indexes.
The equivalent command is nbdb_admin -reorganize.

■ 2) Table Level Defragmentation

This option generates a fragmentation report for each database table. For each table, the
report includes the TABLE_NAME, number of ROWS, number of ROW_SEGMENTS,
and SEGS_PER_ROW.
In addition, a * displays in the ! column for an individual table if it would be automatically
selected for reorganization by the Defragment All option.
A row segment is all or part of one row that is contained on one page. A row may have
one or more row segments. The ROW_SEGMENTS value indicates total number of row
segments for the table. The SEGS_PER_ROW value shows the average number of
segments per row, and indicates whether or not a table is fragmented.
A SEGS_PER_ROW value of 1 is ideal, and any value more than 1 indicates a high
degree of fragmentation. For example, a value of 1.5 means that half of the rows are
partitioned.
See “About fragmentation” on page 984.

■ 3) Index Compression

This option generates a fragmentation report for each database index and lets the
administrator select individual indexes to be compressed. For each index the report
includes the TABLE_NAME, INDEX_NAME, TYPE of index, LEVEL, and DENSITY. The
index TYPE is one of the following values: PKEY (primary key), FKEY (foreign key), UI
(unique index), UC (unique constraint), NUI (non-unique index).
In addition, a * displays in the ! column for an individual index if it would be automatically
selected for reorganization by the Defragment All option.
The LEVEL and DENSITY indicate whether or not an index should be reorganized. The
number of levels in the index tree determines the number of I/O operations that are needed
to access a row using the index. Indexes with fewer levels are more efficient than indexes
with greater numbers of levels. The density is a fraction between 0 and 1 providing an
indication of how full each index page is on average.
A LEVEL value of 1 is ideal. An index with a LEVEL value of 4 or more or with a level
value of 2 or 3 with a density greater than 0.5 is a good candidate for reorganization.

Database Reorganize
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Table 24-8 Database Space and Memory Management options (continued)

DescriptionOption

Select this option to add additional free space to individual dbspaces. Additional free space
helps to reduce future fragmentation of the database objects that are stored in the database.

When the relational database is initially created or rebuilt, 25MB of free space is automatically
added to the data and the index dbspaces.

A Rebuild eliminates all free space and then adds back what was initially added when the
database was created. If you accidentally add too much free space, a Rebuild can be used
to eliminate the space.

Add Free Space

About the Database Validation Check and Rebuild menu options
The Database Validation Check and Rebuild option lets you validate and rebuild
the currently selected database.

The Database Validation Check and Rebuild menu contains the following options.

Table 24-9 Database Validation Check and Rebuild menu options

DescriptionOption

This option lets you validate the indexes and keys on all of the tables in the database. Each
table is scanned. For each row, a check is made that it exists in the appropriate indexes. The
number of rows in the table must match the number of entries in the index.

This option is equivalent to the command nbdb_admin -validate.

Standard Validation

This option performs the same checks as the Standard Validation option. In addition, Full
validation ensures that every row that is referenced in each index exists in the corresponding
table. For foreign key indexes, it also ensures that the corresponding row exists in the primary
table. This option is equivalent to the command nbdb_admin -validate -full.

Note: To perform a full database validation, shut down NetBackup and start only the database
service.

If any validation errors are reported, perform the following tasks:

■ Shut down NetBackup (all daemons and services).
■ Start only the SQL Anywhere database server (NB_dbsrv, the NetBackup Relational

Database Manager).
■ Repeat the validation check using this tool or the nbdb_admin command line utility.

If validation errors persist, contact Veritas customer support. The administrator may be asked
to rebuild the database using the Database Rebuild option or the nbdb_unload command
line utility.

Full Validation
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Table 24-9 Database Validation Check and Rebuild menu options (continued)

DescriptionOption

This option lets you rebuild the database. This menu option is equivalent to the command
nbdb_unload -rebuild. A Database Rebuild results in a complete unload and reload of
the database. A new database with all of the same options is built in place. A Database
Rebuild may be required if Database Validation errors are reported using the Standard or
Full Validation options.

During a Database Rebuild, all NetBackup operations are suspended.

When you select this option, a message appears which recommends that you exit and create
a backup using the Backup Database option before you rebuild the database. You then have
the choice of whether to continue or not.

See “About the Backup and Restore Database menu options” on page 998.

Database Rebuild

See “Using the NetBackup Database Administration utility on UNIX” on page 990.

About the Move Database menu options
The Move Database menu options let you change the location of the database files
or split the database files into multiple directories. Changing the locationmay improve
performance in the case of large databases. The database files are moved for both
NBDB and BMRDB, if present.

Note:Due to performance issues, NetBackup supports database files only on locally
attached drives.

In addition, the Move Database menu lets you create a mirrored transaction log.
The transaction logs (NBDB.log and BMRDB.log) are critical files used to recover
the relational databases.

For extra protection, a mirrored transaction log can be used. Create the mirrored
log in a different directory from the original log.

The Move Database menu contains the following options.

Table 24-10 Move Database menu options

DescriptionOption

Select this option to change the location of the data dbspaces. Changing the location
temporarily suspends NetBackup operations.

Move Data

Select this option to change the location of the index dbspaces. Changing the location
temporarily suspends NetBackup operations.

Move Index
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Table 24-10 Move Database menu options (continued)

DescriptionOption

Select this option to change the location of the transaction log. Changing the location
temporarily suspends NetBackup operations.

Move Transaction Log

Select this option to change the location of the mirrored transaction log. If the mirrored
transaction log does not already exist, it is created in the new location. Changing the location
temporarily suspends NetBackup operations.

Move/Create Mirrored
Log

This option is displayed only if a mirrored transaction log is used. Select this option to configure
the database server so that it stops using a mirrored transaction log. The existing mirrored
transaction log file is deleted. This action temporarily suspends NetBackup operations.

Stop Using Mirrored
Transaction Log

See “Using the NetBackup Database Administration utility on UNIX” on page 990.

About the Unload Database menu options
The Unload Databasemenu options let you unload either the schema or the schema
and data from the relational database.

A SQL command file is created that can be used to rebuild the database. If the data
is also included in the unload, a set of data files in comma-delimited format is
created.

The Unload Database menu contains the following options.

Table 24-11 Unload Database menu options

DescriptionOption

This option lets you unload only the database schema. The schema is unloaded as a file that
is named reload.sql in the named directory.

Schema Only

This option lets you unload both the database schema and the data. The data is unloaded
as a set of files. One file is created for each database table.

Data and Schema

This option lets you change the directory location for the files that unload options (1) or (2)
create.

Change Directory
option for unloading the
database

See “Using the NetBackup Database Administration utility on UNIX” on page 990.
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About the Backup and Restore Database menu options
The Backup and Restore Database menu options let you back up the relational
database to the specified directory. You can restore from a previously created
backup.

Veritas recommends creating a backup copy of the database files in the following
situations:

■ Before you move the database.

■ Before you rebuild the database.

■ Before you add data space.

■ Before you add index space.

■ Before you modify the transaction logging mode from FULL to PARTIAL.

■ Before you truncate the transaction log.

Note: Using the NetBackup Database Administration utility to back up and restore
the NetBackup database can potentially break the consistency between the
NetBackup catalog and the database. This loss of consistency can lead to loss of
data. Use the tool to back up and restore the NetBackup database only as a
precautionary measure.

The Backup and Restore Database menu contains the following options.

Table 24-12 Backup and Restore Database menu options

DescriptionOption

This option lets you make a copy of the database files while the database is active. Other
NetBackup activity is not suspended during this time.

Online Backup

This option lets you restore from a copy of the database files previously made with either
options 1 or 2. The currently running database files are overwritten, and the database is shut
down and restarted after the restore is completed.

Restore Backup

This option lets you change the directory location for the files that backup options (1) or (2)
create. This directory is the source of the files for the restore option (3).

Change Directory

See “Using the NetBackup Database Administration utility on UNIX” on page 990.
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Post-installation tasks
The tasks described in the following topics are optional and can be performed after
the initial installation:

■ Change the database password.
See “Changing the NetBackup database password” on page 999.

■ Move NBDB and BMRDB database files (possibly to tune performance).
See “Moving NBDB database files after installation” on page 1000.

■ Add a mirrored transaction log.
See “Adding a mirrored transaction log” on page 1002.

■ Recreate NBDB.
See “Creating the NBDB database manually” on page 1004.

Changing the NetBackup database password
The database password is set to a randomly generated password upon installation.
This password is used for NBDB and BMRDB and for all DBA and application
accounts. (For example, EMM_MAIN.) You can use this procedure to change it to a
known password.

The password is encrypted and stored in the vxdbms.conf file. The permissions
for the vxdbms.conf file allow only a Windows administrator or a root user to read
or write to it.

For requirements when NBAC is enabled, see the NetBackup Security and
Encryption Guide.
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To change the database password

1 Log on to the server as a Windows Administrator or as root.

2 To change the password for the first time after installation, run the following
command. The command updates the vxdbms.conf file with the new, encrypted
string:

OnWindows: install_path\NetBackup\bin\nbdb_admin -dba new_password

On UNIX: /usr/openv/db/bin/nbdb_admin -dba new_password

The password needs to be an ASCII string. Non-ASCII characters are not
allowed in the password string.

3 To change a known password to a new password, you can either use the
nbdb_admin command or the NetBackup Database Administration utility. You
must know the current password to log into the NetBackup Database
Administration utility.

See “Using the NetBackup Database Administration utility on Windows”
on page 978.

See “Using theNetBackupDatabase Administration utility on UNIX” on page 990.

Moving NBDB database files after installation
In the case of large databases, you can change the location of the database files
or split the database files into multiple directories to improve performance.

Note:Due to performance issues, NetBackup supports database files only on locally
attached drives.

Note: Run a catalog backup to back up NBDB and BMRDB both before and after
moving the database files.

Moving the database files on Windows
To move the NBDB and the BMRDB database files on Windows

1 Perform a catalog backup.

2 Shut down all NetBackup services by typing the following command:

install_path\Veritas\NetBackup\bin\bpdown

3 Start the SQL Anywhere service by typing the following command:

install_path\Veritas\NetBackup\bin\bpup -e SQLANYs_VERITAS_NB
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4 Use one of the following methods to move the existing data, index, and
transaction log files:

■ Use the NetBackup Database Administration utility.
See “Moving the NetBackup database files” on page 986.

■ Enter the following command:
install_path\Veritas\NetBackup\bin\nbdb_move.exe

-data data_directory

-index index_directory -tlog log_directory

You can run the nbdb_move command at any time because it does not drop
the database and recreate it. Thus, all data is preserved.
If a mirrored transaction log is in use, enter the following command:
install_path\Veritas\NetBackup\bin\nbdb_move.exe -data

data_directory

-index index_directory -tlog log_directory

-mlog log_mirror_directory

Note: NetBackup does not require that the database directories are
world-writable. Make sure that the new database directories (data_directory,
index_directory, log_directory, and log_mirror_directory) have
appropriate permissions so that the directories are not world-writable.

5 Start all services by typing the following command:

install_path\Veritas\NetBackup\bin\bpup

6 Perform a catalog backup.

Moving the database files on UNIX
To move the NBDB and the BMRDB database files on UNIX

1 Perform a catalog backup.

2 Shut down all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.kill_all

3 Start the SQL Anywhere daemon by typing the following command:

/usr/openv/netbackup/bin/nbdbms_start_stop start

4 Use one of the following methods to move the existing data, index, and
transaction log files:

■ Use the NetBackup Database Administration utility.
See “About the Move Database menu options” on page 996.
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■ Enter the following command:
/usr/openv/db/bin/nbdb_move

-data data_directory

-index index_directory -tlog log_directory

You can run the nbdb_move command at any time because it does not drop
the database and recreate it. Thus, all data is preserved.
If a mirrored transaction log is in use, enter the following command:
/usr/openv/db/bin/nbdb_move -data data_directory

-index index_directory -tlog log_directory

-mlog log_mirror_directory

Note: NetBackup does not require that the database directories are
world-writable. Make sure that the new database directories (data_directory,
index_directory, log_directory, and log_mirror_directory) have
appropriate permissions so that the directories are not world-writable.

5 Start all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.start_all

6 Perform a catalog backup.

See “About NetBackup master server installed directories and files” on page 967.

Adding a mirrored transaction log
The transaction logs NBDB.log and BMRDB.log are critical files used to recover the
SQL Anywhere databases.

For extra protection, use a mirrored transaction log. Create this mirrored log in a
different directory from the original log.

To create a mirrored transaction log on a Windows computer

1 Perform a catalog backup.

2 Shut down all NetBackup services by typing the following command:

install_path\Veritas\NetBackup\bin\bpdown

3 Start the SQL Anywhere service by typing the following command:

install_path\Veritas\NetBackup\bin\bpup -e SQLANYs_VERITAS_NB
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4 Create the mirrored transaction log:

Enter the following command:

install_path\Veritas\NetBackup\bin\nbdb_move.exe

-mloglog_mirror_directory

To move the existing data, index, transaction log files, and create the mirrored
transaction log, enter the following command:

install_path\Veritas\NetBackup\bin\nbdb_move.exe

-datadata_directory-index index_directory -tlog log_directory-mlog

log_mirror_directory

5 Start all NetBackup services by typing the following command:

install_path\Veritas\NetBackup\bin\bpup

6 Perform a catalog backup.

To create a mirrored transaction log on a UNIX computer

1 Perform a catalog backup.

2 Shut down all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.kill_all

3 Start the SQL Anywhere daemon by typing the following command:

/usr/openv/netbackup/bin/nbdbms_start_stop start

4 Create the mirrored transaction log:

Enter the following command:

/usr/openv/db/bin/nbdb_move -mlog log_mirror_directory

To move the existing data, index, transaction log files, and create the mirrored
transaction log, enter the following command:

/usr/openv/db/bin/nbdb_move -data data_directory-index

index_directory -tlog log_directory-mlog log_mirror_directory

5 Start all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.start_all

6 Perform a catalog backup.

See “About catalog backups” on page 932.

See “Moving NBDB database files after installation” on page 1000.
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Creating the NBDB database manually
The NBDB database is created automatically during NetBackup installation.
However, it may be necessary during certain catalog recovery situations to create
it manually by using the create_nbdb command.

Note: Recreating the database manually is not recommended in most situations.

Note: If the NBDB.db database already exists, the create_nbdb command does
not overwrite it. If you want to move the database, move it by using the nbdb_move

command.

To create the NBDB database manually on Windows

1 Shut down all NetBackup services by typing the following command:

install_path\Veritas\NetBackup\bin\bpdown

2 Start the SQL Anywhere service by typing the following command:

install_path\Veritas\NetBackup\bin\bpup -e SQLANYs_VERITAS_NB

3 Run the following command:

install_path\Veritas\NetBackup\bin\create_nbdb.exe

4 Start all NetBackup services by typing the following command:

install_path\Veritas\NetBackup\bin\bpup

5 The new NBDB database is empty and does not contain the EMM data that is
loaded during a normal installation.

Make sure that you have the most current support for new devices before the
data is repopulated. New devices are added approximately every 2 months.

6 Repopulate the EMM data by running the tpext utility. tpext updates the EMM
database with new versions of device mappings and external attribute files.

install_path\Veritas\Volmgr\bin\tpext.exe

During regular installation, tpext is run automatically.

If the create_nbdb command is used to create a database manually, the tpext
utility must also be run. tpext loads EMM data into the database.
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To create the NBDB database manually on UNIX

1 Shut down all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.kill_all

2 Start the SQL Anywhere daemon by typing the following command:

/usr/openv/netbackup/bin/nbdbms_start_stop start

3 Run the following command:

/usr/openv/db/bin/create_nbdb

4 Start all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.start_all

5 The new NBDB database is empty and does not contain the EMM data that is
loaded during a normal installation.

Make sure that you have the most current support for new devices before the
data is repopulated. New devices are added approximately every two months.

6 Repopulate the EMM data by running the tpext utility. tpext updates the EMM
database with new versions of device mappings and external attribute files.

/usr/openv/volmgr/bin/tpext

During regular installation, tpext is run automatically.

If the create_nbdb command is used to create a database manually, the tpext
utility must also be run. tpext loads EMM data into the database.

Additional create_nbdb options
In addition to using the create_nbdb command to create the NBDB database, you
also can use it to perform the following actions. In each command,NB_server_name
matches the name in server.conf.

See “About the NetBackup server.conf file” on page 968.

■ Drop the existing NBDB database and recreate it in the default location by typing
the following command:

■ On Windows: create_nbdb -drop[current_data_directory]

Provide the location of the current NBDB data directory,
current_data_directory, if the default location is not used.

■ On UNIX: create_nbdb -drop

The location of the current NBDB data directory is retrieved automatically
from the bp.conf file.

The -drop option instructs NetBackup to drop the existing NBDB database.
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■ Drop the existing NBDB database and do not recreate by typing the following
command:
On Windows: create_nbdb -db_server NB_server_name

-drop_only[current_data_directory]

On UNIX: create_nbdb -drop_only

Provide the location of the current NBDB data directory,
current_data_directory, if the default location is not used.

■ Drop the existing NBDB database and recreate it in the directories as specified
by typing the following command:

■ On Windows:
create_nbdb -drop [current_data_directory] -data

data_directory-index index_directory -tlog log_directory

[-mloglog_mirror_directory]

■ On UNIX:
create_nbdb -drop -data data_directory -index index_directory

-tlog log_directory [-mloglog_mirror_directory]

If the NBDB database files weremoved from the default location by using nbdb_move,
use this command to recreate them in the same location. Specify
current_data_directory.

If the location of NBDB.db changed from the default, BMRDB.db must also be
recreated. The BMRDB.db files must reside in the same location as the NetBackup
database files.

About backup and recovery procedures
The catalog method can be performed while regular backup activity takes place. It
runs according to a policy and is virtually transparent to the customer. Set up the
policy by using either the Catalog BackupWizard or the Policy ConfigurationWizard.
Either wizard automatically includes all the necessary catalog files to include the
database files (NBDB, NBAZDB, and BMRDB) and any catalog configuration files
(vxdbms.conf, server.conf, databases.conf).

The catalog allows an administrator to recover either the entire catalog or pieces
of the catalog. (For example, the databases separately from the image catalog.)

It offers an incremental backup. For Sybase SQL Anywhere, an incremental backup
means a backup of the transaction log only. Transaction logs are managed
automatically, truncated after each successful backup.
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Database transaction log
The transaction log for the NetBackup database is necessary for recovering the
database. It is automatically truncated after a successful catalog backup.

The transaction log, NBDB.log, is located by default in the following directory:

On Windows: install_path\NetBackupDB\data\NBDB.log

On UNIX: /usr/openv/db/data/NBDB.log

The transaction log continues to grow until it becomes truncated. Catalog backups
must run frequently enough so that the transaction log does not grow to fill the file
system.

In addition to the default transaction log, a mirrored transaction log can be created
for additional protection of NBDB.

The directory for the mirrored log should not be the same as the directory for the
default transaction log. Ideally, the mirrored log should be located on a file system
on a different physical disk drive.

If BMR is installed, a transaction log for BMRDB is also created by default in:

On Windows: install_path\NetBackupDB\data\BMRDB.log

On UNIX: /usr/openv/db/data/BMRDB.log

It has an optional mirrored log in the following location:

On Windows: mirrored_log_directory\BMRDB.m.log

On UNIX: mirrored_log_directory/BMRDB.m.log

The BMRDB transaction logs are backed up and truncated during the catalog backup
along with the NBDB transaction logs.

Note: If a catalog backup is not run, the logs are not truncated. Truncation must
be managed in this manner as it is critical to recovery of the database.

About catalog recovery
Recovery scenarios include the following:

■ A full recovery from a complete disaster
Using the Disaster Recovery wizard, the databases are restored along with
the image catalog to a consistent state.

■ A recovery of the database files only
Using bprecover, the relational database files and configuration files can be
restored and recovered.
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Details about catalog recovery scenarios and procedures are available in the
NetBackup Troubleshooting Guide.

Commands for backing up and recovering the relational databases
The recommended method to protect the relational databases is to use the catalog
backup and recovery interfaces.

A temporary backup of the NBDB and BMRDB databases can be made for extra
protection before database administration activities such moving or reorganizing
the database files.

Table 24-13 Commands used to back up and recover relational databases

DescriptionCommand

Use nbdb_backup or nbdb_backup.exe to make a copy of the NBDB database files and the
BMRDB database files in a directory. The nbdb_backup command does not truncate the transaction
log. Transaction logs are managed only by using the catalog backup.

On Windows:

install_path\NetBackup\bin\nbdb_backup.exe [-dbn database_name] -online
destination_directory [tlog_only] [-truncate_tlog]

On UNIX:

/usr/openv/db/bin/nbdb_backup [-dbn database_name] -online
destination_directory [tlog_only] [-truncate_tlog]

-dbn database_name only backs up the specified database (NBDB or BMRDB).

-online destination_directory is the location for the copied files.

-tlog_only generates only the database transaction log along with the configuration files for
the backup.

-truncate_tlog truncates the database transaction log after the backup completes the backup.

Note: Using this command (or the NetBackup Database Administration utility) to back up the
NetBackup database can potentially break the consistency between the NetBackup catalog and
the database. This loss of consistency can lead to loss of data. Use this command (or the
NetBackup Database Administration utility) to back up the NetBackup catalog only as a
precautionary measure.

nbdb_backup or
nbdb_backup.exe
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Table 24-13 Commands used to back up and recover relational databases
(continued)

DescriptionCommand

Use nbdb_restore to recover from a database backup that was made using nbdb_backup.

On Windows: install_path\NetBackup\bin\nbdb_restore.exe -recover
source_directory -dbn database_name [-ignore_tlog]

On UNIX: /usr/openv/db/bin/nbdb_restore -recover source_directory -dbn
database_name [-ignore_tlog]

Logs are recorded in the /admin or \admin directory.

nbdb_restore restores from the staging directory to recover only the NetBackup database
(NBDB). The default is to apply the current transaction log to make the database as consistent
as possible with the current db\images or /db/images directory.

-ignore_tlog does not apply the current transaction log to the NBDB recovery operation.

Note: Using this command (or the NetBackup Database Administration utility) to restore the
NetBackup database can potentially break the consistency between the NetBackup catalog and
the database. This loss of consistency can lead to loss of data. Use this command (or the
NetBackup Database Administration utility) to restore the NetBackup catalog only as a
precautionary measure.

nbdb_restore or
nbdb_restore.exe

About the catalog backup process
Normally, a catalog backup consists of one parent job and two or more child jobs.
Events for these jobs appear in the dbm log.

An overview of the catalog backup process consists of the following process:

■ Creates a staging directory where the command can store the temporary copies:
On Windows: install_path\NetBackupDB\staging
On UNIX: /usr/openv/db/staging
Once the copy is made, NetBackup can back up the catalog files.

■ A child job backs up files in a single stream as follows:

■ Configuration files (server.conf, database.conf, vxdbms.conf)

■ Database files
BMR_DATA.db

BMRDB.db

BMRDB.log

BMR_INDEX.db

DARS_DATA.db
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DARS_INDEX.db

DBM_DATA.db

DBM_INDEX.db

EMM_DATA.db

EMM_INDEX.db

JOBD_DATA.db

NBAZDB.db

NBAZDB.db.template

NBAZDB.log

NBDB.db

NBDB.log

vxdbms.conf

If BMR was installed

■ A second child job begins the image catalog backup.

■ Transaction logs are truncated after a successful full or incremental backup.
If the transaction logs are manually changed or deleted, a hole could exist in
the recovery.
The child job for the relational database backup is normally run on the master
server. The master server is the default location for NBDB and the required
location for BMRDB.
If NBDB was moved to a media server, the child job runs on the media server.
In this case, additional logging for the job appears in the admin log on the media
server.
If NBDB was moved to a media server and BMRDB is installed on the master
server, two child jobs exist for the relational database backup portion of the
catalog backup. One on the media server for NBDB and one on the master
server for BMRDB.

Unloading the NetBackup database
Use the NetBackup Database Administration utility or the nbdb_unload command
line utility to dump the entire NetBackup or Bare Metal Restore databases. These
utilities can also be used to dump individual tables (one .dat file is created for each
table), or schema. Use either method to create a copy of the SQL Anywhere
database that may be requested in some customer support situations.

There should be no active connections to the database when nbdb_unload is run.
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When either method is used, a reload.sql script is generated. The script contains
all the code that is required to recreate the database. Veritas Technical Support
uses this script and the associated files to assist in support cases.

On Windows:

install_path\NetBackup\bin\nbdb_unload.exe [-dbn database_name] [-t

table_list] [-s] destination_directory

On UNIX:

/usr/openv/db/bin/nbdb_unload [-dbn database_name] [-t table_list]

[-s] destination_directory

In the script where:

■ -dbn database_name

database_name is NBDB (default) or BMRDB.

■ -t table_list

Must list the owner of the table, then the table name. For EMM, the account
EMM_MAIN owns all tables.
nbdb_unload -t EMM_MAIN.EMM_Device, EMM_MAIN.EMM_Density

■ -s

No data is dumped, only schema.

■ destination_directory

Specify the location where the dump is created.

Terminating database connections
Before you run nbdb_unload, shut down NetBackup to terminate all active
connections to the database. Shutting down NetBackup eliminates any possible
concurrency problems.

To terminate database connections on Windows

1 Shut down all NetBackup services by typing the following command:

install_path\NetBackup\bin\bpdown

2 In the Windows Services Manager, restart the service titled NetBackup
Relational Database Manager.

3 Use one of the following methods to terminate database connections:

■ Use the NetBackup Database Administration utility.
See “Using the NetBackup Database Administration utility on Windows”
on page 978.
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■ Run nbdb_unload and indicate the outputs (database name, table lists, or
schema only) and the destination directory.

4 Stop the SQL Anywhere service by typing the following command:

install_path\NetBackup\bin\bpdown -e SQLANYs_VERITAS_NB

5 Start all NetBackup services by typing the following command:

install_path\NetBackup\bin\bpup

To terminate database connections on UNIX

1 Shutdown all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.kill_all

2 Start the SQL Anywhere daemon by typing the following command:

/usr/openv/netbackup/bin/nbdbms_start_stop start

3 Start only the database server by using
/usr/openv/netbackup/bin/nbdbms_start_stop start

4 Use one of the following methods to terminate database connections:

■ Use the NetBackup Database Administration utility.
See “Using the NetBackup Database Administration utility on UNIX”
on page 990.

■ Run nbdb_unload and indicate the outputs (database name, table lists, or
schema only) and the destination directory.

5 Shut down the database server by using /usr/openv/netbackup/bin

nbdbms_start_stop stop.

6 Stop the SQL Anywhere daemon by typing the following command:

/usr/openv/netbackup/bin/nbdbms_start_stop stop

7 Start all NetBackup daemons by typing the following command:

/usr/openv/netbackup/bin/bp.start_all

Veritas does not recommend using reload.sql to make a copy of the relational
databases in a production environment. Use the NetBackup Database Administration
utility or nbdb_backup to make a physical copy or use nbdb_move to relocate the
database files.
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Managing backup images
This chapter includes the following topics:

■ About the Catalog utility

■ About searching for backup images

■ Verifying backup images

■ Viewing job results

■ Promoting a copy to a primary copy

■ Duplicating backup images

■ Expiring backup images

■ About importing backup images

About the Catalog utility
Use the Catalog utility in the NetBackup Administration Console to create and
configure catalog backups. Catalog backups are required for NetBackup to protect
NetBackup internal databases. The catalogs contain setup information as well as
critical information about client backups. The catalog backups are tracked separately
from other backups to ensure recovery in case of a server crash.

The Catalog utility is also used to perform the following actions:

■ Search for backup images to verify the contents of media with what is recorded
in the NetBackup catalog.

■ Duplicate a backup image.

■ Promote a backup image from a copy to the primary backup copy.

■ Expire backup images.
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■ Import expired backup images or images from another NetBackup server.

Figure 25-1 Catalog utility options

1

3

5

2 4

6

Table 25-1 Host Properties utility

DescriptionNumber

The name of the currently selected master server.1

Right-click Catalog to view the shortcut menu.2

Select an action to perform in the Catalog utility.3

Set search criteria, including a specific media and date range.4

The user toolbar is specific to the Catalog utility.5

Display of search results.6

About searching for backup images
Use theCatalog utility to search for a backup image to perform the following actions:

■ Verify the backup contents with what is recorded in the NetBackup catalog.

■ Duplicate the backup image to create up to 10 copies.

■ Promote a copy of a backup to be the primary backup copy.
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■ Expire backup images.

■ Import expired backup images or images from another NetBackup server.

NetBackup uses the specific search criteria to build a list of backups from which
you can make your selections.

When you search for specific kinds of images, note the following:

■ Verification image
Backups that have fragments on another volume are included, as they exist in
part on the specified volume.

■ Import image
The backup is not imported if it begins on a media ID that the initiating backup
procedure did not process.
The backup is incomplete if it ends on a media ID that the initiating backup
procedure did not process.
See “About importing backup images” on page 1027.

Table 25-2 lists the search criteria for backup images.

Table 25-2 Catalog utility search properties

DescriptionProperty

Specifies the action that was used to create the image: Verify, Duplicate, Import.

See “Verifying backup images” on page 1017.

See “Duplicating backup images” on page 1020.

See “Expiring backup images” on page 1026.

Action

Specifies the media ID for the volume. Enter a media ID in the box or select one from the
scroll-down list. To search on all media, select <All>.

Media ID

On UNIX: Specifies the host name of the media server that produced the originals. Enter a
host name in the box or select one from the scroll-down list. To search through all hosts, select
All Media Hosts.

Media Host

On Windows: Specifies the name of the media server that produced the originals. Enter a
media server name in the box or select one from the scroll-down list. To search through all
media servers, select All Media Servers.

Media Server

Specifies the type of the disk storage unit on which to search for backup images.Disk type

Specifies the name of the disk pool on which to search for backup images.Disk pool

Specifies the ID of the disk volume in the disk pool on which to search for backup images.Volume ID
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Table 25-2 Catalog utility search properties (continued)

DescriptionProperty

Searches for an image on a disk storage unit, if the path is entered. Or, searches all of the
disk storage on the specified server, if All was selected. Appears if the disk type is BasicDisk.

Path

Specifies the range of dates and times that includes all the backups for which you want to
search. The Global Attributes property Policy Update Interval determines the default range.

Date/time range

Specifies the source you want to search. From the scroll-down list, select either Primary or
the copy number.

Copies

Specifies the policy under which the selected backups were performed. Enter a policy name
in the box or select one from the scroll-down list. To search through all policies, select All
Policies.

Policy

Specifies the host name of the client that produced the originals. Enter a client name in the
box or select one from the scroll-down list. To search through all hosts, select All Clients.

Client (host name)

Specifies the type of schedule that created the backup. Enter a schedule type in the box or
select one from the scroll-down list. To search through all schedule types, select All Backup
Types.

Type of backup

Selects the job priority for verify, duplicate, and import actions.

To change the default for the selected action, enable Override default job priority. Then,
select a value in the Job Priority field.

Changes in the catalog dialog box affect the priority for the selected job only.

If this option is not enabled, the job runs using the default priority as specified in the Default
Job Priorities host properties.

See “Default Job Priorities properties” on page 100.

Override default job
priority

The Search tab columns list information about matching backup images based on the defined
search criteria.

Search tab columns

The Results tab displays the progress of the request to verify, duplicate, expire, or import an
image.

Results tab columns

On UNIX: Displays the messages about the tasks that run as background processes. The
pane appears only if there is an informative message or error message for a task. If the task
completes normally, the pane does not appear. The Messages pane can be maximized,
minimized, or closed.

Messages pane
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Verifying backup images
NetBackup can verify the contents of a backup by reading the volume and comparing
its contents to what is recorded in the NetBackup catalog.

This operation does not compare the data on the volume to the contents of the
client disk. However, the operation does read each block in the image to verify that
the volume is readable. (However, data corruption within a block is possible.)
NetBackup verifies only one backup at a time and tries to minimize media mounts
and positioning time.

To verify backup images

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, on the Search tab, set up the search criteria for the image
you want to verify. Click Search Now.

3 In the right pane, select the image you want to verify and on the Action
drop-down menu, select Action > Verify.

4 In the right pane, click the Results tab, then select the verification job to view
the job results.

Viewing job results
The results of verify, duplicate, or import jobs appear in the Results tab for the
Catalog options. The top portion of the dialog box displays all existing log files.

To view a log file, select the name of the log from the list. The current log file appears
in the bottom portion of the Results dialog box. If an operation is in progress, the
log file results refresh as the operation proceeds.

To view job results

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, click the Results tab.

3 Select a log file.

4 On the View menu, click View > Full View to display the entire log file in a
screen editor.

On the Edit menu, select Edit > Delete to delete the log.

You can also right-click the log file and select an action from the scroll-down
menu.
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Promoting a copy to a primary copy
Each backup is assigned a primary copy. NetBackup uses the primary copy to
satisfy restore requests. The first backup image that is created successfully by a
NetBackup policy is the primary backup. If the primary copy is unavailable and a
duplicate copy exists, select a copy of the backup and set it to be the primary copy.

NetBackup restores from the primary backup, and Vault duplicates from the primary
backup. If your Vault profile performs duplication, you can designate one of the
duplicates as the primary. In most circumstances, the copy remaining in the robot
is the primary backup. When a primary backup expires, the next backup (if it exists)
is promoted to primary automatically.

Use one of the following methods to promote a copy to a primary copy:

Promoting a backup copy to a primary copy using the
NetBackup Administration Console

Promote a backup copy to a primary copy using search
criteria

Promoting a copy to a primary copy for many backupsPromote a copy to a primary copy for many backups using
the bpchangeprimary command

Promoting a backup copy to a primary copy using
bpduplicate

Promote a backup copy to a primary copy using the
bpduplicate command

Figure 25-2 Primary copy status

Primary Copy status indicates that the
image is now the primary copy
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Promoting a backup copy to a primary copy using the
NetBackup Administration Console
To promote a backup copy to a primary copy

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, set up the search criteria for the image you want to promote
to a primary copy. Be sure that you indicate a copy in the Copies field and not
Primary Copy. Click Search Now.

See “About searching for backup images” on page 1014.

3 Select the image you want to promote.

4 On the Actions menu, click Actions > Set Primary Copy.

After the image is promoted to the primary copy, the Primary Status column
immediately reads Yes.

Promoting a copy to a primary copy for many backups
To promote a copy to a primary copy for many backups

◆ You can also promote a copy to be a primary copy for many backups using
the bpchangeprimary command. For example, the following command promotes
all copies on the media that belongs to the SUN volume pool. The copies must
have been created after August 8, 2012:

bpchangeprimary -pool SUN -sd 08/01/2012

In the next example, the following command promotes copy 2 of all backups
of client_a. The copies must have been created after January 1, 2012:

bpchangeprimary -copy 2 -cl client_a -sd 01/01/2012

More information is available in the NetBackup Commands Reference Guide.
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Promoting a backup copy to a primary copy using
bpduplicate
To use bpduplicate to promote a backup copy to a primary copy

1 Enter the following command:

On Windows:

install_path\NetBackup\bin\admincmd\bpduplicate

-npc pcopy -backupid bid

On UNIX:

/usr/openv/netbackup/bin/admincmd/bpduplicate -npc pcopy

-backupid bid

Where:

pcopy is the copy number of the new primary copy.

bid is the backup identifier as shown in the Images on Media report.

Find the volume that contains the duplicate backup by using the Images on
Media report.

2 Specify the backup ID that is known (and also the client name if possible to
reduce the search time).

The bpduplicate command writes all output to the NetBackup logs. Nothing
appears in the command window.

After the duplicate copy is promoted to the primary copy, use the client interface
on the client to restore files from the backup.

For instructions, see the online Help in the Backup, Archive, and Restore
client interface.

Duplicating backup images
NetBackup does not verify in advance whether the storage units and the drives that
are required for the duplicate operation are available for use. NetBackup verifies
that the destination storage units exist. The storage units must be connected to the
same media server.

Table 25-3 lists the scenarios in which duplication is possible and scenarios in which
duplication is not possible:

1020Managing backup images
Duplicating backup images



Table 25-3 Backup duplication scenarios

Duplication not possibleDuplication possible

■ While the backup is created (unless making
multiple copies concurrently).

■ When the backup has expired.
■ By using NetBackup to schedule

duplications automatically (unless you use
a Vault policy to schedule duplication)

■ When it is a multiplexed duplicate of the
following type:
■ FlashBackup
■ NDMP backup
■ Backups from disk type storage units
■ Backups to disk type storage units
■ Nonmultiplexed backups

■ From one storage unit to another.
■ From one media density to another.
■ From one server to another.
■ From multiplex to nonmultiplex format.
■ From multiplex format and retain the

multiplex format on the duplicate. The
duplicate can contain all or any subset
of the backups that were included in the
original multiplexed group. The duplicate
is created with a single pass of the tape.
(A multiplexed group is a set of backups
that were multiplexed together during a
single session.)

An alternative to taking time to duplicate backups is to create up to four copies
simultaneously at backup time. (This option is sometimes referred to as Inline Copy.)
Another alternative is to use storage lifecycle policies.

See “About writing multiple copies using a storage lifecycle policy” on page 699.

To duplicate backup images

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, set up the search criteria for the image you want to duplicate.
Click Search Now.
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3 Right-click the image(s) you want to duplicate and select Duplicate from the
shortcut menu.

If you duplicate an online, hot catalog backup, select all child jobs that were
used to create the catalog backup. All jobs must be duplicated to duplicate the
catalog backup.

1022Managing backup images
Duplicating backup images



4 Specify the number of copies you want to create. NetBackup can create up to
10 copies of unexpired backups.

If enough drives are available, the copies are created simultaneously.
Otherwise, the system may require operator intervention if four copies are to
be created using only two drives, for example.

5 The primary copy is the copy from which restores are done. Normally, the
original backup is the primary copy.

If you want one of the duplicated copies to become the primary copy, check
the appropriate check box, otherwise leave the fields blank.

When the primary expires, a different copy automatically becomes primary.
(The copy that is chosen is the one with the smallest copy number. If the primary
is copy 1, copy 2 becomes primary when it expires. If the primary is copy 5,
copy 1 becomes primary when it expires.)

6 Specify the storage unit where each copy is stored. If a storage unit has multiple
drives, it can be used for both the source and destination.

All storage units must meet the criteria for creating multiple copies.

See “About configuring multiple copies” on page 806.
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7 Specify the volume pool where each copy is stored.

The following volume pool selections are based on the policy type setting that
was used for the query.

Specifies that all volume pools are
included in the drop-down list. Both
catalog and non-catalog volume pools are
included.

If the Policy type is set toAll Policy Types
(default).

Specifies that only catalog volume pools
are included in the drop-down list.

If the Policy type is set to NBU-Catalog.

Specifies that only non-catalog volume
pools are included in the drop-down list.

If the Policy type is set to a policy type
other than NBU-Catalog or All Policy
Types.

NetBackup does not verify that the media ID selected for the duplicate copy is
different from the media ID that contains the original backup. Because of this
potential deadlock, specify a different volume pool to ensure that a different
volume is used.

8 Select the retention level for the copy, or select No change.

The duplicate copy sharesmany attributes of the primary copy, including backup
ID. Other attributes apply only to the primary. (For example, elapsed time.)
NetBackup uses the primary copy to satisfy restore requests.

Consider the following items when selecting the retention level:

■ If No Change is selected for the retention period, the expiration date is the
same for the duplicate and the source copies. You can use the bpexpdate

command to change the expiration date of the duplicate.

■ If a retention period is indicated, the expiration date for the copy is the
backup date plus the retention period. For example, if a backup was created
on November 14, 2010 and its retention period is one week, the new copy’s
expiration date is November 21, 2010.

9 Specify whether the remaining copies should continue or fail if the specified
copy fails.
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10 Specify who should own the media onto which you duplicate images.

Select one of the following:

Specifies that NetBackup chooses the media owner,
either a media server or server group.

Any

Specifies the media server that writes to the media
owns the media. No media server is specified
explicitly, but you want a media server to own the
media.

None

Specifies that only those media servers in the group
are allowed to write to the media on which backup
images for this policy are written. All of the media
server groups that are configured in your NetBackup
environment appear in the drop-down list.

A server group

11 If the selection includes multiplexed backups and the backups are to remain
multiplexed in the duplicate, check Preserve Multiplexing. If you do not
duplicate all the backups in a multiplexed group, the duplicate contains a
different layout of fragments. (A multiplexed group is a set of backups that were
multiplexed together during a single session.)

By default, duplication is done serially and attempts to minimize media mounts
and positioning time. Only one backup is processed at a time. If Preserved
Multiplexing is enabled, NetBackup first duplicates all backups that cannot
be multiplex duplicated before the multiplexed backups are duplicated.

The Preserve Multiplexing setting does not apply when the destination is a
disk storage unit. However, if the source is a tape and the destination is a disk
storage unit, select Preserve Multiplexing to ensure that the tape is read in
one pass.

12 Click OK to start duplicating.

13 Click the Results tab, then select the duplication job to view the job results.

See “Viewing job results” on page 1017.

See “Multiplexed duplication considerations” on page 1025.

Multiplexed duplication considerations
Consider the following items about multiplexed duplication.
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Table 25-4 Multiplexed duplication considerations

DescriptionConsideration

When multiplexed backups are duplicated, the multiplex
settings of the destination storage unit and the original
schedule are ignored. However, if multiple multiplexed groups
are duplicated, the grouping within each multiplexed group
is maintained. This means that the duplicated groups have
a multiplexing factor that is no greater than the factor that
was used during the original backup.

Multiplex settings are ignored

When backups in a multiplexed group are duplicated to a
storage unit, the duplicated group is identical as well.
However, the storage unit must have the same characteristics
as the unit where the backup was originally performed. The
following items are exceptions:

■ If EOM (end of media) is encountered on either the source
or the destination media.

■ If any of the fragments are zero length in the source
backups, the fragments are removed during duplication.
A fragment of zero length occurs if many multiplexed
backups start at the same time.

Backups in a multiplexed
group are duplicated and
duplicated group is identical

Jobs that appear while making multiple copies
When multiple copies are made concurrently, a parent job appears, plus a job for
each copy.

The parent job displays the overall status, whereas the copy jobs display the status
of a single copy. Viewing the status of individual jobs lets you troubleshoot jobs
individually. For example, if one copy fails but the other copy is successful, or if
each copy fails for different reasons. If at least one copy is successful, the status
of the parent job is successful. Use the Parent Job ID filter to display the parent
Job ID. Use the Copy filter to display the copy number for a particular copy.

Expiring backup images
To expire a backup image means to force the retention period to expire, or
information about the backup is deleted. When the retention period expires,
NetBackup deletes information about the backup. The files in the backups are
unavailable for restores without first re-importing.
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To expire a backup image

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, set up the search criteria for the image you want to expire,
then click Search Now.

See “About searching for backup images” on page 1014.

3 Select the image you want to expire and on the Actionsmenu, select Actions
> Expire.

4 A message appears that announces that once the backups are expired, they
cannot be used for restores. Select Yes to begin to expire the images.

If the user attempts to manually expire an image or some image copies that are
not SLP-complete, the request fails with status code 1573 (Backup image cannot
be expired because its SLP processing is not yet complete). Use the NetBackup
Troubleshooter or the NetBackup Status Codes Reference Guide to determine
corrective actions.

If you use the NetBackup Administration Console to expire NetBackup images,
the image extension files remain in the catalog. However, NetBackup expires the
image extension files, usually within 12 hours.

About importing backup images
NetBackup can import the backups that have expired or the backups from another
NetBackup server.

During an import operation, NetBackup recreates NetBackup catalog entries for
the backups on the imported volume. The import capability is useful for moving
volumes from one site to another and for recreating NetBackup catalog entries.

An image is imported in the following two phases:

Table 25-5 Phases to import an image

DescriptionPhase

NetBackup creates a list of expired catalog entries for the backups on the imported volume. No actual
import occurs in Phase I.

See “Importing backup images, Phase I” on page 1028.

Phase I: Initiate
Import

Images are selected for importing from the list of expired images that was created in Phase I.

See “Importing backup images, Phase II” on page 1030.

Phase II:
Import
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About importing expired images
The expiration date for the imported items is the current date plus the retention
period. For example, if a backup is imported on November 14, 2015, and its retention
period is one week, the new expiration date is November 21, 2015.

Consider the following items when importing backup images:

■ NetBackup can import the disk images that NetBackup version 6.0 (or later)
writes.

■ You cannot import a backup if an unexpired copy of it already exists on the
server.

■ NetBackup does not direct backups to imported volumes.

■ If you import a catalog backup, import all the child jobs that were used to create
the catalog backup. All jobs must be imported to import the catalog backup.

■ To import a volume with the same media ID as an existing volume on a server,
use the following example where you want to import a volume with media ID
A00001. (A volume with media ID A00001 already exists on the server.)

■ Duplicate the existing volume on the server to another media ID (for example,
B00001).

■ Remove information about media ID A00001 from the NetBackup catalog
by running the following command:
On Windows:
install_path\NetBackup\bin\admincmd\bpexpdate

-d 0 -m mediaID

On UNIX:
/usr/openv/netbackup/bin/admincmd/bpexpdate -d 0 -m

media_ID

■ Delete media ID A00001 from Media Manager on the server.

■ Add the other A00001 to Media Manager on the server.
To avoid this problem in the future, use unique prefix characters for media IDs
on all servers.

See “Expiring backup images” on page 1026.

Importing backup images, Phase I
Phase I of the import process creates a list of images from which to select to import
in Phase II. No import occurs in Phase I.
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If tape is used, each tape must be mounted and read. It may take some time to
read the catalog and build the list of images.

To import a catalog backup, import all of the child jobs that were used to create the
catalog backup.

Use the following procedure to initiate an import of backup images.

To perform Phase I: initialize import of backup images

1 To import the images from tape, make the media accessible to the media server
so the images can be imported.

2 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

3 On the Actions menu, select Initiate Import.

4 In the Initialize Import window, in the Media Server field, specify the name
of the host that contains the volume to import. This media server becomes the
media owner.
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5 Indicate the location of the image. Under Image type, select whether the images
to be imported are located on tape or on disk.

The following table shows the actions to take depending on the location of the
image.

In the Media ID field, enter the Media ID of the volume
that contains the backups to import.

If images are on tape

In the Disk type field, select the type of the disk storage
unit on which to search for backup images. The disk types
depend on which NetBackup options are licensed.

If the disk type references a disk pool, enter or select the
disk pool and the disk volume ID.

For a BasicDisk type, enter or browse to the path to the
images in the field provided.

If images are on disk

Click OK.

6 Click OK to begin reading the catalog information from the source volume.

7 Click on the Results tab to watch as NetBackup looks at each image on the
tape. NetBackup determines whether or not each image has expired and can
be imported. The job also displays in Activity Monitor as an Image Import type.
Select the import job log to view the job results.

Importing backup images, Phase II
To import the backups, first run the Initiate Import operation (Import Phase I). The
first phase reads the catalog to determine all of the media that contain the catalog
backup images. After Phase I, start the Import operation (Phase II). If Phase II is
run before Phase I, the import fails with a message. For example, Unexpected EOF
or Import of backup ID failed, fragments are not consecutive.
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To import backup images, Phase II

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Catalog.

2 In the right pane, set up the search criteria to find images available to import
by setting the search action to Import. Be sure to select a date range that
includes the images you want to import.

Select Import to search
for imported images

Images eligible for importing
appear as a search result

Select the date range
that includes the
images to import

3 Select the image(s) you want to import. On the Actionsmenu, select Actions
> Import to import the selected images.

4 In the Confirm Import dialog box, select whether you'd like to log the names
of all of the files that are found in the imported images. Click OK.

5 Click the Results tab to view the progress of Import Phase 2.
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Deployment Management

■ Chapter 26. Deployment Management

6Section



Deployment Management
This chapter includes the following topics:

■ About deployment policies utility

■ Deployment policy management

■ Copying a deployment policy to create a new deployment policy

■ Copying or moving policy items to another policy

■ Attributes tab

■ Schedules tab

■ Adding or changing schedules in a deployment policy

■ Deleting schedules or hosts from a deployment policy

■ Manually initiating deployment jobs with a policy

■ Perform client initiated upgrade with VxUpdate

■ Deployment job status

About deployment policies utility
Deployment policies is the main component of VxUpdate that serves as a client or
host upgrade tool. The deployment policy lets you configure and run deployment
activities on a schedule or enable the host owners to upgrade at their convenience.
You can schedule precheck, staging, and installation tasks as separate activities
with different schedules, each with their own specific deployment windows.

For more information regarding VxUpdate, see the About VxUpdate section within
the NetBackup Upgrade Guide.

https://www.veritas.com/support/en_US/article.DOC5332
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The deployment policies are not located with the other policies in the NetBackup
Administrative Console. Deployment policies are located in the NetBackup
Administration Console underDeployment Management > Deployment Policies.

Deployment policies provide the instructions that NetBackup follows to upgrade
clients or hosts. Use the Deployment Policies utility to provide the following
instructions for a client or host upgrade:

See “Attributes tab” on page 1041.What type of client or host to upgrade

See “Schedules tab” on page 1042.When to perform VxUpdate

Using the deployment policies utility
To navigate in the deployment policies utility

1 In the NetBackup Administration Console, in the left pane, select
Deployment Management > Deployment Policies

2 To display the policy details of a single
policy:

In the center pane, select a policy name.
The policy details display in the right pane.

In the center pane, double-click on the
policy name. The Change Deployment
Policy dialog box opens.

To open a policy:

■ In the center pane, click on the tree
element next to the policy name to
expand the policy configuration areas:

■ Attributes
■ Schedules
■ Hosts
■ In the center pane, under a policy

name, select one of the configuration
areas to see a detailed view of that
area.

To display specific configuration
information:

In the center pane, click Summary of
Policies.

To display information about all policies on
the current master server:

■ In the center pane, click Summary of
Policies.

■ Select a single or multiple deactivated
policies in the right pane. While the
policies are selected, right-click and
select Activate

To activate the deactivated policies:
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■ In the center pane, click Summary of
Policies.

■ Select a single or multiple policies in
the right pane. While the policies are
selected, right-click and select
Deactivate

To deactivate the active policies:

See “Copying a deployment policy to
create a new deployment policy”
on page 1039.

To copy a policy to create new policy

Deployment policy management
Use the procedures that are shown to create, modify, and delete your deployment
policies.

Creating a deployment policy

Note: You must add packages to the VxUpdate repository before you can create
a working deployment policy. You can create deployment policies without packages
in the repository, but those policies fail to run successfully. More information about
the management of the VxUpdate repository is available.

1 In the NetBackup Administration Console, in the left pane, select Deployment
Management > Deployment Policies.

2 From the Actions menu, select New Deployment Policy.

3 Enter a unique name for the new policy in the Add a New Deployment Policy
dialog box.

4 Click OK.

5 Specify the information that is shown on the Attributes tab in the Change
Deployment Policy window:

■ Package: Select the package that you want deployed from the drop-down
menu.

Note: Specifying a package that supports external certificate authority
certificates presents you with an additional tab titled Security. That tab is
covered later in this procedure.
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■ Media server: Specify themedia server from drop-down. Themedia server
that is specified is used to connect and transfer files to the NetBackup hosts
that are included in the policy. The media server also caches the files from
the NetBackup repository. The media server must be version NetBackup
8.1.2 or later. Since the repository resides on the master server, the master
server is the default value for the media server field.
When you upgrade media servers, the Media server drop-down is
automatically set to the master server and cannot be changed.

■ (Conditional): Select the Limit simultaneous jobs option and specify a
value for jobs to limit the total number of concurrent jobs that can run at a
time. The minimum value is 1 and the maximum value is 999.
If the check box is selected, the default value is 3. If you do not select the
check box, no limit is enforced for the simultaneous upgrade jobs.
You can set unlimited simultaneous upgrade jobs through command line
interface by setting the value as 0.

■ Select hosts: Select hosts from the Available hosts list and select Add
to add hosts to the deployment policy. The list is generated from hosts in
the host database and backup policies. Once you select Add, the hosts
are shown under Selected hosts.
Deployment policies can contain either media servers or clients but not
both. When you select the package you want installed, the list of available
hosts is filtered to media servers or clients.

Note: To upgrade a 7.7.x or 8.0 media server, the media server must be
in a backup policy. The policy does not need to be active and you do not
need to run the policy. Once the media server is upgraded to NetBackup
8.2, you can remove the policy. The policy only needs to have the media
server in the client list. You do not need to specify a file list, schedule, or
any other policy attributes.

If the media server is not in a policy, the operating system for the media
server is listed as Unknown. A tool tip suggests this issue is a missing
package. Package for the selected host’s operating system is missing.
Add the requiredmissing packages to the repository using the nbrepo
command line.While it may be true the package is not in the repository,
you should also add the media server to a backup policy. If the tool tip
persists after the media server is added to a policy, you probably need to
add the required package.

6 Select the Schedules tab in the Change Deployment Policy window.

You can see a summary of all schedules within that policy.
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7 Select New.

8 Specify the information that is shown in the Add Deployment Schedule
window.

■ Name: Enter a name for the new schedule.

■ Type: Specify the type of schedule you want created.

Schedule types:

■ Precheck
Performs the various precheck operations, including confirming there
is sufficient space on the client for the update. The precheck schedule
type does not exist for EEB packages.

■ Stage
Moves the update package to the client, but does not install it. Also
performs the precheck operation.

■ Install
Installs the specified package. Also performs the precheck and the stage
package operations. If you already performed the stage package
operation, the install schedule does not move the package again.

Note: Please be aware that adding multiple different schedule types to the
same deployment schedule window has unpredictable results. VxUpdate
has no defined behavior to determine which schedule type runs first. If a
single deployment schedule window has precheck, stage, and install jobs,
there is no way to specify the order in which they run. The precheck or the
stage schedules can fail, but the install completes successfully. If you plan
to use precheck, stage, and install schedules, Veritas recommends that
you create separate schedules and separate windows for each.

■ Starts: Specify the date and time you want the policy to start in the text
field or with the date and the time spinner. You can also click the calendar
icon and specify a date and time in the resulting window. You can select a
schedule by clicking and dragging over the three-month calendar that is
provided at the bottom of the window.

■ Ends: Specify the date and time you want the policy to end as you specified
the start time.

■ Duration: Optionally, you can specify a duration in days, hours, minutes,
and seconds instead of an end time for the policy. The minimum value is
5 minutes and the maximum is 99 days.
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■ Select Add/OK and the schedule is created. Select OK to save and create
your policy.

9 A Security tab appears when you select a deployment package that contains
support for external certificate authorities.

By default, the Use existing certificates when possible option is selected.
This option instructs NetBackup to use the existing NetBackup CA or external
CA certificates, if available.

Note: If you specify this option and certificates are not available, your upgrade
fails.

Deselecting the Use existing certificates when possible option lets you
specify the location for external certificate authority information for both UNIX
and Linux computers and Windows computers.

10 Windows clients have Use Windows certificate store selected by default.

You must enter the certificate location as Certificate Store Name\Issuer

Distinguished Name\Subject Distinguished Name.

Note: You can use the $hostname variable for any of the names in the certificate
store specification. The $hostname variable evaluates at run time to the name
of the local host. This option provides flexibility when you push NetBackup
software to a large number of clients.

Alternatively, you can specify a comma-separated list of Windows certificate
locations. For example, you can specify:
MyCertStore\IssuerName1\SubjectName,

MyCertStore\IssuerName2\SubjectName2,

MyCertStore4\IssuerName1\SubjectName5

Then select the Certificate Revocation List (CRL) option from the radio buttons
shown:

■ Do not use a CRL. No additional information is required.

■ Use the CRL defined in the certificate. No additional information is
required.

■ Use the CRL at the following path: You are prompted to provide a path
to the CRL.

11 For both media servers and clients that select the From certificate file path
(for file-based certificates) option, specify the information as shown:
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■ Certificate file: This field requires you to provide the path to the certificate
file and the certificate file name.

■ Trust store location: This field requires you to provide the path to the trust
store and the trust store file name.

■ Private key path: This field requires you to provide the path to the private
key file and the private key file name.

■ Passphrase file: This field requires you to provide the path of the
passphrase file and the passphrase file name. This field is optional.

■ Then specify the correct CRL option for your environment:

■ Do not use a CRL. No additional information is required.

■ Use the CRL defined in the certificate. No additional information is
required.

■ Use the CRL at the following path: You are prompted to provide a
path to the CRL.

To change a deployment policy

1 Right click on the deployment policy and select Change.

2 Navigate through the deployment policy tabs andmake any necessary changes
to the policy.

3 Select OK and the policy is updated.

Deleting a deployment policy

1 Right click on the deployment policy and select Delete.

2 Select OK.

3 Confirm the deletion of the policy.

Copying a deployment policy to create a new
deployment policy

Use theCopy to New option to save time creating policies. This option is especially
useful for the policies that contain many of the same policy attributes, schedules,
or hosts selections.

To copy a policy to create a new one

1 In the NetBackup Administration Console, in the left pane, select
Deployment Management > Deployment Policies.

2 In the middle pane, select the policy to copy.
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3 On the Edit menu, click Copy to New.

4 In the Copy a Deployment Policy dialog box, enter the name of the policy
that you want to copy. You can indicate a policy other than the one that is
selected.

5 Enter the name for the new policy.

6 Click OK. The only difference between the new policy and the copied policy is
the name.

The Change Deployment Policy dialog box is displayed. Make the required
changes and click OK to save the changes or click Cancel to discard the
changes.

Copying or moving policy items to another policy
You can copy or move entire policies, attributes, schedules, and hosts from one
policy to another. The following procedure describes which policy items can be
copied or moved.

To copy or move items from one deployment policy to another

1 In the NetBackup Administration Console, in the left pane, expand
Deployment Management > Deployment Policies.

2 In the middle pane, select either the Attributes, Schedules, or Hosts for a
policy that you want to copy or move.

3 In the right pane, based on your selection in the previous step, select the
attributes, schedules, or hosts of a policy that you want to copy or move.

4 Do one of the following:

On the Edit menu, click Copy.To copy an item

■ On the Edit menu, click Cut.
■ Click Yes when asked if you want to

delete the selected item from the policy.

To move an item
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5 In the middle pane, select the policy item to which you want to paste the copied
items.

6 From the Edit menu, click Paste.

When you paste items with the same name, NetBackup provides options: To
either copy and replace the existing item, or copy but keep the existing item,
or to not copy.

Note:When you paste attributes, the existing attributes of the policy are always
replaced.

Attributes tab
Use the policy Attributes tab in the Change Deployment Policy window to
configure deployment management settings when you add a new deployment policy
or change an existing deployment policy.

The policy Attributes tab contains the following attributes:

DescriptionAttribute

Select the package that you want to deploy from the drop-down menu.

Note: You must add packages to the VxUpdate repository before you
can create a working deployment policy. You can create deployment
policies without packages in the repository, but those policies fail to run
successfully.

For more information regarding adding packages, see the Repository
Management section within the NetBackup Upgrade Guide.

https://www.veritas.com/support/en_US/article.DOC5332

Packages

Specify the media server from drop-down. The media server that is
specified is used to connect and transfer files to the NetBackup hosts
that are included in the policy. The media server must be version
NetBackup 8.1.2 or later. Since the repository resides on the master
server, the master server is the default value for the media server field.

Media server
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DescriptionAttribute

Select the Limit simultaneous jobs option and specify a value for jobs
to limit the total number of concurrent jobs that can run at one time.

The default value is 3. The minimum value is 1 and the maximum value
is 999.

If you want to set unlimited simultaneous upgrade jobs, youmust specify
a value which is equivalent or higher than the count of the number of
hosts that are selected for upgrade.

For example, if you have selected 50 hosts, ensure that the Limit
simultaneous jobs value is set to 50 or more but lower than the
maximum value which is 999.

You can set unlimited simultaneous upgrade jobs through command
line interface by providing the value as 0.

Limit simultaneous
jobs (Optional)

Select hosts from the Available hosts list and select Add to add hosts
to the deployment policy. Once you select Add, the hosts are shown
under Selected hosts.

If you see a warning icon besides a host name, it could be due to one
of the following reasons:

■ If a selected package is missing for a particular operating system
■ If the selected hosts are either at a lower or higher version than the

selected package version. For Emergency binaries (EEBs), the
versions must match.

■ If the host is already on the same version as the selected package

Note: The Select hosts list displays hosts from the host database and
policy database.

The Select hosts list displays those hosts which are added to the
deployment policy.

The policy hosts that are not found in the host database shows version
as unknown.

Select hosts

Complete the entries in the policy Attributes tab and clickOk to save the changes.

Click Cancel to go back to discard the changes.

Schedules tab
Use the Schedules tab in theChange Deployment Policywindow for the following
tasks:

■ To view summary of all schedules within that policy
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■ To create a new schedule

■ To edit and delete an existing schedule

The schedules that are defined on the Schedules tab determine when VxUpdate
occur for the selected deployment policy.

The calendar displays a summary of all the schedules. Each schedule type is
associated with a specific color-code. On the calendar, the color of selected schedule
appears bold as compared to the non-selected schedules.

The Schedules tab contains both schedule information and other configuration
options, beyond when the job is to run.

From the policy Schedules tab, perform the following tasks:

■ To create a new deployment schedule, click New.

■ To edit a deployment schedule, select the schedule and click Change.

■ To delete a deployment schedule, select the schedule and click Delete.

Adding or changing schedules in a deployment
policy

Use the following procedure to add or change schedules in an existing deployment
policy.

To add or change schedules in a deployment policy

1 In the NetBackup Administration Console, in the left pane, select
Deployment Management > Deployment Policies

2 Expand the policy name in the middle pane, then select Schedules.

3 Perform one of the following actions:

On the Actions menu, click New >
Schedule.

Add a deployment schedule
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■ Expand the policy which contains a
schedule that you want to copy.

■ In the right pane, right-click the
schedule and select Copy.

■ Expand the policy where you want to
paste the schedule.

■ In the right pane, right-click anywhere
in the schedule area and select Paste.

■ You can also copy a schedule with the
Edit > Copy to New option:
See Copying a schedule into the same
deployment policy or different
deployment policy

Copy a schedule and paste it into another
policy

In the right pane, double-click the schedule
name.

Change an existing deployment schedule

Copying a schedule into the same deployment policy or different
deployment policy

Use the Copy to New option to save time creating schedules. Use this option to
copy a schedule into the same policy or different policy.

To copy a schedule to create a new one

1 In theNetBackupAdministration Console, in the left pane, selectNetBackup
Management > Deployment Policies.

2 In the middle pane, expand a policy and select the Schedules node that
contains the schedule that you want to copy.

3 In the right pane, select the schedule that you want to copy.

4 On the Edit menu, click Copy to New.

5 In the Copy Schedule dialog box, enter the name of the new schedule.

6 Use the menu to select the name of the policy to which you want to paste the
schedule. You can paste the schedule into the same policy or a different policy.

7 Click OK. The Change Schedule dialog box opens for the new schedule.

Deleting schedules or hosts from a deployment
policy

Use the following procedure to delete schedules or hosts from a deployment policy.
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To delete a schedule or hosts from a deployment policy

1 In the NetBackup Administration Console, in the left pane, select
Deployment Management > Deployment Policies.

2 Expand the policy name in the middle pane, and then select Attributes,
Schedules, or Hosts

3 In the right pane, select the item you want to delete.

4 On the Edit menu, click Delete.

5 Click Yes when asked if you want to delete the selected item from the policy.

Manually initiating deployment jobs with a policy
You can manually initiate a deployment policy based on an existing policy. Manually
initiate deployment policies when you are logged into the server locally and need
to force an immediate update. Or you can initiate an immediate upgrade for
emergency binaries.

Use the Manual Deployment option to initiate a deployment job manually.

To manually initiate a deployment policy from the administration console

1 In the NetBackup Administration Console, navigate to Deployment
Management > Deployment Policies.

2 In the middle pane, expand the master server, and select the policy you want
to run.

3 Right-click on the policy you want to start, and select Manual Deployment.

4 Alternatively, after selecting the policy you want to run, you can select Actions
> Manual Deployment.

5 In theManual Deployment dialog box, select the schedule and the hosts that
you want to upgrade.

If you do not select any hosts, NetBackup upgrades all hosts.

6 Click OK to start the manual deployment job.

You can also performmanual deployment using the command line option. For more
information, refer Manually initiating deployment jobs with a policy section within
the NetBackup Upgrade Guide.
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Perform client initiated upgrade with VxUpdate
Manually initiate deployment jobs when you are logged into the server locally and
want to force an immediate update. You can also use a deployment job to initiate
an immediate upgrade for emergency binaries.

Among the reasons for a client initiated upgrade using VxUpdate is mission critical
systems with specific maintenance windows. One example of these systems is
database servers with limited available down time.

To perform client initiated upgrademanually from the administration console

1 In the NetBackup Administration Console, navigate toNetBackupManagement
> Host Properties > Clients

2 In the right pane, right-click the client that you want to upgrade. SelectUpgrade
Host.

3 In the Upgrade Host dialog box, update the following fields:

■ Package: Select the package that you want to deploy from the drop-down
menu.

■ Type: Select the deployment type from the drop-down menu.

■ Precheck

Note: The precheck schedule type does not exist for EEB packages.

■ Stage

■ Install

■ Media server: Specify the media server from drop-down.
The media server must be version NetBackup 8.1.2 or later. Since the
repository resides on the master server, the master server is the default
value for the media server field.

■ Selected hosts: Displays the list of selected hosts.

You can also perform client initiated upgrade using the command line option. For
more information, refer Perform client initiated upgrade with VxUpdate section within
the NetBackup Upgrade Guide.

Deployment job status
Monitor and review deployment job status in the Activity Monitor in the NetBackup
Administration Console. The Deployment job type is the new type for VxUpdate
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policies. Deployment policy parent jobs that exit with a status code 0 (zero) indicate
that all the child jobs successfully completed. Parent jobs that finish with a status
code 1 indicate that one or more of the child jobs succeeded, but at least one failed.
Any other status code indicates failure. Review the status of the child jobs to
determine why they failed. Otherwise, there are no differences between deployment
jobs and other NetBackup jobs.

Your deployment job may receive a status code 224. This error indicates that the
client's hardware and operating system are specified incorrectly. You can correct
this error by modifying the deployment policy with the bpplclients command found
in:

UNIX or Linux: /usr/openv/netbackup/bin/admincmd

Window: install_path\netbackup\bin\admincmd.

Use the syntax shown:

bpplclients deployment_policy_name -modify client_to_update -hardware

new_hardware_value -os new_os_value

Deployment policies use a simplified naming scheme for operating system and
hardware values. Use the values as shown for the bpplclients command:

Table 26-1 Deployment policy operating system and hardware

HardwareOperating system

ia64hpux

x64debian

x64redhat

x64suse

ppc64leredhat

ppc64lesuse

zseriesredhat

zseriessuse

rs6000aix

sparcsolaris

x64solaris

x64windows
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Security certificates are not deployed as part of the VxUpdate upgrade if theSecurity
Level for certificate deployment is set to Very High. This setting is located in the
NetBackup Global Security Settings in the NetBackup Administration Console.

If you cannot communicate with your clients after you use VxUpdate to upgrade
your clients, please ensure that the proper security certificates were issued during
upgrade. You may need to manually deploy the certificates. Refer to the technote
that is shown for additional details:

https://www.veritas.com/support/en_US/article.000127129
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Configuring replication

■ Chapter 27. About NetBackup replication

7Section



About NetBackup
replication

This chapter includes the following topics:

■ About NetBackup replication

■ About NetBackup Auto Image Replication

■ About NetBackup Replication Director

About NetBackup replication
NetBackup offers two forms of replication:

Auto Image Replication

Use this type of replication to replicate backups from one NetBackup domain
to the NetBackup media server in another domain.

See “About NetBackup Auto Image Replication” on page 1051.

Backups

NetBackup Replication Director

This type of replication makes use of NetBackup OpenStorage to replicate
snapshots on primary storage to the disk arrays of OpenStorage partners.

See “About NetBackup Replication Director” on page 1093.

For more information, see the NetBackup Replication Director Solutions
Guide.

Snapshots
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About NetBackup Auto Image Replication
The backups that are generated in one NetBackup domain can be replicated to
storage in one or more target NetBackup domains. This process is referred to as
Auto Image Replication.

The ability to replicate backups to storage in other NetBackup domains, often across
various geographical sites, helps facilitate the following disaster recovery needs:

■ One-to-one model
A single production datacenter can back up to a disaster recovery site.

■ One-to-many model
A single production datacenter can back up to multiple disaster recovery sites.
See “One-to-many Auto Image Replication model” on page 1053.

■ Many-to-one model
Remote offices in multiple domains can back up to a storage device in a single
domain.

■ Many-to-many model
Remote datacenters in multiple domains can back up multiple disaster recovery
sites.

NetBackup supports the following storage types for Auto Image Replication:

Table 27-1 NetBackup Auto Image Replication storage types

Link to more informationStorage type

See the NetBackup Deduplication Guide:

http://www.veritas.com/docs/DOC5332

Media Server Deduplication
Pool

See the NetBackup Deduplication Guide:

http://www.veritas.com/docs/DOC5332

CloudCatalyst storage server

If your storage vendor's product supports replication, you
can automatically replicate backup images to a similar
device in a different master server domain.

See the NetBackup OpenStorage Solutions Guide for
Disk:

http://www.veritas.com/docs/DOC5332

An OpenStorage disk appliance
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Notes about Auto Image Replication
■ Although Auto Image Replication is a disaster recovery solution, you cannot

restore to clients in the primary (or originating) domain from the target master
domain.

■ Auto ImageReplication does not support synthetic backups or optimized synthetic
backups.

■ Auto Image Replication does not support spanning volumes in a disk pool.
NetBackup fails backup jobs to the disk pools that span volumes if the backup
job is in a storage lifecycle policy that also contains a replication operation.

■ Auto Image Replication does not support replicating from a storage unit group.
That is, the source copy cannot be in a storage unit group.

■ The ability to perform Auto Image Replication between different versions of
NetBackup does not overrule the basic image compatibility rules. For example,
a database backup that was taken in one NetBackup domain can be replicated
to a NetBackup domain of an earlier version. However, the older server may
not be able to successfully restore from the newer image.
See the following article for information about version compatibility and
interoperability:
http://www.netbackup.com/compatibility

■ Synchronize the clocks of the master servers in the source and the target
domains so that the master server in the target domain can import the images
as soon as they are ready. Themaster server in the target domain cannot import
an image until the image creation time is reached. Time zone differences are
not a factor because the images use Coordinated Universal Time (UTC).

Process Overview
Table 27-2 is an overview of the process, generally describing the events in the
originating and target domains.

NetBackup uses storage lifecycle policies in the source domain and the target
domain to manage the Auto Image Replication operations.

See “About the storage lifecycle policies required for Auto Image Replication”
on page 1068.
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Table 27-2 Auto Image Replication process overview

Event descriptionDomain in which event
occurs

Event

Clients are backed up according to a backup policy that indicates a storage
lifecycle policy as the Policy storage selection. The SLP must include at least
one Replication operation to similar storage in the target domain.

Originating master server
(Domain 1)

1

The storage server in the target domain recognizes that a replication event
has occurred. It notifies the NetBackup master server in the target domain.

Target master server
(Domain 2)

2

NetBackup imports the image immediately, based on an SLP that contains an
import operation. NetBackup can import the image quickly because the
metadata is replicated as part of the image. (This import process is not the
same as the import process available in the Catalog utility.)

Target master server
(Domain 2)

3

After the image is imported into the target domain, NetBackup continues to
manage the copies in that domain. Depending on the configuration, the media
server in Domain 2 can replicate the images to a media server in Domain 3.

Target master server
(Domain 2)

4

One-to-many Auto Image Replication model
In this configuration, all copies are made in parallel. The copies are made within
the context of one NetBackup job and simultaneously within the originating storage
server context. If one target storage server fails, the entire job fails and is retried
later.

All copies have the same Target Retention. To achieve different Target Retention
settings in each target master server domain, either create multiple source copies
or cascade duplication to target master servers.

Cascading Auto Image Replication model
Replications can be cascaded from the originating domain to multiple domains.
Storage lifecycle policies are set up in each domain to anticipate the originating
image, import it and then replicate it to the next target master.

Figure 27-1 represents the following cascading configuration across three domains.

■ The image is created in Domain 1, and then replicated to the target Domain 2.

■ The image is imported in Domain 2, and then replicated to a target Domain 3.

■ The image is then imported into Domain 3.
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Figure 27-1 Cascading Auto Image Replication

SLP (D1toD2toD3)
Import

Duplication to local storage

SLP (D1toD2toD3)
Backup

Replication to target master

SLP (D1toD2toD3)
Import

Replication to target server

All copies have the same
Target retention, as
indicated in Domain 1.

Import

Domain 1

Domain 2

Domain 3

Import

In the cascading model, the originating master server for Domain 2 and Domain 3
is the master server in Domain 1.

Note:When the image is replicated in Domain 3, the replication notification event
indicates that the master server in Domain 2 is the originating master server.
However, after the image is imported successfully into Domain 3, NetBackup
correctly indicates that the originating master server is in Domain 1.

The cascading model presents a special case for the Import SLP that replicates
the imported copy to a target master. (This master server that is neither the first
nor the last in the string of target master servers.)

The Import SLP must include at least one operation that uses a Fixed retention
type and at least one operation that uses a Target Retention type. So that the
Import SLP can satisfy these requirements, the import operation must use a Target
Retention.

Table 27-3 shows the difference in the import operation setup.
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Table 27-3 Import operation difference in an SLP configured to replicate the
imported copy

Import operation in a cascading
model

Import operation criteria

Same; no difference.The first operation must be an import
operation.

Same; no difference.A replication to target master must use a
Fixed retention type

Here is the difference:

To meet the criteria, the import operation
must use Target retention.

At least one operation must use the Target
retention.

The target retention is embedded in the source image.

In the cascading model that is represented in Figure 27-1, all copies have the same
Target Retention—the Target Retention indicated in Domain 1.

For the copy in Domain 3 to have a different target retention, add an intermediary
replication operation to the Domain 2 storage lifecycle policy. The intermediary
replication operation acts as the source for the replication to target master. Since
the target retention is embedded in the source image, the copy in Domain 3 honors
the retention level that is set for the intermediary replication operation.
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Figure 27-2 Cascading replications to target master servers, with various
target retentions
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Replication to target master

Import
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About the domain relationship for replication
The following table describes important configuration differences depending on the
devices that are used for NetBackup Auto Image Replication.

Table 27-4 Replication relationships

Domain RelationshipStorage

For NetBackupmanaged storage, establish the relationship between the originating domain
and the target domain or domains by setting the properties in the source storage server.
Specifically, in theReplication tab of theChange Storage Server dialog box of the source
storage server.

NetBackup managed storage that qualifies for replication is Media Server Deduplication
Pool storage.

See the NetBackup Deduplication Guide:

http://www.veritas.com/docs/DOC5332

Before you configure the replication relationship, you can add the target master server as
a trusted host.

See “About trusted master servers for Auto Image Replication” on page 1064.

NetBackup managed
storage
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Table 27-4 Replication relationships (continued)

Domain RelationshipStorage

For the third-party vendor appliance storage that is exposed through the OpenStorage API,
the disk appliance manages the storage. The relationship between the originating domain
and the target domain or domains is established by using the storage vendor's tools.

The originating NetBackup domain has no knowledge of the storage server in the target
domain or domains. When the appliances are configured properly, NetBackup images on
the originating disk appliance are replicated automatically to the target disk appliance. That
disk appliance uses the OpenStorage API to notify NetBackup that a replication event
occurred. NetBackup then imports those images.

NetBackup manages the lifecycle of the backup images but does not manage the storage.

Configuring the disk appliance replication relationship is beyond the scope of the NetBackup
documentation.

Third-party vendor disk
appliance

Caution: Choose the target storage server carefully. A target storage server must
not also be a storage server for the originating domain.

About the replication topology for Auto Image Replication
For Auto Image Replication, the disk volumes have the properties that define the
replication relationships between the volumes. The knowledge of the volume
properties is considered the replication topology. The following are the replication
properties that a volume can have:

A source volume contains the backups of your clients. The volume is the
source for the images that are replicated to a remote NetBackup domain.
Each source volume in an originating domain has one or more replication
partner target volumes in a target domain.

Source

A target volume in the remote domain is the replication partner of a source
volume in the originating domain.

Target

The volume does not have a replication attribute.None

The following describes the replication topology for the supported storage types:
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Table 27-5 Replication topology by storage type

Replication topologyStorage type

NetBackup exposes the storage for a Media Server
Deduplication Pool as a single volume. Therefore, there is
always a one-to-one volume relationship for MSDP.

You configure the replication relationships in the source
domain. To do so, you add target storage servers in the
Replication tab of the Change Storage Server dialog box
of the source storage server.

See the NetBackup Deduplication Guide:

http://www.veritas.com/docs/DOC5332

Media Server Deduplication
Pool

Your storage administrator configures the replication topology
of the volumes in the storage devices. Based on the volume
properties, you create homogeneous disk pools. That is, all
of the volumes in a disk pool must have the same properties,
and you create the disk pools to match that topology. The
disk pools inherit the replication properties from the volumes
that you add to them.

You should work with your storage administrator to
understand the topology so you can create the proper disk
pools. You also should work with your storage administrator
to understand any changes that are made to the replication
topology.

NetBackup discovers the topology of the volumes when you
configure a disk pool.

Disk storage devices that
support replication and also
conform to the Veritas
OpenStorage API

NetBackup discovers the replication topology when you configure the replication
relationships. NetBackup discovers topology changes when you use the Refresh
option of the Change Disk Pool dialog box.

NetBackup includes a command that can help you understand your replication
topology. Use the command in the following situations:

■ After you configure the replication targets.

■ After you configure the storage server and before you configure disk pools.

■ After changes to the volumes that comprise the storage.

See “Viewing the replication topology for Auto Image Replication” on page 1059.
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Viewing the replication topology for Auto Image Replication
A volume that is a source of replication must have at least one replication partner
that is the target of the replication. NetBackup lets you view the replication topology
of the storage.

See “About the replication topology for Auto Image Replication” on page 1057.

To view the replication topology for Auto Image Replication

◆ Run the bpstsinfo command, specifying the storage server name and the
server type. The following is the command syntax:

■ Windows: install_path\NetBackup\bin\admincmd\bpstsinfo -lsuinfo

-storage_server host_name -stype server_type

■ UNIX: /usr/openv/netbackup/bin/admincmd/bpstsinfo -lsuinfo

-storage_server host_name -stype server_type

The following are the options and arguments for the command:

The name of the target storage server.-storage_server host_name

■ For aMedia Server Deduplication Pool target,
use PureDisk.

■ For an OpenStorage disk appliance, the vendor
provides the string for server_type.

-stype server_type

Save the output to a file so that you can compare the current topology with the
previous topology to determine what has changed.

See “Sample volume properties output for MSDP replication” on page 1059.

See “Sample volume properties output for OpenStorage backup replication”
on page 1061.

Sample volume properties output for MSDP replication
The following two examples show output from the bpstsinfo -lsuinfo command
for two NetBackup deduplication storage servers. The first example is the output
from the source disk pool in the originating domain. The second example is from
the target disk pool in the remote master server domain.

The two examples show the following:

■ All of the storage in a deduplication disk pool is exposed as one volume:
PureDiskVolume.

■ The PureDiskVolume of the deduplication storage server
bit1.datacenter.example.com is the source for the replication operation.

1059About NetBackup replication
About NetBackup Auto Image Replication



■ The PureDiskVolume of the deduplication storage server
target_host.dr-site.example.com is the target of the replication operation.

> bpstsinfo -lsuinfo -storage_server bit1.datacenter.example.com -stype PureDisk

LSU Info:

Server Name: PureDisk:bit1.datacenter.example.com

LSU Name: PureDiskVolume

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: PureDisk storage unit (/bit1.datacenter.example.com#1/2)

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_ACTIVE | STS_LSUF_STORAGE_NOT_FREED |

STS_LSUF_REP_ENABLED | STS_LSUF_REP_SOURCE)

Save As : (STS_SA_CLEARF | STS_SA_IMAGE | STS_SA_OPAQUEF)

Replication Sources: 0 ( )

Replication Targets: 1 ( PureDisk:target_host.dr-site.example.com:PureDiskVolume )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 74645270666

Physical Size: 77304328192

Bytes Used: 138

Physical Bytes Used: 2659057664

Resident Images: 0

> bpstsinfo -lsuinfo -storage_server target_host.dr-site.example.com -stype PureDisk

LSU Info:

Server Name: PureDisk:target_host.dr-site.example.com

LSU Name: PureDiskVolume

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: PureDisk storage unit (/target_host.dr-site.example.com#1/2)

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_ACTIVE | STS_LSUF_STORAGE_NOT_FREED |

STS_LSUF_REP_ENABLED | STS_LSUF_REP_TARGET)

Save As : (STS_SA_CLEARF | STS_SA_IMAGE | STS_SA_OPAQUEF)

Replication Sources: 1 ( PureDisk:bit1:PureDiskVolume )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 79808086154

Physical Size: 98944983040

Bytes Used: 138
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Physical Bytes Used: 19136897024

Resident Images: 0

Sample volume properties output for OpenStorage backup
replication
The following examples show sample output from the bpstsinfo command for two
OpenStorage devices. The first example is the output from the source disk pool
that contains the client backups. The second example is from the target disk pool
in the remote master server domain.

The two examples show the following:

■ Volume dv01 on storage server pan1.example.com is the replication source for
volume dv01 on pan2.example.com.

■ Volume dv02 on storage server pan1.example.com is the replication source for
volume dv02 on pan2.example.com.

■ Volume dv03 on both devices has no replication properties.

>bpstsinfo -lsuinfo -storage_server pan1.example.com -stype Pan

LSU Info:

Server Name: pan1.example.com

LSU Name: dv01

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_SOURCE)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 1 ( Pan:pan2.example.com:dv01 )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan1.example.com

LSU Name: dv02

Allocation : STS_LSU_AT_STATIC
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Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_SOURCE)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 1 ( Pan:pan2.example.com:dv02 )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan1.example.com

LSU Name: dv03

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

>bpstsinfo -lsuinfo -storage_server pan2.example.com -stype Pan

LSU Info:

Server Name: pan2.example.com

LSU Name: dv01

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\
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Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_TARGET)

Save As : (STS_SA_IMAGE)

Replication Sources: 1 ( Pan:pan1.example.com:dv01 )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan2.example.com

LSU Name: dv02

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_TARGET)

Save As : (STS_SA_IMAGE)

Replication Sources: 1 ( Pan:pan1.example.com:dv02 )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan2.example.com

LSU Name: dv03

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED)

Save As : (STS_SA_IMAGE)
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Replication Sources: 0 ( )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

About trusted master servers for Auto Image Replication
NetBackup provides the ability to establish a trust relationship between replication
domains. A trust relationship is optional for Media Server Deduplication Pool and
PureDisk Deduplication Pool as a target storage. Before you configure a
CloudCatalyst storage server as a target storage, establish a trust relationship
between the source A.I.R. and the target A.I.R operations.

The following items describe how a trust relationship affects Auto Image Replication:

NetBackup replicates to all defined target storage servers.
You cannot select a specific host or hosts as a target.

No trust relationship

You can select a subset of your trusted domains as a target
for replication. NetBackup then replicates to the specified
domains only rather than to all configured replication targets.
This type of Auto Image Replication is known as targeted
A.I.R.

Trust relationship

About adding trusted master server using NetBackup
CA-signed certificate
With targeted A.I.R., when establishing trust between the source and the remote
target server, you need to establish trust in both the domains.

1. In the source master server, add the target master server as a trusted server.

2. In the target master server, add the source master server as a trusted server.
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Note: TheNetBackup Administration Console does not support adding a trusted
master server using an external CA-signed certificate.

See “Adding a trusted master server using external CA-signed certificate”
on page 225.

See “About the certificate to be used for adding a trustedmaster server” on page 219.

The following diagram illustrates the different tasks for adding trusted master servers
when NetBackup CA-signed certificate (or host ID-based certificate) is used for
establishing trust between the source and the target master servers.

Figure 27-3 Tasks to establish a trust relationship between master servers
for targeted A.I.R. using NetBackup CA-signed certificate

Media server Image

Replication Policy

Master Server A

Media serverImage

Import Policy

Master Server BAdmin Admin

Get CA certificate Fingerprint and Authorization token or User
credentials from remote master servers

Add as trusted master servers in both the domains
using the NetBackup Administration Console or command line

6

Domain A
(Source)

Domain B
(Target)

Targeted
AIR

5 4

3

2

1

Trust
established
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Table 27-6 Tasks to establish a trust relationship between master servers
for targeted A.I.R.

ProcedureTaskStep

To obtain the authorization tokens, use the
bpnbat command to login and nbcertcmd
to get the authorization tokens.

To obtain the SHA1 fingerprint of root
certificate, use the nbcertcmd
-displayCACertDetail command.

To perform this task, see the NetBackup
Commands Reference Guide.

Note: When you run the commands, keep
the target as the remote server.

Administrators of both the source and target master servers
must obtain each other’s CA certificate fingerprint and
authorization tokens or the user credentials. This activity
must be performed offline.

Note: Veritas recommends using an authentication token
to connect to the remote master server. An authentication
token provides restricted access and allows secure
communication between both the hosts. The use of user
credentials (user name and password) may present a
possible security breach.

Step 1

To perform this task in the Veritas
Administration Console, see the following
topic:

See “Adding a trusted master server using
NetBackup CA-signed (host ID-based)
certificate” on page 220.

To perform this task using the nbseccmd,
see the NetBackup Commands Reference
Guide.

Establish trust between the source and the target domains.

■ On the source master server, add the target master server
as trusted server.

■ On the target master server, add the source master server
as trusted server.

Step 2

To understand the use of host ID-based
certificates, see the Veritas Security and
Encryption Guide.

After you have added the source and target trusted servers,
they have each other’s host ID-based certificates. The
certificates are used during each communication.

Master Server A has a certificate issued by Master Server B
and vice versa. Before communication can occur, Master
Server A presents the certificate issued by Master Server B
and vice versa. The communication between the source and
target master servers is now secured.

Step 3

Configure the source media server to get the security
certificates and the host ID certificates from the target master
server.

Step 3.1

See “About storage lifecycle policies”
on page 645.

Create an import storage lifecycle policy in the target domain.Step 4

On the source MSDP server, use the Replication tab from
theChange Storage Server dialog box to add the credentials
of the target storage server.

Step 5
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Table 27-6 Tasks to establish a trust relationship between master servers
for targeted A.I.R. (continued)

ProcedureTaskStep

See “About storage lifecycle policies”
on page 645.

Create a replication storage lifecycle policy in the source
domain using the specific target master server and storage
lifecycle policy.

The backups that are generated in one NetBackup domain
can be replicated to storage in one or more target NetBackup
domains.

Step 5.1

See “About NetBackup Auto Image
Replication” on page 1051.

The backups that are generated in one NetBackup domain
can be replicated to storage in one or more target NetBackup
domains. This process is referred to as Auto Image
Replication.

Step 6

If your source and target trusted servers use different NetBackup versions, consider
the following.

Note:When you upgrade both the source and the target master server to version
8.1 or later, you need to update the trust relationship. Run the following command:

nbseccmd -setuptrustedmaster -update

See the NetBackup Commands Reference Guide.

Table 27-7 Trust setup methods for different NetBackup versions

Trust setup methodTarget server versionSource server version

Add a trusted master server using
authorization token.

Complete action on both the servers.

8.1 and later8.1 and later

On the source server, add the target
as the trusted master server using the
remote (target) server’s credentials.

8.0 or earlier8.1 and later

On the source server, add the target
as the trusted master server using the
remote (target) server’s credentials.

8.1 and later8.0 or earlier
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About the storage lifecycle policies required for Auto Image
Replication

To replicate images from one NetBackup domain to another NetBackup domain
requires two storage lifecycle policies. The following table describes the policies
and their requirements:

Table 27-8 SLP requirements for Auto Image Replication

Storage lifecycle policy requirementsDomain

The Auto Image Replication SLP in the source domain must meet the following criteria:

■ The first operation must be aBackup operation to storage that NetBackup supports for replication.
Indicate the exact storage unit from the drop-down list. Do not select Any Available.

Note: The target domain must contain the same type of storage to import the image.
■ At least one operation must be a Replication operation to storage in another domain that

NetBackup supports for replication from the source storage.
You can configure multiple Replication operations in an Auto Image Replication SLP. The
Replication operation settings determine whether the backup is replicated to all replication targets
in all master server domains or only to specific replication targets.
See “About trusted master servers for Auto Image Replication” on page 1064.
See “New or Change Storage Operation dialog box settings” on page 688.

■ The SLP must be of the same data classification as the Import SLP in Domain 2.

Domain 1

(Source
domain)

If replicating to all targets in all domains, in each domain NetBackup automatically creates an Import
SLP that meets all the necessary criteria.

Note: If replicating to specific targets, you must create the Import SLP before creating the Auto
Image Replication SLP in the originating domain.

The Import SLP must meet the following criteria:

■ The first operation in the SLP must be an Import operation. NetBackup must support the
Destination storage as a target for replication from the source storage.
Indicate the exact storage unit from the drop-down list. Do not select Any Available.

■ The SLP must contain at least one operation that has the Target retention specified.
■ The SLP must be of the same data classification as the SLP in Domain 1. Matching the data

classification keeps a consistent meaning to the classification and facilitates global reporting by
data classification.

See the following topic for more information about Replication operation configuration:

See “Replicating to all inter-domain targets or to a specific target” on page 1069.

Domain 2

(Target
domain)

Figure 27-4 shows how the SLP in the target domain is set up to replicate the images
from the originating master server domain.

1068About NetBackup replication
About NetBackup Auto Image Replication



Figure 27-4 Storage lifecycle policy pair required for Auto Image Replication

SLP on master server in the source domain

Import

Replication operation indicates
a target master

Import operation
imports copies

SLP that imports the copies to the target domain

Note: Restart nbstserv after you make changes to the underlying storage for any
operation in an SLP.

Replicating to all inter-domain targets or to a specific target
With Auto Image Replication, you can replicate backups to all configured replication
targets or to a subset of all configured replication targets. To replicate to specific
master server domains, you must first configure trusted master servers.

See “About trusted master servers for Auto Image Replication” on page 1064.
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Table 27-9 Configuration differences between replicating to all inter-domain
targets or to a specific target

Import SLP configurationAuto ImageReplication SLP configurationReplication objective

The Import SLPs are created
automatically in all domains.

See Figure 27-5 for a
representation of this scenario.

Create an SLP in the originating domain.

■ The first operation must be a Backup
operation.

■ The SLPmust include aReplication operation.
To copy to all domains, selectAll inter-domain
replication target(s).

Replicate the backup to all
configured master server
domains.

The Import SLPs are not created
automatically.

Note: Create the Import SLP
before creating the Auto Image
Replication SLP in the originating
domain.

Create an Import SLP in each
target domain.

The Import SLP must have an
Import operation as the first
operation, but can contain other
operations as needed.

Figure 27-6 represents this
scenario.

In this case, first create the Import SLPs before
the SLP in the originating domain.

■ The first operation must be a Backup
operation.

■ The SLPmust include aReplication operation.
Select A specific Master Server and indicate
the domain of the target master server.

Replicate the backup to
targets in specific NetBackup
master server domains.

Additional requirements for Auto Image Replication SLPs are described in the
following topic:

See “About the storage lifecycle policies required for Auto Image Replication”
on page 1068.
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Figure 27-5 Replicating from one domain to all inter-domain master servers
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Figure 27-6 represents replication to a specific master domain target.

Figure 27-6 Replicating from one domain to a specific inter-domain master
server
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To replicate copies to a specific domain, make sure that the target domain master
server is a trusted master server of the originating domain.

See “Adding a trusted master server using NetBackup CA-signed (host ID-based)
certificate” on page 220.

Customizing how nbstserv runs duplication and import
jobs
The NetBackup Storage Lifecycle Manager (nbstserv) runs replication, duplication,
and import jobs. Both the Storage Lifecycle Manager service and the Import Manager
service run within nbstserv.

The NetBackup administrator can customize how nbstserv runs jobs by changing
the default of certain SLP-related configuration options.

See “SLP Parameters properties” on page 230.

About Auto Image Replication import confirmation
When using targeted Auto Image Replication (A.I.R.), storage lifecycle (SLP)
processing of each replicated image is paused in the source domain until a message
has been received from the target domain that confirms that the image has been
imported successfully. SLP processing does not continue for the image until the
confirmation occurs. Import confirmation ensures that source domain images remain
in place at least until those images have been safely imported in the target domain.

In the source domain, NetBackup keeps track of image copies that remain in import
pending state for more than 24 hours. Whenever such images exist, NetBackup
generates a message in the Problems report. This message indicates that
import-pending images are present. You can configure a different time threshold
for generating a confirmation message. You can also configure an email address
to receive the same information send to the Problems report.

See “SLP Parameters properties” on page 230.

If you receive notification that images are in an import pending state, you can run
the nbstlutil command. This command generates a report that provides details
of those images. You must then investigate the cause of the import problem and
address any issue that you find. The import-pending state is automatically updated
when the imports are completely successfully. Alternatively, you may decide that
import operations in the target domain are no longer needed, and you can then
cancel SLP processing for those images in the source domain. This action also
clears the import-pending state, but no further SLP processing happens for those
images.

See the NetBackup Commands Reference Guide for details about nbstlutil.
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Note: A.I.R. operations require that a trust relationship be established before
configuring and operating SLPs that perform targeted replication. In NetBackup
8.1.2, 8.1.1, and 8.1, these operations include import confirmation messages that
are sent from the target domain to the source domain. Security changes that were
added in NetBackup 8.1 require that this trust relationship be re-established before
import confirmation can proceed.

Import confirmation operations are not enabled by default in NetBackup 8.1 or 8.1.1,
regardless of whether the system is upgraded to NetBackup 8.1 or 8.1.1 or an initial
install of 8.1 or 8.1.1 is performed. Refer to the following tech note for information
about enabling the A.I.R. import confirmation feature in NetBackup 8.1 or 8.1.1:

https://www.veritas.com/support/en_US/article.000127326

Auto Image Replication setup overview
The following table is an overview of the setup process for Auto Image Replication,
describing the actions that are required.

Table 27-10 Auto Image Replication setup overview

DescriptionActionStep

Configure the storage servers for your storage type.

See the NetBackup Deduplication Guide or the NetBackup OpenStorage
Solutions Guide for Disk:

http://www.veritas.com/docs/DOC5332

Configure the storage
servers

1

Configure the disk pools for your storage type.

To replicate images from one domain to another requires that suitable storage
be configured in each domain. NetBackup must support the storage for
replication.

See the NetBackup Deduplication Guide or the NetBackup OpenStorage
Solutions Guide for Disk:

http://www.veritas.com/docs/DOC5332

Configure the disk pools.2

Configure the storage units in both the originating domain and the target
domain.

See “Creating a storage unit” on page 590.

Configure the storage units.3
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Table 27-10 Auto Image Replication setup overview (continued)

DescriptionActionStep

Define the relationship between the domains so that the originating domain
knows where to send the data.

See “About the domain relationship for replication” on page 1056.

See “About trusted master servers for Auto Image Replication” on page 1064.

Define the relationship
between the domains.

4

Configure the necessary storage lifecycle policies.

See “About the storage lifecycle policies required for Auto Image Replication”
on page 1068.

See “Creating a storage lifecycle policy” on page 646.

Configure the storage
lifecycle policies.

5

The backup policy must indicate the configured SLP as the Policy storage
selection.

See “Creating a backup policy” on page 718.

Configure and run the
backup policy in the
originating domain.

6

How to resolve volume changes for Auto Image Replication
When you open the Change Disk Pool dialog box, NetBackup loads the disk pool
properties from the catalog. NetBackup queries the storage server for changes
when you either click the Refresh button in the Change Disk Pool dialog box or
when you configure a new disk pool for the storage server.

Veritas recommends that you take the following actions when the volume topology
changes:

■ Discuss the changes with the storage administrator. You need to understand
the changes so you can change your disk pools (if required) so that NetBackup
can continue to use them.

■ If the changes were not planned for NetBackup, ask your storage administrator
to revert the changes so that NetBackup functions correctly again.

NetBackup can process changes to the following volume properties:

■ Replication Source

■ Replication Target

■ None

If these volume properties change, NetBackup can update the disk pool to match
the changes. NetBackup can continue to use the disk pool, although the disk pool
may no longer match the storage unit or storage lifecycle purpose.

The following table describes the possible outcomes and how to resolve them.
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Table 27-11 Refresh outcomes

DescriptionOutcome

No changes are required.No changes are discovered.

The new volumes appear in the Change Disk Pool dialog box. Text in the dialog box
changes to indicate that you can add the new volumes to the disk pool.

NetBackup discovers the new
volumes that you can add to the
disk pool.

A Disk Pool Configuration Alert pop-up box notifies you that the properties of all of the
volumes in the disk pool changed, but they are all the same (homogeneous).

You must click OK in the alert box, after which the disk pool properties in the Change
Disk Pool dialog box are updated to match the new volume properties

If new volumes are available that match the new properties, NetBackup displays those
volumes in the Change Disk Pool dialog box. You can add those new volumes to the
disk pool.

In the Change Disk Pool dialog box, select one of the following two choices:

■ OK. To accept the disk pool changes, click OK in the Change Disk Pool dialog box.
NetBackup saves the new properties of the disk pool.
NetBackup can use the disk pool, but it may no longer match the intended purpose
of the storage unit or storage lifecycle policy. Change the storage lifecycle policy
definitions to ensure that the replication operations use the correct source and target
disk pools, storage units, and storage unit groups. Alternatively, work with your storage
administrator to change the volume properties back to their original values.

■ Cancel. To discard the changes, click Cancel in the Change Disk Pool dialog box.
NetBackup does not save the new disk pool properties. NetBackup can use the disk
pool, but it may no longer match the intended use of the storage unit or storage
lifecycle policy.

The replication properties of all of
the volumes changed, but they
are still consistent.
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Table 27-11 Refresh outcomes (continued)

DescriptionOutcome

A Disk Pool Configuration Error pop-up box notifies you that the replication properties
of some of the volumes in the disk pool changed. The properties of the volumes in the
disk pool are not homogeneous.

You must click OK in the alert box.

In the Change Disk Pool dialog box, the properties of the disk pool are unchanged, and
you cannot select them (that is, they are dimmed). However, the properties of the individual
volumes are updated.

Because the volume properties are not homogeneous, NetBackup cannot use the disk
pool until the storage configuration is fixed.

NetBackup does not display new volumes (if available) because the volumes already in
the disk pool are not homogeneous.

To determine what has changed, compare the disk pool properties to the volume
properties.

See “Viewing the replication topology for Auto Image Replication” on page 1059.

Work with your storage administrator to understand the changes and why they were
made. The replication relationships may or may not have to be re-established. If the
relationship was removed in error, re-establishing the relationships seem justified. If you
are retiring or replacing the target replication device, you probably do not want to
re-establish the relationships.

The disk pool remains unusable until the properties of the volumes in the disk pool are
homogenous.

In the Change Disk Pool dialog box, click OK or Cancel to exit the Change Disk Pool
dialog box.

The replication properties of the
volumes changed, and they are
now inconsistent.
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Table 27-11 Refresh outcomes (continued)

DescriptionOutcome

A Disk Pool Configuration Alert pop-up box notifies you that an existing volume or
volumes was deleted from the storage device:

NetBackup can use the disk pool, but data may be lost.

To protect against accidental data loss, NetBackup does not allow volumes to be deleted
from a disk pool.

To continue to use the disk pool, do the following:

■ Use the bpimmedia command or the Images on Disk report to display the images
on the specific volume.

■ Expire the images on the volume.
■ Use the nbdevconfig command to set the volume state to DOWN so NetBackup

does not try to use it.

NetBackup cannot find a volume
or volumes that were in the disk
pool.

Removing or replacing replication relationships in an Auto Image
Replication configuration

Auto Image Replication replicates backups from a storage server in the source
domain to storage servers in one or more target NetBackup domains. If a storage
server needs to be removed or replaced from such a relationship, the involved
domains need to make proper preparations to stop or to redirect replication. That
is, to remove the replication relationship.

For example, consider a scenario where cascading Auto Image Replication is used
across 3 domains. To remove the storage server in domain 2 (which serves as the
destination of the import from Domain 1) preparations need to be made in all three
domains. The preparations includemodifying storage lifecycle policies and removing
the storage server from the replication topology.
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Figure 27-7 Removing target storage server example

SLP (D1toD2toD3)
Import

Duplication to local storage

SLP (D1toD2toD3)
Backup

Replication to target master

SLP (D1toD2toD3)
Import

Replication to target server
Import

Domain 1

Domain 2

Domain 3

Import

Storage
server 2

Table 27-12 contains topics that address processes that are involved in removing
or replacing relationships in an Auto Image Replication configuration:

Table 27-12

ReferenceTopic

See “Adding or removing a replication relationship between
two storage servers” on page 1079.

Adding a replication relationship between two storage
servers.

Removing a replication relationship between two storage
servers.

See “Removing all replication relationships between a
domain and a storage server” on page 1079.

Removing a replication relationship between a domain
and a storage server.

See “Replacing all replication relationships between a
domain and a storage server” on page 1080.

Replacing a replication relationship between a domain and
a storage server.

See “Removing or replacing all replication relationships
involving a storage server” on page 1084.

Removing all replication relationships involving a storage
server.

Replacing all replication relationships involving a storage
server.
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Adding or removing a replication relationship between
two storage servers
Before adding a replication relationship, you must understand the consequences
of this action:

■ Any classic (or non-targeted) Auto Image Replication storage lifecycle policies
that replicate from the source domain storage server will replicate to the target
domain storage server.

Before removing a replication relationship, youmust understand the consequences
of this action:

■ Any classic (or non-targeted) A.I.R. SLPs that replicate from the source domain
storage server will no longer replicate to the target domain storage server.

■ Any targeted A.I.R. SLPs that replicate from the source domain storage server
to the target domain storage server will fail. These SLPs should be removed or
modified so that they no longer replicate to the target domain.

Complete the following steps to add or remove a replication relationship between
two storage servers:

To change (add or remove) a replication relationship

1 This step depends on whether OpenStorage or MSDP storage is used:

■ For OpenStorage storage, contact your storage administrator to change
the replication relationship, as this procedure differs between vendors.

■ For MSDP storage, the relationships can be changed in the source domain
by the NetBackup administrator.

2 After the relationship is changed, update the disk pools in both domains to
reflect the topology changes:

In the NetBackup Administration Console, expand Media and Device
Management > Devices > Disk Pools. Select and refresh the disk pools. The
nbdevconfig –updatedp command can also be used. (See the OpenStorage
Solutions Guide for information about the replication topology for Auto Image
Replication.)

Removing all replication relationships between a domain
and a storage server
Complete the following steps to remove all replication relationships between two
domains. The procedure refers to domain D1 and a storage server in domain D2:

To remove all replication relationships between a domain and a storage server

1 In domain D1:
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Run the following command on the master server:

nbdecommission -list_ref -oldserver

storage_server_name–machinetype replication_host

The output lists:

■ All of the storage servers in the domain that reference the deprecated
storage server as a replication target or a replication source.

■ All of the targeted A.I.R. replication SLPs that reference an SLP that imports
to the deprecated storage server.

Note: If an SLP has in-process images, either wait until those images are
complete or cancel them before decommissioning the storage server. Note
that this includes SLPs of all versions. Use the SLP utility command (nbstlutil)
to cancel the processing of existing SLP-managed images.

See “Lifecycle operation administration using the nbstlutil command”
on page 651.

2 Remove the replication operations from the targeted A.I.R. storage lifecycle
polices that were found in step 1.

If these SLPs are no longer necessary, the SLPs can be deleted now.

3 Remove the replication relationships that were found in step 1.

See “Adding or removing a replication relationship between two storage servers”
on page 1079.

Any remaining A.I.R. storage lifecycle polices in both domains that are no
longer necessary can be deleted now.

4 Run the following command to decommission the storage server:

nbdecommission -oldserver storage_server_name–machinetype

replication_host

Replacing all replication relationships between a domain
and a storage server

Note: If the storage server to be replaced is involved in a classic (non-targeted)
Auto Image Replication configuration, the replacement storage server must not
have any additional replication target relationships.
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The procedure refers to two domains: D1 and D2. Auto Image Replication is
configured to occur from storage servers in D1 to D2. Also, from D2 to D1.

A new storage server (S2) is added to D2 so that D2 now contains two storage
servers (S1 and S2). Relationships to S1 must be replaced with relationships to
S2.

Table 27-13 lists the configuration before the switch to D2. Table 27-14 lists the
configuration after the changes have been made.

Table 27-13 Example configuration before changes

Storage lifecycle policiesStorage serversDomains

■ BACKUP_D1_REPLICATE_D2
This SLP replicates to S1 in D2 using the target import SLP
IMPORT_S1.

■ IMPORT_D1
This SLP imports to a storage server in D1.

Contains several storage
servers but they are not
necessary in the example.

D1

■ BACKUP_D2_REPLICATE_D1
This SLP replicates to D1 using the target import SLP IMPORT_D1.

■ IMPORT_S1
This SLP imports to D2 and stores on S1.

S1 (To be deprecated)

S2 (New in D2)

D2

Figure 27-8 Topology before changes

Domain 1 (D1) Domain 2 (D2)

Storage lifecycle policies Storage
server S1

Storage
server

IMPORT_D2 BACKUP_D2_REPLICATE_D1

IMPORT_S1BACKUP_D1_REPLICATE_D2
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Table 27-14 Example configuration after changes

Storage lifecycle policiesStorage serversDomains

■ BACKUP_D1_REPLICATE_D2
This SLP replicates to S2 in D2 using the target import SLP
IMPORT_S2

■ IMPORT_S1
This SLP imports to a storage server in D1.

Contains several storage
servers but they are not
necessary in the example.

D1

■ BACKUP_D2_REPLICATE_D1
This SLP replicates to D1 using the target import SLP IMPORT_D1.

■ IMPORT_S2
This SLP imports to D2 and stores on S2.

S1 (To be deprecated)

S2 (New in D2)

D2

Figure 27-9 Topology after changes

Storage lifecycle policies Storage
server S2

Storage
server

IMPORT_D2 BACKUP_D2_REPLICATE_D1

IMPORT_S2BACKUP_D1_REPLICATE_D2

Circled items have been changed.

Domain 1 (D1) Domain 2 (D2)

In the following procedure, note that steps must be performed in specific domains.
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Table 27-15 Replacing all replication relationships between a domain and a
storage server

DescriptionStepDomain

Run the following command to determine the replication relationships of storage server S1:

bpstsinfo -lsuinfo -storage_server storage_server_name -stype
storage_server_type

For example:

bpstsinfo -lsuinfo -storage_server S1 -stype replication_host

1In
domain
D2:

For each replication target relationship that is found in step 1, add a corresponding relationship
between storage server S2 and the target in D1.

See “Adding or removing a replication relationship between two storage servers” on page 1079.

2

Copy all import SLPs that import to storage server S1. Modify the new SLPs to import to storage
server S2.

For example, copy IMPORT_S1. Modify the SLP to import to storage server S2. Change the SLP
name to reflect that it will import to S2: IMPORT_S2.

Note: Do not delete the existing import SLPs yet. All of the SLPs that are no longer performing
any function can be deleted later in this procedure.

3

Run the following command on the master server:

nbdecommission -list_ref -oldserver storage_server_name–machinetype
replication_host

For example:

nbdecommission -list_ref -oldserver S1 –machinetype replication_host

The output lists:

■ All of the storage servers in the source domain (S1) that reference the deprecated storage
server as a replication target or replication source.

■ All of the targeted A.I.R. replication SLPs that reference an SLP that imports to the deprecated
storage server.

Note: If an SLP has in-process images, either wait until those images are complete or cancel
them before decommissioning the storage server. Note that this includes SLPs of all versions.
Use the SLP utility command (nbstlutil) to cancel the processing of existing SLP-managed
images.

See “Lifecycle operation administration using the nbstlutil command” on page 651.

4In
domain
D1:
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Table 27-15 Replacing all replication relationships between a domain and a
storage server (continued)

DescriptionStepDomain

Complete steps 5-6 only if step 4 listed any replication source relationships.In
domain
D2: Modify replication SLPs that replicate from S1 to domain D1 to replicate from S2. This includes

both non-targeted and targeted A.I.R. SLPs.

For example, change the Replication operation in BACKUP_D2_REPLICATE_D1. Change the
backup storage destination from S1 to S2.

5

Remove the replication source relationships that were found in step 4.

See “Adding or removing a replication relationship between two storage servers” on page 1079.

6

Complete steps 7-10 only if step 4 listed any replication target relationships.In
domain
D1: Add replication relationships from each storage server that was listed in step 2 that has a replication

target relationship to storage server S2.

See “Adding or removing a replication relationship between two storage servers” on page 1079.

7

Modify the replication operations that were found in step 4. Change the target import SLP to the
corresponding import SLP created in step 3.

For example, change the Replication operation in BACKUP_D1_REPLICATE_D2. Change the
Target import SLP setting from IMPORT_S1 to IMPORT_S2.

8

Remove the replication target relationships that were found in step 4.

See “Adding or removing a replication relationship between two storage servers” on page 1079.

9

Run the following command to decommission the storage server:

nbdecommission -oldserver storage_server_name –machinetype
replication_host

For example:

nbdecommission -oldserver D1 –machinetype replication_host

10

Any import SLPs to S1 that are no longer necessary may now be deleted.

For example, IMPORT_S1 can be deleted now.

11In
domain
D2:

Removing or replacing all replication relationships
involving a storage server
To remove or replace all of the replication relationships involving a storage server,
completely remove or replace all replication relationships between a domain and
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the storage server. This must be done for each domain that is involved in a
replication relationship with the storage server.

The following command lists replication target and replication source relationships.
The command is useful for determining which domains have replication relationships
with the storage server:

bpstsinfo -lsuinfo -storage_server storage_server_name -stype

storage_server_type

Example: Replacing a storage server in a non-targeted
Auto Image Replication configuration
This example walks through the steps necessary to replace a storage server in a
simple, classic (non-targeted) Auto Image Replication configuration.

Specifically, to replace an MSDP storage server (D2_MSDP_1) in domain D2 with
another MSDP storage server (D2_MSDP_2).

Table 27-16 Example configuration

Storage lifecycle
policies

Storage serversDomains

BACKUP_D1D1_MSDPD1

No replication-related SLPsD2_MSDP_1

D2_MSDP_2

D2

The changes to the replication and the storage lifecycle topologies are tracked
throughout the example.

Figure 27-10 Example replication topology before the process

Domain 1 Domain 2

D1_MSDP D2_MSDP_1

D2_MSDP_2
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Figure 27-11 Example storage lifecycle policy topology

Domain 1

SLP: Backup_D1

Operation

Backup
Replication

Target

D1_MSDP
All replication targets

To replace the storage server D2_MSDP_1 with D2_MSDP_2

1 Add a replication target relationship from D1_MSDP to D2_MSDP_2.

2 Refresh disk pools in both domains.

D1_MSDP D2_MSDP_1

D2_MSDP_2

3 Remove the replication target relationship between D1_MSDP and
D2_MSDP_1.
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4 Refresh disk pools in both domains.

Domain 1 Domain 2

D1_MSDP D2_MSDP_1

D2_MSDP_2

5 In D1, run the following command to decommission MSDP_D2_1:

nbdecommission –oldserver MSDP_D2_1 –machinetype replication_host

Example: Replacing a storage server in a cascading,
targeted Auto Image Replication configuration
This example walks through the steps necessary to replace an MSDP storage
server in a cascading, targeted Auto Image Replication configuration. The changes
to the replication and the storage lifecycle topologies are tracked throughout the
example.

The environment contains three domains. Each domain contains one or moreMDSP
storage servers.

Table 27-17 Example configuration

Storage lifecycle
policies

Storage serversDomains

BACKUP_D1D1_MSDPD1

IMPORT_D2D2_MSDP

D2_MSDP_2

D2

IMPORT_D3D3_MSDPD3
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Figure 27-12 Example replication topology

Domain 3

D3_MSDP

Domain 2

D2_MSDP_1

D2_MSDP_2

Domain 1

D1_MSDP

Figure 27-13 Example storage lifecycle policy topology

Domain 1

SLP: Backup_D1

Operation

Backup
Replication

Target

D1_MSDP
IMPORT_D2

Domain 2

SLP: IMPORT_D2

Operation

Import
Replication

Target

D2_MSDP
IMPORT_D3

Domain 3

SLP: IMPORT_D3

Operation

Import

Target

D3_MSDP

To replace the storage server D2_MSDP with D2_MSDP_2

1 Add replication target relationship from D2_MSDP_2 to D3_MSDP.

2 Refresh disk pools in both domain D2 and domain D3.

Domain 3

D3_MSDP

Domain 2

D2_MSDP_1

D2_MSDP_2

Domain 1

D1_MSDP
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3 Copy IMPORT_D2 andmodify name to IMPORT_2_D2 and destination storage
to a storage unit on D2_MSDP_2.

Domain 3

SLP: IMPORT_D3

Oper.

Import

Target

D3_MSDP

Domain 2

SLP: IMPORT_2_D2

Oper.

Import
Rep.

Target

D2_MSDP_2
IMPORT_D3

SLP: IMPORT_2

Oper.

Import
Rep.

Target

D2_MSDP
IMPORT_D3

Domain 1

SLP: Backup_D1

Oper.

Backup
Rep.

Target

D1_MSDP
IMPORT_D2_2

4 Add a replication target relationship from D1_MSDP to D2_MSDP_2.

5 Refresh disk pools in both domains.

Domain 3

D3_MSDP

Domain 2

D2_MSDP_1

Domain 1

D2_MSDP_2

D1_MSDP
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6 Modify BACKUP_D1 Replication Operation Target import SLP to
IMPORT_2_D2.

Domain 3

SLP: IMPORT_D3

Oper.

Import

Target

D3_MSDP

Domain 1 Domain 2

SLP: IMPORT_D2

Oper.

Import
Rep.

Target

D2_MSDP
IMPORT_D3

SLP: IMPORT_2_D2

Oper.

Import
Rep.

Target

D2_MSDP_2
IMPORT_D3

SLP: Backup_D1

Oper.

Backup
Rep.

Target

D1_MSDP
IMPORT_D2_2

7 Remove the replication target relationship from D1_MSDP to D2_MSDP_1.

8 Refresh the disk pools in both domains.

Domain 3

D3_MSDP

Domain 2

D2_MSDP_1

Domain 1

D2_MSDP_2

D1_MSDP

9 Run the following command in D1:

nbdecommission –oldserver MSDP_D2 –machinetype replication_host
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10 Delete IMPORT_D2.

Domain 1 Domain 2 Domain 3

SLP: IMPORT_D3

Oper.

Import

Target

D3_MSDP

SLP: IMPORT_2_D2

Oper.

Import
Rep.

Target

D2_MSDP_2
IMPORT_D3

SLP: Backup_D1

Oper.

Backup
Rep.

Target

D1_MSDP
IMPORT_D2_2

11 Remove the replication target relationship from D2_MSDP_1 to D3_MSDP.

12 Refresh disk pools in both domains.

Domain 3

D3_MSDP

Domain 2

D2_MSDP_1

Domain 1

D2_MSDP_2

D1_MSDP

About restoring from a backup at a target master domain
While it is possible to restore a client directly by using the images in the target
master domain, do so only in a disaster recovery situation. In this discussion, a
disaster recovery situation is one in which the originating domain no longer exists
and clients must be recovered from the target domain
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Table 27-18 Client restores in disaster recovery scenarios

DescriptionDoes client
exist?

Disaster recovery
scenario

Configure the client in another domain and restore directly to the client.YesScenario 1

Create the client in the recovery domain and restore directly to the
client. This is the most likely scenario.

NoScenario 2

Perform an alternate client restore in the recovery domain.NoScenario 3

The steps to recover the client are the same as any other client recovery. The actual
steps depend on the client type, the storage type, and whether the recovery is an
alternate client restore.

For restores that use Granular Recovery Technology (GRT), an application instance
must exist in the recovery domain. The application instance is required so that
NetBackup has something to recover to.

For information on granular recovery, see the following topics and guides:

■ See “Active Directory granular backups and recovery” on page 897.

■ See “Enable granular recovery (policy attribute)” on page 763.

■ See “Configuring a UNIX media server and Windows clients for backups and
restores that use Granular Recovery Technology (GRT)” on page 1244.

■ The NetBackup for Microsoft SharePoint Server Administrator's Guide:
http://www.veritas.com/docs/DOC5332

■ The NetBackup for Microsoft Exchange Server Administrator's Guide:
http://www.veritas.com/docs/DOC5332

Reporting on Auto Image Replication jobs
The Activity Monitor displays both the Replication job and the Import job in a
configuration that replicates to a target master server domain.

Table 27-19 Auto Image Replication jobs in the Activity Monitor

DescriptionJob type

The job that replicates a backup image to a target master displays in the Activity Monitor as a
Replication job. The Target Master label displays in the Storage Unit column for this type of job.

Similar to other Replication jobs, the job that replicates images to a target master can work on
multiple backup images in one instance.

The detailed status for this job contains a list of the backup IDs that were replicated.

Replication
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Table 27-19 Auto Image Replication jobs in the Activity Monitor (continued)

DescriptionJob type

The job that imports a backup copy into the target master domain displays in the Activity Monitor as
an Import job. An Import job can import multiple copies in one instance. The detailed status for an
Import job contains a list of processed backup IDs and a list of failed backup IDs.

Note that a successful replication does not confirm that the image was imported at the target master.

If the data classifications are not the same in both domains, the Import job fails and NetBackup does
not attempt to import the image again.

Failed Import jobs fail with a status 191 and appear in the Problems report when run on the target
master server.

The image is expired and deleted during an Image Cleanup job. Note that the originating domain
(Domain 1) does not track failed imports.

See “Running a report” on page 1141.

Import

About NetBackup Replication Director
Replication Director is the implementation of NetBackup OpenStorage-managed
snapshots and snapshot replication, where the snapshots are stored on the storage
systems of partnering companies. OpenStorage is a Veritas API that lets NetBackup
communicate with the storage implementations that conform to the API.

Replication Director uses the functions of the OpenStorage partners to perform the
following tasks:

■ To share disks so that multiple heterogeneous media servers can access the
same disk volume concurrently.

■ To balance loads and tune performance. NetBackup balances backup jobs and
storage usage among the media servers and disk pools.

■ To make full use of disk array capabilities, including fast storage provisioning
and almost unlimited storage.

■ To use as an alternative to off-site vaulting. Storage replication technology
provides an efficient means to send copies of user data (files, applications,
databases) to off-site storage as part of a disaster recovery plan.

NetBackup stores snapshots of client data on the volumes that are available to the
storage server.

Snapshots represent a point-in-time of primary storage data as captured by the
storage hardware. NetBackup can then instruct the storage server to replicate the
snapshot from primary volumes to other volumes available to the storage server.
The snapshot can be replicated to multiple volumes within the storage server, or
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to storage outside of the storage server, such as a tape device or other disk storage.
Replication Director can accommodate an assortment of scenarios to meet the
specific data protection needs of an organization.

Replication Director offers a single NetBackup interface for end-to-end data
protection management for the following tasks:

■ Unified policy management.
Use the NetBackup Administration Console as the one, centralized backup
infrastructure to manage the lifecycle of all data.

■ Snapshot copy management.
Use NetBackup to manage the entire lifecycle of the snapshot. Replication
Director uses OpenStorage with a media server to access the storage server
volumes. No image can be moved, expired, or deleted from the disk array unless
NetBackup instructs the storage server to do so.
The instruction to perform the initial snapshot comes from an operation in a
NetBackup storage lifecycle policy (SLP). You can create one SLP that instructs
NetBackup to create the initial snapshot, to replicate the snapshot to several
locations, and to indicate a different retention period for each of the replications.
Additional instructions (or operations) can be included in the SLP that create a
backup from the snapshot, index the snapshot, and more.

■ Snapshot copy monitoring.
Use NetBackup OpsCenter to monitor the creation of each copy at each storage
location. OpsCenter provides extensive reporting on the entire replication
environment.

■ Global search and restore.
Recovery is available from any storage device in the environment that is defined
to NetBackup. This includes recovery from the primary copy or any replicated
copy on disk, or from any duplicated copy on disk or tape.

For more information, see the NetBackup Replication Director Solutions Guide.
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Monitoring and reporting

■ Chapter 28. Monitoring NetBackup activity

■ Chapter 29. Reporting in NetBackup

■ Chapter 30. Using the Logging Assistant
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Monitoring NetBackup
activity

This chapter includes the following topics:

■ About the Activity Monitor

■ Setting Activity Monitor options

■ About the Jobs tab

■ About the Daemons tab

■ About the Processes tab

■ About the Drives tab

■ About the Error Logs tab

■ About the jobs database

■ About the Device Monitor

■ About media mount errors

■ About pending requests and actions

About the Activity Monitor
Use the Activity Monitor in the NetBackup Administration Console to monitor
and control the following aspects of NetBackup:

See “About the Jobs tab” on page 1100.

The job details are described in the online Help.

Jobs
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See “About the Daemons tab” on page 1106.Services or Daemons

See “About the Processes tab” on page 1118.Processes

See “About the Drives tab” on page 1125.Drives

See “About the Error Logs tab” on page 1127.Error Logs

■ As long as the Activity Monitor is active in the NetBackup Administration
Console, the bpjobd daemon supplies the job activity status to the Activity
Monitor.
Updates to the Activity Monitor occur as jobs are initiated, updated, and
completed. Without a refresh cycle, updates occur instantaneously.
The status bar appears in the Jobs tab, at the top of the Activity Monitor Details
pane.

Note: The Filter option on the Viewmenu is useful for displaying in Activity Monitor
only those jobs with specified characteristics. For example, the jobs that were started
before a specific date; jobs in the queued state; jobs with status completion codes
within a specified range.

The status bar displays the following information:

■ The master server on which the jobs reside.

■ The total number of jobs.

■ The number of jobs in each of the job states: Active, Queued, Waiting for Retry,
Suspended, Incomplete, and Done.

■ The number of jobs currently selected.

■ The number of NetBackup services or daemons that run.

■ The number of drives and the state of each (Active, Down).

The numbers always reflect the actual number of jobs, even when the filter is used.
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Figure 28-1 Activity Monitor

Standard toolbar
Current master
server

User toolbar

Status bar

Menu bar

Right-click in pane to view the shortcut menu

Tabs

Setting Activity Monitor options
The following procedure describes how to set the options for the Activity Monitor
in the NetBackup Administration Console.

To configure options for the Activity Monitor

1 In the NetBackup Administration Console, in the menu bar, click View >
Options and select the Activity Monitor tab to access configurable options
for the Activity Monitor.

2 The following options are available to receive a confirmation warning.

Prompts the user with a confirmation dialog box when
a job is deleted.

Confirm job deletions

Prompts the user with a confirmation dialog box when
a job is canceled.

Confirm job cancellations
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Enable to display a confirmation dialog box when a
daemon is stopped.

To discontinue further delete, cancel, or stop daemon
confirmations, enable the In the future, do not show
this warning option.

Confirm stop daemons

Specifies the maximum number of Activity Monitor job
details, daemon details, and the process details windows
that can be displayed at one time.

Maximum details windows

Enable to refresh data on the Daemons tab and the
Processes tab and the job details elapsed time. Other
Jobs tab data refreshes independently of the Auto
Refresh setting.

Enter the rate (in seconds) at which data refreshes in
the Daemons tab and the Processes tab.

Automatically refresh
display

Enable to view NetBackup error logs in the Error Logs
tab in the Activity Monitor.

You can customize the view of error logs in Activity
Monitor by configuring the following options:

■ Select the option from the drop-down menu to
configure Show error logs for. The default selection
is Error and above which lists all the errors and
critical logs. You can select to view specific logs like
critical logs, information logs, errors, and warnings.

■ Select the time window next to Show error logs for
last to configure viewing logs in the selected time
frame. Default time window is set for last 24 hours.

■ Set the auto-refresh time by specifying the Refresh
display every option, in minutes. The default refresh
time is set to 15 minutes.

Show error logs in Activity
Monitor

Enable viewing error logs in the Job Details window.
When this option is checked, after clicking a specific
Job ID, you can view the log entries in the Job Details
window in a separately generated Error Logs tab. In
the Job Details window, the errors and critical logs that
are specific to the selected job entry, are shown.

Show error logs in Job
details window

3 Click OK to close the dialog box and apply any changes.
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About the Jobs tab
The Jobs tab in the Activity Monitor displays all of the jobs that are in process or
that have completed for the master server currently selected. The Jobs tab also
displays details about the jobs. The job details are described in the online Help.

For some backup jobs, a parent job is used to perform pre- and post-processing.
Parent jobs display a dash (-) in the Schedule column.

A parent job runs the start and end notify scripts (PARENT_START_NOTIFY,
PARENT_END_NOTIFY) from the master server. The scripts are located in the following
directory:

On Windows: install_path\NetBackup\bin

On UNIX: /usr/openv/netbackup/bin/

The role of the parent job is to initiate requested tasks in the form of children jobs.

The tasks vary, depending on the backup environment, as follows.

Table 28-1 Tasks initiated by parent jobs

DescriptionTask

The parent job creates the snapshot, initiates children jobs, and deletes the snapshot
when complete.

Children jobs are created if the Snapshot Client settings are configured to retain
snapshots for Instant Recovery, then copy snapshots to a storage unit. (Snapshots
and copy snapshots to a storage unit is selected in the policy Schedule Attributes
tab.)

Children jobs are not created if the Snapshot Client settings are configured to retain
snapshots for Instant Recovery, but to create snapshots only. That is, the snapshot is
not backed up to a storage unit, so no children jobs are generated. (Snapshots only
is selected in the policy Schedule Attributes tab.)

Snapshot Client

The parent job runs brmsavecfg, then initiates the backup as a child job. If
multistreaming and BMR are used together, the parent job can start multiple children
jobs.

Bare Metal Restore

The parent job for catalog backups works with bpdbm to initiate multiple children backup
jobs:

■ A Sybase backup
■ A file system backup of the master server
■ A backup of the BMR database, if necessary

Catalog backups
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Table 28-1 Tasks initiated by parent jobs (continued)

DescriptionTask

A multiple copies job produces one parent job and multiple child jobs. Child jobs that
are part of a multiple copies parent job cannot be restarted individually. Only the parent
job (and subsequently all the children jobs) can be restarted.

See “Multiple copies (schedule attribute)” on page 806.

Multiple copies

The parent job performs stream discovery and initiates children jobs. A parent job does
not display a schedule in the Activity Monitor. Instead, a dash (-) appears for the
schedule because the parent schedule is not used and the children schedules may be
different. The children jobs display the ID of the parent job in the Activity Monitor.

Multiple data streams

The parent job runs a resolver process during which children jobs are started. This
process is similar to the stream discovery for multiple data streams. If multiple data
streams are enabled, some children jobs can be split into multiple streams.

SharePoint

The parent job starts the Vault profile. Then, the Vault profile starts the duplicates as
jobs. The duplicates do not appear as children jobs in the Activity Monitor.

Vault

Viewing job details in the Activity Monitor
The following procedure describes how to view job details in the Activity Monitor in
the NetBackup Administration Console.

To view job details in the Activity Monitor

◆ In the NetBackup Administration Console, click Activity Monitor.

Double-click on a job that is displayed in the Jobs tab pane.

The Job Details dialog box contains detailed job information on separate tabs:

■ Job Overview tab

■ Detailed Status tab

■ Job Hierarchy tab

■ Error Logs

To view the details of the previous or the next job, click the up or down arrow.

Click Help to view the descriptions of the fields.

Not all columns appear by default. In theNetBackup Administration Console,
click View > Columns > Layout or View > Column Layout to show or hide
columns.

1101Monitoring NetBackup activity
About the Jobs tab



Showing or hiding column heads in the Activity Monitor
The following procedure describes how to show or hide column heads in the Activity
Monitor.

To show or hide column heads in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor.

2 Select an item in the right-hand pane.

3 Click View > Columns > Layout. The Set Column Layout orColumn Layout
the dialog box appears.

4 Select the heading you want to display or hide.

■ Select the Show Column button to display the heading.

■ Select the Hide Column button if you do not want to see the column head.

5 To change the order in which the columns appear, select the column head.
Then, click the Move Up button or the Move Down button to reorder the
columns.

6 Click OK to apply the changes.

Monitoring the detailed status of a selected job in the Activity Monitor
The following procedure describes how to monitor the detailed status of a job.

To monitor the detailed status of a selected job

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select one or more jobs.

3 Select Actions > Details.

Deleting completed jobs in the Activity Monitor
The following procedure describes how to delete a completed job.

To delete completed jobs in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select the job(s) you want to delete.

3 Select Edit > Delete.

When a parent job is deleted, all the children jobs are deleted as well. When a child
job is deleted that has no children, that child job alone is deleted.
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Canceling a job that has not completed in the Activity Monitor
The following procedure describes how to cancel a job that has not completed.

To cancel a job that has not completed in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select the job that has not completed that you want to cancel. It may be a job
that is in the Queued, Re-Queued, Active, Incomplete, or Suspended state.

3 Select Actions > Cancel Job.

If the selected job is a parent job, all the children of that parent job are canceled
as well.

In most cases, a canceled child job cancels only that job and allows the other
child jobs to continue. One exception is multiple copies created as part of a
policy or a storage lifecycle policy: canceling a child job cancels the parent job
and all child jobs.

4 To cancel all jobs in the jobs list that have not completed, click Actions >
Cancel All Jobs.

Restarting a failed (completed) job in the Activity Monitor
The following procedure describes how to restart a job that has completed. Use
this procedure to retry a job that has failed.

To restart a completed job in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select the job that you want to restart.

3 Select Actions > Restart Job. In this case, a new job ID is created for the job.
The job details for the original job reference the job ID of the new job.

Suspending and resuming jobs in the Activity Monitor
The following procedure describes how to suspend restore or backup jobs.
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To suspend a restore or a backup job in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select the job you want to suspend.

Only the backup and the restore jobs that contain checkpoints can be
suspended.

3 Select Actions > Suspend Job.

The following procedure describes how to resume suspended or incomplete jobs.

To resume a suspended or an incomplete job in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select the suspended or the incomplete job you want to resume.

Only the backup and the restore jobs that contain checkpoints can be
suspended.

3 Select Actions > Resume Job.

Printing job list information in the Activity Monitor
The following procedure describes how to print job list information from a list of
jobs.

To print job list information from a list of jobs in the Activity Monitor

1 In the NetBackup Administration Console, open the Activity Monitor and
select the Jobs tab.

2 Select a job to print. Hold down the Control or Shift key to select multiple jobs.
If no job is selected, all jobs print.

3 Select File > Print.

Exporting Activity Monitor data to a text file
The following procedure describes how to export Activity Monitor data to a text file.

To export Activity Monitor data to a text file

1 In the NetBackup Administration Console, open the Activity Monitor.

2 From any Activity Monitor tab, select File > Export.
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3 Select whether to export all rows or only the rows currently selected.

4 Enter the full path to the file where you want the job data to be written, then
click Save.

Copying Activity Monitor text to a file
The following procedure describes how to copy Activity Monitor text to a file.

To copy Activity Monitor text to a file

1 In the NetBackup Administration Console, open the Activity Monitor and
select rows that you want to copy.

2 Perform one of the following method:

■ Select Edit > Copy To Clipboard.

■ Press Ctrl + C.

■ Right-click and select Copy To Clipboard from the right-click menu.

■ Click the Copy To Clipboard icon on the toolbar.

3 Paste the selected text into the file (for example, an Excel document).

Note: These methods of copying information from the Activity Monitor also apply
to other tables in NetBackup. The table title is not copied.

Changing the Job Priority dynamically from the Activity Monitor
To dynamically change the priority of a job, select one or more queued or active
jobs that wait for resources. Then, either from theActionsmenu or by right-clicking
the job, select Change Job Priority.

Select one of the following methods to change the job priority.

Table 28-2 Change Job Priority options

DescriptionOption

Enters the specific job priority for the selected jobs.Set Job Priority to

Raises the priority of the job by the selected internal.Increment the Job
Priority by

Lowers the priority of the job by the selected internal.Decrement the Job
Priority by
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Changes in the Change job priority dialog box affect the priority for the selected
job only, and not all other jobs of that type.

To change the job priority defaults, use the Default Job Priorities host properties.

See “Default Job Priorities properties” on page 100.

About the Daemons tab
In the NetBackup Administration Console, the Daemons tab in the Activity
Monitor displays the status of NetBackup daemons on master and media servers.

Figure 28-2 The Daemons tab in the Activity Monitor

Not all columns display by default. Click View > Column Layout to show or hide
columns.

Table 28-3 describes the NetBackup daemons.
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Table 28-3 NetBackup daemons

DescriptionDaemon

Populates the NetBackup catalog database with database agent metadata and
service requests for agents. This service is also responsible for initiating certain
actions, such as starting jobs for Oracle cloning.

NetBackup Agent Request Server
(nbars or nbars.exe)

The Audit Manager provides the mechanism to query and report on auditing
information.

NetBackup Audit Manager
(nbaudit or nbaudit.exe)

NetBackup Product Authentication validates identities and forms the basis for
authorization and access control in NetBackup. The authentication service also
generates security certificates that are consumed by various NetBackup
components.

See “About security certificates for NetBackup hosts” on page 35.

NetBackup Authentication (nbatd
or nbatd.exe)

NetBackup Product Authorization provides access control in NetBackup
applications.

NetBackup Authorization (nbazd
or nbazd.exe)

Is present if BareMetal Restore Boot Server is installed. BMR boot servers manage
and provide the resources that are used to rebuild systems.

NetBackup Bare Metal Restore
Boot Server Service (bmrbd or
bmrbd.exe)

Is present if Bare Metal Restore is installed. Manages restoration data, objects,
and servers.

NetBackup Bare Metal Restore
Master Server (bmrd or
bmrd.exe)

Is present if Bare Metal Restore is installed. Provides the TFTP protocol services
to Bare Metal Restore clients.

NetBackup BMR MTFTP Services
(PXEMTFTP or PXEMTFTP.exe)

Is present if Bare Metal Restore is installed. Provides the PXE protocol services
to Bare Metal Restore clients.

NetBackup BMR PXE Service
(bmrpxeserver or
bmrpxeserver.exe)

The NetBackup Client daemon. This process issues requests to and from the
master server and the media server to start programs on remote hosts.

On UNIX clients, bpcd can only be run in standalone mode.

On Windows, bpcd always runs under the supervision of bpinetd.exe.
NetBackup has a specific configuration parameter for bpcd. If the port number
is changed within the NetBackup configuration, the software also updates the port
number in the services file.

NetBackup Client Service (bpcd
or bpcd.exe)

1107Monitoring NetBackup activity
About the Daemons tab



Table 28-3 NetBackup daemons (continued)

DescriptionDaemon

This is applicable to media server versions 7.7.x to 8.1.2 only.

The CloudStore Service Container is a web-based service container that runs on
the media server that is configured for cloud storage. This container hosts the
throttling service and the metering data collector service. The container requires
that an authentication certificate is installed on the media server.

See “About security certificates for NetBackup hosts” on page 35.

Note: For NetBackup releases beyond 8.1.2, the nbcssc service is no longer
deployed. The NetBackup Web Management Console (nbwmc) service handles
the cloud storage configuration operations and the NetBackup Service Layer
(nbsl) service handles the throttling service and the metering data collector
service functions. For media server versions beyond 8.1.2, authentication is done
using host ID-based certificate.

NetBackup CloudStore Service
Container (nbcssc or
nbcssc.exe)

Communicates with legacy NetBackup services.NetBackup Compatibility Service
(bpcompatd or bpcompatd.exe)

Manages the NetBackup internal databases and catalogs. BPDBMmust be running
on the NetBackup master server during all normal NetBackup operations.

NetBackup Database Manager
(bpdbm or bpdbm.exe)

Runs on the NetBackup deduplication storage server host to store and manage
deduplicated client data. spoold stands for storage pool daemon; do not confuse
it with a print spooler daemon.

Active only if the NetBackup Data Protection Optimization Option is licensed and
the media server is configured as a deduplication storage server.

NetBackup Deduplication Engine
(spoold or spoold.exe)

Runs on the NetBackup deduplication storage server host to maintain the
NetBackup deduplication configuration, control deduplication internal processes,
control replication, control security, and control event escalation.

Active only if the NetBackup Data Protection Optimization Option is licensed and
the media server is configured as a deduplication storage server.

NetBackupDeduplicationManager
(spad or spad.exe)

Starts the Volume Manager (vmd), the automatic volume recognition process
(avrd), and any robotic processes. Processes the requests to mount and dismount
tapes in robotically controlled devices through the robotic control processes.
Mounts the volumes on the tape devices in response to user requests.

NetBackup DeviceManager (ltid
or ltid.exe)
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Table 28-3 NetBackup daemons (continued)

DescriptionDaemon

Accesses and manages the database where media and device configuration
information is stored (EMM_DATA.db). nbemm.exe must be running in order for
jobs to run.

The service cannot be stopped from the Activity Monitor because it receives
data that appears in the NetBackup Administration Console. If it is stopped,
the console cannot display the data.

NetBackup Enterprise Media
Manager (nbemm or nbemm.exe)

Provides the communication infrastructure to pass information and events between
distributed NetBackup components. Runs on the same system as the NetBackup
Enterprise Media Manager.

NetBackup Event Management
Service (nbevtmgr or
nbevtmgr.exe)

Manages the Hold Service.NetBackup Indexing Manager
(nbim or nbim.exe)

Accepts the jobs that the Policy Execution Manager (nbpem or nbpem.exe)
submits and acquires the necessary resources. The Job Manager then starts the
job and informs nbpem that the job is completed.

NetBackup Job Manager (nbjm or
nbjm.exe)

A master server-based symmetric Key Management Service that provides
encryption keys to media server BPTM processes.

NetBackup Key Management
Service (nbkms or nbkms.exe)

Listens for connections from NetBackup servers in the network and when an
authorized connection is made, starts the necessary NetBackup process to service
the connection.

The service cannot be stopped from the Activity Monitor because it receives
data that appears in the NetBackup Administration Console. If it is stopped,
the console cannot display the data.

Note: On Windows, the Client Service must be run as either an Administrator or
Local System account. Problems arise if the Client Service logon account differs
from the user that is logged on to use NetBackup.When NetBackup tries to contact
the Client Service, a message appears that states the service did not start because
of improper logon information. The event is recorded in the Windows System
event log. The log notes that the account name is invalid, does not exist, or that
the password is invalid.

To configure a BasicDisk storage unit that uses CIFS, nbrmms must share the
same logon credentials as bpinetd on the media server.

See “Configuring credentials for CIFS storage and disk storage units” on page 599.

NetBackup Legacy Client Service
(bpinetd or bpinetd.exe)

Creates Policy/Client tasks and determines when jobs are due to run. If a policy
is modified or if an image expires, nbpem is notified and the Policy/Client task
objects are updated.

NetBackup Policy Execution
Manager (nbpem or nbpem.exe)
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Table 28-3 NetBackup daemons (continued)

DescriptionDaemon

Executes the Open Storage (OST) calls on any host and returns the results to
the proxy plugin side. The plugin side returns them to the application. The proxy
server (and plugin) provides a network connection between different servers to
relay Open Storage calls.

NetBackup Proxy Service
(nbostpxy or nbostpxy.exe)

Manages the NetBackup relational database. The service must be running on the
NetBackup master server during all normal NetBackup operations.

On Windows, the display name is SQLANYs_VERITAS_NB.

NetBackup Relational Database
Manager (NB_dbsrv or
dbsrv12.exe)

Discovers andmonitors disk storage on NetBackupmedia servers. Also discovers,
monitors, and manages Fibre Transport (FT) connections on media servers and
clients for the NetBackup SAN Client option. Runs on NetBackup media servers.

To configure a BasicDisk storage unit that uses CIFS, nbrmms must share the
same logon credentials as bpinetd on the media server.

See “Configuring credentials for CIFS storage and disk storage units” on page 599.

NetBackup Remote Manager and
Monitor Service (nbrmms or
nbrmms.exe)

Manages the socket connections between a NetBackupmedia server and a client
that is configured for resilient communication. This service runs on the NetBackup
master server, NetBackup media servers, and clients. NetBackup starts this
service when resilient connections are required between hosts. The service stops
when resilient connections are no longer required.

One instance of the service can process 256 connections. Multiple instances of
the service can run simultaneously.

See “NBRNTD_IDLE_TIMEOUT option for NetBackup servers” on page 317.

See “Resilient Network properties” on page 192.

NetBackup Remote Network
Transport Service (nbrntd or
nbrntd.exe)

Processes the requests from NetBackup clients and servers. bprd also prompts
NetBackup to perform automatically scheduled backups. bprd must be running
on the NetBackup master server to perform any backups or restores.

NetBackup Request Daemon
(bprd or bprd.exe)

Allocates the storage units, tape drives, and client reservations for jobs. nbrb
works with the Enterprise Media Manager (NBEMM).

The nbrbutil utility can be used to add or change the Resource Broker settings.

See “Using the nbrbutil utility to configure the NetBackup Resource Broker”
on page 1112.

NetBackupResource Broker (nbrb
or nbrb.exe)

Runs on NetBackup SAN clients. Implements the client side of the Fibre Transport
(FT) mechanism. The client FT service opens and closes FT connections and
manages the FT connections for shared memory data transfers.

NetBackup SAN Client Fibre
Transport Service
(nbftclnt.exe)
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Table 28-3 NetBackup daemons (continued)

DescriptionDaemon

Facilitates the communication between the NetBackup graphical user interface
and NetBackup logic. NBSL is required to run Veritas NetBackup OpsCenter
which manages and monitors multiple NetBackup environments.

The service cannot be stopped from the Activity Monitor because it receives
data that appears in the NetBackup Administration Console. If it is stopped,
the console cannot display the data.

This service also does the following for Cloud storage:

■ Generates the metering information for the metering plug-in.
■ Controls the network bandwidth usage with the help of the throttling plug-in.

Note: For media server versions 7.7.x to 8.1.2, the metering service and the
throttling service functions are handled by the the NetBackup CloudStore Service
Container (nbcssc) service.

NetBackup Service Layer (nbsl
or nbsl.exe)

Monitors the NetBackup services that run on the local computer. If a service
unexpectedly terminates, the service tries to restart the terminated service. If
nbsvcmon determines that NetBackup is configured for a cluster, the service
shuts down, and the monitoring is taken over by the cluster.

The service cannot be stopped from the Activity Monitor because it receives
data that appears in the NetBackup Administration Console. If it is stopped,
the console cannot display the data.

NetBackup Service Monitor
(nbsvcmon or nbsvcmon.exe)

Manages the storage lifecycle operations and schedules duplication jobs. Monitors
disk capacity on capacity-managed volumes and removes older images when
required.

The SLP Manager and the Import Manager run within nbstserv:

■ The SLP Manager creates batches of the images to be imported based on
SLP name and storage device (disk media id or robot number).

■ The Import Manager monitors a worklist in EMM for images to be imported
and initiates bpimport jobs for those images.

Note: Restart nbstserv after making changes to the underlying storage for any
operation in an SLP.

NetBackup Storage Lifecycle
Manager (nbstserv or
nbstserv.exe)

Manages NetBackup Vault. NBVAULT must be running on the NetBackup Vault
server during all NetBackup Vault operations.

NetBackup Vault Manager
(nbvault or nbvault.exe)

Manages the volumes (tapes) needed for backup or restore and starts local device
management daemons and processes.

NetBackup Volume Manager (vmd
or vmd.exe)
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Table 28-3 NetBackup daemons (continued)

DescriptionDaemon

The process for the NetBackup Web Management Console. Manages requests
for certificate and host management, and Cloud storage configuration.

Note: For NetBackup release versions up to 8.1.2, the NetBackup CloudStore
Service Container (nbcssc) service is used for the cloud storage configuration.

To configure ports for the NetBackup Web Services, see "Configuring ports for
the NetBackupWeb Services" in the NetBackup Network Ports Reference Guide.

NetBackup Web Management
Console (nbwmc or nbwmc.exe)

Provides single-port access to clients outside the firewall that connect to Veritas
product services. Service name: VRTSpbx.

Note: This service does not appear in the Activity Monitor but is represented
in the Windows Services utility.

Veritas Private Branch Exchange
(pbx_exchange.exe)

The vxesfsd daemon runs on a CloudCatalyst storage server configured for
deduplication to the cloud. The ESFS Storage Manager is a component of
vxesfsd and uses vxesp daemons to upload and download data to cloud storage.

For information about CloudCatalyst, see the NetBackup Deduplication Guide.

NetBackup Extendable Storage
File System Service (vxesfsd)

The vxesp daemons run on a CloudCatalyst storage server configured for
deduplication to the cloud. They are responsible for interacting with the cloud.
Under normal operations, there are always two vxesp processes: one is the
master and one is the worker.

NetBackup Extendable Storage
Proxy daemons vxesp)

Using the nbrbutil utility to configure the NetBackup Resource Broker
The NetBackup Resource Broker (nbrb) allocates resources andmaintains resource
requests for jobs in the job queue. Use the nbrbutil utility to configure the Resource
Broker.

The nbrbutil utility is located in the following directory:

■ On Windows: install_path\NetBackup\bin\admincmd\nbrbutil

■ On UNIX: /usr/openv/netbackup/bin/admincmd/nbrbutil

For a complete description of nbrbutil, see the NetBackup Commands Reference
Guide.

Table 28-4 describes the options available to nbrbutil command.
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Table 28-4 nbrbutil options

DescriptionOption

Cancels the allocation request within the given identifier.-cancel requestID

Changes the request priority.-changePriority requestID

Changes the request priority class.-changePriorityClass requestID
-priorityClass priorityClass

Adds or changes the nbrb configuration settings.

Table 28-5 describes the configuration settings in detail.

-changeSettings
parameterparameter_value

Deletes a Resource Broker configuration setting that is identified by
settingname.

-deleteSetting settingname

Dumps all Resource Broker allocation and request lists.-dump

Enables the Resource Broker to log its internal state in the specified file
name.

-dumptables [-f filename]

Lists the help for this command.-help

Lists all the active jobs for a drive.-listActiveDriveJobs
[driveName]

Lists all the active jobs.-listActiveJobs

Lists all the active jobs for a media ID (disk or tape).-listActiveMediaJobs mediaId

Lists all the active jobs for a volume pool.-listActivePoolJobs poolName

Lists all the active jobs for a storage unit or a storage unit group.-listActiveStuJobs
stuName|stugroup

Lists the drives that are reserved in EMM but have no corresponding
allocation in the Resource Broker.

-listOrphanedDrives

Lists the media that is reserved in EMM but has no corresponding allocation
in the Resource Broker.

-listOrphanedMedia

Lists the orphaned Fibre Transport pipes.-listOrphanedPipes

Lists the storage units that are reserved in EMM but have no corresponding
allocation in the Resource Broker.

-listOrphanedStus

Lists the configuration settings of the Resource Broker.-listSettings

Changes the request priority.-priority priority
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Table 28-4 nbrbutil options (continued)

DescriptionOption

Release the allocation with the given identifier.-release allocationID

Releases the allocation holds caused by allocation errors for drives and
media.

-releaseAllocHolds

Releases all allocations for the named drive.-releaseDrive drivename

Releases the EMM and the MDS allocations that MDS allocates by the
specified identifier.

-releaseMDS mdsAlocationKey

Releases all allocations for the specified volume.-releaseMedia mediaid

Releases the drives that are reserved in EMM but have no corresponding
allocation in the Resource Broker.

-releaseOrphanedDrive drivekey

Releases the media that are reserved in EMM but have no corresponding
allocation in the Resource Broker.

-releaseOrphanedMedia mediakey

Releases the orphaned Fibre Transport pipes.-releaseOrphanedPipes

Releases the storage units that are reserved in EMM but have no
corresponding allocation in the Resource Broker.

-releaseOrphanedStu stuName

Reports inconsistent the allocations between the Resource Broker and MDS.-reportInconsistentAllocations

Resets all Resource Broker allocations, requests, and persisted states.-resetAll

Resets all Resource Broker EMM and MDS allocations that are related
toltid on the media server.

-resetMediaServer mediaserver

Resumes the Resource Broker processing.-resume

Disables the future job from joining the group for this drive.-setDriveGroupUnjoinable

Disables the future job from joining the group for this media.-setMediaGroupUnjoinable

Suspends the Resource Broker processing.-suspend

Syncs up any allocation difference between the Resource Broker and MDS.-syncAllocations

Table 28-5 lists the parameters for the nbrbutil -changesettings option, and
describes the use of each.

Use the nbrbutil command with the -changesettings option to add or change
Resource Broker configuration settings.
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Table 28-5 nbrbutil -changesettings parameters

DescriptionParameter

When the RB_DO_INTERMITTENT_UNLOADS parameter is set to true
(default), nbrb initiates unloads of the drives that have exceeded the media
unload delay. Drives become available more quickly to jobs that require
different media servers or different media than the job that last used the
drive. However, the loaded media or drive pair may not be available for jobs
with less priority in the prioritized evaluation queue that can use the drive or
media without unload.

RB_DO_INTERMITTENT_UNLOADS=true

RB_DO_INTERMITTENT_UNLOADS

When the RB_ENABLE_OPTIMIZATION parameter is set to true (default),
this entry instructs nbrb to cache states of resource requests.

RB_ENABLE_OPTIMIZATION=true

RB_ENABLE_OPTIMIZATION

When the RB_RESPECT_REQUEST_PRIORITY parameter is set to false
(default), nbrb continues to evaluate jobs in the prioritized job queue. As a
result, a job is likely to reuse a drive more quickly after the drive has been
released. However, some lower priority jobs may receive drives before higher
priority jobs do.

When the RB_RESPECT_REQUEST_PRIORITY parameter is set to true,
nbrb restarts its evaluation queue at the top of the prioritized job queue after
resources have been released.

RB_RESPECT_REQUEST_PRIORITY=false

RB_RESPECT_REQUEST_PRIORITY

When a high priority request appears (a tape span request, a subsequent
request for a synthetic or a duplication job, or a read request for an optimized
duplication), nbrb immediately interrupts the evaluation cycle. nbrb releases
and unloads drives, if required, before a new evaluation cycle is started.

If the RB_BREAK_EVAL_ON_DEMAND parameter is set to true (default), the
evaluation cycle can be interrupted by high priority requests.

RB_BREAK_EVAL_ON_DEMAND=true

RB_BREAK_EVAL_ON_DEMAND

Spanning requests and additional resources for an active duplication job are
put in a special queue for priority processing. The
RB_MAX_HIGH_PRIORITY_QUEUE_SIZE parameter sets the maximum
number of requests that NetBackup allows in that queue. (Default: 100
requests.)

RB_MAX_HIGH_PRIORITY_QUEUE_SIZE=100

RB_MAX_HIGH_PRIORITY_QUEUE_SIZE
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Table 28-5 nbrbutil -changesettings parameters (continued)

DescriptionParameter

The RB_RELEASE_PERIOD parameter indicates the interval that NetBackup
waits before it releases a resource. (Default: 180 seconds.)

RB_RELEASE_PERIOD=180

RB_RELEASE_PERIOD

The RB_CLEANUP_OBSOLETE_DBINFO parameter indicates the number of
seconds that can elapse between the cleanup of obsolete information in the
nbrb database. (Default: 60 seconds.)

RB_CLEANUP_OBSOLETE_DBINFO=60

RB_CLEANUP_OBSOLETE_DBINFO

The RB_MPX_GROUP_UNLOAD_DELAY parameter indicates the number of
seconds that nbrb waits for a new job to appear before a tape is unloaded.
(Default: 10 seconds.)

RB_MPX_GROUP_UNLOAD_DELAY=10

This setting can help avoid unnecessary reloading of tapes and applies to
all backup jobs. During user backups, nbrb uses the maximum value of
RB_MPX_GROUP_UNLOAD_DELAY and the Media mount timeout host
property setting when nbrb unmounts the tape.

During restores, Media mount timeout is used, not
RB_MPX_GROUP_UNLOAD_DELAY.

See “Timeouts properties” on page 238.

RB_MPX_GROUP_UNLOAD_DELAY

The RB_RETRY_DELAY_AFTER_EMM_ERR parameter indicates how long
NetBackup waits after an EMM error before it tries again. The error must be
one where a retry is possible. For example, if a media server is down.
(Default: 60 seconds.)

RB_RETRY_DELAY_AFTER_EMM_ERR=60

RB_RETRY_DELAY_AFTER_EMM_ERR

The RB_REEVAL_PENDING parameter indicates the number of seconds that
can elapse between evaluations of the pending request queue. For example,
a pending request queue can include, jobs awaiting resources. (Default: 60
seconds.)

RB_REEVAL_PENDING=60

RB_REEVAL_PENDING

The RB_REEVAL_PERIOD parameter indicates the time between evaluations
if an outstanding request is not satisfied, and if no other requests or resources
have been released. (Default: Five minutes must pass before the initial
request is reevaluated.)

RB_REEVAL_PERIOD=300

RB_REEVAL_PERIOD
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Types of NetBackup daemons
The following table describes additional information about NetBackup daemons,
found on the UNIX platform.

Always run and listen to accept connections. Examples
include bpdbm, bprd, bpjobd, and vmd.

Standalone daemons

Splits or forks a child process to handle requests. Examples
include bpdbm and bprd.

Multiprocess standalone
daemons

Accept connections and handle requests in the same process.Single-process standalone
daemons

inetd(1m) or bpinetd usually launch these NetBackup
daemons. Examples include bpcd, bpjava-msvc, and
vnetd.

inetd daemons

Veritas recommends that you exit all instances of the NetBackup Administration
Console after restarting daemons in the Activity Monitor or by using a command.
Then restart the console with the jnbSA command.

The jnbSA command is described in the NetBackup Commands Reference Guide.

Monitoring NetBackup daemons
The following procedure describes how to monitor NetBackup daemons.

To monitor NetBackup daemons

1 In the NetBackup Administration Console, select Activity Monitor.

2 Select the Daemons tab.

3 Double-click the name of the daemon to view the details.

4 In theDaemon Details dialog box, click the up or down arrow to see the details
of the next or the previous daemon in the list.

For a description of the daemon, click Help in the dialog box.

Starting or stopping a daemon
The following procedure describes how to start or stop a NetBackup daemon.

To start or stop a NetBackup daemon

1 In the NetBackup Administration Console, select Activity Monitor.

2 Select the Daemons tab.
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3 Select the daemon(s) that you want to start or stop.

4 Select Actions > Stop Selected or Actions > Start Selected.

Or, select Actions > Start Daemon or Actions > Stop Daemon.

To start or stop daemons requires the necessary user permissions on the system
where the daemon runs.

Displaying all media servers in the Activity Monitor
TheActivity Monitormay not immediately display all media servers in theDaemons
tab as soon as the media is added. Also, the Media Servers tab of the Storage
Server dialog may not immediately display all available media servers in a cloud
environment.

Even though the media servers may not be visible, it does not affect existing media
servers or other NetBackup operations.

To display all media servers:

■ Close the NetBackup Administration Console on the master server.

■ Stop and restart the NetBackup Service Layer (NBSL). Restarting NBSL does
not affect any ongoing backup or restore jobs.

■ Open the NetBackup Administration Console. The services of the newly
added media servers should be visible in the NetBackup Administration
Console.

This situation affects only the Remote Administration Console on Windows and
the OpsCenter interface.

About the Processes tab
In the NetBackup Administration Console, the Processes tab in the Activity
Monitor displays the NetBackup processes that run on master and media servers.

Not all columns display by default. Click View > Column Layout to show or hide
columns.

Table 28-6 lists and describes the NetBackup processes.

Table 28-6 NetBackup processes

DescriptionPortProcess

The acsd (Automated Cartridge System) daemon runs on the NetBackup media server and
communicates mount and unmount requests to the host that controls the ACS robotics.

13702acsd
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Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

On UNIX: The NetBackup ACS storage server interface (SSI) event logger acssel logs
events.

Noneacssel

On UNIX: The NetBackup ACS storage server interface (SSI) acsssi communicates with
the ACS library software host. acsssi processes all RPC communications from acsd or
from the ACS robotic test utility that is intended for the ACS library software.

Noneacsssi

The Automatic Volume Recognition process handles automatic volume recognition and
label scans. The process allows NetBackup to read labeled tapes and assign the associated
removable media requests to drives.

Noneavrd

The process for the NetBackup Bare Metal Restore Master Server service.8362bmrd

The NetBackup Client daemon issues requests to and from themaster server and themedia
server to start programs on remote hosts.

On UNIX clients, bpcd can only be run in standalone mode.

On Windows, bpcd always runs under the supervision of bpinetd.exe. NetBackup has
a specific configuration parameter for bpcd: if the port number is changed within the
NetBackup configuration, the software also updates the port number in the services file.

13782bpcd

The process for the NetBackup Compatibility service.Nonebpcompatd

The process for the NetBackup Database Manager service.

The process that responds to queries that are related to the NetBackup catalog.

Manages the NetBackup internal databases and catalogs. This service must be running on
the NetBackup master server during all normal NetBackup operations.

13721bpdbm

On Windows: The process for the NetBackup Legacy Client Service.

The process that provides a listening service for connection requests.

Note: To configure a BasicDisk storage unit that uses CIFS, the media server and the
following processes must have the same logon credentials: bpinetd, nbrmms, and vnetd.

See “Configuring credentials for CIFS storage and disk storage units” on page 599.

Nonebpinetd

The NetBackup Java application server authentication service program. bpinetd starts
the program during startup of the NetBackup Java applications and authenticates the user
that started the NetBackup Java application.

Nonebpjava-msvc

1119Monitoring NetBackup activity
About the Processes tab



Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

The NetBackup Java application server user service program on NetBackup servers.
bpjava-msvc starts the program upon successful login with the NetBackup login dialog
box. bpjava-susvc services all requests from the NetBackup Java applications for
administration and end user operations on the host on which the NetBackup Java application
server is running.

Nonebpjava-susvc

The NetBackup Jobs Database Management daemon. This process queries and updates
the jobs database.

13723bpjobd

The process for the NetBackup Request Daemon.

The process that starts the automatic backup of clients and responds to client requests for
file restores and user backups and archives.

NetBackup has a specific configuration parameter for bprd: if the port number changes
within the NetBackup configuration, the software also updates the port number in the services
file.

13720bprd

The process for the NetBackup Device Manager service.Noneltid

The NetBackup Authentication Service validates, identifies, and forms the basis for
authorization and access.

13783nbatd

The NetBackup Audit Manager runs on the master server. The Enterprise Media Manager
(EMM) maintains audit records in the NetBackup database. The act of starting or stopping
nbaudit is audited, even if auditing is disabled.

nbaudit

The NetBackup Authorization Service verifies that an identity has permission to perform a
specific task.

13722nbazd

This is applicable to media server versions 7.7.x to 8.1.2 only. The nbcssc service is no
longer deployed in NetBackup release versions beyond 8.1.2.

The NetBackup CloudStore Service Container hosts the throttling service and the metering
data collector service.

The specified port number is used to provide back-level media support for older media
servers that are configured for cloud storage. If there are no older media servers, this port
is not used.

Note: Ensure that the older media servers use this port. Communication with the master
server fails if the older media servers use a different port.

5637nbcssc

The NetBackup Agent Request Server service populates the NetBackup catalog database
with database agent metadata and services request for agents. This service is also
responsible for initiating certain actions, such as starting jobs for Oracle cloning.

Nonenbars
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Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

The NetBackup Relational Database Manager manages the NetBackup relational database.
This service must be running on the NetBackup master server during all normal NetBackup
operations. On Windows, the display name is SQLANYs_VERITAS_NB.

13785NB_dbsrv

The process for the NetBackup Enterprise Media Manager service.

The process that accesses andmanages the database wheremedia and device configuration
information is stored (EMM_DATA.db). nbemm.exemust be running in order for jobs to run.

Nonenbemm

The process for the NetBackup Event Manager service.

The process that creates and manages event channels and objects for communication
among NetBackup daemon. The Event Manager daemon runs with the Enterprise Media
Manager (nbemm) only on master servers.

NonenbEvtMgr

The process that controls the Fibre Transport target mode drivers on the media server.
nbfdrv64 runs on the media servers that are configured for NetBackup Fibre Transport.

Nonenbfdrv64

The Fibre Transport (FT) server process that runs on the media servers that are configured
for NetBackup Fibre Transport. It does the following for the server side of the FT connection:
controls data flow, processes SCSI commands, manages data buffers, and manages the
target mode driver for the host bus adaptors.

Nonenbftsrvr

The process for the NetBackup Job Manager service.

The process that accepts the jobs that the Policy Execution Manager (NBPEM) submits and
acquires the necessary resources. The Job Manager then starts the job and informs nbpem
that the job is completed.

Nonenbjm

The process for the NetBackup Policy Execution Manager service.

It creates Policy/Client tasks and determines when jobs are due to run. If a policy is modified
or if an image expires, NBPEM is notified and the appropriate Policy/Client tasks are updated.

Nonenbpem

The process that safely allows multithreaded NetBackup processes to use existing
multithreaded unsafe libraries.

Nonenbproxy

This process allocates storage units, tape drives, and client reservations for jobs. nbrb
works with the Enterprise Media Manager (NBEMM).

Nonenbrb

The process for the NetBackup Remote Manager and Monitor service. It enables NetBackup
to remotely manage and monitor resources on a system that are used for backup (or affected
by backup activity).

Note: To configure a BasicDisk storage unit that uses CIFS, the media server and the
following processes must have the same logon credentials: bpinetd, nbrmms, and vnetd.

See “Configuring credentials for CIFS storage and disk storage units” on page 599.

Nonenbrmms

1121Monitoring NetBackup activity
About the Processes tab



Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

The process for the NetBackup Service Layer service.

nbsl listens on this port for connections from local processes and then facilitates the
communication between the graphical user interface and NetBackup logic. The port was
formerly used by visd.

9284nbsl

The process for the NetBackup Storage Lifecycle Manager. Manages the storage lifecycle
policy operations and schedules duplication jobs. Monitors the disk capacity on the volumes
that are capacity-managed and removes older images when required.

Note: Restart nbstserv after making changes to the underlying storage for any operation
in an SLP.

Nonenbstserv

The process for the NetBackup Service Monitor. Monitors the NetBackup services. When
a service unexpectedly terminates, nbsvcmon attempts to restart the terminated service.

Nonenbsvcmon

If Vault is installed, the process for the NetBackup Vault Manager service.Nonenbvault

The process for the NetBackupWebManagement Console. Manages requests for certificate
and host management, and Cloud storage configuration.

Note: For NetBackup release versions up to 8.1.2, the NetBackup CloudStore Service
Container (nbcssc) service is used for the cloud storage configuration.

To configure ports for the NetBackupWeb Services, see "Configuring ports for the NetBackup
Web Services" in the NetBackup Network Ports Reference Guide.

Nonenbwmc

NDMP is the acronym for Network Data Management Protocol. NDMP servers are designed
to adhere to this protocol and listen on port 10000 for NDMP clients to connect to them.

10000ndmp

The NetBackup Volume Manager (vmd) starts the oprd operator request daemon. This
process receives requests to mount and unmount volumes and communicates the requests
to the NetBackup Device Manager ltid. The NetBackup Device Manager communicates
the requests to the robotics through SCSI interfaces.

Noneoprd

The NetBackup Deduplication Manager manages the PureDisk Deduplication Engine.

Runs on the NetBackup deduplication storage server host to maintain the NetBackup
deduplication configuration, control deduplication internal processes, control replication,
control security, and control event escalation.

10102spad

The process for the NetBackup Deduplication Engine service. It runs on the deduplication
storage server.

Active only if the NetBackup Data Protection Optimization Option is licensed and configured.

10082spoold
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Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

The tl4d process runs on the host that has a Tape Library 4mm. This process receives
NetBackup Device Manager requests to mount and unmount volumes and communicates
these requests to the robotics through SCSI interfaces.

13713tl4d

The tl8d process runs on a NetBackup media server that manages a drive in a Tape Library
8mm. This process receives NetBackup Device Manager requests to mount and unmount
volumes, and sends these requests to the robotic-control process tl8cd.

The tl8cd process communicates with the TL8 robotics through SCSI interfaces.

To share the tape library, tl8cd runs on the NetBackup server that provides the robotic
control.

13705tl8d

tl8cd

The tldd process runs on a NetBackup server that manages a drive in a Tape Library DLT.
This process receives NetBackup Device Manager requests to mount and unmount volumes
and sends these requests to the robotic-control process tldcd.

The tldcd process communicates with the Tape Library DLT robotics through SCSI
interfaces.

To share the tape library, tldcd runs on the NetBackup server that provides the robotic
control.

13711tldd

tldcd

The tlhd process runs on each NetBackup server that manages a drive in a Tape Library
Half-inch. This process receives NetBackup DeviceManager requests to mount and unmount
volumes and sends these requests to the robotic-control process tlhcd.

The tlhcd process runs on the NetBackup server that provides the robotic control and
communicates with the TLH robotics through SCSI interfaces.

13717tlhd

tlhcd

The tlmd Tape Library Multimedia (TLM) daemon runs on a NetBackup server. It
communicates mount, unmount, and robot inventory requests to a NetBackup media server
that hosts ADIC DAS/SDLC software and controls the TLM robotics.

13716tlmd

The process for the NetBackup Volume Manager service.13701vmd
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Table 28-6 NetBackup processes (continued)

DescriptionPortProcess

The process for the Veritas Network Daemon, which allows all socket communication to
take place while it connects to a single port. The following vnetd process and proxy types
can exist on NetBackup hosts:

■ Standalone. A standalone process must exist, and more than one can exist.
■ Inbound proxy. An inbound proxy must exist, and more than one can exist, each identified

by a different number.
■ Outbound proxy. An outbound proxy must exist, and more than one can exist, each

identified by a different number.
■ HTTP tunnel proxy. By default, an HTTP tunnel proxy should run on NetBackup media

servers. It does not run on NetBackup clients.
See “WEB_SERVER_TUNNEL_ENABLE option for NetBackup servers” on page 357.

You can determine the vnetd process and proxy types as follows:

■ On UNIX and Linux, you can use the NetBackup bpps command.
■ On Windows, you can use the Task Manager Processes tab (you must show the

Command Line column).

Note: To configure a BasicDisk storage unit that uses CIFS, the media server and the
following processes must have the same logon credentials: bpinetd, nbrmms, and vnetd.

See “Configuring credentials for CIFS storage and disk storage units” on page 599.

13724vnetd

The Veritas Private Branch Exchange allows all socket communication to take place while
it connects through a single port. Connections to NetBackup 7.0.1 and later use the
veritas_pbx port.

1556

1557

veritas_pbx

vxesfsd runs on a CloudCatalyst storage server. CloudCatalyst is used for deduplication
to the cloud.

Nonevxesfsd

vxesp runs on a CloudCatalyst storage server. The ESFSStorageManager is a component
of vxesfsd and uses vxesp to upload and download data to cloud storage.

Nonevxesp

Monitoring NetBackup processes in the Process Details dialog box
The following procedure describes how to view the details for a process.
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To view the details for a process

1 In the NetBackup Administration Console, click Activity Monitor.

2 To view the details for a specific process, double-click on the process you want
to display in the Processes tab. The Process Details dialog box appears for
the selected process.

3 In the Process Details dialog box, click the up or down arrow to see the details
of the next process in the list.

About the Drives tab
The Drives tab in the Activity Monitor displays the status of NetBackup drives on
the monitored server. Use the Drives tab to manage drives, device paths, and
service requests for operators. Change the status of the drive, clean the tape drive,
and perform other operations that you can also perform using the Device Monitor
under Media and Device Management.

Figure 28-3 Activity Monitor Drives tab
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To view the details for a drive, double-click the drive in the Drives tab pane. For a
description of the drive details, click Help in the Drives Details dialog box.

Monitoring tape drives
The following procedure describes how to monitor NetBackup tape drives.

To monitor NetBackup tape drives

1 In the NetBackup Administration Console, click the Activity Monitor.

2 In the right pane, select the Drives tab. Double-click a drive from the drive list
to view a detailed status.

3 A Drives Details dialog box appears for the drive you selected. To view the
status of the previous drive or the next drive, click the up or down arrow.

Cleaning tape drives from the Activity Monitor
Drive cleaning functions can also be performed from the Device Monitor.

To clean a tape drive

1 In the NetBackup Administration Console, select Activity Monitor. Then,
select the Drives tab in the Details pane.

2 Select the drive that you want to clean.

3 SelectActions > Drive Cleaning, then select one of the following drive cleaning
actions.

DescriptionAction

Starts an operator-initiated cleaning of the selected drive,
regardless of the cleaning frequency or accumulated mount
time. If the drive is a standalone drive, it must contain a
cleaning tape for a mount request to be issued.Clean Now
resets the mount time to zero, but the cleaning frequency
value remains the same.

Clean Now

Resets the mount time for the selected drive to zero. Use
Reset Mount Time to reset the mount time after doing a
manual cleaning of a drive.

Reset Mount Time

Sets the number of mount hours between drive cleanings.Set Cleaning Frequency
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About the Error Logs tab
The Error Logs tab in the Activity Monitor displays the status of NetBackup error
logs on the monitored server. You can enable viewing the Error Logs tab in the
Activity Monitor by navigating to View and then selectingOptions. Select the option
for enabling the view of error logs. Use the Error Logs tab on the Activity Monitor
to view the critical logs, information logs, errors and warnings generated during the
last 'n' hours duration which is configurable in the Error Logs tab.

Figure 28-4 Activity Monitor Error Logs tab

Click on a log entry to view the details that are associated with the log entry in a
separate Log details dialog box. For a description of the drive details, click Help
in the Log Details dialog box.

About the jobs database
NetBackup uses the bpdbjobs -clean command to periodically delete the jobs
that are done.
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By default, the bpdbjobs process deletes all completed jobs that are more than
three days old. By default, the bpdbjobs process retains more recent done jobs
until the three-day retention period expires.

To keep jobs in the jobs database longer than the default of three days, you must
change the default value.

If the bprd NetBackup request daemon is active, bprd starts the bpdbjobs process
automatically when it performs other cleanup tasks. The process starts the first time
bprd wakes up after midnight. The automatic startups occur regardless of whether
you choose to run bpdbjobs at other times by using cron or alternate methods.

The bpdbjobs -clean is located in the following directory:

On Windows: install_path\NetBackup\bin\admincmd\bpdbjobs -clean

On UNIX: /usr/openv/netbackup/bin/admincmd/bpdbjobs -clean

Changing the default bpdbjobs_options values
Use the one of the following methods to change the default values of the
bpdbjobs_options on a permanent basis:

■ On Windows:
Use the following method to add new registry key(s) to
HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\

CurrentVersion\Config

To add the key(s) safely, run the following commands. For example:

install_path\Veritas\NetBackup\bin\admincmd\

echo KEEP_JOBS_HOURS = 192 | nbsetconfig

Where 192 is the number of hours that unsuccessful jobs are kept in the jobs
database or Activity Monitor display.
For example, run:

echo KEEP_JOBS_SUCCESSFUL_HOURS = 192 | nbsetconfig

Where 192 is the number of hours that successful jobs are kept in the jobs
database or Activity Monitor display.

■ On UNIX:
Change the entries in the bp.conf file.
For example, add the following entry to the bp.conf file:

KEEP_JOBS_HOURS = 192
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Where 192 is the number of hours that unsuccessful jobs are kept in the jobs
database or Activity Monitor display.
For example, to change the retention of successful jobs, add the following entry:

KEEP_JOBS_SUCCESSFUL_HOURS = 192

Where 192 is the number of hours that successful jobs are kept in the jobs
database or Activity Monitor display.

Consider the following notes when changing the default values:

■ The default values for KEEP_JOBS_SUCCESSFUL_HOURS and KEEP_JOBS_HOURS

is 78 hours.

■ The retention period values are measured against the time the job ended.

■ Information about successful jobs cannot be kept longer than information about
unsuccessful jobs. If KEEP_JOBS_SUCCESSFUL_HOURS is greater than
KEEP_JOBS_HOURS, bpdbjobs sets KEEP_JOBS_SUCCESSFUL_HOURS to equal
KEEP_JOBS_HOURS.

■ If KEEP_JOBS_SUCCESSFUL_HOURS is set to 0, bpjobd uses the KEEP_JOBS_HOURS
bpdbjobs value instead for successful jobs.
If the KEEP_JOBS_SUCCESSFUL_HOURS value is greater than 0 but less than
KEEP_JOBS_HOURS, KEEP_JOBS_HOURS is used for unsuccessful jobs only.

About the BPDBJOBS_OPTIONS environment variable
The BPDBJOBS_OPTIONS environment variable provides a convenient method to set
job retention options with a script. The bpdbjobs process determines how long to
retain a job by checking for the BPDBJOBS_OPTIONS environment variable.

If present on Windows: BPDBJOBS_OPTIONS overrides the registry key settings.

If present on UNIX: BPDBJOBS_OPTIONS overrides the bp.conf settings. To customize
the output of bpdbjobs, add a BPDBJOBS_COLDEFS entry to the bp.conf file for each
column you want to appear in the output.

The following options can be used to determine the length of time NetBackup retains
jobs. The options should be entered in lower case in the BPDBJOBS_OPTIONS

environmental variable.
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Table 28-7 BPDBJOBS_OPTIONS environment variable options

DescriptionOption

Use with the -clean option to specify how many hours
bpdbjobs keeps unsuccessfully completed jobs. Default: 78
hours.

To keep both successful and both failed jobs longer than the
default of 78 hours, keep_successful_hours must be used
with keep_hours.

-keep_hours hours

Use with the -clean option to specify how many hours
bpdbjobs keeps successfully completed jobs. The number of
hours must be less than or equal to keep_hours.

Values outside the range are ignored. Default: 78 hours.

-keep_successful_hours hours

Use with the -clean option to specify how many days
bpdbjobs keeps completed jobs. Default: 3 days.

-keep_days days

This value must be less than the -keep_days value.

Use with the -clean option to specify how many days
bpdbjobs keeps successfully completed jobs. Default: 3 days.

-keep_successful_days days

In the following example, a batch file (cleanjobs.bat) was used on a Windows
server. You can copy the script directly from this document and change as needed.

■ The first line specifies how long to keep unsuccessful jobs (24 hours) and
successful jobs (five hours).

■ The second line specifies the path to the bpdbjobs command. Indicate the
correct location of bpdbjobs in the .bat file. In this example, NetBackup was
installed in the default location:

set BPDBJOBS_OPTIONS= -keep_hours 24 -keep_successful_hours 5

C:\progra~1\VERITAS\NetBackup\bin\admincmd\bpdbjobs -clean

The same script on a UNIX server would look like the following:

setenv BPDBJOBS_OPTIONS "-keep_hours 24 -keep_successful_hours 5 -clean"

/usr/openv/netbackup/bin/admincmd/bpdbjobs ${*}

You can store the .bat file anywhere, as long as it is run from the appropriate
directory.

In the following example, the administrator created and stored cleanjobs.bat in
C:\Program Files\VERITAS\NetBackup.
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Figure 28-5 Running cleanjobs.bat on Windows

bpdbjobs command line options
The bpdbjobs command interacts with the jobs database to delete or move
completed job files. The command line options supersede all other job retention
instructions.

The -clean option causes bpdbjobs to delete the completed jobs that are older
than a specified time period as follows:

bpdbjobs -clean [ -M <master servers> ]

[ -keep_hours <hours> ] or [ -keep_days <days> ]

[ -keep_successful_hours <hours> ] or

[ -keep_successful_days <days> ]

For example, the following command deletes unsuccessful jobs older than 72 hours.

bpdbjobs -clean -keep_hours 72

More information is available in the NetBackup Commands Reference Guide.

Enabling the bpdbjobs debug log
If you need detailed information on bpdbjobs activities, use the following procedure:

Enabling the bpdbjobs debug log

◆ Enable the bpdbjobs debug log by creating the following directory:

On Windows: install_path\NetBackup\logs\bpdbjobs

On UNIX: /usr/openv/netbackup/logs/bpdbjobs

1131Monitoring NetBackup activity
About the jobs database

http://www.veritas.com/docs/DOC5332


Note: Before you use a debug log, read the guidelines about legacy logging in the
NetBackup Logging Reference Guide:

http://www.veritas.com/docs/DOC5332

About the Device Monitor
Use the NetBackup Administration Console Device Monitor to manage your
tape drives, disk pools, and service requests for operators, as follows:

See “About media mount errors” on page 1133.Media mounts

See “About pending requests and actions” on page 1134.

See “About pending requests for storage units” on page 1134.

See “Resubmitting a request” on page 1136.

See “Resolving a pending action” on page 1136.

See “Denying a request” on page 1137.

Pending requests
and actions

See “Changing a drive comment” on page 465.

See “About downed drives” on page 466.

See “Changing a drive operating mode” on page 466.

See “Cleaning a tape drive from the Device Monitor” on page 469.

See “Resetting a drive” on page 470.

See “Resetting the mount time of a drive” on page 471.

See “Setting the drive cleaning frequency” on page 471.

See “Viewing drive details” on page 472.

See “Denying a request” on page 1137.

Tape drives

See “Changing OpenStorage disk pool state” on page 432.

More information about disk pools is available in the NetBackup guide
for your disk storage option:

■ The NetBackup AdvancedDisk Storage Solutions Guide.
■ The NetBackup Cloud Administrator's Guide.
■ The NetBackup Deduplication Guide.
■ The NetBackup OpenStorage Solutions Guide for Disk.
■ The NetBackup Replication Director Solutions Guide.

The Guides are available through the following URL:

http://www.veritas.com/docs/DOC5332

Disk pools
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About media mount errors
Errors can occur when media is mounted for NetBackup jobs. Depending on the
type of error, NetBackup adds the mount request to the pending requests queue
or cancels the mount request, as follows:

When NetBackup adds the mount request to the queue, NetBackup
creates an operator-pending action. The action appears in the
NetBackupAdministrationConsoleDeviceMonitor. A queuedmount
request leads to one of the following actions:

■ The mount request is suspended until the condition is resolved.
■ The operator denies the request.
■ The media mount time out is reached.

Adds to the
pending requests
queue

When a mount request is automatically canceled, NetBackup tries to
select other media to use for backups. (Selection applies only in the
case of backup requests.)

Many conditions lead to a mount request being automatically canceled
instead of queued.When amediamount is canceled, NetBackup selects
different media so that the backup is not held up.

See the section called “When NetBackup selects different media”
on page 1133.

Cancels the
request

When NetBackup selects different media
The following conditions can lead to automatic media reselection:

■ The requested media is in a DOWN drive.

■ The requested media is misplaced.

■ The requested media is write protected.

■ The requested media is in a drive not accessible to the media server.

■ The requested media is in an offline ACS LSM (Automated Cartridge System
Library Storage Module). (ACS robot type only.)

■ The requested media has an unreadable barcode. (ACS robot type only.)

■ The requested media is in an ACS that is not accessible. (ACS robot type only.)

■ The requested media is determined to be unmountable.
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About pending requests and actions
In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor. If requests await action or if NetBackup acts on
a request, the Pending Requests pane appears. For example, if a tape mount
requires a specific volume, the request appears in the Pending Requests pane.
If NetBackup requires a specific volume for a restore operation, NetBackup loads
or requests the volume. After all requests are resolved (automatically by NetBackup
or manually by operator intervention), the Pending Requests pane disappears.

If NetBackup cannot service a media-specific mount request automatically, it
changes the request or action to a pending state.

Table 28-8 Pending states

DescriptionPending state

Specifies that a pending request is for a tape mount that NetBackup
cannot service automatically. Operator assistance is required to
complete the request. NetBackup displays the request in the Pending
Requests pane.

NetBackup assigns pending status to a mount request when it cannot
determine the following:

■ Which standalone drive to use for a job.
■ Which drive in a robot is in Automatic Volume Recognition (AVR)

mode.

Pending request

Specifies that a tape mount request becomes a pending action when
the mount operation encounters problems, and the tape cannot be
mounted. Operator assistance is required to complete the request, and
NetBackup displays an action request in the Pending Requests pane.
Pending actions usually occur with drives in robotic libraries.

Pending action

About pending requests for storage units
In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor. The following tape mount requests do not appear
in the Device Monitor Pending Requests pane:

■ Requests for backups

■ Requests for a tape that is required as the target of a duplication operation

These requests are for resources in a storage unit and therefore are not for a specific
volume. NetBackup does not assign a mount request for one storage unit to the
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drives of another storage unit automatically. Also, you cannot reassign the mount
request to another storage unit.

If the storage unit is not available, NetBackup tries to select another storage unit
that has a working robot. If NetBackup cannot find a storage unit for the job,
NetBackup queues the job (a Queued state appears in the NetBackup
Administration Console Activity Monitor).

You can configure NetBackup so that storage unit mount requests are displayed
in the Device Monitor if the robot or drive is down. Pending requests appear in the
Device Monitor, and you can assign these mount requests to drives manually.

Resolving a pending request
Use the following procedure to resolve a pending request.

For ACS robots: If a request pends because the Library Storage Module (LSM) in
which the media resides is offline, no operator action is required. NetBackup retries
the requests hourly until the LSM is online. NetBackup reports the LSM offline status
in the Job Details dialog box. Open the Job Details dialog box from the Jobs tab
in the Activity Monitor.

To resolve a pending request

1 Insert the requested volume in a drive that matches the density of the volume
that was requested.

2 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

3 If you licensed a disk pool feature, select the Drives tab.

4 In the Pending Requests pane, select the request and note the contents of
the following columns of the request:

■ Density

■ External Media ID

■ Mode

5 In the Drive Status pane, find a drive type that matches the density for the
pending request.

6 Verify that the drive is up and not assigned to another request.

7 Select the drive.

8 Ensure that the drive and the pending request are on the same host.

9 If necessary, get the media, write-enable it, and insert it into the drive.
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10 Wait for the drive to become ready, as explained in the vendor’s drive equipment
manual.

11 On the Actions menu, select Assign Request.

12 Verify that the request was removed from the Pending Requests pane.

13 In the Drive status pane, verify the following:

■ The job request ID appears in the Request ID column for the drive

■ The User column is not blank

Resolving a pending action
A pending action is similar to a pending request. For a pending action, NetBackup
determines the cause of the problem and issues instruction to the operator to resolve
the problem.

A media icon identifies a pending action; the icon appears to the left of the request
ID. The icon includes a human hand, which depicts that a manual action is required.

Use the following procedure to resolve a pending action.

To resolve a pending action

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Pending Requests pane, select the pending action.

4 On theActionsmenu, selectDisplay Pending Action (on UNIX, you can also
double-click the pending action).

5 In the message box that describes the problem, review the list of possible
corrective actions. The message box also shows other information, such as
user name, recorded media ID, external media IDs, and drive number.

6 Click OK.

7 Correct the error condition and either resubmit the request or deny the request.

See “Resubmitting a request” on page 1136.

See “Denying a request” on page 1137.

Resubmitting a request
After you correct a problem with a pending action, you can resubmit the request.

Use the following procedure to resubmit a request.
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If the problem is a volume missing from a robot, first locate the volume, insert it into
the robot, and then update the volume configuration. Usually, a missing volume
was removed from a robot and then requested by NetBackup.

See “Robot inventory options” on page 571.

To resubmit a request

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Pending Requests pane, select the request.

4 On the Actions menu, select Resubmit Request.

Denying a request
Some situations may require that you deny requests for service. For example, when
a drive is not available, you cannot find the volume, or the user is not authorized
to use the volume. When you deny a request, NetBackup sends an appropriate
status message to the user.

Use the following procedure to deny a request.

To deny a request

1 In the NetBackup Administration Console, expand Media and Device
Management > Device Monitor.

2 If you licensed a disk pool feature, select the Drives tab.

3 In the Pending Requests pane, select the request.

4 On the Actions menu, select Deny Request.
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Reporting in NetBackup
This chapter includes the following topics:

■ About the Reports utility

■ Running a report

■ Copying report text to another document

■ Saving or exporting a report

■ Printing a report

About the Reports utility
Use the Reports utility in the NetBackup Administration Console to generate
reports to verify, manage, and troubleshoot NetBackup operations. NetBackup
reports display information according to job status, client backups, and media
contents. Use the Troubleshooter to analyze the cause of the errors that appear
in a NetBackup report.

In the Reports window, in the right pane, manage the report data or select a report
to run.
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Figure 29-1 Reports utility

1
2

3

4

Table 29-1 Reports utility

DescriptionNumber

The name of the currently selected master server.1

The user toolbar is specific to the Reports utility.2

Report descriptions.3

Right-click in the right pane to view the shortcut menu.4

NetBackup offers many different reports to view information about job activity and
media.

Table 29-2 NetBackup Reports

DescriptionReport name

The Status of Backups report shows status and error information about the jobs that completed
within the specified time period. If an error occurred, a short explanation of the error is included in
the report.

Status of
Backups

The Client Backups report shows detailed information about the backups that completed within the
specified time period.

Client
Backups
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Table 29-2 NetBackup Reports (continued)

DescriptionReport name

The Problems report generates a list of the problems that the server has logged during the specified
time period. The information in this report is a subset of the information that is obtained from the All
Log Entries report.

Problems

The All Log Entries report generates a list of all log entries for the specified time period. This report
includes the information from the Problems report andMedia Logs report. This report also displays
the transfer rate. The transfer rate is useful to determine rates and predict backup times for future
backups. (The transfer rate does not appear for multiplexed backups.)

All Log Entries

The Images on Media report generates a list of the media contents as recorded in the NetBackup
image catalog. You can generate this report for any type of media (including disk) and filter it according
to client, media ID, or path.

Images on
Media

The Media Logs report shows the media errors or the informational messages that are recorded in
the NetBackup error catalog.

Media Logs

The Images on Tape report generates the contents of the tape-based media as recorded in the
NetBackup image catalog. The Images on Tape is a subset of the Images on Media report.

Images on
Tape

The Tape Logs report displays all error logs related to tape-based backup and recovery. The Tape
Logs report is a subset of the Media Logs report.

Tape Logs

The Tape Contents report (formerly known as the Media Contents report) generates a list of the
contents of a volume as read directly from the media header and backup headers. This report lists
the backup IDs (not each individual file) that are on a single volume. If a tape must be mounted, the
delay is longer before the report appears.

Before running this report, you can choose to override the default job priority for the job. The default
priority is specified in the Default Job Priorities host properties.

Tape Contents

The Tape Summary report summarizes active and nonactive volumes for the specified media owner
according to expiration date. It also shows howmany volumes are at each retention level. In verbose
mode, the report shows each media ID and the expiration date.

Nonactive media are those with a status of FULL, FROZEN, SUSPENDED, or IMPORTED. Other
volumes are considered active.

Expired volumes with a status of FULL, SUSPENDED, or IMPORTED do not appear in the report.
However, expired volumes with a FROZEN status do appear in the report. NetBackup deletes other
expired volumes from the media catalog when it runs backups. An expired volume of a different
status can display if the report is run between the time the volume expires and the time that the next
backup is done.

Tape
Summary

The Tape Written report identifies the volumes that were used for backups within the specified time
period. The report also does not display the volumes that were used for duplication if the original
was created before the specified time period.

Tape Written
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Table 29-2 NetBackup Reports (continued)

DescriptionReport name

The Tape Lists report generates information about the volumes that are allocated for backups for
the selected media owner or media ID.

This report does not show media for disk type storage units. For the backups that are saved to disk
storage units, use the Images on Media report or the Images on Disk report.

Tape Lists

The Images on Disk report generates the image list present on the disk storage units that are
connected to the media server. The Images on Disk report is a subset of the Images on Media
report, showing only disk-specific columns.

Images on
Disk

The Disk Logs report displays all error logs related to disk-based backup and recovery. The Disk
Logs report is a subset of the Media Logs report.

Disk Logs

The Disk Storage Unit Status report displays the state of the disk storage units in the current
NetBackup configuration. (For example, the total capacity and the used capacity of the disk storage
unit.)

Multiple storage units can point to the same disk pool. When the report query searches by storage
unit, the report counts the capacity of disk pool storage multiple times.

Storage units that reference disk groups do not display capacity values.

Disk Storage
Unit Status

The Disk Pool Status report generates the details of one or more disk pools.Disk Pool
Status

See “Copying report text to another document” on page 1142.

For information about Vault reports, see the NetBackup Vault Administrator’s Guide.

Running a report
The following procedure describes how to run a NetBackup report from theReports
utility.
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To run a report

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports.

NetBackup runs the report for the master server that is currently selected. To
run a report on a different master server, on the File menu, click Change
Server.

See “Accessing remote servers” on page 1173.

2 In the left pane, click the name of the report you want to run.

For some reports, you must first expand a report group, and then click the
name of the report.

3 Select the criteria for what to include or exclude in the report. For example,
select the media servers and clients on which to run the report, and select the
time period that the report should span.

4 Click Run Report.

See “Copying report text to another document” on page 1142.

Copying report text to another document
The following procedure describes how to copy the text from a NetBackup report
and paste it into a spreadsheet or other document.

To copy report text to another document

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports.

2 In the left pane, double-click the name of the report you want to run.

For some reports, you must first expand a report group, and then click the
name of the report.

3 Select the criteria for what to include or exclude in the report, and click Run
Report.

4 Select the rows of the report you want to copy by holding down the Shift or
Ctrl key.

5 On the Edit menu, click Copy to Clipboard.

6 Paste the selected rows into a spreadsheet or other document.
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Saving or exporting a report
The following procedure describes how to save or export a NetBackup report.

To save or export a report

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports.

2 In the left pane, click the name of the report you want to run.

For some reports, you must first expand a report group, and then click the
name of the report.

3 Select the criteria for what to include or exclude in the report and click Run
Report.

4 On the File menu, click Export.

5 In the Save As dialog box, select the location where you want to save the
report, and specify the file name.

6 Click Save.

See “Copying report text to another document” on page 1142.

Printing a report
The following procedure describes how to print a NetBackup report.

To print a report

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports.

2 In the left pane, click the name of the report you want to run.

For some reports, you must first expand a report group, and then click the
name of the report.

3 Select the criteria for what to include or exclude in the report and click Run
Report.

4 On the File menu, click Print.
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Using the Logging
Assistant

This chapter includes the following topics:

■ About the Logging Assistant

■ Logging Assistant sequence of operation

■ Viewing the Logging Assistant records

■ Viewing the details of a Logging Assistant record

■ Adding or deleting a Logging Assistant record

■ Setting up debug logging

■ Set minimum debug logging

■ Disabling debug logging

About the Logging Assistant
The Logging Assistant is a helpful tool that can shorten the time that is required to
set up and collect debug logs and other information. Because Logging Assistant
automatically performs a number of functions, you can avoid the problems that are
associated with manually logging into NetBackup hosts, creating log directories,
and changing logging levels.

Note: Use the Logging Assistant under the guidance of Veritas Support.

The Logging Assistant uses a series of wizards to help quickly troubleshoot a
problem. Depending on the category of NetBackup problem, the tool suggests the
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possible hosts that may be involved in the problem and the logs that should be
enabled on those hosts.

Note:While collecting NetBackup logs using Logging Assistant, the total NetBackup
log size may increase. If you have enabled the Keep logs up to GB property on
theHost Properties > Logging dialog box and the total NetBackup log size reaches
its high water mark, logs are deleted. Logs that you want to retain may also be
deleted. To avoid the deletion of logs that you want to retain, you need to disable
theKeep logs up to GB property while you collect logs using the Logging Assistant.
Alternatively, you can set the Keep logs up to GB property to a value higher than
the current value, so that the important logs are not deleted before the log collection
is complete.

No special licensing is required. However, you must have root permissions for UNIX
and administrator privileges for Windows to use the Logging Assistant.

Table 30-1 shows a summary of the main Logging Assistant operations.

Table 30-1 Logging Assistant operations

DescriptionOperation

Add a Logging Assistant record that you use throughout the process of troubleshooting
a NetBackup problem. Typically, you associate the record that you create with a failed
job that appears in the Activity Monitor. A list of records appears when you select the
Logging Assistant node in the right pane of the NetBackup Administration Console.

See “Adding or deleting a Logging Assistant record” on page 1151.

Add a new Logging Assistant
record.

View the details for the selected record.View details.

After the failed job runs successfully, you can delete the Logging Assistant record.

See “Adding or deleting a Logging Assistant record” on page 1151.

Delete a Logging Assistant
record.

Use the Setup Debug Logging Wizard to enable selected NetBackup debug logs and
other processes that Technical Support uses to troubleshoot NetBackup problems.
Logging Assistant automatically creates the necessary log folders and sets the log
levels of the debug logs to the highest verbosity. (The highest log level of many of the
debug logs is 5).

See “Setting up debug logging” on page 1154.

Enable debug logging.
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Table 30-1 Logging Assistant operations (continued)

DescriptionOperation

Use the Set Minimum Debug Logging Wizard to set the specified process log levels
(verbosity) to a minimum value. This setting still allows info, warning, error, and critical
messages (legacy logging), and application logs, diagnostic logs, and some debug
logs (unified logging). You may want to set the debug logging to minimum values after
you resolve the job failure problem for the selected Logging Assistant record.

See “Set minimum debug logging” on page 1158.

Set minimum debug logging.

Use the Disable Debug Logging Wizard to disable the debug logging after you resolve
the job failure problem for the selected Logging Assistant record. The only logs that
NetBackup continues to generate are application logs and diagnostic logs.

See “Disabling debug logging” on page 1159.

Disable debug logging.

Use the Collect nbsu Output Wizard to gather the nbsu diagnostic information onto
the master server.

Collect nbsu output.

After you complete collection, you can cancel the operation if it is currently in progress
(for example, if the data is too large and the operation is time-consuming). Check that
the progress field of this record displays In progress, then right-click the Logging
Assistant record and select Cancel Operation.

Cancel operation.

Logging Assistant sequence of operation
Table 30-2 shows a typical procedure that uses the Logging Assistant to help
troubleshoot and solve a NetBackup problem.

Table 30-2 Steps for troubleshooting NetBackup problems

DescriptionActionStep

Create a Logging Assistant record to troubleshoot a NetBackup problem.
You normally associate the record with a failed job that appears in the Activity
Monitor.

See “Adding or deleting a Logging Assistant record” on page 1151.

Create a Logging Assistant
record.

Step 1

Use the Setup Debug Logging Wizard to enable selected NetBackup debug
logging that Technical Support uses to troubleshoot NetBackup problems.

See “Setting up debug logging” on page 1154.

Enable debug logging.Step 2

Go to the Activity Monitor and rerun the failed job. NetBackup generates the
debug logs that you have enabled.

See “Restarting a failed (completed) job in the Activity Monitor” on page 1103.

Rerun the failed job.Step 3
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Table 30-2 Steps for troubleshooting NetBackup problems (continued)

DescriptionActionStep

You can collect debug logs, nbsu diagnostics, and additional evidence.
Technical Support may want you to run the NetBackup Support Utility (nbsu)
first to get diagnostic information. You can also collect the evidence that
supports the debug logs and nbsu diagnostic information.

Collect data.Step 4

Work with Technical Support to read and analyze the debug logs, nbsu
diagnostics, and evidence, and correct any problems you detect.

Troubleshoot the problem.Step 5

After you take corrective actions, retry the operation. If the job still fails, work
with Technical Support to identify and enable additional debug logs using
the same Logging Assistant record. Repeat steps 2-6 until the job runs
successfully.

Rerun the failed job.Step 6

Disabling debug logging automatically removes the log directories and
disables all debug logging messages. Minimum debug logging disables all
messages except application logs and diagnostic logs.

See “Disabling debug logging” on page 1159.

See “Set minimum debug logging” on page 1158.

Disable or set minimum
debug logging.

Step 7

Remove the Logging Assistant record from the list of records.

See “Adding or deleting a Logging Assistant record” on page 1151.

Delete the record.Step 8

Viewing the Logging Assistant records
The Logging Assistant Recordsmain screen lists all the Logging Assistant records
that you create. The records are listed in the right pane of the NetBackup
Administration Console when you select the Logging Assistant node.

Figure 30-1 shows the Logging Assistant main screen containing one record.
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Figure 30-1 Logging Assistant

The details for the records (status, description, progress, and so on) are listed in
column format. This information is repeated for individual records when you select
View Details in the Actions menu.

Viewing the details of a Logging Assistant record
The Logging Assistant Recordsmain screen lists all the Logging Assistant records
that you create. The records are listed in the right pane of the NetBackup
Administration Console when you select the Logging Assistant node.

To view the details of a Logging Assistant record

1 In theNetBackupAdministrationConsole, in the left pane, select the Logging
Assistant node.

2 The right pane of the NetBackup Administration Console displays the list
of Logging Assistant records. Select the record that you want to view.

3 Select the record that you want details for.
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4 In the Actions menu, select View Details.

The Logging Assistant Record Details dialog box displays the following
information:

The record name that you enter in the New Logging Assistant
Record panel.

Logging Assistant
Record ID

The record description that you enter in the New Logging
Assistant Record panel.

Description

Yes: Debug logs are set up or enabled.Debug logs
currently enabled No: Debug logs are not set up or have been disabled or reset.
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The following are several of the possible states of the Logging
Assistant records:

Record created: You have added this record to the Logging
Assistant database by using the Add a New Logging Assistant
Record panel.

Debug logging set up: You have completed the Setup Debug
Logging Wizard for this record.

Debug Logging partially set up: You have set up debug logging
for all the selected hosts and processes by using the Setup Debug
Logging Wizard, but not all the hosts and processes have been
verified.

Debug logging set to minimum: You have completed the Set
Minimum Debug Logging Wizard for this record.

Debug logging disabled: You have completed the Disable Debug
Logging Wizard for this record.

Debug logs collected: You have completed the Collect Debug
Logs Wizard.

nbsu output collected: You have completed the Collect nbsu
Output Wizard.

Record status

The progress of the current activity being performed for the Logging
Assistant record.

Progress

The output location where the debug logs and other
troubleshooting information is collected.

Staging Directory

The date and time when you used the New Logging Assistant
Record panel to create this record.

Record creation
time

The date and time that you performed the most recent activity on
the record by using one of the Logging Assistant wizards.

Record last
modified
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The date and time when you completed the Setup Debug Logging
Wizard.

Debug logging set
up time

5 Click Associated Host and Logs to display the Associated Hosts and Logs
Details panel. The panel displays the selected hosts for the current record
which includes the master server, any media servers, any associated clients,
and a list of logs that are enabled on each host.

Adding or deleting a Logging Assistant record
Create a Logging Assistant record that you can use throughout the process of
troubleshooting a NetBackup problem.
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To create a new Logging Assistant record

1 In theNetBackupAdministrationConsole, in the left pane, select the Logging
Assistant node.

2 In the Actions menu, select New Logging Assistant Record.

3 In the Logging Assistant Record ID field, enter a unique descriptive name
for the new record. Use numeric, alphabetic, plus, minus, underscore, and
period characters. Do not use the minus (-) symbol as the first character or
leave spaces between characters.

Veritas recommends that you use the Support Case ID as the Logging
Assistant Record ID to more easily track the record through the troubleshooting
process.

4 In the optional Description field, enter a problem summary and the Job ID of
the failed job (if applicable).

5 Under Actions, select an action:
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■ Collect nbsu diagnostic information: Select this option to immediately
display the Collect nbsu Output Wizard when you leave this dialog. This is
often the first action to take after you create the Logging Assistant Record.

■ Setup debug logging: Select this option to immediately display the Setup
Debug Logging Wizard after you leave this dialog.
See “Setting up debug logging” on page 1154.

■ No action, only create a record: Select this option to return to the
NetBackup Administration Console after you click OK. The new record
appears in the console.

6 Click OK to create a Logging Assistant record in its database and add it to the
list of records in the Logging Assistant Records pane.

Deleting a Logging Assistant record
You can delete the Logging Assistant record if you no longer require it.

Warning: Before deleting the record, ensure that logging is disabled or set to
minimum.

To delete a Logging Assistant record

1 In theNetBackupAdministrationConsole, in the left pane, select the Logging
Assistant node.

2 The right pane of the NetBackup Administration Console displays the list
of Logging Assistant records. Select the record that you want to delete.
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3 In the Actions menu, select Delete Record. The Delete Logging Assistant
Record dialog box displays.

4 Click Yes to delete the selected Logging Assistant record.

Setting up debug logging
Use the Setup Debug LoggingWizard to enable selected NetBackup debug logging
that Technical Support uses to troubleshoot NetBackup problems. The Logging
Assistant automatically creates the necessary log folders and sets the verbosity of
the pertinent logs to their highest level.

Note: Ensure that each of the selected hosts contains enough available space for
the selected debug logs.

To set up debug logging

1 In the NetBackup Administration Console, select Logging Assistant in the
left pane.

2 In the right pane, select the Logging Assistant record for which you want to set
up debug logging. Select Actions > Setup Debug Logging.

3 Click Next on theWelcome panel.

4 On the Job Selection panel, select one of the following:

■ Enable the Analyze job to identify relevant hosts and debug logging
parameter, and then enter the Job ID. If you do not know the Job ID, go to
the Activity Monitor to find the Job ID of the failed job. The Logging Assistant
identifies the hosts and the pertinent debug logs related to the job.
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Based on the Job ID that you enter, the Logging Assistant identifies and
selects debug logs for hosts and processes that enable the most effective
troubleshooting of this problem. The wizard panels that follow this panel
show the processes that the Logging Assistant has selected.

■ For the following scenarios, skip this panel that sets up the logs based on
a Job ID, and click Next:

■ The problem does not involve a particular NetBackup job.

■ You already know the hosts and debug logs that you want to enable.

■ You want to enable the logs that you previously set up for this record.
Those log selections appear automatically in the panels that follow.

The following Host Selection panel appears:

5 Do one or more of the following:

■ Click Setup debug logging on Master Server to set up debug logging on
the master server. The Master Server text window displays the master
server.

■ Click Setup debug logging on Media Server(s) to set up debug logging
on the media servers. If the master server is also a media server, you may
still want to select it again as a media server. Use the right arrow option
(>>) to move a highlighted media server from theAvailable Media Servers
window across to the Selected Media Servers window.
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■ Click Setup debug logging on Client(s). Enter Client names. to set up
debug logging on clients. In the text window under this parameter, enter
the names of clients for which you want to set up debug logging. Separate
the client names by commas. Do not use any spaces between the client
names.

Click Next to display the panel.

Click Next to continue. Logging Assistant validates the specified hosts to
establish connectivity and validates the NetBackup versions that are installed
on the hosts.
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6 If you selected Setup debug logging on Master Server, the Setup Debug
Logging on Master Server panel appears.

This panel contains a list of problem categories on the master server and the
process names associated with each category of problem. Click the problem
category or categories that apply to the failed job.

For example, for problems with synthetic backups on the failed job, select
Backup - Synthetic. The debug logs for bpcd, bpdm, and bptm are enabled.

Click If required, specify additional components to set up debug logging
to enter components to enable debug logging. For example, for if you have
Java interface problems, but only want the debug logs for jnbSA, instead of all
four of the processes lists, enter jnbSA in the text window. Enter multiple
components separated by commas with no spaces between entries.

Technical Support publishes a list of valid components that you can specify in
this text box.

http://www.veritas.com/docs/TECH204256

Click Next to continue.

7 Perform the same actions for the media server (if selected in step 5) and the
clients (if selected in step 5).

Click Next to continue.
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8 TheSetupDebug Logging Summary panel confirms all the items you selected
in the previous panels of the Setup Debug Logging Wizard. Review the
information. The summary shows on which hosts of your NetBackup system
that you chose to enable logs: master server, media servers, and clients or a
combination of these items. It also shows the host names and the logs that are
enabled on each.

ClickNext to enable the debug logging. All pertinent logs are set to their highest
(most verbose) level.

9 The Setup Debug Logging Results panel displays the hosts and components
that have been successfully enabled and unsuccessfully enabled.

Click Finish to return to the Logging Assistant Records panel of the
NetBackup Administration Console.

Set minimum debug logging
The Set Minimum Debug Logging Wizard panel sets to minimum the logging levels
of the NetBackup debug logging that the Setup Debug Logging Wizard enabled.

Information about the logging levels that this wizard configures is available in the
following document:

http://www.veritas.com/docs/TECH204256

To set minimum debug logging

1 In theNetBackupAdministrationConsole, in the left pane, select the Logging
Assistant node.

2 The right pane of the NetBackup Administration Console displays the list
of Logging Assistant records. Select the record whose debug logging you want
to set to minimum.

3 In the Actions menu, select Set Minimum Debug Log. TheWelcome panel
for the Set Minimum Debug Logging Wizard appears.

Click Next to continue.
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4 The Set Minimum Debug Logging Selected Hosts and Processes panel
appears. Use this panel to confirm the host problem categories and processes
for all debug logs that were enabled. The hosts can be the master server, one
or more media servers, and one or more clients.

Click Next to continue.

5 The Set Minimum Debug Logging Results panel displays the results of the
reset operation. The upper window shows the hosts and processes whose
debug logs are successfully reset. The lower window shows the unsuccessful
debug logging resets.

Click Finish to complete the Set Minimum Debug Logging Wizard.

Disabling debug logging
The Disable Debug Logging Wizard disables the NetBackup debug logging that
the Setup Debug Logging Wizard enabled. A disabled debug log cannot generate
any logging messages.

To disable debug logging

1 In theNetBackupAdministrationConsole, in the left pane, select the Logging
Assistant node.

2 The right pane of the NetBackup Administration Console displays the list
of Logging Assistant records. Select the record whose debug logging you want
to disable.

3 In the Actions menu, select Disable Debug Logs. TheWelcome panel for
the Reset Logging Wizard appears.

Click Next to continue.

4 The Selected Hosts and Processes panel appears. Use this panel to confirm
the host problem categories and processes for all debug logs that were enabled.
The hosts can be the master server, one or more media servers, and one or
more clients.

Click Next to continue.

5 TheDisable Debug Logging Results panel displays the results of the disable
operation. The upper window shows the hosts and processes whose debug
logs are successfully disabled.

The lower window shows the results of the unsuccessful debug disable
attempts. Logs that other Logging Assistant records use cannot be disabled,
and are listed as unsuccessful in the lower window.

Click Finish to complete the Disable Logging Wizard.
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Management topics
This chapter includes the following topics:

■ Configuring the NetBackup Client Service

■ Units of measure used with NetBackup

■ NetBackup naming conventions

■ Wildcard use in NetBackup

■ Wildcard characters in backup selections for an NDMP policy

Configuring the NetBackup Client Service
By default, the NetBackup Client Service is configured on Windows with the Local
System account. The Local System account lacks sufficient rights to perform
certain backup and restore operations.

For example, for NetBackup to access CIFS volumes, the account must be changed
from Local System to an account with access to the CIFS share.

To change the NetBackup Client Service logon account on a Windows computer:

■ Open the Windows Services application.

■ To change the logon account, stop the NetBackup Client Service.

■ Open the properties for the NetBackup Client Service.

■ Provide the name and password of the account that has the necessary
permissions. For example, change the logon to that of Administrator.

■ Restart the service.

If the logon property is not changed for the NetBackup Client Service, the policy
validation fails with status code 4206.
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Situations in which the NetBackup Client Service logon
account requires changing
The following list contains situations in which the NetBackup Client Service logon
account needs to be changed:

■ To access CIFS storage for a storage unit.

■ To use UNC paths, the network drives must be available to the service account
that the NetBackup Client Service logs into at startup. You must change this
account on each Windows client that is backed up that contains data that is
shared with another computer.

■ During a snapshot: To have read access to the share for backup purposes and
write access during restores.
The account must be for a domain user that is allowed to access and write to
the share. To verify the account, log on as that user and try to access the UNC
path. For example: \\server_name\share_name.

■ For database agents and options, configure the service with a logon account
that has the necessary permission or privileges. See the documentation for your
agent or option for more information.

■ For the database agents that support VMware backups on a NetApp disk array,
configure the logon account to one that has access to the disk array.

Units of measure used with NetBackup
For most units of measure for data, NetBackup uses the terms and abbreviations
kilobyte (KB), megabyte (MB), and so on to mean the binary, or bitwise, values of
each term. NetBackup does not use the powers-of-ten values, such as 1,000 for
KB or 1,000,000 for MG.

When you calculate values that appear in NetBackup displays and reports, it is
important to understand the difference between a unit's binary value and its
powers-of-ten value. For example, a displayed value of 1.5TB actually means
1,649,267,441,664, bytes (the binary value) and not 1,500,000,000,000 bytes (the
powers-of-ten value), a difference of almost 150 billion bytes.

The following table shows a number of common displayed units of measure with
their corresponding bitwise names, binary multipliers, and actual values.

Table 31-1 Units of measure used in NetBackup

Actual value in bytesBinary multiplierBitwise unitDisplayed unit

10242^10Kebibyte (KiB)Kilobyte (KB)
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Table 31-1 Units of measure used in NetBackup (continued)

Actual value in bytesBinary multiplierBitwise unitDisplayed unit

10485762^20Mebibyte (MiB)Megabyte (MG)

10737418242^30Gibibyte (GiB)Gigabyte (GB)

10995116277762^40Tibibyte (TiB)Terabyte (TB)

11258999068426242^50Pebibyte (PiB)Petabyte (PB)

11529215046068469762^60Exbibyte (EiB)Exabyte (EB)

The Institute of Electrical and Electronics Engineers (IEEE) and the International
Electrotechnical Commission (IEC) have adopted standards for these values. See
the following articles for more information:

■ https://standards.ieee.org/standard/1541-2002.html (with a paid IEEE
subscription)
https://en.wikipedia.org/wiki/IEEE_1541-2002

■ https://en.wikipedia.org/wiki/ISO/IEC_80000

NetBackup naming conventions
NetBackup has rules for naming logical constructs, such as clients, disk pools,
backup policies, storage lifecycle policies, and so on. Generally, names are
case-sensitive. The following set of characters can be used in user-defined names
and passwords:

■ Alphabetic (A-Z a-z) (names are case-sensitive)

■ Numeric (0-9)

■ Period (.)

■ Plus (+)

■ Minus (-)
Do not use a minus as the first character.

■ Underscore (_)

These characters are also used for foreign languages.
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Note: No spaces are allowed.

The Logical Storage Unit (LSU) name or the Domain Volume name must have
fewer than 50 ASCII characters including a hyphen (-) and an underscore (_) and
must not have a blank space.

Wildcard use in NetBackup
NetBackup recognizes the following wildcard characters in areas where wildcards
can be used. (For example, in the paths of include and exclude file lists.)

The following table shows the wildcards that can be used in various NetBackup
dialog boxes and lists.

Table 31-2 Wildcard use in NetBackup

UseWildcard

An asterisk serves as a wildcard for zero or more characters.

An asterisk can be used in the backup selection list, the include list, and the exclude list for Windows and
UNIX clients.

For example:

r* refers to all files that begin with r

r*.doc refers to all files that begin with r and end with .doc.

To back up all files that end in .conf, specify:

/etc/*.conf

*

A question mark serves as a wildcard for any single character (A through Z; 0 through 9).

A question mark can be used in the backup selection list, the include list, and the exclude list for Windows
and UNIX clients.

For example:

file? refers to file2, file3, file4

file?? refers to file12, file28, file89

To back up all files named log01_03, log02_03, specify:

c:\system\log??_03

?

1164Management topics
Wildcard use in NetBackup



Table 31-2 Wildcard use in NetBackup (continued)

UseWildcard

A pair of square brackets indicates any single character or range of characters that are separated with
a dash.

For example:

file[2-4] refers to file2, file3, and file4

file[24] refers to file2, file4

*[2-4] refers to file2, file3, file4, name2, name3, name4

Brackets are not valid wildcards under all circumstances for all clients:

■ Brackets that are used as wildcards in include and exclude lists:
Windows clients: Allowed
UNIX clients: Allowed

■ Brackets that are used as wildcards in policy backup selections lists:
Windows clients: Not allowed; the use of brackets in policy backup selections lists causes backups
to fail with a status 71.
UNIX clients: Allowed

[ ]

Curly brackets can be used in the backup selection list, the include list, and the exclude list for UNIX
clients only.

A pair of curly brackets (or braces) indicates multiple file name patterns. Separate the patterns by commas
only; no spaces are permitted. A match is made for any or all entries.

For example:

{*1.doc,*.pdf} refers to file1.doc, file1.pdf, file2.pdf

Note: Curly brackets are valid characters for Windows file names and cannot be used as wildcards on
Windows platforms. Backslashes cannot be used as escape characters for curly bracket characters.

{ }

To use wildcard characters literally, precede the character with a backslash (\).

A backslash (\) acts as an escape character only when it precedes a special or a
wildcard character. NetBackup normally interprets a backslash literally because a
backslash is a legal character to use in paths.

Assume that the brackets in the following examples are to be used literally:

C:\abc\fun[ny]name

In the exclude list, precede the brackets with a backslash:

C:\abc\fun\[ny\]name
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Table 31-3 Placement of wildcards in the path of backup selections

ExamplesClient type

The following example is allowed:

C:\abc\xyz\r*.doc

Wildcard characters do not work elsewhere
in the path. For example, an asterisk functions
as a literal character (not as a wildcard) in the
following examples:

C:\*\xyz\myfile

C:\abc\*\myfile

For Windows clients, wildcards function
correctly only when they are placed at the
end of the path, in the file or the directory
name.

See “Pathname rules for Windows client
backups” on page 852.

The following examples are allowed:

/etc/*/abc/myfile

/etc/misc/*/myfile

/etc/misc/abc/*.*

For UNIX clients, wildcards can appear
anywhere in the path.

See “Pathname rules for UNIX client backups”
on page 859.

See “Backup Selections tab” on page 841.

Wildcard characters in backup selections for an
NDMP policy

You can use wildcard characters in regular expressions or the directive
ALL_FILESYSTEMS to specify path names in NDMP policy backup selections.

Wildcard characters in regular expressions or directives are valid for streaming and
non-streaming NDMP backups.
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Note: Directory-level expansion is not supported for some NDMP servers. Some
NDMP filer vendors do not have the APIs that NetBackup uses to support wildcard
characters lower than the volume level.

If you specify a backup selection using wildcard characters lower than the volume
level for these filers, status code 106 is generated. The following message is
displayed: Invalid file pathname found, cannot process request.

Currently, only NetApp filers support wildcard characters for backup selections
lower than the volume level. This support is not available in NetApp clustered Data
ONTAP version 8.2. To see the versions of NetApp Data ONTAP that support
wildcard characters for backup selections lower than the volume level, refer to the
NetBackup Master Compatibility List.

You cannot use any wildcard characters that also match file names. For example,
a backup selectionmight include /vol/vol_archive_01/autoit*. This specification
might match a path name such as /vol/vol_archive_01/autoit_01/. However,
if this specification also matches a file name like
/vol/vol_archive_01/autoit-v1-setup.exe, the backup job fails with status
code 99 because wildcards can specify only path names. The following message
is displayed: NDMP backup failure (99).

Table 31-4 Valid wildcard characters for NDMP policy backup selections

DescriptionWildcard character

Specifies a string match. For example:

/vol/vol_archive_*

This form of the path specification matches all paths that begin with the literal characters
/vol/vol_archive_ and end with any characters.

The string match wildcard can also specify multiple variable characters between literal
characters as in the following examples:

/vol/ora_*archive or /vol/ora_*archive*

/vol/ora_vol/qtree_*archive or /vol/ora_vol/qtree_*archive*

*

Specifies a single-character match.

/fs?

This path specification matches all paths that begin with the literal characters /fs and
end with any single character. For example, /fs1,/fs3, /fsa, /fsd and so on match
the specified pattern /fs?.

?
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Table 31-4 Valid wildcard characters for NDMP policy backup selections
(continued)

DescriptionWildcard character

Specifies an alphanumeric pattern match. For example:

/fs[1-9]

This path specification matches all paths that begin with the literal characters /fs and
end with any single numeric character from 1 through 9. For example, /fs1,/fs2,
and so on up to /fs9 match the specified pattern /fs[1-9]. However, /fs0 and
/fsa do not match the specified pattern; 0 is out of the specified numeric range, and
a is a non-numeric character.

The pattern match wildcard can also specify alphanumeric patterns such as
/fs[1-5a]. This specification matches /fs1, /fs2, and so on up to /fs5 as well
as /fsa.

Similarly, the pattern match wildcard can also specify patterns like /fs[a-p4]. This
specification matches /fsa, /fsb, and so on up to /fsp as well as /fs4.

You must use multiple backup selection specifications if the pattern can match more
than 10 volume names in a numeric series. For example, you may want to back up
110 volumes that begin with the literal characters /vol/ndmp and are numbered 1
through 110. To include these volumes in a backup selection with wildcards, specify
three backup selections with the following wildcard patterns:

■ /vol/ndmp[0-9]

This pattern matches any volume name that begins with /vol/ndmp and ends
with a single numeric character 0 through 9.

■ /vol/ndmp[0-9][0-9]

This pattern matches any volume name that begins with /vol/ndmp and ends
with the two-digit numeric characters 00 through 99.

■ /vol/ndmp[0-9][0-9][0-9]

This pattern matches any volume name that begins with /vol/ndmp and ends
with the three-digit numeric characters 000 through 999.

Do not specify /vol/ndmp[1-110] in this example. This pattern produces inconsistent
results.

[...]

Curly brackets can be used in the backup selection list and the
VOLUME_EXCLUDE_LIST directive for NDMP policies.

A pair of curly brackets (or braces) indicates multiple volume or directory name patterns.
Separate the patterns by commas only; no spaces are permitted. A match is made for
any or all entries.

For example:

{*volA,*volB} or {volA*,volB*}

{...}
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Note the following restrictions and behaviors regarding wildcard expressions:

■ Veritas recommends that you do not use a single forward-slash character (/)
in an NDMP policy backup selection. This method of including all the volumes
on an NDMP filer in the selection is not supported. Instead, use the
ALL_FILESYSTEMS directive:
See “ALL_FILESYSTEMS and VOLUME_EXCLUDE_LIST directives”
on page 869.

■ Nested wildcard expressions can result in recursive path name expansion
operations that can impact performance, especially for directories that have a
very large number of files or directories. An example of nested wildcard
expansion is as follows:
/vol/fome06/*/*private

■ Wildcard expressions do not span or include a path separator (/).

■ All backup selections that contain a wildcard expression must start with a path
separator (/). An example of a correct wildcard expression is as follows:
/vol/archive_*

An example of an incorrect wildcard expression is as follows:
vol/archive_*
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Accessing a remote server
This chapter includes the following topics:

■ Prerequisites for accessing a remote server

■ Accessing remote servers

■ Troubleshooting remote server administration

Prerequisites for accessing a remote server
In a NetBackup environment, you can use multiple NetBackup servers to perform
various administrative tasks.

For example, consider a NetBackup environment that contains two NetBackup
domains. Server_1 in one domain and Server_2 in the other. You can log into the
NetBackup Administration Console of Server_1 and then change to Server_2 to
administer Server_2. You must perform the following tasks before you can change
to a different server:

■ From one server, allow access to another server. See “Allow access to another
server” on page 1170.

■ Authorize users of one server to access another server. See “Authorize users
of one server to access another server” on page 1172.

To change to a different server, you can either specify the remote server on the
login screen or change to the server from within the NetBackup Administration
Console. See “Accessing remote servers” on page 1173.

Allow access to another server
For a local host to administer a remote server, the name of the local host must
appear in the server list of the remote server. Likewise, the remote host must include
the local host in its server list.
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Figure 32-1 assumes that server_1 wants to administer server_2.

Figure 32-1 Server lists on local server and remote server

Server_1 wants to
administer Server_2

Server_1 Server_2

Server list on Server_1
includes Server_2

Server list on Server_2
includes Server_1

To add a server to a server list

1 In theNetBackupAdministrationConsole, expandHost Properties >Master
Server.

2 Double-click the name of the server to view the properties.

3 Select the Servers tab to display the server list.

If the remote server does not appear in theAdditional Servers list, the current
server considers it invalid.

Currently, server_2 allows remote access
to two servers: server_x and server_y

4 To add a server to the server list, click Add.
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5 In the New Server dialog box, type the server name in the field.

6 Click Add to add the server to the list. Then, click Close to close the dialog
box. The server appears in the server list.

The bp.conf file on every UNIX server contains SERVER and possibly
MEDIA_SERVER entries. The server list in the Servers properties dialog box
represents these entries. Hosts that are listed as media servers have limited
administrative privileges.

7 Click OK to save the changes.

Authorize users of one server to access another server
You must explicitly authorize users of one server to access another server. Add
users of a server to the auth.conf file on the server that they are authorized to
access. In this example, authorize users of Server_1 to access Server_2. This task
must be performed on Server_2.
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Note: Add only the users that don't have administrative privileges on one server to
the auth.conf file on another server.

On UNIX, the auth.conf file is located at /usr/openv/java.

OnWindows, create the auth.conf file from the auth.conf.win.template file that
is located at C:\Program Files\Veritas\Java.

See “Authorization file (auth.conf) characteristics” on page 1179.

To authorize users of one server to access another server

◆ In the auth.conf file on Server_2, add users of Server_1 authorized to access
Server_2.

If Server_1 is a Windows host, add the following line in the auth.conf file:

For example, username ADMIN=ALL JBP=ALL

If Server_1 is a UNIX host, add the following line in the auth.conf file:

For example, root ADMIN=ALL JBP=ALL

Accessing remote servers
If a NetBackup site has multiple master servers, you can configure the systems so
that multiple servers can be accessed from one NetBackup Administration
Console.

If the server that you want to access is a media server or client, it must be
provisioned with a security certificate.

See “About security certificates for NetBackup hosts” on page 35.

Use the following procedure to access a remote server.

To access a remote server

1 Ensure that the remote server is accessible to the local server.

See “Allow access to another server” on page 1170.

2 Use one of the following methods to access a remote server:

■ Use the Change Server option:

■ Select any main node in the left pane of theNetBackup Administration
Console. (The option does not appear in the File menu unless a main
node is selected.)

■ Select the File > Change Server menu command.
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■ Click OK to launch a new console.

■ Enter the host name of another server.
Enter a user name and password and click Login.
If the user has the necessary permissions on both servers, the user can
transition from one to another without setting up trust relationships.
If server_1 is not listed on the server list of server_2, server_1 receives
an error message after it tries to change servers to server_2.
If the user has administrative privileges on one server and different
privileges on another server, the user is required to reauthenticate.

■ Specify the remote server on the login screen:
Enter the host name of the remote server.
Enter the user name and password for an authorized NetBackup
administrator, then click Login.

To log in to a different
server, specify the name
of the remote host in the
login screen

Troubleshooting remote server administration
To administer a server from another master server, make sure that the following
conditions are met:

■ The destination server is operational.

■ NetBackup daemons are running on both hosts.

■ The network connection is valid.

■ The user has administrative privileges on the destination host.

■ To perform a Change Server operation, all servers should be at the same
version.
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■ The current host is listed in the server list of the destination host.
See “Allow access to another server” on page 1170.
The host does not need to be listed if the host is a media server or a client. Or,
it does not need to be listed if only media and device management or monitoring
is to take place.
If you change the master server list, stop and restart the NetBackup Database
Manager (bpdbm) and NetBackup Request Daemon (bprd) to ensure that all
appropriate NetBackup processes use the new server entry.

■ Authentication is set up correctly, if used.

■ To perform a Change Server operation to a media server or client, the media
server or client must have a security certificate installed.

■ For problems changing servers to configure media or devices or monitor devices,
verify that the NetBackup Volume Manager is running on that server.

■ If you cannot access devices on the remote host, it may be necessary to add a
SERVER entry to the vm.conf file on that host.
See the NetBackup Administrator’s Guide, Volume II for instructions.

■ If you cannot start or stop processes or services through the Activity Monitor,
verify the following:

■ The remote server is a Windows system. Only on other Windows systems
can processes be monitored and controlled.

■ You have the required permissions on the remote server. Windows security
must allow access to the user that is running the Activity Monitor.
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Using the NetBackup
Remote Administration
Console

This chapter includes the following topics:

■ About the NetBackup Remote Administration Console

■ About authorizing NetBackup users

■ Authorization file (auth.conf) characteristics

■ About authorizing nonroot users for specific applications

■ About authorizing specific tasks in the Backup, Archive, and Restore user
interface

■ Run-time configuration options for the NetBackup Administration Console

■ About improving NetBackup performance

■ About adjusting time zones in the NetBackup Administration console

About the NetBackup Remote Administration
Console

The NetBackup Remote Administration Console is a stand-alone Java-based
administration console. This console is installed on a host that does not have
NetBackup server software. It is used to monitor NetBackup servers remotely.
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Installing this console installs the NetBackup Administration Console. The
presence of the client software enables the computer to be backed up like any other
client. No master server software or media server software is installed.

NetBackup includes an administration console for all the supported versions of
NetBackup. Select the version of the console that is compatible with the NetBackup
server that you want to administer.

For information about supported versions of NetBackup, see the following website:

https://sort.veritas.com/eosl.

Note: To upgrade any of the multiple versions of consoles to a patch, you must
first install the base version of the Remote Administration Console. Use the installer
of the base version to install the Remote Administration Console. You must then
upgrade to the corresponding patch of the Remote Administration Console.

Upgrading directly to a patch version of the NetBackup Administration Console
from the multiple versions of the consoles is not supported.

These processes can be run on two different NetBackup hosts. This distributed
application architecture holds true for the Backup, Archive, and Restore client
interface (jbpSA) on UNIX platforms as well.

The administrator first starts the NetBackup Administration Console using one
of the following methods:

■ Select Start > Programs > Veritas NetBackup > NetBackup 8.x
Administration Console on the Windows computer on which the NetBackup
Remote Administration Console is installed.

■ Run the jnbSA command on a UNIX computer where NetBackup is installed.

Then the administrator logs on to the application server on the host that is specified
in the logon dialog box.

The application server is the host that is specified in theNetBackup Administration
Console logon dialog box and authenticates the logon credentials of the user. The
credentials are authenticated by using standard UNIX user account data and
associated APIs.

Note: The host that is specified in the logon dialog box and the system that runs
the NetBackup Administration Console must run the same NetBackup version.

Note: To log on to anyNetBackup Administration Console, your logon credentials
must be authenticated from the connecting master or media server.
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Figure 33-1 NetBackup logon dialog box

Application server

The user name and
password must be valid on
the application server.

The server that is usually the object of all administrative tasks is the host that is
specified in the NetBackup Administration Console logon dialog box.

An exception is the use of the File > Change Server capability in the NetBackup
Administration Console. The Change Server capability allows administration of
a remote server (a server other than the one specified in the NetBackup
Administration Console logon dialog box).

Note: To perform a Change Server operation, all servers should be at the same
version.

Regardless of which server is administered, all administrative tasks that are
performed in the NetBackup Administration Console make requests of the
application server. All tasks are run on the application server host, whether the
server is remote or whether the server is specified on the logon dialog box.

However, regardless of which NetBackup authorization method is configured,
authorization for tasks in the NetBackup Administration Console is specific to
the server being administered. For example, NetBackup authorization capabilities
are in use on Host_A. Use Change Server to change to Host_B. The permissions
are honored as configured in the auth.conf on Host_B.

To administrate from a remote server, the application server host must be included
in the server list of the remote server.

See “Allow access to another server” on page 1170.

See “Accessing remote servers” on page 1173.
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About authorizing NetBackup users
Users who have root or administrator access on the NetBackup master server are
authorized to use all of the NetBackup applications on a NetBackup host. Other
users are allowed to access only the Backup, Archive, and Restore interface.

For the NetBackup web user interface (web UI), you can authorize other users by
creating access rules for those users using RBAC. See the NetBackup Web UI
Guide for the Security Administrator.

For the Administration Console, you can use the auth.conf file to grant users
access to specific NetBackup applications.

See “About authorizing nonroot users for specific applications” on page 1181.

Authorization file (auth.conf) characteristics
By default, the authorization file or auth.conf file grants access for the following:

Administrator applications and capabilities for the root user. User
backup and restore capabilities for all other users.

On NetBackup
servers

User backup and restore capabilities for all users.OnNetBackup clients

Auth.conf file location

auth.conf.win.template ininstall_path\NetBackup\Java

Use this template file to create an auth.conf file at the same
location. The template file contains an example of giving permissions
to a user.

Windows NetBackup
servers

auth.conf in install_path/NetBackup/Java

Contains the following entries:

root ADMIN=ALL JBP=ALL
* ADMIN=JBP JBP=ENDUSER+BU+ARC

UNIX NetBackup
servers

Configuring the auth.conf file
Configure the auth.conf file as follows:

■ If the auth.conf file exists, it must contain an entry. Provide an entry for each
user or use an asterisk (*) to indicate all users. Users without entries in the file
cannot access any NetBackup applications.
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■ Entries for specific users must be listed first, followed by any entries with an
asterisk (*).

■ Use the first field of each entry to indicate the user name that is granted or
denied access rights. Use an asterisk to indicate any user name.

■ The remaining fields specify the specific access rights for the user or users. You
cannot use an asterisk (*) authorize all users for all applications. Each user (or
all users) must have specific application keywords. To deny all capabilities to a
specific user, do not provide any keywords for the interface. For example:

mydomain\ray ADMIN= JBP=

Specifies the applications that the user can access. ADMIN=ALL allows access to all
NetBackup applications and the related administrator-related capabilities.

See “About authorizing nonroot users for specific applications” on page 1181.

ADMIN keyword

Specifies what the user can do with the Backup, Archive, and Restore client application
(jbpSA). JBP=ALL allows access to all Backup, Archive, and Restore capabilities, including
those for administration.

See “About authorizing specific tasks in the Backup, Archive, and Restore user interface”
on page 1182.

JBP keyword

An asterisk in the first field indicates that any user name is accepted and the user is allowed
to use the applications as specified. The second line of the released version contains an
asterisk in the first field. The asterisk means that NetBackup validates any user name for
access to the Backup, Archive, and Restore client application jbpSA.
JBP=ENDUSER+BU+ARC allows users to back up, archive, and restore files only.

Asterisk (*)

User authentication
The credentials that are entered in the logon screen must be valid on the computer
that is specified in the host field. The NetBackup application server authenticates
with the specified computer. The user name is the account used to back up, archive,
or restore files. To perform remote administration or user operations with jbpSA, a
user must have valid accounts on the NetBackup UNIX server or client computer.
The Backup, Archive, and Restore application (jbpSA) relies on system file
permissions of when to browse directories and files to back up or restore.

The password must be the same password that was used upon logon at that
computer. For example, assume you log on with the following information:

username = joe

password = access

You must use this same user name and password to log into NetBackup.
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You can log on to the NetBackup application server under a different user name
than the name used to log on to the operating system. For example, if you log on
to the operating system with a user name of joe, you can subsequently log on to
jnbSA as root.

Application state information
Upon exit, some application state information is automatically saved in the directory
of joe $HOME/.java/.userPrefs/vrts directory. (For example, table column order.)
The information is restored the next time you log on to the operating system under
account joe and initiate the NetBackup application. This logon method is useful if
there is more than one administrator because it saves the state information for each
administrator.

Note: NetBackup creates a user’s $HOME/.java/.userPrefs/vrts directory the
first time an application is exited. Only NetBackup applications use the
.java/.userPrefs/vrts directory.

About authorizing nonroot users for specific
applications

Nonroot users can be authorized for a subset of the NetBackup administrator
applications.

To authorize users for a subset of the NetBackup administrator applications, use
the following identifiers for the ADMIN keyword in the auth.conf file:

Indicates that the user has administrative privileges for all of the
applications that are listed in this table.

ALL

Activity MonitorAM

Bare Metal RestoreBMR

Backup Policy ManagementBPM

Backup, Archive, and RestoreBAR or JBP

CatalogCAT

Device MonitorDM

Host PropertiesHPD

Media ManagementMM
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ReportsREP

Security ManagementSM

Storage Unit ManagementSUM

Vault ManagementVLT

For example, to give a user (user1) access only to the Device Monitor and Activity
Monitor, add the following entry to the auth.conf file:

user1 ADMIN=DM+AM

About authorizing specific tasks in the Backup,
Archive, and Restore user interface

The Backup, Archive, and Restore interface can be configured to let only a user
perform certain tasks. Not all tasks can be performed successfully without some
additional configuration.

The following require additional configuration and are documented elsewhere:

■ Redirected restores.
See “About server-directed restores” on page 1206.
See “About client-redirected restores” on page 1207.

■ User backups or archives require a policy schedule of these types and the task
to be submitted within the time window of the schedule.

To authorize users for a subset of Backup, Archive, and Restore capabilities, use
the following identifiers for the JBP keyword in the auth.conf file:

Table 33-1 Identifiers for the JBP keyword in the auth.conf file

DescriptionIdentifier

Allows the users to perform restore tasks from true image or regular backups plus redirected restores.ENDUSER

Allows the users to perform backup tasks.BU

Allows the users to perform archive tasks. The capability to perform backups (BU) is required to
allow archive tasks.

ARC

Allows the users to perform raw partition restores.RAWPART
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Table 33-1 Identifiers for the JBP keyword in the auth.conf file (continued)

DescriptionIdentifier

Allows the users to perform all actions, including server-directed restores. (Restores to a client that
is different from the client that is logged into.) Server-directed restores can only be performed from
a NetBackup master server.

ALL

For example, to allow a user (user1) to restore but not backup up or archive files:

user1 ADMIN=JBP JBP=ENDUSER

Run-time configuration options for the NetBackup
Administration Console

OnWindows computers, the analogous file containing configuration options for the
NetBackup Administration Console is install_path\java\setconf.bat

OnUNIX computers, file /usr/openv/java/nbj.conf contains configuration options
for the NetBackup Administration Console. Enter one option per line, following
the same syntax rules as exist for the bp.conf file.

nbj.conf and setconf.bat contain commands for each of the configuration options
that are described in the following topics. To make changes, change the value after
the equal sign in the relevant set command.

FIREWALL_IN
The FIREWALL_IN configuration option provides a method to use a NetBackup
Administration Console that is outside of a trusted network to administer the
NetBackup master servers that are within a trusted network.

This option uses the following format.

On Windows:

SET FIREWALL_IN=

HOST1:PORT1=HOST2:PORT2;IP_ADDR1:PORT3=IP_ADDR2:PORT4

SET FIREWALL_IN >> "%NBJDIR%"\nbjconf

On UNIX:

FIREWALL_IN= HOST1:PORT1=HOST2:PORT2[;...;HOSTn:PORTn=HOSTm:PORTm]

Where HOST is a host name or an IP address.
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This configuration option provides a way to allow administrators to bypass the
firewall by using one of the following methods:

■ Enter the port number of the bpjava service in the trusted internal network.
Then, map the private interface where the bpjava service runs to a public
interface that can be reached from outside the firewall.

■ Set up a Secure Shell (SSH) tunnel from the local host to the system inside the
firewall.

In the following example:

■ Master server NBMaster.abc.com is in a trusted network, behind a firewall.

■ The IP address of NBMaster.abc.com is 10.221.12.55.

■ The NetBackup Administration Console is installed on localhost.

■ SSH tunnels exist from localhost to NBMaster.abc.com as follows:

localhost:port1bpjava-msvc port (default 13722)

localhost:port2vnetd port (default 13724)

localhost:12345pbx port (default 1556)

Where localhhost is the host name and port1 is the IP port.

To make relevant changes for connections to bpjava-msvc and vnetd, see the
following topic:

See “VNETD_PORT” on page 1189.

On Windows systems, use setconf.bat to add the option:

SET FIREWALL_IN=

NBMaster.abc.com:1556=localhost:12345;10.221.12.55:12345=localhost:12345

SET FIREWALL_IN >> "%NBJDIR%"\nbjconf

On UNIX systems, add the following line to the nbj.conf file:

FIREWALL_IN=NBMaster.abc.com:1556=localhost:12345;10.221.12.55:12345=localhost:12345

The entry indicates the following:

■ The connection to NBMaster.abc.com:1556 is to be redirected to localhost:12345.

■ The connection to 10.221.12.55:1556 is to be redirected to localhost:12345.
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Note: The same options are used if NBMaster.abc.com has a public interface
(NBMasterpub.abc.com) that can be reached from the Internet. In this case, the
administrator replaces localhost with NBMasterPub.abc.com.

FORCE_IPADDR_LOOKUP
The FORCE_IPADDR_LOOKUP configuration option specifies whether NetBackup
performs an IP address lookup to determine if two host name strings are indeed
the same host. This option uses the following format:

FORCE_IPADDR_LOOKUP = [ 0 | 1 ]

Where:

Indicates that no IP address lookup is performed to determine if two host name strings
are indeed the same host. They are considered to be the same host if the host name
strings compare equally. Or, if a short name compares equally to the short name of a
partially or fully qualified host name.

0

Indicates that an IP address lookup is performed if the two host name strings do not
match. The lookup determines if they have the same host. The default is to perform
an IP address lookup if necessary to resolve the comparison. The IP address lookup
is not performed if the host name strings compare equally.

1

Note:Use a value of 1 for this option if you have the same host name in two different
domains. For example, eagle.abc.xyz and eagle.def.xyz or by using host name
aliases.

Many places in the NetBackup Administration Console compare host names to
determine if the two are the same host. For example, the File > Change Server
command.

The IP address lookup can consume time and result in slower response time.
However, accurate comparisons are important.

No IP address lookup is necessary if the host name is specified consistently in the
NetBackup Administration Console logon dialog box. It must match how the host
names are configured in NetBackup. Host names are identified in the server list
that is found in the Servers host properties. On UNIX systems, the host names
also appear in the bp.conf file.

Using host names eagle and hawk, the following describes how this option works:
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Comparisons of the following result in no IP address lookup. The hosts are
considered to be the same host.

eagle and eagle
eagle.abc.def and eagle.abc.def
eagle.abc and eagle.abc.def
eagle and eagle.abc.def
eagle and eagle.anything

The hosts are considered to be different for any comparisons of short,
partially, or fully qualified host names of eagle and hawk regardless of aliases.

FORCE_IPADDR_LOOKUP = 0

Comparisons of the following result in no IP address lookup. The hosts are
considered to be the same host.

eagle and eagle
eagle.abc and eagle.abc
eagle.abc.def and eagle.abc.def

In addition to all comparisons of eagle and hawk, the following result in an
IP address lookup. The comparison determines if the hosts are indeed the
same host.

eagle.abc and eagle.abc.def
eagle and eagle.abc.def
eagle and eagle.anything

FORCE_IPADDR_LOOKUP = 1

INITIAL_MEMORY, MAX_MEMORY
Both INITIAL_MEMORY and MAX_MEMORY allow configuration of memory usage for
the Java Virtual Machine (JVM).

Veritas recommends that all of the interfaces (theRemote Administration Console,
the NetBackup Administration Console, or the NetBackup Backup, Archive,
and Restore user interface) run on a system that contains at least 1 gigabyte of
physical memory. Make sure that 512 megabytes of memory are available to the
application.

INITIAL_MEMORY specifies how much memory is allocated for the heap when the
JVM starts. The value probably does not require changing. The default is sufficient
for quickest initialization of jnbSA, the Remote Administration Console, or jbpSA
on a system with the recommended amount of memory.

On UNIX systems, the initial memory allocation can also be specified as part of the
jnbSA or jbpSA command. For example:

jnbSA -ms 256M
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Default = 256M (megabytes).

MAX_MEMORY specifies the maximum heap size that the JVM uses for dynamically
allocated objects and arrays. If the amount of data is large, consider specifying the
maximum heap size. For example, a large number of jobs in the Activity Monitor.

On UNIX systems, the maximum memory allocation can also be specified as part
of the jnbSA or jbpSA command. For example:

jnbSA -mx 512M

Default = 512M (megabytes).

MEM_USE_WARNING
The MEM_USE_WARNING configuration option specifies the percent of the memory
that is used as compared to MAX_MEMORY, at which time a warning dialog box
appears to the user. Default = 80%. This option uses the following format:

MEM_USE_WARNING=80

NBJAVA_CLIENT_PORT_WINDOW
The NBJAVA_CLIENT_PORT_WINDOW configuration option specifies the range of
non-reserved ports on this computer to use for connecting to the NetBackup
application server. It also specifies the range of ports to use to connect to the bpjobd
daemon from the Activity Monitor in the NetBackup Administration Console.

This option uses the following format:

NBJAVA_CLIENT_PORT_WINDOW = n m

Where:

Indicates the first in a range of non-reserved ports that are used for connecting to the bpjava processes on
the NetBackup application server. It also specifies the range of ports to use to connect to the bpjobd daemon
or Windows service from the Activity Monitor of the Remote Administration Console.

If n is set to 0, the operating system determines the non-reserved port to use (default).

n

Indicates the last in a range of non-reserved ports that are used for connecting to theNetBackup Administration
Console or the Remote Administration Console.

If n and m are set to 0, the operating system determines the non-reserved port to use (default).

m

The minimum acceptable range for each user is 120. Each additional concurrent
user requires an additional 120. For example, the entry for three concurrent users
might look as follows:
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NBJAVA_CLIENT_PORT_WINDOW = 5000 5360

If the range is not set wide enough, jnbSA exits with an error message that states
an invalid value has occurred during initialization.

Note: Performance is reduced with the use of NBJAVA_CLIENT_PORT_WINDOW.

NBJAVA_CORBA_DEFAULT_TIMEOUT
The NBJAVA_CORBA_DEFAULT_TIMEOUT configuration entry specifies the default
timeout that is used for most CORBA operations that theNetBackupAdministration
Console performs.

This option is present by default and uses the following format:

NBJAVA_CORBA_DEFAULT_TIMEOUT=60

The default is 60 seconds.

NBJAVA_CORBA_LONG_TIMEOUT
The NBJAVA_CORBA_LONG_TIMEOUT configuration entry specifies the timeout value
that the NetBackup Administration Console uses in the following areas:

■ Device Configuration Wizard

■ Disk Pool Configuration Wizard

■ Disk Pool Inventory

This option is present by default and uses the following format:

NBJAVA_CORBA_LONG_TIMEOUT=1800

The default is 1800 seconds.

NETBACKUP_API_CLIENT_CONNECTION_TIMEOUT
The NETBACKUP_API_CLIENT_CONNECTION_TIMEOUT configuration option specifies
the default timeout value that the NetBackup Administration Console uses while
it establishes a connection with the NetBackup web API server.

This option is present by default and uses the following format:

NETBACKUP_API_CLIENT_CONNECTION_TIMEOUT=180

The default is 180 seconds.
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See “NETBACKUP_API_CLIENT_READ_TIMEOUT” on page 1189.

NETBACKUP_API_CLIENT_READ_TIMEOUT
The NETBACKUP_API_CLIENT_READ_TIMEOUT configuration option specifies the
default timeout value that the NetBackup Administration Console uses when it
requests the data from the NetBackup web API server.

This option is present by default and uses the following format:

NETBACKUP_API_CLIENT_READ_TIMEOUT=1800

The default is 1800 seconds.

See “NETBACKUP_API_CLIENT_CONNECTION_TIMEOUT” on page 1188.

PBX_PORT
The PBX_PORT configuration entry specifies the pbx port.

This option is present by default and uses the following format:

PBX_PORT=1556

VNETD_PORT
The VNETD_PORT is the configured port for the vnetd daemon process and is
registered with the Internet Assigned Number Authority (IANA).

This option uses the following format:

VNETD_PORT=13724

Veritas recommends that this port not be changed. If changes are necessary, make
the change on all NetBackup hosts in the relevant NetBackup cluster.

This option is preserved for backward compatibility when the 7.0.1 NetBackup
Administration Console is used to communicate with a 7.0 NetBackup server.

For more information, see the NetBackup Installation Guide.

The value must be set in the corresponding setconf.bat (Windows) or nbj.conf
(UNIX) configuration option.

About improving NetBackup performance
The most important factor to consider concerning performance issues for the
following interfaces is the platform on which the console runs:
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■ Remote Administration Console

■ NetBackup Administration Console

■ NetBackup Backup, Archive, and Restore user interface

Regardless of the platform, you can run the administration console from one of the
following locations:

■ Run it locally on a desktop host (on supported Windows and UNIX platforms)

■ Run it remotely and display it back to a desktop host (from supported UNIX
platforms)

To provide the best performance, the recommendedmethod for using these consoles
is to run the consoles locally on a desktop host. When the consoles are run locally,
they do not exhibit the font and the display issues that can be present in some
remote display-back configurations.

About running the NetBackup Administration Console locally
On Windows platforms, select Start > Programs > Veritas NetBackup >
NetBackup 8.x Administration Console to start the console.

On supported UNIX platforms, the console is run locally if jnbSA or jbpSA is entered
on the same host on which the console appears. That is, your display environment
variable is set to the host on which the jnbSA or jbpSA commands were entered.

Improvements in Java technology have made remote X-display back potentially
viable on some platforms. However, problems continue with certain controls in the
consoles. For example, incorrect box operations, sluggish scrolling, and display
problems in tables with many rows. More serious issues have also occurred.
Consoles can abort and hang because of a Java Virtual Machine (JVM) failure
when run in this mode on some platforms. Therefore, Veritas cannot recommend
running the consoles in a remote X-display back configuration.

About running a console locally and administering a remote server
TheNetBackup Administration Console and theBackup, Archive, and Restore
user console are distributed applications. Both applications consist of two major
and separate system processes that can run on different computers. For example:
the NetBackup Administration Console on one computer and the console’s
application server - bpjava processes on another computer.

The NetBackup Administration Console does not need to run on a NetBackup
server host. However, the application server must run on this host in order for you
to be able to administer NetBackup.
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Although the NetBackup Administration Console does not run on all
NetBackup-supported platforms, the application server for the console does run on
all supported platforms. The distributed application architecture enables direct
administration of all NetBackup platforms, even though the consoles themselves
run only on a subset of the NetBackup-supported platforms.

To log into the NetBackup Administration Console, specify a host name. The
host name is the computer where the application server (bpjava) runs. (For example,
a NetBackup master server.) All requests or updates that are initiated in the console
are sent to its application server that runs on this host.

Enhancing console performance
Performance of the NetBackup applications depends on the environment where
the applications are running, including available resources and network throughput.
The NetBackup default configuration, specifically the INITIAL_MEMORY and
MAX_MEMORY configuration options, assumes sufficient memory resources on the
computer where the console is running. For example, where the jnbSA command
is run or the NetBackup Administration Console is started.

Following are guidelines for improving performance:

■ Consider the network communication speed and the amount of data being
transferred.

■ Consider the amount of work being performed on the relevant computers.
Run NetBackup on a computer that has a low level of activity. For example,
there can be large differences in response time when other memory-intensive
applications are running on the computer. (For example, web browsers.) Multiple
instances of NetBackup on the same computer has the same effect.

■ Run NetBackup on a 1-gigabyte computer that has at least 256 MB of RAM
available to the application. In some instances, the application does not initiate
due to insufficient memory. A number of messages identify these failures in the
xterm window where the jnbSA command was run. Or, the messages appear
in the application log file. Possible messages include the following:

Error occurred during initialization of VM

Could not reserve enough space for object heap

Out of Memory

See “INITIAL_MEMORY, MAX_MEMORY” on page 1186.

■ Consider the amount of physical memory on the relevant computers. Possibly
add memory on the host being administered (the console’s application server
host).
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■ Consider increasing the swap space to relevant computers:

■ The console host (the host where the console is started)

■ The host being administered
To increase performance, increase the amount of swap space available to the
system where you are running the applications. This is especially true if there
is a great deal of other activity on the computer. More swap space can alleviate
hangs or other problems that relate to insufficient memory for the applications.

■ Consider additional or faster CPUs to relevant computers:

■ The console host (the host where the console is started)

■ The host being administered

■ Consider limiting the amount of NetBackup data that is retained for long periods
of time to only that which is necessary. For example, do not retain successfully
completed jobs for more than a few hours.
See “About the jobs database” on page 1127.

Determining better performance when the console is run locally or
uses remote display back

Performance depends on the following:

■ The speed of the network

■ The console and the application server computer resources

■ The workloads on the console

■ The application server hosts

■ The amount of NetBackup data (Data is the number of jobs in the Activity Monitor
or number of NetBackup policies.)

The console may perform better if started on the console’s application server host,
then displayed back to the desktop host. However, Veritas is not aware of a situation
where that configuration produces better console performance. As previously
mentioned, the configuration is not recommended due to problems unrelated to
performance issues.

Consider the following scenarios to determine what would provide the best
performance for your configuration.

NetBackup performance scenario 1
Assume no deficiency in either the console host’s resources or the application
server host’s resources. Assume that the amount of NetBackup configuration data
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being transferred to the console host far exceeds the X-Windows pixel display data.
That is, the actual console screen being sent from the remote host.

Unfortunately, the only way to determine the viability of this situation is to try it.
Network capabilities and the proximity of the two hosts influences each NetBackup
configuration.

NetBackup performance scenario 2
Assume that the available resources of the application server host far exceed that
of the console host.

Assume that the console host has a very limited CPU and memory as compared
to the NetBackup master server being administered. (The console host is the
computer on which the console is started.) If the console is run on the master server
and displayed back to the desktop host, performance may be enhanced.

If the desktop host is a Windows computer, X-terminal emulation or remote display
tools such as Exceed and VNC are required.

These scenarios address the performance aspect of using the NetBackup console.
There may be other reasons that require you to display back remotely to your
desktop, however, it is not recommended. Review the release notes for additional
issues of relevance to the NetBackup Administration Console and the Backup,
Archive, and Restore client console.

Table 33-2 shows the files that contain configuration entries.

Table 33-2 Files containing configuration entries

DescriptionFile

Authorization options./usr/openv/java/auth.conf

Configuration options (server and client)./usr/openv/netbackup/bp.conf

Configuration options for the NetBackup
Administration Console

/usr/openv/java/nbj.conf

Configuration options for media and device
management.

/usr/openv/volmgr/vm.conf

Configuration options for user (on client).$HOME/bp.conf
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About adjusting time zones in the NetBackup
Administration console

Sites in a geographically dispersed NetBackup configuration may need to adjust
the time zone in the NetBackup Administration Console for administration of
remote NetBackup hosts. (A remote NetBackup host may either be the host that is
specified in the administration console logon dialog box or one referenced by the
File > Change Server capability in the console.)

The default time zone for the console is that of the host on which the console is
started, not the host that is specified (if different) in the console logon dialog box.

For backup, restore, or archive operations from within the NetBackup
Administration Console or the Backup, Archive, and Restore application when
run on a client, set the time zone relative to the NetBackup server from which the
client restores files.

Set the time zone in separate instances of theNetBackup Administration Console
when servers in different time zones are administered.

For example, open a NetBackup Administration Console to set the time zone
for the local server in the Central time zone. To set the time zone for a server in
the Pacific time zone as well, open another NetBackup Administration Console.

Change servers (File > Change Server), and then set the time zone for the Pacific
time zone server. Doing so changes the time zone for the Central time zone server
as well.

To perform aChange Server operation to a media server or client, the media server
or client must have a security certificate installed.

Adjusting the time zone in the NetBackup Administration Console or
the Backup, Archive, and Restore console

Use the following procedure to adjust the time zone or to use daylight savings time.

To adjust the time zone

1 In the NetBackup Administration Console, or in the Backup, Archive, and
Restore console box, select File > Adjust Application Time Zone.

2 Select the Standard tab.

3 Clear the Use custom time zone check box.

4 Select the time zone.

5 For daylight savings time, select Use daylight savings time.
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6 To have administrative capabilities and to apply the settings to the current
session and all future sessions, select Save as default time zone.

7 Click OK.

Configuring a custom time zone in the NetBackup Administration
Console or the Backup, Archive, and Restore console

Use the following procedure to configure a custom time zone in the administration
or the client consoles.

To configure a custom time zone

1 In the NetBackup Administration Console, or in the Backup, Archive, and
Restore console, select File > Adjust Application Time Zone.

2 Select the Use custom time zone check box.

3 Select the Custom tab.

4 Select the time zone on which to base the Backup, Archive, and Restore
interface time.

5 For the Offset from Greenwich Mean Time setting, adjust the time to reflect
how many hours and minutes the server’s time zone is either behind or ahead
of Greenwich Mean Time.

6 Select the Use daylight savings time check box.

7 To make a selection in the Daylight savings time starts section of the dialog,
see the following table for descriptions of each option:

Select Absolute date and indicate the month and dayBegin daylight savings time on a specific date

Select First day of week in month. Indicate the day of the
week and the month.

Begin daylight savings time on the first occurrence of a
day in a month

Select First day of week in month after date. Indicate the
day of the week and the month and day.

Begin daylight savings time on the first occurrence of a
day in a month and after a specific date

Select Last day of week in month. Indicate the day of the
week and the month.

Begin daylight savings time on the last occurrence of a
day in a month

Select Last day of week in month before date. Indicate
the day of the week and the month and day.

Begin daylight savings time on the last occurrence of a
day in a month and before a specific date

8 Indicate when daylight savings time should end by using one of the methods
in the previous step.
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9 To have administrative capabilities and apply the settings to the current session
and all future sessions, select Save as default time zone.

10 Click OK.
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Alternate server restores
This chapter includes the following topics:

■ About alternate server restores

■ About supported configurations for alternate server restores

■ About performing alternate server restores

About alternate server restores
This topic explains how to restore files by using a server other than the one that
was used to write the backup. This type of restore operation is called an alternate
server restore or server independent restore. It allows easier access to data for
restores in master and media server clusters and provides better failover and
disaster recovery capabilities.

The architecture of NetBackup allows storage devices to be located on multiple
servers (either separate storage devices or a shared robot). The NetBackup image
catalog on the master server contains an entry that defines the server (master or
media server) to which each backup was written. Information specific to the backup
media is contained within the master server image catalog (in the attribute file for
each backup). The information is also contained in the Enterprise Media Manager
(EMM) database, generally located on the master server.

To restore data through a device on another server is more involved than other
restores. Use the methods that are described in this topic to restore the backups.
Although the methods do not require you to expire and import backup images, in
some instances it is useful.

The information in this topic is also pertinent in the case of restoring from a backup
copy. If you created multiple copies of a backup, it is possible to restore from a
specific backup copy other than the primary copy. To do so, use the bprestore

command.
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More information is available in the NetBackup Commands Reference Guide.

See “Expiring and importing media for alternate server restores” on page 1204.

About supported configurations for alternate
server restores

All of the methods for alternate server restores require that the server that is used
for the restore be in the same cluster as the server that performed the original
backup. It must also share the same Enterprise Media Manager database.

Figure 34-1 and Figure 34-2 show configurations where NetBackup supports
alternate server restores. All methods require that the server that is used for the
restore be in the same cluster as the server that performed the original backup.
The server must also share the same Enterprise Media Manager database.

Figure 34-1 NetBackup servers that share robotic peripherals

NetBackup image
catalog

Enterprise Media
Manager database Master server

Drive 1

Control
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Drive 2

Drive 3

Media
server 1

Media
server 2

Assume the following in Figure 34-1:

■ A single, shared Enterprise Media Manager database exists on the NetBackup
master server.

■ The NetBackup master server is available at time of restore.

■ Robotic control is on a NetBackup server that is available at the time of the
restore.
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Figure 34-2 NetBackup servers with separate non-shared peripherals
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Assume the following in Figure 34-2:

■ Themedia is made physically accessible through an available NetBackup server.
The Enterprise Media Manager database is updated to reflect this move.

■ A single, shared Enterprise Media Manager database exists on the NetBackup
master server.

■ The NetBackup master server is available at time of restore

■ Robotic control (if applicable) is on a NetBackup server that is available at the
time of the restore.

About performing alternate server restores
The method that NetBackup administrators can use to perform alternate server
restores depends on the configuration and the situation. The method can include
one or more of the following:

■ Modify the NetBackup catalogs.
See “About modifying the NetBackup catalogs” on page 1200.

■ Override the original server for restores.
See “Overriding the original server for restores” on page 1201.

■ Enable automatic failover to an alternate server
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See “About enabling automatic failover to an alternate server” on page 1203.

About modifying the NetBackup catalogs
To perform alternate server restores by modifying the NetBackup catalogs, change
the contents of the NetBackup catalogs. Use this method only when the server
reassignment is permanent.

Some examples of when to use this method are as follows:

■ Media is moved to an off-site location, where a media server exists.

■ A robot was moved from one server to another.

■ Two (or more) servers share a robot, each with connected drives and one of
the servers is to be disconnected or replaced.

■ Two (or more) servers each have their own robots. One of the server’s robots
has run out of media capacity for future backups, while several empty slots exist
on another server’s robot.

The actual steps that are used vary depending on whether the original server is still
available.

Modifying NetBackup catalogs when the server that wrote
the media is available
Use the following procedure to modify catalogs when the server that wrote the
media is available.

To modify NetBackup catalogs when the server that wrote the media is
available

1 If necessary, physically move the media.

2 Update the Enterprise Media Manager database by using move volume options
in the Media Manager administration utilities.

3 Update the NetBackup image catalog on the master server.

4 Update the NetBackup media catalogs on both the original NetBackup server
(oldserver) and the destination NetBackup server (newserver).

Use the following command, which can be run from any one of the NetBackup
servers.

Enter the admincmd command on one line:

■ As administrator on a Windows NetBackup server:
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cd install_path\NetBackup\bin\admincmd

bpmedia.exe -movedb -m media_id

-newserver hostname -oldserver hostname

■ As root on a UNIX NetBackup server:

cd /usr/openv/netbackup/bin/admincmd

bpmedia -movedb -m media_id -newserver hostname

-oldserver hostname

Modifying NetBackup catalogs when the server that wrote
the media is unavailable
Use the following procedure to modify catalogs when the server that wrote the
media is unavailable.

To modify NetBackup catalogs when the server that wrote the media is
unavailable

1 If necessary, physically move the media.

2 Update the Enterprise Media Manager database by using the move volume
options in the Media and Device Management window.

3 Update only the NetBackup image catalog on the master server.

Use the following commands from the NetBackup master server.

Enter the admincmd command on one line:

■ As administrator on a Windows NetBackup server:

cd install_path\NetBackup\bin\admincmd

bpimage.exe -id media_id -newserver hostname

-oldserver hostname

■ As root on a UNIX NetBackup server:

cd /usr/openv/netbackup/bin/admincmd

bpimage -id media_id -newserver hostname

-oldserver hostname

Overriding the original server for restores
NetBackup allows the administrator to force restores to a specific server, regardless
of where the files were backed up. For example, if files were backed up on server
A, a restore request can be forced to use server B.
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Examples of when to use this method are as follows:

■ Two (or more) servers share a robot, each with connected drives. A restore is
requested while one of the servers is either temporarily unavailable or is busy
doing backups.

■ A server was removed from the NetBackup configuration, and is no longer
available.

Use the following procedure to override the original server for restores.

To override the original server for restores

1 In the NetBackup Administration Console, in the left pane, expand
NetBackupManagement > Host Properties. Depending on the type of server
to override, click on either Master Servers or Media Servers.

See “General Server properties” on page 132.

2 In the right pane, click on the selected server to open theGeneral Server host
properties dialog box.

3 In the General Server host properties dialog box, click on the Add button to
open the Add Media Override settings window. Add entries for the original
backup server and the restore server and click the Add button in the Add
Media Override settings window.

4 Click OK.

Overriding the original server for restores manually
Use the following procedure to manually override the original server for restores.

To manually override the original server for restores

1 If necessary, physically move the media and update the Enterprise Media
Manager database Media Manager volume database to reflect the move.

2 Modify the NetBackup configuration on the master server as follows:

■ By using the NetBackup Administration Console:
In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties. Click on Master Servers.
In the right pane, click on the selected server to open the General Server
host properties dialog box of the master server.
In the General Server host properties dialog box, click on the Add button
to open the Add Media Override settings window. Add entries for the
original backup server and the restore server and click the Add button in
the Add Media Override settings window.

■ By modifying the bp.conf file on a UNIX NetBackup server:
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As root add the following entry to the

/usr/openv/netbackup/bp.conf file:

FORCE_RESTORE_MEDIA_SERVER = fromhost tohost

The fromhost is the server that wrote the original backup and the tohost is
the server to use for the restore.

To revert to the original configuration for future restores, delete the changes
that were made in this step.

3 Click OK.

4 Stop and restart the NetBackup Request daemon on the master server.

The override applies to all storage units on the original server. This means that
restores for any storage unit on fromhost go to tohost.

About enabling automatic failover to an alternate server
NetBackup allows the administrator to configure automatic restore failover to an
alternate server if the original server is temporarily inaccessible. Once it is
configured, this method does not require administrator intervention.

See “Restore Failover properties” on page 200.

Some examples of when to use this method are as follows:

■ Two or more servers share a robot, each with connected drives.
When a restore is requested, one of the servers is temporarily inaccessible.

■ Two or more servers have standalone drives of the same type.
When a restore is requested, one of the servers is temporarily inaccessible.

In these instances, inaccessible means that the connection between bprd on the
master server and bptm on the original server (through bpcd) fails.

Possible reasons for the failure are as follows:

■ The original server is down.

■ The original server is up but bpcd on that server does not respond. (For example,
if the connection is refused or access is denied.)

■ The original server is up and bpcd is fine, but bptm has problems. (For example,
if bptm cannot find the required tape.)

Note: The failover uses only the failover hosts that are listed in the NetBackup
configuration. By default, the list is empty and NetBackup does not perform the
automatic failover.
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Failing over to an alternate server
Use the following procedure to enable automatic failover to an alternate server.

To enable automatic failover to an alternate server

1 Modify the NetBackup configuration on the master server are as follows:

■ By using the NetBackup Administration Console:
In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Host Properties. Click onMaster Servers to
open the Master Server Properties dialog box. In the left pane, click on
Restore Failover to open theRestore Failover host properties dialog box.
In the Restore Failover host properties dialog box, click on the Add button
to open theAdd Failover Serverswindow. Add entries for the media server
and the failover restore server(s) and click the Add button in the Add
Failover Servers window. Click OK.

■ By modifying the bp.conf file on a UNIX NetBackup server:
As root, add the following entry to the
/usr/openv/netbackup/bp.conf file:

FAILOVER_RESTORE_MEDIA_SERVERS =

failed_host host1 host2 ... hostN

Where:
failed_host is the server that is not operational.
host1 ... hostN are the servers that provide failover capabilities.

When automatic failover is necessary for a given server, NetBackup searches
through the relevant FAILOVER_RESTORE_MEDIA_SERVERS list. NetBackup looks
from left to right for the first server that is eligible to perform the restore.

There can be multiple FAILOVER_RESTORE_MEDIA_SERVERS entries and each
entry can have multiple servers. However, a NetBackup server can be a
failed_host in only one entry.

2 Stop and restart the NetBackup Request daemon on the master server.

Expiring and importing media for alternate server restores
It may be necessary to expire media and then import it, even with the alternate
server restore capabilities.

Regarding identifying media spanning groups, an alternate server restore operation
can include media IDs that contain backup images that span media. It may be
necessary to identify the media IDs that contain fragments of the spanned images.
The group of related media is called a media spanning group.
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On Windows: To identify the media in a specific media spanning group, run the
following command as administrator from the command prompt on the NetBackup
master server:

cd install_path\NetBackup\bin

bpimmedia.exe -spangroups -U -mediaid media_id

On UNIX: To identify the media in a specific media spanning group, run the following
command as root on the NetBackup master server:

cd /usr/openv/netbackup/bin/admincmd

bpimmedia -spangroups -U -mediaid media_id

To display all media in all spanning groups, omit -mediaid media_id from the
command.
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Managing client backups
and restores

This chapter includes the following topics:

■ About server-directed restores

■ About client-redirected restores

■ About restoring the files that have Access Control Lists (ACLs)

■ About setting the original atime for files during restores on UNIX

■ Restoring the System State

■ About the backup and restore of compressed files on VxFS file systems

■ About backups and restores on ReFS

About server-directed restores
By default, NetBackup clients are configured to allow NetBackup administrators on
a master server to direct restores to any client.

To prevent server-directed restores, configure the client accordingly as follows:

■ On Windows clients:
In theNetBackup Administration Console, in the toolbar, click File > Backup,
Archive, and Restore.
Select File > NetBackup Client Properties > General, then clear the Allow
server-directed restores check box.

■ On UNIX clients:
Add DISALLOW_SERVER_FILE_WRITES to the following file on the client:
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/usr/openv/netbackup/bp.conf

Note: On UNIX systems, the redirected restores can incorrectly set UIDs or
GIDs that are too long. The UIDs and GIDs of files that are restored from one
platform to another may be represented with more bits on the source system
than on the destination system. If the UID or the GID name in question is not
common to both systems, the original UID or GID may be invalid on the
destination system. In this case, the UID or GID is replaced with the UID or GID
of the user that performs the restore.

See “DISALLOW_SERVER_FILE_WRITES option for NetBackup servers and
clients” on page 283.

On UNIX: No progress log is produced if the bp.conf file of the requesting server
does not contain an entry for the restoring server. Without that entry, the restoring
server has no access to write the log files to the requesting server. (A progress log
is an entry in the Task Progress tab of the Backup, Archive, and Restore client
interface.)

Consider the following solutions:

■ To produce a progress log, add the requesting server to the server list.
To do so, log into the requesting server. In the NetBackup Administration
Console, expand NetBackup Management > Host Properties > Master
Servers > Double-click on the master server > Servers. Add the restoring server
to the server list.

■ Log on to the restoring server. Check the Activity Monitor to determine the
success of the restore operation.

To restore a UNIX backup that contains soft and hard links, run the Backup,
Archive, and Restore client interface from a UNIX machine.

About client-redirected restores
The Backup, Archive, and Restore client interface contains options for allowing
clients to restore the files that were backed up by other clients. The operation is
called a redirected restore.

For the following Backup Services API (XBSA) agents, redirected restores to a
different version of the agent is not supported:

■ MariaDB

■ MySQL

■ PostgreSQL
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About restore restrictions
By default, NetBackup permits only the client that backs up files to restore those
files. NetBackup ensures that the client name of the requesting client matches the
peer name that was used to connect to the NetBackup server.

Unless clients share an IP address, the peer name is equivalent to the client’s host
name. (Clients can share an IP address due to the use of a gateway and token ring
combination, or multiple connections.) When a client connects through a gateway,
the gateway can use its own peer name to make the connection.

The NetBackup client name is normally the client’s short host name, such as client1
rather than a longer form such as client1.null.com.

The client name is found in the following locations:

■ On Windows clients:
In theNetBackupAdministration Console, in the toolbar, select File > Backup,
Archive, and Restore. In the Backup, Archive, and Restore dialog box, in
the toolbar, select File > Specify NetBackup Machines and Policy Type. The
client name that is selected as Source Client for Restores is the source of the
backups to be restored.

■ On UNIX clients:
In the Backup, Archive, and Restore dialog box, select File > Specify
NetBackupMachines and Policy Type. In the Specify NetBackupMachines
and Policy Type dialog box, select the client name as the Source client for
restores.

Allowing all clients to perform redirected restores
The NetBackup administrator can allow clients to perform redirected restores. That
is, allow all clients to restore the backups that belong to other clients.

To do so, first create an altnames directory on the NetBackup master server where
the backup policy for the clients resides. Place an empty No.Restrictions file
inside of the directory.

■ On Windows:
install_path\NetBackup\db\altnames\No.Restrictions

Do not add a suffix to the files in the altnames directory.

■ On UNIX:
/usr/openv/netbackup/db/altnames/No.Restrictions

The NetBackup client name setting on the requesting client must match the name
of the client for which the backup was created. The peer name of the requesting
client does not need to match the NetBackup client name setting.
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Note: The altnames directory can present a breach of security, so use it only limited
circumstances. Users that are permitted to restore files from other clients may also
have local permission to create the files that are found in the backup.

Allowing a single client to perform redirected restores
The NetBackup administrator can permit a single client to restore the backups that
belong to other clients.

To do so, create an altnames directory on the NetBackup master server where the
policy that backed up the other client(s) resides. Place an empty peername file
inside of the altnames directory where peername is the client to possess restore
privileges.

■ On Windows:
install_path\NetBackup\db\altnames\peername

■ On UNIX:
/usr/openv/netbackup/db/altnames/peername

In this case, the requesting client (peername) can access the files that are backed
up by another client. The NetBackup client name setting on peernamemust match
the name of the other client.

Allowing redirected restores of a specific client’s files
The NetBackup administrator can permit a single client to restore the backups that
belong to another specific client.

To do so, create an altnames directory on the NetBackup master server of the
requesting client in the following location:

■ On Windows:
install_path\NetBackup\db\altnames\peername

■ On UNIX:
/usr/openv/netbackup/db/altnames/peername

Then, create a peername file inside of the directory where peername is the client
to possess restore privileges. Add to the peername file the names of the client(s)
whose files the requesting client wants to restore.

The requesting client can restore the files that were backed up by another client if:

■ The names of the other clients appear in the peername file, and

■ The NetBackup client name of the requesting client is changed to match the
name of the client whose files the requesting client wants to restore.
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Examples of redirected restores
This topic provides some example configurations that allow clients to restore the
files that were backed up by other clients. These methods may be required when
a client connects through a gateway or has multiple Ethernet connections.

In all cases, the requesting client must have access to an image database directory
on the master server or the requesting client must be a member of an existing
NetBackup policy.

■ On Windows: install_path\NetBackup\db\images\client_name

■ On UNIX: /usr/openv/netbackup/db/images/client_name

Note:Not all file system types on all computers support the same features. Problems
can be encountered when a file is restored from one file system type to another.
For example, the S51K file system on an SCO computer does not support symbolic
links nor does it support names greater than 14 characters long. You may want to
restore a file to a computer that doesn’t support all the features of the computer
from which the restore was performed. In this case, all files may not be recovered.

In the following examples, assume the following conditions:

■ client1 is the client that requests the restore.

■ client2 is the client that created the backups that the requesting client wants to
restore.

■ On Windows: install_path is the path where you installed the NetBackup
software. By default, this path is C:\Program Files\Veritas.

Note: The information in this topic applies to the restores that are made by using
the command line, not the Backup, Archive, and Restore client interface.

Note: On Windows: You must have the necessary permissions to perform the
following steps.

On UNIX: You must be a root user for any of the steps that must be performed
on the NetBackup server. You may also need to be a root user to make the
changes on the client.
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Example of a redirected client restore
Assume you must restore files to client1 that were backed up from client2. The
client1 and client2 names are those specified by the NetBackup client name setting
on the clients.

In the nominal case, do the following:

■ On Windows: Log on to the NetBackup server.

Add client2 to the following file and perform one of the following:

■ Edit install_path\NetBackup\db\altnames\client1 to include the name
of client2.

■ Create the following empty file:
install_path\NetBackup\db\altnames\No.Restrictions

■ On UNIX: Log on as root on the NetBackup server.

Perform one of the following actions:

■ Edit /usr/openv/netbackup/db/altnames/client1 so it includes the name
of client2. Or,

■ Run the touch command on the following file:
/usr/openv/netbackup/db/altnames/No.Restrictions

Note: The No.Restrictions file allows any client to restore files from client2.

■ Log on to client1 and change the NetBackup client name to client2.

■ Restore the file.

■ Undo the changes that were made on the server and client.

Example of a redirected client restore using the altnames
file
This example explains how altnames provides restore capabilities to clients that
do not use their own host name when they connect to the NetBackup server.

By default, the NetBackup client name of the requesting client must match the peer
name that is used in the connection to the NetBackup server. When the NetBackup
client name is the host name for the client and matches the peer name (normal
case), this requirement is met.

However, problems arise when clients connect to multiple ethernet or connect to
the NetBackup server through a gateway.
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Figure 35-1 Example restore from a token ring client
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In this example, restore requests from client1, client2, and client3 are routed through
the TCP gateway. Because the gateway uses its own peer name rather than the
client host names for connection to the NetBackup server, NetBackup refuses the
requests. Clients cannot restore even their own files.

To correct the situation, do the following.

Determine the peer name of the gateway:

■ Try a restore from the client in question. In this example, the request fails with
an error message similar to the following:
client is not validated to use the server

■ Examine the NetBackup problems report and identify the peer name that is used
on the request. Entries in the report may be similar to the following:
01/29/12 08:25:03 bpserver - request from invalid server or client

client1.dvlp.null.com

In this example, the peer name is client1.dvlp.null.com.

On Windows: Determine the peer name, then create the following file on the
NetBackup master server:

install_path\NetBackup\db\altnames\peername

On UNIX: Run the touch command on the following file:

/usr/openv/netbackup/db/altnames/peername

In this example, the file is:

On Windows:

install_path\NetBackup\db\altnames\client1.dvlp.null.com

On UNIX:

/usr/openv/netbackup/db/altnames/client1.dvlp.null.com
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Edit the peername file so that it includes the client names.

For example, if you leave file client1.dvlp.null.com empty, client1, client2, and
client3 can all access the backups that correspond to their NetBackup client name
setting.

See “Allowing a single client to perform redirected restores” on page 1209.

If you add the names client2 and client3 to the file, you give these two clients access
to NetBackup file restores, but exclude client1.

See “Allowing redirected restores of a specific client’s files” on page 1209.

Note that this example requires no changes on the clients.

Restore the files.

Example of how to troubleshoot a redirected client restore
using the altnames file
If you cannot restore files with a redirected client restore by using the altnames

file, troubleshoot the situation, as follows.

On Windows:

■ Create the debug log directory for the NetBackup Request Daemon:
install_path\NetBackup\logs\bprd

■ On the master server, stop and restart the NetBackup Request Daemon. Restart
the service to ensure that this service is running in verbose mode and logs
information regarding client requests.

■ On client1 (the requesting client), try the file restore.

■ On the master server, identify the peer name connection that client1 uses.

■ Examine the failure as logged on the All Log Entries report. Or, examine the
debug log for the NetBackup Request Daemon to identify the failing name
combination:
install_path\NetBackup\logs\bprd\mmddyy.log

■ On the master server, do one of the following:

■ Create an install_path\NetBackup\db\altnames\No.Restrictions file.
The file allows any client to access client2 backups if the client changes its
NetBackup client name setting to client2.

■ Create an install_path\NetBackup\db\altnames\peername file. The file
allows client1 to access client2 backups if client1 changes its NetBackup
client name setting to client2.

■ Add client2 name to the following file:
install_path\NetBackup\db\altnames\peername.
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■ client1 is allowed to access backups on client2 only.

■ On client1, change the NetBackup client name setting to match what is specified
on client2.

■ Restore the files from client1.

■ Perform the following actions:

■ Delete install_path\NetBackup\logs\bprd and the contents.

■ On the master server, select NetBackup Management > Host Properties
> Master Servers > Double-click on master server. In the Master Server
Properties dialog box, in the left pane, click on Logging. Clear the Keep
logs for days property check box.

■ If you do not want the change to be permanent, do the following:

■ Delete install_path\NetBackup\db\altnames\No.Restrictions (if
existent).

■ Delete install_path\NetBackup\db\altnames\peername (if existent).

■ On client1, change the NetBackup client name to its original value.

On UNIX:

■ On the NetBackup master server, add the VERBOSE entry and a logging level to
the bp.conf file. For example:

VERBOSE = 3

■ Create the debug log directory for bprd by running the following command:
mkdir /usr/openv/netbackup/logs/bprd

■ On the NetBackup server, stop the NetBackup Request Daemon, bprd, and
restart it in verbose mode by running:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

/usr/openv/netbackup/bin/bprd -verbose

Restart bprd to ensure that bprd logs information regarding client requests.

■ On client1, try the file restore.

■ On the NetBackup server, identify the peer name connection that client1 used.
Examine the failure as logged on the All Log Entries report or examine the bard
debug log to identify the failing name combination:
/usr/openv/netbackup/logs/bprd/log.date

■ Take one of the following on the NetBackup server:
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Enter the following commands:■

mkdir -p /usr/openv/netbackup/db/altnames touch

/usr/openv/netbackup/db/altnames/No.Restrictions

These commands allow any client access to client2 backups by changing
its NetBackup client name setting to specify the client2.

■ Run the touch command on the following file:
/usr/openv/netbackup/db/altnames/peername

The command allows client1 access to any client2 backups by changing its
NetBackup client name setting to specify client2.

■ Add client2 to the /usr/openv/netbackup/db/altnames/peername file. The
addition to the peername file allows client1 access to the backups that were
created on client2 only.

■ On client1, change the NetBackup client name setting in the user interface to
match what is specified on client2.

■ Restore the files to client1.

■ Do the following:

■ Delete the VERBOSE entry from the /usr/openv/netbackup/bp.conf file on
the master server.

■ Delete /usr/openv/netbackup/logs/bprd and the contents.

■ To return the configuration to what it was before the restore, do the following:

■ Delete /usr/openv/netbackup/db/altnames/peer.or.hostname (if it exists)

■ Delete /usr/openv/netbackup/db/altnames/No.Restrictions (if it exists)

■ On client1, restore the NetBackup client name setting to its original value.

See “Allowing redirected restores of a specific client’s files” on page 1209.

See “Allowing a single client to perform redirected restores” on page 1209.

About restoring the files that have Access Control
Lists (ACLs)

An Access Control List (ACL) is a table that conveys the access rights users need
to a file or directory. Each file or directory can have a security attribute that extends
or restricts users’ access.

By default, the nbtar (/usr/openv/netbackup/bin/nbtar) restores ACLs along
with file and directory data.
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However, in some situations the ACLs cannot be restored to the file data, as follows:

■ Where the restore is cross-platform.

■ When a restore utility (tar) other than nbtar is used to restore files.

In these instances, NetBackup stores the ACL information in a series of generated
files in the root directory using the following naming form:

.SeCuRiTy.nnnn

These files can be deleted or can be read and the ACLs regenerated by hand.

Note: If performing an alternate restore where the original directory was
ACL-enabled, the alternate restore directory must also be ACL-enabled. If the
alternate restore directory is not ACL-enabled, the restore is not successful.

Restoring files without restoring ACLs
The NetBackup client interface onWindows is available to administrators to restore
data without restoring the ACLs. Both the destination client and the source of the
backup must be Windows systems.

To restore files without restoring ACLs, the following conditions must be met:

■ The policy that backed up the client is of policy type MS-Windows.

■ An administrator performs the restore and is logged into a NetBackup server
(Windows or UNIX). The option is set at the server by using the client interface.
The option is unavailable on standalone clients (clients that do not contain the
NetBackup server software).

■ The destination client and the source of the backup must both be systems
running supported Windows OS levels. The option is disabled on UNIX clients.

Use the following procedure to restore files without restoring ACLs.

To restore files without restoring ACLs

1 Log on to the NetBackup server as administrator.

2 Open the Backup, Archive, and Restore client interface.

3 From the client interface, initiate a restore.

4 Select the files to be restored, then select Actions > Start Restore of Marked
Files.

5 In theRestore Marked Files dialog box, place a check in theRestore without
access-control attributes check box.
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6 Make any other selections for the restore job.

7 Click Start Restore.

About setting the original atime for files during
restores on UNIX

During a restore, NetBackup sets the atime for each file to the current time by
default. You can elect to have NetBackup set the atime for each restored file to
the value the file had when it was backed up. To do so, create the following file on
the client:

/usr/openv/netbackup/RESTORE_ORIGINAL_ATIME

Restoring the System State
The System State includes the registry, the COM+ Class Registration database,
and boot and system files. If the server is a domain controller, the data also includes
the Active Directory services database and the SYSVOL directory.

Note: The best recovery procedure depends on many hardware and software
variables that pertain to the server and its environment. For a complete Windows
recovery procedure, refer to the Microsoft documentation.

Read the following notes carefully before you restore the System State:

■ The System State should be restored in its entirety. Do not restore selected
files.

■ Do not redirect a System State restore. System State is computer-specific and
to restore it to an alternate computer can result in an unusable system.

■ Do not cancel a System State restore operation. To cancel the operation may
leave the system unusable.

■ To restore the System State to a domain controller, the Active Directory must
not be running.

Restoring the System State
Use the following procedure to restore the System State.

1217Managing client backups and restores
About setting the original atime for files during restores on UNIX



To restore the System State

1 To restore the Active Directory, restart the system, and press F8 during the
boot process. F8 brings up a startup options menu. Press F8 upon restart if
the system to which you are to restore is a Windows domain controller.
Otherwise, begin with step 4.

2 From the startup options, select Directory Services Restore Mode and
continue the boot process.

3 Ensure that the NetBackup Client Service, either bpinetd on Windows or
inetd on UNIX, has started. Use the Activity Monitor or the Services
application in the Windows Control Panel.

4 Start the Backup, Archive, and Restore client interface. Click Select for
Restore, and place a checkmark next to System State.
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5 To restore a system state backup using an incremental backup, select the full
backup and one or more differential-incremental or cumulative-incremental
backups.

6 From the Actions menu, select Restores.

7 From the Restore Marked Files dialog box, select Restore everything to its
original location and Overwrite the existing file.

Do not redirect the System State restore to a different host. System State is
computer-specific. To restore it to a different computer can result in an unusable
system.

8 Click Start Restore.
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9 The network may contain more than one domain controller. To replicate Active
Directory to other domain controllers, perform an authoritative restore of the
Active Directory after the NetBackup restore job completes.

To perform an authoritative restore of the Active Directory, run the Microsoft
ntdsutil utility after you restored the System State data but before the server
is restarted. An authoritative restore ensures that the data is replicated to all
of the servers.

Additional information about an authoritative restore and the ntdsutil utility
is available.

See the Microsoft documentation.

10 Restart the system before performing subsequent restore operations.

If you booted into Directory Services Restore Mode on a domain controller,
restart into normal mode when the restore is complete.

About the backup and restore of compressed files
on VxFS file systems

NetBackup can back up and restore VxFS-compressed files, maintaining the
compression state when the target volume supports file system compression. Future
releases will expand this capability to other file systems.

Upon backup of files on a VxFS file system, a message displays in the Activity
Monitor whenever NetBackup encounters a compressed file:

Compress flag found for ‘file_name’.

Upon restore, NetBackup restores the files to a VxFS file system in their compressed
form.

If the restore is to a non-VxFS file system, NetBackup restores the files in an
uncompressed form. The following message displays in the Progress tab of the
Backup, Archive, and Restore client interface:

File ‘file_name’ will not be restored in compressed form. Please

refer to the Release Notes or User Guide.

The message appears only for the first file that cannot be restored in its compressed
form.

Note: The compression messages display if the verbose level is 1 or greater.
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About backups and restores on ReFS
Microsoft Resilient File System (ReFS) support in NetBackup is automatic and
requires no additional configuration.

To restore optimized backups, use the Restore from Optimized Backup in the
Backup, Archive, and Restore interface. You can select individual files for restore.

NetBackup does not support a redirected restore of a Microsoft Resilient File
Systems (ReFS) file system.

Table 35-1 lists the ReFS-to-NTFS backup and restore combinations and the
success of each.

Table 35-1 ReFS backup and restore

RestoresBackupsBetween file
systems

SuccessfulSuccessfulReFS to ReFS

SuccessfulSuccessfulReFS to NTFS

Limited success

For successful restores:

■ Restore NTFS backups to NTFS file system.
■ Remove all non-supported ReFS items.
■ Copy the files to an ReFS file system.

SuccessfulNTFS to ReFS
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Powering down and
rebooting NetBackup
servers

This chapter includes the following topics:

■ Powering down and rebooting NetBackup servers

■ Shutting down and starting up all NetBackup services and daemons

■ Rebooting a NetBackup server

■ Rebooting a NetBackup media server

■ About displaying active processes with bpps on UNIX

■ About displaying robotic processes with vmps on UNIX

Powering down and rebooting NetBackup servers
To close and restart NetBackup servers, use the following recommended procedure.

To power down a server

1 In the NetBackup Administration Console, in the left pane, click Activity
Monitor. Click the Jobs tab and make sure that no jobs are running.

2 Click the Daemons tab and right-click the NetBackup Request daemon, bprd.

Select Stop daemon to stop additional job activity and to let current activity
end.

3 Right-click any daemons that are still running and select Stop daemon.
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4 From the command line, run:

On Windows:

install_path\NetBackup\bin\admincmd\bprdreq -terminate

On UNIX:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

bprdreq does not run on a media server.

5 Run the system shutdown command.

The installation process copies the appropriate startup and shutdown script
from /usr/openv/netbackup/bin/goodies to /init.d and creates links to it
from the appropriate /rc directory.

Use system startup scripts to begin the Media Manager and NetBackup
daemons when the system boots up. Use shutdown scripts to terminate the
daemons at system shutdown.

The NetBackup Installation Guide contains more information about the startup
and shutdown scripts.

6 On Windows, run:

install_path\NetBackup\bin\bpdown

7 Power down the server.

Shutting down and starting up all NetBackup
services and daemons

To shut down and start all NetBackup services and daemons, enter the following
commands from a command line:

On Windows:

■ To shut down all NetBackup services:

install_path\NetBackup\bin\bpdown

■ To startup all NetBackup services:

install_path\NetBackup\bin\bpup

On UNIX:

■ To shut down all NetBackup daemons:
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/usr/openv/netbackup/bin/bp.kill_all

■ To startup all NetBackup daemons:

/usr/openv/netbackup/bin/bp.start_all

All open NetBackup Administration Console sessions need to be restarted and
reconnected if NetBackup services are restarted or if a NetBackup server has been
rebooted.

Rebooting a NetBackup server
Use the following procedure to reboot a NetBackup server.

To reboot a NetBackup master server

1 Restart the system.

2 On Windows: If the required NetBackup services are not set up to start
automatically, do the following:

■ From the Windows desktop, start the Windows Services applet.

■ Start the NetBackup Client service.

■ Start the NetBackup Device Manager service. The NetBackup Volume
Manager service also starts automatically.

■ Start the NetBackup Request Daemon service to start the NetBackup
Database Manager service.

3 On UNIX: Ensure that bprd, bpdbm, and vmd are up by running the following
script:

/usr/openv/netbackup/bin/bpps -a

4 On UNIX: Start all NetBackup daemons:

/usr/openv/netbackup/bin/bp.start_all

Rebooting a NetBackup media server
Use the following procedure to reboot a NetBackup media server.
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To reboot a NetBackup media server

1 Restart the system.

2 On Windows: The required NetBackup services start automatically if they are
set up to do so.

If they are not set to start automatically, do the following:

■ From the Windows desktop, start the Windows Services applet.

■ Start the NetBackup Client service.

■ Start the NetBackup Device Manager service (ltid). The NetBackup
Volume Manager service (vmd) also starts.

3 On UNIX: Start ltid if it is not already running:

From the NetBackup Administration Console, do the following:

■ Click Activity Monitor, then select the Processes tab.

■ Right-click ltid and select Start Daemon.

4 On UNIX: From the command line, run:

/usr/openv/volmgr/bin/ltid

About displaying active processes with bpps on
UNIX

NetBackup provides the bpps command to determine which NetBackup processes
are active on a UNIX system.

bpps is located in the following directory:

/usr/openv/netbackup/bin/bpps

The following is example output:

root 310 0.0 0.0 176 0 ? IW Oct 19 15:04 /usr/openv/netbackup/bin/bpdbm

root 306 0.0 0.0 276 0 ? IW Oct 19 2:37 /usr/openv/netbackup/bin/bprd

To display both NetBackup and Media Manager options, run:

/usr/openv/netbackup/bin/bpps -a
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About displaying robotic processes with vmps
on UNIX

The vmps script shows the Media Manager daemons and robotic processes that
are active on a UNIX system.

To run this script, use the following command:

/usr/openv/volmgr/bin/vmps

In the following sample, the second column contains the process IDs for the
processes.

root 303 0.0 0.2 136 264 ? S Feb 11 4:32 ltid -v

root 305 0.0 0.0 156 0 ? IW Feb 11 0:54 vmd -v

root 306 0.0 0.0 104 0 ? IW Feb 11 0:15 tl8d -v

root 307 0.0 0.0 68 56 ? S Feb 11 12:16 avrd

root 310 0.0 0.0 116 0 ? IW Feb 11 0:07 tl8cd -v

The status for the nbemm command is not shown in the output of vmps. The nbemm

status is shown in the output of the bpps command.
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About Granular Recovery
Technology

This chapter includes the following topics:

■ About installing and configuring Network File System (NFS) for Active Directory
Granular Recovery

■ About configuring Services for Network File System (NFS) on Windows 2012,
2012 R2, or 2016

■ About configuring Services for Network File System (NFS) on Windows 2008
and 2008 R2

■ Configuring a UNIXmedia server andWindows clients for backups and restores
that use Granular Recovery Technology (GRT)

■ Configuring a different network port for NBFSD

About installing and configuring Network File
System (NFS) for Active Directory Granular
Recovery

NetBackup Granular Recovery leverages Network File System, or NFS, to read
individual objects from a database backup image. Specifically, the NetBackup client
uses NFS to extract data from the backup image on the NetBackup media server.
The NetBackup client uses “Client for NFS” to mount and access a mapped drive
that is connected to the NetBackup media server. The NetBackup media server
handles the I/O requests from the client through NBFSD.
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NBFSD is the NetBackup File System (NBFS) service that runs on the media server.
NBFSD makes a NetBackup backup image appear as a file system folder to the
NetBackup client over a secure connection.

Network File System, or NFS, is a widely recognized, open standard for client and
server file access over a network. It allows clients to access files on dissimilar
servers through a shared TCP/IP network. NFS is typically bundled with the host
operating system. NetBackup uses Granular Recovery Technology (GRT) and NFS
to recover the individual objects that reside within a database backup image, such
as:

■ A user account from an Active Directory database backup

■ Email messages or folders from an Exchange database backup

■ A document from a SharePoint database backup

Multiple NetBackup agents that support GRT (for example, Exchange, SharePoint,
and Active Directory) can use the same media server.

About configuring Services for Network File
System (NFS) onWindows 2012, 2012 R2, or 2016

To restore individual items from the Active Directory, you must configure Services
for NFS on the NetBackup media server and all Active Directory domain controllers
or ADAM/LDS hosts.
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Table 37-1 Configuring NFS on Windows 2012, 2012 R2, or 2016

DescriptionActionStep

On the media server do the following:

■ Stop and disable the ONC/RPC Portmapper service, if it exists.
■ Enable NFS.

See “Enabling Services for Network File System (NFS) on a Windows
2012, 2012 R2, or 2016 media server” on page 1229.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 1242.

■ Stop the Client for NFS service.
See “Disabling the Client for NFS on the media server” on page 1240.
Note: If the Active Directory domain controller or ADAM/LDS host
resides on the media server, do not disable the Client for NFS.

■ Configure the portmap service to start automatically at server restart.
Issue the following from the command prompt:
sc config portmap start= auto

This command should return the status [SC] ChangeServiceConfig
SUCCESS.

Configure NFS on the media
server.

Step 1

On all Active Directory domain controllers or ADAM/LDS hosts, do the
following:

■ Enable NFS on the clients.
See “Enabling Services for Network File System (NFS) on a Windows
2012, 2012 R2, or 2016 client” on page 1233.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 1242.

Configure NFS on all Active
Directory domain controllers
or ADAM/LDS hosts.

Step 2

Enabling Services for Network File System (NFS) on a Windows
2012, 2012 R2, or 2016 media server

To restore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System (NFS). When this
configuration is completed on the media server, you can disable any unnecessary
NFS services.
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To enable Services for Network File System (NFS) on a Windows 2012, 2012
R2, or 2016 media server

1 Open the Server Manager.

2 From the Manage menu, click Add Roles and Features.

3 In the Add Roles and Features Wizard, on the Before You Begin page, click
Next.
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4 On the Select installation type page, select Role-based or feature-based
installation.

5 Click Next.

6 On the Server Selection page, click Select a server from the server pool
and select the server. Click Next.
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7 On the Server Roles page, expand File and Storage Services and File and
iSCSI Services.

8 Click File Server and Server for NFS. When you are prompted, click Add
Features. Click Next.

9 If the media server is also an Active Directory domain controllers or ADAM/LDS
host, on the Features page, click Client for NFS. Click Next.
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10 On the Confirmation page, click Install.

11 Disable any unnecessary services, as follows:

■ If you have a single host that functions as both the media server and the
Active Directory domain controllers or ADAM/LDS host, you can disable
the Server for NFS service.
See “Disabling the Server for NFS” on page 1242.

■ For a host that is only the NetBackup media server, you can disable the
Server for NFS and the Client for NFS services.
See “Disabling the Server for NFS” on page 1242.
See “Disabling the Client for NFS on the media server” on page 1240.

Enabling Services for Network File System (NFS) on a Windows
2012, 2012 R2, or 2016 client

To restore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System (NFS). When this
configuration is completed all the Active Directory domain controllers or ADAM/LDS
hosts, you can disable any unnecessary NFS services.
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To enable Services for Network File System (NFS) on a Windows 2012, 2012
R2, or 2016 client

1 Open the Server Manager.

2 From the Manage menu, click Add Roles and Features.

3 In the Add Roles and Features Wizard, on the Before You Begin page, click
Next.
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4 On the Select installation type page, select Role-based or feature-based
installation.

5 Click Next.

6 On the Server Selection page, click Select a server from the server pool
and select the server. Click Next.

7 On the Server Roles page, click Next.
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8 On the Features page, click Client for NFS. Click Next.

9 On the Confirmation page, click Install.

About configuring Services for Network File
System (NFS) on Windows 2008 and 2008 R2

To restore individual items from the Active Directory, you must configure Services
for NFS on the NetBackup media server and all Active Directory domain controllers
or ADAM/LDS hosts.
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Table 37-2 Configuring NFS in a Windows 2008 or 2008 R2 environment

DescriptionActionStep

On the media server do the following:

■ Stop and disable the ONC/RPC Portmapper service, if it exists.
■ Enable NFS.

See “Enabling Services for Network File System (NFS) on Windows
2008 or 2008 R2” on page 1238.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 1242.

■ Stop the Client for NFS service.
See “Disabling the Client for NFS on the media server” on page 1240.
Note: If the Active Directory domain controller or ADAM/LDS host
resides on the media server, do not disable the Client for NFS.

■ Configure the portmap service to start automatically at server restart.
Issue the following from the command prompt:
sc config portmap start= auto

This command should return the status [SC] ChangeServiceConfig
SUCCESS.

Configure NFS on the media
server.

Step 1

On all Active Directory domain controllers or ADAM/LDS hosts, do the
following:

■ Enable NFS.
See “Enabling Services for Network File System (NFS) on Windows
2008 or 2008 R2” on page 1238.

■ Stop the Server for NFS service.
See “Disabling the Server for NFS” on page 1242.

Configure NFS on all Active
Directory domain controllers
or ADAM/LDS hosts.

Step 2

On all Active Directory domain controllers or ADAM/LDS hosts, install the
hotfix for Client for NFS. The hotfix is available at the following location:

http://support.microsoft.com/kb/955012

Note: ImportantWindows Vista hotfixes andWindows Server 2008 hotfixes
are included in the same packages. However, the hotfix Request page
lists only Windows Vista. To request the hotfix package that applies to
one or both operating systems, select the hotfix that is listed under
Windows Vista on the page. Always refer to the Applies To section
in articles to determine the actual operating system for each hotfix.

Install the hotfix for Client for
NFS on all Active Directory
domain controllers or
ADAM/LDS hosts.

Step 3
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Enabling Services for Network File System (NFS) on Windows 2008
or 2008 R2

To restore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System (NFS). When this
configuration is completed on the media server and all Active Directory domain
controllers or ADAM/LDS hosts, you can disable any unnecessary NFS services.

To enable Services for Network File System (NFS) on Windows 2008 or 2008
R2

1 Open the Server Manager.

2 In the left pane, click Roles and, in the right pane, click Add Roles.

3 In the Add Roles Wizard, on the Before You Begin page, click Next.
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4 On the Select Server Roles page, under Roles, check the File Services
check box. Click Next.

Note: If a role service is already installed for the File Services role, you can
add other role services from Roles home page. In the File Services pane, click
Add Role Services.

5 On the Files Services page, click Next.

6 On the Select Role Services page, do the following:

■ Uncheck File Server.

■ Check Services for Network File System.

■ Click Next and complete the wizard.
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7 For each host in your configuration, choose from one of the following:

■ If you have a single host that functions as both the media server and the
Active Directory domain controllers or ADAM/LDS host, you can disable
the Server for NFS.

■ For a host that is only the NetBackup media server, you can disable the
Server for NFS and the Client for NFS.

■ For a host that is only an Active Directory domain controllers or ADAM/LDS
host, you can disable the Server for NFS.

Disabling the Client for NFS on the media server
After you enable Services for Network File System (NFS) on a host that is only a
NetBackup media server, you can disable the Client for NFS.
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To disable the Client for NFS on the NetBackup media server

1 Open the Server Manager.

2 In the left pane, expand Configuration.

3 Click Services.

4 In the right pane, right-click on Client for NFS and click Stop.

5 In the right pane, right-click on Client for NFS and click Properties.
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6 In the Client for NFS Properties dialog box, from the Startup type list, click
Disabled.

7 Click OK.

Disabling the Server for NFS
After you enable Services for Network File System (NFS) on the media server and
on the Active Directory domain controllers or ADAM/LDS hosts, you can disable
Server for NFS.

To disable the Server for NFS

1 Open the Server Manager.

2 In the left pane, expand Configuration.
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3 Click Services.

4 In the right pane, right-click on Server for NFS and click Stop.

5 In the right pane, right-click on Server for NFS and click Properties.
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6 In the Server for NFS Properties dialog box, from the Startup type list, click
Disabled.

7 Click OK.

8 Repeat this procedure for the media server and for all Active Directory domain
controllers or ADAM/LDS hosts.

Configuring a UNIX media server and Windows
clients for backups and restores that useGranular
Recovery Technology (GRT)

To perform backups and restores that use Granular Recovery Technology (GRT),
perform the following configuration if you use a UNIX media server and Windows
clients:

■ Confirm that your media server is installed on a platform that supports granular
recovery.
See the Software Compatibility List.

■ No other configuration is required for the UNIX media server.
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■ Enable or install NFS on all Active Directory domain controllers or ADAM/LDS
hosts.
See “Enabling Services for Network File System (NFS) on a Windows 2012,
2012 R2, or 2016 media server” on page 1229.
See “Enabling Services for Network File System (NFS) on a Windows 2012,
2012 R2, or 2016 client” on page 1233.
See “Enabling Services for Network File System (NFS) on Windows 2008 or
2008 R2” on page 1238.

■ You can configure a different network port for NBFSD.
See “Configuring a different network port for NBFSD” on page 1245.

Configuring a different network port for NBFSD
NBFSD runs on port 7394. If another service uses the standard NBFSD port in your
organization, you 20can configure the service on another port. The following
procedures describe how to configure a NetBackup server to use a network port
other than the default.

To configure a different network port for NBFSD (Windows server)

1 Log on as administrator on the computer where NetBackup server is installed.

2 Open Regedit.

3 Open the following key.:

HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

4 Create a new DWORD value named FSE_PORT.

5 Right-click on the new value and click Modify.

6 In the Value data box, provide a port number between 1 and 65535.

7 Click OK.

To configure a different network port for NBFSD (UNIX server)

1 Log on as root on the computer where NetBackup server is installed.

2 Open the bp.conf file.

3 Add the following entry, where XXXX is an integer and is a port number between
1 and 65535.

FSE_PORT = XXXX

1245About Granular Recovery Technology
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